NT-series
Support Tool for Windows Ver.4.

OPERATION MANUAL

OMRON
Introduction

The NT-series Support Tool for Windows (Ver. 4.) is a software package for creating and maintaining screen data used by OMRON Programmable Terminals. Be sure to read and understand the functions and performance of the Support Tool before you attempt to use a Programmable Terminal. When using the Support Tool, be sure to have the manuals for the Programmable Terminal close at hand.

Intended Audience

This manual is intended for the following personnel, who must also have knowledge of electrical systems (an electrical engineer or the equivalent) and computers.

- Personnel in charge of introducing FA systems into production facilities
- Personnel in charge of designing FA systems
- Personnel in charge of installing and connecting FA equipment
- Personnel in charge of managing FA systems and facilities

Notice

This manual provides information required to use the NT-series Support Tool for Windows (Ver. 4.). Be sure to read this manual before attempting to use the Support Tool, and keep the manual close at hand for reference during operation.

© OMRON, 2000

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form, or by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior written permission of OMRON.

No patent liability is assumed with respect to the use of the information contained herein. Moreover, because OMRON is constantly striving to improve its high-quality products, the information contained in this manual is subject to change without notice. Every precaution has been taken in the preparation of this manual. Nevertheless, OMRON assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained in this publication.

Trademarks

Microsoft®, MS-DOS®, Windows® and Windows NT® are either registered trademarks or Trademarks of Microsoft Corporation in the United States and/or other countries.
PLC names of MELSEC FX, A series and FX-2PIF of MELSEC F series are registered trademarks of Mitsubishi Electric Corporation.
Hewlett-Packard, HP, PCL and Laser Jet are registered trademarks of Hewlett-Packard Company.
**Read and Understand this Manual**

Please read and understand this manual before using the product. Please consult your OMRON representative if you have any questions or comments.

**Warranty and Limitations of Liability**

<table>
<thead>
<tr>
<th><strong>WARRANTY</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>OMRON’s exclusive warranty is that the products are free from defects in materials and workmanship for a period of one year (or other period if specified) from date of sale by OMRON.</td>
</tr>
</tbody>
</table>

OMRON makes no warranty or representation, express or implied, regarding non-infringement, merchantability, or fitness for particular purpose of the products. Any buyer or user acknowledges that the buyer or user alone has determined that the products will suitably meet the requirements of their intended use. OMRON disclaims all other warranties, express or implied.

<table>
<thead>
<tr>
<th><strong>LIMITATIONS OF LIABILITY</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>OMRON SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMMERCIAL LOSS IN ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.</td>
</tr>
</tbody>
</table>

In no event shall the responsibility of OMRON for any act exceed the individual price of the product on which liability is asserted.

IN NO EVENT SHALL OMRON BE RESPONSIBLE FOR WARRANTY, REPAIR, OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS OMRON’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR.
Application Considerations

SUITABILITY FOR USE

OMRON shall not be responsible for conformity with any standards, codes, or regulations that apply to the combination of products in the customer’s application or use of the products.

At the customer’s request, OMRON will provide applicable third party certification documents identifying ratings and limitations of use that apply to the products. This information by itself is not sufficient for a complete determination of the suitability of the products in combination with the end product, machine, system, or other application or use.

The following are some examples of applications for which particular attention must be given. This is not intended to be an exhaustive list of all possible uses of the products, nor is it intended to imply that the uses listed may be suitable for the products:

- Outdoor use, uses involving potential chemical contamination or electrical interference, or conditions or uses not described in this manual.

- Nuclear energy control systems, combustion systems, railroad systems, aviation systems, medical equipment, amusement machines, vehicles, safety equipment, and installations subject to separate industry or government regulations.

- Systems, machines, and equipment that could present a risk to life or property.

Please know and observe all prohibitions of use applicable to the products.

NEVER USE THE PRODUCTS FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, AND THAT THE OMRON PRODUCTS ARE PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

PROGRAMMABLE PRODUCTS

OMRON shall not be responsible for the user’s programming of a programmable product, or any consequence thereof.
### Disclaimers

#### CHANGE IN SPECIFICATIONS

Product specifications and accessories may be changed at any time based on improvements and other reasons.

It is our practice to change model numbers when published ratings or features are changed, or when significant construction changes are made. However, some specifications of the products may be changed without any notice. When in doubt, special model numbers may be assigned to fix or establish key specifications for your application on your request. Please consult with your OMRON representative at any time to confirm actual specifications of purchased products.

#### DIMENSIONS AND WEIGHTS

Dimensions and weights are nominal and are not to be used for manufacturing purposes, even when tolerances are shown.

#### PERFORMANCE DATA

Performance data given in this manual is provided as a guide for the user in determining suitability and does not constitute a warranty. It may represent the result of OMRON’s test conditions, and the users must correlate it to actual application requirements. Actual performance is subject to the OMRON Warranty and Limitations of Liability.

#### ERRORS AND OMISSIONS

The information in this manual has been carefully checked and is believed to be accurate; however, no responsibility is assumed for clerical, typographical, or proofreading errors, or omissions.
Safety Precautions

Safety-related Indications and Their Meanings

The following precautionary indications and symbols are used in this manual to aid in the safe usage of the NT-series Support Tool for Windows (Ver. 4.□). These precautions contain important safety information. Be sure to observe them carefully. The indications and symbols used herein, and their meanings, are as listed below.

**WARNING** Indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury. Additionally, there may be severe property damage.

**Caution** Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury, or property damage.

**Precautions for Safe Use**
Indicates actions that should be done, or avoided, for the safe use of this product.

**Precautions for Correct Use**
Indicates actions that should be done, or avoided, to prevent operating failure or malfunction of this product, or to prevent adverse effects on the performance or functions of this product.

**Note**
Notes within the text of this manual indicate safety–related points and information that are equivalent in importance to those included in the Precautions for Safe Use sections.

**Symbols**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="disassembly.png" alt="Disassembly Prohibition" /></td>
<td>Indicates prohibitions when there is a possibility of injury, such as from electric shock, as the result of disassembly.</td>
</tr>
<tr>
<td><img src="electrical.png" alt="Electrical Shock Caution" /></td>
<td>Indicates the possibility of electric shock under specific conditions.</td>
</tr>
<tr>
<td><img src="caution.png" alt="Caution" /></td>
<td>Indicates the possibility of injury by high temperature under specific conditions.</td>
</tr>
</tbody>
</table>

**WARNING** Failure to read and understand the information provided in this manual may result in personal injury or death, damage to the product, or product failure. Please read each section in its entirety and be sure you understand the information provided in the section and related sections before attempting any of the procedures or operations given.
# TABLE OF CONTENTS

## SECTION 1
**Introduction to the Support Tool** ........................................... 1
  1-1 What Is Support Tool? ................................................. 2
  1-2 Equipment Necessary for Using the Support Tool ......................... 6
  1-3 General Configuration of the Support Tool ................................ 7
  1-4 Basic Operation Flow .................................................. 21
  1-5 Menu Chart ............................................................. 22
  1-6 Usable Hardware Combinations ......................................... 26

## SECTION 2
**Setting Up the Support Tool** ........................................... 29
  2-1 Before Installing the Software .......................................... 30
  2-2 Installing the Support Tool ............................................ 31

## SECTION 3
**Support Tool Starting-up and Exiting Procedure and File Operation** ............. 37
  3-1 Starting-up and Exiting the Support Tool .............................. 38
  3-2 User Interface ....................................................... 40
  3-3 Operation of Screen Data (Application) File ............................ 45

## SECTION 4
**Application Manager** ................................................... 65
  4-1 What Is the Application Manager? ...................................... 66
  4-2 Operating the Application Manager .................................... 67

## SECTION 5
**Screen Types** ........................................................... 79
  5-1 Types of Screens, Common Dialog Box Settings and Operations ............ 80
  5-2 Standard Screen ........................................................ 90
  5-3 Continuous/Overlapping Screens ......................................... 91
  5-4 Window/Keyboard Screens ............................................... 94
  5-5 Extended Screen ....................................................... 99
  5-6 Occurrence History Screen ............................................. 100
  5-7 Frequency History Screen ............................................. 101
  5-8 Host Connect Screen (System Initializing Screen) ........................ 101
  5-9 Password Screen ...................................................... 102
  5-10 Menu Screen ............................................................ 103
  5-11 Print Format Screen .................................................. 103
  5-12 Programming Console Screen ......................................... 103
  5-13 Device Monitor Screen ................................................ 104
  5-14 Contrast and Brightness Adjustment .................................... 104
# TABLE OF CONTENTS

## SECTION 6
Element Operating Procedures ................................. 105
6-1 Common Operation ............................................. 107
6-2 Fixed Display .................................................. 138
6-3 Alarm .......................................................... 161
6-4 Data Input ...................................................... 173
6-5 Lamps .......................................................... 194
6-6 Numeral Display ............................................... 202
6-7 Character String Display ..................................... 206
6-8 Touch Switches ................................................ 209
6-9 Graphs .......................................................... 226
6-10 Registering Created Elements (Symbol Manager Operation) .............................................. 252
6-11 Recipe Screen Element ....................................... 261

## SECTION 7
Memory Table Setting .............................................. 267
7-1 Common Operation ............................................. 268
7-2 Numeral Memory Table ....................................... 277
7-3 Character String Memory Table (String Table) ............... 283
7-4 Bit Memory Table ............................................. 288
7-5 Extended I/O Input Table ..................................... 293
7-6 Extended I/O Output Table .................................... 297
7-7 I/O Comment Table .......................................... 298
7-8 F-Key Input Notify Table ..................................... 307
7-9 Mathematical Table .......................................... 308
7-10 Recipe Table ................................................ 313

## SECTION 8
Editing Graphic Data .............................................. 323
8-1 Image Editor ................................................... 324
8-2 Library Editor ................................................ 336
8-3 Mark Editor ................................................... 344

## SECTION 9
Example Screens .................................................. 351
9-1 Example Screen Configuration ............................... 352
9-2 Operation Flow .............................................. 357
9-3 Creating the Sample Data .................................... 360

## SECTION 10
Quick Reference .................................................. 407
10-1 Quick Reference ............................................. 408

## SECTION 11
Data Communications with a PT ................................ 429
11-1 Preparation for Data Communications with a PT and Data Communication Procedure .............................................. 430
11-2 Communication Setting at the Support Tool ................... 432
11-3 Sending (Downloading) the Data ............................ 433
11-4 Receiving (Uploading) Data .................................. 436
11-5 Receiving (Uploading) the History Record .................... 439
11-6 Setting and Reading the Date and Time ...................... 440
# TABLE OF CONTENTS

## SECTION 12
Making Reports .................................................. 443

  12-1 Report Types .............................................. 444
  12-2 Printing Reports .......................................... 451
  12-3 Displaying the Print Image (Preview) .................... 458
  12-4 Outputting the Screen Image ............................. 459

## Appendices

A Data Conversion ............................................... 463
B System Installer Operation .................................... 487
C NT Transfer Utility ............................................ 493
D Translation Support Utility ................................... 501
E Tables of Functions of PT Models ............................ 517
F Limits on Numbers of Elements ............................... 537
G New Functions of Support Tool Ver.4.1 ....................... 541
H New Functions of Support Tool Ver.4.6 ....................... 543
I New Functions of Support Tool Ver.4.7 ....................... 545
J New Functions of Support Tool Ver.4.8 ....................... 547
K Error Messages ................................................ 549
L Shortcut Keys .................................................. 555
M Connecting Cable Specifications ............................. 557
N Keycode Tables and Conversion Rule ......................... 559

## Index .......................................................... 569

## Revision History ............................................... 575
Organization of the Manual, and How to Use It:

The related manuals are listed below.

* The final digit of the manual number is the revision code.

For operating the Support Tool

- NT-series Support Tool for Windows Operation Manual (V061-E1-2): Details on the operating procedure, settings, etc., of the Support Tool can be displayed on the screen in the form of online help information. Normal operation can be carried out by following this help information.

When you are unsure of the operating procedure while using the Support Tool, or you need to check detailed settings, refer to this manual.

The explanations in this manual center on the Support Tool itself. It does not include detailed explanations on the operation of the PT. Therefore, refer to the following manuals also.

This manual also explains the operation of NT Transfer Utility which is exclusively used for downloading and uploading the screen data.

The NT-series Support Tool for Windows (Ver. 4.□) can be used with the latest direct access versions of the following PT models. Details are given in this manual.

NT11, NT11S, NT20, NT20S, NT21, NT30, NT30C, NT31, NT31C, NT600S, NT620S, NT620C, NT625C, NT631, NT631C

For information on PT functions, operations, and restrictions

- NT11 Programmable Terminal User’s Manual (V084-E1-□)
- NT11S Programmable Terminal User’s Manual (V029-E1-□)
- NT20 Programmable Terminal User’s Manual (V091-E1-□)
- NT20S Programmable Terminal Operation Manual (V020-E1-□)
- NT600S Programmable Terminal Operation Manual (V022-E1-□)
- NT30/NT30C Programmable Terminal Operation Manual (V034-E1-□)
- NT620S/NT620C/NT625C Programmable Terminal Operation Manual (V033-E1-□)
- NT21 Programmable Terminal Setup Manual (V068-E1-□)
- NT31/31C Programmable Terminal Setup Manual (V062-E1-□)
- NT631/631C Programmable Terminal Setup Manual (V063-E1-□)
- NT21/31/631 Programmable Terminal Reference Manual (V069-E1-□)

These manuals contain full descriptions of PT functions, operations, and restrictions.

For information on the functions and operations of the PC

- Operation manual for each PC
When you need information about the operations, functions, etc., of the PC, refer to the operation manual for the PC, advanced function unit, or communication unit being used.

Description of NT31, NT31C, NT631 and NT631C

There are two types of the NT31, NT31C, NT631, and NT631C, models with the suffix "-V/[C0106]" and models without the suffix "-V/[C0106]." In this manual, they are written as "NT31, NT31C, NT631 and NT631C" collectively when it is not necessary to classify them. However, they are written separately as "NT31, NT31C, NT631, and NT631C with -V/[C0106]" and "NT31, NT31C, NT631 and NT631C without -V/[C0106]" when it is necessary to classify them. (The system program version will be indicated as "NT31, NT31C, NT631 and NT631C with (System Ver. 3.1)," if required.)

The system programs of the NT31, NT31C, NT631, and NT631C with "-V2" or "-V3" (System Ver. 3.1/4.1) are supplied by NT-series Support Tool for Windows (Ver.4/[C0106]). System Ver. 4.1 is supported only by NT31, NT31C, and NT631C models with "-V3." It cannot be installed to upgrade the NT31, NT31C, NT631, or NT631C below "-V3." It is possible to upgrade NT31, NT31C, NT631 and NT631C models without "-V2" to System Ver. 3.1 by installing the new system. In this case, however, the functions indicated below cannot be used even though other functions can be used in the same way as the models with "-V2."

- 32-dot font

For details of 32-dot font, refer to Settings for text display in NO TAG Setting Properties. Note that smoothing is not performed for 32-dot font.

For details of font types, refer to Font Type in NO TAG Operation of Screen Data (Application) File and Appendix K.
SECTION 1
Introduction to the Support Tool

This section is designed for users to utilize the efficient usage of Support Tool. Discussed in this section are what you can do using the Support Tool and the specifications and functions of Support Tool.

1-1 What Is Support Tool? .................................................. 2
1-2 Equipment Necessary for Using the Support Tool ....................... 6
1-3 General Configuration of the Support Tool ................................ 7
  1-3-1 Outline of Screen Data ........................................... 7
  1-3-2 Correspondence to PC (PLC) Data ................................ 11
  1-3-3 Tables ............................................................. 15
  1-3-4 Types of Screens .................................................. 18
1-4 Basic Operation Flow .................................................... 21
1-5 Menu Chart ............................................................. 22
1-6 Usable Hardware Combinations ......................................... 26
  1-6-1 Applicable PT ....................................................... 26
  1-6-2 Communication Method for Each PT Model ......................... 27
1-1 What Is Support Tool?

The NT-series Support Tool for Windows (Ver. 4.□) (hereafter referred to as the Support Tool) is application software that runs on Windows 95, 98, NT4.0, 2000, or XP and was developed to create the screen data for programmable terminals (PTs).

Since the Support Tool has been developed to use the graphical interface and run under the operation environment of Windows, persons not familiar with the Support Tool can create the screen data of the programmable terminal without difficulties.

The Support Tool can create the screen data for the following models of PT.

NT11, NT11S, NT20/NT20S, NT30, NT30C, NT600S, NT620S, T620C/NT625C
NT21, NT31, NT31C, NT631, NT631C

The screen data created using the Support Tool consists of the objects shown in the following page.
What Is Support Tool?

Section 1-1

Product Configuration

The NT-series Support Tool for Windows (Ver. 4.) consists of the following software and data.

- Support Tool

<table>
<thead>
<tr>
<th>Model number</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT-ZJCAT1-EV4</td>
<td>For IBM PC/AT or compatible, media: CD-ROM</td>
</tr>
</tbody>
</table>

- Keyboard tenkey library
- Color palette symbols (Library of parts for filling with color models)
- System Installer (to replace PT system program)
- NT20 system program
- System program for NT31, NT31C, and NT631C with “-V3”
- Original NT30/620 system program
- NT Screen Data Transfer Utility
  This utility is for uploading and downloading PT data using mmi screen data files. Refer to Appendix C NT Transfer Utility for details.

- Samples
  Lamp/touch switch parts library
  This parts library contains the image library with lamps and touch switches incorporated into it as a mmi image data file. Refer to 3-3-7 Using Method of Parts Collection for details. (The folder containing the parts library list in the samples folder also contains HTML files with operating methods and a parts list.)

  Sample screen data
  This screen data is provided only as a sample. Operation may not be as expected when this data is transferred to a PT and used for communications with a PLC.

  Symbol manager ISO symbol data
  Refer to 6-10 Registering Created Elements (Symbol Manager Operation) for details.

Main Differences of V4.1

Following changes are made for NT-series Support Tool for Windows to improve operational efficiency and to support new functions added for NT31, NT31C, NT631 and NT631C with “-V2” or “-V3” (System Ver. 3.1 or 4.0). Refer to Appendix G New Functions of Support Tool Ver. 4.1.

NT31, NT31C, NT631, NT631C new system program support

System program for the NT31, NT31C, NT631, and NT631C has been upgraded to Ver. 3.1/Ver. 4.0, so the following functions are now supported. System program version 4.0 is used only with the NT31, NT31C, NT631, and NT631C. New system program is supplied with Support Tool Ver. 4.1.

- CS/CJ-series PC (PLC) memory area support
- Recipes
- Interlocks
- Mathematical table
What Is Support Tool?

- NT30/620-compatible mode
- Multiple line labels
- ON/OFF state labels
- Numeral display/string display labels
- Device monitor screens
- Contrast & brightness adjustment screens

Addition of NT Translation Support Utility

The Translation Support Utility is software that helps in translating a language to another supported language.

For details, refer to Appendix D NT Translation Support Utility.

I/O comments importing from TAB-delimited text file

For details, refer to 7-7-4 Importing I/O Comments from Tab-delimited Text Files.

Centering the Labels of Lamp and Touch Switches

Only horizontal direction could be centered in previous versions. In this version, the labels of lamp/touch switches can be centered in both vertical and horizontal directions.

For details, refer to 6-1-9 Centering the Label of Lamp and Touch Switch.

The Data input string in a string input function touch switch (Only for NT31/631)

The label was used for the input data string in previous versions. In this version, a different string from the label can be specified as the data input string.

For details, refer to 6-8-3 Character String Input Touch Switch.

Launch the system installer

It is possible to launch the system installer from [Connect]–[Launch System Installer] in the menu bar.

Addition of NT30/620 series system programs

The system programs for NT30/620 are included.

Main Differences of V4.6

NT21 New System Program Support

Starting with NTST-EV4.6, the NTST supports creating screen data for the NT21.
NT31-V2 (System Ver. 3.1) data and NT21 data can be converted for mutual compatibility.
NT20 data can be converted to NT21 data.
NTST-EV4.6 can transfer screen data to the NT21 in high-speed mode.
Refer to NT21/31/631 Reference Manual for details.

Pick I/O Comments from a CX-Server Database

I/O name in CX-Server data can be used as PT I/O comment.
When a PLC address is defined in the dialog, an I/O comment can be picked up from CX-Server PLC point data in a cdm file. The "Pick CX-Server point" button is enabled only when CX-Server is installed.
When the I/O comment table is edited, multiple I/O comment data can be picked up from CX-Server PLC point data in the cdm file. The "Import" button is enabled only when CX-Server is installed.
Each I/O name will be imported as a PT I/O comment within 16 characters.

**Property Dialog for Grouped Objects**

Grouped object attributes can be edited by double-clicking or right-clicking to display the properties for grouped objects. The properties show the tree the objects included in the group. Choose each object in the tree to edit the structure.

**Preview in Symbol Manager**

Registered symbols can be previewed on the symbol manager. Previous symbols can be previewed after they are copied onto the NTST-EV4.6 screen and copied back to symbol manager to create preview images. Or, those symbols can be reused without preview as they are.

**Copying Image/Library/Mark with contents**

When copying Image/Library/Mark objects, NTST-EV4.6 will copy them with contents and registered them in each table. If the same code is already used in the table, the NTST will display a dialog to show the next unused number as a substitute.

The functionality does not recursively apply to references in the Image/Library/Mark object. For example, when copying a library object that refers to library entry, and the content of the entry contains text with a mark reference, then the corresponding mark content will be ignored. It also does not apply to when screens are copied in Application Manager for pasting into a second instance of NTST.

**Main Differences of V4.7**

**NT11-V1 New System Program Support**

Starting with NTST-EV4.7, the NTST supports creating screen data for the NT11-V1.

NT11S data can be converted to NT11-V1 data.

Refer to *NT11 User’s Manual* for details.

**Supported Windows OS**

Starting with NTST-EV4.7, the NTST supports Windows Me, 2000 (Professional Edition), and XP (Pro/Home Edition).

**Automatically Adjusted Screen Size when Editing Starts**

In response to the high resolution of personal computers recently, the screen size is now automatically enlarged when editing screens.

**Main Differences of V4.8**

Support for the NT20 PTs has been added to version 4.8 of the NT-series Support Tool for Windows.

- The NT20 system program has been added.
- The system installer has been updated to support the NT20 system program.

### 1-2 Equipment Necessary for Using the Support Tool

The following indicates the equipment necessary for using the Support Tool.

**Hardware**

- Recommended CPU
  
  Pentium 100 MHz or faster CPU

- Personal Computer
  
  Use an IBM personal computer or 100% compatible.

- Recommended Memory
32 Mbytes minimum

- Free area in hard disk
  
  At least 52 Mbytes is required to install everything.

  The following options can be selected at installation:

  - Support Software: Approx. 23 Mbytes
  - System installer
    - Only system installer: Approx. 8 Mbytes
    - With support programs: Approx. 30 Mbytes
  - Samples (parts, parts list, etc.): Approx. 40 Mbytes

- CD-ROM drive
  
  At least one drive is required if the Support Tool is provided on CD-ROM.

- Display
  
  VGA compatible display

  When creating screen data for a PT that has a color display, a color display is required.

  When the resolution setting of desktop area is low (lower than \(640 \times 480\)), part of the window of Support Tool may stick out of the screen. In this case, change the resolution setting of desktop area to the higher one with the control panel property of Windows.

- Mouse
  
  Serial mouse or bus mouse

### Operating system

The NT-series Support Tool runs on Microsoft Windows 95, Microsoft Windows 98, and Microsoft Windows NT 4.0. Version 4.05 or higher of the NT-series Support Tool also runs on Microsoft Windows 2000 and Microsoft Windows XP.

Version 4.80 or higher of the NT-series Support Tool also runs on Microsoft Windows Vista and Microsoft Windows 7.

The NT-series Support Tool will not run on Windows 3.1.

Operation on a 64-bit OS or server OS is also not supported.

### Device necessary for transmitting screen data

- RS-232C cable

  For cable specifications, refer to *Appendix K Connecting Cable Specifications*.

### 1-3 General Configuration of the Support Tool

#### 1-3-1 Outline of Screen Data

The screen data of the Support Tool consists of multiple screens that are linked with each other.

Screens are managed by screen numbers. The range of usable screen numbers varies according to the type of the PT connected to the Support Tool.

The screen display is switched by pressing a touch switch or giving an instruction from the PC (PLC).
General Configuration of the Support Tool

<table>
<thead>
<tr>
<th>PT Model</th>
<th>Range of Screen Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT11/NT11S</td>
<td>1 to 25</td>
</tr>
<tr>
<td>NT20/NT20S</td>
<td>1 to 250, 256 to 500</td>
</tr>
<tr>
<td>NT600S</td>
<td>1 to 1000</td>
</tr>
<tr>
<td>NT30/NT30C/NT620S/NT620C/NT625C</td>
<td>1 to 1899, 1900 to 1979, 1980 to 1999, 2000</td>
</tr>
<tr>
<td>NT21</td>
<td>1 to 3999, 9000, 9001, 9002, 9020</td>
</tr>
<tr>
<td>NT31/NT31C/NT631/NT631C</td>
<td>1 to 3999, 9000, 9001, 9002, 9020 to 9023, 9030</td>
</tr>
</tbody>
</table>

On a screen, a variety of objects can be arranged as desired.

The following objects are used to create a screen.

**Display objects**

Display objects are drawn on a screen and do not have an input function.

Display objects are classified into two kinds: Objects that are always displayed in the same status, and those that change according to the status of the PT or the PC (PLC).

**Input objects**

Input objects are objects that allow input by operation at the PT. Touch switches and input fields for numerals and strings are examples of input objects.

**Objects having code numbers**

These objects are created using an exclusive editor.

They are registered with a code number so that they can be used in different positions and different screens.

- **Library data**
  
  A drawing created as a fixed display is registered as library data so that it can be used multiple positions and screens.

  The library editor is used to create library data.

- **Image data**
  
  Image data are objects used to display bit map data on the screen.

  An image editor or bit map editor (running on Windows 95, 98, NT 4.0, 2000, or XP) available on the market is used to create image data.

- **Marks**
  
  Marks are used to display special characters and symbols. These objects can be handled as characters.

  The mark editor is used to create marks.

**Registering created objects (symbol manager)**

The efficiency of use of created objects can be increased by reusing them in other screen data or by registering objects that will be used frequently.

The symbol manager is provided to register created objects.
### Objects that can be used

The table below shows that objects can be used with particular PT models.

<table>
<thead>
<tr>
<th>Objects</th>
<th>Display Object</th>
<th>NT11S/NT11</th>
<th>NT20/NT20S NT600S</th>
<th>NT30C/NT30C NT620C NT625C</th>
<th>NT21</th>
<th>NT31C/NT31C NT631C NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arc</td>
<td></td>
<td>–</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Circle</td>
<td></td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Sector</td>
<td></td>
<td>–</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Polyline</td>
<td></td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Polygon</td>
<td></td>
<td>–</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Rectangle</td>
<td></td>
<td>–</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Text</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Tiling</td>
<td>–</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Standard Lamp</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Image/Library Lamp</td>
<td></td>
<td>–</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Numeral Display</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>String Display</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Bar Graph</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Broken-line Graph</td>
<td></td>
<td>–</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Analogue Meter</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Trend Graph</td>
<td>–</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Alarm List</td>
<td>–</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Alarm History</td>
<td>–</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Recipe</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

●: Can be used.

Δ*1: Can be used only with models with “-V1” and above.

Δ*2: Only use is insertion into character strings.

Δ*3: Can be used only with models “-V2 (System Ver.3.1) and above.”
### General Configuration of the Support Tool

<table>
<thead>
<tr>
<th>Objects</th>
<th>Input Objects</th>
<th>Touch Switch</th>
<th>Numeral Input</th>
<th>String Input</th>
<th>Thumbwheel Switch</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>–</td>
<td>●</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Library Type Object</td>
<td>Image Display</td>
<td>–</td>
<td>●</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Library Type Object</td>
<td>Library Display</td>
<td>–</td>
<td>–</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Library Type Object</td>
<td>Mark</td>
<td>△^{*2}</td>
<td>△^{*2}</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

- ●: Can be used.
- △^{*1}: Can be used only with models with “-V1” and above.
- △^{*2}: Only use is insertion into character strings.
1-3-2 Correspondence to PC (PLC) Data

The following table shows objects that are capable of transmitting data with PC (PLC) to execute processing such as updating the screen display.

<table>
<thead>
<tr>
<th>Object</th>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Lamp</td>
<td>PC (PLC) (bit address)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PT (Numeral table)*1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PT (String table)*1</td>
<td></td>
</tr>
<tr>
<td>Image/Library Lamp</td>
<td>PC (PLC) (bit address)</td>
<td></td>
</tr>
<tr>
<td>Touch Switch</td>
<td>PC (PLC) (bit address for lamp)</td>
<td>Notify Bit (bit address)</td>
</tr>
<tr>
<td></td>
<td>(bit address for interlock) *1</td>
<td>Switch Screen</td>
</tr>
<tr>
<td></td>
<td>PC (PLC) (bit address for interlock) *1</td>
<td>Input key-Window/Keyboard</td>
</tr>
<tr>
<td></td>
<td>PT (Numeral table) *1</td>
<td>Window Move</td>
</tr>
<tr>
<td></td>
<td>PT (String table) *1</td>
<td>(Can be used only on Window Screen)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Copy Setting</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Numeral, String table)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input key - Control</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input key - String</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cursor Move</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Print Screen</td>
</tr>
<tr>
<td>Thumbwheel Switch</td>
<td>PC (PLC) (bit address for interlock) *1</td>
<td>PT (Numeral table)</td>
</tr>
<tr>
<td>Numeral Display</td>
<td>PT (Numeral table)</td>
<td></td>
</tr>
<tr>
<td>String Display</td>
<td>PT (String table)</td>
<td></td>
</tr>
<tr>
<td>Bar Graph</td>
<td>PT (Numeral table)</td>
<td></td>
</tr>
<tr>
<td>Analogue Meter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Broken-line Graph</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trend Graph</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Numeral Input</td>
<td>PC (PLC) (bit address for interlock) *1</td>
<td>PT (Numeral table)</td>
</tr>
<tr>
<td>String Input</td>
<td>PC (PLC) (bit address for interlock) *1</td>
<td>PT (String table)</td>
</tr>
<tr>
<td>Alarm History</td>
<td>PT (Bit Memory table)</td>
<td>PT (Alarm History)</td>
</tr>
<tr>
<td>Alarm List</td>
<td>PT (Bit Memory table)</td>
<td>String Display</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Image/Library Display</td>
</tr>
<tr>
<td>Recipe Object</td>
<td>PC (PLC) (Word address)</td>
<td>PC (PLC) (Word address)</td>
</tr>
</tbody>
</table>

*1: For the NT21 and the NT31, NT31C, NT631, and NT631C with “-V2” or “-V3,” only for numeral display or string display for labels.

*2: For the NT21 and the NT31, NT31C, NT631, and NT631C with “-V2” or “-V3,” only when using the interlock function.

Operation of changing display objects

- Lamp display

  The lamp is turned ON (OFF) when the specified PC (PLC) bit goes ON (OFF).
• Touch switch – Notify Bit
The specified PC (PLC) bit goes ON (OFF) when the switch area is pressed.

• Touch switch – Switch Screen
The display screen is switched to another when the switch area is pressed.

• Touch switch – Input Key - Window/Keyboard
A window (Keyboard Screen) pops up in the screen when the switch area is pressed.

• Touch switch – Window Move
The window is moved by touch panel operation when the switch area is pressed.

• Touch switch – Input key - Control
When the switch area is pressed, the processing assigned to the specified control code is executed.
• Touch switch – Input Key - String

When the switch area is pressed, the characters of the label set for the switch are displayed in the string input field and stored in the string table.

• Touch switch – Copy Setting

When the switch area is pressed, data is copied. The following types of copying can be designated.

- Data in Numeral table → Numeral table
- Data in Numeral table → Numeral Input field
- Data in String table → String table
- Data in String table → String Input field
- Constant → Numeral table
- Constant → Numeral Input field

• Touch switch – Cursor Move

The cursor moves from Numeral Input to Numeral Input fields when the switch area is pressed.

• Touch switch – Print Screen

A hard copy of the screen will be printed when the switch area is pressed.
• Numeral display

The data in a Numeral table will be displayed.

• String display

The string display object displays the data in a string entry.

• Graph display

The graph display object displays the data in a numeral table entry.

• Data Input – numeral input and string input

These input objects write data into a table.

Numeral Input field → Numeral Table
String Input field → String Table

• Data Input – Thumbwheel switch

The Thumbwheel Switch object stores the numeric values to a numeral table entry through transaction of Thumbwheel Switch.
• Data Input – Recipe

The recipe object reads/writes numeric values that were set using NTST from/to the PC (PLC) when the write/read touch switch is pressed.

![Screen diagram]

• Alarm

When a bit in a bit memory table is ON (OFF), the object displays the data in a string table entry and stores it in the alarm history.

When the displayed data of the string table is touched, the object displays image/library data, switches the screen to the specified screen.

Reference: If an “Indirect Reference” is used with image/library data, data to be displayed can be changed according to the change in the contents of numeral table. (The NT21 and NT31, NT31C, NT631, NT631C with System Ver. 2.1 and above only.)

Reference: The NT31, NT31C, NT631, and NT631C with “-V2” or “-V3” provide an interlock function that can be used to enable/disable operations or inputs using touch switches, numeral inputs, string inputs, or thumbwheel switch based on the status of specific bits in the PLC.

1-3-3 Tables

Tables are areas secured in the PT to store data such as numeral data and character string data. They are used to share data for the functions assigned to objects and communicate with a PC (PLC).

If a word address of a PC (PLC) is set in a table, data communication processing between the PT and PC (PLC) is executed automatically in predetermined cycles.

The following types of tables are provided.

• Numeral table
• String table
• Bit memory table
• Extended I/O Input table
• Extended I/O Output table
• I/O Comment table
- F-key Input Notify table
- Mathematical table
- Recipe Table

The number of memory table entries varies according to the model of PT connected.

<table>
<thead>
<tr>
<th></th>
<th>NT11S/NT11</th>
<th>NT20/NT20S</th>
<th>NT600S NT30/NT30C</th>
<th>NT620S NT620C/NT625C</th>
<th>NT21 NT31/NT31C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeral table</td>
<td>128</td>
<td>128</td>
<td>512</td>
<td>512 or 1000</td>
<td>512, 1000, or 2000</td>
</tr>
<tr>
<td>String table</td>
<td>128</td>
<td>128</td>
<td>256</td>
<td>256 or 1000</td>
<td>256, 1000 or 2000</td>
</tr>
<tr>
<td>Bit Memory table</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>256</td>
<td>256 or 1000</td>
</tr>
<tr>
<td>Extended I/O Input</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>64</td>
<td>–</td>
</tr>
<tr>
<td>Extended I/O Output</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>64</td>
<td>–</td>
</tr>
<tr>
<td>F-key Input Notify</td>
<td>4</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Mathematical table</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>256</td>
</tr>
<tr>
<td>Recipe table</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>200</td>
</tr>
</tbody>
</table>

*1: This option is available only for V2 and above.
*2: This option is available only for V2 (System Ver.3.1) and above.

**Numeral Table**

The Numeral table stores numeral data.

This table is set when using Numeral Display objects, Graph objects, and Numeral Data Input.

For details of table setting, refer to 7-2 Numeral Memory Table.

**String Table**

The String table stores text data.

This table is set when String Display object and String Input object are used.

For details of table setting, refer to 7-3 Character String Memory Table (String Table).

**Bit Memory Table**

The Bit Memory table stores status of a PC (PLC) memory bit.

This table is set when using the alarm list/history function.
It is also used when switching the screen by the operation at the PC (PLC).

For details of table setting, refer to 7-4 Bit Memory Table.

**Extended I/O Input Table**

The Extended I/O Input table sets the usage of input terminals of an extended I/O unit (e.g., B7A Unit).

For the individual input terminals, a function is set or a PC (PLC) bit to be referenced is allocated.

For details of table setting, refer to 7-5 Extended I/O Input Table.

**Extended I/O Output Table**

The Extended I/O Output table is used to allocate the PC (PLC) bits that control the output terminals of an extended I/O unit.

The output terminals of the extended I/O unit are controlled according to the statuses (ON/OFF) of PC (PLC) bits.

For details of table setting, refer to 7-5 Extended I/O Output Table.

**I/O Comment Table**

The I/O Comment Table is an area provided in a PT to manage the comment data of all words and bits in the PC (PLC) that are set by the Support Tool.

It displays comments on PC (PLC) words and bits specified by the numeral memory table, character string memory table (string table), bit memory table, extended I/O input table, extended I/O output table, and elements, in list form.

The displayed comments can be edited. For details, refer to 7-7 I/O Comment Table.

**F-Key Input Notify Table**

The F-Key Input Notify table assigns to a function key in a PT device. Host bits are allocated to the function keys. By switching the function key ON and OFF, the corresponding bit is turned ON and OFF. For details of table setting, refer to 7-8 F-Key Input Notify Table.

**Mathematical Table**

Mathematical functions can be formed through this table and associated to any numeral table entry/PLC address location. For details refer to 7-9 Mathematical Table.

**Recipe Table**

The Recipe Table will set the parameters of designated memory areas of the address. For details refer to 7-10 Recipe Table.
1-3-4 Types of Screens

A PT displays two types of screens — user screens that are created by arranging objects as desired and system screens for which a specific function is preset.

The types of screens displayed on a PT, and screen numbers assigned to the each screen are shown below.

<table>
<thead>
<tr>
<th>Screen Types</th>
<th>NT11S/NT11</th>
<th>NT20/NT20S</th>
<th>NT600S</th>
<th>NT30/NT30C</th>
<th>NT620S/NT620C</th>
<th>NT625C</th>
<th>NT21/NT21C</th>
<th>NT31/NT31C</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Screens</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard screens</td>
<td>1 to 250</td>
<td>1 to 250</td>
<td>1 to 1000</td>
<td>1 to 1899</td>
<td>1 to 1899, 2000</td>
<td>1 to 3999</td>
<td>1 to 3999</td>
<td>1 to 3999</td>
</tr>
<tr>
<td>Overlapping screens</td>
<td>–</td>
<td>–</td>
<td>1 to 1000</td>
<td>1 to 1899</td>
<td>1 to 1899, 2000</td>
<td>1 to 3999</td>
<td>1 to 3999</td>
<td>1 to 3999</td>
</tr>
<tr>
<td>Continuous screens</td>
<td>–</td>
<td>–</td>
<td>1 to 1000</td>
<td>1 to 1899</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Window/Keyboard screens</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>1900 to 1979</td>
<td>1 to 3999</td>
<td>1 to 3999</td>
<td>1 to 3999</td>
</tr>
<tr>
<td>Host connect screens</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>1999</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>System initializing screens</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>9000</td>
<td>9000</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Password screens</td>
<td>1 to 250</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Menu screens</td>
<td>1 to 250</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Print format screens</td>
<td>255</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>System Screens</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen display OFF</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Extended screens</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>1980 to 1996</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Occurrence history screens</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>1997</td>
<td>9001</td>
<td>9001</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Frequency history screens</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>1998</td>
<td>9002</td>
<td>9002</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Programming Console screens</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>9020</td>
<td>9020</td>
</tr>
<tr>
<td>Device monitor screens</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>9021 to 9023</td>
<td>9023</td>
</tr>
<tr>
<td>Return to the previous screen</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>9999</td>
<td>9999</td>
<td>–</td>
<td>–</td>
</tr>
</tbody>
</table>

*1: Available only from the system menu. A screen number is not assigned.
*2: Only with V2 and above.

**Standard screens**

Standard screens are the fundamental screens of the PT. Specify a Standard Screen to create a screen.
Overlapping screens

Overlapping screens are grouped screens; a maximum of eight screens can be overlapped to display information on one screen. The screen used as the base for the overlapping screens is called the Parent Screen and the multiple standard screens that configure the overlapping screen are called Child Screens.

When screen No. 8 (parent screen) is specified, objects set on the individual child screens (screens No. 10, No. 7, No. 25) are displayed in this order.

Since screen No. 8 is set as an overlapping screen, it cannot be displayed independently. Note that a child screen can be displayed independently.

Continuous screens

Continuous screens are grouped screen: a maximum of eight screens can be displayed in series. The base screen where continuous screens are registered is called the Parent Screen and the registered screens are called Child Screens.

When screen No. 10 is specified, screen No. 20 – which is the first of the continuous screens – is displayed. After that, screens are displayed in the order of screen No. 20, screen No. 15, and screen No. 1 by the operation of touch switch \([ \downarrow ]\).

Since screen No. 10 is set for a continuous screen, it cannot be displayed independently.

Continuous screens are switched by pressing touch switches \([ \downarrow ]\) and \([ \uparrow ]\), to which system keypad is assigned.

Continuous screens cannot be used for the NT21, NT31/NT31C, and NT631/NT631C. For these models, Switch Screen function of touch switch is recommended to obtain the identical function.

Window/Keyboard Screen

Window/Keyboard Screen is used as a window screen. This is a partial screen used to display a keyboard such as a keypad for inputting numeral/string or an operational help etc. overlapping a display screen.

For NT30, NT30C, NT620S, NT620C, and NT625C, this screen can also be used as a standard screen if it is not used as a keyboard screen. (For NT21,
NT31, NT31C, NT631, and NT631C, a keyboard screen cannot be displayed independently.)

With the NT21 and with the NT31, NT31C, NT631 and NT631C with “-V1” and above, all objects other than thumbwheel SW can be registered. With other models, only fixed display, and touch switch used to input numeral/string and temporary input field can be registered. (This type of window is called a Keyboard Screen.)

With the NT21 and with the NT31, NT31C, and NT631C with “-V1” and above, up to 3 window/keyboard screens can be opened at the same time. (With other models, only 1 window/keyboard can be opened.) For details, refer to 5-4 Window/Keyboard Screens.

Host connect screen (System initializing screen)

This screen is displayed at the start of PT operation until the connection to a PC (PLC) is completed.

If a Host Connect screen is not registered, the default screen that shows the host connection message is automatically displayed when the PT power is switched on or when the PT mode transfers to the run mode.

Display OFF screen (no-display screen)

This screen is used when nothing is to be displayed on the screen. Since this screen is reserved by the system as a Display OFF screen, it cannot be edited.

Extended screen

Screens reserved for future extension of PT functions. Screens should not be registered to the screen numbers of these reserve screens.

Occurrence history screen

An occurrence history screen displays the numbers of screens displayed by Switch screen operations in the order of occurrence.

Frequency history screen

A frequency history screen displays the numbers of screens displayed by Switch screen operations in the order of frequency.

Password screen

This screen exists for the secure protection of a designated screen so that users can switch the screen only when the accurate password is input.

Menu screen

Menu screen serves as a control screen to switch to a designated screen through the operation of numeric key.

Print Format screen

If this screen is assigned, printing can be done by simple operation.

Programming Console Screen

This screen can be used to execute Programming Console functions with the NT21, NT31, NT31C, NT631, and NT631C. User editing of this screen is not possible. Refer to 5-12 Programming Console Screen for details.

Device Monitor Screen

This screen can be used to execute device monitoring functions with the NT31, NT31C, NT631, and NT631C with “-V2” or higher. User editing of this screen is not possible. Refer to 5-13 Device Monitor Screen for details.
1-4 Basic Operation Flow

The procedure for creating a screen using the Support Tool is shown below.

⚠️ CAUTION

Carefully check the operation of all screen data and host programs before using them. If incorrect, the system may operate unpredictably. Otherwise, the system may operate unpredictably.
1-5  Menu Chart

The pull down menu commands provided by the Support Tool and the function of each menu item are shown below.

### File
- New ............................ Creating new screen data
- Open ............................ Reading created screen data
- Close ............................ Ending creation of screen data
- Save ............................ Saving screen data being created to a file
- Save As .......................... Registering screen data being created under a new file name
- Import Component ............ Importing data from different screen data file
- Import ............................ Reading the data created by DOS version Support Tool
- Print ............................... Printing screen data
- Print Preview .................... Displaying print format of screen data
- Print Setup ....................... Setting the printer
- Recent File(s) .................... Recently used files
- Exit ............................... Exiting the Support Tool

### Edit
- Undo ............................... Canceling the last operation
- Redo ............................... Returning the screen status to the status before Undo
- Cut ................................. Cutting an object (to the clip board)
- Copy ............................... Copying an object (to the clip board)
- Paste ............................... Pasting an object (from the clip board)
- Align
  - Align Top ......................... Aligning objects to the top
  - Align Bottom .................... Aligning objects to the bottom
  - Align Left ....................... Aligning objects to the left
  - Align Right ..................... Aligning objects to the right
  - Center in a Row ................ Aligning objects to vertically center
  - Center in a Column ............ Aligning objects to horizontally center
- Delete ............................ Deleting an object
- Select All ........................ Specifying objects collectively
- Edit Object ........................ Specifying editing an object
- Select Object .................... Selecting an object
### Menu Chart

#### View
- **Full Tiling**
  - Switching tiling display for object to be tiled
- **Show Tag**
  - **PC (PLC) Address**
    - Changing over the display to one with word numbers
  - **Table No.**
    - Changing over the display to one with table entry numbers
  - **Image and Library Code**
    - Changing over the display to one with code numbers
- **Show Local 1 (keyboard)**
  - Displaying/not displaying local window 1 (keyboard screen)
  - **Local 2**
    - Displaying/not displaying local window 2
- **Refresh**
  - Redrawing the current screen
- **Toolbars**
  - **Standard Bar**
    - Displaying/not displaying standard tool bar
  - **Draw Bar**
    - Displaying/not displaying drawing tool bar
  - **Utility Bar**
    - Displaying/not displaying utility bar
  - **Alignment Bar**
    - Displaying/not displaying alignment bar
- **Status Bar**
  - Displaying/not displaying status bar
- **Full Screen**
  - Changing over entire screen display
- **Zoom**
  - **100%**
    - Changing display enlargement scale (100%)
  - **200%**
    - Changing display enlargement scale (200%)
  - **400%**
    - Changing display enlargement scale (400%)
  - **800%**
    - Changing display enlargement scale (800%)
- **Error Log**
  - Displaying the error log
- **Simulate Flash**
  - Displaying flash status of an object
- **Simulate ON/OFF**
  - Displaying lamp ON/OFF status

#### Draw
- **Selector**
  - Selecting object
- **Group**
  - Grouping objects
- **Ungroup**
  - Ungrouping objects
- **Bring to Front**
  - Bringing object to the front
- **Send to Back**
  - Sending object to the back
- **Associate with**
  - Associating touch switch with object
- **Disassociate**
  - Canceling association of touch switch with object
- **Set Order**
  - Specifying moving order among numeral/character-string input fields
- **Properties**
  - Setting attributes of selected object
- **Use as Default**
  - Registering the status of the selected object as the default for the object
- **Centralize Label**
  - Centralizing label of lamp/touch switch
Objects

<table>
<thead>
<tr>
<th>Display</th>
<th>Text</th>
<th>Specifying text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Circle</td>
<td>Specifying a circle</td>
</tr>
<tr>
<td></td>
<td>Arc</td>
<td>Specifying an arc</td>
</tr>
<tr>
<td></td>
<td>Sector</td>
<td>Specifying a sector</td>
</tr>
<tr>
<td></td>
<td>Polyline</td>
<td>Specifying a polyline</td>
</tr>
<tr>
<td></td>
<td>Polygon</td>
<td>Specifying a polygon</td>
</tr>
<tr>
<td></td>
<td>Rectangle</td>
<td>Specifying a rectangle</td>
</tr>
<tr>
<td></td>
<td>Tiling</td>
<td>Specifying tiling</td>
</tr>
<tr>
<td></td>
<td>Image Display</td>
<td>Specifying image data display</td>
</tr>
<tr>
<td></td>
<td>Library Display</td>
<td>Specifying library data display</td>
</tr>
<tr>
<td></td>
<td>Mark</td>
<td>Specifying a mark</td>
</tr>
</tbody>
</table>

Touch Switch

| Specifying a touch switch |

Lamp

<table>
<thead>
<tr>
<th>Standard</th>
<th>Specifying a standard lamp</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Image</td>
</tr>
</tbody>
</table>

Data Input

<table>
<thead>
<tr>
<th>Numeral</th>
<th>Specifying a numeral setting input field</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>String</td>
</tr>
<tr>
<td></td>
<td>Thumbwheel Switch</td>
</tr>
<tr>
<td></td>
<td>Recipe</td>
</tr>
</tbody>
</table>

Numeral Display

| Specifying a numeral display |

String Display

| Specifying a character-string display |

Graph

<table>
<thead>
<tr>
<th>Bar Graph</th>
<th>Specifying a bar graph</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analogue Meter</td>
<td>Specifying an analogue meter</td>
</tr>
<tr>
<td>Broken-line Graph</td>
<td>Specifying a broken-line graph</td>
</tr>
<tr>
<td>Trend Graph</td>
<td>Specifying a trend graph</td>
</tr>
</tbody>
</table>

Alarm

<table>
<thead>
<tr>
<th>List</th>
<th>Specifying alarm list</th>
</tr>
</thead>
<tbody>
<tr>
<td>History</td>
<td>Specifying alarm history</td>
</tr>
</tbody>
</table>

Screen

<table>
<thead>
<tr>
<th>New</th>
<th>Adding a new screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Deleting a screen</td>
</tr>
<tr>
<td>Modify Parent</td>
<td>Setting continuous/overlapping screens</td>
</tr>
<tr>
<td>Copy to Image</td>
<td>Saving screen data in image (BMP format) file</td>
</tr>
<tr>
<td>Extended I/O</td>
<td>Setting an extended I/O table (setting a table common to all screens)</td>
</tr>
<tr>
<td>Grid</td>
<td>Setting grid</td>
</tr>
<tr>
<td>Properties</td>
<td>Setting screen attributes</td>
</tr>
</tbody>
</table>
Tools
- Table ................. Setting memory tables
- Image Editor ........ Editing image
- Library Editor ........ Editing library
- Mark Editor ........ Editing marks
- Mathematical Table .... Editing mathematical functions
- Recipe Table ........ Setting recipe data
- Import I/O comments ... Importing I/O comments from ladder program
- Change Address ........ Changing PC (PLC) addresses set for objects and memory tables collectively
- Validate ............... Checking errors
- PT Configuration ....... Setting PT type, system settings, PT Status Control Area/PT Status Notify Area settings, changing PT type (data conversion)

Connect
- Comms. Setting ........ Setting methods for communicating with the PT
  - Download (Support Tool to PT)
    - Application ........ Sending (downloading) all screen data to the PT
    - Screen ............... Sending (downloading) screen data to the PT in units of screens
    - Direct Access Information .... Sending (downloading) direct connection setting data to the PT
    - System Memory ........ Sending (downloading) system memory data to the PT
    - Table ................ Sending (downloading) memory table data to the PT
  - Upload (PT to Support Tool)
    - Application ........ Reading (uploading) all screen data from the PT
    - Screen ............... Reading (uploading) screen data to the PT in units from the screen
    - Direct Access Information .... Reading (uploading) direct connection setting data from the PT
    - System Memory ........ Reading (uploading) system memory data to the PT
    - Table ................ Reading (uploading) memory table data to the PT
- Get History Log
  - Screen History .......... Reading (uploading) screen history data from the PT
  - Alarm History .......... Reading (uploading) alarm history data from the PT
- Date and Time ........... Reading/setting (uploading/downloading) clock data in the PT

Window
- New Window ............ Opening another window on the same screen
- Cascade ............... Displaying cascaded windows
- Tile ................... Displaying tiled windows
- Arrange Icons .......... Arranging icons
- Symbol Manager ........ Starting symbol manager
  (Opened Window) .......... Selecting window
## 1-6 Usable Hardware Combinations

The combinations of hardware that can be used are shown below. The table shows the basic combinations. Depending on the PT display method and system configuration, they may not be usable.

### 1-6-1 Applicable PT

NT-series Support Tool for Windows (Ver. 4.□) can create screen data for the following PT models.

<table>
<thead>
<tr>
<th>PT Model</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT11S</td>
<td>NT11S-SF121□</td>
</tr>
<tr>
<td>NT11</td>
<td>NT11-SF121□-EV1</td>
</tr>
<tr>
<td>NT20</td>
<td>NT20-ST121□</td>
</tr>
<tr>
<td>NT20S*1</td>
<td>NT20S-ST121□-V1</td>
</tr>
<tr>
<td></td>
<td>NT20S-ST122□-V1</td>
</tr>
<tr>
<td>NT30</td>
<td>NT30-ST131□-E</td>
</tr>
<tr>
<td>NT30C</td>
<td>NT30C-ST141□-E</td>
</tr>
<tr>
<td>NT600S*1</td>
<td>NT600S-ST121□-V1</td>
</tr>
<tr>
<td></td>
<td>NT600S-ST211□-V1</td>
</tr>
<tr>
<td>NT620S</td>
<td>NT620S-ST211□-E</td>
</tr>
<tr>
<td>NT620C</td>
<td>NT620C-ST141□-E</td>
</tr>
<tr>
<td>NT625C</td>
<td>NT625C-ST152□</td>
</tr>
<tr>
<td>NT21</td>
<td>NT21-ST121□-E</td>
</tr>
<tr>
<td>NT31</td>
<td>NT31-ST121□-E</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>NT31C</td>
<td>NT31C-ST141□-E</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>NT631</td>
<td>NT631-ST211□-E</td>
</tr>
<tr>
<td>NT631C</td>
<td>NT631C-ST141□-E</td>
</tr>
<tr>
<td></td>
<td>NT631C-ST151□-E</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1: NT20S and NT600S have direct access Ver.4 and Ver.5. NT-series Support Tool for Windows supports only Ver.5.

**Reference:** Direct access version 4 screen data for the NT20S or NT600S can be used on Windows by using version 5 of the Support Tool for Windows.
1-6-2 Communication Method for Each PT Model

Usable communication method differs depending on the PT types.

Also, some PT can use communication method that is not supported in their initial state by installing the exclusive system programs. (For details, refer to Appendix B System Installer Operation.)

<table>
<thead>
<tr>
<th>PT Model</th>
<th>Model</th>
<th>Communication Method</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Host Link</td>
<td>NT Link (1:1,1:N)</td>
</tr>
<tr>
<td>NT11S</td>
<td></td>
<td>○</td>
</tr>
<tr>
<td>NT11</td>
<td>NT11-SF121</td>
<td>○ (1:1 only)</td>
</tr>
<tr>
<td>NT20</td>
<td>NT20-ST121</td>
<td>○</td>
</tr>
<tr>
<td>NT20S</td>
<td>NT20S-ST121</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NT20S-ST121-V1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NT20S-ST121-EV3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NT20S-ST122-V1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NT20S-ST161-EV3</td>
</tr>
<tr>
<td>NT30</td>
<td>NT30-ST131</td>
<td>○</td>
</tr>
<tr>
<td>NT30C</td>
<td>NT30C-ST141</td>
<td>○</td>
</tr>
<tr>
<td>NT600S</td>
<td>NT600S-ST121</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NT600S-ST121-EV3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NT600S-ST211-V1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NT600S-ST211-EV3</td>
</tr>
<tr>
<td>NT620S</td>
<td>NT620S-ST211</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NT620S-ST212-E</td>
</tr>
<tr>
<td>NT620C</td>
<td>NT620C-ST141</td>
<td>○</td>
</tr>
<tr>
<td>NT625C</td>
<td>NT625C-ST152</td>
<td>○</td>
</tr>
<tr>
<td>PT Model</td>
<td>Model</td>
<td>Communication Method</td>
</tr>
<tr>
<td>----------</td>
<td>------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Host Link</td>
</tr>
<tr>
<td>NT21</td>
<td>NT21-ST121□-E</td>
<td>○ ○</td>
</tr>
<tr>
<td>NT31</td>
<td>NT31-ST121□-E</td>
<td>○ ○</td>
</tr>
<tr>
<td></td>
<td>NT31-ST121□-EV1</td>
<td>○ ○</td>
</tr>
<tr>
<td></td>
<td>NT31-ST121/122□-EV2</td>
<td>○ ○</td>
</tr>
<tr>
<td></td>
<td>NT31-ST123□-EV3</td>
<td>○ ○</td>
</tr>
<tr>
<td>NT31C</td>
<td>NT31C-ST141□-E</td>
<td>○ ○</td>
</tr>
<tr>
<td></td>
<td>NT31C-ST141□-EV1</td>
<td>○ ○</td>
</tr>
<tr>
<td></td>
<td>NT31C-ST141/142□-EV2</td>
<td>○ ○</td>
</tr>
<tr>
<td></td>
<td>NT31C-ST143□-EV3</td>
<td>○ ○</td>
</tr>
<tr>
<td>NT631</td>
<td>NT631-ST211□-E</td>
<td>○ ○</td>
</tr>
<tr>
<td></td>
<td>NT631-ST211□-EV1</td>
<td>○ ○</td>
</tr>
<tr>
<td></td>
<td>NT631-ST211□-EV2</td>
<td>○ ○</td>
</tr>
<tr>
<td>NT631C</td>
<td>NT631C-ST141□-E</td>
<td>○ ○</td>
</tr>
<tr>
<td></td>
<td>NT631C-ST141□-EV1</td>
<td>○ ○</td>
</tr>
<tr>
<td></td>
<td>NT631C-ST141□-EV2</td>
<td>○ ○</td>
</tr>
<tr>
<td></td>
<td>NT631C-ST151□-E</td>
<td>○ ○</td>
</tr>
<tr>
<td></td>
<td>NT631C-ST151□-EV1</td>
<td>○ ○</td>
</tr>
<tr>
<td></td>
<td>NT631C-ST151/152□-EV2</td>
<td>○ ○</td>
</tr>
<tr>
<td></td>
<td>NT631C-ST153□-EV3</td>
<td>○ ○</td>
</tr>
</tbody>
</table>

○: Usable in the default state.
△: Exclusive system program should be installed.
▲: Exclusive communication I/F unit is needed. (C200H I/F unit: NT-LB122)
×: Not usable

**Note** Communication methods are indicated in the table above using the following abbreviations:

C200H: C200H I/F
SECTION 2
Setting Up the Support Tool

When you are going to use the Support Tool for the first time, the Support Tool software must be installed at your personal computer.

The Support Tool is an application software that runs on Windows 95, 98, NT4.0, 2000, or XP of Microsoft Corporation. The procedure described in the following pages assumes that your personal computer already has Windows installed.

2-1 Before Installing the Software ............................................................. 30
2-2 Installing the Support Tool ............................................................... 31
   2-2-1 Basic Installation Operation ......................................................... 31
   2-2-2 Procedure ..................................................................................... 31
   2-2-3 Uninstall ...................................................................................... 36
   2-2-4 Using the Help File on Windows Vista or Windows 7 ...................... 36
2-1 Before Installing the Software

The Support Tool comes with the following program data.

<table>
<thead>
<tr>
<th>Type</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT-ZJCAT1-EV4</td>
<td>For IBM PC/AT compatibles, media: CD-ROM</td>
</tr>
</tbody>
</table>

- Support Tool
- Supplement Symbols (keyboard/keypad collection)
- Color Palette Symbol (Tilling collection for color-type PT)
- System installer (for replacing the PT system program)
- NT20 system program
- System program for NT31/NT31C/NT631C with “-V3”
- System programs for NT31/NT31C with “-V2” (Ver. 3.1)
- System programs for NT631/NT631C with “-V2” (Ver. 3.1)
- System programs for NT21
- System program for NT11S
- System program for NT11-V1
- System programs for NT30/620 Series

The following software should be installed separately.

- NT Transfer Utility
  This utility uploads/downloads screen data file from/to PT using MMI format. For details, refer to Appendix C NT Transfer Utility.

- NT Translation Support Utility
  This utility will help in translating the language to another supported language. For details, refer to Appendix D Translation Support Utility

The following data is copied to the folder if it is selected when installation.

- Parts Collection
  Lamps and touch switches combined with image/library data are registered in the Parts Collection (This is a screen data file in MMI format). For details, refer to 3-3-7 Using Method of Parts Collection.

- Sample Screen Data
  This data is provided just as sample screen data. It is not created for the purpose of actual operation on PT after downloading it to PT.

- Symbol manager – ISO symbol data
  For details, refer to 6-10 Registering Created Elements (Symbol Manager Operation).

Reference:
- The system installer is an application software that sends the system program from a personal computer to PT to update the system program. Updating the system program allows communication using a new method or upgrades the PT software. However, since the system program is specific to each PT model, the system program that matches the PT model must be downloaded.
2-2 Installing the Support Tool

To install the Support Tool, execute the install program provided in your software package.

Reference: The following data is selectable for installation.

- NT-series Support Tool Ver. 4.
- System Installer
- Sample Collection

If you select a Sample Collection, data such as Parts Collection, Image/Library Sample Collection, ISO symbol data, and Sample Screen Data are installed.

- NT Transfer Utility should be installed separately. Please refer to Appendix C NT Transfer Utility.
- NT Translation Support Utility should be installed separately. Refer to Appendix D Translation Support Utility.
- Data can be added afterward by executing the installation program again. In this case, when an item that is already installed is specified, it will not be overwritten. Also, the data will not be uninstalled even if its check mark was set to OFF when the data is already installed.

To delete data that has already been installed, delete all data by uninstalling it and then perform installation again.

2-2-1 Basic Installation Operation

The buttons that are displayed during the course of installation are shown below.

- Clicking on this button confirms the settings in the displayed window and displays the next window.
- Clicking on this button cancels the settings in the displayed window and displays the previous window.
- Clicking on this button causes the window to close. The status set in the window is canceled.
- This button stops Support Tool installation if it is clicked at the program install window. In this case, a message is displayed requesting confirmation that installation is to be stopped.
- Clicking on this button displays the actual folder configuration in tree form. You can select the folder in this display to install the Support Tool.

2-2-2 Procedure

The following procedure uses Support Tool version 4.8 as an example.

1. Start up Windows.
   When using Windows 2000, Windows XP, Windows Vista, or Windows 7, log in with a user ID in the administrators group.

2. Set the Support Tool CD-ROM in the CD-ROM drive. The setup program automatically starts. Follow step 6 onward. If the setup program does not start automatically, execute the setup program according to the steps shown below.
Reference: You can execute the setup program by double clicking Setup.exe in the Support Tool system disk by displaying Windows Explorer. In this case, steps 3, 4, and 5 below can be skipped.

3. Click on the Start button of Windows and select “Run ...”

4. Input “d:\FD_Version\ Disk1\ Setup.exe” in the input field in the displayed window.

   Note that drive designation must agree with the name of the drive where you set the CD-ROM. If you set the CD-ROM in drive E, input “e:\FD-Version\ Disk1\ Setup.exe.”

5. Click on Finish.

   The installation is started.

6. When the setup screen of the Support Tool is displayed, click the Next button.

   The screen to prompt you to input User Information (Name and Company) is displayed.
7. Input your name and company. In the initial state, the name and company that are registered for the computer are displayed.

After inputting, click the **Next** Button.

The screen for specifying the destination of program installation is displayed.

8. Select the directory for installation.

In the initial state, the directory shown below is set as the destination directory.

C:\Program Files\Omron\NTST4.8E

To change the directory, click the **Browse** Button and input the drive and directory. (If a directory that does not exist in the hard disk is specified, the directory is automatically made.)

After specifying the destination, click the **Next** Button.
Installing the Support Tool

The program selection screen is displayed to allow you to select the programs to be installed.

9. Click on the check box, displayed to the left of the program to be selected to enter a check mark.

The following data and software will be installed depending on the options that are selected.

<table>
<thead>
<tr>
<th>Option</th>
<th>Data/software that is installed</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT-series Support Tool ver 4.8</td>
<td>The Support Tool, keyboard/tenkey library, and color palette symbols (approx. 23 MB)</td>
</tr>
<tr>
<td>System Installer</td>
<td>Only the System Installer (access the system programs directly from the CD-ROM (approx. 20 MB))</td>
</tr>
<tr>
<td>Sample Collection</td>
<td>Lamp/touch switch parts library, parts library list, sample screen data, and ISO parts library (approx. 30 MB)</td>
</tr>
</tbody>
</table>

Click the Next Button

The screen for specifying the destination for registering the start menu is displayed.

10. In the start menu of Windows, specify the folder where the short-cut to the Support Tool is created.

In the initial state, the following folder is selected.

Start\Program\Omron\NTST4.8E
If you want to change the folder, select the desired folder from the Existing Folders or directly input the folder name. (If a folder that does not exist in the hard disk is specified, the specified folder is automatically made.)

After specifying the folder, click the Begin Button.
Installation of the specified programs is implemented; files are copied.
During program installation, the progress of the processing is indicated as a percentage.
11. After step (10), a dialog to select restart/non-restart will come out for Windows 95, 98, NT4.0, 2000, or XP.

Restarting your machine is recommended because important information is registered after the restart. If you select to restart later, the registration will be performed at this next restart and installation is completed.
Click the Finish Button to finish or restart. Restart is not required for Windows2000.
2-2-3 Uninstall

An uninstaller (uninstall software) is supplied with the Support Tool.

If you want to remove the Support Tool from your personal computer, run the uninstaller to delete the Support Tool program files and installation information. Note that the data created by the Support Tool is not deleted.

• Starting the uninstaller from the Windows start menu

  Select “Uninstall NTST” in the same folder where the short-cut to the Support Tool is stored.

Example: Assuming the short-cut to the Support Tool exists in the Start\Program\Omron\NTST4.8E

  Select the uninstaller by the following operation.

  [Start] → [Program] → [Omron] → [NTST4.8E] →[Uninstall NTST]

  After the start up of the uninstaller, follow the instructions displayed on the screen.

2-2-4 Using the Help File on Windows Vista or Windows 7

Help files with an "hlp" file name extension cannot normally be used on Windows Vista and Windows 7. Microsoft, however, provides a tool that will allow you to use a help file with an "hlp" file name extension. This tool can be used to enable accessing the help file.

If you attempt to open the help file while connected to the Internet, the download page will be displayed automatically.

The tool to access the help file can also be downloaded from the following URL:

http://support.microsoft.com/kb/917607/en–us (Web page last confirmed in March 2010.)
This section describes how to start up and exit the Support Tool and the operating procedure for PT screen data files.

### 3-1 Starting-up and Exiting the Support Tool
- **3-1-1 Start-up Procedure**
- **3-1-2 Exit Procedure**

### 3-2 User Interface
- **3-2-1 Functions Provided in the Main Window**
- **3-2-2 Major Functions of Dialog Boxes**
- **3-2-3 Functions of Message Boxes**

### 3-3 Operation of Screen Data (Application) File
- **3-3-1 Creating New Screen Data (Application) File**
- **3-3-2 Reading the Existing Screen Data (Application) File**
- **3-3-3 Saving the Screen Data (Application) File**
- **3-3-4 Closing the Screen Data (Application) File**
- **3-3-5 Importing (Reading) the DOS Version Screen Data (Application) File**
- **3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool)**
- **3-3-7 Using Method of Parts Collection**
3-1 Starting-up and Exiting the Support Tool

The procedure for starting up the Support Tool installed in your personal computer and exiting it is shown below.

3-1-1 Start-up Procedure

To start up the Support Tool, select [Programs] → [Omron] → [NTST4.8E] → [NT-Series Support Tool] beginning with the Windows start button.

After the start-up of the Support Tool, the main window, shown below, is displayed.

Reference: Up to two Support Tools can be started up at the same time. You can copy and paste the screen data or table data between them by opening the two different screen data files. To start up the second Support Tool, select [Import Component] from the [File] menu in the main window of the first Support Tool (It is not possible to start up the second Support Tool from the [Start] menu of Windows). For details, refer to 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool).
On Windows 2000, Windows XP, Windows Vista, or Windows 7, you must have administrator rights to run the Support Tool.

Before you start the Support Tool, make sure you are logged on with a user ID in the administrators group or power users group.

On Windows Vista or Windows 7, the following procedure can be used to run the Support Tool with administrator rights.

1. Right-click the program, select Properties, and then click the Compatibility Tab. In the Privilege Level Area, select Run this program as an administrator, and then click the OK Button. (Refer to the box in the following figure.)

2. Right-click the program and select Run as an administrator.

3. Use the Program Compatibility Wizard, specify the NT-series Support Tool, select Run this program as an administrator, and then click the OK Button.

Reference: If the Windows Aero theme is used with Windows Vista or Windows 7, the cross-hair cursor that indicates positions when editing parts will be displayed in black on a black background, making it very difficult to see. Set a theme other than Windows Aero.
3-1-2 Exit Procedure

To exit the Support Tool, use any of the operations shown below.

- In the menu, select [File] → [Exit].
- Click the \( \times \) Button at the upper right corner in the main window.
- Double click the Support Tool icon displayed at the upper left section in the main window.
- Click the Support Tool icon displayed at the upper left section in the main window, then select the \( \times \) Button in the control menu box.
- Press F4 key while pressing down the Alt key.

If you are going to exit the Support Tool before saving the data of the opened screen, a confirmation message is displayed.

After you exit the Support Tool, the screen returns to the Windows screen.

3-2 User Interface

3-2-1 Functions Provided in the Main Window

The configuration of the Support Tool operation screen, name of each parts, and the available functions are described below.

Application manager screen

Directories of screens and tables are displayed as a tree list, which allows opening, copying, and other operations.

Data creation screen

On this screen, the screen to be displayed by the PT is created.

Control menu box

The control menu box displayed at the upper left corner of the operation screen and windows allows you to select how a window is displayed.
Title bar

The titles of windows are displayed here on each window respectively.

Status bar

The status bar displays a simple explanation about the selected function, selected object, cursor position, object position, the model type of the objective PT, PLC Vendor, the maximum memory size, and the remaining application size.

Menu bar

The functions provided by the Support Tool are divided into several groups.

The menu bar shows the names of these function groups and the functions in each group are displayed in pull-down menus.

- Standard Toolbar

  Functions that are used frequently — such as file reading/writing, copy and paste, undo/redo, and print — are assigned to the buttons in the standard toolbar.

  These functions can be called easily without selecting the function item from the menu bar.

- Draw Bar

  Functions to draw objects are assigned to buttons in the draw bar.
These functions can be called easily without accessing the commands from the menu bar.

- **Utility Bar**
  
  Buttons for centralizing label of touch switch or lamp (refer to 5-1-3 Changing the Display Method on the Support Tool), simulation for flash attribute in fixed display objects (refer to 5-1-3 Changing the Display Method on the Support Tool), lamp ON facility (refer to 5-1-3 Changing the Display Method on the Support Tool), and a combo-box for selecting to display certain screen object type (refer to 5-1-4 Filter Function) are provided.

- **Alignment Bar**
  
  This toolbar provides the object alignment to the top, bottom, left, right and also center in a row and center in a column. (Refer to 6-1-6 Aligning Elements.)

**Reference:** Whether or not Status Bar, Standard Toolbar, Draw Bar, Utility Bar and Alignment Bar are displayed can be selected, respectively, by the following operation.
Status Bar: [View] (menu bar) → [Status Bar]
Standard Toolbar: [View] (menu bar) → [Toolbars] → [Standard Bar]
Draw Bar: [View] (menu bar) → [Toolbars] → [Draw Bar]
Utility Bar: [View] (menu bar) → [Toolbars] → [Utility Bar]
Alignment Bar: [View] (menu bar) → [Toolbars] → [Alignment Bar]

Each time you select the item, display/no-display selection changes alternately. The check mark, if displayed, indicates that the selection of the corresponding item is to be displayed.

If [Auto hide] invoked by selecting [Start] button (Windows) → [Settings] → [Taskbar] → [Taskbar Options] is checked, status bar may not be displayed correctly when the window of the Support Tool is maximized. In this case, clear the checkmark for [Always on top] at [Taskbar Options].

Floating palette

The standard toolbar, draw bar, utility bar and alignment bar can be moved as a floating palette to a convenient place for your operation.

Object information on the status bar

The information for the selected object that will be displayed on the status bar is indicated in the following table. (No information will be displayed when multiple objects are selected) Information to be displayed may be cut depending on the resolution of the screen or the selected object.

<table>
<thead>
<tr>
<th>Screen Element (Selected item)</th>
<th>Information to be displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Display Object</td>
<td>Fixed Display {Object Name: Attribute}</td>
</tr>
<tr>
<td>Fixed Display-Mark</td>
<td>Mark Object {Code*1}</td>
</tr>
<tr>
<td>Fixed Display-Image</td>
<td>Image Object {Reference Type: Code*1: Comment: Size: Compression}</td>
</tr>
<tr>
<td>Fixed Display-Library</td>
<td>Library Object {Reference Type: Code*1: Comment}</td>
</tr>
<tr>
<td>Image Lamp</td>
<td>Image Lamp {PLC Address: ON code<em>1: OFF code</em>1: ON comment if check else OFF comment}</td>
</tr>
<tr>
<td>Standard Lamp</td>
<td>Standard Lamp {PLC Address: Label*2}</td>
</tr>
<tr>
<td>Touch Switch</td>
<td>Touch Switch {Function: PLC Address: Label*2} (If function type is Notify Bit, display Notify Address, else display Lamp Address)</td>
</tr>
</tbody>
</table>
### Screen Element (Selected item) | Information to be displayed
---|---
Thumbwheel | Thumbwheel \{PLC Address: Table Entry\(^3\)\}
Numeral Input | Numeral Input \{PLC Address: Table Entry\(^3\); Reference Type\}
String Input | String Input \{PLC Address: Table Entry\(^3\); Reference Type\}
Recipe | Recipe \{Recipe Number; Recipe Name; Write Notify Bit; No. of Records: No. of Parameters\}
Numeral Display | Numeral Display \{PLC Address: Table Entry\(^3\); Reference Type\}
String Display | String Display \{PLC Address: Table Entry\(^3\); Reference Type\}
Bar Graph | Bar Graph \{PLC Address: Table Entry\(^3\); Direction\}
Trend Graph | Trend Graph \{Type: Drawing Width: Direction\}
Broken-line Graph | Broken-line Graph \{Direction\}
Alarm History | Alarm History \{Display Image/Library or not\}
Alarm List | Alarm List \{Table Entry\(^3\); Display Image/Library or not\}
Analogue Meter | Analogue Meter \{PLC Address: Table Entry\(^3\)\}

(*1) M: Mark  I: Image  L: Library

(*2) If the image or library data for when the switch is lit is not specified, the comment for the image or library data for when the switch is not lit will be displayed.

(*3) For the NT21 and the NT31. NT31C, NT631, NT631C with “-V2” or “-V3,” the information to be displayed depends on the Label Type as follows:
- Static: Label
- On Off Static: When [View] – [Simulate ON/OFF] setting is ON, displays ON label, when OFF, displays OFF label.
- Numeral Display: Same for Numeral Display information
- String Display: Same for String Display information

(*4) N: Numeral Table  S: String Table  B: Bit Memory Table

## 3-2-2 Major Functions of Dialog Boxes

A dialog box is a window that is displayed in a fixed size. The purpose of a dialog box is to set data that is required to execute the functions of the Support Tool.

The following types of dialog boxes are used and the procedure for setting the data differs according to the type of dialog box.

- **Option button**

  This represents a selection item, with \(\bigcirc\) displayed to the left of the item name.

  Only one of the displayed items can be chosen. The item is identified by a black circle.

- **Check box**

  This represents a selection item, with \(\square\) displayed to the left of item name.

  Items can be selected by giving a check mark in this box.
3-3 Section

Operation of Screen Data (Application) File

- Text box
  This text box is an input field to set characters.

- List box
  A list box displays a list of data: the data to be set is selected from the list.

- Combo box
  A list of selection items appears in the dropdown list box format. The data to be set is selected from the list.

3-2-3 Functions of Message Boxes

Message boxes display details of errors that occur during Support Tool operation and messages that request your confirmation of attempted operations.

When a message box shows up, operation can be continued or cancelled by pressing the corresponding button in the message box.

3-3 Operation of Screen Data (Application) File

The procedure for operating the screen data file, where the PT screen data is stored, is described below. The PT Configuration, which determines the basic PT operation, is also discussed.
3-3-1 Creating New Screen Data (Application) File


PT configuration dialog box appears so that users can set information of the application environment and type of PT device.

Click the **OK** Button after completing the setting at the PT configuration dialog box. For details of the setting at the PT configuration dialog box, refer to Dialog Box Settings in the PT Configuration below.

If the PT is set to the NT21, the clock address dialog box will appear next. Refer to page 54.

The application manager and the data creation screen (1 Standard Screen) are displayed.

PT screen data is created by arranging objects on this data creation screen.

The application manager is the tool to manage the screen data created by a user. For operation procedure, refer to Section 4 Application Manager.

**Dialog Box Settings in the PT Configuration**

Before creating screen data, it is necessary to set the PT configuration and the Control and Notify Areas that are shared with the PC (PLC).

The operation steps shown below display the PT configuration dialog box.
• Menu Bar → [File] → [New] (creating new application)
• Menu Bar → [Tools] → [PT Configuration] (for modifying)

The PT configuration dialog box has a variety of setting items provided in three pages.

• PT Type page
• System page
• Control/Notify Area page

• PT Type page

The PT Type page is displayed when you click on the [PT Type] tab.

The PT Type page is used to set the hardware configuration of the PT to be connected.

PT Model

Specify the type of PT to be connected. When you are using the NT31, NT31C, NT631 or NT631C, refer to the table below to select the correct model according to the system program being installed.

<table>
<thead>
<tr>
<th>PT Model</th>
<th>System Program</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Ver.1.01</td>
</tr>
<tr>
<td>NT31</td>
<td>&quot;NT31&quot;</td>
</tr>
<tr>
<td>NT31C</td>
<td>&quot;NT31C&quot;</td>
</tr>
<tr>
<td>NT631</td>
<td>&quot;NT631&quot;</td>
</tr>
<tr>
<td>NT631C</td>
<td>&quot;NT631C&quot;</td>
</tr>
</tbody>
</table>

Reference: To check the system program version installed in a PT, display the following screens:

• Version display at the upper right position of PT system menu
• PT system menu → Expansion mode → Version display

With the NT20, either "NT20S" screen data (compatible with previous NT20S) or "NT20" screen data (with expanded CS/CJ-series PLC data access) can be used.

The following PT Models are also available:
• NT31-V2
• NT31C-V2
• NT631-V2
• MT631C-V2

**NT20/30/620 Compatible Mode**

For NT21 and NT31/631-V2 or higher models, the NT20/30/620 Compatible Mode check box will be enabled. By setting this option, the Control Area will take 4 memory address, instead of 5 and Notify Area will take 3 memory address, instead of 2. This allows straight conversion for NT30/620 PT models to NT31/631 or NT20S models to NT21 without the need to modify the PLC program.

**PLC Vendor**

Specify the usable direct access type from either of the following. MEMLINK, Mitsubishi_A and Mitsubishi_Fx can be set only with NT31, NT31C, NT631 and NT631C with “-V1” and above. AB and GE can be set only with NT31, NT31C, NT631 and NT631C below “-V1.” Siemens can be set only with NT31, NT31C, NT631 and NT631C with “-V1.” (Refer to page 27).

• OMRON
• Mitsubishi_A
• Mitsubishi_Fx
• MEMLINK
• AB
• GE
• Siemens

**Font Type**

If you are using NT31-V1, NT31C-V1, NT631-V1, NT631C-V1 and above hardware or had NT31, NT31C, NT631 and NT631C and been updated the system program to the -V2 (System Ver.3.1) system program, which is attached to this Support Tool, it is possible to select the Font Type ISO8859-1 or CP437. If you are using the European Keyboards, please refer to Appendix K for more details.

**Reference:** Specify "OMRON" as the PLC type when using memory links between the NT30, NT30C, NT620S, NT620C, and NT625C.

**Comment**

Set the comment that is appended to the screen data file.

An arbitrary character of up to 28 characters can be set.

**Reference:** The PT model of the screen data that is opened can be changed. If it is changed, the data is converted automatically. Note that changing of PT models is allowed only for the restricted combinations shown in Appendix A Data Conversion.
- System page

The System page is displayed when users click on the [System] tab. Fundamental operating functions can be set in this System page.

![PT Configuration](image)

**Initial Screen**

Screen number, which appears when the wrong data is set for PT Control Area when PT is driven, is selected from the drop-down list box or keyboard input. Normally, this setting is invalid since PT References PT Control Area for the initial screen number when starting up.

The screen numbers of existing screen data are listed in the list box or only screen number 1 is displayed if the screen data is newly created.

**Backlight OFF**

Specify whether or not the backlight OFF function is used.

This option can be selected from System of PT Configuration in the Support Tool. The Backlight OFF function automatically turns OFF the screen if the Support Tool is not operated for a certain time period to save the backlight of PT.

If the check box is clicked to utilize the option, the time interval will be displayed in the drop-down list box to set it.

For details of the PT models that can use this function, refer to Appendix E System Setting (PT Configuration).

**Resume Function**

The resume function holds the data in the table when the PT is OFF or reset.

For details of the PT models that can use this function, refer to Appendix E System Setting (PT Configuration).

**History Setting**

This item specifies the method for processing when the Log memory of the alarm history function and History screen function becomes full.

- Alarm (Use Ring Buffer):

  Same meaning with FIFO (First In First Out)

Alarm FIFO system is applied for this function if the log memory area is full. When new alarm occurs, the oldest record data will be deleted so that the new data can be stored there.
If the Alarm function is not chosen, newly coming data is not acceptable to record when the memory space is full.

- **Screen (Use Ring Buffer):**
  
  Same meaning with FIFO (First In First Out).
  
  When the new screen history occurred, the oldest record data will be deleted so that new data can be stored there. This is so called FIFO. If this check box is not ON, newly coming data is not acceptable to record when the memory space is full.

Either the Alarm and the Screen data is available for the following PT models.

NT30, NT30C, NT21, NT31, NT31C, NT620S, NT620C, NT625C, NT631, NT631C.

(For NT21, NT31, NT31C, NT631, and NT631C, both Alarm and Screen settings are available.)

**Number of Table Entries**

Specify the number of numeral memory table entries, character string memory table entries (String Table), and bit memory table entries.

Setting of the Number of Table Entries is valid for the following PT models.

NT30, NT30C, NT21, NT31, NT31C, NT620S, NT620C, NT625C, NT631, NT631C

**Buzzer – Enable**

Specify whether or not the buzzer function is used.

To use the buzzer function, click the check box to enter the check mark. To set the buzzer function to be unused, click the check box to clear the check mark.

To sound the buzzer only at the occurrence of an alarm, specify [On Error] at the drop-down list box.

If [Always] is selected for the buzzer function, the buzzer sounds at following events.

- Occurrence of an error at PT
- Reception of a command from the host
- Screen switching

Setting of the buzzer function is valid for the following PT models.

NT30, NT30C, NT620S, NT620C, NT625C

**Reference:** With the NT21, NT31, NT31C, NT631, and NT631C, buzzer function settings are made by system menu operation at the PT and setting from the Support Tool is not allowed.

**Buzzer – Key Input**

Click the check box of [Key Input] to enter the check mark if you want to sound the buzzer in response to the input from a touch switch or the extended I/O unit. Clear the check mark if the key input sound is not to be used.

**Printer for PT**

A printer can be connected to PT device for printing screen data if required. You have to specify the type of printer being used by the application for the following PT models:
NT30, NT30C, NT620S, NT620C, NT625C

- Printer
  Select one of the Supported printers from the printer drop-down list box.
  Although this setting is possible for NT31, NT31C, NT631, NT631C, it is not
  valid from Support Tool.
  Please set from the Maintenance Mode of PT.

- Mode
  Color:
    Specify “Color” for color printing.
    Designation of Color is valid for the following PT models.
    NT30C, NT620C, NT625C
  Tone:
    Specify “Tone” for monochrome printing.
    If a color type PT is used with Tone set for [Mode], color data is expressed using
    a gray scale, printed in monochrome.

These setting are available for the following PT models.
  NT30, NT30C, NT620S (Printer only), NT620C, NT625C
For NT21, NT31, NT31C, NT631, and NT631C, this setting has to be selected
from PT.

**Numeral Storage Type**

BCD or Binary can be selected for the storage type of the Numeral memory table.
This setting is available only when the time the Storage Type in the Numeral
memory table has [System] setting. When BCD or Binary is set for Numeral
memory table Storage Type, this setting in the PT Configuration will be ignored
and follows the storage type in the Numeral Table.

This setting is available for the following PT Model.
  NT21, NT31, NT31C, NT631, NT631C

- Control/Notify Area page
  The Control/Notify Area page is displayed when you click on the [Control/Notify
  Area] tab.
  The Control/Notify Area page is prepared to set the PT Control area, controlling PT from PC (PLC) and for PT Notify Area, notifying PT information to a PC
(PLC and for window control area, controlling a window (NT21, NT31, NT31C, NT631, NT631C with "-V1" and "-V2" only).

PT Control Area

PC (PLC) Address

Set the type of words at the PC (PLC) and the first address (word number) of the area used as the PT Status Control Area.

The PT Status Control Area differs depending on the PT model and it occupies the following number of words.

NT31, NT31C, NT631, NT631C:
For V1 models, and V2 models without NT20/30/620 Compatible mode: 5 words
For V2 models with NT30/620 Compatible mode: 4 words

NT21:
Without NT20/30/620 Compatible mode: 5 words
With NT20/30/620 Compatible mode: 4 words
Other models: 4 words

Comments

Set a comment concerning this area.
As a comment, up to 16 character can be set.

PT Notify Area

PC (PLC) Address

Set the type of words at the PC (PLC) and the first address (word number) of the area used as the PT Status Notify Area.

The PT Status Notify Area differs depending on the PT model and it occupies the following number of words.

NT31, NT31C, NT631, NT631C:
For V1 models and V2 models without NT20/30/620 Compatible mode: 2 words
For V2 models with NT20/30/620 Compatible mode: 3 words

NT21:
Without NT20/30/620 Compatible mode: 2 words
With NT20/30/620 Compatible mode: 3 words
Other models: 3 words
Comments
Set a comment concerning the area set as the PT Status Notify Area.
As a comment, a character string of up to 16 characters can be set.

Window Control Area

PC (PLC) Address
Set the type of words at the PC (PLC) and the first address (word number) of the area used as the Window Control Area.

Window Control Area differs depending on the PT model and it occupies the following number of words.
- NT21 and NT31, NT31C, NT631, NT631C with "-V1" or "V2": 9 words
- Other models: can not be used

Comments
Set a comment concerning the area set as the Window Control Area.
As a comment, a character string of up to 16 characters can be set.

Note
Set memory addresses so that the PT Control Area, PT Notify Area and Window Control Area do not overlap.

- PC (PLC) Address dialog box
  Clicking on the [Set] button in the [PT Control Area], [PT Notify Area] or [Window Control Area] displays the PC (PLC) Address dialog box.

  In the PC (PLC) Address dialog box, the PC (PLC) address of the PT Status Control Area, the PT Status Notify Area and the Window Control Area can be set by specifying the area type and address individually. The setting made in the PC (PLC) Address dialog box will be reflected on the setting made in the [PC (PLC) Control Area], [PT Notify Area] or [Window Control Area].

  Use the PC (PLC) Address dialog box only when the area type and address are input individually. If the PC (PLC) address is directly input in the Control/Notify Area page, it is not necessary to call this dialog box.

Example PLC Vendor: OMRON

Channel (Word)
Specify the type of PC (PLC) area that is used as a PT Status Control Area, a PT Status Notify Area or a Window Control Area by selecting an item from the drop-down list box.

Address
Specify the first word address in the PC (PLC) area that is to be used as the PT Status Control Area, PT Status Notify Area, and Window Control Area.
I/O Comments

Set a comment concerning the area set as the PT Status Control Area, a PT Status Notify Area, or a Window Control Area.

As a comment, a character string of up to 16 characters can be set.

Clock Address

When the PT is set to the NT21, the addresses must be set to read the clock from the PLC host. This setting is not necessary for other models of PT.

If the PT is set to the NT21 on the tools page of the PT configuration dialog box, the clock address dialog box shown below appears. Always set an address when using the clock function (data displays, screen display history, or alarm history).

PLC Address

Set the area and the address of the first word from which to read the clock data. A Clock Data Area will be defined consisting of 4 words starting at the specified address.

I/O Comments

Set a comment for the address used to define the Clock Data Area. Up to 16 character can be input.

- PLC Address Dialog Box

This dialog box is set in the same way as the one for the PT configuration dialog box.

3-3-2 Reading the Existing Screen Data (Application) File

To read the screen data that is saved in a file, select [File] → [Open] from the main window menu.
The dialog box for the applicable folder, file name, and files of type exist appears to specify them.

After specifying the folder, file name, and file type click on the [Open] button. The application manager of the read out screen data is displayed.

With NT-series Support Tool for Windows, following screen data files can be handled.

- onw
- mmi

For details, refer to File Types in page 56

Reference:
- Recent used files will be shown at the bottom of [File] menu. Recent four files can be opened from this command.
- NT-series Support Tool for Windows (Ver. 4.7) can read the screen data that is created using an earlier version of NT-series Support Tool.
- It is not possible to read screen data created by NT-series Support Tool for Windows (Ver. 4.7) with an earlier version of NT-series Support Tool.
- With MMI files, the screen data created by the Support Tool Ver.4 can be read using Support Tool Ver.3 as long as the PT model is supported with Ver.3. (With MMI format, user group and grid information will be lost.)

 e.g.
 NT30C MMI file created with Ver.4.
 → Can be read with Ver.3
 NT31C-V2 MMI file created with Ver.4.
 → Cannot be read with Ver.3

### 3-3-3 Saving the Screen Data (Application) File

After creating the screen data, save it to a file.

The procedure for saving the screen data to a file is: [File] (main window menu) → [Save], or [File] (main window menu) → [Save As].

Save:

The existing screen data of the opened file is overwritten by the new screen data.
If the file was opened using [New], the operation to be followed is the same as for saving a file by selecting [Save As].

**Save As:**

The created or edited screen data is saved by specifying the folder and the file name.

- **File name setting dialog**
  
  If you select [Save] when creating new screen data or [Save As], the file name setting window (Save As) opens.

![Save As Dialog]

After inputting the folder and file name, click the **Save** button the screen data is saved to the specified file.

If the file name of an existing file is specified, a message requesting confirmation that the file is to be overwritten is displayed.

- **File types**
  
  When saving files in file name setting dialog, either of following two file types can be selected.

  - **NTST screen data (*.onw) format (onw format)**
    
    This is a standard file format for Support Tool.

    Use this format to save screen data normally.

  - **Memory map image file (*.mmi) format (mmi format)**
    
    This is a file format to which screen data is compressed after deleting information used only for Support Tool. (Data to be lost are grid setting and grouping information.)

    Use this format for purposes such as transferring screen data using FD.

    It is advisable to save the same data with onw format also, since part of information are lost with this format as mentioned above.

Once you saved data, specified file types will not be changed until you exit the Support Tool or perform saving/reading the onw file. (Data will be saved in the format same as before when you select “Save” to save it.) If you want to change the file type, select “Save As.”

**Reference:**

- It is not possible to save data in DOS format.

  - Once you read the data that was created using DOS version Support Tool by NT-series Support Tool for Windows, do not upload the data with DOS tool.
even if it has been download to PT. Downloading will be possible; however, the data may not be used with DOS version Support Tool correctly.

- With mmi file format, error check is executed before saving. By this error check, data that cannot be downloaded to PT will not be stored.
- With the Support Tool on CD-ROM, the NT Transfer Utility, which transmits mmi file to the PT, is supplied. For details, refer to Appendix C NT Transfer Utility.

3-3-4 Closing the Screen Data (Application) File

It is not possible to open two or more screen data files with one Support Tool. So when you want to edit different screen data file, you need to close the currently opened file, or start up the second Support Tool using the [Import Component] command from the [File] menu. For details of Import Component, refer to 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool).

To close application, select [Close] from [File] in the main window menu.

If the screen data (application) has not been saved, a message requesting confirmation of saving it is indicated/displayed.

If the file name is not set, the name setting dialog appears. If the file name has been already determined, the data will be overwritten.

The screen data file closes without saving the screen data.

The file close operation is canceled.

3-3-5 Importing (Reading) the DOS Version Screen Data (Application) File

The Support Tool has a function for reading screen data files created using the previous DOS version Support Tool. Note that although the DOS version screen data files can be read, files cannot be saved in DOS format.
The procedure for reading a DOS version screen data file is: [File] (main window menu) → [Import].

For “Files of type,” select any of the following items according to the model of Support Tool used to create the screen data you are going to read.

- **M1S**: Screen data for NT11S/NT11
- **M2S**: Screen data for NT20S
- **M6S**: Screen data for NT600S
- **G6S**: Screen data for NT30, NT30C, NT620S, NT620C, and NT625C

Click the **Open** button after selecting the folder and specifying the file name.

The application manager of the read screen data will be displayed.

**Reference:**
- For details of the PT models and types, the Support Tool can create screen data for, refer to 1-6 Usable Hardware Combinations.
- Refer to Appendix A Data Conversion to reuse or convert screen data from previous PT models.

### 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool)

Select [Import Component] from the [File] menu and you can start up the second Support Tool and open a different screen data file. By reading out the different screen data files with the two Support Tools, data copying/pasting can be performed easily between the files.
When you select [Import Component], a dialog box to specify the file to be read is displayed. (For details of this dialog, refer to 3-3-2 Reading the Existing Screen Data (Application) File.)

![Dialog box](image)

After specifying the folder, file name and file type, click the **Open** Button. The second Support Tool starts up and the application manager of the read out screen data is displayed.

**Reference:**
- It is not possible to start up the second Support Tool from the [Start] button of Windows (Error message will be displayed). Be sure to select [Import Component] from the [File] menu in the main window of the first Support Tool.
- Copy/paste operation can not be performed between the two files if the PT model of the two files is different. In this case, perform data conversion beforehand so that the PT model setting of the copy source screen data matches to the setting of the copy destination screen data. (Selected PT model can be checked on the status bar.)
- It is not possible to edit the same screen data file by two Support Tools. If you try to read out the file that is already opened by the other Support Tool, error message will be displayed.
- The second Support Tool can read out the screen data file regardless of the file types (onw, mmi).
- When the second Support Tool is started, the windows of both Support Tools are automatically resized into normal windows that overlap each other to facilitate the copy operation between the files.
- It is not possible to open one more Support Tool when two Support Tools are already started.
- [Import Component] will not be displayed in the [File] menu when no screen data is opened with the Support Tool.
- Conversion of PLC address is executed when the PLC vendor (direct access) is different between the copy source/destination screen data.
- Conversion of key code is executed when the key code (font type) is different between the copy source/destination screen data.
- In case of the numeral/string table and bit memory table, if the table size of copy destination is smaller than the size of copy source, excessive entries will be discarded.
- To achieve higher performance, close the second Support Tool after you completed import operation.
It may take time to read out MMI file since data checking is performed before opening the file.

**Possible Operation between Two Support Tools**

While screen data files of the same PT model are opened with the two Support Tools, following operations are possible.

a. Copying, cutting, pasting and drag & drop of a screen between application managers (multiple screens can be also handled). (Refer to 4-2-4 Copying a Screen.)

b. Copying, cutting, pasting and drag & drop of a table data between application managers (All the data in a table is handled, it is possible to handle a table entry individually or to handle multiple table entries collectively.) (Refer to 4-2-9 Copying the Whole Table.)

c. Copying, cutting, pasting of a number/code between the following table entries (Drag & drop is not possible).
   - Between image table entries (Refer to NO TAG Operating the Image Table.)
   - Between library table entries (Refer to NO TAG Operating the Library Table.)
   - Between bit memory table entries (Refer to 7-1-4 Edit Operation.)
   - Between numeral table entries (Refer to 7-1-4 Edit Operation.)
   - Between string table entries (Refer to 7-1-4 Edit Operation.)
   - Between extended I/O output table entries (Refer to 7-1-4 Edit Operation.)
   - Between extended I/O input table entries (Refer to 7-1-4 Edit Operation.)

d. Copying, cutting, pasting and drag & drop of objects between editing screens or library editors. (Drag & drop can not be performed if the copy destination...
window is hidden under other windows.) (Refer to 6-1-5 Copying, Cutting, Pasting, and Deleting Elements.)

e. Copying, cutting, pasting of the specified area between image editors or mark editors (Drag & drop is not possible). (Refer to NO TAG Creating Image Data Using Image Editor, NO TAG Creating Marks Using the Mark Editor.)

These operating procedures are same as normal operations of copy, cut, paste and drag & drop on one Support Tool.

**Copying/Pasting an Object That Contains Image/Library Data**

Even if a screen or an object that contains image/library data is pasted onto a different screen data file, image/library data itself is not copied if NT-series Support Tool version number is lower than 4.6.

If you want to copy/paste an object that contains image/library data between screen data files, you need to copy the image/library data referenced by the object beforehand.

Ex: Copying/pasting a fixed-display image that references image code 0001 while the contents of the code are different between the screen data files

As shown above, image data to be displayed will vary even if both objects are referencing the same code, when the contents of the referenced image code are different between the screen data files. (When no data is registered to the referenced code, ☐ is displayed.)

### 3-3-7 Using Method of Parts Collection

With the Support Tool on CD-ROM, Parts Collection is supplied. In this section, using method of Parts Collection is described.
Parts Collection

Lamps and touch switches will be graphical and expressive parts when they are combined with image/library data or image lamps. These graphical lamps and touch switches are registered to the Parts Collection (Parts Collection for each PT model is provided).

Using [Import Component] command, desired data can be copied/pasted from Parts Collection to the editing screen easily.

Reference:
- Parts Collection is supplied only for the Support Tool on CD-ROM. It can be installed by specifying “Sample Collection” when installing the Support Tool.
- Parts Collection for NT11S/NT11, NT20/NT20S and NT600S is not supplied.
- Parts Collection is created in MMI format. It may take time to read out/save MMI file.
- If you install the Parts Collection, the Parts Collection List, which shows how to use the Parts Collection, the list of screen images, will be automatically installed as well. This list is stored in the Parts Collection List folder inside the Sample collection folder.

Operation Procedure

To use the Parts Collection, follow the procedure below.

Here, operations such as copying, pasting, drag & drop are not described in details. Please refer to NO TAG Image Editor, NO TAG Library Editor and 6-1-5 Copying, Cutting, Pasting, and Deleting Elements.

(1) Open the screen data file to which you want to paste data from Parts Collection.

(2) Select [Import Component] from the [File] menu.

(3) Dialog box to specify the file to be opened is displayed. Open the Sample Collection folder in the folder that Support Tool has been installed into. Then, open the folder of the required PT model (see below). Select “Memory Map Image File (*.mmi)” as a file type. Parts Collection for each PT model is displayed. Specify the Parts Collection of the PT model same as the currently opened screen data file and click the Button.

Second Support Tool starts up and the selected Parts Collection opens.

(4) In the screen data file of Parts Collection, decide the object that you want to import.

(5) If the object contains image/library data, the image/library data should be copied between image/library table entries beforehand by copy/paste operation if NT-series Support Tool version number is lower than 4.6. Follow the proce-
procedure below.
Code number to be copied can be checked in the property of an object. (Refe-
erenced image/library code is also displayed on the status bar for some ob-
ject when they are selected.)
If image/library copying is not performed beforehand, display will not be as
intended since the image/library allocated to the code is not copied even if the
object itself is copied.

Procedure

a. Open the property of an image lamp or image/library data to be imported and
check the referenced image/library code.

b. Select [Image Editor] or [Library Editor] from the [Tools] menu and copy ([Edit]
– [Copy]) the code to be imported on the image/library table.

c. Open the image/library table of the screen data file of copy destination and
paste the image/library data that has been copied.
This time, if the copy destination code number is different from the copy
source code number, display will not be correct when the object is pasted.
Register the same code number as copy source by clicking the
  New
  Button.

(6) Drag & drop the object that you want to import from the screen data file of
Parts Collection to the screen data file of copy destination ([Copy], [Paste] in
the [Edit] menu can be used also).
SECTION 4
Application Manager

This section shows how the application manager is used when checking the created data, copying screen data, setting a memory table, operating a window.

4-1 What Is the Application Manager? 
4-2 Operating the Application Manager

- 4-2-1 Opening a Data Creation Screen
- 4-2-2 Closing a Creation Screen
- 4-2-3 Creating a New Screen
- 4-2-4 Copying a Screen
- 4-2-5 Deleting a Screen
- 4-2-6 Displaying and Setting the PT configuration
- 4-2-7 Displaying and Setting Screen Properties
- 4-2-8 Editing a Table
- 4-2-9 Copying an Entire Table
- 4-2-10 Saving the Screen Data (Application) to a File
- 4-2-11 Error Check (Validation)
- 4-2-12 Sending (Downloading) the Data to a PT
- 4-2-13 Window Menu
- 4-2-14 Help Menu
What Is the Application Manager?

A screen data (application) file holds a variety of data. The application manager is a data management tool used for managing the various types of screen data. Since the application manager displays the data in tree style, you can check the created data or read the necessary data easily.

(The number and type of screens and tables displayed in the application manager vary according to the setting made for [PT Model] of [PT Type] in the PT configuration. Bit map shown above is in case of NT31, NT31C, NT631 and NT631C.)

The application manager provides following operations:

- Opening a data creation screen
- Creation of new application
- Copying a screen
- Deleting a screen
- Displaying and setting PT configuration
- Displaying and setting screen properties
- Editing tables
- Saving the created data to a file
- Sending (downloading) the created data to a PT

Icons used by the application manager

- App 1: Name of application folder
  When a file name has been specified, the file name specified by App 1 is used. Double clicking of this icon opens a set of sub-data box by screen type.
- screen: Screen data box
  Double clicking of this icon displays the screen data boxes classified by group.
- table: Table data box
  Double clicking of this icon shows memory tables classified by icon.
- 1-1899.2000 (Standard): Screen data boxes classified by screen type
  1-1899.2000: Indicates a screen number.
  Standard: Indicates screen type.
  Double-clicking of this icon displays the screen icons in a group.
  The screen number and screen type displayed here differ from PT models.
4-2 Operating the Application Manager

The procedure for operating and setting the data using the application manager is shown below.

Two types of operations - mouse operation and menu operation - are possible. For the menu driven operation, short-cut keys (keys used to call menu functions) may be used instead of displaying the menu.

4-2-1 Opening a Data Creation Screen

The procedure for opening a creation screen of existing data is shown below.

Operation using the mouse (1)

(1) Double click the screen icon.

Operation using the mouse (2)

(1) Click the right mouse button at the screen icon.
(2) Select [Open].

4-2-2 Closing a Creation Screen

The procedure for closing a creation screen is shown below.

Operation using the mouse

(1) Click the Button at the upper right corner in the data creation screen.

4-2-3 Creating a New Screen

The procedure for opening a new screen is shown below.

Operation using the mouse

(1) Click the screen data box icon, or right click the mouse on the screen data box (classified by group).
(2) Select [New], choose the screen type, then click the Button.
(3) Input a screen number and a comment, then click the Button.

Operation using the menu

(1) Select [New] from [Screen] in the menu bar.
(2) Select the screen type, then click the Button.
(3) Input a screen number and a comment, then click the OK Button.

4-2-4 Copying a Screen

The procedure for copying an existing screen to another screen number is shown below.

Reference: The operations shown below can be performed between different screen data files of the same PT model by starting up two Support Tools. For details, refer to 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool).

Operation using the mouse (1)

(1) Specify the screen icon.
Multiple screen icons can be selected by dragging the mouse cursor while pressing the Shift key or Ctrl key.
(2) Click right button of the mouse on the selected screen icon, then select [Copy].
(3) Click right button of the mouse on one of the screen icon, then select [Paste].
(4) Input a screen number, then click the OK Button.
The screen number of the copy source screen is displayed as a duplicated number, and in the new screen number field, the smallest number of the available screen numbers is displayed.
If you input an existing screen number, a confirmation message is displayed to overwrite it.

Operation using the mouse (2)

(1) Specify the screen icon.
Multiple screen icons can be selected by dragging the mouse cursor while pressing the Shift key or Ctrl key.
(2) Drag the selected screen icon in the screen icon display area.
(3) Input a screen number, then click the OK Button.
The screen number of the copy source screen is displayed as a duplicated number, and in the new screen number field, the smallest number of the available screen numbers is displayed.
If you input an existing screen number, a confirmation message is displayed to overwrite it.

Operation using the menu

(1) Specify the screen icon.
Multiple screen icons can be selected by dragging the mouse cursor while pressing the Shift key or Ctrl key.
(2) Select [Copy] from [Edit] in the menu bar.
(4) Input a screen number, then click the OK Button.
The screen number of the copy source screen is displayed as a duplicated number, and in the new screen number field, the smallest number of the available screen numbers is displayed.
If you input an existing screen number, a confirmation message is displayed to overwrite it.
4-2-5 Deleting a Screen

The procedure for deleting a created screen is shown below.

Operation using the mouse

(1) Specify the screen icon.
   Multiple screen icons can be selected by dragging the mouse cursor while pressing the Shift key or Ctrl key.

(2) Click right button of the mouse on the selected screen icon, then choose [Delete].
   The message requesting your confirmation is displayed.

Operation using the menu

(1) Specify the screen icon.
   Multiple screen icons can be selected by dragging the mouse cursor while pressing the Shift key or Ctrl key.

(2) Select [Delete] from [Edit] in the menu bar.
   A message requesting your confirmation is displayed.

4-2-6 Displaying and Setting the PT configuration

The procedure for displaying the PT configuration dialog box is shown below.
For details, refer to Dialog Box Setting in the PT Configuration on page 46.

Operation using the mouse

(1) Click right button of the mouse on the screen data (application) file icon, then select [Setup].

Operation using the menu

(1) Select [PT Configuration] from [Tools] in the menu bar.

4-2-7 Displaying and Setting Screen Properties

The procedure for displaying the property setting dialog box is shown below.
For details, refer to 5-1 Types of Screens, Common Dialog Box Settings and Operations.

Operation using the mouse

(1) Click right button of the mouse on the screen data file icon, then select [Properties].

Operation using the menu

(1) Select the screen icon.
(2) Select [Properties] from [Screen] in the menu bar.

Reference: The following operations can also display the screen property setting dialog box.
   - Click right button of the mouse on the editing screen where no objects are registered, then select [Properties].
   - Double click on the editing screen where no objects are registered.

4-2-8 Editing a Table

The procedure for displaying the table setting dialog box is shown below.
For details, refer to Section 7 Memory Table Setting or Section 8 Editing Graphic Data.

**Operation using the mouse (1)**

Double click the icon of the table data to be edited.

**Operation using the mouse (2)**

Make a right click on the icon of the table data to be edited, then select [Modify].

**Operation using the menu**

1. Select [Tools] in the menu bar, then choose [Table], [Image Editor], [Library Editor] or [Mark Editor].

2. If [Table] is chosen, select the tab of the table to be edited.

### 4-2-9 Copying an Entire Table

An entire table can be copied between the screen data files of the same PT model by starting up two Support Tools.

**Caution:** Copying of tables, screens, and objects between two screen data files involves addition or overwriting of PLC address. Please check the movement sufficiently before shifting to actual operation.

**Reference:**

- To start up second Support Tool, select [Import Component] from [File] menu, For details, refer to 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool).
- If the whole table is copied, all the contents in the specified table are copied collectively. For method to copy the individual data in a table, refer to Section 7 Memory Table Setting or Section 8 Editing Graphic Data.
- A check box for “Overwrite PLC Address” appears when copying the whole table indicated below. If this check box is checked, PLC address setting is overwritten. If not checked, settings such as initial value will be overwritten but the PLC address setting remains the same. Note that I/O comments are not copied even if the PLC address is overwritten. If you need the same I/O comment, copy the I/O comment.

  - Bit memory table, Extended I/O output table, Numeral table, String table, F-Key input notify table

**Operation using the mouse (1)**

1. Specify the table data icon.
   Multiple tables can be selected by dragging the mouse cursor while pressing the Shift key or Ctrl key.

2. Click right button of the mouse on the selected table data icon, then select [Copy].

3. Click right button of the mouse on the desired table in the table data icon display area of another Support Tool, then select [Paste].

4. In the confirmation dialog box, click the [Yes] Button. If a check box for “Overwrite PLC Address” appeared in the dialog box, make the setting as required.

**Operation using the mouse (2)**

1. Specify the table data icon.
   Multiple tables can be selected by dragging the mouse cursor while pressing the Shift key or Ctrl key.
(2) Drag the selected table data icon to the table data icon display area of another Support Tool.

(3) In the confirmation dialog box, click the Yes Button. If a check box for "Overwrite PLC Address" appeared in the dialog box, make the setting as required.

**Operation using the menu**

(1) Specify the table data icon.
   Multiple tables can be selected by dragging the mouse cursor while pressing the Shift key or Ctrl key.

(2) Select [Copy] from [Edit] in the menu bar.


(4) In the confirmation dialog box, click the Yes Button. If a check box for "Overwrite PLC Address" appeared in the dialog box, make the setting as required.

### 4-2-10 Saving the Screen Data (Application) to a File

The procedure for saving the screen data to a file is shown below.

For details, refer to 3-3-3 Saving the Screen Data (Application) File.

Please save frequently. Support Tool will not save automatically.

**Operation using the mouse**

(1) Click right button of the mouse on the screen data file icon, then select [Save] or [Save As].
   If you select [Save] for a file other than a new file, the saving operation starts immediately without prompting dialog box.

(2) Specify the folder and file name of the destination and click the Save Button.
   If you specify an existing file, a message requesting your confirmation is displayed if it is overwritten.

**Operation using the menu**

(1) Select [File] in the menu bar, then choose [Save] or [Save As].
   If you select [Save] for a file other than a new file, the saving operation starts immediately without prompting dialog box.

(2) Specify the folder and file name of the destination and click the Save Button.
   If you specify an existing file, a message requesting your confirmation is displayed if overwriting should be done.

### 4-2-11 Error Check (Validation)

The Support Tool has a function to check the data such as limitations of screen elements and PC (PLC) address assignments in order to prevent illegal data from being downloaded. This is called Validation.

The following three validation functions are provided:

- Validation performed on real time
The Support Tool provides real time validation while users are creating data. This function mainly checks the elements one by one. Moreover, maximum number of elements and memory size will be also watched.

- Validation performed from the [Tools] menu → [Validate]

It is also possible to perform the Validation using [Tools] → [Validate] from the menu bar.

By the check, Support Tool will detect the contradiction in the screen (application) data including association between touch switches and the elements and so on.

This check will be also performed at the beginning of the download process to prohibit the wrong data to be downloaded.

- Validation during the data conversion and importing DOS data file

Validation will be also performed when converting the screen data (application) from a current model to another model and when importing the DOS data file. Data conversion will be also performed when the registered symbol data from the Symbol Manager that was created by a certain PT model, has been dragged and dropped to the another PT model screen. So at this time validation will be also performed.

**Reference:** Validation will be also performed when saving the screen data in mmi format.

**Executing the Validation**

- Validating the current focused screen

  Make sure the screen you want to validate is open, and select [Validate] from the [Tools] menu.

- Validating the whole screen data (application) file

  (1) Right after performing the screen validation mentioned above, choose [Validate] from the [Tools] menu again. Confirmation dialog box arrives.

  (2) Click the **OK** Button. Then the validation will start.

  During the validation, it is not possible to perform other operation.

  After the validation has been completed the result message arrives.

**Reference:** • Please execute the validation after the creation of screen data (application).

- Validation might need a sufficient time period in case the screen data (application) itself has large size and validation for the whole data has been executed. So when “Validating for the whole data” has been performed, the confirmation dialog box appears asking whether you want to perform the validation or not. Click the **OK** Button to start the validation.

**Displaying the error log and its location**

If the error check function detects an error, a brief error message is displayed and you are requested to confirm the “error log.”

**Reference:** • The messages contents of the error log are cleared when an element or a screen is operated. Therefore, if an error is detected, display the error log window immediately to determine the details of the error. Since errors occurring during data conversion, in particular, may not reoccur if you try to check them later, they must be checked at their occurrence.
Operating the Application Manager

Section 4-2

- The results of the error check can be printed or saved in a file. For details, refer to Section 12 Making Reports.

The procedure for displaying the error log window is shown below.

1. Select [View] in the menu bar, then choose [Error Log].

   The error log window opens.

With some types of errors, double-clicking on the error message will display the screen(s) where the error has occurred.

For the meaning of error message and the solution to be taken to correct the error, refer to Appendix A Data Conversion and Appendix H Error Messages.

4-2-12 Sending (Downloading) the Data to a PT

The data created using the Support Tool can be sent (downloaded) to a PT. It is possible to send the screen data collectively or only the data of the specified screens or memory tables. Here, only the procedure is described. For details, refer to 11-3 Sending (Downloading) the Data.

Before sending the data, set the communication conditions (communication port and communication speed [Baud Rate]) by selecting [Connect] (menu bar) and [Comms. Setting].

Operation using the mouse

- Sending (Downloading) the whole data file
  1. Right click the mouse on the screen data file icon, then select [Download].

     If the screen data is free of errors, sending of the data starts immediately. A message is displayed if the data has an error.

- Sending (Downloading) specified screen
  1. Specify the screen icon.

     Multiple files can be selected by dragging the mouse cursor while pressing the Shift key or Ctrl key.

  2. Make a right click on the selected screen icon, then choose [Download].

  3. Specify if child screens of continuous/overlapping screens are also to be sent, then click the Button.

     If the screen data is free of errors, transmitting of the data starts immediately. A message will be displayed if the data has an error.
• Sending (Downloading) specified Table

(1) Right click the mouse on the table data box icon, then select [Download].

The dialog box used for specifying the table to be sent (downloaded) is displayed for PTs that allow table data to be sent in table individually. With PTs that do not allow table data to be sent table by table, sending of the data starts immediately.

(2) Specify the table to be sent (downloaded), then click the OK Button.

Reference: It is not possible to send (download) the direct access information or system memory individually. Please use the menu operation.

Operation using the menu

• Sending (Downloading) the whole data file

(1) Select [Connect] in the menu bar, then choose [Download (NT-series Support Tool → PT)] → [Application].

If the screen data is free of errors, sending of the data starts immediately. A message is displayed if the data has an error.

• Sending (Downloading) specified screen

(1) Specify the screen icon.

Multiple files can be selected by dragging the mouse cursor while pressing the Shift key or Ctrl key.

(2) Select [Connect] in the menu bar, then choose [Download (NT-series Support Tool → PT)] → [Screen].

(3) Specify if child screens of continuous/overlapping screens are also to be sent, then click the OK Button.

If the screen data is free of errors, sending of the data starts immediately. A message is displayed if the data has an error.

• Sending (Downloading) specified Tables

(1) Select [Connect] in the menu bar, then choose [Download (NT-series Support Tool → PT)] → [Table].

The dialog box used for specifying the table to be sent is displayed for PTs that allow table data to be sent in table units. With PTs that do not allow table data to be sent table by table, sending of the data starts immediately.

(2) Specify the table to be sent, then click the OK Button.

Reference: Downloading in table units may not be possible with some PT types.

• Sending the Direct Access Information and system memory

(1) Select [Connect] in the menu bar, then choose [Download (NT-series Support Tool → PT)] → [Direct Access Information] or [System Memory].

If the setting is free of errors, sending of the data starts immediately. A message is displayed if the data has an error.

4-2-13 Window Menu

The following Support Tool operations are possible using the [Window] menu.

• Opening a new window for the data creation screen that is active
• Arranging windows
• Switching windows

Reference: The Support Tool can operate windows in the same manner as other Windows applications. Here, only the functions that can be selected from the Support Tool menus are explained.

Opening a new window

To open a new window for the data creation screen that is active, follow the procedure described below.

Reference 1. Windows with the same screen number display the same contents.

2. When the same screen is displayed in two windows, elements can be copied between the windows by dragging them while pressing the Ctrl key. Usually, copying an element to a desired position in the same screen is not possible. However, if two same windows are opened, it is possible to copy an element to a desired position although they are on the same screen.

(Similarly, if different screen data files of the same PT model are opened by two Support Tools, it is possible to copy screen data between the files.)

3. When multiple windows that have the same screen number exist, the following information is displayed in the window title area (for standard screens).

\[ x \text{ Standard Screen: } y \]

(x: Screen number, y: Serial number)

Serial numbers will be assigned in the order the windows are opened. If any window presently opened is closed, the serial numbers are renumbered automatically.

4. The Support Tool can open up to ten windows at the same time in addition to the application manager window.

• Operation

(1) Specify the screen.

Click on the screen or double-click on the screen icon to open multi-windows.

(2) Select [New Window] from [Window] in the menu bar.

An additional window opens for the screen specified in step (1).

Arranging windows

Windows can be arranged in any of the following three ways.

Cascade:

All windows are cascaded in such a way that window titles are visible. All windows are displayed at the same size.

The order of cascading differs depending on the display position of the windows before the cascading operation is attempted.

Tile:

All windows are arranged over the entire main window area at the same size. However, the sizes may differ slightly, depending on the number of windows.

The order of tiling differs depending on the display position of windows before tiling operation is attempted.
Arrange Icons:
The application manager and creation screens shown in icon form are arranged in the lower left part of the main window.
The order in which the icons are displayed differs depending on the display position of the icons before the arrange icons operation was attempted.

- Operation
  1. Select [Window] in the menu bar, then choose [Cascade], [Tile], or [Arrange Icons].

  The windows are arranged according to the selected item.

Switching windows

Under the [Window] menu, up to nine windows that are open are displayed in a list.
If the number of windows is ten or more, the [More windows...] item is displayed.
The window selection dialog box opens when this item is selected.
Users can activate the particular screen to edit from [Window] in the main menu or selecting from window selection dialog box of [More windows...].
This feature brings simple operation to edit data of veiled screen.

4-2-14 Help Menu

The [Help] menu includes the following items.
- Contents
- Search for Help on
- What’s This?
- PLC Address Help
- About NT-series Support Tool

Displaying help information using the table of contents

The help information of the Support Tool is constructed so that the functions can be tracked according to the menu configuration. To display help on a specific function, display the table of contents of the help information and find help on the relevant function.

- Operation
  1. Select [Help] in the menu bar, then select [Contents].

    The table of contents of help is displayed.
  2. Select an item to display the corresponding help contents.

    In the information displayed in the help screen, items that have a link to detailed help information are underlined; click on such an item to access the detailed information.

    The necessary information will be reached by tracking the items in this way.

Reference: The button or F1 key is also used to display the table of contents for help information.

Displaying help information by searching for a keyword

Help information on a specific topic can be displayed by inputting the related keyword.
• Operation

(1) Select [Help] in the menu bar, then select [Search for Help on].
The topic search dialog box is displayed.

(2) Input a keyword.
When the keyword is input, the corresponding help item is highlighted.

(3) If you find the specified help item, click the button.
The help information relating to the specified item is displayed.

Displaying help information by clicking on a screen

The Support Tool provides the [What's This?] item that allows you to get help when an item for which you need help is displayed.

Using this feature, you can display the help information in a simple operation without tracking the table of contents or inputting a keyword.

• Operation

(1) Select [Help] in the menu bar, then select [What's This?] a
A question mark (?) is appended to the mouse cursor.

Clicking the button in the standard tool bar, also displays a question mark at the mouse cursor.

(2) Click on the item (place) for which you need help.
The corresponding help information is displayed.

Checking the input method of PLC address

PLC address dialog box is displayed when an address is allocated to an object.
If [PLC Address Help] is selected in the [Help] menu, the help about the PLC address dialog box that shows the input method of PLC address is displayed.

Checking the Support Tool version

If [About NT-series Support Tool] is selected in the [Help] menu, the dialog box that shows the version of the Support Tool is displayed.

If you have questions on the Support Tool, please check the version of your Support Tool before contacting.
SECTION 5
Screen Types

This section deals with the types of screens that can be created by the Support Tool.

<table>
<thead>
<tr>
<th>5-1</th>
<th>Types of Screens, Common Dialog Box Settings and Operations</th>
<th>80</th>
</tr>
</thead>
<tbody>
<tr>
<td>5-1-1</td>
<td>Setting the Screen Attributes</td>
<td>80</td>
</tr>
<tr>
<td>5-1-2</td>
<td>Grid Setting</td>
<td>82</td>
</tr>
<tr>
<td>5-1-3</td>
<td>Changing the Display Method on the Support Tool</td>
<td>83</td>
</tr>
<tr>
<td>5-1-4</td>
<td>Filter Function</td>
<td>87</td>
</tr>
<tr>
<td>5-1-5</td>
<td>Switching Screens by Extended I/O Input at Each Screen</td>
<td>89</td>
</tr>
<tr>
<td>5-1-6</td>
<td>Saving the Screen Image</td>
<td>90</td>
</tr>
<tr>
<td>5-2</td>
<td>Standard Screen</td>
<td>90</td>
</tr>
<tr>
<td>5-3</td>
<td>Continuous/Overlapping Screens</td>
<td>91</td>
</tr>
<tr>
<td>5-3-1</td>
<td>Continuous Screens</td>
<td>92</td>
</tr>
<tr>
<td>5-3-2</td>
<td>Overlapping Screens</td>
<td>93</td>
</tr>
<tr>
<td>5-3-3</td>
<td>Editing a Parent Screen (Modification)</td>
<td>94</td>
</tr>
<tr>
<td>5-4</td>
<td>Window/Keyboard Screens</td>
<td>94</td>
</tr>
<tr>
<td>5-4-1</td>
<td>Window/Keyboard Screens</td>
<td>94</td>
</tr>
<tr>
<td>5-4-2</td>
<td>Improved Input Key-window/Keyboard Function</td>
<td>97</td>
</tr>
<tr>
<td>5-5</td>
<td>Extended Screen</td>
<td>99</td>
</tr>
<tr>
<td>5-6</td>
<td>Occurrence History Screen</td>
<td>100</td>
</tr>
<tr>
<td>5-7</td>
<td>Frequency History Screen</td>
<td>101</td>
</tr>
<tr>
<td>5-8</td>
<td>Host Connect Screen (System Initializing Screen)</td>
<td>101</td>
</tr>
<tr>
<td>5-9</td>
<td>Password Screen</td>
<td>102</td>
</tr>
<tr>
<td>5-10</td>
<td>Menu Screen</td>
<td>103</td>
</tr>
<tr>
<td>5-11</td>
<td>Print Format Screen</td>
<td>103</td>
</tr>
<tr>
<td>5-12</td>
<td>Programming Console Screen</td>
<td>103</td>
</tr>
<tr>
<td>5-13</td>
<td>Device Monitor Screen</td>
<td>104</td>
</tr>
<tr>
<td>5-14</td>
<td>Contrast and Brightness Adjustment</td>
<td>104</td>
</tr>
</tbody>
</table>
5-1 Types of Screens, Common Dialog Box Settings and Operations

The Support Tool provides various types of screen. The screens that can be created using the Support Tool are shown below. The screens that can be used differ depending on the PT model.

- Standard screens
- Continuous/overlapping screens
- Window/Keyboard screens
- Extended screens
- Occurrence history screens
- Frequency history screens
- Host connect screens (system initializing screens)

The screen attributes and grid can be set for each screen, individually.

- Password screens
- Menu screens
- Print format screens
- Device monitor screens
- Contrast tuning screens

5-1-1 Setting the Screen Attributes

All screens have screen attributes used for setting the screen display specifications.

The information to be set as attributes, specific to the individual screens, includes screen number, screen comment, recording in display history, backlight, and buzzer control.

To display the attributes, follow any of the operations indicated below.

- [Screen] (menu bar) → [Properties]
- Right click on a screen data icon in the application manager → [Properties]
- Right click at an arbitrary position on the screen → [Properties]
- Double click at an arbitrary position on the screen
Screen No.

Specify a screen number. The screen number of an existing screen may be changed.

History (other than NT20/NT20S)

Specify whether or not the event of screen display is to be recorded in the display history record (Screen history Log). The display history function records the date/time and frequency of screen display for screens for which the [History] attribute check box is ticked. The recorded display history can be checked on the occurrence history screen and the frequency history screen.

The event of screen display is recorded in the display history if the check box of the history attribute is ticked; if it is not ticked, the event is not recorded.

Title (other than NT20/NT20S)

Specify the title of screens that are displayed in the display history.

Setting of the title is possible only when the history attribute is selected.

Comment

Set the comment for a screen. For the comment, characters of up to 24 characters can be set.

Backlight - Type

Set if the backlight is to light continuously or flash when the screen is turned ON.

Light: When the screen is turned ON, the backlight lights.
Flash: When the screen is turned ON, the backlight flashes.

This attributes cannot be set for NT600S, NT620S, NT620C, NT625C.

Backlight - Color (only for NT30)

Specify the backlight color, white or red.

Buzzer (other than NT11S/NT11)

Specify whether or not the buzzer should sound when a screen is displayed and also the type of buzzer sound.

If this attribute is selected, the buzzer sounds when a screen is displayed.

The buzzer type can be selected from the following.

Continuous: The buzzer sounds continuously.
Short: The buzzer sounds in cycles of 0.5-second beep and 0.5-second stop. (Setting is not possible for NT20, NT20S and NT600S.)
Long: The buzzer sounds in cycles of 1-second beep and 1-second stop. (Setting is not possible for NT20, NT20S and NT600S.)
Beep: The buzzer sounds in cycles of 0.5-second beep and 0.5-second stop. (Only for NT20, NT20S and NT600S)

Buzzer type setting is possible only when the buzzer attribute is selected.

Load Local 1 (Keyboard) (other than NT11S/NT11, NT20, NT20S and NT600S)

Select whether or not a local window 1 (Keyboard) pops up on the screen when standard screen is opened.
If the attribute is checked, a window (keyboard) pops up when the screen is displayed. Window (keyboard) does not pop up if the attribute is not selected. If the attribute is not set when the standard screen is created, it can be selected later to display.

Specify the screen number of window/keyboard screen to be displayed as a pop-up window/keyboard.

Window (Keyboard) will be displayed at the position specified when window/keyboard screen was created.

With NT30, NT30C, NT620S, NT620C, NT625C, and NT31, NT31C, NT631, NT631C below “-V1,” window is called a keyboard window since it is used to place keypad (touch switch) for inputting numeral/string.

With the NT21 and with the NT31, NT31C, NT631 and NT631C with “-V1” and above, it is simply called a window since all kinds of objects other than thumbwheel can be registered on it. For details of window/keyboard screen, refer to 5-4 Window/Keyboard Screens.

Load Local 2 (NT21 and NT31, NT31C, NT631, NT631C with “-V1” and above)

Select whether or not a local window 2 pops up on the screen when standard screen is opened.

If the attribute is checked, window pops up when the screen is displayed. Window does not pop up if the attribute is not selected. If the attribute is not set when the standard screen is created, it can be selected later to display.

Specify the screen number of window screen to be displayed as a pop-up window.

Window is displayed at the position specified when window/keyboard screen was created.

For details of window/keyboard screen refer to 5-4 Window/Keyboard Screens.

System Keypad (other than NT11S/NT11, NT21, NT31, NT31C, NT631 and NT631C)

Specify whether or not the keypad that is automatically created by the system is used for setting numerals or strings.

If the attribute is selected, the system keypad is used and it is not used if the attribute is not selected.

Color - Background (NT30, NT30C, NT31C, NT620C, NT625C, NT631C)

Set the background color.

5-1-2 Grid Setting

Specify the grid used for drawing.

The grid is used as the guide when drawing an element. When the grid is selected, dots are set in the specified spacing.

The grid can be set so that the specified points of an element being drawn are positioned at grid points.

To display the attributes, follow any of the operations indicated below.

• [Attributes] of screen property →
5-1 Section
Types of Screens, Common Dialog Box Settings and Operations

Grid Size - Custom
Set the grid spacing in the horizontal and vertical directions to create the grid of the desired spacing, respectively.

- Horizontal Spacing: Specify the grid spacing in the horizontal direction as a number of dots.
- Vertical Spacing: Specify the grid spacing in the vertical direction as a number of dots.

Grid Size - Touch Switch Grid
If this attribute is selected, grid spacing equivalent to the size of a touch switch is set. The actual size differs depending on the PT model.

Display Grid
Specify whether or not the grid is displayed.
To display the grid, tick the check box of this attribute. If you want not to display the grid, cancel the tick in the check box.

Snap to Grid
Specify if the specified position of an element being drawn is automatically adjusted so that it coincides with a grid position.
To adjust the element position, tick the check box of this attribute. If adjustment is not necessary, cancel the tick in the check box.

Reference:
- When saving screen data using mmi format, grid setting information and grouping information will not be stored. (Refer to 3-3-3 Saving the Screen Data (Application) File.)
- It is possible to select whether to print screen grid or not when printing screen image. (Refer to 12-2-2 Output to a Printer.)
  If grid is to be printed, the grid setting of each screen will be included in the screen image.

5-1-3 Changing the Display Method on the Support Tool
The procedures for changing the screen display method and displaying the information on elements are indicated below.

Reference: In addition to the display methods indicated below, Support Tool has a filter function that displays only the elements of the selected type. (Refer to 5-1-4 Filter Function.)

Confirming full tiling status
When [Full Tiling] is selected in the [View] menu with a tick mark entered on the left side of the menu item, the element is displayed on the Support Tool screen in the tiled status.
Reference:  • There may be differences in element display order and details in display between the Support Tool and a PT. Therefore, results of tiling may be different in the display obtained at a PT and that confirmed by the Support Tool.

• When a filter function is used for a fixed display, Full Tiling will be automatically cancelled (confirmation message will be displayed) since the tiled status may not be displayed correctly if the object used as a border is hidden by a filter function.

Displaying element information (Show Tag)

The Support Tool can display the following element information on the screen at the same time.

<table>
<thead>
<tr>
<th>Information Displayed on the Screen</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC (PLC) address</td>
<td>PC (PLC) bit addresses of lamp settings (light function) for lamps, PC (PLC) addresses of lamp settings for touch switches, or PC (PLC) addresses of notification (notify) bits are displayed. For a touch switch with the notification bit function, both PC (PLC) address of the notification (notify) bit and lamp setting are displayed (upper: notify bit, lower: lamp bit), and for touch switches with other functions, the PC (PLC) addresses of lamp settings (light function) are displayed. The first character represents the type of element as shown below. (In case of touch switch, the first character for lamp bit is also represented by a T.) L: Lamp T: Touch switch The second character represents the area type of PC (PLC) addresses. Example (PLC Vendor: OMRON) Blank: CIO area H: HR area A: SR area L: LR area D: DM (Data Memory) area E: EM Current Bank For characters that indicates area type of Mitsubishi, refer to page 131.</td>
</tr>
</tbody>
</table>
Types of Screens, Common Dialog Box Settings and Operations

### Table No.

<table>
<thead>
<tr>
<th>Information Displayed on the Screen</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table No.</td>
<td>The table entry number of the Numeral or Character String Memory Table (String Table) that is referenced for a numeral display, (character-)string display, bar graph, numeral setting input, (character-)string input, or thumbwheel switch is displayed. The first character represents the type of table as shown below. <strong>N:</strong> Numeral memory table <strong>S:</strong> Character String Memory Table (String Table)</td>
</tr>
<tr>
<td>Image and library code</td>
<td>The code of image and library data of a fixed display is displayed as a hexadecimal number.</td>
</tr>
</tbody>
</table>

Multiple sets of the element information described above can be displayed at the same time. If they are set for a single element, the information is displayed according to the priority shown below.

**PC (PLC) address > Table entry number > Image and library data code**

Setting for the display of element information is possible for all the editing screens.

The display method for element information is set in the manner shown below.

1. Select [View] in the menu bar, then choose [Show Tag].
   - The menu shows the items that can be set.
   - The items for which display is presently set are identified by a tick.

2. Select any of [PLC Address], [Table No.], and [Image and Library Code] to change whether element information should be displayed or not.
   - Each time a menu item is selected, the tick mark is set, or canceled, alternately. When a tick mark is displayed, the specified element information is displayed.

#### Inverting and flashing the objects

Some of the objects have Inverse, Flash, and Inverse Flash attributes. Inverse status is always reflected on the screen. Flash display can be checked by specifying the Simulate Flash command. (It is possible to view Inverse Flash state also.)
“Simulate Flash” is applied to each screen individually.
To activate this setting, follow the procedure below.

1. Select “Simulate Flash” from the [View] menu. (or click on the button.)
   In the [View] menu, the check mark is set to ON and OFF each time it is selected.
   When the check mark is displayed, the objects that have Flash or Inverse Flash attribute show their flashing status.
   Each time the “Simulate Flash” button is clicked, it changes as follows:
   - : Flash status being shown
   - : Flash status not shown

**Lighting and flashing the lamps/touch switches**

For lamps and touch switches, it is possible to specify PLC address for lamp setting. Lamps and touch switches light (flash) according to the status of the host bit. When the PLC address for lamp setting goes to 1 (ON), they light or flash. (Whether they light or flash is determined by the lamp attribute set to the object.) With the Support Tool, ON status of lamps and touch switches can be checked on the screen.

The Simulate ON/OFF setting is applied to all the screens being displayed.

**Reference:**
- In case of image lamp, ON state image and dotted line indicating the position of OFF state image is shown when the state is ON, and OFF state image and dotted line indicating the position of ON state image is shown when the state is OFF.

- With the NT21 and NT31/631-V2 and above, the contents of a label can be specified for each ON and OFF state. The display of the label is changed according to the status of the lamp or the touch switch.

- Display of lamp ON/OFF status may differs between the Support Tool and PT for the following cases.
  - ON color when lamps/touch switches are overlapped.
  - ON color of lamp/touch switch label when using NT30C, NT620C/NT625C.
  - ON status of lamp/touch switch when overlapping with other object (other than fixed display)

To activate this setting, follow the procedure below.

1. Select [Simulate ON/OFF] from [View] menu. (or click on the button)
   In the [View] menu, the check mark is set to ON and OFF each time it is selected.
   When the check mark is displayed, the lamps and touch switches show their ON statuses.
   Each time the Simulate ON/OFF button is clicked, it changes as follows:
   - : Lamp ON status being shown
   - : Lamp ON status not shown

**Redrawing the editing Screen (Refresh)**

In case the screen has disrupted during the edition of the screen, Refresh function will help you redrawing the screen.

Redrawing can be performed as follows:

1. Select [Refresh] from the [View] menu. The screen will be updated.
Displaying Full Screen (Full Screen)

This is available in case if you want to view the screen in wide range. (But is impossible to edit while displaying in full screen.)

Full Screen can be performed as follows:

(1) Select [Full Screen] from [View] menu. The current editing screen will be displayed in wide range.

To recover from this condition, click at any place on the screen.

Zoom

Zooms the screen to 100% view (Normal), 200%, 400% or 800%. If the grid is set, it will also be zoomed to the respective size.

It will help you to operate small elements. Zoom can be performed as follows:

(1) Select [Zoom] from [View] menu. On this menu, current zoom percentage is displayed using check mark.

Displaying window/keyboard (Show Window/Keyboard)

Local window (Keyboard) set for attribute of currently displayed screen can be displayed overlapping on the screen to check the actual status to be displayed on PT.

Local window 2 is available only with the NT21 and with the NT31, NT31C, NT631 and NT631C with “-V1” and above.

Show Window/Keyboard command can be performed as follows:

(1) Open a property sheet of the screen and set a check mark for the window type to be displayed and specify the screen number.

(2) Select [Show Window/Keyboard] from the [View] menu and specify the window/keyboard type to be displayed (Local 1 (Keyboard) or Local 2). Check mark will be set on menu next to the name of the displayed window type.

Each time you select window, the check mark switches to the objective one and according to it, window/keyboard display will be changed.

5-1-4 Filter Function

Support Tool has a filter function that can show only the specified object on the screen.

It is possible to edit/select objects while this function is executed. So it will be useful when you correct or edit complicated screen. In addition, it is possible to display the list of each object by types if this function is used with Select Object function. (For details, refer to the Reference.)

Filter function is applied to individual screen.

To activate this setting, follow the procedure below.
(1) Select the object to be displayed from the combo box on the utility bar. To display all the objects (cancel filter function), select “All.”

Reference: While a filter function is used, you can edit only the objects being displayed.

- If the Select Object dialog box (refer to page 109) is displayed by right-clicking the object while a filter function is used, only the type of object being displayed is shown in the list. In this case, the type name of the object will not be displayed in the Select Object dialog box and detailed information of objects is shown.
- If a filter function is used for a Fixed Display, Full Tiling ([View] menu) will be cancelled automatically since the tiled status may not be displayed correctly if the element used as a border is hidden by a filter function. (Confirmation message is displayed.)
- With a filter function, only one type of object can be specified. It is not possible to select two or more objects, such as a Touch Switch and Bar Graph.

Reference: When the operations indicated below are performed while a filter function is being used, the filter function will be reset and returned to “All.”

<table>
<thead>
<tr>
<th>Operation</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>File→Print</td>
<td>When the user performs this operation, the screen will refresh and then the operation will be performed.</td>
</tr>
<tr>
<td>File→Print Preview</td>
<td></td>
</tr>
<tr>
<td>Edit→Paste</td>
<td></td>
</tr>
<tr>
<td>Edit→Align</td>
<td></td>
</tr>
<tr>
<td>Draw→Associate With</td>
<td></td>
</tr>
<tr>
<td>Draw→Disassociate</td>
<td></td>
</tr>
<tr>
<td>Draw→Set Order</td>
<td></td>
</tr>
<tr>
<td>Draw→Group</td>
<td></td>
</tr>
<tr>
<td>Draw→Ungroup</td>
<td></td>
</tr>
<tr>
<td>All menu items under “Object”</td>
<td>This includes all creation of screen elements using the menus and toolbar except the object specified on the filter.</td>
</tr>
<tr>
<td>Connect→Download</td>
<td>When the user performs this operation, the screen will refresh and then the operation will be performed.</td>
</tr>
<tr>
<td>Connect→Upload</td>
<td></td>
</tr>
<tr>
<td>All the references from the table</td>
<td>When the user chooses the reference from the table, the filter will be reset to ALL.</td>
</tr>
</tbody>
</table>
5-1-5 Switching Screens by Extended I/O Input at Each Screen

It is possible to make a setting so that the specified screen is displayed when the input of the extended I/O that is connected to the PT is turned ON. The following two setting methods are provided to switch the screen by extended I/O input.

Note that this setting is possible only for NT30 and NT30C.

Common setting for all screens:

Regardless of the screen presently displayed, the specified screen is always displayed when the extended I/O input is turned ON.

Select [Table] from [Tools] in the menu bar. Then click the tab of Extended I/O Input to set the Switch screen.

Setting for the individual screens:

It is possible to set the screen to be displayed in response to turning ON of the extended I/O input for each screen.

For this setting, select [Extended I/O] from [Screen] in the menu bar.

For example, this setting allows the display screen to change sequentially from screen No. 1 to screen No. 2, then to screen No. 3 in response to turning ON of the extended I/O input. If the extended I/O input 0 goes ON while screen No. 1 displayed, the screen switches to screen No. 2, then if the extended I/O input 0 goes ON while screen No. 2 displayed, the screen switches to screen No. 3. To allow screens to be changed in this way, set [Switch Screen No. 2] for [Extended I/O] at screen No. 1, and [Switch Screen No. 3] for [Extended I/O] at screen No. 2.

Here, only the setting for screen switching at the individual screens is described. Operations of the Extended I/O Input table and the common setting to all screens are described in 7-5 Extended I/O Input Table.

The procedure for setting the screen to be displayed on turning ON of the extended I/O input at each screen is shown below.

1. Select the screen for which [Extended I/O] is to be set to place the screen in edit enabled state.

2. Select [Screen] in the menu bar, then select [Extended I/O]. An extended I/O input table dialog box is displayed.

3. Select the extended I/O input row where setting is to be done, and click on .
An extended I/O input setting dialog box is displayed.

(4) Set [Switch Screen] for [Function] and the screen number of the screen to be displayed for [Screen No.].

5-1-6 Saving the Screen Image

The Support Tool provides a function to save the displayed screen image in a bit map file as it is.

The grid display status and Show Tag can be also saved.

The following describes the procedure for saving the screen image.

1) Select the screen that is going to be saved in a file so that it can be edited.

2) Select [Screen] in the menu bar, then select [Copy to Image].
   
   A dialog box is displayed to set a file name.

3) Set the folder and file name, then click on [Save].
   
   The screen image is saved to the specified file.

5-2 Standard Screen

A standard screen is the base screen for the display at a PT.

Screen numbers of standard screens differ depending on the PT model. The table below shows the screen numbers that can be used for a standard screen.
5-3 Continuous/Overlapping Screens

Continuous/overlapping screens are multiple screens that are switched consecutively or overlapped for display.

Screens that are switched consecutively are called continuous screens and screens that overlap multiple screens are called overlapping screens.

Screen numbers that can be used for continuous/overlapping screens are same as those for standard screens. Note that continuous screens cannot be used with the NT21, NT31, NT31C, NT631, and NT631C. To obtain the same effect as continuous screens with these PT models, use touch switches that are assigned the switch screen function.

Reference: The application manager displays a parent screen as a folder as shown below and child screens are displayed when the folder is opened.

For NT11S/NT11, parent screen setting is not possible.
5-3-1 Continuous Screens

Two to eight screens can be registered for one continuous screen. The base screen where multiple screens are registered is called a parent screen and multiple screens registered to the parent screen are called child screens.

When screen No. 10 is specified, the first continuous screen, screen No. 20, is displayed. Pressing touch switch \( \downarrow \) changes the screen to screen No. 15. Pressing the touch switch again changes the screen to screen No. 1.

Since the screen of screen No. 10 is set as the parent screen of continuous screens, it cannot be displayed independently.

Screens set as continuous screens are switched by the pressing of the touch switches \( \downarrow \) and \( \uparrow \), for which system key functions are allocated.

In the parent screen setting dialog, show page number can be set or reset to indicate currently activated child screen number out of total pages on the upper right corner of the parent screen.

Child screens should be created on standard screens in advance.

Continuous screens are set in the procedure described below.

1. Create child screens using standard screens.
3. In the parent screen setting dialog box, set a parent screen number, child screen numbers, and whether or not a page number is displayed.

   a. Set the number of the parent screen for [Screen No.] in [Parent].
   b. Select [Continuous].
   c. If necessary, tick [Show Page Number].
   d. Specify child screens.

   Select screens that are specified as child screens by selecting them from the [Standard] field, then click on \( \Rightarrow \). The selected screen moves to the [Child] field. If a wrong number is moved, click on \( \Rightarrow \) : the screen returns from the [Child] field to the [Standard] field.
Two to eight screens can be registered as child screens.
e. Modify the screen switching order.
Child screens are displayed in the order they are set in the [Child] field.
The setting order of the child screens can be modified using [Move Up] and
[Move Down].
f. Click on [OK] after the completion of child screen setting.

When creating continuous screens with NT20, NT20S and NT600S, it is recom-
mended to create Switch Screen touch switch.

5-3-2 Overlapping Screens
Overlapping screens allow two to eight screens to be displayed as one screen.
(For the NT21, NT31, NT31C, NT631, and NT631C, one to eight screens can be
set.) The base screen of an overlapping screen is called the parent screen and
multiple screens that are the constituents of the overlapping screens are called
child screens.

![Diagram of overlapping screens]

When screen No. 8 (parent screen) is specified, the elements set on the screens
No. 10, No. 7, and No. 25 are overlapped for display on the parent screen.
Since the screen of screen No. 8 is set for a parent screen for overlapping
screens, it cannot be displayed independently.
In the setting for a parent screen, screen numbers of a parent and child screens
are set.
Child screens should be created on standard screens in advance.
Overlapping screens are set in the procedure indicated below.
(1) Create the child screens on standard screens.
(2) Specify [Parent Screen] from [New] command in [Screen].
(3) In the parent screen setting dialog box, set a parent screen number and child
screen numbers.
a. Set the screen number of a parent screen for [Screen No.] in [Parent].
   If the screen number has already existed, it cannot be registered as a parent screen.

b. Select [Overlapping].

c. Specify child screens.
   Select a screen that is specified as a child screen by selecting it from the [Standard] field, then click on \[Insert\].
   The selected screen moves to the [Child] field. If a wrong number is moved, click on \[Remove\]: the screen returns from the [Child] field to the [Standard] field.

   Two to eight screens can be registered as child screens.

   For the NT21, NT31, NT31C, NT631, and NT631C, one to eight screen can be registered as child screen.

d. Modify the screen switching order.
   Child screens are overlapped in the order they are set in the [Child] field.
   The setting order of the child screens can be modified using \[Move Up\] and \[Move Down\].

e. Click on \[OK\] after the completion of child screen setting.

5-3-3 Editing a Parent Screen (Modification)

The type (continuous/overlapping) and configuration of a created parent screen can be modified.

The procedure for modifying a parent screen is indicated below.

(1) Specify the parent screen that you want to modify from the application manager, or display the pop-up menu by right clicking the mouse on the parent screen.

(2) Select [Screen] in the menu bar, then choose [Modify Parent], or select [Modify] in the pop-up menu.
   The parent screen modify dialog box is displayed.
   The procedure for modifying the setting is the same as setting for new parent screen information. Refer to 5-3-1 Continuous Screens or 5-3-2 Overlapping Screens.

Reference: If a parent screen is copied on the application manager, child screens are also copied. (When two Support Tools are started up, the same operation is possible between the Support Tools.)
   For details of screen copying, refer to 4-2-4 Copying a Screen.

5-4 Window/Keyboard Screens

5-4-1 Window/Keyboard Screens

A window/keyboard screen is used as a window screen for the pop-up window/keyboard function. It means a partially display window that contains a keypad or other elements to overlap on the base screen.

Note that window/keyboard screen cannot be used with NT11S/NT11, NT20, NT20S, and NT600S.
With NT30, NT30C, NT620S, NT625C and NT31, NT31C, NT631, NT631C below “-V1,” only one window can be opened at a time and objects that can be registered are limited mainly to those used for inputting numeral/string as follows (with these PTs, this window is called a keyboard screen):

- Fixed displays
- Touch switches (Notify bit, cursor move and print screen functions are not permitted.)
- Numeral/string setting input filed (Only one input field can be set.)

Other elements are not displayed when the window/keyboard screen is opened as a window although they can be registered for the window/keyboard screen.

With the NT21, and with the NT31, NT31C, NT631, and NT631C “-V1” and above, up to three windows can be opened at the same time and all objects other than thumbwheels and recipes can be registered. (However, only one input field of numeral/string input can be registered.)

The pop-up display frame specifies the display range and display position of a pop-up window/keyboard, the size and position of the frame can be specified as follows:

- NT30, NT30C, NT620S, NT620C, NT625C: Specify by 1 dot unit
- NT21, NT31, NT31C, NT631, NT631C: Specify by 20 dot

The pop-up function displays only the area enclosed by the pop-up display frame.

**Reference:**
- Since the same memory area is shared by a pop-up window/keyboard and print screen function, it is not possible to open the window during the printing process. Moreover, it is also not possible to print from PT during the window is opened.
- With PT models other than the NT21 and the NT31, NT31C, NT631, and NT631C “-V1” and above, communication with a PC (PLC) is not possible for elements that are displayed in a keyboard/window. Therefore, the lamp bit of a touch switch in a window cannot be controlled.
- While a window is open, display processing may be slowed a little.

Touch Switch functions that can be set on Window/Keyboard screen:
- NT30, NT30C, NT620S, NT620C, NT625C:
  - Notify Bit
  - Switch Screen
Changing the size and the position of pop-up display frame

The procedure for changing the size and the position of a pop-up display frame is shown below.

1. Click the mouse on a dotted line of the pop-up display frame.
   Green ■ (handles) appear around the pop-up display frame.
   (Arrows in the handle indicates the direction to be resized.)

2. The frame size can be changed by dragging a handle.
   When the mouse cursor is positioned on a handle, the shape of the mouse cursor changes as shown below according to the handle position. When the mouse cursor is dragged in this state, the pop-up display frame size changes in the direction the arrow symbol of the mouse cursor indicates.

   - Right-left handle
   - Up-down handle
   - Apex handle
(3) To move the pop-up frame, drag any position in the dotted lines other than handles.

When the mouse cursor is positioned on dotted lines other than at handles, the shape of mouse cursor changes as shown below. The pop-up display frame moves when the mouse cursor is dragged in this state.

![Cursor Diagram]

(4) After the size and the position of the pop-up display frame are determined, click on an arbitrary point in the screen other than the pop-up display frame.

The size and the position of the pop-up display frame are set and the handles are cleared.

To change the size and the position of the pop-up display frame, repeat the procedure shown above from step (1).

Reference: The size and position of the pop-up display frame can be specified as follows:

- NT30, NT30C, NT620S, NT620C, NT625C: Specify by 1 dot unit
- NT21, NT31, NT31C, NT631, NT631C: Specify by 20 dot

### 5-4-2 Improved Input Key-window/Keyboard Function

This section describes input key-window/keyboard function that was improved for the NT21 and the NT31, NT31C, NT631 and NT631C “-V1” and above.

#### Types of windows

Following two types of windows are available.

**Global window**

This window can be kept displaying all the time regardless of the screen displayed on PT. Global window stays at the same position even when the displayed screen is switched. (Global window will be closed automatically when the screen other than user screen was displayed, and will be re-displayed when the screen was switched back to user screen.)

Only one global window can be displayed at a time.

It can be opened, closed or moved only by the operation of Window Control Area from the host. For details of Window Control Area, please refer to the operation manual of PT.

**Local window**

This window will be closed when the screen displayed on PT is switched.

By setting local window for attribute of each screen, specified window can be opened at the same time the screen is opened.

Up to two local windows can be opened at the same time. (Local window 1, Local window 2)

Local window can be opened, closed or moved by following operations.

- Setting screen attribute (Opens when the screen is displayed.)
Touch switch operation (By Input key-window/keyboard touch switch and window move touch switch)

Operation of Window Control Area from the host

Types of windows can be specified when opening the window.

It is possible to open same window as a Global window or as a Local window.
(However, multiple display of the same window is not possible.)

**Opening/Closing and moving a window**

Window can be controlled by the following operations.

**Opening windows by setting screen attribute**

When creating screen using Support Tool, up to two windows can be selected to be displayed when opening the screen.

By this method, window is displayed at the position that was specified when window screen was created. This type of window will be local window. For details of the setting, refer to 5-1-1 Setting the Screen Attributes.

**Opening/Closing and moving a window by touch switch operation**

To create input key-window/keyboard touch switch on a screen or a window enables to open/close specified window.

By this method, window is displayed at the position set for touch switch property.

This type of window will be local window.

Also, by creating window move touch switch on window, it is possible to move window by touch panel operation at PT.

For details of touch switch settings, refer to 6-8 Touch Switches.

It is not possible to control global window by touch panel operation.

**Opening/ Closing and moving a window by the operation of Window Control Area**

Window Control Area is added for the NT21 and the NT31, NT31C, NT631 and NT631C “-V1” and above as a direct access area.
While running PT, by writing window screen number or x, y co-ordinate of window position (bottom left) at Window Control Area from the host, opening/closing, moving a window are possible.

Window Control Area can control global window and local window. For details, refer to the operation manual of PT.

Size and display position of window (the NT21 and the NT31, NT31C, NT631, NT631C “-V1” and above)

With the NT21 and the NT31, NT31C, NT631, and NT631C “-V1” and above, size of window can be specified freely by 20 dot unit. (Minimum window size: 20 × 20)

It is possible to display a window at a different position from where it was created, or to move a window.

However, the distance between the position where window was created and where it is displayed have to be always multiple of 20 dot.

Reference: Specify the bottom left co-ordinate of window when specifying the window position at Window Control Area.

Checking the display status of a window

Whether window is opened or closed will be written to the PT Status of the PT Notify Area.

Window screen number and window position (bottom left co-ordinate) of currently displayed screen will be written to Window Control Area.

Checking these areas from the host enables to know the display status of window. For details, refer to the operation manual of PT.

5-5 Extended Screen

An extended screen is used by the expansion function of a PT.

Although an extended screen can be used in the same manner as a standard screen, it should not be used unless absolutely necessary since it is used by the expansion function.
If data is registered as a standard screen, the registered data is given priority. The screen numbers used for an extended screen are indicated below.

<table>
<thead>
<tr>
<th>PT Model</th>
<th>Screen No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT11S/NT11, NT20, NT20S, NT600S</td>
<td>None</td>
</tr>
<tr>
<td>NT30, NT30C, NT620S, NT620C, NT625C</td>
<td>1980 to 1996</td>
</tr>
<tr>
<td>NT21, NT31, NT31C, NT631, NT631C</td>
<td>None</td>
</tr>
</tbody>
</table>

### 5-6 Occurrence History Screen

An occurrence history screen displays the screen numbers recorded by the display history (Screen History) function in the order of displayed date and time. This function records the date/time of display and the number of times the screen was displayed for the screens for which the [History] attribute is ticked in the screen property.

The occurrence history screen, provided with NT30, NT30C, NT620S, NT620C, and NT625C, has a blank area at the right side in the screen so that scroll and screen switching touch switches can be created. Other area of the screen must not be changed.

The screen number of the occurrence history screen is indicated below.

<table>
<thead>
<tr>
<th>PT Model</th>
<th>Screen No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT11S/NT11, NT20, NT20S, NT600S</td>
<td>None</td>
</tr>
<tr>
<td>NT30, NT30C, NT620S, NT620C, NT625C</td>
<td>1997</td>
</tr>
<tr>
<td>NT21, NT31, NT31C, NT631, NT631C</td>
<td>9001*</td>
</tr>
</tbody>
</table>

*: Cannot edit (Only display is possible.)

The screen to be displayed differs according to the PT model.

**Example:** For NT30, NT30C

![Occurrence History Screen](image)

**[No.] (NT30/NT30C), [Screen No.] (NT620S/NT620C/NT625C)**

Indicates a screen number.

**[Date] (NT30/NT30C), [Time] (NT30/NT30C)**

([YY/MM/DD HH:MM]) (NT620S/NT620C/NT625C)

Indicates the date and time the screen was displayed.

**[Cnt.] (NT30/NT30C), [Frequency] (NT620S/NT620C/NT625C)**

Indicates the number of times the screen has been displayed.

**[Message]**

Indicates the [Title] of the screen attribute.
5-7 Frequency History Screen

A frequency history screen displays the screen numbers recorded by the display history (Screen History) function in the order of frequency of screen display. This function records the date/time of display and the number of times the screen has been displayed for screens for which the [History] attribute is ticked in the screen property.

The frequency history screen, provided with NT30, NT30C, NT620S, NT620C, and NT625C, has a blank area at the right side in the screen so that scroll and screen switching touch switches can be created. Other area of the screen must not be changed.

The screen number of the frequency history screen is shown below.

<table>
<thead>
<tr>
<th>PT Model</th>
<th>Screen No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT11S/NT11, NT20, NT20S, NT600S</td>
<td>None</td>
</tr>
<tr>
<td>NT30, NT30C, NT620S, NT620C, NT625C</td>
<td>1998</td>
</tr>
<tr>
<td>NT21, NT31, NT31C, NT631, NT631C</td>
<td>9002*</td>
</tr>
</tbody>
</table>

*: Cannot edit (Only display is possible.)

The screen to be displayed differs according to the PT model.

Example: For NT30, NT30C

[No.] (NT30/NT30C), [Screen No.] (NT620S/NT620C/NT625C)
Indicates a screen number.

[Date] (NT30/NT30C), [Time] (NT30/NT30C)
[(YY/MM/DD HH:MM)] (NT620S/NT620C/NT625C)
Indicates the date and time the screen was displayed.

[Cnt.] (NT30/NT30C), [Frequency] (NT620S/NT620C/NT625C)
Indicates the number of times the screen has been displayed.

[Message]
Indicates the [Title] of the screen attribute.

5-8 Host Connect Screen (System Initializing Screen)

The host connect screen is displayed for the start of PT operation until communication with the PC (PLC) is established.

This screen can be created freely using only fixed display.

In case host connect screen is not registered, a default screen indicating that PT is trying to connect to the host will be automatically displayed at the time PT power is switched on or when the mode is changed to the RUN mode.
The screen number of the host connect screen is shown below.

<table>
<thead>
<tr>
<th>PT Model</th>
<th>Screen No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT11S/NT11, NT20, NT20S, NT600S</td>
<td>None</td>
</tr>
<tr>
<td>NT30, NT30C, NT620S, NT620C, NT625C</td>
<td>1999</td>
</tr>
<tr>
<td>NT21, NT31, NT31C, NT631, NT631C</td>
<td>9000</td>
</tr>
</tbody>
</table>

**Reference:** For the NT21, NT31, NT31C, TN631, and NT631C, it is called a System Initializing Screen.

### 5-9 Password Screen

A Password screen is treated as one of the 250 Standard screen in NT11S/NT11. It is used to protect another screen by password. When a password screen is displayed on the NT11S/NT11 PT, it forces the user to enter the correct password before bringing up the designated screen.

The figure above shows a new password screen created. It has a text element with “password” as labeled. Next to the text element is the password element that indicates the current password for this password screen. In the password property page, you can set the password and the designated screen number to be displayed next.
5-10 Menu Screen

A Menu Screen is treated as one of the 250 Standard screens in NT11S/NT11. It serves as a control screen that maps a numeric key inputs onto a designated screen. A maximum of 4 designated screens for each of the numeric keys 1 to 4 can be specified in the menu screen property page.

5-11 Print Format Screen

The Print Format Screen has the screen number 255 in NT11S/NT11. It creates a format for PT printing function mainly for the daily printing. You can only use Numerical and String display to create the format.

5-12 Programming Console Screen

The Programming Console Screen is used to access the Programming Console functions built into the PT. Displaying the Programming Console Screen during PT operation enables using the Programming Console functions without displaying the System Menu. PT operation, however, will stop while the Programming Console Screen is displayed.

Refer to the User’s Manual or Reference Manual for your PT for details on the Programming Console functions.

The Programming Console Screen can not be edited on the Support Tool.
### 5-14 Contrast and Brightness Adjustment

This is a system-defined screen and cannot be created or viewed on NTST. The application manager will not list this screen. Contrast and Brightness Adjustment is used for tuning the contrast and brightness of the PT screen without the need to disconnect from the PLC.

The screen number designated is 9030.

PT models that support this requirement are as follows:
- NT31-V2 (System Ver3.1),
- NT31C-V2 (System Ver3.1),
- NT631C-V2 (System Ver3.1). (NT631C-ST141 only)

This screen can be accessed using the following functions:

1. **Touch switch** – Switch screen
2. **Bit memory table** – Switch screen function
3. **Bit memory table** – Alarm function
SECTION 6
Element Operating Procedures

Screen data for a PT is created by arranging elements on a screen.
Elements are classified into two groups, elements for display and those used for inputting data at a PT.

6-1 Common Operation .................................................. 107
  6-1-1 Creating an Element ........................................... 107
  6-1-2 Pop-up Edit Menu ............................................... 107
  6-1-3 Selecting an Element ........................................... 108
  6-1-4 Modifying an Element ......................................... 112
  6-1-5 Copying, Cutting, Pasting, and Deleting Elements .......... 113
  6-1-6 Aligning Elements ............................................. 116
  6-1-7 Grouping Elements ............................................ 118
  6-1-8 Associating Elements with the Touch Switch ............... 119
  6-1-9 Centralizing the Label of Lamp and Touch Switch ........... 119
  6-1-10 Setting Properties ........................................... 120
   6-1-11 Relationships between Elements and Memory Tables ....... 136
  6-1-12 Interlock ..................................................... 136
6-2 Fixed Display .......................................................... 138
  6-2-1 Polyline .......................................................... 138
  6-2-2 Arc .............................................................. 140
  6-2-3 Rectangle ....................................................... 141
  6-2-4 Circle ............................................................ 142
  6-2-5 Polygon .......................................................... 144
  6-2-6 Sector ........................................................... 146
  6-2-7 Text ............................................................. 147
  6-2-8 Tiling ............................................................ 149
  6-2-9 Image Object Data ............................................. 152
  6-2-10 Mark ............................................................ 155
  6-2-11 Library Object (Data) ....................................... 157
6-3 Alarm ................................................................. 161
  6-3-1 Alarm List ....................................................... 161
  6-3-2 Alarm History ................................................... 167
6-4 Data Input ............................................................. 173
  6-4-1 Numeral Input ................................................... 173
  6-4-2 Character String Input ........................................ 181
  6-4-3 Thumbwheel Switch ............................................ 189
6-5 Lamps ................................................................. 194
  6-5-1 Standard Lamps ................................................ 194
  6-5-2 Image/library Lamps .......................................... 199
6-6 Numeral Display ..................................................... 202
6-7 Character String Display ........................................... 206
6-8 Touch Switches ....................................................... 209
  6-8-1 Input Notify Touch Switch .................................... 216
  6-8-2 Switch Screen Touch Switch .................................. 217
  6-8-3 (Character) String Input Touch Switch ...................... 217
  6-8-4 Pop-up Window/Keyboard Function Touch Switch .......... 218
  6-8-5 Control Code Input Touch Switch ............................ 219
  6-8-6 Copy Setting Touch Switch ................................... 222
  6-8-7 Cursor Moving Touch Switch .................................. 223
  6-8-8 Window Moving Touch Switch ................................. 225
  6-8-9 Print Screen Touch Switch .................................... 225
6-1 Common Operation

Operations common to all element creation steps are shown below.

6-1-1 Creating an Element

To create an element, specify the element to be created and click the mouse at the position where the element is to be placed.

(1) Specify an element.

Menu bar: [Objects] → Select the objects to be created.

Drawing toolbar: Click on the icon of the object to be created.

(2) Click the mouse after placing the mouse cursor at the position where you want to create the specified element.

The elements shown below can be dragged to change the size of the elements instead of clicking the mouse when the element is positioned.

Circle, Arc, Sector, Polyline, Polygon, Rectangle, Touch switch, Standard lamp, Bar graph, Analogue meter, Broken-line graph, Trend graph

After placing the element by clicking or dragging, the dialog box for setting the property of the element is automatically displayed. (The procedure to open the property setting dialog box is omitted.)

(3) In the displayed dialog box, set the property of the element. Change the size and the shape as required.

The selection of an element, the object to be created, is canceled on completion of the drawing of a graphic.

To draw graphics with the same element continuously, you can maintain the element’s selected status by pressing the Shift key when releasing the left mouse button after the clicking or dragging.

Reference: The dialog will be displayed each time the element is created even when the Shift key is being pressed to draw the same element continuously. In case of Polyline however, the dialog will be displayed only for the last element that was created immediately after the Shift key is released.

6-1-2 Pop-up Edit Menu

The Support Tool provides pop-up menus where functions used for editing are collected.

The pop-up edit menu is displayed by clicking the right button of the mouse.

Items displayed in the pop-up edit menu are common to most of all elements.

(1) Select an element.
(2) Right click the mouse.

6-1-3 Selecting an Element

To edit or move an element, select the created element.

When an element is selected, marks (handles) are displayed to enclose the selected element.

Reference: Arrows in the handle indicate the direction to which the size of the element can be changed. When the mouse cursor is set on the handle, the shape of the cursor is changed to an arrow of the same direction.

• Selecting an element using a mouse
  Click the element you want to select.

• Selecting an element using a Tab key
  Each time the Tab key is pressed, elements are selected one by one according to the display order. (If no elements are selected, the element of the highest display order will be in selected status when the Tab key is pressed.)
  When the Shift + Tab keys are pressed together, the selection order will be reversed.

Selecting an element from among overlapped elements

When elements are overlapped complicatedly, use the element selection function below.

Reference: When you click on the overlapped elements, the element with the smallest area enclosing the point of selection will be selected. However, if you want to select an element A that is enclosed by other element, like in the figure below, it is not possible to select element A if the element enclosing it is already selected. In this case, click any position on the screen where no element is registered to cancel the selected status and then select element A.
For a complicated screen, element select operation will be easier if a filter function (refer to 5-1-4 Filter Function) is used to limit the display objects.

(1) Select the element at the foremost position.

(2) Select [Edit] (menu bar), then select [Select Object].

This operation is also possible using the pop-up edit menu; display the pop-up edit menu by right clicking the mouse and choose [Select Object] in the menu.

The list of elements behind the element selected first is displayed. (Detailed information of the objects are displayed in the list. However, part of the information may not be displayed for some objects such as lamps/touch switches with long label.)

(3) Select the desired element from the list.

(4) Click on OK.

Reference: 
- The element selected in the Select Object dialog box is also selected on the screen so that you can confirm which element is being selected before you click the OK button.

- In the Select Object dialog box, object information same as the one displayed on the status bar is shown. For details, refer to page 43.

Batch selection of multiple elements

It is possible to select multiple elements collectively.

- Using the Shift key

Click an element while holding down the Shift key, and it is added to the previously selected elements. If you click a selected element while holding down the Shift key, the element is deselected.

- Specifying a range
Drag the mouse cursor so that all elements will be enclosed by the range specifying frame.

- Selecting all elements in a screen

To select all the elements arranged in a screen, use the select all function.

Select [Select All] from the [Edit] menu.

Specifying an element consisting of multiple elements

To edit an element that consists of multiple elements as shown below, use the edit element function.

- Position of a label in a touch switch
- Position of a label in a standard lamp
- Position of a “Display %” in a bar graph
- Position of a “Display %” in an analogue meter
- Position of a “Display %” in a trend graph and touch switches for controlling function
- Display position of image/library data and position of touch switches in an alarm list/alarm history

1. Select the element to be edited.
   Select only one element, if multiple elements are selected, edit object function can not be used.

2. Select [Edit] (menu bar), then select [Edit Object].
   This operation is also possible using the pop-up edit menu; display the pop-up edit menu by right clicking the mouse on the elements and select [Edit Object] in the menu.
   It is also possible to enter Edit Object mode by simply pressing the [Insert] button on a keyboard.
   (To cancel Edit Object mode, press [Insert] button again.)
   The green ■ marks (handles) change into red.

3. Select an element.
Example: Changing the position of the label in a touch switch

Reference: The following operation is also possible.

(1) Confirm that no element (or element other than objective one) is selected.

(2) While holding down the Shift key and Ctrl key, click on the objective part of the element that consists of multiple elements.

(3) The element automatically enters into Edit Object mode so that the element selected at (2) can be edited.

Multiple Edit Mode for Recipe Touch Switch

Activating Edit Modes

To edit the component of a recipe element (frame and touch switches),

(1) Select the Recipe element.

(2) Select “Edit Object” from the Edit menu, or right click the mouse button and select “Edit Object” from the pop-up menu.

This is the first level edit mode.

The recipe touch switches now behave like normal touch switches. The touch switches can be resized and moved. When an internal touch switch is being selected, Edit Mode will be available again for you to manipulate the components of the internal touch switch by means of activating second level edit mode. That is, the Edit Object menu item (both in pop-up menu and main menu) will not be checked, and by selecting it the touch switch can be switched to edit mode. You may also switch to edit mode using the Ins key.

In short, using the Edit Object menu item or the Ins key will allow you to toggle between edit mode and selection mode or second edit level and first edit level. If any of the editable components is selected, the screen element will go to second edit level. In that level, the editable component will be selected.

Only when the recipe screen element is in edit level one, can the internal touch switches be resized.

Appearance of Resize Handles

When the second edit mode is active, the red handles surrounding the recipe screen element are switched from solid red handles to red-outlined handles, while the handles of the internal touch switch change from green to red solid and
the selected component of the internal touch switch will be decorated with green handles.

6-1-4 Modifying an Element

The size, shape, and/or position of a created element can be modified.

Modifying the size and shape of an element

To modify the size or the shape of an element, drag one of green \( \square \) marks (handles) that enclose the objective element.

Position the mouse cursor on a green handle, and the shape of mouse cursor changes as shown below. (Same direction as arrows in the handles)

Drag the mouse cursor in the indicated direction to modify the size and the shape of the element.

Note If a green mark is shown as \( \square \) when an element is selected, the size of this element cannot be changed.

Moving an element by dragging operation

To move an element, position the mouse cursor on the selected element and confirm that the mouse cursor changes as shown below. Then, drag the element as desired.
If multiple data creation screens are displayed, an element can be moved over to another data creation screen by dragging it.

**Moving an element by keyboard operation**

The screen element can be moved by pressing cursor key (↑, ↓, ←, →) on keyboard after selection.

The size of movement depends on the setting of the Snap to Grid as follows:

**When Snap to Grid is OFF**

- **Cursor key:** move by 1 dot
- **Shift key + Cursor key:** move by 16 dots

**When Snap to Grid is ON**

- **Cursor key:** move by 1 dot
- **Shift key + Cursor key:** move by set grid size

However, if the selected elements include touch switch, elements always move by the size of the touch switch grid regardless of whether Shift key is pressed or not.

To move a part of an element such as the % Display for a bar graph or Label for a lamp/touch switch, click on the objective part while holding down the Shift key and Ctrl key (or after selecting “Edit Object”), then perform move operation.

In case of NT11S/NT11, there is a special requirement i.e. The selected objects will move by one system grid size (8,16) in all cases. The snap to grid option value is not considered.

**Reference:** The Snap to Grid setting can be made by the procedures below.

- [Screen] menu - [Property] - [Grid] button
- [Screen] menu - [Grid]
- Double clicking on a screen – [Grid]

**6-1-5 Copying, Cutting, Pasting, and Deleting Elements**

The operations for copying, cutting, and pasting elements using the clip board, and also the operation for delete an element, are described below.

**Copying and pasting elements**

The procedure for copying an arranged element to the clip board then pasting it at another position in the screen is shown below.

The attributes set for the copy source element are also copied.

The pasted element is displayed at the upper left section of the screen.

The element copied to the clip board can be used for pasting as many times as desired until another element is copied or cut. Pasting a copied element to another screen is also possible.
(1) Select an element.

(2) Select [Edit] (menu bar), then select [Copy].

This operation is also possible using the pop-up edit menu; display the pop-up edit menu by right clicking the mouse on the element and select [Copy] in the menu.

(3) Select [Edit] (menu bar), then select [Paste].

This operation is also possible using the pop-up edit menu; display the pop-up edit menu by right clicking the mouse and select [Paste] in the menu.

Reference:
- If multiple data creation screens are displayed, an element can be moved over to another data creation screen by dragging it.
  If Ctrl key is being pressed while dragging, an element will be copied instead of being moved.
- If two Support Tools are started up, copy, cut, paste and drag & drop operations can be performed between Support Tools.
  For details, refer to 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool).

Cutting and pasting elements

The procedure for cutting an arranged element to the clip board then pasting it at another position in the screen is shown below.

The attributes set to the cut source element are also copied.

The pasted element is displayed at the upper left section of the screen.

The element cut to the clip board can be used for pasting as many times as desired until another element is copied or cut. Pasting a cut element to another screen is also possible.

(1) Select an element.

Selection of multiple elements collectively is possible.

(2) Select [Edit] (menu bar), then select [Cut].

This operation is also possible using the pop-up edit menu; display the pop-up edit menu by right clicking the mouse on the element and select [Cut] in the menu.

(3) Select [Edit] (menu bar), then select [Paste].
This operation is also possible using the pop-up edit menu; display the pop-up edit menu by right clicking the mouse on the element and select [Paste] in the menu.

Reference:  
- If multiple data creation screens are displayed, an element can be moved over to another data creation screen by dragging it. If Ctrl key is being pressed while dragging, an element will be copied instead of being moved.
- If two Support Tools are started up, copy, cut, paste are drag & drop operations can be performed between Support Tools. For details, refer to 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool).

Deleting an element

The procedure for deleting an arranged element is described below. Since the delete operation does not store the element in the clip board, the deleted element cannot be restored by the paste function.

1. Select an element.  
   Selection of multiple elements collectively is possible.

2. Select [Edit] (menu bar), then select [Delete].

   This operation is also possible using the pop-up edit menu; display the pop-up edit menu by right clicking the mouse on the element and select [Delete] in the menu.

Moving an overlapped element to the front or back

If multiple elements are overlapped, it is possible to move a selected element to the front or back of other elements. This command is valid between same kinds of elements only.

Therefore, it is not possible to change the laying order of touch switch and lamp, for example.
(However, it is effective between different shapes of fixed display since they are treated as one kind.)

(1) Select an element.
   Selection of multiple elements collectively is possible.

(2) Select [Draw] (menu bar), then select [Bring to Front] or [Send to Back].
   This operation is also possible using the pop-up edit menu; display the pop-up edit menu by right clicking the mouse on the object and select [Bring to Front] or [Send to Back] in the menu.
   Choose [Bring to Front] to move the selected element to the foreground and [Send to Back] to move it to the background.

Undoing the operation

The Undo function will undo or cancel the last (most recent) action that was performed. Ten times of Undo can be performed.

It is invoked by:
Menu bar: [Edit] → [Undo]
Draw bar: Click on

Redoing the operation

The Redo function will repeat the last (most recent) action that was performed. Ten times of Redo can be performed.

It is invoked by:
Menu bar: [Edit] → [Redo]
Draw bar: Click on

6-1-6 Aligning Elements

Two or more elements can be aligned collectively.
There are following six functions for alignment. The buttons below are provided on the alignment bar.

- Align Top: (Short cut key: Ctrl + Up Arrow)
- Align Bottom: (Short cut key: Ctrl + Down Arrow)
- Align Left: (Short cut key: Ctrl + Left Arrow)
- Align Right: (Short cut key: Ctrl + Right Arrow)
- Center in a Column: (Short cut key: Ctrl + F9)
• Center in a Row: 
   (Short cut key: Ctrl + Shift + F9)

These functions can align the elements to the extremely edge in the selected elements' range or to the vertical/horizontal center of all the selected objects.

**Align Top, Align Bottom, Align Left, Align Right**

**Center in a Column, Center in a Row**

However, if a touch switch (including elements, such as thumbwheels, alarm lists/histories, that contain touch switches within themselves) is included in the selected elements, the touch switch will take precedence for alignment and the other elements will be aligned to the touch switch as follows:

**Example: Align Bottom, Align Right**

**Reference:** • Alignment function can be used also in the Edit Object mode. By using this function in this mode, position of the lamp/touch switch label or image/library
for image/library lamp ON/OFF status can be aligned easily within the element. If alignment function was used in Edit Object mode, only the selected element will be moved (Alignment is performed towards the whole area of the element).

- Touch switches may not be aligned to the center properly when “Center in a Column” or “Center in a Row” is performed because of the defined touch switch grid size. (They will be aligned to the nearest center.)

- If alignment function is performed when the filter function is activated, the filter function will be cancelled.

1. Select multiple elements to be aligned
   Or: select one element that consists of multiple elements and specify the objective part after entering the Edit Object mode.

   Or: right-click the mouse and specify the aligning method after selecting [Align] from the pop-up menu. (Short cut key can also be used. Refer to page 116.)

### 6-1-7 Grouping Elements

It is possible to group multiple elements into one element.

When creating a graphic by combining several elements, future editing such as copying, pasting, and moving will be facilitated if they are grouped.

Grouped elements can be returned to individual elements by ungrouping them.

In the grouped state, it is not permissible to change the element size and property settings. To change the size or set properties, ungroup the elements.

**Reference:** When saving screen data using mmi format, grid setting information and grouping information will not be stored. (Refer to 3-3-3 Saving the Screen Data (Application) File.)

**Grouping**

1. Specify the elements to be grouped.
2. Select [Draw] (menu bar), then select [Group].
   
   This operation is also possible using the pop-up edit menu; display the pop-up edit menu by right clicking the mouse and select [Group].

**Ungrouping**

1. Select an element in the grouped elements. (Select only one grouped element).
2. Select [Draw] (menu bar), then select [Ungroup].
This operation is also possible using the pop-up edit menu; display the pop-up edit menu by right clicking the mouse and select [Ungroup].

6-1-8 Associating Elements with the Touch Switch

If the cursor move touch switch has been created independently later than a certain element, this touch switch has to be associated with this element in order to specify the data input field when the touch switch has been pressed on PT. For NT30, NT30C, NT620S, NT620C, NT625C, it is possible to associate the control code input touch switches (page and line scroll touch switches) with the alarm list and history.

It is also possible to disassociate the touch switch with the elements.

Reference:
1. If the Auto Arrange check box is ticked in the Setting property of cursor move touch switch, the cursor move touch switch will always be moved together with the attached data input object. So, it is not possible to move or resize the cursor move touch switch itself independently. To move or resize it, first of all cancel the Auto Arrange check box, then move or resize it.

2. For the NT21, NT31, NT31C, NT631, and NT631C, the touch switch of trend graph and alarm list/history is built into each element. It is only possible to change the location of the touch switch. (Size cannot be changed.)

Association

1. Select the touch switch that you want to associate. (Select only one element.)

   The touch switches that can be associated to an element should be page or line scroll touch switch.

2. Select [Associate With...] from the [Draw] menu.

   Dialog box that prompts the user to select the elements to be associated will be displayed.

3. Choose the data input or Alarm that you want to associate. Then click [OK].

Disassociation

1. Select the touch switch you want to disassociate. (Select only one element.)


   Touch switch disassociation will be performed.

6-1-9 Centralizing the Label of Lamp and Touch Switch

With the Support Tool, the label of lamp/touch switch can be centralized within the element (both vertical and horizontal directions). This function is useful, for
example, when the label is edited after the creation of lamp/touch switch. Touch switch has two kinds of areas, one is the displayed figure and the other is the touch sensing area. “Centralize Label” is performed toward the touch sensing area.

(1) Select the lamp/touch switch you want to centralize. Multiple selection is also possible. However, “Centralize Label” cannot be performed if no lamps or touch switches are included in the selected elements. “Centralize Label” can be performed also when elements other than lamp or touch switch are included in the selected elements. (Nothing is performed for elements other than lamp or touch switch)

(2) Select [Centralize Label] from the [Draw] menu, or click on the \( \text{button} \). (or press Ctrl key + L)

Reference: • Centralization of lamp/touch switch label can be also performed by alignment function (Center in a Column) in Edit Object mode. However, the result may differ since the alignment function is performed towards the whole lamp/touch switch area.

• If “Center in a Row” is performed for a label in Edit Object mode, the label is centralized vertically.

• If “Center in a Column” is performed for a label in Edit Object mode, the label is centralized horizontally.

• By selecting multiple lamps/touch switches, you can center labels collectively.

6-1-10 Setting Properties

For each element, properties are set to characterize the individual elements. Basically, following two types of properties are set.

• General
  General settings such as display color and character size.

• Settings (only for elements that have a specific function)
  Settings related to data conversion, such as PC (PLC) address and memory table address.

In addition to the properties shown above, some elements have the following properties.

• Light Function (only for lamps and touch switches)
Setting of bits (lamp bits) for control that are used when changing display.

- Label (only for lamps and touch switches)
  Setting of label that is displayed on lamps or touch switches.

- Interlock (only for touch switches, numeral input, string input, thumbwheel and recipe in the NT21 and NT31/631-V2 and above)
  Setting of interlock bit that is used for controlling whether the corresponding object is enabled/disabled.

- Logging (Data Logging property) (only for trend graph)
  Setting of the data logging function that records data.

The following explains only the basic settings. For details of the properties of each element, refer to 6-2 Fixed Display and later sections.

### Displaying the Property Setting Dialog Box

The property setting dialog box is displayed in any of the following operations.

- Using the mouse (1)
  (1) Double click an element.

- Using the mouse (2)
  (1) Right click the mouse on an element, then select [Properties...].

- Using the menu
  (1) Specify the element for which you want to display properties (specify only one element).

- Using the keyboard
  (1) Specify the element for which you want to display properties (specify only one element).

  (2) Press the Enter key while holding down the Alt key.

### Setting the line type

You can select the type of line for polylines, broken-line graphs, and trend graphs.

<table>
<thead>
<tr>
<th>Solid</th>
<th>Dash</th>
<th>Dot-dash</th>
<th>Dot-dot-dash</th>
</tr>
</thead>
</table>

The line type is set in a property of individual elements.

### Setting the display color

Set the display color of elements.

Color setting is possible with NT30C, NT31C, NT620C, NT625C, and NT631C.

The colors that can be used are shown below.

- White, black, blue, red, magenta, green, cyan, yellow

For some elements, [Transparent] may be specified to display a transparent background. Note that [Transparent] can be specified only for the elements shown below.

- Background of fixed display text (Either foreground or background has to be other color.)
• Background of label of lamps and touch switches
• OFF state color of lamps and touch switches
• Background of element tiling patterns

• Setting the color for text and numerals
For text and numerals, color setting is possible both for characters and background.
Foreground: Specify the color of text and numerals.
Background: Specify the color for the background of text and numerals.
If [Transparent] is specified, elements arranged behind text is visible.

![Background color](image1.png)  
![Foreground color](image2.png)

• Setting the color for graphics
For a graphic, the foreground color can be set.
Foreground: Specify the color of lines in a graphic and the color of the graphic itself when the attribute is set to Inverse.

![Foreground color](image3.png)

**Reference:** Color setting is possible only for color-type PT. However, with NT30, the NT21, and NT31, setting of white and black (and transparent) is possible.

• Setting the tiling color
When tiling a graphic, color designation is possible for the foreground, background, and border.
Foreground: Specify the tiling color.
Background: Specify the background color of tiling (color visible through blank areas in the selected pattern). If [Transparent] is specified, the background becomes transparent, and elements arranged behind text and numerals are visible.
Border: Specify the border color of tiling area.

![Background](image4.png)  
![Foreground](image5.png)  
![Border](image6.png)

Available tiling patterns are shown below.

![Tiling patterns](image7.png)

When tiling a graphic, the color of border should be set to the same color as set for graphics that surround the tiling element. If a different color is specified, or there is a gap in the border, the tiling fills out the specified area.
Reference: The Color Palette Symbol for which tiling patterns and color combinations are registered is supplied with Support Tool as symbol data. Using color palette symbol enables you to register required tiling objects on screen while checking their display status. Color palette symbol does not have transparent background patterns. Border colors are set to ‘White’. Change the setting as required when using it. For details, refer to 6-10-5 Operating Procedure of Color Palette Symbol.

• Setting the color for lamps and touch switches

When specifying the color for lamps and touch switches, it is possible to specify the color for the frame, color when ON, and color when OFF.

Frame: Specify the frame color if an element is displayed with a frame.

ON: Specify the color that represents the lamp/touch switch ON status.

OFF: Specify the color that represents the lamp/touch switch OFF status.

If a lamp or a touch switch is set to flash, the ON color and OFF color are displayed alternately.

• Setting graph colors

When setting the color for bar graphs, analogue meters, broken-line graphs, and trend graphs, specification is possible for the frame of the graph, +range, –range, line (foreground), and scale.

Frame: Specify the color of the graph frame.

+ Range: Specify the background color of the graph, to be applied when the numeric value is positive.

For a bar graph, the bar is displayed in the specified color in the positive range.

– Range: Specify the background color of the graph, to be applied when the numeric value is negative.

For a bar graph, the bar is displayed in the specified color in the negative range.

Line-Color (Foreground color): Specify the line color of broken-line graphs and trend graphs, and foreground color for present value of analogue meters.
Scale Color: Specify the scale color of analogue meters.

Settings for text display

Set the size and display attributes for displaying fixed display of text and character strings in a character string memory table (string table) in the manner shown below.

The following shows only the common settings for text of fixed display.

As an example, the properties for a text display (fixed display) are shown below.

Font Type

Specify the font type for displaying alphanumerics and symbols.

Standard: A character is displayed in standard font (16 × 8 dots).

Half Height: A character is displayed in half-height font (8 × 8 dots).
Scale
Specify the character size. (Only $1 \times 1$ (Equal) and $2 \times 1$ (Wide) can be set for NT11S/NT11.)

- $1 \times 1$ (Equal): A character is displayed in the original size both in height and width.
- $1 \times 2$ (High): A character is displayed with doubled height and the original width.
- $2 \times 1$ (Wide): A character is displayed with the original height and doubled width.
- $2 \times 2$: A character is displayed with doubled height and width.
- $3 \times 3$: A character is displayed with threefold height and width.
- $4 \times 4$: A character is displayed with fourfold height and width.
- $8 \times 8$: A character is displayed with eightfold height and width (not possible for NT20/NT20S).

Reference: With the NT21 and with the NT31, NT31C, NT631, NT631C “-V1” and above, characters of $2 \times 2$ or larger scale are automatically displayed in 32 dot high-definition font. (Marks inserted into a string are always displayed in $16 \times 16$ dot font.) 32 dot font and font type ISO 8859-1 are not available on PT when system programs of “-V1” type and above, were installed for NT31, NT31C, NT631, NT631C below “-V1,” even though other functions will be same as “-V1” and above type. Therefore, in this case, characters of $2 \times 2$ or larger scale are displayed in 16 dot font for PT, while they are displayed in 32 dot font for Support Tool. Also, ISO8859-1 font type can not be used for PT, CP437 font type is applied.

Smoothing
Smoothing processing allows jags to be smoothed when a character is displayed in an enlarged scale.

Selection of this item is possible for characters of $2 \times 2$ or larger and for marks ($16 \times 16$ dots). (With the NT21, NT31, NT31C, NT631, and NT631C, smoothing is not performed for marks.)

Smoothing cannot be selected for NT20, NT20S and NT600S since smoothing processing is always executed for characters larger than $2 \times 2$ with these models.

Attribute
This is an attribute to determine how text is displayed. Attributes to be displayed here vary somewhat according to the PT model.
Standard: Text is displayed in the specified color and specified background color.

Inverse: Text and background are displayed in colors that are the reverse of the specified colors.

Flash: Text flashes when displayed. If this attribute is selected, standard display and no display (background color only) are alternately displayed.

Inverse Flash: Text is displayed by alternating standard display and inverse display.

Reference: To check “Flash” and “Inverse Flash” display on the screen, specify [Simulate Flash] from the [View] menu. (For details, refer to 5-1-3 Changing the Display Method on the Support Tool.)

Settings for numeral display

Set the size and display attributes for displaying numeric values of numeral table data and percentage values in a graph in the manner shown below.

The following shows only the common settings for numeral display.

As an example, the properties of a numeral display are described below.

Font Type

Specify the font type.

Standard: A numeric value is displayed in the standard font (16 x 8 dots).

Half Height: A numeric value is displayed in the half-height font (8 x 8 dots).

Double Width: A numeric value is displayed in the double-width font (16 x 16 dots).

Scale

Specify the character size. (Only 1 x 1 (Equal) and 2 x 1 (Wide) can be set for NT11S/NT11.)

1 x 1 (Equal): A numeric value is displayed at the original size both in height and width.
1 × 2 (High): A numeric value is displayed with doubled height and original width.

2 × 1 (Wide): A number is displayed at the original height and doubled width.

2 × 2: A numeric value is displayed with doubled height and width.

3 × 3: A numeric value is displayed with threefold height and width.

4 × 4: A numeric value is displayed with fourfold height and width.

8 × 8: A numeric value is displayed with eightfold height and width (not possible for NT20/NT20S).

Reference: With the NT21 and with the NT31, NT31C, NT631, and NT631C “-V1” and above, numbers of 2 × 2 or larger scale are automatically displayed in 32 dot font.

Smoothing

Smoothing processing allows jags to be smoothed when a number is displayed in an enlarged scale.

Selection of this item is possible, for numbers of 2 × 2 or larger.

Smoothing cannot be selected for NT20, NT20S and NT600S since smoothing processing is always executed for numbers larger than 2 × 2 with these models.

Attribute

This is an attribute to determine how a numeric value is displayed. Attributes to be displayed here vary somewhat according to the PT model.

Standard: The numeric value is displayed in the specified color and specified background color.

Inverse: The numeric value and background are displayed in colors that are the reverse of the specified colors.

Flash: The numeric value flashes when displayed. If this attribute is selected, standard display and no display (background color only) are alternated.

Inverse Flash: The numeric value is displayed by alternating standard display and inverse display.
**Reference:** To check “Flash” and “Inverse Flash” display on the screen, specify [Simulate Flash] from the [View] menu. (For details, refer to 5-1-3 Changing the Display Method on the Support Tool.)

**Display Type**

Specify the notation in which numeric values are displayed.

- **Decimal:** Numeric value is displayed in decimal.
- **Hexadecimal:** Numeric value is displayed in hexadecimal.

The display will differ according to the specified notation even if the same content is displayed.

\[
\begin{array}{c|c}
\text{23456} & \text{5BA0} \\
\text{Decimal} & \text{Hexadecimal}
\end{array}
\]

**Format**

Specify the number of digits in the integer part and decimal fraction part.

- **Integer:** Specify the number of digits entered in the integer part.
- **Decimal:** Specify the number of digits entered in the decimal fraction part.

\[
\begin{array}{c|c}
\text{123.45} & \\
\text{Integer part} & \text{Decimal part}
\end{array}
\]

**Zero Suppression**

Specify whether leading zeros should be suppressed.

- **Ticked:** Leading zeros are suppressed.
- **Not ticked:** Leading zeros are not suppressed.

\[
\begin{array}{c|c}
\text{00012345} & \text{12345} \\
\text{Without zero suppression} & \text{With zero suppression}
\end{array}
\]

**Display Sign**

Specify if a sign (–) is displayed.
When a negative numeric value is displayed with this item selected, a negative sign "–" is displayed preceding a numeral. Since this sign is included in the number of digits in the integer part, the maximum digit number is reduced by 1. When this item is not selected, a negative numeric value is displayed as an absolute value.

Ticked: Numeric values are displayed without a sign.
Not ticked: Numeric values are displayed with a sign.

When a negative numeric value is displayed with this item selected, a negative sign "–" is displayed preceding a numeral. Since this sign is included in the number of digits in the integer part, the maximum digit number is reduced by 1. When this item is not selected, a negative numeric value is displayed as an absolute value.

Ticked: Numeric values are displayed without a sign.
Not ticked: Numeric values are displayed with a sign.

Reference: How a numeric value is displayed according to the setting for [Integer], [Decimal], [Zero Suppression], and [Display Sign] is shown below.

<table>
<thead>
<tr>
<th>Integer</th>
<th>Decimal</th>
<th>Zero Suppression</th>
<th>Display Sign</th>
<th>Data Stored in Numeral Table</th>
<th>Display on the Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>0</td>
<td>Not ticked</td>
<td>Check mark not set</td>
<td>12</td>
<td>012</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Not ticked</td>
<td>Check mark not set</td>
<td>–12</td>
<td>012</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Ticked</td>
<td>Check mark not set</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Ticked</td>
<td>Check mark set</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Ticked</td>
<td>Check mark set</td>
<td>–12</td>
<td>–12</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>Not ticked</td>
<td>Check mark not set</td>
<td>1</td>
<td>000.1</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>Not ticked</td>
<td>Check mark not set</td>
<td>–12</td>
<td>001.2</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>Not ticked</td>
<td>Check mark set</td>
<td>1</td>
<td>00.1</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>Not ticked</td>
<td>Check mark set</td>
<td>–12</td>
<td>–01.2</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>Ticked</td>
<td>Check mark set</td>
<td>1</td>
<td>0.1</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>Ticked</td>
<td>Check mark set</td>
<td>–12</td>
<td>–1.2</td>
</tr>
</tbody>
</table>

*: With conventional PT models, negative numeric value data is prefixed by F. For example, –12 is set as F0000012.

With the NT21, NT31, NT31C, NT631, and NT631C, numeric values are stored as signed binary data.

**Word setting for an element**

Specify the PC (PLC) address used for reading and writing by an element such as memory table entry, lamp, or touch switch.

For a numeral or character string memory table entry (string table), specify the lower address or the least significant address of the word to be referred to.

For a lamp, a touch switch, or a bit memory table entry, specify the allocated bit number.

When specifying a bit, specify the address of the word and the bit position in the word that is referred to

Note that, timer (TIM) and counter (CNT) cannot be set for bits or character string words.

• Using PLC address setting dialog box

Normally, a button for displaying the PLC address setting dialog is provided for PLC address input field.
In the dialog, PLC address can be set easily by selecting from the available areas.

Example: Numeral table  
(PLC Vendor : OMRON)

Example: Touch switch  
(PLC Vendor : OMRON)

Channel (Word)
Select the type of word to be referred to from the list box.

Address
Input the address of word to be referred to.

Bit
Input the bit position in the word to be referred to.

Direct input of PLC address
It is possible to input PC (PLC) address, for example D00001, directly into the address input field. You can input addresses easily when you know which area is available.

When inputting PLC addresses, input a word address and a bit number without a blank following a character that indicates area type. However, in case of numeral table or string table, specification of bit number is not needed.

When you do not specify PLC address, input “- -” into the input field.

Input methods varies according to the PLC Vendor setting as listed below. Only input method is described here. For details on specification method of PLC address for PLC other than OMRON, refer to PC Connection Operation Manual (V042-E1-□).

PLC Vendor: OMRON
Possible areas and characters that indicate area type are as follows:

<table>
<thead>
<tr>
<th>Character</th>
<th>Area Type</th>
<th>Word</th>
<th>Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Common I/O Area</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>H</td>
<td>HR Area</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>A</td>
<td>AR Area</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>L</td>
<td>LR Area</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>T</td>
<td>Timers</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>C</td>
<td>Counters</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>D</td>
<td>Data Memory Area</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>E</td>
<td>EM Current Bank</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>E0</td>
<td>EM Bank 0 (CS/CJ–series PLCs)</td>
<td>○¹</td>
<td>○¹</td>
</tr>
<tr>
<td>E1</td>
<td>EM Bank 1 (CS/CJ–series PLCs)</td>
<td>○¹</td>
<td>○¹</td>
</tr>
<tr>
<td>E2</td>
<td>EM Bank 2 (CS/CJ–series PLCs)</td>
<td>○¹</td>
<td>○¹</td>
</tr>
<tr>
<td>E3</td>
<td>EM Bank 3 (CS/CJ–series PLCs)</td>
<td>○¹</td>
<td>○¹</td>
</tr>
<tr>
<td>E4</td>
<td>EM Bank 4 (CS/CJ–series PLCs)</td>
<td>○¹</td>
<td>○¹</td>
</tr>
</tbody>
</table>
**Common Operation**

<table>
<thead>
<tr>
<th>Character</th>
<th>Area Type</th>
<th>Word</th>
<th>Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>E5</td>
<td>EM Bank 5 (CS/CJ–series PLCs)</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>E6</td>
<td>EM Bank 6 (CS/CJ–series PLCs)</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>E7</td>
<td>EM Bank 7 (CS/CJ–series PLCs)</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>E8</td>
<td>EM Bank 8 (CS/CJ–series PLCs)</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>E9</td>
<td>EM Bank 9 (CS/CJ–series PLCs)</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>EA</td>
<td>EM Bank A (CS/CJ–series PLCs)</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>EB</td>
<td>EM Bank B (CS/CJ–series PLCs)</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>EC</td>
<td>EM Bank C (CS/CJ–series PLCs)</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>CU</td>
<td>Count Up Flag (CS/CJ–series PLCs)</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td>TU</td>
<td>Time Up Flag (CS/CJ–series PLCs)</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td>W</td>
<td>Work Area (CS/CJ–series PLCs)</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>TK</td>
<td>Task Flag (CS/CJ–series PLCs)</td>
<td>×</td>
<td>○</td>
</tr>
</tbody>
</table>

* EM Bank D, EM Bank E, EM Bank F are not available since these are reserved words.

1 Only available for the NT20/NT21 and the NT31/631-V2 and above models.

○: Specification possible   ×: Specification not possible

With NT11S/NT11, NT20S, NT30, NT30C, NT600S, NT620S, NT620C and NT625C:
Input a word address as a 4-digit number (leading zeros can be suppressed) and a bit number as a 2-digit number.

With NT20, NT21, NT31, NT31C, NT631 and NT631C:
Input a word address as a 5-digit number (leading zeros can be suppressed) and a bit number as a 2-digit number.

**PLC Vendor: MEMLINK**

Possible areas and characters that indicate area types are as follows:

<table>
<thead>
<tr>
<th>Character</th>
<th>Area Type</th>
<th>Word</th>
<th>Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Memory Link Area</td>
<td>○</td>
<td>○</td>
</tr>
</tbody>
</table>

○: Specification possible   ×: Specification not possible

Input a word address as a 4-digit number (leading zeros can be suppressed) and a bit number as a 2-digit number.

**PLC Vendor: Mitsubishi_A**

Possible areas and characters that indicate area types are as follows:

<table>
<thead>
<tr>
<th>Character</th>
<th>Area Type</th>
<th>Word</th>
<th>Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Input Relay</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Y</td>
<td>Output Relay</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>M</td>
<td>Internal Relay</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>L</td>
<td>Latch Relay</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>B</td>
<td>Link Relay</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>C</td>
<td>Counter</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>T</td>
<td>Timer</td>
<td>○</td>
<td>×</td>
</tr>
</tbody>
</table>
### Common Operation

#### Section 6-1

<table>
<thead>
<tr>
<th>Character</th>
<th>Area Type</th>
<th>Word</th>
<th>Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>Data Register</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>R</td>
<td>File Register</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>W</td>
<td>Link Register</td>
<td>√</td>
<td>√</td>
</tr>
</tbody>
</table>

○: Specification possible  ×: Specification not possible

Input a word address as a 4-digit number (leading zeros can be suppressed) and a bit number as a 2-digit number.

**PLC Vendor: Mitsubishi Fx**

Possible areas and characters that indicate area types are as follows:

<table>
<thead>
<tr>
<th>Character</th>
<th>Area Type</th>
<th>Word</th>
<th>Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Input Relay</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Y</td>
<td>Output Relay</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>M</td>
<td>Auxiliary Relay</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>S</td>
<td>State</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>C</td>
<td>Counter</td>
<td>√</td>
<td>×</td>
</tr>
<tr>
<td>T</td>
<td>Timer</td>
<td>√</td>
<td>×</td>
</tr>
<tr>
<td>D</td>
<td>Data Register</td>
<td>√</td>
<td>√</td>
</tr>
</tbody>
</table>

○: Specification possible  ×: Specification not possible

Input a word address as a 4-digit number (leading zeros can be suppressed) and a bit number as a 2-digit number.

**PLC Vendor: AB**

Possible file types and characters are as follows (available only for NT31/631 models):

<table>
<thead>
<tr>
<th>Character</th>
<th>File Type</th>
<th>File/Slot Number</th>
<th>Element/Word Number</th>
<th>Sub-Element Number</th>
<th>Bit/Terminal Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Bit</td>
<td>√</td>
<td>√</td>
<td>×</td>
<td>√</td>
</tr>
<tr>
<td>C</td>
<td>Counter</td>
<td>×</td>
<td>×</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>N</td>
<td>Integer</td>
<td>√</td>
<td>√</td>
<td>×</td>
<td>√</td>
</tr>
<tr>
<td>R</td>
<td>Control</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>S</td>
<td>Status</td>
<td>√</td>
<td>√</td>
<td>×</td>
<td>√</td>
</tr>
<tr>
<td>T</td>
<td>Timer</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
</tbody>
</table>

○: Specification possible  ×: Specification not possible

Input a file number as a 3-digit number (leading zeros can be suppressed), element number or word address as 3-digit number, sub-element number as 1 digit and bit number as a 2-digit number.

**PLC Vendor: GE**
Possible memory types and characters are as follows (available only for NT31/631 models):

<table>
<thead>
<tr>
<th>Character</th>
<th>Memory Type</th>
<th>Data Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Register</td>
<td>○</td>
</tr>
<tr>
<td>AL</td>
<td>Analog Input</td>
<td>○</td>
</tr>
<tr>
<td>AQ</td>
<td>Analog Output</td>
<td>○</td>
</tr>
<tr>
<td>I</td>
<td>Discrete Input</td>
<td>○</td>
</tr>
<tr>
<td>Q</td>
<td>Discrete Output</td>
<td>○</td>
</tr>
<tr>
<td>T</td>
<td>Discrete Temporary</td>
<td>○</td>
</tr>
<tr>
<td>M</td>
<td>Discrete Internal</td>
<td>○</td>
</tr>
<tr>
<td>S</td>
<td>System Status</td>
<td>○</td>
</tr>
<tr>
<td>SA</td>
<td>System Status A</td>
<td>○</td>
</tr>
<tr>
<td>SB</td>
<td>System Status B</td>
<td>○</td>
</tr>
<tr>
<td>SC</td>
<td>System Status C</td>
<td>○</td>
</tr>
<tr>
<td>G</td>
<td>Genius Global Data</td>
<td>○</td>
</tr>
</tbody>
</table>

○: Specification possible    ×: Specification not possible

Input a Data Offset as a 4-digit number (leading zeros can be suppressed).

**PLC Vendor: Siemens**

Possible memory types and characters are as follows (available only for NT31/631-V1 models):

<table>
<thead>
<tr>
<th>Character</th>
<th>Memory Type</th>
<th>Address</th>
<th>Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Counter</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>DB</td>
<td>Data Block</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>I</td>
<td>Input</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>IW</td>
<td>Input</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>M</td>
<td>Bit Memory</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>MW</td>
<td>Word Memory</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>Q</td>
<td>Output</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>QW</td>
<td>Output</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>T</td>
<td>Timer</td>
<td>○</td>
<td>×</td>
</tr>
</tbody>
</table>

○: Specification possible    ×: Specification not possible

Input a address number as a 4-digit (5 digit in case of DB) number (leading zeros can be suppressed) and a bit number as a 1-digit number.

**Batch address change operation**

The set PC (PLC) addresses can be changed into the required addresses in a batch. Since the change source can be specified as a range, processing such as changing the address range DM 1000 to DM 01499 to the address range DM 1800 to DM 2299 is possible at one time. Shifting in bit units is also possible.

**Reference:** Batch address change operation is possible using either the dialog box displayed by [Tools] → [Table...] or the function called by [Tools] → [Change Address]. Depending on how the address change operation is called, the objective addresses...
differ—in the operation using the edit dialog box of the memory table, addresses in the table being edited are objective while all addresses in the entire screen data are objective of the operation if the operation is performed using the [Tools] menu.

The explanation below is given for the batch address change operation where the entire screen data is the objective of the operation. For the procedure to perform the operation using the edit dialog box of the memory table, refer to 7-1-3 Batch Address Change Operation.

- Description of batch address change dialog box

**Find – Channel (Word)**
Specify the channel type of the batch change source.

**Find – Start Range**
Specify the start address of the source range for the batch address change.

**Find – End Range**
Specify the end address of the source range for batch address change.
The address to be set for [End Range] must always be larger than or equal to the address set for [Start Range].

**Change to – Channel (Word)**
Specify the word type, and start address, after the change.
Addresses are changed within the number of specified points from the start address (number of points from “Start Range” to “End Range”).

**Change Comment**
Specify whether or not the same I/O comment appended to an address before the change is appended to the address after the change.
To append the same I/O comment, click on the check box to display a check mark in it.

Batch address change processing starts when you click on this button.

- How addresses are changed
In the operation for changing addresses in bit units, processing is executed assuming that bit 15 of a word is immediately followed by bit 0 of the next word.
Addresses are changed as shown below according to the set search range and the address after the change.
Example: Bit memory table entry

Address and Bit set for [End Range]

Address and Bit set for [Start Range]

*Operation procedure*

1. [Tools] (menu bar) → [Change Address]
2. Select the type of word before the change in the [Channel] box.
3. Specify the range of the change by setting addresses at the [Start Range] and [End Range] boxes.
4. Specify the word and the address after the change in the corresponding boxes in the [Change To] area.
5. Set a check mark in the Change Comment check box as desired. If a check mark is set in this check box, I/O comments appended to the addresses before the change are also appended to the addresses after the change.
6. Click on [OK].

*Setting the current object status as the existing value*

Register the status of the selected object as the existing value of the same kind of object. This feature allows the status of the object, when it is registered to the screen, to be changed, eliminating the operation steps to modify the property of the object.

Note that the PC (PLC) address and reference memory table entry cannot be registered as the existing value.

1. Specify the object to be registered as the existing value (select only one object).
2. [Draw] (menu bar) → [Use as Default] (Or select [Use as Default] from pop-up edit menu)
The current set status of the specified object is registered as the existing value of the same kind of object.

6-1-11 Relationships between Elements and Memory Tables

The relationships between elements and memory tables are shown below.

When creating an element, attend carefully to the memory table address, capacity, etc.

- **●**: Reading from a memory table
- **○**: Writing to a memory table

<table>
<thead>
<tr>
<th></th>
<th>Numeral Memory Table</th>
<th>Character String Memory Table (String Table)</th>
<th>Bit Memory Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeral display</td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bar graph</td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analogue Meter</td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Broken-line graph</td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trend graph</td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Numeral setting</td>
<td></td>
<td>○</td>
<td></td>
</tr>
<tr>
<td>+ Touch switch (for inputting control code)*1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Numeral setting</td>
<td></td>
<td>○</td>
<td></td>
</tr>
<tr>
<td>+ Touch switch (for copy setting)*1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Numeral setting</td>
<td></td>
<td>○</td>
<td></td>
</tr>
<tr>
<td>+ Touch switch (for numeral input)*1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thumbwheel switch</td>
<td>○</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm list</td>
<td>–</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Alarm history</td>
<td>–</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Character string display</td>
<td>–</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Character string setting</td>
<td>–</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>+ Touch switch (for character string input)*1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Character string setting</td>
<td>–</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>+ Touch switch (for inputting control code)*1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Character string setting</td>
<td>–</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>+ Touch switch (for copy setting)*1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard lamp*4</td>
<td>–</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image lamp*2</td>
<td>–</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Touch switch (for notifying input)*4</td>
<td>–</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1: Numeral setting and character string setting are used in combination with a touch switch.

*2: A standard lamp and an image lamp reads the specified PC (PLC) bit directly without using a memory table.

*3: A touch switch (for notifying input) directly drives the specified PC (PLC) bit ON/OFF without using a memory table.

*4: When a Numeral Display or a String Display is specified as the label type, the specified memory table will be read. (Only for NT21 and NT31/631-V2 and above)

6-1-12 Interlock

By setting the Interlock flag, the interlock facility will be activated for touch switch/thumbwheel/numeral input/string input and recipe. When interlock is set, the co-
responding object will be enabled/disabled according to the interlock bit: when the PLC Address set on the Interlock address is ‘ON’ the touch switch/thumbwheel/numeral input/string input will work; if the address is ‘OFF’, the touch switch/thumbwheel/numeral input/string input will not respond to the touches.

The interlock functionality is supported for the PT models NT21 and NT31/631-V2 and above. The temporary input object does not support interlock function.

**Operation procedure**

Select the Interlock tab on the property sheet of the screen object that supports Interlock.

**Property setting**

This property page will be the same for all other supported objects. Only the caption will be changed according to the object.

**Interlock Check Box**

To ON/OFF interlock. By default it is OFF.

**PLC Bit Address**

To specify the bit address associated with Interlock. Interlock is ON, if this bit is set, OFF otherwise.

**IO Comment**

I/O Comment for the address specified.

**Conversion**

For conversions due to cut/copy/paste, drag/drop of screen elements with interlock settings (e.g. Touch Switch, Thumbwheel, Numeral Input, and String Input)
from the NT21 and NT31/631-V2 and above to previous PT models, interlock settings will be discarded as they are not being supported.

In the case of copy/paste of screen elements, drag/drop of screen elements as well as application conversion:

<table>
<thead>
<tr>
<th>Target PT model supports Interlock</th>
<th>Original screen elements support Interlock</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>No</td>
<td>Interlock Flag will assume FALSE.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>Interlock Flag will be set to FALSE and ignored.</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>No conversion required.</td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>No conversion required.</td>
</tr>
</tbody>
</table>

Reference

This feature is used by Touch Switch, Thumbwheel Switch, String Input and Numerical Input.

6-2  Fixed Display

Fixed display means graphic data that does not have the data communication function with a PC and a memory table.

Set only general properties.

Reference: Rotation and other processing are not possible for the fixed display. For image data, rotation and inverse are possible during creation of the image data.

6-2-1  Polyline

A straight line is drawn.

Polylines cannot be used with NT11S/NT11.

Reference: To draw a continuous polyline, press the Shift key when the drag operation is finished. Dragging this end point creates a continuous polyline.
Terminology

Property setting

**General**

Line Style: Specify the type of line
Solid line, dotted line, alternate short and long lines, alternate
two short and long lines

Attribute

Standard, Flash (Flash can be set only for the NT21, NT31, NT31C, NT631,
and NT631C)

Color

Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Guidance

• For line type, the following four choices are provided.

<table>
<thead>
<tr>
<th>Solid</th>
<th>Dash</th>
<th>Dot-dash</th>
<th>Dot-dot-dash</th>
</tr>
</thead>
</table>

The line type is specified using the line style property.

• When creating a polyline, draw a continuous line first, then add vertices in the
edit operation to change the drawn continuous line into the desired broken line.

Vertices can be set at up to 254 positions.

• To add a vertex, follow the steps shown below.

(1) Draw a continuous line.

(2) After locating the cursor at a position where a vertex is to be added, right
click the mouse and select [Add Node] in the pop-up menu.
(3) Drag the vertex to the desired position.

![](image)

- To remove a vertex, locate the cursor on the vertex to be removed and select [Remove Node] in the pop-up menu.

### 6-2-2 Arc

An arc is drawn.

Arcs cannot be used with NT11S/NT11, NT20, NT20S and NT600S.

![Arc](image)

(1) An arc is drawn. The radius of an arc can be changed.

#### Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → [Arc]

Selection using the drawing toolbar:

#### Terminology

![Terminology](image)

#### Property setting

**General**

**Position**

- Center point: Indicates the position of the center of an arc.
- Start point: Indicates the position of the start point of an arc.
End point: Indicates the position of the end point of an arc. An arc is drawn anti-clockwise from the start point to the end point.

Size: Indicates the radius of an arc.

Attribute: Specify the display attribute. Standard, Inverse, Flash, Inverse Flash

Color

Foreground: Specify the line color. (Can only be set for PTs with color display.) White, black, blue, red, magenta, green, cyan, yellow

Guidance

• An arc is defined by the center point, the start point, and the end point.
The line type is specified using line style attribute.

Center point: Indicates the position of the center of an arc.

End point: Indicates the position of the end point of an arc. The end point can be dragged to the desired position.

Start point: Indicates the position of the start point of an arc. When the start point is dragged, the start point position and arc radius are changed.

6-2-3 Rectangle

A rectangle is drawn.

Rectangles cannot be used with NT11S/NT11, NT20, NT20S and NT600S.

(1) A rectangle is drawn. The length of a vertical and horizontal sides can be changed.

Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → [Rectangle]

Selection using the drawing toolbar: □
Terminology

Property setting

General

- Position: Indicates the display position of a rectangle.
- Size: Indicates the size of a rectangle.
- Attribute: Specify the display attribute.
  - Standard, Inverse, Flash, Inverse Flash
- Color
  - Foreground: Specify the line color.
    (Can only be set for PTs with color display.)
    - White, black, blue, red, magenta, green, cyan, yellow

Guidance

- A rectangle element can be modified in the manner shown below.
  A rectangle can be modified by dragging a green □ mark (handle).

- To tile a rectangle, paste a tiling element into it.

For details of tiling elements, refer to 6-2-8 Tiling.

6-2-4 Circle

A circle is drawn.
Circles can be used with all models except for NT11S/NT11.

(1) A circle is drawn. The radius of a circle can be changed.

**Operation procedure**

Selection using the menu bar: [Objects] → [Fixed Display] → [Circle]

Selection using the drawing toolbar: 

**Terminology**

**Center point**

**Property setting**

**General**

Position

Center point: Indicates the position of the center of a circle.

Size: Indicates the radius of a circle.

Attribute: Specify the display attribute. (Setting is not possible with NT20, NT20S and NT600S) Standard, Inverse, Flash, Inverse Flash

Color

Foreground: Specify the line color.

(Can only be set for PTs with color display.)

White, black, blue, red, magenta, green, cyan, yellow

**Guidance**

- A circle element can be modified in the manner shown below.
  
  A circle can be modified by dragging a green mark (handle).
Note that a circle cannot be deformed to an oval.

- To tile a circle, paste a tiling element into it.

For details of tiling elements, refer to 6-2-8 Tiling.

6-2-5 Polygon

A polygon is drawn.

Polygons cannot be used with NT11S/NT11, NT20, NT20S and NT600S.

(1) After a polygon is drawn, it is modified to give the desired shape.

Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → [Polygon]

Selection using the drawing toolbar:

Terminology

144
Property setting

General
Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash

Color
Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Position: Indicates the position of Attribute Point (reference point).

Guidance

• A polygon is created on the basis of a triangle. After a triangle is drawn, vertices are added in the edit operation to create a polygon.

Vertices can be set at up to 255 positions.

• To add a vertex, follow the steps shown below.

(1) Draw a polygon.

(2) After locating the cursor at a position where a vertex is to be added, right click the mouse and select [Add Node] in the pop-up menu.

(3) Drag the vertex to the desired position.

• To remove a vertex, locate the cursor on the vertex to be removed and select [Remove Node] in the pop-up menu.
• To tile a rectangle, paste a tiling element into it.

For details of tiling elements, refer to 6-2-8 Tiling.

6-2-6 Sector

A sector is drawn.
Sectors cannot be used with NT11S/NT11, NT20, NT20S and NT600S.

(1) A sector is drawn. The size of a sector can be changed.

Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → [Sector]
Selection using the drawing toolbar: 

Terminology

Property setting

General
Position
Center point: Indicates the position of the center of a sector.
Start point: Indicates the position of the start point of a sector.
End point: Indicates the position of the end point of a sector.
A sector is drawn anti-clockwise from the start point to the end point.
Size: Indicates the radius of a sector.
Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash

Color

Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Guidance

- A sector is defined by the center point, the start point, and the end point
  The line type is specified using line style attribute.
  Center point: Indicates the position of the center of a sector.
  End point: Indicates the position of the end point of a sector.
  The end point can be dragged to a desired position to change the position of the end point.
  Start point: Indicates the position of the start point of a sector.
  When the start point is dragged, the start point position and sector radius are changed.

- When tiling a sector, paste a tiling element in it.

For details of tiling element, refer to 6-2-8 Tiling.

6-2-7 Text

Text is drawn.
Text can be used with all models.

(1) Text is drawn. Font, size, color, etc. can be changed.

Note
Mark data can be inserted into a character string. With the NT30, NT30C, NT620S, NT620C, NT625C, NT21 and NT31/631-V2 and above with NT20/30/620-compatible mode set, image data can also be inserted.

Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → [Text]
Selection using the drawing toolbar: 

A
Terminology

Property setting

General
Description: Set the text to be displayed.
Position: Indicates the position where the text is displayed.
Font type: Specify the font. (Only Standard can be set for NT11S/NT11.)
Standard, Half Height
Scale: Specify the character size.
(Only 1 x 1 (Equal) and 2 x 1 (Wide) can be set for NT11S/NT11.)
1 x 1 (Equal), 1 x 2 (High), 2 x 1 (Wide), 2 x 2, 3 x 3, 4 x 4, 8 x 8
(Not for NT20, NT20S)
Smoothing: Specify whether smoothing processing is executed for characters
larger than 2 x 2 scale. (Setting is not possible for NT11S/NT11,
NT20, NT20S and NT600S. For NT20S, NT600S, smoothing is al-
ways ON.)
Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash
Color
Foreground: Specify the text color.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan,
yellow (Transparent is available for the NT21, NT31, NT31C,
NT631, NT631C)
Background: Specify the color of the background in the text display area.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan,
yellow

Guidance
- The maximum number of characters that can be input (displayed) is:
  NT11S/NT11: 20 characters
NT20, NT20S, NT21: 32 characters  
NT30, NT30C, NT31, NT31C: 40 characters  
NT600S, NT620S, NT620C/NT625C, NT631, NT631C: 80 characters  

- To display "\", input two characters without a blank, like "\".
- It is possible to insert mark data, image data into a character string.  
  (For NT20, NT20S, NT600S, mark data can be used only in strings.)

Note that insertion of image data is possible only for the NT30, NT30C,  
NT620S, NT620C, NT625C, NT21 (NT20/30/620-compatible mode),  
NT31/C-V2 (NT20/30/620-compatible mode) and NT631/C-V2  
(NT20/30/620-compatible mode). Although the NT21, NT31, NT31C, NT631,  
and NT631C support image data, it cannot be inserted into a character string.  
The procedure for inserting mark data, image data into a character string is  
shown below.

1. In the character string input field, move the cursor ( | ) to the mark/image data  
   insertion position.
2. Select [ ] or [ ] in the dialog box.
   The mark selection dialog box or image selection dialog box is displayed.
   Select the mark data, image data to be inserted and click on [ OK ].

   Mark data: FF20 to FFFFH (FF20 to EF5FH for NT11S/NT11,  
NT20, NT20S and NT600S)

   Image data: Only for the NT30, NT30C, NT620S, NT620C, NT625C, NT21, and  
NT31/631-V2 and above with NT20/30/620-compatible mode  
FE20 to FEFFH  

Example:  Mark data

3. The code of the specified data is displayed at the data insertion position in  
   the character string input field.
4. Click on [ OK ] to close the character string attribute. The set mark data,  
   image data, or library data is displayed in the character string displayed on  
   the screen.

### 6-2-8 Tiling

The closed area of the graphic (inside the border) will be filled with some pattern  
and color.
Tiling cannot be used for NT11S/NT11, NT20, NT20S and NT600S.

(1) The area inside the border is tiled according to the specified color and pattern.

**Operation procedure**

Selection using the menu bar: [Objects] → [Fixed Display] → [Tiling]

Selection using the drawing toolbar:  

**Terminology**

<table>
<thead>
<tr>
<th>Background color</th>
<th>Foreground color</th>
<th>Border</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transparent</td>
<td>White, black, blue, red, magenta, green, cyan, yellow</td>
<td>White, black, blue, red, magenta, green, cyan, yellow</td>
</tr>
</tbody>
</table>

**Property setting**

**General**

Position: Indicates the position of the tiling element.

Pattern: Specify the tiling pattern.

**Color**

Foreground: Specify the foreground color of the tiling area.

(Can only be set for PTs with color display.)

White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the tiling area.

(Can only be set for PTs with color display.)

Transparent, white, black, blue, red, magenta, green, cyan, yellow

Border: Specify the color of the border of tiling area.

(Can only be set for PTs with color display.)

White, black, blue, red, magenta, green, cyan, yellow

**Guidance**

- A ■ mark (handle) is displayed when a tiling element is selected.

Property setting and tiling element can be edited by selecting the ■ mark (handle).
Tiling is possible for the elements shown below. Rectangle, circle, polygon, sector

In addition to the elements indicated above, tiling is possible for an area enclosed by a solid line of the same color (border color). If an element such as a lamp that changes status is specified for the border, however, tiling may not be executed correctly due to changes in color and display.

To check the tiling status, select [View] (menu bar) then select [Full Tiling]. The result of tiling will be displayed (in this state, a check mark is set for [Full Tiling] in the display menu.). When [Full Tiling] is selected again, then return to the previous mark (handle).

To execute tiling, specify the same color for the border of area and the border of a tiling element. Tiling is executed in the enclosed area for which the same color as the color set for the border is set. If an enclosed area with the same color does not exist, the tiling extends outside the enclosed area.

If the tiling area is not an enclosed area, the tiling spills out the specified area.

The patterns are displayed in the actual status of tiling according to the setting for the foreground and background color. The available tiling patterns are shown below.

Reference: Transparent background can be set for tiling objects. However, it will not be displayed as transparent on the Support Tool. When the screen is downloaded to a PT, it will be displayed as transparent.

1. Double-click the screen to display the screen property.
2. Set Red for screen background color.
3. Register a tiling object on the screen and set Transparent for the background and for Pattern.
5. Tiling will be executed and the screen background color (red) will be invisible (figure (a) below).
6. When this screen data is downloaded to a PT, background color for tiling object will be transparent (figure (b) below).

(a) Support Tool screen
(b) PT screen
6-2 Section

Fixed Display

- If “Full Tiling” is performed, performance of Support Tool may be slower. In this case, clear the check mark for [Full Tiling] from the [View] menu.

- [Full Tiling] is automatically cancelled when a filter function is performed for a Fixed Display.

- The Color Palette Symbol, for which tiling patterns and color combinations are registered, is supplied with Support Tool as symbol data. Using color palette symbol enables you to register required tiling objects on screen while checking their display status. Color palette symbol does not have transparent background patterns. Border colors are set to ‘White’. Change the setting as required when using it. For details, refer to 6-10-5 Operating Procedure of Color Palette Symbol.

6-2-9 Image Object Data

Image data is displayed.

There are two types of image data. One type of image data references the fixed code directly, the other type uses indirect reference. Indirect reference is a function that can change the image data to be displayed by writing the image code to the numeral table just like the indirect reference of numeral/string display. This enables the animation display by switching the display contents using a simple program. For details of the PT models that can use indirect reference, refer to Appendix D Table of Functions of Each PT Model.

Image data cannot be used for NT11S/NT11, NT20, NT20S and NT600S.

(1) Image data created in the bit map (BMP) format is displayed.

**Note** Bit map data created by general application software running on Windows can be displayed.

**Operation procedure**

Selection using the menu bar: [Objects] → [Fixed Display] → [Image Display]

Selection using the drawing toolbar: 

**Terminology**

[Diagram of Color Palette Symbol]
## Property setting

### General

**Position:** Indicates the display position of image data.  
(The reference point is at the upper left corner in the image element.)

**Size:** Indicates the size of image data.

### Reference Type

**Direct:** Set the image code directly.

**Code:** Indicates the code number of the image data to be displayed.

**Mode:** Indicates the color mode of the image data (2 colors, 8 colors).

**Comment:** Displays the comment that is set for the image data.

**Indirect:** Set this item when the value for the specified numeral table entry is treated as image code and referenced indirectly.

**Table No.:** Specify the numeral table entry to be referenced.  
When using the indirect reference, set the storage type of allocated numeral table entry to Binary. Also, when specifying the image code from a program etc., use hexadecimal value since the image table code is in hexadecimal.

### Color

**Foreground:** Set the display color of image data.  
(Setting is possible only when 2 colors is set for the color mode.)

**Background:** Set the color of background in the image data display area.  
(Setting is possible only when 2 colors is set for the color mode.)

### Guidance

- When the image data is firstly specified, the data of character code FE20H (for the NT30, NT30C, NT620S, NT620C, NT625C and NT21 and NT31/631-V2 and above with NT20/30/620-compatible mode), or the data that corresponds to image/library code 0001H (for the NT21, NT31, NT31C, NT631, NT631C without NT20/30/620-compatible mode) is arranged as default.

- The mark shown below will be displayed if image data has not been created for the specified code.

  ![Blank Mark]

- To change the image data to be displayed, click on ![Blank Mark] in the property and select the desired image data or numeral table entry from the list.

  If you are using the NT31, NT31C, NT631 or NT631C “-V1” and above, and its system program version is 2.1 and above, “Indirect reference” can be set.

  The procedure for specifying the desired image data is shown below.

### Direct

Specify the code of the image data to be displayed directly.
(1) Click on at the right side of the Code field after checking the [Direct] button in the property setting dialog box to display the image data selection dialog box.

(2) If the code of the desired image data is not found in the list, scroll the list using the scroll bar at the right side of the screen, or click on to open the code input dialog box.

Input the code of the desired image data and click on .
By pressing cursor keys (↑, ↓) on keyboard, the contents of the code can be checked in the preview window one by one.

(3) Select the code of the desired image data to be displayed.
The selected line will be highlighted.

(4) Click on to close the dialog box.

**Indirect**
Specify the numeral table entry to be referenced.
With indirect reference, the contents for the specified numeral table entry are treated as an image code and the corresponding image data is displayed. This is useful when you want to change the image data to be displayed according to the statuses. Set the storage type of numeral table entry to be referenced by indirect reference to Binary and specify the value (image code) to be stored in hexadecimal since the image code is in hexadecimal.

Set the numeral table entry number to be referenced in the table entry number field.
It is possible to display a numeral table entry so that you can select the desired
table entry number from it.

To display a numeral table entry, follow the procedure below.

1. Click on at the right side of the table entry number after checking the [Indirect] button in the property setting dialog box to display the numeral table selection dialog box.

2. If the number of the desired numeral table entry is not found in the list, scroll the list using the scroll bar at the right side of the screen, or click on to open the entry input dialog box.

   ![Numeral Table Selection Dialog Box]

   Input the number of the desired numeral table entry and click on .

3. Select the desired numeral table entry to be referenced. The selected line will be highlighted.

4. Click on to close the dialog box.

   How to create the image data is described in 8-1 Image Editor.

---

**6-2-10 Mark**

Mark data is displayed.

Mark data can be used for all models. (With NT11S/NT11, NT20, NT20S, and NT600S, mark data can be inserted only in string.) Since the Support Tool does not support mark data of 32 × 32 dots and 64 × 64 dots, it is necessary to group 16 × 16 dot marks if image data created by the DOS version Support Tool is imported.

---

155
(1) The mark data, fixed at 16 x 16 dot size, is displayed.

Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → [Mark]

Selection using the drawing toolbar: 

Terminology

Property setting

General

Position: Indicates the display position of mark data.
(The attribute point is at the upper left corner in the mark data.)

Code: Indicates the character code of the mark data to be displayed.

Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash
(With the NT21, NT31, NT31C, NT631 and NT631C, the Inverse attribute is not supported.)

Scale: Specify the character size.
1 x 1 (Equal), 1 x 2 (High), 2 x 1 (Wide), 2 x 2, 3 x 3, 4 x 4, 8 x 8

Smoothing: Specify whether smoothing processing is executed for mark data.*1
(Setting is not possible for the NT21, NT31, NT31C, NT631 and NT631C)

Color

Foreground: Set display color of mark data.

Background: Set the color of background in the mark data display area.

*1: For the NT21, NT31, NT31C, NT631, and NT631C, even under condition that the string has smoothing ON and the mark has inserted, it will not work.

Guidance

- By specifying mark data, special characters and symbols can be created on the screen.
- To display a mark, specify its code.
- If no mark data has been created for the specified code, a blank is displayed.
- To change the mark data to be displayed, click on in the property setting dialog box and select the desired mark data in the list.
The procedure for selecting the desired mark data is shown below.

1. Click on [Change] in the attribute setting dialog box to display the mark data selection dialog box.

![Dialog Box]

2. Specify the mark data to be displayed. The specified field is displayed enlarged. Or, input the character code that corresponds to the mark data to be displayed into the [Code] input field.

3. Click on [OK] to close the dialog box.

- For the procedure for creating mark data, refer to 8-3 Mark Editor.

6-2-11 Library Object (Data)

Library data is displayed.

There are two types of library data. One type of library data references the fixed code directly, the other type uses indirect reference. Indirect reference is a function that can change the library data to be displayed by writing the library code to the numeral table entry just like the indirect reference of numeral/string display. This enables the animation display by switching the display contents using a simple program. For details of the PT models that can use indirect reference, refer to Appendix E Table of Functions of Each PT Model.

Library data cannot be used for NT11S/NT11, NT20, NT20S and NT600S.

![Library Display]

1. Library data consisting of fixed display elements is displayed.

**Note**

By registering a graphic created using multiple fixed display elements as the library data, the same graphic can be arranged in different positions.

**Operation procedure**

Selection using the menu bar: 
[Objects] → [Fixed Display] → [Library Display]
Selection using the drawing toolbar:

**Property setting**

**General**

Position: Indicates the display position of library data. (The attribute point is at the upper left corner in the library data.)

Size: Indicates the size of library data. (Frame size of the library data)

**Reference Type**

Direct: Set the library code directly.

Code: Indicates the code of the library data to be displayed.

Comment: Displays the comment that is set for the library data.

Indirect: Set this item when the value for the specified numeral table entry is treated as library code and referenced indirectly.

Table No.: Specify the numeral table entry to be referenced. When using the indirect reference, set the storage type of allocated numeral table entry to Binary. Also, when specifying the library code from a program etc., use hexadecimal value since the library table code is in hexadecimal.

: Displays the list for selecting the library data when Direct is specified. Displays the list for referencing the numeral table entry when Indirect is specified.

**Guidance**

- When the library data is specified, the data of character code FA20H (for the NT30, NT30C, NT620S, NT620C, NT625C, NT21, and NT31/631-V2 and above with NT20/30/620-compatible mode), or the data that corresponds to image/library code 1000H (for the NT21, NT31, NT31C, NT631, NT631C without NT20/30/620-compatible mode) is arranged.

- The mark shown below will be displayed if library data has not been created for the specified code.

- To change the library data to be displayed, click on in the property and select the desired library data or numeral table entry from the list. If you are using the NT31, NT31C, NT631 or NT631C “-V1” and above, and its system program version is 2.1 and above, “Indirect reference” can be set.

The procedure for specifying the desired library data is shown below.

**Direct**

Specify the code of the library data to be displayed directly.
(1) Click on at the right side of the code after checking the [Direct] button in the property setting dialog box to display the library data selection dialog box.

(2) If the code of the desired library data is not found in the list, scroll the list using the scroll bar at the right side of the screen, or click on to open the code input dialog box.

Input the code of the desired library data and click on .

By pressing cursor keys (↑, ↓) on keyboard, the contents of the code can be checked in the preview window one by one.

(3) Select the code of the library data to be displayed.

The selected line will be highlighted.

(4) Click on to close the dialog box.

**Indirect**

Specify the numeral table entry to be referenced.

With indirect reference, the contents for the specified numeral table entry are treated as a library code and the corresponding library data is displayed. This is useful when you want to change the library data to be displayed according to the statuses. Set the storage type of numeral table entry to be referenced by indirect reference to Binary and specify the value (library code) to be stored in hexadecimal since the library code is in hexadecimal.

Set the numeral table entry number to be referenced in the table entry number field.

It is possible to display a numeral table entry so that you can select the desired
To display a numeral table entry, follow the procedure below.

(1) Click on the button at the right side of the table entry number after checking the [Indirect] button in the property setting dialog box to display the numeral table selection dialog box.

(2) If the number of the desired numeral table entry is not found in the list, scroll the list using the scroll bar at the right side of the screen, or click on the button to open the entry input dialog box.

Input the number of the desired numeral table entry and click on the button.

(3) Select the desired numeral table entry to be referenced. The selected line will be highlighted.

(4) Click on the button to close the dialog box.

- For the procedure for creating library data, refer to 8-2 Library Editor.
6-3 Alarm

Alarms are elements that check the status of a bit memory table entry and change the contents of the display according to the detected status. Alarm elements consist of alarm lists and alarm histories.

Alarm list:

When a bit memory table entry in the specified range goes ON, the alarm list displays the corresponding message or image/library data.

Since the bit memory table entries to be checked are set for the individual alarm lists, it is possible to check different ranges of bit memory table entries with different alarm table entries.

Bit memory table entries in the specified range are checked only while an alarm list is displayed, and the message and image/library data are displayed in accordance with the bit memory table entry that is ON.

Alarm history:

When a bit memory table entry for which a check mark is set for the history property goes ON, the date/time and the number of going ON events are recorded and displayed by the alarm history. All bit memory table entries for which a check mark is set for the history property are objects of alarm history recording. Therefore, it is not possible to check different bit memory table entries with different alarm histories.

The status of the bit memory table entries for which a check mark is set is always checked while a PT is running, regardless of whether or not an alarm history element is displayed.

Note that an alarm history element displays only the record of past events. It displays only the contents of the record at the point when it was displayed and the displayed record remains the same even if the status of the bit memory table entry changes after that.

Alarm list and alarm history elements cannot be used with NT11S/NT11, NT20, NT20S and NT600S.

6-3-1 Alarm List

If a bit memory table entry in the check objective range goes ON, the alarm list element displays the contents (alarm message) of the character string memory table entry (string table) that is allocated to the bit memory table entry. It is also possible to display the corresponding image/library data.

Note: It is possible to switch the screen by operating the alarm list element by setting the screen number to which the screen should be switched for the bit memory table entry.
(1) When the bit memory table entry number in the specified range goes ON, the alarm list element reads out the alarm message from the character string memory table entry (string table) and displays the message at the alarm list area in the screen.

(2) If an operator touches the displayed alarm message, the specified image/library data will arrive.

**Note** The alarm message and the image/library data to be displayed are specified according to the setting at the bit memory table entry.

### Operation procedure

Selection using the menu bar: 
[Objects] → [Alarm] → [List]

Selection using the drawing toolbar: [ ]

### Related elements and settings

**Bit memory table entry:** 
[Tools] → [Table] → Bit Memory  
(Refer to 7-4 Bit Memory Table.)

### Terminology

![Terminology Diagram]

### Property setting

#### General

**Position:** Indicates the display position of the alarm list.  
(The attribute point is at the upper left corner of the alarm list.)

**Size:** Indicates the size of the alarm list.

**Message**

**Length:** Specify the number of characters of the message to be displayed.

- Max. 32 characters: NT21
- Max. 39 characters: NT30, NT30C, NT31, and NT31C
- Max. 40 characters: NT631 and NT631C to which a system program version lower than Ver.2.1 is installed.

With these models above, the number of characters to be displayed will be less
than these values according to the display method and if the history information is displayed.

Max. 40 characters: NT620S, NT620C, NT625C, NT631 (System Ver.2.1), and NT631C (System Ver.2.1)

With these models above, up to 40 characters can be displayed regardless of the display method etc.

Display Line Qty: Specify the number of messages to be displayed.

Max. 7 lines: NT21
Max. 12 lines: NT30, NT30C, NT31, NT31C
Max. 16 lines: NT620S
Max. 24 lines: NT620C, NT625C, NT631, NT631C

Scale: Specify the character size of the message to be displayed.

1 × 1 (Equal), 1 × 2 (High), 2 × 1 (Wide), 2 × 2, 3 × 3, 4 × 4, 8 × 8

Smoothing: Specify if smoothing processing is executed for the message to be displayed.

Line Scroll Touch Switch: Set if a touch switch is set for scrolling messages line by line. Only for NT21, NT31, NT31C, NT631, and NT631C

Page Scroll Touch Switch: Set if a touch switch is set for scrolling messages page by page. Only for NT21, NT31, NT31C, NT631, and NT631C

Color

Frame: Specify the color used for the frame of an alarm list.

Background

ON: Specify the background color of the selected message display field.

OFF: Specify the background color of the message display fields that are not selected.

Image & Library

Display of Image Lib: Specify if the image/library data is displayed.

Color

Specification of color is valid only when 2-color mode image data is displayed by a color type PT.

Foreground: Specify the display color of image data.

Background: Specify the background color of the image data display area.

Reference: With NT30, NT30C, NT620S, NT620C, and NT625C, a dialog box is displayed to set if the line scroll touch switch and page scroll touch switch are used.

With NT21, NT31, NT31C, NT631, and NT631C, whether or not the line scroll touch switch and page scroll touch switch are used is determined in the alarm list/history properties.

Settings

List Setting
Start Bit Table Entry: Specify the start number of bit memory table entries that are checked by the alarm list element.

No. of Bits Referenced: Specify the number of bit memory table entries that are checked by the alarm list element.

Guidance

- Using a line scroll touch switch and a page scroll touch switch, you can scroll messages in units of a line or a page within the alarm list display area.

- With NT31, NT31C, NT631, and NT631C, to display a line scroll touch switch and/or a page scroll touch switch, set a check mark in the line scroll touch switch and/or a page scroll touch switch check box in the Property setting dialog box.

- With the NT21, NT31, NT31C, NT631, and NT631C, a line scroll touch switch and a page scroll touch switch are a part of an alarm list element. Therefore, they cannot be modified as a touch switch. They can be moved only when the alarm list is modified. For the NT21, NT31, NT31C, NT631, and NT631C, the line and page scroll touch switch can be moved by clicking the desired touch switch while holding down the Shift key and Ctrl key. ([Edit Object] from the [Edit] menu (or pop-up menu) and Ins key can also be used for this operation.)

With NT30, NT30C, NT620S, NT620C, and NT625C, however, a line scroll touch switch and a page scroll touch switch are independent elements and their position, size, and label can be changed as required. However, the touch switch function and the lamp setting should not be changed, otherwise the switch and the lamp will fail to function correctly on PT.

- To display the image/library data, set a check mark in the check box of [Display Image Lib] in the Property setting dialog box.

- The procedure for editing the image/library data display area is shown below.

  1. Specify only the image/library data display area (dotted line frame) while holding down the Shift key and Ctrl key. (automatically enters to Edit Object mode)

     Green ■ marks (handles) are displayed surrounding the image/library data display area.

     There are other methods to enter Edit Object mode. For details, refer to Specifying an element consisting of multiple elements on page 110.

  2. Specify the display size of the image/library data display area and move it as desired.

- If the size of the image/library data is smaller than the display area, the image/library data is displayed taking the lower left corner of the display area as the reference.

Reference: With NT31, NT31C, NT631, NT631C, if image/library data is larger than the image/library data display area, the area exceeding the display area will not be
displayed on PT while the whole data is displayed on the Support Tool. Be sure to set image/library data display area so that image/library data fits inside it.

- For an alarm list element, the property settings, bit memory table, and character string memory table (string table) are related to each other as shown below.

![Diagram of alarm list element and its components]

- An alarm list element is used in combination with bit memory table entries. How they function is shown below:

**Setting at bit memory table**

- Setting at Set dialog box

**PLC Address**

- Setting at Function dialog box

**History**

**Screen No.**

- Switch Screen
  - Screen No.

**String Table Entry**

**Image/Library Code**

- Use of image/library data
  - Image/library code

**Color**

**Property settings for alarm list element**

**Start Bit Table Entry**

**No. of Bits Referenced**

- The setting for the [Switch Screen] bit memory table setting differs between the NT30, NT30C, NT620S, NT620C, and NT625C, and the NT21, NT31, NT31C, NT631, and NT631C as shown below.

**NT30, NT30C, NT620S, NT620C, and NT625C:**

Specifies whether or not the screen is switched at the same time the PC (PLC) bit allocated to bit memory table entry goes ON.
NT21, NT31, NT31C, NT631, and NT631C:

Specifies whether or not the screen is switched when the message displayed at the alarm list is pressed.

The following table shows the appropriate setting of the bit memory table for the required alarm processing, for your reference.

NT30, NT30C, NT620S, NT620C, and NT625C:

<table>
<thead>
<tr>
<th>Usage of Alarm</th>
<th>Setting for Bit Memory Table</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Function Setting</td>
</tr>
<tr>
<td>To display alarm only</td>
<td>Alarm/Switch Screen</td>
</tr>
<tr>
<td>To display alarm and switch to a specified screen in response to the pressing of alarm message</td>
<td>Alarm/Switch Screen</td>
</tr>
<tr>
<td>To switch to a specified screen at the same time the bit goes ON</td>
<td>Alarm/Switch Screen</td>
</tr>
<tr>
<td>To switch to the previous screen at the same time the bit goes ON (Switch to the previous screen based on the record of screen history)</td>
<td>Alarm/Switch Screen</td>
</tr>
</tbody>
</table>

NT21, NT31, NT31C, NT631, NT631C:

<table>
<thead>
<tr>
<th>Usage of Alarm</th>
<th>Setting for Bit Memory Table</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Function Setting</td>
</tr>
<tr>
<td>No function (For registering only allocated bits and securing them)</td>
<td>None</td>
</tr>
<tr>
<td>To display alarm only</td>
<td>Alarm</td>
</tr>
<tr>
<td>To display alarm and switch to a specified screen in response to the pressing of alarm message</td>
<td>Alarm</td>
</tr>
<tr>
<td>To switch to a specified screen at the same time the bit goes ON</td>
<td>Switch screen</td>
</tr>
</tbody>
</table>

WARNING

When converting the bit memory table from the NT30, NT30C, NT620S, NT620C, NT625C to the NT21, NT31, NT31C, NT631, NT631C, the function setting is not the same with before converting. To adjust the setting of this bit memory table, please refer to Data Conversion (Bit memory conversion) in Appendix A.
• The [Settings] of an alarm list element are used to specify the range of bit memory table entries that are subject to the check.

The check objective range is determined by setting the start bit memory table entry number and the number of bit memory table entries. The maximum allowable number of bit memory table entries varies according to the PT model and the setting of the number of bit memory table entries. The range of bit memory table entry numbers is displayed in parentheses in the dialog box: Set the start memory table entry number and the number of memory table entries so that the displayed range is not exceeded.

While an alarm list element is displayed, the status of the bit memory table entries in the specified range is always checked and the element displays the message or image/library data that is set for the bit memory table entry when a bit memory table entry is turned ON.

Allocation of a PC (PLC) bit to a bit memory table entry is specified at the bit memory table. (Specified character string memory table entry (string table) and image/library data code are also specified at the bit memory table.)

The alarm range, i.e., the start address (No.) in the bit memory table entry and the size, is specified by the alarm list element.

### 6-3-2 Alarm History

If a bit memory table entry for which a check mark is set for the history property goes ON, the date/time and the number of going ON events are recorded in an alarm history. An alarm history element displays the recorded bit table entry numbers in the order of occurrence or frequency when the element is displayed.

An alarm history element can also display the contents (alarm message) of the character string memory table entry (string table) and the image/library data that are allocated to the bit memory table entry.

(1) When a bit memory table entry for which a check mark is set for the history property goes ON, the alarm history element reads out the alarm message from the character string memory table entry (string table) and records the
message with the date/time of the occurrence. The recorded information is displayed when the alarm history element is displayed.

(2) If the operator touches the displayed alarm message, the specified image/library data is displayed.

**Note**  The bit memory table entries to be checked are determined according to the settings made at the individual bit memory table entries.

**Operation procedure**

Selection using the menu bar:  [Objects] → [Alarm] → [History]

Selection using the drawing toolbar:  

**Related elements and settings**

Bit memory table:  [Tools] → [Table] → Bit Memory  
(Refer to 7-4 Bit Memory Table.)

**Terminology**

- **Display line**
- **Length**
- **Frame**
- **Background**
- **Page scroll touch switch**
- **Line scroll touch switch**
- **Image/library data**
- **Foreground**

**Property setting**

**General**

- **Position:** Indicates the display position of the alarm history.  
  (The attribute point is at the upper left corner of the alarm history)
- **Size:** Indicates the size of the alarm history.
- **Message**

  - **Length:** Specify the number of characters of a message to be displayed.
    - Max. 32 characters: NT21
    - Max. 39 characters: NT30, NT30C, NT31, and NT31C
    - Max. 40 characters: NT631 and NT631C to which a system program version lower than Ver.2.1 is installed

  With these models above, the number of characters to be displayed will be less than these values according to the display method and if the history information is displayed.

  - Max. 40 characters: NT620S, NT620C, NT625C, NT631 (System Ver.2.1), and NT631C (System Ver.2.1)
With these models above, up to 40 characters can be displayed regardless of the display method etc.

**Display Line Qty:** Specify the number of messages to be displayed.

- **Max. 7 lines:** NT21
- **Max. 12 lines:** NT30, NT30C, NT31, NT31C
- **Max. 16 lines:** NT620S
- **Max. 24 lines:** NT620C, NT625C, NT631, NT631C

**Scale:** Specify the character size of the message to be displayed.

- 1 × 1 (Equal), 1 × 2 (High), 2 × 1 (Wide), 2 × 2, 3 × 3, 4 × 4, 8 × 8

**Smoothing:** Specify if smoothing processing is executed for the message to be displayed.

**Line Scroll Touch Switch:** Set if a touch switch is set for scrolling messages line by line. Only for NT31, NT31C, NT631, and NT631C

**Page Scroll Touch Switch:** Set if a touch switch is set for scrolling messages page by page. Only for NT31, NT31C, NT631, and NT631C

**Color**

- **Frame:** Specify the color used for the frame of an alarm list.
- **Background**
  - **ON:** Specify the background color of the selected message display field.
  - **OFF:** Specify the background color of the message display fields that are not selected.

**Image & Library**

- **Display of Image Lib:** Specify if the image/library data is displayed.

**Color**

Specification of color is valid only when the image data of 2-color mode is displayed by a color type PT.

- **Foreground:** Specify the display color of image data.
- **Background:** Specify the background color of the image data display area.

**Reference:** With NT30, NT30C, NT620S, NT620C, and NT625C, a dialog box is displayed to set if line scroll touch switch and page scroll touch switch are used. With NT31, NT31C, NT631, and NT631C, whether or not the line scroll touch switch and page scroll touch switch are used is determined by the setting for the use of control touch switches in the alarm list/history properties.

**Settings**

**History Info:**

Specify whether or not an alarm message is displayed with date/time of occurrence or frequency of occurrence. If a check mark is set for this item, the date/time of alarm occurrence is displayed with an alarm message for display in order of occurrence, or the frequency of occurrence is displayed with an alarm
message for display in the frequency of occurrence. The display format of the
date/time of occurrence is set for [Info Type]. If the date/time or frequency of
occurrence is displayed, the number of alarm message display characters is
reduced accordingly.

Order Type

Order of Frequency: Alarm messages are displayed in the order of occur-
rence frequency.

Order of Occurrence: Alarm messages are displayed in the order of occur-
rence (from the oldest record or from the newest re-
cord). The order in which the alarm messages are
displayed depends on the system memory setting.

Info Type:

If the setting is so made to display the date/time of alarm occurrence, the dis-
play format of the date/time is specified for this item. The setting for this item is
invalid if the date/time is not displayed with an alarm message.

Y/M/D h:m (14 digits)
M/D h:m (11 digits)
h:m (5 digits)

Guidance

• Using a line scroll touch switch and a page scroll touch switch, you can scroll
messages in units of a line or a page within the alarm list display area.

• With the NT21, NT31, NT31C, NT631, and NT631C, to display a line scroll
touch switch and/or a page scroll touch switch, set a check mark in the check
box for the line scroll touch switch and/or a page scroll touch switch in the Prop-
erty setting dialog box.

• With the NT21, NT31, NT31C, NT631, and NT631C, a line scroll touch switch
and a page scroll touch switch are a part of an alarm list element. Therefore,
they cannot be modified as a touch switch. They can be moved only when the
alarm list is modified. To move a line scroll touch switch or a page scroll touch
switch, click the desired touch switch while holding down the Shift key and Ctrl
key. ([Edit Object] from the [Edit] menu (or pop-up menu) and Ins key can also
be used for this operation.)

With NT30, NT30C, NT620S, NT620C, and NT625C, however, a line scroll
touch switch and a page scroll touch switch are independent elements and
their position, size, and label can be changed as required. However, the touch
switch function and the lamp setting should not be changed, otherwise the
switch and the lamp will fail to function correctly.

• To display the image/library data, set a check mark in the check box of [Display
Image Lib] in the Property setting dialog box.

• The procedure for editing the image/library data display area is shown below.

   (1) Specify only the image/library data display area (dotted line frame) while
       holding down the Shift key and Ctrl key. (automatically enters to Edit Object
       mode)

       Green ■ marks (handles) are displayed surrounding the image/library data
display area.

   (2) Specify the display size of the image/library data display area and move it as
desired.
If the size of the image/library data is smaller than the display area, the image/library data is displayed taking the lower left corner of the display area as the reference.

**Reference:** With the NT21, NT31, NT31C, NT631, and NT631C, if image/library data is larger than the image/library data display area, the area exceeding the display area will not be displayed on PT while the whole data is displayed on the Support Tool. Be sure to set image/library data display area so that image/library data fits inside it.

- For an alarm history element, the property settings, bit memory table entry, and character string memory table entry (string table) are related to each other as shown below.

An alarm history element is used in combination with the bit memory table entry. How they function is shown below:

### Setting at bit memory table entry
- Setting at Set dialog box
  PLC Address
- Setting at Function dialog box
  History
  Screen No.

Switch Screen
Screen No.
### String Table Entry

#### Image/Library Code

- Use of image/library data
- Image/library code

### Color

**Property settings for alarm history element**

- History Info
- Order Type
  - Order of Frequency
  - Order of Occurrence

- All bit memory table entries for which a check mark is set for the alarm history property are subject to alarm history recording.
6-4 Data Input

For inputting numerals and character strings in a PT, the following three data input elements are provided.

Numeral input:

A numeric value is input into a numeral setting input field using touch switches to which numerals are allocated and the input from an extended I/O connected to a PT.

Character string input:

A character string is input to a character string input field using touch switches to which characters are allocated and a bar code reader connected to a PT.

Thumbwheel switch:

Touch switches that increase or decrease a numeral are provided at each digit of an input field; a numeric value can be input by simply pressing the + and – touch switches.

String input is not possible for NT11S/NT11, NT20, NT20S and NT600S.

6-4-1 Numeral Input

You can write numeric data to a numeral memory table entry using touch switches and extended inputs.

Touch switches must be allocated numerals or the copy function beforehand.

For extended inputs, numerals must be allocated beforehand.

Input using touch switches (control code input function)

(1) Create numeric keys using the touch switch control code input function, or create a system keypad using the screen property. (With the NT21, NT31, NT31C, NT631, and NT631C, system keypad is not available.)

(2) Set a numeric value in the numeral setting input field using the numeric keys on the screen.

(3) Press the touch switch to which the key code is allocated to write the data set at the input field to the specified numeral memory table entry.
Input using touch switches (copy function + control code input function)

(1) Copy the preset data (numeral memory table entry or constant) to the input field using the copy function allocated to a touch switch.

(2) Press the touch switch to which the \( \mathcal{D} \) key code is allocated (by the control code input function) to write the data that was copied (set) to the input field to the specified numeral memory table entry.

**Reference:** To copy (in the numeral table) and display a numeral by a single key operation, without using the \( \mathcal{D} \) key code, use a touch switch (copy function) and a numeral display element.

Input using extended input (control code input function)

(1) By turning ON an external switch that is connected to an external input, the numeral or the control code set for the extended input function can be input to the numeral setting input field.

(2) Press the touch switch to which the \( \mathcal{D} \) key code is allocated to write the data set at the input field to the specified numeral memory table entry.

(For the setting of an extended input, refer to 7-5 Extended I/O Input Table.)

**Operation procedure**

Selection using the menu bar: [Objects] → [Data Input] → [Numeral]

Selection using the drawing toolbar: 

**Related elements and settings**

Touch switch (control code input): [Objects] → [Touch Switch] → Control code input function
Touch switch (copy setting): [Objects] → [Touch Switch] → Copy setting

Extended I/O input table (control code input): [Tools] → [Table] → Control code function

### Terminology

![Terminology Diagram]

- **Cursor (focus) moving touch switch**
- **Foreground**
- **Background**
- **Focus (cursor) frame**
- **Sign digit**
- **Integer**
- **Decimal**
- **Input digits of maximum limit**

### Property setting

#### General

- **Position:** Indicates the display position of the numeral setting input field. (The attribute point is at the upper left corner of the input field.)
- **Font type:** Specify the font for the numerals to be input. Standard, Half Height, Double Width (Only Standard can be set for NT11S/NT11.)
- **Size:** Specify the size of numerals to be displayed. 1 × 1 (Equal), 1 × 2 (High), 2 × 1 (Wide), 2 × 2, 3 × 3, 4 × 4, 8 × 8 (Not supported for NT20, NT20S) (Only 1 × 1 (Equal) and 2 × 1 (Wide) can be set for NT11S/NT11.)
- **Smoothing:** Specify whether or not smoothing processing is executed for numerals. (Setting is not possible for NT11S/NT11, NT20, NT20S and NT600S.)
- **Attribute:** Specify the display attributes (attributes to be displayed depend on PT models.) Standard, Inverse, Flash, Inverse Flash

#### Color

- **Foreground:** Specify the numeral color. (Can only be set for PTs with color display.) White, black, blue, red, magenta, green, cyan, yellow
- **Background:** Specify the color of the background in the numeral display area. (Can only be set for PTs with color display.) White, black, blue, red, magenta, green, cyan, yellow

#### Settings

- **Table Entry:** Specify the table entry number of the numeral memory table where input data is stored.
Display Type (Only Decimal can be set for NT11S/NT11.)*1

Decimal: Specify this item to display the input numeric value in decimal.
Hexadecimal: Specify this item to display the input numeric value in hexadecimal.

Format*2

Integer: Specify the number of digits of the integer part of the input data.
Decimal: Specify the number of digits of the decimal fraction part of the input data.

Limit (Setting is not possible for NT11S/NT11.)*1

Maximum: Specify the upper limit of the input data.*3
Minimum: Specify the lower limit of the input data.*3

Zero Suppression:*1 Specify whether or not leading zeros are suppressed to display the input data.
Display Sign:*1 Specify if a sign is displayed for a negative value.
Focus Frame: Specify whether or not the frame that indicates the data input objective is displayed. (Setting is not possible for NT11S/NT11, NT20S and NT600S.)
Focus Attribute: Specify how the input data is displayed before it is confirmed. Standard, Inverse, Flash, Inverse Flash

*1: Setting is not possible when a numeral input is used as a temporary input field for the NT21, NT31, NT31C, NT631, and NT631C.
*2: When a numeral input is used as a temporary input field for the NT21, NT31, NT31C, NT631, and NT631C, only No. of digits (sign digit + integer digit + decimal point + decimal digit) can be specified, since the digits such as decimal digits are determined by the numeral input field on a base screen.
*3: An input method for a negative value in decimal differs between the following types of PT:

- With NT20, NT20S, NT30, NT30C, NT600S, NT620S, NT620C, and NT625C:
  Input F to indicate a negative value in the most significant digit.
  (e.g., F0000008)

- With NT21, NT31, NT31C, NT631, and NT631C:
  Input – (negative sign) in the most significant digit.
  (e.g., –8)

When setting values with decimal fractions, such as 0.1234, 1.234, or 123.4 for upper limits or lower limits, input only the 4-digit integer.

Interlock
Refer to 6-1-12 Interlock.

Guidance

- When a numeral input element is specified, a dialog box is displayed to set whether the cursor moving touch switch is automatically created or not.
Note  It is possible to create a touch switch to which a cursor moving key is allocated later.

Create Cursor Move Touch Switch

Specify whether or not a cursor moving touch switch is automatically created. Settings may not be possible for some PT models.

Each time a numeral input or thumbwheel object is newly created, a numeral table entry number (where input data is stored) is automatically set as 0→1→2... incrementally (table entry number after the last set one will be the next default number). A numeral table entry number can be changed by displaying the property setting dialog box. (It is also possible to change it later.)

- A numeral input element itself creates a numeral setting input field. It is always used with a control code inputting touch switch (control code input function) or a system keypad. Data is input to a numeral setting input field using the control code input touch switches and the system keypad that are displayed with the numeral setting input field.

The procedure for creating a control code input touch switch is shown below.

1. Set the control code input function for a touch switch.
2. Select the code from the control code list.
The control code input function allows an arbitrary name for a label of a touch switch. Click the **Edit** button in the **General** tab to display the label input dialog box. Input a label.

- A system keypad is created in the manner shown below.
  
  With the NT21, NT31, NT31C, NT631, and NT631C, a system keypad cannot be created.

1. Select [Screen] (menu bar), then select [Properties].
   
   This operation is also possible by selecting [Properties] after displaying the pop-up edit menu, which is displayed by right clicking the mouse or by double clicking the mouse with the mouse cursor placed at a position other than an element.

2. Set a check mark for the system keypad in the screen properties.
   
   The allowable maximum number of input digits is determined by the setting for the [Format] and [Display Sign] properties.

   Even if multiple input fields are arranged in a screen, input is possible only for one numeral setting input field. Therefore, it is necessary to create a touch switch (cursor moving touch switch, or arrow symbol touch switches) that can be used to select the desired numeral setting input field. If the Create Cursor Move Touch Switch check box is ON when creating the input element, a cursor moving touch switch is automatically created overlapping a numeral setting input field. By simply pressing this input field, the cursor is moved.
If a touch switch on input field No. 2 is pressed, the No. 2 input field becomes the objective field for data input. The data input using the numeric keys is stored in input field No. 2.

- A cursor moving touch switch is created using the dialog box that is displayed when creating a numeral input element. The properties for the cursor moving touch switch can be set in the same manner as for a standard touch switch.

How the properties for a touch switch are set is shown below.

For details of [Settings], refer to 6-8 Touch Switches.

- If a check mark is set for [Use Window/Keyboard Screen] in the cursor moving touch switch setting properties, it is possible to display the specified window/keyboard at the same time the cursor is moved.

This feature allows appropriate numeric keys for the input field to be displayed.

It is possible to create a temporary input field in addition to numeric keys. (With the NT21 and with the NT31, NT31C, NT631, and NT631C "-V1" and above, all objects other than thumbwheel switch and recipe objects can be created on window.)
• It is possible to create a temporary input field at the same time as numeric keys are arranged in the window/keyboard.

A temporary input field is created using a numeral input element.

When a numeral input element is arranged in the window/keyboard, the element is automatically set as a temporary input field.

Only one numeral input element (temporary input field) can be created for one window/keyboard.

• Setting processing differs as shown below depending on whether or not a temporary input field is used.

**When a temporary input field is used**

1. The data that is input using numeric keys is displayed in the temporary input field.

2. Input the key, and the data in the temporary input field is set in the numeral setting input field and stored in the numeral memory table at the same time.

**When a temporary input field is not used**

1. The data input using numeric keys is directly set in the numeral setting input field.

2. Press the key, and the set data is stored in the numeral memory table.

**Reference:** With the NT21, NT31, NT31C, NT631, and NT631C, the settings, such as the Display Sign cannot be set at setting property of temporary input field (These settings are determined by the numeral input field on a base screen). When a numeral input field is used as a temporary input field for the NT21, NT31, NT31C, NT631, and NT631C, specify the required No. of digits (sign digit + integer digit + decimal point + decimal digit).

**⚠️ CAUTION**

When the numeral values entered are confirmed, upper/lower limits are checked. Otherwise the system may operate unpredictably.
Note 1. The data set in the input field is not stored in the numeral memory table until the return (button where the Return key code is set) or the ENT key is pressed. At the end of data input, always press the return or the ENT key.

2. To correct the data set in the input field, use the CLR key, the BS key, and the DEL key.

3. When a numeral setting input field is moved, the touch switch is also moved automatically. To modify or move a numeral setting input field and a touch switch independently, cancel the check mark set for [Auto Arrange] in the [Settings] page of the touch switch properties.

4. The cursor can also be moved using an arrow symbol key touch switch. The cursor moves in the order the numeral input elements were created; this order can be changed after creating the elements.

5. With the NT21, NT31, NT31C, NT631, and NT631C, when hexadecimal value is input, it is regarded as signed binary data and upper/lower limit check is performed. Therefore, if the top bit is 1, it is regarded as negative value and input will be prohibited when the minimum limit was set as 0. In this case, set those value such as $80000000 (−2147483648) for minimum limit setting to prevent it from being checked.

Reference: At the numeral setting input field, the written numeric value in the numeral memory table is displayed when the return key is pressed. Since this is different from the one read from the numeral memory table entry, it is necessary to use another numeral input element to read out the data from the same address of the numeral memory table entry.

6-4-2 Character String Input

You can write character string data to a character string memory table entry (string table) using touch switches and a bar code reader.

Touch switches must be allocated character strings or a key code (control code input and character string input function), or the copy function beforehand.
Input using touch switches (character string input function + control code input function)

1. Set the character strings to be input using the character string input function to touch switches.
2. Press a touch switch to set the label that is set for the touch switch into the character string input field.
3. Press the touch switch for which the \[\text{\textbackslash i} \] key code is allocated (by the control code input function) to write the character string set at the input field to the specified character string memory table entry (string table).

Input using touch switches (copy function + control code input function)

1. Copy the preset data (character string memory table entry (string table)) to the input field using the copy function allocated to a touch switch.
2. Press the touch switch for which the \[\text{\textbackslash i} \] key code is allocated (by the control code input function) to write the data that was copied (set) into the input field to the specified character string memory table entry (string table).

Reference: To copy (in the character string memory table entry (string table)) and display a character string by a single key operation, without using the \[\text{\textbackslash i} \] key code, use a touch switch (copy function) and a character string display element.
Input using a bar code reader

(1) By reading out a bar code using a bar code reader, the bar code data can be input to the character string setting input field. If “automatic confirm” is set for bar code reading operation by the memory switch of a PT, the read-out character string is automatically written to a character string memory table entry (string table).

(2) If the setting for bar code reading operation is “manual confirm,” the data set in the input field is written to the specified character string memory table entry (string table) when the touch switch allocated the key code is pressed.

(For details of memory switch setting, refer to the operation manual for PT.)

Operation procedure

Selection using the menu bar: [Objects] → [Data Input] → [String]

Selection using the drawing toolbar: 

Related elements and settings

Touch switch (character string input): [Objects] → [Touch Switch] → character string input function

Touch switch (control code input): [Objects] → [Touch Switch] → Control code input function

Touch switch (copy setting): [Objects] → [Touch Switch] → Copy setting

Terminology

Property setting

General

Position: Indicates the display position of the numeral setting input field. (The attribute point is at the upper left corner of the input field.)

Font type: Specify the font of the character string to be input. Standard, Half Height
Size: Specify the size of character string to be displayed.
- $1 \times 1$ (Equal), $1 \times 2$ (High), $2 \times 1$ (Wide), $2 \times 2$, $3 \times 3$, $4 \times 4$, $8 \times 8$

Smoothing: Specify whether or not smoothing processing is executed for character strings.

Attribute: Specify the display attribute (attributes displayed depend on the PT model.)
- Standard, Inverse, Flash, Inverse Flash

Color
- Foreground: Specify the character string color.
  (Can only be set for PTs with color display.)
  - White, black, blue, red, magenta, green, cyan, yellow
- Background: Specify the color of the background in the character string display area.
  (Can only be set for PTs with color display.)
  - White, black, blue, red, magenta, green, cyan, yellow

Settings
- Table Entry:*1 Specify the table entry number of the character string memory table entry (string table) where input data is to be stored.
- Length: Specify the number of characters to be input.
- Focus Frame: Specify whether or not the frame which indicates the data input objective is displayed.
- Focus Attribute: Specify how the input data is displayed before it is confirmed.
  - Standard, Inverse, Flash, Inverse Flash

*1: Setting is not possible when a string input is used as a temporary input field for the NT21, NT31, NT31C, NT631, and NT631C.

Interlock
Refer to 6-1-12 Interlock.

Guidance
- When a character string input element is specified, the dialog box is displayed to set whether the cursor moving touch switch is automatically created or not.

Note
- It is possible to create a touch switch to which a cursor moving key is allocated later.

Create Cursor Move Touch Switch
Specify whether or not a cursor moving touch switch is automatically created.
- Each time a string input object is newly created, a string table entry number (where input data is stored) is automatically set as $0 \rightarrow 1 \rightarrow 2 \ldots$ incrementally (table entry number after the last set one will be the next default number). A
string table entry number can be changed by displaying the property setting dialog box. (It is also possible to change it later.)

- A character string input element itself creates a character string setting input field. It is always used with a control code inputting touch switch (control code input function) or a system keypad. Data is input to a character string setting input field using the control code input touch switches and the system keypad, which are displayed with the character string setting input field.

This data input field is created by a character string input element.

The input field and the control code input touch switch are automatically correlated. Insertion of a character string is automatically processed.

After creating touch switches (character string input and control code input) or a system keypad on the same screen (includes a pop-up window), pressing the key allocated label [A] enters [A] in the character string setting input field. If the touch key allocated [B] is then pressed, the input field shows AB.

Press the key to store the data input to the input field in the character string memory table (string table).

- The procedure for creating a character string input touch switch is shown below.

**NT30, NT30C, NT620S, NT620C and NT625C**

(1) Set the character string input function for the touch switch function.

(2) Set a check mark for the [Label] property in the Label tab.

(3) Click the Button and input the character string as a label.

A label may be either a character or a character string consisting of multiple characters. When a touch switch is pressed, the character string set as the label is set to the character string input field.

When a lamp bit with an I/O comment is set, pressing the Copy I/O Comments button copies the I/O comment as a label.

**Example**

Property setting for input key-string touch switch

---

**NT21, NT31, NT31C, NT631 and NT631C**

(1) Set the character string input function for the touch switch function.
(2) Specify a string to be input for the Input Key String in the Settings tab.

The string can be either a character or a character string consisting of multiple characters. When a touch switch is pressed, the character string set as the Input Key String is set to the character string input field.

When a label is set, pressing the Copy From Label button copies the label as an Input Key String. When the label type is “On Off Static,” the Off label will be used. When multiple lines of label have been set, only the first line will be used. If more than 40 characters are set for a label, only the first 40 characters will be set.

- The number of characters that can be set for a character string input touch switch and the number of characters that are actually written to a character string input field differ depending on the PT model, as shown below.

<table>
<thead>
<tr>
<th>PT Model</th>
<th>Number of Characters (Label)</th>
<th>Number of Characters (Written to Input Field)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT30, NT30C</td>
<td>Max. 40 characters</td>
<td>Max. 40 characters</td>
</tr>
<tr>
<td>NT620S, NT620C, NT625C</td>
<td>Max. 80 characters</td>
<td>Max. 40 characters</td>
</tr>
</tbody>
</table>

With the NT21, NT31, NT31C, NT631 and NT631C, a maximum of 40 characters can be used for string input function regardless of the PT model.

- The procedure for creating a control code input touch switch is shown below.

  (1) Set the control code input function for a touch switch.

  (2) Select the code from the control code list.

  (3) The control code input function allows an arbitrary name for a label of a touch switch. Click the **Edit...** Button in the **General** Tab to display the label input dialog box. Input a label.

- The number of characters that can be input depends on the setting for the [Length] property.

- Even if multiple input fields are arranged in a screen, input is possible only for one character string input field. Therefore, it is necessary to create a touch switch (cursor moving touch switch, or arrow symbol touch switches) that is used to select the desired character string input field. If the [Focus Frame]
If the touch switch on input field No. 2 is pressed, the No. 2 input field becomes the objective field for data input. The input character string is stored in input field No. 2.

- A cursor moving touch switch is created using the dialog box that is displayed when creating a character string input element. The properties for the cursor moving touch switch can be set in the same manner as for a standard touch switch.

How the properties for a touch switch are set is shown below. For details of [Settings], refer to 6-8 Touch Switches.

- If a check mark is set for [Use Window/Keyboard Screen] in the cursor moving touch switch setting properties, it is possible to display the specified window/keyboard at the same time as the cursor is moved.
This feature allows appropriate numeric keys for the input field to be displayed. It is possible to create a temporary input field in addition to numeric keys. (With the NT21 and with the NT31, NT31C, NT631, and NT631C “V1” and above, all objects other than thumbwheel switch and recipe objects can be created on a window.)

- It is possible to create a temporary input field at the same time as numeric keys are arranged in the window/keyboard.

A temporary input field is created using a character string input element.

When a character string input element is arranged in the window/keyboard, the element is automatically set as a temporary input field.

Only one string input element (temporary input field) can be created for one window/keyboard

- Setting processing differs as shown below depending on whether or not a temporary input field is used.

**When a temporary input field is used**

1. The input character string is displayed in the temporary input field.
2. Press the key, and the character string in the temporary input field is set in the character string input field and stored in the character string memory table (string table) at the same time.

**When a temporary input field is not used**

1. Press the key, and the character string is stored in the character string memory table (string table) at the same time.
(1) The input character string is directly set in the character string input field.

(2) Press the Return key, and the set data is stored in the character string memory table (string table).

**Reference:** When there are no string to show, string input will be invisible. Therefore, with Support Tool, dotted-line frame is displayed in character foreground color enclosing string input. (This frame will not be displayed on PT) This frame can not be set to off. However, the dotted-line frame can be set to ON and OFF when printing screen image (refer to page 427).

**Note**
1. The data set in the input field is not stored in the character string memory table (string table) until the Return key (button where the Return key code is set) or the ENT key is input if “manual confirm” is set for the bar code read operation (set using the PT memory switches). If “manual confirm” is set, always input the Return key or the ENT key at the end of data input.
2. To correct the data set in the input field, use the CLR key, the BS key, and the DEL key.
3. When a character string input field is moved, the touch switch is also moved automatically. To modify or move a character string input field and a touch switch independently, cancel the check mark set for [Auto Arrange] in the [Settings] page of a touch switch property.
4. The cursor can also be moved using an arrow symbol key touch switch. The cursor moves in the order the character string input elements were created; this order can be changed after creating the elements.

6-4-3 Thumbwheel Switch

Thumbwheel switches are provided as means to input numeric data. “+” and “−” keys are provided at each input digit to allow you to input numeric data at individual digits. (Thumbwheel switch cannot be used with NT11S/NT11.)

(1) Touch the + or – key at each digit of thumbwheel switches to set numeric data.

(2) The numeric data set using the thumbwheel switch is written to a numeral memory table entry.
Data Input

Note

If thumbwheel switches are used to input numeric data, the input data is directly written to a numeral memory table entry without being set in a data input field.

Operation procedure

Selection using the menu bar: 
[Objects] → [Data Input] → [Thumbwheel Switch]

Selection using the drawing toolbar:

Terminology

Property setting

General

Position: Indicates the display position of the thumbwheel switch. (The attribute point is at the upper left corner of the thumbwheel switch.)

Size: Specify the size of the thumbwheel switch.
Small, Medium, Large

Attribute: Specify the display attribute (attributes displayed depend on the PT model.) Standard, Inverse, Flash, Inverse Flash

End Plate: Specify whether or not end plates are displayed at the ends of the thumbwheel switch.

Thumbwheel Color

Frame: Specify the color of thumbwheel switch frame. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Foreground: Specify the foreground color of the thumbwheel switch. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the thumbwheel switch. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Character Color

Foreground: Specify the foreground color of the numeric value displayed in the thumbwheel switch.
Data Input

Settings

Table Entry: Specify the table entry number of the numeral memory table entry where input data is stored.

Display Type

Decimal: Specify this item to display the input numeric value in decimal.

Hexadecimal: Specify this item to display the input numeric value in hexadecimal.

Format

Integer: Specify the number of digits of the integer part of the input data.

Decimal: Specify the number of digits of the decimal fraction part of the input data.

Limit

Maximum: Specify the upper limit of the input data.*1

Minimum: Specify the lower limit of the input data.*1

Display Sign: Specify if a sign is displayed for a negative value.

*1: An input method for a negative value in decimal differs between the following types of PT:

- With NT20, NT20S, NT30, NT30C, NT600S, NT620S, NT620C, and NT625C:
  Input F to indicate a negative value in the most significant digit.
  (e.g., F0000008)

- With NT21, NT31, NT31C, NT631, and NT631C:
  Input “−” (negative sign) in the most significant digit.
  (e.g., −8)

Interlock

Refer to 6-1-12 Interlock.

Guidance

Each time a numeral input or thumbwheel object is newly created, a numeral table entry number (where input data is stored) is automatically set as 0→1→2... incrementally (table entry number after the last set one will be the next default number). A numeral table entry number can be changed by displaying the property setting dialog box. (It is also possible to change it later.)
The size of a thumbwheel switch can be selected from the following three sizes.

- **Small**
- **Medium**
- **Large**

End plates can be displayed at both ends of a thumbwheel switch.

- With a thumbwheel switch, the data input method can be selected as decimal or hexadecimal.
  
  **Decimal selection:** Numbers in the range of 0 to 9 can be set at each digit.
  
  **Hexadecimal selection:** Numbers in the range of 0 to 9 and A to F can be set at each digit.

For [Decimal] property, specify the position of a decimal point in the numeral to be displayed. Numeric data is written to a numeral memory table entry without a decimal point and input data is stored as an integer.

- In the sign digit, " " or "–" is displayed. To set a positive value, specify a blank (" "). For a negative value, specify "–." 

**CAUTION**

When the numeral values entered are confirmed, upper/lower limits are checked. Otherwise the system may operate unpredictably.

**Note**

1. If you use a thumbwheel switch to input numeric data, the set data is written to a numeral memory table entry at each pressing of the + or – key. This means that the values during data setting are also written to the memory table.

2. With a thumbwheel type numeric setting input field, if \( n...n < m...m \) [upper limit: \( 1n...n \), lower limit: \( 0m...m \) (\( n \) and \( m \) are arbitrary values at each digit)], carry over and shift to the lower digit are not possible at the highest digit position.
Example:

When 1200 is set for the Maximum and 201 is set for the Minimum, if the initial value is a 3-digit value, the setting value can be changed only in the range of 201 to 999, and if the initial value is a 4-digit value, the setting value can be changed only in the range of 1000 to 1200.
This is because the limit check function detects an error if the most significant digit value is changed from 0 to 1 or from 1 to 0.
To avoid this problem, set the maximum and minimum limits so that n...n ≥ m...m or provide a touch switch separately to write a value at carry over or shift to the lower digit.

3. With the NT21, NT31, NT31C, NT631, and NT631C, when hexadecimal value is input, it is regarded as signed binary data and upper/lower limit check is performed. Therefore, if the top bit is 1, it is regarded as negative value and input will be prohibited when the minimum limit was set as 0. In this case, set those value such as $80000000 (−2147483648) for minimum limit setting to prevent it from being checked.
6-5 Lamps

The status of a lamp changes according to the status of a PC (PLC) bit.

Two types of lamp element are provided – standard lamps that change their display status (ON/flash/inverse flash) and image/library lamps that show different image/library data in the lamp ON and OFF states.

Image/library lamps cannot be used with NT11S/NT11, NT20, NT20S and NT600S.

6-5-1 Standard Lamps

A lamp (OFF/ON/flash) is displayed in accordance with the status of a PC (PLC) bit.

![Diagram showing relationship between PC (PLC) bit and lamp status]

1. The status of a lamp is changed according to the allocated PC (PLC) bit.

Operation procedure

Selection using the menu bar: [Objects] → [Lamp] → [Standard]

Selection using the drawing toolbar: 

Terminology

![Terminology diagram showing label, frame, ON color/ OFF color]

Property setting

**General**

Position: Indicates the display position of a standard lamp. (The reference point is at the upper left corner of the standard lamp)

Size: Indicates the size of a standard lamp.

Frame: Specify whether or not a frame is displayed for a standard lamp.

Shape: Displays shapes of a standard lamp. (Selectable shapes vary according to the PT model) Rectangle, Circle, Polygon, Sector
Color

Frame: Specify the color of a lamp frame if [Frame] is selected. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

ON: Specify the display color of a standard lamp when the PC (PLC) bit is ON. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

OFF: Specify the display color of a standard lamp when the PC (PLC) bit is OFF. (Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan, yellow

Light Functions

Address

PC (PLC) Bit Address: Specify the bit at the PC (PLC) that drives a standard lamp ON/OFF.
I/O Comment: Specify the comment of the PC (PLC) bit that drives a standard lamp ON/OFF.

Lamp Attribute

ON Type: Specify the status of a standard lamp that is ON.
Light, Flash

: Displays the dialog box used to specify the bit number.
: Displays an I/O comment table entry.

Label

Label: Specify whether or not a label is appended to a standard lamp.
Label Type: Specify the type of the Label when [Label] is selected. Following selections will be available for the NT21 and NT31/631-V2/V3 models: Static, Static On Off, Numeral Display and String Display. For the other PT models, this option is disabled and is set to Static (default).

: Displays the dialog box used to edit a label. This button is enabled only when [Label] is selected.

: Copies the I/O comment set to the lamp bit as a label.

To display a label, set a check mark in the check box of the Label attribute in [label] page and select an option of the available options from the Label Type combo box.

For the non-NT21 and NT31/631 V2 models this combo box will have only one choice (‘Static’) and this will remain disabled.

Static: For this option the On label and the Off label will be same.
On Off Static: For this option On/Off labels may be different.
**Numeral Display:** Displays the numeral value by referencing the specified table entry. Indirect reference is also possible.

**String Display:** Displays the character string by referencing the specified table entry. Indirect reference is also possible.

To display the settings for a label click the **Edit** button. The dialog box for setting a label is displayed.

Use the **Copy I/O Comments** button in the property dialog to copy the I/O comment set to the PLC address of the lamp bit as a label.

The property setting dialog for both Static and On Off Static labels is shown below.

For Static, the label can be set by changing description of **Off Label** group box of [Standard Lamp <Label>] dialog box. **On Label** group box will be disabled.

For On Off Static, the Off Label and the On Label can be set by changing description of corresponding text boxes.

![Standard Lamp <Label>](image)

- **Off Description:** Specify the text of the label that will be displayed when lamp bit is OFF.
- **On Description:** Specify the text of the label that will be displayed when lamp bit is ON.
- **Line Spacing:** Determines the space between two lines in both the Off Description and the On Description.
- **Insert New Line:** Inserts a new line character in the description to bring the following characters to the next line. On the Label Description edit box, the new line character will be shown as `\n`.
Set Lines: Displays the On/Off Description Settings dialog box. This dialog is for entering Off Description and On Description with multiple lines.

In all NT21 and NT31/631 V2 models, Labels can be entered in multiple lines. The following table shows the specification for each PT model.

<table>
<thead>
<tr>
<th></th>
<th>Maximum number of characters</th>
<th>Maximum number of characters per line</th>
<th>Number of lines permitted</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT21</td>
<td>128</td>
<td>32</td>
<td>1 to 8</td>
<td>Maximum number of characters per line include the “\n” character.</td>
</tr>
<tr>
<td>NT31/C-V2</td>
<td>128</td>
<td>40</td>
<td>1 to 15</td>
<td>Maximum number of characters per line include the “\n” character.</td>
</tr>
<tr>
<td>NT631/C-V2</td>
<td>256</td>
<td>80</td>
<td>1 to 30</td>
<td>Maximum number of characters per line include the “\n” character.</td>
</tr>
</tbody>
</table>

The Set Lines button will display On/Off Description Settings dialog box, in which the On/Off description can be entered in multiple lines by pressing Enter Key.

When Numeral Display or String Display is selected as Label Type (For the NT21 and NT31/631-V2 Models only)

**Indirect Reference:**

If a numeral in the specified memory table entry is treated as the reference table entry number for indirect reference, specify this item.

**Table Entry:**

Specify the address of the numeral or string memory table entry to be referred to. If [indirect Reference] is not selected, the contents of this numeral or string memory table entry are displayed, and if [indirect Reference] is selected, the contents of this numeral memory table entry are treated as the reference table entry number and the contents of the reference memory table entry are displayed.

**Edit:**

Displays the Numeral Display or String Display property page. For description on property settings refer to 6-6 Numeral Display and 6-7 Character String Display.

**Reference:** To check lamp ON status on the editing screen, select [Simulate ON/OFF] from the [View] menu. Additionally, to view flashing display of lamp attribute, select [Simulate Flash] from the [View] menu. For details, refer to 5-1-3 Changing the Display Method on the Support Tool.

**Guidance**

- The following kinds of standard lamps are provided.

  ![Rectangle](Rectangle.png) ![Circle](Circle.png) ![Polygon](Polygon.png) ![Sector](Sector.png)
The shape of a lamp can be modified when you select polygon or sector.

Use the element edit function to modify the lamp shape. (For details, refer to page 112.)

1. Click on a line of a polygon or a sector while pressing the Shift key and Ctrl key.

2. Drag a green ■ mark to modify the graphic.

3. To add a green ■ mark (addition of a vertex), position the mouse cursor on the line in a graphic and execute the vertex addition operation (right click the mouse → [Add Node]).

   To delete a green ■ mark (deletion of a node), position the mouse cursor on the green ■ mark to be deleted and execute the vertex deletion operation (right click the mouse → [Remove Node]).

4. Drag the added green ■ mark to modify the shape of the graphic.

Example: Modification of the shape of polygon

- A standard lamp element can display a label (lamp name).

To display a label, set a check mark in the check box of the [Label] attribute and click on [Edit ...]. The dialog box for setting a label is displayed. Set the property for the label to be displayed.

For the procedure for setting the properties, refer to 6-2-7 Text. For the NT21, NT31, NT31C, NT631, and NT631C, it is possible to set different colors for lamp ON and lamp OFF by setting [Color – OFF] and [Color – ON] instead of setting label color. However, background color is fixed to transparent for the NT21, NT31, NT31C, NT631 and NT631C.

Use the button in the property dialog to copy the I/O comment set to the lamp bit as a label.

- To edit the position of a label, use the element edit function. (For details, refer to page 112.)

   (1) Click on the label while pressing the Shift key and Ctrl key.
(2) Drag the label to change the display position.

- When displaying a string as a label, mark data and image data can be inserted into a string by clicking the Insert Mark Button or the Insert Image Button. On the NT21 and NT31/631 without NT20/30/620-compatible mode, image data cannot be used in a string.

Reference: With a standard lamp, only the lamp color and the label color change. To change the contents of a label, create image/library lamps and display different image/library data according to the status of the lamp.

Example:

ON

OFF

(1) The image data or the library data is switched to be displayed according to the status of the allocated PC (PLC) bit.

6-5-2 Image/library Lamps

Different image/library data are displayed according to the status of a PC (PLC) bit.

Operation procedure

Selection using the menu bar: [Objects] → [Lamp] → [Image]
Selection using the drawing toolbar:  

Terminology

Property setting

General

OFF State
Code: Specify whether or not image/library data is displayed in the lamp OFF state and the code of the image/library data to be displayed.

ON State
Code: Specify whether or not image/library data is displayed in the lamp ON state and the code of the image/library data to be displayed.

Change Image: Specify the image data to be displayed when the lamp is ON/OFF.

Change Library: Specify the library data to be displayed when the lamp is ON/OFF.

Color (Only for NT31C and NT631C. Setting is not possible for other color types of PT.)

Foreground: Set the display color of an image element. (Specification of color is valid only when the color mode is 2 colors. Setting is not possible for a monochrome type PT.)

Background: Set the display color of the background in the image element display area. (Specification of color is valid only when the color mode is 2 colors. Setting is not possible for a monochrome type PT.)

Light Functions

Address
PC (PLC) Bit Address: Specify the bit at the PC (PLC) that drives an image/library lamp ON/OFF.

I/O Comment: Specify the comment of the PC (PLC) bit that drives an image/library lamp ON/OFF.

Edit ... : Displays the dialog box used to specify the bit number.

... : Displays an I/O comment table entry.

Reference: To check lamp ON status on the editing screen, select [Simulate ON/OFF] from the [View] menu. For details, refer to 5-1-3 Changing the Display Method on the Support Tool.
Guidance

- For image/library lamp element, the image/library data that is displayed when the PC (PLC) bit is ON and the image/library data that is displayed when the PC (PLC) bit is OFF are specified independently.

To display the image data or the library data only when the PC (PLC) bit is ON or OFF, cancel the check mark in the check box of the bit status for which the image/library data is not to be displayed.

- To select the image/library data to be displayed, click on *Change Image* / *Change Library* and select the desired image/library data from the list.

Click on the line of the desired data to display the line in reverse video and click the *OK* Button.

Clicking the *Goto Code* Button enables the direct display of the specified code.

- If the data is not registered to the specified code, the mark shown below is displayed on the screen.

- For the procedure for creating the image data, refer to 8-1 Image Editor.
- For the procedure for creating the library data, refer to 8-2 Library Editor.
6-6 Numeral Display

The contents of a numeral memory table entry are displayed.

Numeral displays can be used with all models.

![Diagram of Numeral Display]

(1) The contents of the specified numeral memory table entry are displayed.

**Operation procedure**

Selection using the menu bar: [Objects] → [Numeral Display]

Selection using the drawing toolbar: 

**Terminology**

**Display digits of maximum limit**

- **Foreground**
- **Background**

- **Sign digit**
- **Integer**
- **Decimal**

**Property setting**

**General**

- **Position:** Indicates the display position of the numeral display field.
  (The reference point is at the upper left corner of the display field.)
- **Font Type:** Specify the font of the numeric value to be displayed.
  Standard, Half Height, Double Width
  (Only Standard can be set for NT11S/NT11.)
- **Scale:** Specify the scale of the numeric value to be displayed.
  $1 \times 1$ (Equal), $1 \times 2$ (High), $2 \times 1$ (Wide), $2 \times 2$, $3 \times 3$, $4 \times 4$, $8 \times 8$
  (Only $1 \times 1$ (Equal) and $2 \times 1$ (Wide) can be set for NT11S/NT11.)
- **Smoothing:** Specify whether or not smoothing processing is executed for numeric values to be displayed.
  (Setting is not possible for NT11S/NT11, NT20, NT20S and NT600S.)
- **Attribute:** Specify the display attribute (attributes displayed depend on the PT model.)
  Standard, Inverse, Flash, Inverse Flash
Color

Foreground: Specify the numeral color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

When this property page is called from Label of Standard Lamp or Touch Switch when Label Type is Numeral Display, Foreground ON/OFF color can be specified.

ON: Specify the display color of a standard lamp when the PC (PLC) bit is ON.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

OFF: Specify the display color of a standard lamp when the PC (PLC) bit is OFF.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan, yellow

Background: Specify the color of the background in the numeral display area. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Settings

Reference:

Indirect Reference:
If a numeral in the specified memory table entry is treated as the reference table entry number for indirect reference, specify this item. (Setting is not possible for NT11S/NT11.)

Table Entry:
Specify the address of the numeral memory table entry to be referred to. If [Indirect Reference] is not selected, the contents of this numeral memory table entry are displayed, and if [Indirect Reference] is selected, the contents of this numeral memory table entry are treated as the reference table entry number and the contents of the reference memory table entry are displayed.

Display Type (Only Decimal can be set for NT11S/NT11.)
Decimal: Specify this item to display the input numeric value in decimal.
Hexadecimal: Specify this item to display the input numeric value in hexadecimal.

Format

Integer: Specify the number of digits of the integer part of the input data.
Decimal: Specify the number of digits of the decimal fraction part of the input data.

Zero Suppression: Specify whether or not leading zeros are suppressed to display the input data.

Display Sign: Specify if a sign is displayed for a negative value.

Guidance

- With a numeral display element, the memory table designation method can be selected as direct designation or indirect designation.
Example: Specifying numeral memory table address 2.

**Direct designation**

<table>
<thead>
<tr>
<th>Numeral memory table</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

**Indirect designation**

<table>
<thead>
<tr>
<th>Numeral memory table</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>123</td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

The contents of the specified memory table entry are displayed.

The contents of the specified memory table entry are treated as the table address reference value and the contents of the referenced memory table entry are displayed.

Indirect designation is possible only in the following cases. Do not apply for other cases.

- When C200H I/F unit is used.
- When the NT21, NT20, NT30, NT30C, NT31, NT31C, NT620S, NT620C, NT625C, NT631, or NT631C is used.
- When an NT20S or NT600S that uses the direct connection ver. 5 is used.

With conventional models, up to 50 indirect designation settings can be made per screen, including both numeral display and character string display.

- For numeral display elements, it is possible to select whether numeric values are displayed in decimal (signed/unsigned) or hexadecimal.

**Reference:**

With the NT21, NT31, NT31C, NT631, and NT631C, numerals are always stored as signed binary data. When allocating numeral memory table entries to PC (PLC) words, it is possible to select whether the data is recognized in BCD or recognized in hexadecimal using the [Storage Type] property.

According to the combination of the storage type and display method, numeric values are stored and displayed in the manner shown below.

**PC (PLC) words** (2-word allocation)

<table>
<thead>
<tr>
<th>Recognition in BCD</th>
<th>Numeral memory table</th>
<th>Display in decimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 4 5 6</td>
<td>00005BA0</td>
<td>23456</td>
</tr>
<tr>
<td>0 0 0 2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Recognition in hexadecimal</th>
<th>Numeral memory table</th>
<th>Display in hexadecimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 BA 0</td>
<td></td>
<td>5 BA 0</td>
</tr>
<tr>
<td>0 0 0 0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

With NT30, NT30C, NT620S, NT620C, and NT625C, the only difference in decimal/hexadecimal display of a numeric value is whether or not F at the most
significant digit is treated as a sign or a numeral. With the NT21, NT31, NT31C, NT631, and NT631C, however, the stored numeric value is converted for display according to the decimal/hexadecimal designation.

- For [Decimal], the number of digits entered in decimal fraction part is specified. Since integers are stored in the numeral memory table entry, a decimal point is appended according to this setting when a numeral is displayed.

- If [Display Sign] is selected, a blank (" ") is displayed for a positive value and "–" is displayed for a negative value. If a negative value is displayed with [Display Sign] deselected, it is displayed as an absolute value.

- For [Format] (number of numeral digits; integer part + decimal fraction part), set a sufficient value according to the contents of the numeral memory table entry.

The allowable display range for numeric values is shown below.

<table>
<thead>
<tr>
<th>Display Method</th>
<th>NT20, NT11S/NT11, NT20S, NT600S, NT30, NT30C, NT620S, NT620C, NT625C</th>
<th>NT21, NT31, NT31C, NT631, NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hexadecimal</td>
<td>000000000 to FFFFFFFFH</td>
<td>00000000 to 7FFFFFFFH</td>
</tr>
<tr>
<td>Decimal (signed)</td>
<td>–99999999 to 9999999</td>
<td>–2147483648 to 2147483647</td>
</tr>
<tr>
<td>Decimal (unsigned)</td>
<td>0 to 99999999</td>
<td>0 to 2147483647*1</td>
</tr>
</tbody>
</table>

*1: Since a negative value is also displayed as a positive value when [Display Sign] is deselected, –2147483648 is displayed as 2147483648, even though the maximum value that can be stored in the numeral memory table is 2147483647.
6-7 Character String Display

The contents of a character string memory table entry are displayed.
Character string displays can be used with all models.

(1) The character string stored in the specified character string memory table entry (string table) is displayed.

Operation procedure
Selection using the menu bar: [Objects] → [the String Display]
Selection using the drawing toolbar: 

Terminology

Property setting

General
Position: Indicates the display position of the (character) string display field.
(The reference point is at the upper left corner of the display field.)
Font Type: Specify the font of characters to be displayed.
Standard, Half Height
(Only Standard can be set for NT11S/NT11.)
Scale: Specify the scale of characters to be displayed.
1 × 1 (Equal), 1 × 2 (High), 2 × 1 (Wide), 2 × 2, 3 × 3, 4 × 4, 8 × 8
(Not possible for NT20, NT20S)
Smoothing: Specify whether or not smoothing processing is executed for characters to be displayed. (Setting is not possible for NT11S/NT11, NT20, NT20S and NT600S.)
Attribute: Specify the display attribute (attributes displayed depend on the PT model.) Standard, Inverse, Flash, Inverse Flash

Color
Foreground: Specify the character color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

When this property page is called from Label of Standard Lamp or Touch Switch
Foreground ON/OFF color can be specified for Label of type String Display.
ON: Specify the display color of a standard lamp when the PC (PLC) bit is ON. (Can only be set for PTs with color display.) White, black, blue, red, magenta, green, cyan, yellow

OFF: Specify the display color of a standard lamp when the PC (PLC) bit is OFF. (Can only be set for PTs with color display.) Transparent, white, black, blue, red, magenta, green, cyan, yellow

Background: Specify the color of the background in the (character) string display area. (Can only be set for PTs with color display.) Transparent, white, black, blue, red, magenta, green, cyan, yellow

Settings

Reference

Indirect Reference: If the numeric value in the specified memory table entry is treated as the reference table entry number and used for indirect table reference, specify this item. (Setting is not possible for NT11S/NT11.)

Table Entry: Specify the number of the character string memory table entry (string table) to be referred to. If [Indirect Reference] is not selected, the contents of this character string memory table entry (string table) are displayed. If [Indirect Reference] is selected, the contents of this numeral memory table entry are treated as the reference table entry number and the contents of the referenced character string memory table entry (string table) are displayed.

Length: Specify the number of characters to be displayed.

Guidance

- With a (character) string display element, the memory table designation method can be selected as direct designation or indirect designation.
Example

Specifying memory table address 2

<table>
<thead>
<tr>
<th>Direct designation</th>
<th>Indirect designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character string memory table (String table)</td>
<td>Character string memory table (String table)</td>
</tr>
<tr>
<td>1</td>
<td>Display</td>
</tr>
<tr>
<td>2</td>
<td>TOOL</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

The contents of the specified memory table entry are displayed.

The contents of the specified numeral memory table entry are treated as the table entry address reference value and the contents of the referenced memory table are displayed.

Indirect designation is possible only in the following cases. Do not apply for other cases.

- When C200H I/F unit is used.
- When the NT20, NT21, NT30, NT30C, NT31, NT31C, NT620S, NT620C, NT625C, NT631, or NT631C is used.
- When an NT20S or NT600S that uses direct connection ver. 5 is used.

With conventional models, up to 50 indirect designation settings can be made per screen, including both numeral display and (character) string display.

- If the value set for [Length] (the number of digits to be displayed) is smaller than the number of characters in the specified character string memory table entry (string table), the specified number of characters is displayed from the first character of the (character) string. The remaining characters are not displayed.
- To display mark data or image data, specify the address of the mark data or image data as shown below.

Note that image data cannot be inserted into a (character) string when using the NT11S/NT11, NT20, NT20S, NT21 (20/30/620 mode off), NT31, NT31C, NT600S, NT631, NT631C, NT31/C-V2 (20/30/620 mode off), and NT631/C-V2 (20/30/620 mode off).

Reference: When there are no string to show, string input will be invisible. Therefore, with Support Tool, dotted-line frame is displayed in character foreground color enclosing string input. (This frame will not be displayed on PT.)
This frame can not be set to off. However, the dotted-line frame can be set to ON and OFF when printing screen image (refer to page 427).
6-8 Touch Switches

When a touch switch is pressed, any of the nine functions shown below is executed. In addition to the general functions such as the input notification (notify bit) and the screen switching (standalone) function, a variety of functions can be realized including control codes used in combination with a data input element. (Touch switches cannot be used for NT11S/NT11.)

**CAUTION**

Do not use input functions such as PT touch switches for applications where danger to human life or serious property damage is possible or for emergency switch applications.

**Notify bit touch switch**

(1) When a touch switch is pressed, the specified bit in the PC (PLC) goes ON/OFF. Set switches, reset switches, alternate switches, and momentary switches can be used.

**Screen switching touch switch**

(1) When a touch switch is pressed, the screen is switched to the screen with the specified screen number.

**Character string input function touch switch**

(1) When a touch switch is pressed, the label of the touch switch is stored in the (character) string input field.

**Note** This type of touch switch is always used in combination with a (character) string input element.

**Pop-up window/keyboard function touch switch**

(1) When a touch switch (OPEN) is pressed, the specified window (keyboard screen) is displayed on the screen presently displayed.

(2) When a touch switch (CLOSE) is pressed, the window (keyboard screen) presently displayed closes.
Control code input touch switch (Input key – Control)

(1) When a touch switch is pressed, the input processing of the control code is executed as shown below.

- 0 to 9 numeral keys:
  Data setting at the numeral setting input field

- CLR key:
  Clearing the numeral setting input field

- key:
  Confirmation

- Arrow symbol key:
  Switching among continuous/overlapping screens
  Moving the cursor in the numeral setting input field

Numeric keys can be created using the touch switches assigned these control codes.

Note These touch switches are always used with a numeral/character string input element. (The element to be used differs according to the allocated control codes.)

Copy setting touch switch

(1) When a touch switch is pressed, the data in the memory table entry or a constant is copied to another memory table entry or input field.

<table>
<thead>
<tr>
<th>Copy Source</th>
<th>Copy Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeral memory table</td>
<td>Numeral memory table</td>
</tr>
<tr>
<td>Character string memory table</td>
<td>Character string memory table</td>
</tr>
<tr>
<td>String table</td>
<td>String table</td>
</tr>
<tr>
<td>Constant</td>
<td>Constant</td>
</tr>
<tr>
<td>Input field specified by cursor</td>
<td>Input field specified by cursor</td>
</tr>
</tbody>
</table>

Window move touch switch

(1) When a touch switch (window move touch switch) is pressed, the window can be moved by touch panel operation at PT. When you press the destination (center of the window will come here), window will be moved to that position.

Note Window move touch switch can be created only on window/keyboard screen.

Cursor moving touch switch

(1) When a touch switch (cursor moving touch switch) in an input field is pressed, the cursor moves to that input field.

Note The cursor moving touch switch should be specified when creating a numeral or (character) string input element. (The cursor moving touch switch can be added later.)
Print screen function touch switch

(1) When a touch switch is pressed, a hard copy of the screen is output to a printer.

Operation procedure

Selection using the menu bar: [Objects] → [Touch Switch]

Selection using the drawing toolbar: 

Terminology

Property setting

General

Position: Indicates the display position of a touch switch frame (the area that senses pressing of the switch.)
(The reference point is at the upper left corner of the touch switch frame)

Size: Indicates the size of a touch switch frame.

Frame: Specify whether or not a frame is displayed for a touch switch.

Shape: Specify the shape of a touch switch.
Standard, Shadow, 3-Dimension, Rectangle, Circle, Polygon, Sector

Show ON State: Specify the status when touch switch is pressed. When this check box is ticked, touch switch will be lighten. (Not valid for 3-Dimension)

Color

Frame: Specify the color of a touch switch if [Frame] is selected.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

ON: Specify the display color of a touch switch which is ON.
(Can only be set for PTs with color display.)
(Setting is valid only when [Show ON state] is selected.)
White, black, blue, red, magenta, green, cyan, yellow

OFF: Specify the display color of a touch switch that is OFF.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan, yellow
Settings

Function: Specify the touch switch function. Select from the following nine functions.

- Notify bit
- Switch screen
- Input key – Control
- Input key – Window/Keyboard
- Input key – String
- Copy setting
- Cursor move
- Window move (Only available on Window/Keyboard Screen)
- Print screen

The setting contents differ depending on the selected touch switch function. For details of setting, refer to Guidance.

Light Function

Touch switch also has the light function like a lamp.

Address

- PC (PLC) Bit Address: Specify the bit at the PC (PLC) that drives a touch switch ON/OFF.
- I/O Comment: Specify the comment of the PC (PLC) bit that drives a touch switch ON/OFF.

Lamp Attributes

- ON Type: Specify the status of a touch switch that is ON. Light, Flash

Reference: To check lamp ON status on the editing screen, select [Simulate ON/OFF] from the [View] menu. Additionally, to view flashing display of lamp attribute, select [Simulate Flash] from the [View] menu. For details, refer to 5-1-3 Changing the Display Method on the Support Tool.

Label

Label: Specify whether or not a label is appended to a touch switch.

Label Type: Specify the type of the Label when [Label] is selected. Following selections will be available for the NT21 and NT31/631-V2 models: Static, Static On Off, Numeral Display and String Display. For the other PT models, this option is disabled and set to Static (default). Refer to Guidance section for details of individual label type description.

To display a label, set a check mark in the check box of the Label attribute in [Label] page and select an option of the available options from the Label Type combo box.
For non-NT21 and NT31/631-V2 models this combo box will have only one choice (‘Static’) and this will remain disabled.

**Static**: For this option the On label and the Off label will be the same.

**On Off Static**: For this option On/Off labels may be different.

**Numeral Display**: Displays the numeral value by referencing the specified table entry. Indirect reference is also possible.

**String Display**: Displays the character string by referencing the specified table entry. Indirect reference is also possible.

To display the settings for a label, click the **Edit** button. The dialog box for setting a label is displayed.

Use the **Copy I/O Comments** button in the property dialog to copy the I/O comment set to the PLC address as a label.

In case of Notify Bit function: I/O comment of notify bit

In case of other function: I/O comment of lamp bit

The property setting dialog for both Static and On Off Static labels is shown below.

For Static, the label can be set by changing description of **Off Label** group box of [Standard Lamp< Label >] dialog box. **On Label** group box will be disabled.

For On Off Static, the Off Label and the On Label can be set by changing description of corresponding text boxes.

**Off Description**: Specify the text of the label that will be displayed when lamp bit is OFF.
On Description: Specify the text of the label that will be displayed when lamp bit is ON.

Line Spacing Determines the space between two lines in both the Off Description and the On Description.

Insert New Line Inserts a new line character in the description to bring the following characters to the next line. On the Label Description edit box, the new line character will be shown as ‘<\n>’.

Set Lines Displays the On/Off Description Settings dialog box. This dialog is for entering Off Description and On Description with multiple lines.

In all NT31/631 V2 models, Labels can be entered in multiple lines. The following table shows the specification for each PT model.

<table>
<thead>
<tr>
<th></th>
<th>Maximum number of characters</th>
<th>Maximum number of characters per line</th>
<th>Number of lines permitted</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT21</td>
<td>128</td>
<td>32</td>
<td>1 to 8</td>
<td>Maximum number of characters per line include the “\n” character.</td>
</tr>
<tr>
<td>NT31/31C</td>
<td>128</td>
<td>40</td>
<td>1 to 15</td>
<td>Maximum number of characters per line include the “\n” character.</td>
</tr>
<tr>
<td>NT631/631C</td>
<td>256</td>
<td>80</td>
<td>1 to 30</td>
<td>Maximum number of characters per line include the “\n” character.</td>
</tr>
</tbody>
</table>

Set Lines button will display On/Off Description Settings dialog box, in which the On/Off description can be entered in multiple lines by pressing Enter Key.

When Numeral Display or String Display is selected as Label Type (For NT31/631-V2 Models only)

Indirect Reference:

If a numeral in the specified memory table entry is treated as the reference table entry number for indirect reference, specify this item.

Table Entry:

Specify the address of the numeral or string memory table entry to be referred to. If [Indirect Reference] is not selected, the contents of this numeral or string memory table entry are displayed, and if [Indirect Reference] is selected, the contents of this numeral memory table entry are treated as the reference table entry number and the contents of the reference memory table entry are displayed.

Edit:

Displays the Numeral Display or String Display property page. For description on property settings refer to Section 6-6 Numeral Display and 6-7 String Display.
Guidance

Common description

- The following shapes can be used for touch switch elements. (Selectable shapes vary according to the PT model.)

Although [Standard] and [Rectangle] have the same shape, how the touch switch frame is defined differs between them. With [Standard], the touch switch frame itself provides the display graphic. With [Rectangle], however, a rectangle shape can be specified independently of the touch switch frame and the touch switch frame can be separated from the rectangle shape.

- If rectangle, circle, polygon, or sector is selected, only the shape of a graphic can be modified in the procedure shown below. The touch switch frame (touch sensing area) remains unchanged even if the shape is modified.

Use the element edit function to modify the touch switch shape. (For details, refer to page 112.)

1. Click on a line of a graphic while pressing the Shift key and Ctrl key.
2. Drag a green mark to modify the graphic.
3. To add a green mark (addition of a node) in a polygon, position the mouse cursor on the line in a graphic and execute a vertex addition operation (right click the mouse → [Add Node]).

   To delete a green mark (deletion of a node), position the mouse cursor on the green mark to be deleted and execute a vertex deletion operation (right click the mouse → [Remove Node]).

4. Drag the added green mark to modify the shape of the graphic.

Example: Modification of the shape of polygon

- A touch switch element can display a label (touch switch name).
To display a label, set a check mark in the check box of the [Label] property and click on [Edit ...]. The dialog box for setting a label is displayed. Set the property for the label to be displayed.

![Label dialog box](image)

For the procedure for setting the properties, refer to 6-2-7 Text. When using the NT21, NT31, NT31C, NT631, and NT631C, it is possible to set different colors for the lamp ON and lamp OFF states. With these models, however, it is not permissible to insert image data.

The [Copy I/O Comments] button in the property dialog can copy the I/O comment set to the PLC address as a label.

- In case of Notify Bit function: I/O comment of notify bit
- In case of other function: I/O comment of lamp bit
- To edit the position of a label, use the element edit function. (For details, refer to page 112.)

1. Click on the label while pressing the Shift key and Ctrl key.
2. Drag the label to change the display position.

(1) (2)

### 6-8-1 Input Notify Touch Switch

**Function:** Notify bit

**Settings**

**Address**

- **PC (PLC) Bit Address:** Specify the PC (PLC) bit that is driven ON/OFF according to the operation of a touch switch.
- **I/O comment:** Specify the comment of the PC (PLC) bit that is driven ON/OFF according to the operation of a touch switch.
Action Type

Set, Reset, Alternative, Momentary

- Displays the dialog box used to specify the bit number.
- Displays the I/O comment table.

Guidance

- The input notify touch switch drives the specified PC (PLC) bit ON/OFF in response to the pressing of the touch switch.
- The status of the PC (PLC) bit when the touch switch is pressed is processed as shown below according to the setting for [Action Type].

Set: Drives the PC (PLC) bit ON when the touch switch is pressed. The PC (PLC) bit stays ON even after the touch switch is released.

Reset: Drives the PC (PLC) bit OFF when the touch switch is pressed. The PC (PLC) bit stays OFF even after the touch switch is released.

Alternative: Drives the PC (PLC) bit from OFF to ON or from ON to OFF when the touch switch is pressed. The PC (PLC) bit is turned ON when the touch switch is pressed while it is OFF and if the touch switch is pressed when the PC (PLC) bit is ON, the PC (PLC) bit goes OFF.

Momentary: Drives the PC (PLC) bit ON when the touch switch is pressed; the PC (PLC) bit remains ON only while the touch switch is being pressed. The PC (PLC) bit goes OFF when the touch switch is released.

6-8-2 Switch Screen Touch Switch

Function: Switch screen

Settings

- Screen No.: Specify the screen number of the screen to which the display is to change when the touch switch is pressed.

Guidance

The switch screen touch switch changes the displayed screen at a PT to the specified screen.

6-8-3 (Character) String Input Touch Switch

Function: Input key – String

Settings

- Input Key String: Indicates the (character) string that is input into the (character) string input field when the touch switch is pressed. This control is enabled for the PT models NT21 and NT31/631 only.
- Insert Mark: Select the mark data to be pasted into a string.
- Copy from Label: Copies the contents of Touch Switch's label to the Input Key String label. This will be enabled only if the label type of a Touch Switch is Static or On Off Static.

Related elements and setting

(Character) string input element:
[Objects] → [Data Input] → [String] (Refer to 6-4-2 (Character) String Input.)
Guidance

- The (character) string input touch switch is used for inputting a (character) string to a (character) string input field.
- The (character) string to be input is set for a label in the General attributes. It may be a single character or multiple (character) strings.
- Numeric keys can be created on the screen by combining (character) string input touch switches and control code input touch switches.
- For details of (character) string input elements, refer to 6-4-2 (Character) String Input.

Note

(Character) string input touch switches are always used in combination with (character) string input elements.

6-8-4 Pop-up Window/Keyboard Function Touch Switch

Function: Input key-Window/Keyboard

Settings

- Screen No.: Specify the window (keyboard screen) type (Local 1 or Local 2) and screen number of the window (keyboard screen) that is displayed when the touch switch is pressed.
- Window Position: Specify the bottom left co-ordinate of window to be displayed.
- Action Type: Specify how the window/keyboard is displayed when the touch switch is pressed.
  - Open, Close, Toggle
- Replace Local Window:
  - Specify the behavior of windows when another window of the same type (Local 1, Local 2) is already displayed when opening a window.

Guidance

The input key-window/keyboard touch switch is used for displaying the window (keyboard screen) overlapping the presently displayed screen (base screen).

This touch switch function can not be used with NT20, NT20S and NT600S. Settings shown below can be made only with the NT21 and with the NT31, NT31C, NT631, NT631C “-V1” and above.

- Local 2
  - Window Position
  - Replace Local Window

Display methods of window/keyboard varies depending on PT models.

**NT30, NT30C, NT620S, NT620C, NT625C, and NT31,NT31C, NT631, NT631C below “-V1”**

How the window/keyboard is displayed is determined by the setting for [Action Type].

**Action Type**

- Open: Displays the specified window/keyboard. If another window/keyboard is already displayed, it is closed and then the specified window/key-
Touch Switches

board is opened. If the specified window/keyboard is already displayed, no operation is executed.

Close: Closes the presently displayed window/keyboard. No operation is executed if no window/keyboard is displayed.

Toggle: Closes the presently displayed window/keyboard and opens the specified window/keyboard. If the specified window/keyboard is already opened, the window/keyboard closes.

**NT21 and NT31, NT31C, NT631, NT631C “-V1” and above**

How the window is displayed is determined by the settings for [Action Type] and [Replace Local Window].

**Action Type**

Open: Displays the specified window. If another window of the same type (Local 1, Local 2) is already displayed, follows the setting for [Replace Local Window]. If the specified window is already displayed in specified type, no operation is executed.

Close: Closes the presently displayed window with specified type (Local 1, Local 2) and number. No operation is executed if specified window is not displayed in specified type.

Toggle: Closes the window with specified type (Local 1, Local 2) and number if it is presently displayed and opens the specified window if it is not opened. If another window of the same type is already displayed, follows the setting for [Replace Local Window].

**Replace Local Window**

Check mark: If another window of the same type (Local 1, Local 2) is already displayed, no operation is executed.

No check mark: If another window of the same type (Local 1, Local 2) is already displayed, closes the window and then opens the specified window.

**6-8-5 Control Code Input Touch Switches**

**Function:** Input key-Control

**Settings**

Control Key: Specify the key code that is input when the touch switch is pressed. (Select from 39 kinds of codes.)

Some codes cannot be specified depending on the PT model.

**Related elements and setting**

Numeral input element:
[Object] → [Data Input] → [Numerals] (Refer to 6-4-1 Numerical Input.)

(Character) string input element:
[Object] → [Data Input] → [String] (Refer to 6-4-2 (Character) String Input.)
Guidance

- Control code input touch switches control data input processing, cursor movements, etc.
- The contents of control are selected from the codes shown below.

Control code input touch switches are used in combination with numeral input elements, (character) string input elements, continuous screens, alarm list elements, and alarm history elements.

(1) Combination with numeral input elements, (character) string input elements, and continuous screens

If control code input touch switches are arranged with a numeral input element or a (character) string input element on the same screen (including the window (keyboard) and the base screen), these touch switches can be used to input data into the input field.

Numeric keys and other data input devices can be created by combining these items.

- Inputs numeral 0 in a data input field.
- Inputs numeral 1 in a data input field.
- Inputs numeral 2 in a data input field.
- Inputs numeral 3 in a data input field.
- Inputs numeral 4 in a data input field.
- Inputs numeral 5 in a data input field.
- Inputs numeral 6 in a data input field.
- Inputs numeral 7 in a data input field.
- Inputs numeral 8 in a data input field.
- Inputs numeral 9 in a data input field.
- Inputs hexadecimal A in a data input field.
- Inputs hexadecimal B in a data input field.
- Inputs hexadecimal C in a data input field.
- Inputs hexadecimal D in a data input field.
- Inputs hexadecimal E in a data input field.
- Inputs hexadecimal F in a data input field.
- Moves cursor in a data input field one character left.
- Moves cursor in a data input field one character right.
- Deletes numeric value/(character) string in a data input field.
- Cancels inputs in a data input field.
- Backspaces a cursor to delete a character in a data input field.
- Deletes the character at the cursor location in a data input field.
Touch Switches

Section 6-8

- Confirms inputs in a data input field (cursor remains in this field.).
- Confirms inputs in a data input field (cursor moves to the next input field.).
- Toggles plus (+) and minus (–) sign in a data input field.
- Inputs a decimal point in a data input field.
- Moves the input cursor to the data input field at the upper left area.
- Moves the cursor to the data input field immediately above the present data input field.*1
- Moves the cursor to the data input field immediately below the present data input field.*1
- Move the cursor to the left data input field.*1
- Move the cursor to the right data input field.*1
- Moves the cursor to the previous data input field in the order. Changes continuous screens to the previous screen.
- Moves the cursor to the next data input field in the order. Changes continuous screens to the next screen.

*1 When moving the cursor with the cursor keys, the cursor may not move in the expected order if the X,Y coordinates are not aligned in the upper left corners of the input fields.

Reference: With  and  keys, the cursor moves between the data input fields in the order the data input fields were made. However, the order of moving the cursor can be changed with [Set Order] of the [Draw] menu.

(2) Combination with alarm list elements and alarm history elements

This control code can be selected only with NT30, NT30C, NT620S, NT620C, and NT625C. With the NT21, NT31, NT31C, NT631, and NT631C, these touch switches are a part of alarm list/history elements. These touch switches can be created automatically when creating an alarm list/history.

- Scrolls up alarm list/history display page (page scroll).
- Scrolls down alarm list/history display page (page scroll).
- Scrolls up alarm list/history display page (line scroll).
- Scrolls down alarm list/history display page (line scroll).

(3) PT control

- Stops buzzer.
- Displays system menu.

Reference: Any required (character) string can be used as the label of a control code input touch switch. For example, “SET” can be used as the label of a control code touch switch.

Click the  Button in the  Tab attributes to display the label setting dialog box. Input a label in the displayed dialog box.
6-8-6 Copy Setting Touch Switch

Function: Copy setting

Settings

Copy From

Numeral Table: Specifies a numeral table entry for the copy source.

String Table: Specifies a character string memory table entry (string table) for the copy source.

Code: Specifies copying a constant (numeric data).

Data setting field: Specify the memory table entry number when a numeral table entry or a character string memory table entry (string table) is specified. When code is specified, specify a constant here.

Copy To

Numeral Table: Specifies a numeral table entry for the copy destination.

String Table: Specifies a character string memory table entry (string table) for the copy destination.

Cursor Position: If this is specified, the numeral input field or the character string input field, which is the active input objective, is selected for the copy destination.

Data setting field: Specify the memory table entry number when a numeral table entry or a character string memory table entry (string table) is specified. If Cursor Position is selected, this field is invalid.

Displays the list of numeral/character string memory table entries (string table).

Guidance

- A copy setting touch switch is used in the cases shown below.

Copying the data in a memory table entry to another memory table entry

By setting the data in several memory table entries beforehand, the necessary data can be copied to the work area as needed.

Note

Data copying from a memory table entry to a memory table entry is possible only between memory table entries of the same type; from numeral memory table entry to numeral memory table entry, and from character string memory table entry (string table) to character string memory table entry (string table).
Copying a constant to a numeral memory table entry (setting)

By setting a constant in the data setting field of a copy function touch switch beforehand, the necessary data can be copied to a numeral memory table entry as desired.

**Note** Copying a constant to a string table entry is not possible.

**Copying data or a constant in a memory table entry to an input field**

By setting the setting data to a memory table entry or a touch switch beforehand, the data is copied to the input field at the cursor location as desired.

Since the data is copied to the input field, it can be modified after copying.

### 6-8-7 Cursor Moving Touch Switch

**Function:** Moving cursor

**Settings**

- **Use Window/Keyboard Screen:**
  Specify whether or not the window (keyboard screen) is displayed when the cursor is moved.

- **Screen No.**
  Specify the screen type (Local 1/Local 2) and the screen number of the window (keyboard screen) to be displayed when moving a cursor.

- **Window position:**
  Specify the bottom left co-ordinate of window to be displayed.

- **Replace Local Window:**
  Specify the behavior of windows when another window of the same type (Local 1/Local 2) is already displayed when opening a window.

- **Auto Arrange:**
  Specify if a touch switch is to move with, or independently of, an input field when the input fields shifts.

**Related elements and setting**

- **Numeral input element:**
  [Object] → [Data Input] → [Numeral] (Refer to 6-4-1 Numeral Input.)

- **(Character) string input element:**
  [Object] → [Data Input] → [String] (Refer to 6-4-2 (Character) String Input.)
Guidance

- When a cursor moving touch switch is pressed, input is enabled at the specified (or associated) input field.

- Settings shown below can be made only with the NT21 and with the NT31, NT31C, NT631, and NT631C “-V1” and above.

Local 2
Window Position
Replace Local Window

- If a cursor moving touch switch is created automatically at the creation of a numeral/(character) string input element, the touch switch is created overlapping the input field.

- It is possible to specify a window (keyboard) for a cursor moving touch switch. This specification enables display of the specified window (keyboard) by simply pressing the cursor moving touch switch.

Reference: • A cursor moving touch switch can be created automatically when creating a numeral input element or a (character) string input element.

• If [Auto Arrange] is selected, it is not possible to move a touch switch independently. To move a touch switch independently, deselect this attribute.

• If a cursor moving touch switch is created later independently, the touch switch can be associated with a specific input field. Specify the touch switch and select [Draw] (menu bar) \(\rightarrow\) [Associate With]. To disassociate the touch switch from an input field, select [Draw] (menu bar) \(\rightarrow\) [Disassociate].

• Cursor movement among data input fields is also possible using control code input touch switches for which arrow-symbol key codes are set.
6-8-8 Window Moving Touch Switch

Function:  Moving window

Settings

Function setting only.

Guidance

When a window move touch switch on a window is pressed, window can be moved by touch panel operation at PT.

This touch switch function is available only with the NT21 and with the NT31, NT31C, NT631, and NT631C “-V1” and above.

Procedure for moving a window is as follows:

1) Press a window move touch switch on a window to be moved.

2) Press the touch panel at a destination position of a window (center position of window comes) and a window moves to that position.

6-8-9 Print Screen Touch Switch

Function:  Print screen

Settings

Printing of Display Screen

Start:  Specify when starting printing of screen hard copy.

Abort:  Specify when aborting printing.

Guidance

- A print screen touch switch is used to print the image (hard copy) of the presently displayed screen.

- Printing of a hard copy can be aborted by pressing the abort touch switch if it is selected in Settings.

- The print screen function cannot be used with the NT20, NT20S, NT21, and NT600S.

- With conventional models where the same memory area is shared by the print screen function and the input key-window/keyboard function, it is not possible to print a hard copy while a window (keyboard) is displayed.
6-9 Graphs

Graphs can be used to display the contents of a numeral memory table entry. The Support Tool provides four types of graph as indicated below.

Bar Graph:
A present value in a numeral memory table entry is displayed in the form of a bar graph.

Analogue Meter:
A present value in a numeral memory table entry is displayed in the form of quarter, semi-circle, and circle graph.

Broken-line Graph:
Present values of several consecutive numeral memory table entries are displayed in the form of a broken-line graph.

Trend Graph:
Numeral memory table entry contents that change with time are displayed in the form of a trend graph. The graph moves as time passes. The data logging function, which logs the past data, and the background function, which continues logging the data while a trend graph is not displayed, are available.

6-9-1 Bar Graph

A present value in a numeral memory table entry is displayed in the form of a bar graph.

(1) A value in a numeral memory table entry is converted into a percentage value, in the range from 0 to 100% or from –100% to 100%, and displayed in the form of a bar graph.

Operation procedure

Selection using the menu bar: [Objects] → [Graph] → [Bar Graph]

Selection using the drawing toolbar: 📊
**Terminology**

![Graphs Diagram]

**Property setting**

**General**

- **Position:** Indicates the display position of a bar graph. (The reference point is at the upper left corner of the bar graph)
- **Size:** Indicates the size of a bar graph.
- **Frame:** Specify whether or not a frame is displayed for a bar graph.
- **Display Sign:** Specify whether or not a display area for negative values is displayed. (Setting is not possible for NT11S/NT11.)
- **Direction:** Specify the display direction of a bar graph. Right (→), Left (←), Up (↑), Down (↓) (Only Right (→) can be set for NT11S/NT11.)

**Color**

- **Frame:** Specify the color of a bar graph frame if [Frame] is selected. (Can only be set for PTs with color display.) White, black, blue, red, magenta, green, cyan, yellow
- **+Range:** Specify the color of bar graph displayed for a positive value. (Can only be set for PTs with color display.) White, black, blue, red, magenta, green, cyan, yellow
- **–Range:** Specify the color of bar graph displayed for a negative value. (Can only be set for PTs with color display.) Valid only when [Display Sign] is selected. White, black, blue, red, magenta, green, cyan, yellow

**Settings (Only 100% can be set for NT11S/NT11.)**

**Value**

- **Table Entry:** Specify the table entry number of a numeral memory table entry to be displayed.
- **Display %:** Specify whether or not a percentage value is displayed on the screen.
- **100%**
  - **Table Entry:** Specify this item if a 100% value is set by a numeral memory table entry; set the table entry number of the numeral memory table.
  - **Value:** Specify this item if a 100% value is set by a constant; set the value to be taken for a 100% value.
0%
Table Entry: Specify this item if a 0% value is set by a numeral memory table entry; set the table entry number of the numeral memory table.
Value: Specify this item if a 0% value is set by a constant; set the value to be taken for a 0% value.

–100%
Table Entry: Specify this item if a –100% value is set by a numeral memory table entry; set the table entry number of the numeral memory table.
Value: Specify this item if a –100% value is set by a constant; set the value to be taken for a –100% value.

Note that specification for –100% is valid only when [Display Sign] is selected.
Setting of 0% and –100% is not possible with NT20S and NT600S.

Guidance

- The following types of bar graph element are provided.

0% to 100% display

-100% to 100% display

- Which of [0 to 100%] and [–100 to 100%] bar graphs is displayed should be selected with the setting for [Display Sign] in the general attributes.
  Check mark set: –100 to 100% display
  Check mark not set: 0 to 100% display

- In the default setting, a percentage value is displayed.
  Whether or not a percentage value is displayed can be set with the [Display %] property.
  Check mark set: A percentage value is displayed.
  Check mark not set: A percentage value is not displayed.

- If the setting is for a percentage value to be displayed, the size and display position of the value can be modified using the element edit function in the manner shown below. (For detail of the element edit function, refer to page 112.)
(1) Click on a percentage value while pressing the Shift key and Ctrl key.

(2) Drag a percentage value to change the display position.

**Example:** Modifying the percentage value display position

![Diagram of percentage value display modification]

(1) (2)

(3) To change the size of a displayed percentage value, double click on the value.

The properties of a percentage value display are displayed.

![Percentage value display properties dialog]

Position: Indicates the display position of the percentage value. (The reference point is at the upper left corner of the percentage value.)

Font Type: Specify the font of the value to be displayed. Standard, Half Height, Double Width (Only Standard can be set for NT11S/NT11.)

Scale: Specify the scale of the value to be displayed. $1 \times 1$ (Equal), $1 \times 2$ (High), $2 \times 1$ (Wide), $2 \times 2$, $3 \times 3$, $4 \times 4$, $8 \times 8$ (Only $1 \times 1$ (Equal) can be set for NT11S/NT11.)

Smoothing: Specify whether or not smoothing processing is executed for the value to be displayed. (Setting is not possible for NT11S/NT11, NT20, NT20S and NT600S.)

Attribute: The display attribute cannot be set (fixed as standard display).

Color

Foreground: Specify the color of the percentage value. (Can only be set for PTs with color display.) White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the percentage value display area. (Can only be set for PTs with color display.) White, black, blue, red, magenta, green, cyan, yellow
- When displaying a specific value (reference value) in a bar graph, the percentage value is calculated based on the values for 100%, 0%, and –100%.

If the 100% value, 0% value, and –100% value are set as indicated below, reference values are displayed in the bar graph as shown below.

If the 100% value, 0% value, and –100% value are set using numeral memory table entries as indicated below, the percentage value of the reference value is calculated according to the value stored at the specified address.

6-9-2 Analogue Meter

A present value in a numeral memory table entry is displayed in the form of quarter, semi-circle, circle graph.

Analogue meter can be used only with the NT21 and with the NT31, NT31C, NT631, and NT631C “-V1” and above.

A value in a numeral memory table entry is converted into a percentage value, in the range from 0 to 100% or from –100% to 100%, and displayed in the form of quarter, semicircle, circle graph. Also, scale display is available.
Operation Procedure

Selection using the menu bar: [Objects] → [Graph] → [Analogue Meter]
Selection using the drawing toolbar:

Terminology

Property settings

**General**
- **Position**: Indicates the display position of an analogue meter. (The reference point is at the upper left corner of the analogue meter. It changes depending on the other settings.)
- **Size**:
- **Center Point**: Indicates the center point of an arc or a circle of the analogue meter. (It is not affected by other settings.)
- **Radius**: Indicates the meter radius of an analogue meter. (It is not affected by other settings.)
- **Frame**: Specify whether or not a frame is displayed for a meter of an analogue meter. When the frame display is ON, select the frame color. (Can only be set for PTs with color display.) White, black, blue, red, magenta, green, cyan, yellow
- **Display Sign**: Specify whether or not a display area for negative value is displayed.
- **Direction**: Specify the positive direction of an analogue meter. Clockwise, Anti-Clockwise

**Meter Shape**
- **Shape**: Specify the shape of an analogue meter. Quarter, Semi-Circle, Circle
- **Direction**: Specify the display direction of an analogue meter. Right (→), Left (←), Up (↑), Down (↓)
- **Type**: Specify the display type of an analogue meter. Needle, Fill
- **Width Rate**: Specify the meter width of an analogue meter in % format regarding the radius as 100%. 10 to 100 (by 1%)
Scale Display

Scale: Specify whether or not a scale is displayed for an analogue meter.

Distance: Specify the scale position in % format regarding the radius as 100%.
0 to 150 (by 1%)

Scale Length: Specify the scale length in % format regarding the radius as 100%.
10 to 110 (by 1%)

No. of Division: Specify the number of the division that the scale should be divided in the range from 0 to 100%.
1 to 20

Scale Color: Specify the scale color of an analogue meter.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Color

Foreground: Specify the color for displaying the present value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the circumscribed rectangle of an analogue meter.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan, yellow

+Range: Specify the color of analogue meter displayed for a positive value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

–Range: Specify the color of analogue meter displayed for a negative value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Settings

Value

Table Entry: Specify the table entry number of a numeral memory table entry to be displayed.

Display %: Specify whether or not a percent value is displayed on the screen.
100%

Table Entry: Specify this item if a 100% value is set by a numeral memory table entry; set the table entry number of the numeral table.

Value: Specify this item if a 100% value is set by a constant; set the value to be taken for a 100% value.

0%

Table Entry: Specify this item is a 0% value is set by a numeral memory table entry; set the table entry number of the numeral table.

Value: Specify this item if a 0% value is set by a constant; set the value to be taken for a 0% value.

–100%

Table Entry: Specify this item if a –100% value is set by a numeral memory table entry; set the table entry number of the numeral table.
Value: Specify this item if a –100% value is set by a constant; set the value to be taken for a –100% value.

Note that specification for –100% is valid only when [Display Sign] is selected.

Guidance:
- Analogue meters are displayed as follows depending on the settings of [Shape], [Direction] and [Display sign].

Assumptions
Direction: Clockwise, Display: 30%

<table>
<thead>
<tr>
<th>Shape</th>
<th>Display sign</th>
<th>Direction: Up (↑)</th>
<th>Direction: Down (↓)</th>
<th>Direction: Left (←)</th>
<th>Direction: Right (→)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quarter</td>
<td>ON</td>
<td><img src="image" alt="Quarter ON" /></td>
<td><img src="image" alt="Quarter Down" /></td>
<td><img src="image" alt="Quarter Left" /></td>
<td><img src="image" alt="Quarter Right" /></td>
</tr>
<tr>
<td></td>
<td>OFF</td>
<td><img src="image" alt="Quarter OFF" /></td>
<td><img src="image" alt="Quarter Down" /></td>
<td><img src="image" alt="Quarter Left" /></td>
<td><img src="image" alt="Quarter Right" /></td>
</tr>
<tr>
<td>Semi-Circle</td>
<td>ON</td>
<td><img src="image" alt="Semi-Circle ON" /></td>
<td><img src="image" alt="Semi-Circle Down" /></td>
<td><img src="image" alt="Semi-Circle Left" /></td>
<td><img src="image" alt="Semi-Circle Right" /></td>
</tr>
<tr>
<td></td>
<td>OFF</td>
<td><img src="image" alt="Semi-Circle OFF" /></td>
<td><img src="image" alt="Semi-Circle Down" /></td>
<td><img src="image" alt="Semi-Circle Left" /></td>
<td><img src="image" alt="Semi-Circle Right" /></td>
</tr>
<tr>
<td>Circle</td>
<td>ON</td>
<td><img src="image" alt="Circle ON" /></td>
<td><img src="image" alt="Circle Down" /></td>
<td><img src="image" alt="Circle Left" /></td>
<td><img src="image" alt="Circle Right" /></td>
</tr>
<tr>
<td></td>
<td>OFF</td>
<td><img src="image" alt="Circle OFF" /></td>
<td><img src="image" alt="Circle Down" /></td>
<td><img src="image" alt="Circle Left" /></td>
<td><img src="image" alt="Circle Right" /></td>
</tr>
</tbody>
</table>

- Which of [0 to 100%] and [-100 to 100%] analogue meters is displayed should be selected with the setting for [Display Sign] in the general attributes.

Check mark set: –100% to 100% display
Check mark not set: 0 to 100% display

- A present value is displayed as follows according to the types.

Needle

Fill
• Meter shape is displayed as follows according to the width rate.

<table>
<thead>
<tr>
<th>Width Rate: 10%</th>
<th>Width Rate: 50%</th>
<th>Width Rate: 100%</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Graph" /></td>
<td><img src="image2.png" alt="Graph" /></td>
<td><img src="image3.png" alt="Graph" /></td>
</tr>
</tbody>
</table>

• Scale position and its shape are displayed as follows depending on the settings of [Distance], [Scale Length].

<table>
<thead>
<tr>
<th>Scale Length</th>
<th>Distance: 0%</th>
<th>Distance: 100%</th>
<th>Distance: 150%</th>
</tr>
</thead>
<tbody>
<tr>
<td>10%</td>
<td><img src="image4.png" alt="Graph" /></td>
<td><img src="image5.png" alt="Graph" /></td>
<td><img src="image6.png" alt="Graph" /></td>
</tr>
<tr>
<td>50%</td>
<td><img src="image7.png" alt="Graph" /></td>
<td><img src="image8.png" alt="Graph" /></td>
<td><img src="image9.png" alt="Graph" /></td>
</tr>
<tr>
<td>100%</td>
<td><img src="image10.png" alt="Graph" /></td>
<td><img src="image11.png" alt="Graph" /></td>
<td><img src="image12.png" alt="Graph" /></td>
</tr>
</tbody>
</table>

Scale is always displayed at the front of meter. Therefore, when type is set to a Needle, the needle may be invisible if meter and scale are overlapped.

• When the Display Sign is set to ON, specified No. of division is applied also for a negative range. Therefore, actual numbers of division differs as follows depending on the presence/absence of display sign even if the specified number of divisions is same.

Example: In case No. of division is 5

**Display Sign: ON**

![Graph](image13.png)

**Display Sign: OFF**

![Graph](image14.png)

• In the default setting, a percentage value is displayed.

Whether or not a percentage value is displayed can be set in the [Display Label] property.

Check mark set: A percentage value is displayed.

Check mark not set: A percentage value is not displayed.

• If the setting for a percentage value is displayed, the size and display position of the value can be modified using the element edit function in the manner shown below. (For detail of the element edit function, refer to page 112.)

1. Click on a percentage value while pressing the Shift key and Ctrl key.
2. Drag a percentage value to change the display position.
E.g. Modifying the percentage value display position.

(1) (2)

(3) To change the size of a displayed percentage value, double click on the value.

The properties of a percentage value display are displayed.

Position: Indicates the display position of the percentage value. (The reference point is at the upper left corner of the percentage value.)

Font Type: Specify the font of the value to be displayed. Standard, Half Height, Double Width

Scale: Specify the scale of the value to be displayed. $1 \times 1$ (Equal), $1 \times 2$ (High), $2 \times 1$ (Wide), $2 \times 2$, $3 \times 3$, $4 \times 4$, $8 \times 8$

Smoothing: Specify whether or not smoothing processing is executed for the value to be displayed.

Attribute: The display attribute can not be set (fixed as standard display).

Color

Foreground: Specify the color of the percentage value. (Can only be set for PTs with color display.) White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the percentage value display area. (Can only be set for PTs with color display.) White, black, blue, red, magenta, green, cyan, yellow

When displaying a specific value (reference value) in an analogue meter, the percentage value are calculated based on the values for $100\%$, $0\%$, $-100\%$
When the following values are specified 100%, 0%, –100% in an analogue meter with semi-circle shape:

If the 100% value, 0% value, and –100% value are set using numeral memory table entries as indicated below, the percentage value of the reference value is calculated according to the value stored at the specified address.
6-9-3 Broken-line Graph

The present values of several consecutive numeral memory table entries are displayed in the form of a broken-line graph.

![Image of a broken-line graph]

<table>
<thead>
<tr>
<th>Numeral memory table</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
</tr>
<tr>
<td>80</td>
</tr>
<tr>
<td>32</td>
</tr>
<tr>
<td>72</td>
</tr>
<tr>
<td>33</td>
</tr>
<tr>
<td>83</td>
</tr>
</tbody>
</table>

(1) The values of consecutive memory table entries are converted into percentage values, in the range from 0 to 100% or from −100% to 100%, and displayed in the form of a broken-line graph.

Operation procedure

Selection using the menu bar: 
[Objects] → [Graph] → [Broken-line Graph]

Selection using the drawing toolbar: X

Terminology

Frame

+Range

−Range

Line

Property setting

**General**

Position: Indicates the display position of a broken-line graph. (The reference point is at the upper left corner of the broken-line graph)

Size: Indicates the size of a broken-line graph.

Frame: Specify whether or not a frame is displayed for a broken-line graph.

Display Sign: Specify whether or not a display area for negative values is displayed.

Direction: Specify the display direction (display direction of numeral memory table entries in ascending order) of a broken-line graph. Right (→), Left (←), Up (↑), Down (↓)
Color
Frame: Specify the color of a broken-line graph frame if [Frame] is selected. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow
+Range: Specify the color of broken-line graph displayed for a positive value. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow
–Range: Specify the color of broken-line graph displayed for a negative value. (Can only be set for PTs with color display.)
Valid only when [Display Sign] is selected.
White, black, blue, red, magenta, green, cyan, yellow

Settings
: Specify this when displaying multiple broken lines. The line properties [Line] are displayed.
: Specify this when deleting broken lines.
: Specify this when modifying broken lines. The line properties [Line] are displayed.

Line
Start Table Entry: Specify the start table entry number of the numeral memory table entries that are displayed in a broken-line graph.
No. of Points: Specify the number of vertices in the broken-line graph.
Interval Type
Even: Specify this when displaying numeral memory table entries at even intervals.
Uneven: Specify this when displaying numeral memory table entries at user-selected intervals.
: Set the broken-line intervals if [Uneven] is selected.

Line
Color: Specify the broken-line color.
(Single only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow
Style: Specify the broken-line style.
Solid, Dash, Dot-dash, Dot-dot-dash

100%
Table Entry: Specify this item if a 100% value is set with a numeral memory table entry: set the table entry number of the numeral memory table.
Value: Specify this item if a 100% value is set with a constant: set the value to be taken as the 100% value.

0%
Table Entry: Specify this item if a 0% value is set with a numeral memory table entry: set the table entry number of the numeral memory table.
Value: Specify this item if a 0% value is set with a constant: set the value to be taken as the 0% value.
-100%

Table Entry: Specify this item if a -100% value is set with a numeral memory table entry: set the table entry number of the numeral memory table.

Value: Specify this item if a -100% value is set with a constant: set the value to be taken as the -100% value.

Note that specification for -100% is valid only when [Display Sign] is selected.

Guidance

- The following types of broken-line graph element are provided.

0% to 100% display

-100% to 100% display

- Which of [0 to 100%] and [-100 to 100%] broken-line graphs is displayed should be selected with the setting for [Display Sign] in the general properties.

Check mark set: -100 to 100% display

Check mark not set: 0 to 100% display

- If you specify a broken-line graph element, only one broken line is displayed. To modify the settings for the broken line, select the broken line to be modified and click on [Line Property]. The line properties are displayed.
To add a broken line, click on [Add Line...]. A broken line is added and the line properties are displayed for the added broken line. A maximum of 256 broken lines can be created.

To delete a broken line, select the broken line to be deleted with the "Settings" and click on [Delete Line]. The specified broken line is deleted.

- The following four types of line are provided for displaying broken-line graphs.

<table>
<thead>
<tr>
<th>Solid</th>
<th>Dash</th>
<th>Dot-dash</th>
<th>Dot-dot-dash</th>
</tr>
</thead>
</table>

Set the line type with the [Style] property.

- The relationships between the points (vertices) in a broken-line graph and numeral memory table contents are shown below.

When display direction is right

![Diagram showing relationships between points and numeral memory table]

- The intervals between numeral memory table entries in a broken-line graph can be set as even or uneven, as desired, with the [Interval Type] line property.

If you select even, the numeral memory table entries are displayed in equal intervals.

![Diagram showing even intervals]

If you select uneven, the intervals between numeral memory table entries can be set as desired.

Click on [Interval Settings], and the interval setting dialog box is displayed.

![Interval Settings dialog box]

Set number of dots
Intervals can be set in the manner shown below.

Note that intervals are set as numbers of dots.

(1) Specify the point for which the interval is to be set. The field of the specified point is displayed in reverse video.

(2) Change the width between points (the number of dots).

(3) Click on .

(4) After setting the interval for all point positions, click on .

- When displaying a broken-line graph, the display points are determined by calculating the percentage value based on the values for 100%, 0%, and –100%.

If the 100% value, 0% value, and –100% value are set as indicated below, reference values are displayed in the broken-line graph as shown below.
If the 100% value, 0% value, and –100% value are set using numeral memory table entries as indicated below, the percentage value of the reference value is calculated according to the value stored at the specified address.

### 6-9-4 Trend Graph

Changes in the contents of a numeral memory table entry with time are displayed in the form of a trend graph.

(1) The value in a numeral memory table entry is converted into percentage values at the set intervals, in the range from 0 to 100% or from –100% to 100%, and displayed in the form of a trend graph.

**Operation procedure**

Selection using the menu bar: [Objects] → [Graph] → [Trend Graph]

Selection using the drawing toolbar: 

**Terminology**

Display and control touch switches

(Only NT31, NT31C, NT631, NT631C)
Property setting

**General**

**Position:** Indicates the display position of the trend graph. (The reference point is at the upper left corner of the trend graph)

**Size:** Indicates the size of the trend graph.

**Display**

**Type:** Specify the trend graph display type. Standard, Pen Reco (pen recording)

**Drawing Width:** Specify the amount of graph shift when the display is updated.

**Frame:** Specify whether or not a frame is displayed for the trend graph.

**Display Sign:** Specify whether or not a display area for negative values is displayed.

**Direction:** Specify the direction of trend graph movement. Right (→), Left (←), Up (↑), Down (↓)

**Sampling Cycle:** Specify the graph updating time interval.

NT30, NT30C, NT620S, NT620C, NT625C: 0.1 second unit
NT21, NT31, NT31C, NT631, NT631C: 0.5 second unit

**Color**

**Frame:** Specify the color of the trend graph frame if [Frame] is selected. (Can only be set for PTs with color display.) White, black, blue, red, magenta, green, cyan, yellow

**+Range:** Specify the color of trend graph displayed for a positive value. (Can only be set for PTs with color display.) White, black, blue, red, magenta, green, cyan, yellow

**–Range:** Specify the color of trend graph displayed for a negative value. (Can only be set for PTs with color display.) Valid only when [Display Sign] is selected. White, black, blue, red, magenta, green, cyan, yellow

**Settings**

Specify this when displaying multiple graphs (lines). The line properties [Line] are displayed.

Specify this when deleting a graph (line).

Specify this when modifying a graph (line). The line properties [Line] are displayed.

**Logging Property (only for NT21, NT31, NT31C, NT631, and NT631C)**

**Data logging:** Specify whether or not the data logging function is used.

**Background:** Specify whether or not the background function is used.
Touch switches for logging

Next Page: Specify whether or not a touch switch used to move the display range in the direction of newer records is used.

Previous Page: Specify whether or not a touch switch used to move the display range in the direction of older records is used.

Log Clear: Specify whether or not a touch switch used to clear all logged data is used.

Touch switches for display function

Restart: Specify whether or not a touch switch used to restart the halted data sampling is used.

Stop: Specify whether or not a touch switch used to halt data sampling is used.

Display Clear: Specify whether or not a touch switch used to clear the graph display is used. Note that the log data is not cleared by this switch.

Line

Value

Table Entry: Specify the table entry number of the numeral memory table entry whose contents are displayed in a trend graph.

Display %: Specify whether or not a percentage value is displayed on the screen.

Line

Color: Specify the graph (line) color. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Style: Specify the line type.
Solid, Dash, Dot-dash, Dot-dot-dash

100%

Table Entry: Specify this item if a 100% value is set with a numeral memory table entry: set the table entry number of the numeral memory table.

Value: Specify this item if a 100% value is set with a constant: set the value to be taken as the 100% value.

0%

Table Entry: Specify this item if a 0% value is set with a numeral memory table entry: set the table entry number of the numeral memory table.

Value: Specify this item if a 0% value is set with a constant: set the value to be taken as the 0% value.

–100%

Table Entry: Specify this item if a –100% value is set with a numeral memory table entry: set the table entry number of the numeral memory table.

Value: Specify this item if a –100% value is set with a constant: set the value to be taken as the –100% value.
Note that specification for –100% is valid only when [Display Sign] is selected.

**Guidance**

- Following types of trend graph element are provided.

**0% to 100% display**

- Direction: Right
- Direction: Up
- Direction: Left
- Direction: Down

**–100% to 100% display**

- Direction: Right
- Direction: Up
- Direction: Left
- Direction: Down

- Which of [0 to 100%] and [–100 to 100%] trend graphs is displayed should be selected with the setting for [Display Sign] in the general attributes.
  
  Check mark set: –100 to 100% display
  
  Check mark not set: 0 to 100% display

- The following two types of trend graph display are provided.

  **Standard:** The latest drawing position moves in the direction set for [Direction].
Pen Reco: The latest drawing position is fixed and the entire graph moves in the direction set for [Direction].

- If you specify a trend graph element, only one broken line is displayed. To modify the settings for the line, select the line to be modified and click on [Line Property]. The line properties are displayed.
  
  - To add a line, click on [Add Line]. A line is added and the line properties are displayed for the added line. A maximum of 50 lines can be created.
  - To delete a line, select the line to be deleted with the “Settings” and click on [Delete Line]. The specified line is deleted.

- The following four types of line are provided for displaying trend graphs.
  
  | Solid | Dash | Dot-dash | Dot-dot-dot-dash |

Set the line type with the [Style] property.

- The intervals between points of a trend graph in the time axis is specified by [Drawing Width]. The width is set as a number of dots.

- The time intervals in which the drawing value of a trend graph is read is specified by [Sampling Cycle]. Set the interval in units of 0.1 seconds for NT30, NT30C, NT620S, NT620C, NT625C and 0.5 seconds for the NT21, NT31, NT31C, NT631, and NT631C.

- The latest drawing value of a trend graph can be displayed as a percentage value.

  In the default setting, a percentage value is displayed. Whether or not a percentage value is displayed can be set with the [Display %] line property.

  Check mark set: A percentage value is displayed.

  Check mark not set: A percentage value is not displayed.

- If the setting is for a percentage value to be displayed, the size and display position of the value can be modified using the element edit function in the manner shown below. (For detail of the element edit function, refer to page 112.)

  1. Click on a percentage value while pressing the Shift key and Ctrl key.
  2. Drag a percentage value to change the display position.

  **Example:** Modifying the percentage value display position.
(3) To change the size of a displayed percentage value, double click on the value.

The properties of the percentage value display are displayed.

![Percentage Value Display Properties](image)

**Position:** Indicates the display position of the percentage value.
(The reference point is at the upper left corner of the percentage value.)

**Font Type:** Specify the font of a value to be displayed.
Standard, Half Height, Double Width

**Scale:** Specify the scale of a value to be displayed.
1 × 1 (Equal), 1 × 2 (High), 2 × 1 (Wide), 2 × 2, 3 × 3, 4 × 4, 8 × 8

**Smoothing:** Specify whether or not smoothing processing is executed for a value to be displayed.

**Attribute:** The display attribute cannot be set (fixed as standard display).

**Color**

**Foreground:** Specify the color of the percentage value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

**Background:** Specify the background color of the percentage value display area.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

**Reference:**
- A percentage value and other elements cannot be overlapped on a trend graph.
- With a trend graph, a percentage value can be displayed for each line. If there are too many lines with percentage values and the correspondence between the values and lines is not clear, use the procedure shown below to check the line that corresponds to the percentage value.

1. Select a trend graph.
2. Select [Edit] (menu bar) – [Edit Object].
   Or press Insert key (P122).

   The trend graph element enters the edit enabled state and the ■ marks surrounding the trend graph change to red.
(3) Select [Edit] (menu bar) – [Select Object]. (Place where graph or % display does not exist.)

The components of a trend graph (trend graph, percentage values) are displayed in a list. The line numbers that correspond to the individual percentage values are displayed.

If you click a line in the list, the corresponding percentage value display is selected in the screen to make the correspondence between the line and the percentage value clear.

Instead of the operation in step (3) above, right-clicking the mouse on the trend graph → [Edit Object] → right-clicking the mouse on the trend graph near by the % display where % display and frame does not exist → [Select Object], the percentage values displayed near the click point are displayed in a list.

- When displaying a trend graph, the display points are determined by calculating the percentage value based on the values for 100%, 0%, and –100%.

If the 100% value, 0% value, and –100% value are set as indicated below, reference values are displayed in the trend graph as shown below.
If the 100% value, 0% value, and –100% value are set using numeral memory table entries as indicated below, the percentage value of the reference value is calculated according to the value stored at the specified address.

<table>
<thead>
<tr>
<th>Numeral memory table</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
</tr>
<tr>
<td>–2000</td>
</tr>
</tbody>
</table>

- The data logging function and background function can be used with the NT21, NT31, NT31C, NT631, and NT631C.

**Data logging function**

The data logging function records the values used for display at a PT.

Usually, the data collected in sampling for display in a trend graph are not recorded internally. If you use the data logging function, the data are logged and can be displayed by tracing them back.

The data logging function can be executed for up to 8 kinds of data.

**Background function**

The background function continues data sampling even when a trend graph is not displayed.

With a trend graph, data sampling is executed only when a trend graph is displayed and stops when the screen is switched from the trend graph screen. However, if the background function is used, data sampling can be continued in the background mode (while the trend graph is not displayed). The data sampled and logged when in background mode can be displayed by tracing back to the past.

The background function is valid only when it is used with the data logging function; when the background function is used, the objective data is continuously recorded. Please note that since data sampling is executed continuously if the background function is used, the processing speed at a PT may be a little slow.

- How the data recording is changed depending on whether or not the data logging function and the background function are used is shown below. Regardless of the use of these functions, the trend graph element always starts drawing a graph from the initial state when the screen is changed to the trend graph display screen.

<Without logging and background functions>
<With data logging function but without background function>

The trend graph is drawn newly when the screen is switched back to the trend graph display screen. However, it is possible to redisplay the past data drawn in the trend graph previously by pressing a touch switch that has the function to display the past data. In this case, however, the data are not logged while a trend graph is not displayed.

<With logging and background functions>

Although the trend graph starts displaying new data when the screen is switched back to the trend graph display screen, it is possible to display the data of the period during which the trend graph was not displayed by pressing a touch switch that has the function to display the past data.

- The trend graph element can control data sampling, display and other related operations using the special touch switches shown below.

These touch switches execute their function only once when they are pressed.

**Stop touch switch**

This touches switch stops data sampling. Updating of a trend graph display is also stopped at the same time.

While sampling is halted, the touch switch is lit.

If data sampling is executed by the background function, data sampling in the background mode is also halted.

When the background function is not used, if the screen is switched back to the trend graph display screen after halting data sampling and calling other screens, the trend graph is redisplayed and logging restarts automatically.

**Restart (Continue) touch switch**

This touches switch restarts halted data sampling. At the same time, updating of the trend graph display restarts.
During data sampling, the touch switch is lit.

**Display Clear (Clear Display) touch switch**

Clears the trend graph display. Even if the display is cleared, the logged data are not cleared.

**Log Clear (Clear Log) touch switch**

Clears all logged data. At the same time, the trend graph being displayed is cleared. This switch clears only the trend graph being displayed. The trend graphs registered on other screens are not cleared. This switch is valid only when the data logging function is used.

**Previous Page (Rewind) touch switch**

Displays the logged past data, older than the time range of the presently displayed graph. This switch is valid only when the data logging function is used.

**Next Page (Forward) touch switch**

Displays logged data that is newer than the time range of the presently displayed graph. This switch is valid only when the data logging function is used.

If the latest data is displayed while the data is being logged, updating of the trend graph display automatically restarts.

Concerning the previous page touch switch and the next page touch switch, the one pressed later is lit.

**Reference:** When the data of trend graph made with NT30, NT30C, NT620S, NT620C, and NT625C were converted to the use for NT31, NT31C, NT631, and NT631C, if touch switches for controlling trend graph is added after that, the Label of the touch switch may not be appeared or some other marks may be appeared. This is because the method of using marks of "FFE5 to FFF5 (hexadecimal) code" differs between NT30, NT30C, NT620S, NT620C, NT625C and NT31, NT631, NT631C. (With NT31, NT31C, NT631, and NT631C, they are used for touch switches for controlling trend graph.)

Resetting the each mark of FFE5 to FFF5 code with mark editor enables the correct display. For details, refer to *Correcting the Screen Data Conversion (Correction related to control touch switch of trend graph)* in Appendix A.
6-10 Registering Created Elements (Symbol Manager Operation)

The created graphic data can be collectively registered as an element by using the Symbol Manager. The graphic data registered collectively in a group is called symbol or symbol data.

By registering data that is often used by the Support Tool, it is possible to use the same data among multiple screen data (Application).

Since the graphic data for creating a keyboard and keypads for each PT model and color/pattern combinations of tiling objects are registered and provided with the Support Tool, you can save time when creating graphics.

6-10-1 Screen Configuration of Symbol Manager

The symbol manager screen configuration is shown below.

A folder represents one symbol data file, and symbols displayed under the folder represent the individual symbol data registered in that file.

The name of the selected folder, or the name of the file that stores the selected symbol is displayed in the title column of the Symbol Manager window.

Starting with V4.6, there is a Preview pane to show an overview picture and a Listing pane to show the object contents.

For newly installed symbol data with V4.6, the preview is immediately available. Old data can be reused into this version but a preview is not applicable. To make
a preview of old data, copy the data to the screen on V4.6 and then copy it back to the symbol manager to register the preview information.

File configuration

The symbol manager is controlled in a data file that is separate from the screen data file.

The symbol data file configuration is shown below.

Reference: For the Support Tool, keyboard data for each PT model, color palette and ISO elements are provided as symbol data.
6-10-2 Basic Symbol Manager Operation

Starting up the symbol manager

(1) [Window] (menu bar) → [Symbol Manager]

Reference:
- The symbol manager window is always displayed at the top of the windows displayed on the screen. If this disturbs your operation, minimize the window by either clicking on the button at the upper right area in the window or selecting the [minimize] item from the control menu box displayed by the clicking on the button at the upper left area in the window.

- The symbol manager memorizes the folder that was open when you quit the symbol manager last time and opens the same folder automatically when you next start the symbol manager. The symbol registration state in the folder is, however, the state when the folder was saved last.

Basic operation

- Menu bar

File

New: Creates a new file (folder).
Open: Displays a file (folder) that is not displayed in the screen.
Close: Closes the file (folder) presently displayed in the screen.
(The file is not deleted although it disappears from the screen.)
Save: Saves the specified folder by overwriting the present file.
Save As: Saves the specified folder by changing the file name.
(Folder name remains unchanged.)
Save All: Saves all folders to the individual files.
Exit: Lets you exit the symbol manager.

Edit

Cut: Moves the specified symbol data to the clip board.
(The data is deleted from the symbol manager.)
Copy: Copies the specified symbol data to the clip board.
(The data remains in the symbol manager.)
Paste: Pastes the symbol data, stored in the clip board by cut or paste, to the active screen.
Delete: Deletes the specified symbol data from the symbol manager.
(The data is not stored in the clip board.)
Choose Icon: Changes the icon design of the symbol data.
Change Label: Changes a folder or symbol name.

View

Status Bar: Specifies whether or not the status bar, which displays menu item functions, etc., is displayed un-
Registering Created Elements (Symbol Manager Operation)

In the menu, if there is a check mark to the left of [Status Bar], the status bar is displayed.

Help: Displays the help information.

Contents:

Search for Help on: Enables you to display help information on the input word.

About Symbol Manager: Displays information such as the version of the symbol manager.

Screen Operation

Double click on the folder or symbol name, and the folder opens to display the list of registered symbol data.

Double clicking on the folder or symbol name while the list of the registered symbol data is displayed causes the folder to close so that only the folder name is displayed.

“+” indicates that symbol data is registered for the folder. “–” is displayed when the folder is open. Clicking on this has the same effect as double clicking on the folder name.

Reference: Folders are displayed in the alphabetical order of the folder names. In a folder, the list of symbol data displays the symbol data in the alphabetical order of the symbol names.

6-10-3 Operating the Symbol Manager

Opening a folder (file)

Open a folder in which symbol data is registered. By opening the symbol collections supplied with the Support Tool or the files saved by the symbol manager (P274), it is possible to display the opened data in the symbol manager and to use the required one for screen creation.

Reference:

• The following symbol data files are supplied with the Support Tool.
  Color Palette Symbol (ColorPL.SBL)
  Keyboard/Keypad Collection (Spplmnt.SBL)
  ISO Symbol Collections (ISO7000 (XXXX-XXXX).SBL) (CD-ROM version only)

• The opened folders (symbol data files) in the symbol manager remain displayed until they are closed. The symbol manager memorizes the folder configuration when you quit the symbol manager last time and displays the same state when you next start the symbol manager. (The symbol registration state in the folder is the state when the folder was saved last.)

• While registering a symbol from a screen or pasting it to a screen, the folder to be used (symbol data file) should be opened. However, if the symbol data file has a Read-only property, the characters “Read Only” are displayed in the symbol manager. In this case, it is not possible to perform symbol registration.
(1) Select [File] in the menu bar, then select [Open].

The dialog to specify the file name is displayed. In the dialog, the folders that contain the symbol data file to be read are displayed. (File type is fixed to a Symbol File (*.SBL))

(2) Specify the desired folder and file name and click on \textbf{Open}.

Opened symbol data file is displayed in the symbol manager.

Ex: Opening ISO Symbol file (ISO7000 (0001-0099).SBL)

\begin{figure}
\centering
\includegraphics[width=\textwidth]{image}
\caption{Opening ISO Symbol file (ISO7000 (0001-0099).SBL)}
\end{figure}

\textbf{Closing a folder (file)}

Close the unnecessary folder (symbol data file) to remove it from the symbol manager.

(1) Select the folder that should be closed in the symbol manager. The folder name is displayed in reverse video.

(2) Select [File] in the menu bar, then select [Close].

If the file has not been saved, the message asking you whether to save it or not is displayed.

(3) If you click the \textbf{Yes} Button, the window to specify the file name is displayed.

Specify the file name and save it. (If you click the \textbf{Cancel} Button in the file name specifying window, the symbol folder closes without being saved. If you click the \textbf{No} Button, the symbol folder closes without being saved. (Registered symbol will be discarded.) For details on saving, refer to \textit{Saving a folder (file)} on page 258.

\textbf{Creating a new folder}

Create a new folder to register the symbol data by the procedure shown below.

By collecting symbols related with each other in the same folder, the screen data creation operation can be facilitated since searching for symbol data is simple.

Select [File] in the menu bar, then select [New].
A new folder is named as “No description.”

- Changing folder name

To change the folder name to one that is easy to understand, follow the operation shown below.

1. Select the folder name that should be changed. The folder name is displayed in reverse video.
2. Select [Edit] in the menu bar, then select [Change Label]. The label name change dialog box is displayed.
3. Set the desired folder name and click the OK Button.

Registering the symbol data

A graphic consisting of several elements is registered as a single element (symbol).

After registering the symbol data, be sure to perform the file save operation.

To register the symbol data, select the elements to be registered collectively and drag them to the symbol manager folder where they are to be registered.

The element in the source screen remains as it is.

For a new symbol, symbol name “New Symbol x” (x is a serial number) is assigned.

Reference: The symbol data can be registered also by the following operation.

1. Select the elements to be registered in the source screen and select [Copy] or [Cut] from the [Edit] menu in the Support Tool.
In this case, symbol name “Pasted Symbol x” (x is a serial number) is assigned for a new symbol.

- Changing the symbol name

To change the symbol name to the one easy to understand, follow the operation shown below.

1. Select the symbol name that should be changed. The symbol name is displayed in reverse video.
2. Select [Edit] in the menu bar, then select [Change Label].
   The label name change dialog box is displayed.
3. Set your desired symbol name and click the OK Button.

- Changing the symbol icon

It is possible to change the icon of the symbol data to a desired one. To change the icon, follow the procedure shown below.

1. Select the symbol for which the icon should be changed. The symbol name is displayed in reverse video.
2. Select [Edit] in the menu bar, then select [Choose Icon].
   The data selection dialog box is displayed.
3. Specify the bit map data that should be used as an icon and click on .

Reference: For an icon, 16×16-dot, 8-color bit map data can be used. Although bit map data larger than 16×16 dots can be used, only the 16×16 dots at the upper left area of such data is used.

Saving a folder (file)

After registering the symbol data, save the registered data to a file by the operation shown below.

Select [File] in the menu bar, then select [Save], [Save As], or [Save All].

If there is a folder that has not been saved, the file name specifying window is displayed regardless of the save method you chose. If this window opens, specify the file name to save the folder. Please note that the file name specifying window does not show the objective folder name, which means that the objective
folder for saving cannot be distinguished if you select [Save All] when there are several unsaved folders. It is advisable to save a folder that has not been saved by assigning a file name beforehand.

Reference: Before executing [Save] or [Save As], click the object folder.

Copying/deleting the registered symbol

Registered symbols can be moved or copied to another folder or deleted.

To move, copy, or delete a registered symbol, select [Edit] in the menu bar, then select the required function ([Cut], [Copy], [Paste], [Delete]).

Move or copy of a symbol is also possible by dragging the symbol using the mouse.

- If a symbol is dragged to another folder, the symbol is moved.
- If a symbol is dragged to another folder while the Ctrl key is held, the symbol is copied.

In these operations, the “+” mark is displayed at the mouse cursor.

6-10-4 Pasting a Symbol to Screen

To paste a registered symbol to the data creation screen of the Support Tool, select the symbol and drag it to the desired position on the data creation screen, then release the mouse.

The symbol is copied to the data creation screen.

The symbol copied to a data creation screen can be used in the same manner as other elements.
Reference: Symbols created by different PT models can be pasted to a data creation screen. In this pasting operation, the symbol data is automatically converted and, if an error occurred in data conversion, an error message is displayed. For details, refer to Appendix A Data Conversion.

- Concerning image/library data, only the code is registered at the symbol manager. Therefore, if the image/library data is pasted to another screen data file, the image/library data of that code in the file to which the data was pasted is displayed.

- If the ISO symbols, supplied by the CD-ROM version Support Tool, are used with NT20, NT20S, or NT600S, those symbols that consist of elements that are not supported may not be displayed correctly.

- Image/library collection, supplied by the CD-ROM version Support Tool, can be used only with models that can use image/library.

Pasting an ISO symbol

To paste an ISO symbol to the data creation screen of the Support Tool, select the symbol and drag it to the desired position on the data creation screen, then release the mouse. (Same operation as the other symbols.)

Reference: It is not possible to change the colors and size of ISO symbols, since the elements are registered in the grouped status.

6-10-5 Operating Procedure of Color Palette Symbol

Color palette symbol

Color palette symbol is a symbol for which tiling objects are registered with their tiling patterns, foreground and background colors respectively combined. You can select required tiling objects while checking the tiling status on screen.

Color palette symbol is separated into tiling patterns and each pattern is set as one symbol as shown below. Combinations of foreground and background colors are registered for each symbol.
Recipe Screen Element

6-11-1 Recipe Screen Element

Recipe screen element provides you with an interface to apply a set of data values from the recipe table to the PLC.

It can only be placed on a standard screen and it can be displayed in the parent screen. The screen element property dialog box has 4 pages – general, touch switch, setting and interlock.

Operation procedure

Selection using the menu bar: [Objects] → [Data Input] → [Recipe]

Selection using the drawing toolbar:

Terminology

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Number</th>
<th>Procedure</th>
<th>Colour</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Object A</td>
<td>100</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Object B</td>
<td>200</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Object C</td>
<td>300</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>

Description of Recipe Screen Element Components

Name

Specifies the recipe name.
Number, ... Color
Displays parameter names.

Object A ... Object C
Displays record names.

100, ... 4
Displays record numeral data.

Write
Transfer data to PLC.

Read
Transfer data from PLC.

Scroll 1 page up.

Scroll 1 page down.

Scroll 1 page left.

Scroll 1 page right.

Scroll 1 line up.

Scroll 1 line down.

Scroll 1 line left.

Scroll 1 line right.

No.
Display recipe number.
**Property setting**

### General

**Recipe Screen Element**

![Recipe Screen Element](image)

**Note**

The text data display in the recipe frame will be such that any character that exceeds the specified column width will not be shown. This affects the following fields: recipe name, record name and parameter name. For example, given a recipe entry named "Long Recipe," the recipe frame will show "Long" when the Record Name Width is set as 4.

The parameter data values display will depend on the "Param Column Width" setting. If it is set as 2 and the parameter data is 200, then # will be displayed for each digit. The value will be displayed as 200 only when the column width is set greater than 2.

The width of each cell in the recipe frame will be set such that the width is a multiple of the touch switch grid size, and just enough to accommodate the cell data display. An example recipe frame will have the frame lines exactly over the touch switch grid. The width of a 2-character-wide cell will be exactly 1 touch switch grid wide.

- **Position:** Displays the position of the top-left corner of the screen element.
- **Size:** Displays the size of the screen element.
- **Show Parameter:** Displays parameter when checked.
- **Show Serial No.:** Displays serial number when checked.
Recipe Screen Element

No. of Parameters: Sets the number of parameters to display on the screen.

Display Line Qty: Sets the number of record rows to display on the screen.

Param Column Width: Sets the width of each parameter column. All columns have the same width. The actual width (in pixels) will be in terms of touch switch grid size.

Record Name Width: Sets the width of the record name column. All columns have the same width. The actual width (in pixels) will be in terms of touch switch grid size.

Scale: Defines the font size for alphanumeric characters.

Smoothing: Defines whether alphanumeric characters have smoothing effect.

Frame Colour: Defines the frame color of the screen element.

Record Name Colour

Foreground: Defines the foreground color of the serial numbers, recipe name and record names part of the screen element.

Background: Defines the background color of the serial numbers, recipe name and record names part of the screen element.

Parameter Comment Colour

Foreground: Defines the foreground color of the recipe name and parameter name part of the screen element.

Background: Defines the background color of the recipe name and parameter name part of the screen element.

Parameter Data Colour

Foreground: Defines the foreground color of the parameter data part of the screen element.

Background: Defines the background color of the parameter data part of the screen element.
Recipe Screen Element

Setting

Recipe Entry: Sets the recipe entry to refer to. The “...” button invokes the recipe table when it is clicked.

Edit Param: Call up the Parameter Setting Table.

Write Notify Address

PLC Address: Inputs the write flag PLC address. If this is a valid address, the write notify bit in the memory map is set.

Set: Sets the write flag PLC address via an address composition dialog.

I/O Comments: Inputs comments for the write flag PLC address. The “...” button will invoke the I/O comment table.

Show Window/Keyboard Screen: Allow the use of window/keyboard screen.

Screen No.

Local 1 or Local 2: Sets the keyboard screen to use with this recipe object. Either Local 1 or Local 2 alone can be enabled.

Screen

Position X & Position Y: Sets the position for the keyboard screen.

Screen Attributes

Replace Local Window: Determine whether to replace the local window.
Recipe Screen Element

Touch Switch

![Recipe Screen Element](image)

**Read/Write Touch Switch**

*Read:* Show Read touch switch.

*Write:* Show Write touch switch.

**Page Scroll Touch Switch**

*Up:* Show Page Scroll Up touch switch (▲).

*Down:* Show Page Scroll Down touch switch (▼).

*Left:* Show Page Scroll Left touch switch (◀).

*Right:* Show Page Scroll Right touch switch (▶).

**Line Scroll Touch Switch**

*Up:* Show Line Scroll Up touch switch (▲).

*Down:* Show Line Scroll Down touch switch (▼).

*Left:* Show Line Scroll Left touch switch (◀).

*Right:* Show Line Scroll Right touch switch (▶).

**Interlock**

Refer to 6-1-12 Interlock.
Memory tables are areas in a PT for storing numeric value data and character string data. These areas are used for communicating with PC (PLC).

7-1 Common Operation .......................................................... 268
  7-1-1 Reference Operation .................................................. 268
  7-1-2 Search Operation ....................................................... 269
  7-1-3 Batch Address Change Operation ................................. 272
  7-1-4 Edit Operation .......................................................... 274
  7-1-5 Copy Increment Setting Operation ............................... 276
  7-1-6 Table Display Operation by Specifying the Table Entry Number .......................... 277
7-2 Numeral Memory Table .................................................... 277
  7-2-1 Operation Procedure ................................................ 278
  7-2-2 Related Elements ..................................................... 278
  7-2-3 Description of Numeral Memory Table Fields ................. 279
7-3 Character String Memory Table (String Table) ....................... 283
  7-3-1 Operation Procedure ................................................ 283
  7-3-2 Related Elements ..................................................... 284
  7-3-3 Description of Character String Memory Table (String Table) Fields .................... 284
  7-3-4 Inserting Mark Data into a Character String .................. 286
  7-3-5 Inserting Image Data into a Character String .................. 287
  7-3-6 Inserting Library Data into a Character String .............. 288
7-4 Bit Memory Table .......................................................... 288
  7-4-1 Operation Procedure ................................................ 289
  7-4-2 Related Elements ..................................................... 289
  7-4-3 Description of Bit Memory Table Fields ....................... 290
7-5 Extended I/O Input Table ................................................ 293
  7-5-1 Operation Procedure ................................................ 294
  7-5-2 Description of Extended I/O Input Table Fields .......... 295
7-6 Extended I/O Output Table ................................................ 297
  7-6-1 Operation Procedure ................................................ 298
  7-6-2 Description of Extended I/O Output Table Fields .......... 298
7-7 I/O Comment Table .......................................................... 298
  7-7-1 Operation Procedure ................................................ 299
  7-7-2 Description of I/O Comment Table Fields .................... 300
  7-7-3 Importing I/O Comments from a Ladder Program .......... 301
  7-7-4 Importing I/O Comment from Tab-delimited Text File ..... 305
7-8 F-Key Input Notify Table .................................................. 307
  7-8-1 Operation Procedure ................................................ 307
  7-8-2 Description of F-Key Input Notify Table ..................... 308
7-9 Mathematical Table .......................................................... 308
  7-9-1 Operation Procedure ................................................ 308
  7-9-2 Supported Objects .................................................... 308
  7-9-3 Supported PLC Addresses ......................................... 309
  7-9-4 Description of Mathematical Table Fields .................... 310
  7-9-5 Description of Set Mathematical Formula Fields .......... 311
  7-9-6 Description of Edit Operand Fields ......................... 312
  7-9-7 Description of Edit Result Fields ............................. 313
  7-9-8 Description of Move To Fields ................................. 313
7-10 Recipe Table .............................................................. 313
  7-10-1 Operation Procedure .............................................. 313
  7-10-2 Description of Recipe Table Fields ......................... 314
  7-10-3 Record Setting Table ................................................ 317
7-1 Common Operation

The operating procedures common to all memory tables are described below.

![Memory Table Interface]

Operation starts by specifying the number, that is, clicking on the objective line (memory table entry number). The shape of the mouse cursor changes as shown below when it enters the No. field.

7-1-1 Reference Operation

The reference screen displays the screen numbers and the table entry numbers in which the specified table entry is used, in the form of a list, and the screen or element that corresponds to the specified table entry is displayed.

**Reference:** Reference operation is valid only when a memory table window is opened with the [Tools] → [Table] operation. If the memory table window is called from the element property dialog box, reference operation is not possible.

**Description of reference dialog box**

![Reference Dialog Box]

**Table Entry**
Displays the selected table entry number.

**Screen/Table**
Displays the screen number or the table entry number where the specified table entry is used.
Whether the displayed number is a screen number or a table entry number can be determined from the displayed number as shown below.
For screen numbers, only a number is displayed.
For table entry numbers, a number is preceded by a code that represents the table type.

The codes representing table types are summarized below.

<table>
<thead>
<tr>
<th>Code</th>
<th>Table type</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>Numeral memory table</td>
</tr>
<tr>
<td>S</td>
<td>Character string memory table (String table)</td>
</tr>
<tr>
<td>B</td>
<td>Bit memory table</td>
</tr>
<tr>
<td>I</td>
<td>Extended I/O input table</td>
</tr>
<tr>
<td>O</td>
<td>Extended I/O output table</td>
</tr>
<tr>
<td>M</td>
<td>Mathematical table*1</td>
</tr>
</tbody>
</table>

*1 Reference operation is slightly different for mathematical table. When a mathematical table entry is created with numeral table entry as either operand or result, a reference is created to the corresponding entry in numeral table. When operand/result is PLC address, a reference is created to the corresponding address entry in I/O comment table.

Comments
Displays screen comments corresponding to a screen number.

No. of References
Displays the number of appearances of the screen or the table entry.

Operation

1. Click on the table entry number of the reference memory table entry.
2. Click on Reference. List of referenced screen/table entry number is displayed.
3. In the reference dialog box, specify the objective screen/table entry number and click on OK.

As an alternative to the operation above, you may double click on the objective element.

The specified screen automatically opens to display the specified element.

7-1-2 Search Operation

You can locate specific data set in a table by using the search operation, and also replace the found data with the desired data.

Search and replacement is possible for the following types of memory table.

Note that search and replacement is always executed toward the end of a table. This means that search and replacement is possible within the range from the present cursor position in the table to the last entry number in the table.

<table>
<thead>
<tr>
<th>Table Type</th>
<th>Objective of Search/Replacement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeral memory table</td>
<td>PC (PLC) address, initial value</td>
</tr>
<tr>
<td>Character string memory table (String table)</td>
<td>PC (PLC) address, contents of initial value</td>
</tr>
<tr>
<td>Bit memory table</td>
<td>PC (PLC) address, image/library code</td>
</tr>
</tbody>
</table>
### Common Operation

#### Table Type Objective of Search/Replacement

<table>
<thead>
<tr>
<th>Table Type</th>
<th>Objective of Search/Replacement</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O comment table</td>
<td>I/O comment</td>
</tr>
<tr>
<td>Extended I/O input table</td>
<td>—</td>
</tr>
<tr>
<td>Extended I/O output table</td>
<td>—</td>
</tr>
</tbody>
</table>

### Description of search dialog box

#### PC (PLC) address

<table>
<thead>
<tr>
<th>Search By: PC Address</th>
<th>Find What: PC Address</th>
<th>Replace With: PC Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Next</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Initial value or contents of initial value

<table>
<thead>
<tr>
<th>Search By: Initial Value</th>
<th>Find What: Initial Value</th>
<th>Replace With: Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Next</td>
<td>Replace All</td>
<td>Replace</td>
</tr>
</tbody>
</table>

#### Image/library code

<table>
<thead>
<tr>
<th>Search By: Image/Library code</th>
<th>Find What: Image/Library code</th>
<th>Replace With: Image/Library code</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Next</td>
<td>Replace All</td>
<td>Replace</td>
</tr>
</tbody>
</table>

#### I/O comment

<table>
<thead>
<tr>
<th>Search By: I/O Comment</th>
<th>Find What: I/O Comment</th>
<th>Replace With: I/O Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Next</td>
<td>Replace All</td>
<td>Replace</td>
</tr>
</tbody>
</table>

### Search By

Specify the objective data for the search or replacement operation.

- **PC (PLC) address:** Data set for addresses of table entries.
- **Initial value (contents):** Data set for the initial values of a numeral memory table entry or character string memory table entry (string table).
- **Image/library code:** Image/library codes set for a bit memory table entry.
- **I/O comment:** I/O comment in I/O comment table.

### Find What

Set the data to be searched for or replaced.

### Replace With

Set the new data to replace the data set for [Find What].

Clicking this button starts search processing.

When the specified data is found, the cursor in the table automatically moves to the found table entry number.

Search for the next appearance by clicking on this button again.

Clicking this button starts replace processing.

The data specified for [Find What] is searched for and replaced with the data set for [Replace With].
When the specified data is found, the cursor in the table automatically moves to
the found table entry number.

Search for the next appearance by clicking on this button again.

[Replace All]

Clicking this button starts replace processing.

The data specified for [Find What] is searched for and replaced with the data set
for [Replace With].

All appearances are replaced with the specified data at one time.

**Operation procedure (search)**

1. Specify the table address (the start position of the search range).
2. Click on [Search].
3. Select the objective of the search in the [Search By] box.
4. Specify the search objective data in the [Find What] box.
5. Click on [Find Next].

**Operation procedure (replace)**

1. Specify the table address (the start position of the replace range).
2. Click on [Search].
3. Select the objective of replace in the [Search By] box.
4. Specify the data to be replaced in the [Find What] box.
5. Specify the data to replace the old data in the [Replace With] box.
7-1-3 Batch Address Change Operation

The set PC (PLC) addresses can be changed into the required addresses in a batch. Since the change source can be specified as a range, processing such as changing the address range DM1000 to DM01499 to the address range DM1800 to DM2299 is possible at one time. Shifting in bit units is also possible.

Note that the batch address change operation is allowed only for displayed table entries.

Independent with the location of the cursor, this address change will be performed to the whole table.

Description of batch address change dialog box

Find – Channel (Word)
Specify the word type of the batch change source.

Find – Start Range
Specify the start address of the source range for the batch address change.

Find – End Range
Specify the end address of the source range for batch address change.

The address to be set for [End Range] must always be larger than or equal to the address set for [Start Range].
Change to – Channel (Word)

Specify the word type and start address after the change.

Addresses are changed within the number of specified points from the start address (number of points from “Start Range” to “End Range”).

Change Comment

Specify whether or not the same I/O comment appended to an address before the change is appended to the address after the change.

To append the same I/O comment, click on the check box to display a check mark in it.

Batch address change processing starts when you click on this button.

How addresses are changed

In the operation for changing addresses in bit units, processing is executed assuming that bit 15 of a word is immediately followed by bit 0 of the next word.

Addresses are changed as shown below according to the set search range and the address after the change.

Example: Bit memory table

![Bit memory table diagram](image)

Before change

<table>
<thead>
<tr>
<th>Address</th>
<th>Before change</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000010</td>
<td>00000100000010</td>
</tr>
<tr>
<td>0000012</td>
<td>00000100000012</td>
</tr>
<tr>
<td>0000100</td>
<td>00000100000010</td>
</tr>
<tr>
<td>0000110</td>
<td>00000100000010</td>
</tr>
<tr>
<td>0000115</td>
<td>00000100000010</td>
</tr>
</tbody>
</table>

After change

<table>
<thead>
<tr>
<th>Address</th>
<th>After change</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000010</td>
<td>H0001000000010</td>
</tr>
<tr>
<td>0000012</td>
<td>H0001000000012</td>
</tr>
<tr>
<td>0000100</td>
<td>H0001000000010</td>
</tr>
<tr>
<td>0000110</td>
<td>H0001000000010</td>
</tr>
<tr>
<td>0000115</td>
<td>H0001000000010</td>
</tr>
</tbody>
</table>

Operation procedure

1. Click on 
2. Select the type of word before the change in the [Channel] box.
3. Specify the range of the change by setting addresses at the [Start Range] and [End Range] boxes.
4. Specify the word and the address after the change in the corresponding boxes in the [Change To] area.
(5) Set a check mark in the Change Comment check box as desired.

If a check mark is set in this check box, I/O comments appended to the addresses before the change are also appended to the addresses after the change.

(6) Click on OK.

7-1-4 Edit Operation

The procedure for clearing, cutting, copying, pasting, and incremental copying of the data set in a memory table is described below.

In the “copy to next” operation, the specified incremental amount is automatically added to the data in the memory table entry at the cursor location and copied to the memory table entry with the next number.

The procedure for specifying the incremental amount to be used for “copy to next” is explained in 7-1-5 Copy Increment Setting Operation.

Reference: • To start editing, click on or right click the mouse on a table entry number to display the menu, then select the desired edit function in this menu. It may not be possible to select an edit function if an input field is displayed. If the selection of an edit function is not possible, left click the mouse on a table entry number field to select the entire line and, after that, click on or right click the mouse on a table entry number to display the menu.

• When the two screen data files of the same PT model are opened using [Import Component] command, it is possible to paste the table data that was cut/copied by one Support Tool to a table of another Support Tool. (For details, refer to 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool).)

Clear

Clears the data in the selected memory table entry.

Cut

Cuts the data in the selected memory table entry and stores it in the clipboard. The cut data can be pasted to another memory table entry.

Copy

Copies the data in the selected memory table entry to the clipboard. The copied data can be pasted to another memory table entry.

Paste

Pastes the data stored in the clipboard by the cut or copy function to the memory table entry at the cursor position.
Copy to Next

Executes the “copy to next” operation.

How this function is executed differs according to the table type as shown below.

<table>
<thead>
<tr>
<th>Table Type</th>
<th>Increment Item</th>
<th>PC (PLC) Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeral memory table</td>
<td>Addition processing</td>
<td>Addition processing</td>
</tr>
<tr>
<td>Character string memory table (String table)</td>
<td>Cannot be specified.</td>
<td>Addition processing</td>
</tr>
<tr>
<td>Bit memory table</td>
<td>Cannot be specified.</td>
<td>Addition processing</td>
</tr>
<tr>
<td>Extended I/O input table</td>
<td>Cannot be specified.</td>
<td></td>
</tr>
<tr>
<td>Extended I/O output table</td>
<td>Cannot be specified.</td>
<td></td>
</tr>
</tbody>
</table>

Operation procedure (Clear)

The clear function clears the data at the specified address of a table.

Since the data is not stored in the clipboard, the data deleted by the clear function cannot be restored by the paste function.

1. Click on the table entry number of the data to be cleared.
2. Click on Edit or right click the table entry number.
3. Select [Clear].

Operation procedure (Cut)

The cut function cuts the data at the specified address of a table and stores it in the clipboard.

The data deleted by the cut function can be used for pasting.

1. Click on the table entry number of the data to be cut.
2. Click on Edit or right click the table entry number.
3. Select [Cut].

Operation procedure (Copy)

The copy function copies the data at the specified address of a table to the clipboard.

The data copied by the copy function can be used for pasting.

1. Click on the table entry number of the data to be copied.
2. Click on Edit or right click the table entry number.
3. Select [Copy].

Operation procedure (Paste)

The paste function pastes the data stored in the clipboard by the cut or copy operation to the specified table entry.

1. Click on the table entry number of the table where the data is to be pasted.
2. Click on Edit or right click the table entry number.
3. Select [Paste].
Common Operation

Section 7-1

Operation procedure (Copy To Next)

The "copy to next" function copies the data at the specified address of a memory table to the next address after adding the specified amount to the existing data.

The procedure for specifying the incremental amount is explained in 7-1-5 Copy Increment Setting Operation.

(1) Click on the table entry number of the copy source table.
(2) Click on or right click the table entry number.
(3) Select [Copy To Next].

7-1-5 Copy Increment Setting Operation

To set the incremental amount used for the "copy to next" operation, follow the steps described below.

Copy Increment Setting dialog box

Value – Increment By
Specify the incremental amount for the initial value data in a numeral memory table entry.
The amount set here is valid only for the numeral memory table.

Value – Input Type
Specify whether the incremental amount is specified in decimal or hexadecimal.
The specified item is identified by the indication of a radio button.
The setting is valid only for the numeral memory table.

Address – Increment By
Specify the incremental amount for table addresses.

Address – Format
Specify whether the incremental amount is specified in decimal or hexadecimal.
The specified item is identified by the indication of a radio button.

Operation procedure

(1) Click on .
(2) Specify the incremental amount to be added to the initial value in the numeral memory table at [Value] – [Increment By].
(3) Specify whether the notation of the incremental amount set above is decimal or hexadecimal at [Value] – [Input Type].
(4) Specify the table address incremental amount at [Address] – [Increment By]
(5) Specify whether the notation of the incremental amount set above is decimal or hexadecimal at [Value] – [Input Type].
7-1-6 Table Display Operation by Specifying the Table Entry Number

- Description of [Go to] dialog box

Entry
Specify the table entry number of the table to be displayed. The cursor moves to the specified table entry number.

Operation procedure

(1) Click on [Go to Entry].
(2) Specify the table entry number of the table to be displayed.
(3) Click on [OK].

7-2 Numeral Memory Table

Numeral Memory Table

The numeral memory table is an area provided in a PT to store numeric value data.

A numeral memory table entry is allocated to one or two words in a PC (PLC) and the numeral memory table entry used for display can be shared with the PC (PLC).
With elements such as numeral display, graph, and numeral input, reading/writing of a numeric value is executed by specifying the numeral memory table entry number.

### 7-2-1 Operation Procedure

A numeral memory table entry is displayed by the operation described below.

- At the property settings for individual elements, click on in the table entry number field.
- Select [Tools] (menu bar) → [Table], then click the [Numeral] tab.

### Setting

For numeral memory table entries, the objective of an operation is specified by clicking on a line. The necessary setting can be made by input using a keyboard or by selection using a drop-down list.

For the operation procedure for , , , , , and , refer to 7-1 Common Operation. (Note that cannot be used if it is displayed by the operation using an element property.)

**Reference:** For PT models other than NT20, NT20S and NT600S, numeral memory table entries No. 247 to No. 255 are used by the clock function and, therefore, cannot be allocated to a PC (PLC).

### 7-2-2 Related Elements

- When reading numeral data from a numeral memory table entry

  ![Diagram of numeral memory table and PC (PLC) connections]

  **Numeral Memory Table**

<table>
<thead>
<tr>
<th>Screen</th>
<th>Numeral Memory Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>PT</td>
<td></td>
</tr>
<tr>
<td>Numeral display element</td>
<td>1234</td>
</tr>
<tr>
<td>Numeral data input element</td>
<td>2345</td>
</tr>
<tr>
<td>Bar graph element</td>
<td>Read</td>
</tr>
<tr>
<td>PC (PLC)</td>
<td>No. of words</td>
</tr>
<tr>
<td>0</td>
<td>Shared</td>
</tr>
<tr>
<td>1</td>
<td>Shared</td>
</tr>
<tr>
<td>2</td>
<td>Shared</td>
</tr>
<tr>
<td>3</td>
<td>Shared</td>
</tr>
<tr>
<td>4</td>
<td>Shared</td>
</tr>
<tr>
<td>5</td>
<td>Shared</td>
</tr>
</tbody>
</table>

  **Operation Procedure**

  - At the property settings for individual elements, click on in the table entry number field.
  - Select [Tools] (menu bar) → [Table], then click the [Numeral] tab.

  **Setting**

  For numeral memory table entries, the objective of an operation is specified by clicking on a line. The necessary setting can be made by input using a keyboard or by selection using a drop-down list.

  For the operation procedure for , , , , , and , refer to 7-1 Common Operation. (Note that cannot be used if it is displayed by the operation using an element property.)

  **Reference:** For PT models other than NT20, NT20S and NT600S, numeral memory table entries No. 247 to No. 255 are used by the clock function and, therefore, cannot be allocated to a PC (PLC).

- When reading numeral data from a numeral memory table entry

  Numeral display element
  [Objects] → [Numeral Display]

  Bar graph element
  [Objects] → [Graph] → [Bar Graph]

  Analogue meter element
  [Objects] → [Graph] → [Analogue Meter]

  Broken-line graph element
  [Objects] → [Graph] → [Broken-line Graph]

  Trend graph element
  [Objects] → [Graph] → [Trend Graph]
7-2-3 Description of Numeral Memory Table Fields

The display format varies slightly depending on the PT model. The example screen shown above is for the NT21, NT31, NT31C, NT631, and NT631C.

**Value**

Specify the initial value to be set when the power is switched ON, the PT is reset, or the mode is changed from the System Menu to RUN.

The range of values that can be input in this field is shown below.

<table>
<thead>
<tr>
<th>PT Model</th>
<th>Input Type</th>
<th>Input Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other than NT21, NT31, NT31C, NT631, and NT631</td>
<td>BCD</td>
<td>F9999999 to 99999999</td>
</tr>
<tr>
<td></td>
<td>Hexadecimal</td>
<td>00000000 to FFFFFFFF*1</td>
</tr>
<tr>
<td>NT21, NT31, NT31C, NT631, and NT631</td>
<td>Decimal</td>
<td>–2147483648 to 2147483647</td>
</tr>
<tr>
<td></td>
<td>Hexadecimal</td>
<td>$00000000 to $FFFFFFFE*2</td>
</tr>
</tbody>
</table>

*1 A minus sign is necessary when a value less than zero is input.

*2 The maximum hexadecimal value that can be input is $7FFFFFFF (2147483647 decimal).
*1: F in the most significant digit position (8th digit) indicates a negative value.
*2: With the NT21, NT31, NT31C, NT631, and NT631C, a hexadecimal number can be input by entering $ at the beginning of a numeric value. The input hexadecimal value is converted to decimal for display.

For PT models other than the NT21, NT31, NT31C, NT631, and NT631C, the input 8-digit hexadecimal value is simply stored as it is; there are no distinctions between BCD and hexadecimal for these models. If the input numeric value is displayed in BCD format, F in the most significant digit position (8th digit) is treated as a negative sign.

With the NT21, NT31, NT31C, NT631, and NT631C, the input numeric value is stored after conversion to signed binary data (2 words).

Setting of an initial value is valid when the resume function is not selected and the [Initial] item is selected for the numeral memory table entry, and in this case the content of the numeral memory table entry is returned to the initial value. If the PT has the memory table initialization function, this function can also be used to return the content of a numeral memory table entry to the initial value.

**Initial**
Specify whether or not the content of the numeral memory table entry is written to the allocated word in the host when the PT is switched on or reset, or the mode is changed from the System Menu to RUN.

The term "initialize" means the processing to initialize the content of a word in the host with the content in a numeral memory table entry. The setting for [Initial] is not valid if the numeral memory table entry is not allocated to a word in the host.

To make the [Initial] item valid, click on the check box to display a cross mark (×) in the box. If the box is clicked on while it is in the valid state, the [Initial] item is made invalid.

**Reference:** The content of numeral memory table entries at the start of PT operation is as shown below according to whether or not a numeral memory table entry is allocated to the host, the [Initial] setting for the numeral memory table entry, and whether or not the resume function is used.

| Allocation to Host | [Initial] setting | Resume Function | Resume Function
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Used</td>
<td>Not Used</td>
</tr>
<tr>
<td>Allocated</td>
<td>Initialized (valid)</td>
<td>Existing numeral memory table value retained (also for the word in the host)</td>
<td>Initial value of the numeral memory table (also for the word in the host)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Initial value of the numeral memory table entry if it is initialized by System Menu operation (also for the word in the host)</td>
<td>Content of word in the host</td>
</tr>
<tr>
<td>Not initialized (invalid)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Not allocated (Invalid)</td>
<td>Existing numeral memory table value retained</td>
<td>Initial value of the numeral memory table entry</td>
<td></td>
</tr>
</tbody>
</table>

**Storage Type (only for the NT21, NT31, NT31C, NT631, and NT631C)**
Specify if a numeral in the PC (PLC) is treated as BCD or binary data when reading/writing the content of a PC (PLC) word to which a numeral memory table
entry is allocated. This setting is valid only for the NT21, NT31, NT31C, NT631, and NT631C. With other PT models, numeric values are always treated as BCD.

**BCD:** The content of an allocated word is regarded as BCD (binary coded decimal).

When the content of an allocated word is read, it is stored as signed binary data. If F is set at the most significant digit position in the allocated word, the content is regarded as a negative value. If an error is found in the content of an allocated word (A to E at the most significant digit position or A to F in other than at the most significant digit position), the read out content is not stored in a numeral table. (The previously stored content remains in the numeral table.)

When data is written to an allocated word, the signed binary data in the numeral memory table entry is converted into BCD before writing. If a negative value is written, F is entered at the most significant digit position. (In this case, the number of storable digits is reduced by one.) If the number of digits in the content of a numeral memory table entry is greater than the number of digits of the allocated word in the PC (PLC), only the numeric value is written from the least significant digit value.

**Binary:** The content of an allocated word is regarded as binary data.

When reading the content of the allocated word, the read content is stored in a numeral memory table entry without change.

When writing a numeric value to the allocated word, the content of the numeral memory table entry is written as it is. If the number of digits in the content of a numeral memory table entry is greater than the number of digits of the allocated word in the PC (PLC), only the numeric value is written from the least significant digit value.

**System:** Conforms to the setting for [Numeral Display Type] of [System] in the PC (PLC) Configuration.

**Words**

Specify the number of words to be allocated to a numeral memory table entry. The possible specifications are 1 and 2.

- If the setting is 1 word, the 4-digit BCD or binary data is shared by the PT and PC (PLC).
- If the setting is 2 words, the 8-digit BCD or binary data is shared by the PT and PC (PLC).

When the setting is 2, the 1st to 4th digit data is allocated to the lower digit word in the PC (PLC) and the 5th to 8th digit data is allocated to the higher digit word.

- PT models other than the NT21, NT31, NT31C, NT631, and NT631C

If the setting has been made to display a sign, one digit (bit 4) in the most significant digit position is regarded as representing a sign; if F (1111 in binary) is set, the numeric value is regarded as negative and if any other code is set, the numeric value is regarded as positive. Therefore, if the numeric value is displayed with a sign, the maximum number of significant digits of a negative value is 3 if 1 word is set and 7 if 2 words is set.

**Example:** When 1 word is set, the value –123 is treated as F123 in hexadecimal in a numeral memory table entry.
Similarly, when 2 words are set, the value –1234567 is treated as F1234567 in hexadecimal in a numeral memory table entry.

- PT models NT21, NT31, NT31C, NT631, and NT631C

Regardless of the number of allocated words, 2 words are always secured for a numeral memory table entry and a numeric value is stored as signed binary data. If the setting for [Storage Type] is decimal, F appearing at the most significant digit position is treated as a negative sign. In this case, therefore, the number of significant digits of a negative value is one digit less than the number of significant digits of a positive value, as with conventional PT models.

**Example:** If the settings are BCD and 1 word, the value –123 is treated as F123 in a PC (PLC) word and FFFFFFF85 in a numeral memory table entry. However, the value F123 in a PC (PLC) word is 0000F123 (61731 in decimal) in a numeral memory table entry if the [Storage Type] is hexadecimal.

Similarly, if the settings are BCD and 2 words, the value –1234567 is treated as F1234567 in a PC (PLC) word and FFED2979 in a numeral memory table entry. However, the value F1234567 in a PC (PLC) word is F1234567 (–249346713 in decimal) in a numeral memory table entry if the [Storage Type] is hexadecimal.

**Example**

<table>
<thead>
<tr>
<th>In PC (PLC) Word</th>
<th>Write To</th>
<th>No. of Words</th>
<th>Storage Type</th>
<th>In Numeral Memory Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>F123</td>
<td>↔</td>
<td>1 word</td>
<td>BCD</td>
<td>FFFFFFF85 (in decimal: –123)</td>
</tr>
<tr>
<td></td>
<td>↔</td>
<td>1 word</td>
<td>Binary</td>
<td>FFFFFF123 (in decimal: –3805)</td>
</tr>
<tr>
<td>F1234567</td>
<td>↔</td>
<td>2 words</td>
<td>BCD</td>
<td>FFED2979 (in decimal: –1234567)</td>
</tr>
<tr>
<td></td>
<td>↔</td>
<td>2 words</td>
<td>Binary</td>
<td>F1234567 (in decimal: –249346713)</td>
</tr>
<tr>
<td>4567</td>
<td>→</td>
<td>1 word</td>
<td>BCD</td>
<td>000011D7 (in decimal: –4567)</td>
</tr>
<tr>
<td></td>
<td>→</td>
<td>1 word</td>
<td>Binary</td>
<td>00004567 (in decimal: –17767)</td>
</tr>
<tr>
<td>F567</td>
<td>←</td>
<td>1 word</td>
<td>BCD</td>
<td>FFED2979 (in decimal: –1234567)</td>
</tr>
<tr>
<td>2979</td>
<td>←</td>
<td>1 word</td>
<td>Binary</td>
<td>FFED2979 (in decimal: –1234567)</td>
</tr>
</tbody>
</table>

**Note**

If only one word is allocated although two words are necessary to express a numeric value, only the lower 4 digits of a numeric value are read or written. A sufficient number of words must be allocated for reading/writing a numeric value.

**PLC Address**

Specify the PC (PLC) address (start address) of the area where numeral memory table entries are allocated.

**I/O Comment**

Specify a comment for a PC (PLC) word.
A comment can comprise up to 16 characters.
Character String Memory Table (String Table)

Ref
Indicates whether the table entry with the specified number is already used or not.

Yes: Already used as an element.
No: Not used.

If the indication is Yes, you can check where the table entry in question is used by clicking on Reference.
(For details of Reference, refer to 7-1-1 Reference Operation.)

7-3 Character String Memory Table (String Table)

The character string memory table (String table) is an area provided in a PT to store character string data.

A character string memory table entry (string table) is allocated to 1 to 20 words in a PC (PLC) and a character string memory table entry (string table) used for display can be shared by the PT and the PC (PLC).

It is possible to insert mark data, image data or library data into a character string. Note that, however, NT11S/NT11, NT20, NT20S and NT600S do not have image data and library data. With the NT21, NT31, NT31C, NT631, and NT631C without NT20/30/620-compatible mode, it is not permissible to insert image data and library data into a character string.

With elements such as character string display and character string input, reading/writing of character string data is executed by specifying the character string memory table entry (string table) number.

7-3-1 Operation Procedure

A character string memory table entry (string table) is displayed by the operation described below.

- At the property settings for individual elements, click on Reference in the table entry number field.
- Select [Tools] (menu bar) → [Table], then click [String] tab.

Setting

For character string memory table entries (string table), the objective of operation is specified by clicking on a line. The necessary setting can be made by input using a keyboard or by selection using a drop-down list.
7-3 Character String Memory Table (String Table)

For the operation procedure for , , , , and , refer to 7-1 Common Operation.
(Note that cannot be used if it is displayed by the operation using an element property.)

7-3-2 Related Elements

- When reading from a character string memory table entry (string table)
  Character string display element [Object] → [String]
  Alarm list [Object] → [Alarm] → [List]
  Alarm history [Object] → [Alarm] → [History]

- When writing to a character string memory table entry (string table)
  Character string input element [Object] → [Data Input] → [String]

- When copying character strings between character string memory table entry entries (string table)
  Touch switch (copy setting) [Object] → [Touch Switch] → [Copy Setting]

7-3-3 Description of Character String Memory Table (String Table) Fields

Value

Specify the initial value to be set when the power is switched ON, the PT is reset, or the mode is changed from the System Menu to RUN.

For an initial value, a character string containing a maximum of 40 characters can be specified. (20 characters for NT11S/NT11, 32 characters for NT20/NT20S)

To display "," input two characters without a blank, like "\".

Setting of an initial value is valid when the resume function is not selected and the [Initial] item is selected for the character string memory table entry (string table), and in this case the content of the character string memory table entry (string table) is returned to the initial value. If the PT has the memory table initialization function, this function can also be used to return the content of a character string memory table entry (string table) to the initial value.
By clicking the [Insert Mark], [Insert Image], or [Insert Library] Button, you can insert mark data, image data, or library data into a character string. (With the NT21 and NT31/631 without NT20/30/620-compatible mode, [Insert Image] and [Insert Library] are not enabled.)

**Initial**

Specify whether or not the contents of the character string memory table entry (string table) are written to the allocated words in the host when the PT is switched on or reset, or the mode is changed from the System Menu to RUN.

The term “initialize” means the processing to initialize the content of words in the host with the content in a character string memory table entry (string table). The setting for [Initial] is not valid if a character string memory table entry (string table) is not allocated to a host word.

To make [Initial] valid, click on the check box to display a cross mark (×) in the box. If the box is clicked on while it is in the valid state, [Initial] is made invalid.

**Reference:** The content of character string memory table entries (string table) at the start of PT operation is as shown below according to whether or not a character string memory table entry (string table) is allocated to the host, the [Initial] setting for the character string memory table entry (string table), and whether or not the resume function is used.

<table>
<thead>
<tr>
<th>Allocation to Host</th>
<th>[Initial] setting</th>
<th>[Initial] setting</th>
<th>[Initial] setting</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Used</td>
<td>Not Used</td>
</tr>
<tr>
<td>Allocated</td>
<td>Initialized (valid)</td>
<td>Existing character string memory table (string table) content retained (also for the word in the host)</td>
<td>Initial value of the character string memory table entry (string table) (also for the word in the host)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Content of the character string memory table entry (string table) if it is initialized by System Menu operation (also for the word in the host)</td>
<td></td>
</tr>
<tr>
<td>Not initialized (invalid)</td>
<td></td>
<td>Content of a word in the host</td>
<td></td>
</tr>
<tr>
<td>Not allocated</td>
<td>(Invalid)</td>
<td>Existing character string memory table (string table) content retained</td>
<td>Initial value of the character string memory table entry (string table)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Content of the character string memory table entry (string table) if it is initialized by System Menu operation</td>
<td></td>
</tr>
</tbody>
</table>

**Words**

Specify the number of words in the PC (PLC) to be allocated to the character string memory table entry (string table).

The number of allocated words varies depending on the PT model as shown below.

<table>
<thead>
<tr>
<th>PT Model</th>
<th>No. of Allocated Words</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT11S/NT11</td>
<td>1 to 10 words (1 to 20 characters)</td>
</tr>
<tr>
<td>NT20, NT20S</td>
<td>1 to 16 words (1 to 32 characters)</td>
</tr>
<tr>
<td>NT30, NT30S, NT21, NT31, NT31C, NT600S, NT620S, NT620C, NT625C, NT631, NT631C</td>
<td>1 to 20 words (1 to 40 characters)</td>
</tr>
</tbody>
</table>
One word corresponds to 2 characters.

A character string is allocated to the PC (PLC) words in units of 2 characters, beginning with the leftmost character, from lower digit words to higher digit words. The data type is 1-byte or 2-byte.

**Note**

If the number of characters in a character string memory table entry (string table) is larger than the number of words used, the number of characters equal to the number of specified words is sent to the PC (PLC) beginning with the start of the character string.

<table>
<thead>
<tr>
<th>Character string memory table (String table)</th>
<th>Words allocated in PC (PLC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABCDEFG</td>
<td>AB</td>
</tr>
<tr>
<td>If setting is 2 words.</td>
<td>CD</td>
</tr>
<tr>
<td>* EFG is not sent.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Character string memory table (String table)</th>
<th>Words allocated in PC (PLC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HIJKLMNOPMN</td>
<td>HI</td>
</tr>
<tr>
<td>If setting is 4 words.</td>
<td>JK</td>
</tr>
<tr>
<td>The character string is sent in units of 2</td>
<td></td>
</tr>
<tr>
<td>characters, beginning with the leftmost</td>
<td></td>
</tr>
<tr>
<td>character in the character string, and</td>
<td></td>
</tr>
<tr>
<td>allocated to words from lower word to</td>
<td></td>
</tr>
<tr>
<td>higher word.</td>
<td></td>
</tr>
<tr>
<td>00 (hexadecimal) is entered in blank areas.</td>
<td></td>
</tr>
</tbody>
</table>
| (For details of , refer to 7-1-1 Reference Operation.)

**PLC Address**

Specify the PC (PLC) address (start address) of the area where character string memory table entries (string table) are allocated.

**I/O Comment**

Specify a comment for a PC (PLC) word. A comment can comprise up to 16 characters.

**Ref**

Displays whether the table entry with the specified number is already used or not.

- Yes: Already used as an element.
- No: Not used.

If the indication is Yes, you can check where the table entry in question is used by clicking on **Reference**. Note that this operation is not possible when setting a character string memory table entry (string table) from the property dialog box of an element.

**7-3-4 Inserting Mark Data into a Character String**

To insert mark data into an initial value, follow the steps described below.

1. After specifying the Value field, move the cursor to the position where the mark data is to be inserted.
2. Click on **Insert Mark**. The Show Mark dialog box is displayed.
3. Specify the mark data in the list of mark data.
4. Click on **OK**.
The code of the specified mark data is inserted to the Value field. The mark itself is not displayed here.

7-3-5 Inserting Image Data into a Character String

To insert image data into an initial value, follow the steps described below.

Note that insertion of image data into a character string is possible only with the NT30, NT30C, NT620S, NT620C, NT625C, NT21 (NT20/30/620-compatible mode), NT31/C-V2 (NT20/30/620-compatible mode) and NT631/C-V2 (NT20/30/620-compatible mode).

1. After specifying the Value field, move the cursor to the position where the image data is to be inserted.
2. Click the [Insert Image] Button.
   The Image Table dialog box is displayed.
3. Specify the image data in the list of image data.
4. Click the [OK] Button.
   The code of the specified image data is inserted into the Value field. The image data itself is not displayed here.

Reference: By clicking the [New] Button, an image code with no data can be added to the list. You can first insert this image to a string and then register the image data afterward. (Use the image editor to create image data.)
7-3-6 Inserting Library Data into a Character String

To insert library data into an initial value, follow the steps described below.

Note that insertion of library data into a character string is possible only with the NT30, NT30C, NT620S, NT620C, NT625C, NT21 (NT20/30/620-compatible mode), NT31/C-V2 (NT20/30/620-compatible mode) and NT631/C-V2 (NT20/30/620-compatible mode).

(1) After specifying the Value field, move the cursor to the position where the library data is to be inserted.

(2) Click the [Insert Library] Button.

The Library Table dialog box is displayed.

(3) Specify the library data in the list of library data.

(4) Click the [OK] Button.

The code of the specified library data is inserted to the Value field. The library data itself is not displayed here.

Reference: By clicking the [New] Button, a library code with no data can be added to the list. You can first insert this library code to a string and then register the library data afterward. (Use the library editor to create library data.)

7-4 Bit Memory Table

A bit memory table is an area that operates like flags to execute preset functions when the specified bits go ON.

A bit memory table entry provides a screen switching function that switches the screen when the specified PC (PLC) bit goes ON and an alarm function that displays the alarm message or logs the event of alarm occurrence if the specified PC (PLC) bit goes ON.

By allocating a bit memory table entry to a PC (PLC) bit, data can be shared between a PC (PLC) and a PT.
Screen switching function

Alarm function

### 7-4-1 Operation Procedure

The bit memory table setting dialog box is displayed by following either of the operations described below.

- At the properties of the alarm list element, click on the table entry number field.
- Select [Tools] (menu bar) → [Table], then click [Bit Memory] tab.

**Setting**

For bit memory table entries, the objective of the operation is specified by clicking on a line. The necessary setting can be made by input using a keyboard or by selection using a drop-down list.

For the operation procedure for **Reference**, **Search**, **Change Address**, **Edit**, **Delete Entry**, refer to 7-1 Common Operation. (Note that **Reference** cannot be used if bit memory table entry is displayed by the operation using an element property.)

### 7-4-2 Related Elements

- **Alarm list element**: [Object] → [Alarm] → [List]
- **Alarm history element**: [Object] → [Alarm] → [History]
7-4-3 Description of Bit Memory Table Fields

As the reference of bit memory table setting, please refer to 6-3 Alarm.

**WARNING**

When converting the bit memory table from NT30, NT30C, NT620S, NT620C, NT625C to NT31, NT31C, NT631, NT631C, the function setting is not the same with before converting. To adjust the setting of this bit memory table, please refer to Data Conversion (Bit memory conversion) in Appendix A.

**Items set to use the screen switching function**

To use the screen switching function, follow the procedure below.

1. Input PLC address directly on a PLC address field on a bit memory table entry or click on to input PLC address on a PLC address dialog. (Refer to Word setting for an element on page 129). Input I/O comment if required.

2. Click on to display function dialog.

3. Select “Switch Screen” from function combo box. Setting items for screen switching function are displayed.

4. Set screen number to be switched for “Screen No..”
   - Settings to make at the Set dialog

**PLC Address**

Specify the bit in a PC (PLC) whose status is reflected by the bit memory table entry.

**I/O Comment**

Specify a comment for a PC (PLC) bit.

A comment can comprise up to 16 characters.

- Settings to make at the Function dialog

**Function**

Select [Alarm/Switch Screen] for NT30, NT30C, NT620S, NT620C, and NT625C, and select [Switch Screen] for the NT21, NT31, NT31C, NT631, and NT631C.
Switch Screen (only for NT30, NT30C, NT620S, NT620C, and NT625C)

To make the screen switching function valid, click on the check box to display a check mark in it. If you click on the check box when it already has a check mark in it, the check mark is cleared and the screen switching function is made invalid.

For the NT21, NT31, NT31C, NT631, and NT631C, whether or not the screen switching function is used is determined by the setting for [Function].

Screen No.

Specify the screen No. of the screen to which the screen switches when the bit memory table entry goes ON.

Items set to use the alarm function

To use the alarm function, follow the procedure below.

1. Input PLC address directly on a PLC address field on a bit memory table entry or click on [ ] and input PLC address on a PLC address dialog. (Refer to Word setting for an element on page 129). Input I/O comment if required.

2. Click on [ ] to display function dialog.

3. Select “Alarm” or “Alarm/Switch Screen” from function combo box. Setting items for Alarm function are displayed.

4. Make the settings for the alarm function. (See below)
   - Settings to make at Set dialog

PLC Address

Specify the bit in a PC (PLC) whose status is reflected by the bit memory table entry.

I/O Comment

- Specify a comment for a PC (PLC) bit.
  A comment can comprise up to 16 characters.
- Settings to make at Function dialog

Function

Select [Alarm/Switch Screen] for NT30, NT30C, NT620S, NT620C, and NT625C, and select [Alarm] for the NT21, NT31, NT31C, NT631, and NT631C.

Switch Screen

The meaning of the [Switch Screen] setting differs between the NT30, NT30C, NT620S, NT620C, and NT625C and the NT21, NT31, NT31C, NT631, and NT631C.

- NT30, NT30C, NT620S, NT620C, and NT625C
  To use the alarm function, the check box must not have a check mark set in it. If it does, the screen switching function is selected.

- NT21, NT31, NT31C, NT631, and NT631C
  To display the specified screen by the operation of an alarm list/history element, set a check mark in the check box. Clear the check mark in the check box in order not to display the specified screen.

Screen No.

The message area displayed in the alarm list/history element is a touch switch and pressing the touch switch that is in the selected state displays the specified screen.
- NT30, NT30C, NT620S, NT620C, and NT625C
  Specify the screen No. of the screen to which the screen should switch by the operation of the alarm list/history. Specify 0 if you do not switch the screen.

- NT21, NT31, NT31C, NT631, and NT631C
  Specify the screen No. of the screen to be displayed if a check mark is set for [Switch Screen]. The setting for this item is not valid unless a check mark is set for [Switch Screen].

**String Table Entry**
Specify the character string memory table entry (string table) number where the character string that is displayed as a message is stored when the bit memory table entry goes ON or the bit memory table entry registered for the alarm history is displayed.

**Image/Library Code**
If you want to display image data or library data when a message is selected, set a check mark in the check box and specify the image/library code after clicking on [Change Image] or [Change Library].

**Color – Foreground**
Specify the color in which the message display field is displayed when a message is selected.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

- Code setting in the image/library code field
  When setting a code in the image/library code field, the desired code can be selected from the list as an alternative to direct input of a specified code using a keyboard.

Setting the image data
To set an image code in the image/library code field by selecting image data from the list, follow the procedure described below.
(1) Specify the image/library code field where the code is set.
(2) Click on [Change Image].
(3) Specify the image data from the list.
(4) Click on [OK].

The code of the specified image data is displayed in the image/library code field.

Setting the library data
To set a library code in the image/library code field by selecting library data from the list, follow the procedure described below.
7-5 Extended I/O Input Table

The extended I/O input table is used to set functions at the input terminals of an extended I/O unit or allocate PC (PLC) bits to be referred to.

Extended I/O units can be used only with NT30 and NT30C.

The following functions can be set at extended I/O unit input terminals.

Screen switching

When the input terminal goes ON, the screen is switched to the set screen. If 0 is set, the display returns to the previous screen.

Notify bit

The extended I/O input table notifies the PC (PLC) of the status (ON/OFF) of the input terminals.
Control code input

When the input terminal goes ON, it has the same effect as pressing of the control key.

Canceling backlight OFF

When the input terminal goes ON, the backlight, which has been turned OFF by the Cancel Backlight Off function set by a memory switch, is turned ON to redisplay the screen. A backlight OFF function releasing attribute is automatically provided for the screen switching function and the control code input function.

**WARNING**

Do not use the input function of a PT extended I/O input for applications that could cause fatal injury and/or serious damage, or as an emergency switch function.

### 7-5-1 Operation Procedure

An extended I/O input table entry is displayed by following the operation described below.

- Select [Tools] (menu bar) → [Table] → [Extended I/O Input] tab → Clicking on table entry No.

**Setting**

Settings for the extended I/O input table fields can be made by using the setting dialog box that is displayed by clicking on .

For the operation procedure for , , and , refer to 7-1 Common Operation.
7-5-2 Description of Extended I/O Input Table Fields

No.: Extended I/O unit input terminal number.

Cncl: Presence/absence of the backlight OFF cancelling attribute.
Make this setting at Set dialog.

Function: Function set for the input terminal.
Notify bit, Switch Screen, Input Key-Control.
Make this setting at Set dialog.

Description: Contents set at “Function” are shown.
Make this setting at Set dialog.

Cancel Backlight Off
Specify whether or not the backlight OFF state is to be canceled.

To set the Cancel Backlight Off function, click on the check box to set a check mark in it.

If you do not want to set the Cancel Backlight Off function, clear the check mark in the check box.

This setting is valid when [None] or [Notify Bit] is set for [Function].
The Cancel Backlight Off function is automatically provided for the screen switching function and the control code input function.

Function
Specify the input terminal function.

• None
• Switch Screen
• Notify Bit
• Input Key – Control

When Switch Screen is specified

Screen No.
Specify the screen No. of the screen to which the screen should be switched when the input terminal goes ON.
When Notify Bit is specified

Notify Bit Address
Specify the PC (PLC) bit where the event of the input terminal going ON is notified.

Comments
Specify a comment for a PC (PLC) bit.
A comment can comprise up to 16 characters.

When Input Key – Control is specified

Control Key
Select the control code to be input when the input terminal goes ON from the list.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Inputs numeral 0 in a data input field.</td>
</tr>
<tr>
<td>1</td>
<td>Inputs numeral 1 in a data input field.</td>
</tr>
<tr>
<td>2</td>
<td>Inputs numeral 2 in a data input field.</td>
</tr>
<tr>
<td>3</td>
<td>Inputs numeral 3 in a data input field.</td>
</tr>
<tr>
<td>4</td>
<td>Inputs numeral 4 in a data input field.</td>
</tr>
<tr>
<td>5</td>
<td>Inputs numeral 5 in a data input field.</td>
</tr>
<tr>
<td>6</td>
<td>Inputs numeral 6 in a data input field.</td>
</tr>
<tr>
<td>7</td>
<td>Inputs numeral 7 in a data input field.</td>
</tr>
<tr>
<td>8</td>
<td>Inputs numeral 8 in a data input field.</td>
</tr>
<tr>
<td>9</td>
<td>Inputs numeral 9 in a data input field.</td>
</tr>
<tr>
<td>A</td>
<td>Inputs hexadecimal A in a data input field.</td>
</tr>
<tr>
<td>B</td>
<td>Inputs hexadecimal B in a data input field.</td>
</tr>
<tr>
<td>C</td>
<td>Inputs hexadecimal C in a data input field.</td>
</tr>
</tbody>
</table>
Extended I/O Output Table

7-6: Inputs hexadecimal D in a data input field.
7-7: Inputs hexadecimal E in a data input field.
7-8: Inputs hexadecimal F in a data input field.
7-9: Deletes numeric value/character string in a data input field.
8-0: Confirms inputs in a data input field (cursor remains in this field.).
8-1: Toggles plus (+) and minus (−) sign in a data input field.
8-2: Inputs a decimal point in a data input field.
8-3: Moves the input cursor to the data input field at the upper left area.
8-4: Moves the cursor to the data input field immediately above the present data input field.
8-5: Moves the cursor to the data input field immediately below the present data input field.
8-6: Move the cursor to the left data input field.
8-7: Move the cursor to the right data input field.
8-8: Moves the cursor to the previous data input field in the order. Changes the continuous screens to the previous screen.
8-9: Moves the cursor to the next data input field in the order. Changes the continuous screens to the next screen.
8-A: Stops Buzzer.
8-B: Displays the System menu.

After setting the items for the selected function (switch screen, notify bit, control code input), click on OK.

The specified contents are displayed in the extended I/O input table entry.

7-6 Extended I/O Output Table

An extended I/O output table controls the output terminal of an extended I/O unit according the ON/OFF status of a PC (PLC) bit.

Extended I/O units can be used only with NT30 and NT30C.
7-6-1 Operation Procedure

An extended I/O output table entry is displayed by following the operation described below.

- Select [Tools] (menu bar) → [Table] → [Extended I/O Output] tab

Setting

With an extended I/O output table entry, the objective of an operation is specified by clicking on the line. Setting is performed by using the setting dialog box that is displayed by clicking on [Set].

For the operation procedure for [Change Address], [Edit], and [Go to Entry], refer to 7-1 Common Operation.

7-6-2 Description of Extended I/O Output Table Fields

No.
Extended I/O unit output terminal number.

PLC Address
Specify the PC (PLC) bit that controls the output terminal of an extended I/O unit.

I/O Comment
Specify a comment for a PC (PLC) bit.
A comment can comprise up to 16 characters.

7-7 I/O Comment Table

The I/O comment table is an area provided in a PT to manage the comment data of all words and bits in a PC (PLC) that are set by the Support Tool.

It displays comments on PC (PLC) words and bits specified by numeral memory table entries, character string memory table entries (string table), bit memory...
table entries, extended I/O input table entries, extended I/O output table entries, and elements, in the form of list. The displayed comments can be edited.

Reference: If “--” is displayed for PLC Bit Address when its “Ref” is Yes, object without PLC address exist. Clicking on Reference enables to know which objects is created without PLC address.

### 7-7-1 Operation Procedure
An I/O comment table entry is displayed by following the operation described below.

- When allocating PC (PLC) address by the setting of lamps and touch switches
  Click on in the I/O comment field of the properties displayed for each element → Specify the edit field → Click on

Example:

- [Tools] (menu bar) → [Table] → [I/O Comments] tab → Specify the edit field →

Reference: When only editing an I/O comment of a PC (PLC) address allocated to an element, call out the I/O comment table entry from the property dialog box of the element.

- To set an I/O comment for multiple PC (PLC) addresses, select the [Tools] menu, then select [Table].

Setting
To edit an address or a comment, display the setting dialog box by clicking on Set or edit directly on a table entry.

For the operation procedure for Reference, Edit, and, refer to 7-1 Common Operation. (Note that Reference cannot be used if it is displayed by the operation using an element property.)
7-7-2 Description of I/O Comment Table Fields

Displaying specified word and bit I/O comment

Edit and adding I/O comment

Displaying I/O comment for specified word and bit

The items displayed on an I/O comment table are shown below.

Address
Displays the PC (PLC) word or bit address that corresponds to the comment.

I/O Comments
Displays the comment for the PC (PLC) word or bit.

Reference
Displays if the word is already used or not.
- Yes: Already used in an element or a table.
- No: Not used.

If the indication is Yes, you can check where the word in question is used by clicking on Reference.
(For details of the Reference button, refer to 7-1-1 Reference Operation.)

For details of the Search button, refer to 7-1-2 Search Operation.

Editing or adding an I/O comment

- Editing (modifying) an I/O comment

To edit (modify) the I/O comment already set, click on the table entry number, then click Edit or edit directly on a table entry.
• Adding an I/O comment

To set (add) an I/O comment, after clicking on the table entry number of the blank field at the bottom, click  .

<table>
<thead>
<tr>
<th>PLC Bit Address</th>
<th>I/O Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000000</td>
<td>Trend Graph2</td>
</tr>
<tr>
<td>00000000</td>
<td>Bar Graph1</td>
</tr>
<tr>
<td>00000000</td>
<td>Bar Graph2</td>
</tr>
<tr>
<td>00000001</td>
<td>Namearea1</td>
</tr>
<tr>
<td>00010000</td>
<td>Namearea2</td>
</tr>
<tr>
<td>00014000</td>
<td>Thumbwheel Swl</td>
</tr>
<tr>
<td>00100000</td>
<td>Thumbwheel Swl</td>
</tr>
</tbody>
</table>

• Setting items in the set dialog box

**Channel (Word)**
Specify the type of area (area name in PC (PLC)) for which a comment is to be displayed.

**Address**
Specify the address number where the I/O comment to be edited is allocated. If you specify a new address or bit, an I/O comment can be added.

If a comment is allocated using an element or a table entry (i.e., Yes is displayed for [Reference]), it is not possible to change the comment.

It is possible to change the comment if it is not allocated using an element or a table entry.

**Bit**
Specify the PC (PLC) bit number where the I/O comment to be edited is allocated. If you specify a new address or bit, an I/O comment can be added.

If a comment is allocated using an element or a table entry (i.e., Yes is displayed for [Reference]), it is not possible to change the comment.

It is possible to change the comment if it is not allocated using an element or a table entry.

**I/O Comments**
Specify a comment for a PC (PLC) address or bit.
A comment can comprise up to 16 characters.

7-7-3 Importing I/O Comments from a Ladder Program

With NT-series Support Tool for Windows, it is possible to import I/O comments from the ladder program that is created using the following PLC Support Software. Inputting I/O comments can save time and labor.

This section describes the import method of I/O comment.

• SYSMAC Support Software, SYSMAC CPT

I/O comments can be imported from a C-series ladder program with the extension .SP1.

**Reference:**
• With SYSMAC Support Soft, when saving ladder program, I/O comments are automatically saved in a file with an extension .SP1.
SYSMAC CPT saves ladder program in SSS program (*.SP1) and use this file to import I/O comment.

- I/O comment of CVM1/CV series can not be imported with Support Tool.

- With SYSMAC CPT, it is not possible to save ladder program of PLC with "-Z" in a file with an extension .SP1. Therefore, Support Tool can not import I/O comment of ladder program for "-Z" created with SYSMAC CPT.

Priority in I/O comment

When the I/O comment table at Support Tool has an existing I/O comment or when both word I/O comment and its bit I/O comment exist in ladder program to be imported (e.g., 0005CH:DDD, 000512:EEE), priority will be as follows (smaller number takes higher priority):

1. Existing I/O comment in Support Tool (in I/O comment table)
2. I/O comment of bit in ladder program to be imported
3. I/O comment of word in ladder program to be imported

Example: Existing I/O comments in Support Tool (in I/O comment table)

<table>
<thead>
<tr>
<th>Word / Bit</th>
<th>I/O Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>0005</td>
<td>AAA</td>
</tr>
<tr>
<td>000603</td>
<td>BBB</td>
</tr>
<tr>
<td>0007</td>
<td>CCC</td>
</tr>
</tbody>
</table>

I/O comments in ladder program to be imported

<table>
<thead>
<tr>
<th>Word / Bit</th>
<th>I/O Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>0005</td>
<td>DDD</td>
</tr>
<tr>
<td>000512</td>
<td>EEE</td>
</tr>
<tr>
<td>0006</td>
<td>FFF</td>
</tr>
<tr>
<td>000613</td>
<td>GGG</td>
</tr>
<tr>
<td>000708</td>
<td>HHH</td>
</tr>
<tr>
<td>0008</td>
<td>III</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PLC Bit Address</th>
<th>I/O Comment</th>
<th>Ref</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000500</td>
<td>AAA</td>
<td></td>
</tr>
<tr>
<td>0000512</td>
<td>EEE</td>
<td>No</td>
</tr>
<tr>
<td>0000600</td>
<td>FFF</td>
<td>No</td>
</tr>
<tr>
<td>0000603</td>
<td>BBB</td>
<td>Yes</td>
</tr>
<tr>
<td>0000613</td>
<td>GGG</td>
<td>No</td>
</tr>
<tr>
<td>0000700</td>
<td>CCC</td>
<td>Yes</td>
</tr>
<tr>
<td>0000708</td>
<td>HHH</td>
<td>No</td>
</tr>
<tr>
<td>0000800</td>
<td>III</td>
<td>No</td>
</tr>
</tbody>
</table>

*: Existing I/O comment in Support Tool (in I/O comment table)
Handling of I/O comments of Timer / Counter

Timer/Counter do not have their own number. They share common Timer/Counter number.

However, with an I/O comment table at Support Tool, it is possible to input Timer and Counter separately.

So when the Timer/Counter number is imported, I/O comment table stores the same comment both for timer and counter of the same number.

In case I/O comment table at Support Tool has an existing I/O comment for either of timer and counter, existing I/O comment in Support Tool (in I/O comment table) takes priority and imported I/O comment will be stored only for an empty one.

Example: Existing I/O comment in Support Tool (in I/O comment table)

<table>
<thead>
<tr>
<th>Word / Bit</th>
<th>I/O Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIM002</td>
<td>AAA</td>
</tr>
<tr>
<td>CNT002</td>
<td>BBB</td>
</tr>
<tr>
<td>CNT003</td>
<td>CCC</td>
</tr>
</tbody>
</table>

I/O comments in ladder program to be imported

<table>
<thead>
<tr>
<th>Word / Bit</th>
<th>I/O Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIM/CNT000</td>
<td>DDD</td>
</tr>
<tr>
<td>TIM/CNT002</td>
<td>EEE</td>
</tr>
<tr>
<td>TIM/CNT003</td>
<td>FFF</td>
</tr>
<tr>
<td>TIM/CNT004</td>
<td>GGG</td>
</tr>
</tbody>
</table>

Existing I/O comments in Support Tool (in I/O comment table) after importing

Import Procedure

**SYSMAC Support Software, SYSMAC CPT**

Follow the procedure below to import I/O comment from ladder program.

1. Select “Import I/O Comments” from the Tools menu. Dialog box to specify I/O comment is displayed.
2. Specify the I/O comment file (.SP1) to be imported and click the **OK** button.

I/O comment Import is performed. While importing, progress will be displayed on status bar.
(3) When the operation is finished, the message “Import of I/O Comments, operation completed” is displayed. Then, click the [OK] Button. When an I/O comment import was aborted or could not be done because of error, the message “Failed to import I/O comment” is displayed, then click the [OK] Button. In this case, the contents of I/O comment table in Support Tool remain unchanged.

If this message box is displayed, check the following points.

• Is this a program file for OMRON C-series PLC?

• Is the extension .SP1 (SSS program file format)?

In case OMRON SYSMAC CPT is used, store (export) the ladder program in SSS program (*.SP1) format and then use this file to import I/O comment.

Reference: • For SYSMAC Support Soft, SYSMAC CPT, priority of word types to be imported is given below. CIO has the highest priority.

(With comments of more than 3000 entries, D will be cut first.)

CIO (Bit)
L (Bit)
H (Bit)
TIM/CNT
A (Bit)
CIO (Word)
L (Word)
H (Word)
A (Word)
D (Word)

The I/O comments table displays comments in numerical/alphabetical order.

Using CX-Programmer

Use the following procedure to import the I/O comments from the CX-Programmer.

(1) Copy the symbol table in the CX-Programmer and paste it into Excel.

(2) In Excel, delete columns 2 and 5 to that the names, addresses, and comments are lined up across the sheet.
(3) Select \textit{Save as} and save the sheet as tab-delimited text.

(4) Select \textit{Import I/O Comments} from the Tool Menu in the Support Tool and select the file saved in step 3. The comments will be imported.

\section*{7-7-4 Importing I/O Comment from Tab-delimited Text File}

\textbf{Import Procedure}

1. Select “Import I/O Comments” from the Tools menu. The dialog box to specify I/O comments will be displayed.

2. Specify “CX-P IO Comments (Tab Delimited) (*.txt)” or “All Files” as a file type and specify the I/O comment file (tab delimited text file) saved and click the \texttt{[OK]} Button. The I/O comment will be imported.

3. When the operation is finished, the message “Import of I/O Comments, operation completed” will be displayed. Next, click the \texttt{[OK]} Button. When an I/O comment import was aborted or could not be performed because of an error, the message “Failed to import I/O comment” will be displayed. Click the \texttt{[OK]} Button to clear the message. In this case, the contents of the I/O comment table in Support Tool remain unchanged.

- Is the data format of the I/O comment file to be imported (tab delimited text file) correct? (see the following page)

If an import is aborted in the middle of the import operation, I/O comments in the Support Tool will remain unchanged.

\textbf{Text file format to be imported by the Support Tool}

The Support Tool can read the tab-delimited text file, which was created by the user, as an I/O comment file. Here, the rule for the text file format is described.

\textbf{Format}

- One line must be constructed as follows:

\textit{Name} [TAB] \textit{PLC address} [TAB] \textit{I/O comment} [Enter]

Example

\begin{verbatim}
START    0.01  START(ON)
STOP     0.02  STOP(OFF)
N_DataV1082  DM1082  Speed1
N_DataA1083  DM1083  Speed2
\end{verbatim}

For details of the format rule, see the description below and the [Example of import].

\textbf{Name}

The Support Tool imports only the PLC address and the I/O comments to the I/O comment table. Therefore, the address name can be omitted.

In this case, however, be sure to insert \texttt{TAB} code before “PLC address.”

Example

\begin{verbatim}
[TAB]0.01[TAB]START(ON) [Enter]
\end{verbatim}
### PLC address

Each word type should be expressed as shown below. To specify a bit number, input bit number after a decimal point.

<table>
<thead>
<tr>
<th>Word</th>
<th>Prefix</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>(None)</td>
<td>C series</td>
</tr>
<tr>
<td>Bit</td>
<td></td>
<td>CS/CJ series</td>
</tr>
<tr>
<td>HR area</td>
<td>Address</td>
<td>HR or H</td>
</tr>
<tr>
<td>Bit</td>
<td></td>
<td>HR0.12</td>
</tr>
<tr>
<td>AR area</td>
<td>Address</td>
<td>AR or A</td>
</tr>
<tr>
<td>Bit</td>
<td></td>
<td>AR0.12</td>
</tr>
<tr>
<td>LR area</td>
<td>Address</td>
<td>LR</td>
</tr>
<tr>
<td>Bit</td>
<td></td>
<td>LR0.12</td>
</tr>
<tr>
<td>Timer</td>
<td>TIM or T</td>
<td>TIM100</td>
</tr>
<tr>
<td>Time up flag</td>
<td>TU</td>
<td>TU100</td>
</tr>
<tr>
<td>Counter</td>
<td>CNT or C</td>
<td>CNT100</td>
</tr>
<tr>
<td>Count up flag</td>
<td>CU</td>
<td>CU100</td>
</tr>
<tr>
<td>Work area</td>
<td>Address</td>
<td>W</td>
</tr>
<tr>
<td>Bit</td>
<td></td>
<td>W0.12</td>
</tr>
<tr>
<td>Task flag</td>
<td>TK</td>
<td>TK1</td>
</tr>
<tr>
<td>Data memory area</td>
<td>Address</td>
<td>DM or D</td>
</tr>
<tr>
<td>EM current bank</td>
<td>EM or E</td>
<td>EM20</td>
</tr>
<tr>
<td>EM bank specification</td>
<td>Address</td>
<td>E</td>
</tr>
</tbody>
</table>

*: CS/CJ series does not have an LR area. If an LR area bit (L00000 to L00199) is set to screen data, it will be automatically converted to CIO 01000 to CIO 01199 inside the PT.

### I/O comment

If an I/O comment longer than 16 characters is set, the remaining characters are discarded.

#### Example of import

<table>
<thead>
<tr>
<th>Strings</th>
<th>Import OK/NG</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC [Enter]</td>
<td>NG</td>
<td>---</td>
</tr>
<tr>
<td>ABC [Enter]</td>
<td>NG</td>
<td>---</td>
</tr>
<tr>
<td>ABC [TAB] [Enter]</td>
<td>NG</td>
<td>---</td>
</tr>
<tr>
<td>ABC [TAB] 100.01 [TAB] comment1 [Enter]</td>
<td>OK</td>
<td>00100001</td>
</tr>
<tr>
<td>ABC [TAB] 100.02 [TAB] [Enter]</td>
<td>OK</td>
<td>00100002</td>
</tr>
<tr>
<td>ABC [TAB] [TAB] comment2 [Enter]</td>
<td>NG</td>
<td>---</td>
</tr>
<tr>
<td>ABC [TAB] [Enter]</td>
<td>NG</td>
<td>---</td>
</tr>
<tr>
<td>ABC [TAB] [TAB] [Enter]</td>
<td>NG</td>
<td>---</td>
</tr>
<tr>
<td>ABC [TAB] [TAB] [TAB] [Enter]</td>
<td>NG</td>
<td>---</td>
</tr>
<tr>
<td>ABC [TAB] [TAB] [TAB] [TAB] [Enter]</td>
<td>NG</td>
<td>---</td>
</tr>
<tr>
<td>F-Key Input Notify Table</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[Enter]</td>
<td>Ignored</td>
<td>---</td>
</tr>
<tr>
<td>[TAB] [TAB] [Enter]</td>
<td>NG</td>
<td>---</td>
</tr>
<tr>
<td>[TAB] [Enter]</td>
<td>NG</td>
<td>---</td>
</tr>
<tr>
<td>△ [TAB] 100.03 [TAB] {Enter}</td>
<td>OK</td>
<td>0010003</td>
</tr>
<tr>
<td>△ [TAB] 100.04 [TAB] [Enter]</td>
<td>OK</td>
<td>0010004</td>
</tr>
<tr>
<td>△ [TAB] 100.05 [Enter]</td>
<td>NG</td>
<td>---</td>
</tr>
<tr>
<td>[TAB] [TAB] comment4 [Enter]</td>
<td>NG</td>
<td>---</td>
</tr>
<tr>
<td>[TAB] [TAB] [TAB] [EOF]</td>
<td>NG</td>
<td>---</td>
</tr>
<tr>
<td>[TAB] 100.06 [TAB] comment5 [EOF]</td>
<td>OK</td>
<td>0010006</td>
</tr>
<tr>
<td>ABC [TAB] 100.07 [TAB] comment6 [EOF]</td>
<td>OK</td>
<td>0010007</td>
</tr>
</tbody>
</table>

△: Blank space  [TAB]: TAB code
[Enter]: Enter code  [EOF]: End of file

Reference:

- It may take time to import I/O comments when there are many I/O comments.

- There are the PLC address, I/O Comment, and Reference in an I/O comments table. Addresses with no comment and no reference will not be downloaded to PT. (See below)

    - Can be downloaded  ○: Can be downloaded  ×: Cannot be downloaded
    - Lines in an I/O comment table with only the PLC address input (for future use etc.) will not be downloaded to PT, and as a result, when the data is uploaded to the Support Tool, the line itself will be lost. (This also applies when saving data in mmi format.)
    - Support Tool cannot import more than 3,000 PLC addresses with comments. Therefore, if there are more than 3,000 PLC addresses with comments, only the addresses will be imported for PLC addresses from entry 3001 onwards. (I/O comment import operation will be finished normally.)
    - Rejected entries are displayed in the Error Log. Check them by selecting [Error Log] from the [View] menu and print them.

7-8  F-Key Input Notify Table

This table is only available for NT11S/NT11. The F-Key Input Notify Table consists of four entries. Each entry is assigned to a function key in the PT device. It specifies a PC (PLC) memory bit to be related to a corresponding function key.

7-8-1  Operation Procedure

An F-Key Input Notify Table is displayed by following the operation described below.

- Select [Tools] (menu bar) → [Table] → [F-Key Input Notify] tab → Specify the edit field →
7-8-2 Description of F-Key Input Notify Table

The table entry number field, or the <No.> column is not editable. All table entries are listed in ascending order of their entry numbers, starting from zero to one less than the maximum number of entries.

<table>
<thead>
<tr>
<th>No.</th>
<th>PLC Bit Address</th>
<th>I/O Comment</th>
<th>F-Key Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>--</td>
<td></td>
<td>F1</td>
</tr>
<tr>
<td>1</td>
<td>--</td>
<td></td>
<td>F2</td>
</tr>
<tr>
<td>2</td>
<td>--</td>
<td></td>
<td>F3</td>
</tr>
<tr>
<td>3</td>
<td>--</td>
<td></td>
<td>F4</td>
</tr>
</tbody>
</table>

PLC Bit Address
Specify the PC (PLC) bit that you want to link with the Function Key.

I/O Comment
Specify a comment for a PC (PLC) address or bit.
A comment can comprise up to 16 characters.

7-9 Mathematical Table
Mathematical table is only available for the NT21, NT31/631-V2 and above. The table may contain 0 to 255 entries and each entry can be assigned a mathematical formula. The result of each calculation can be stored in either a Numeral Table entry or a PLC address.

7-9-1 Operation Procedure
The mathematical table setting dialog box is displayed by following either of the operations described below.
- Select [Tools] (menu bar) –> [Mathematical Table].
- Double click on “Mathematical Table” from application manager window

7-9-2 Supported Objects
The following objects are affected or have an effect on the Mathematical Table: Numeral Display, Numeral Input, Thumb wheel switch, Bar Graph, Analogue meter, Broken Line Graph, Trend Graph.
## 7-9-3 Supported PLC Addresses

The supported addresses for the *operand* and *result* based on the PLC vendor type are as follows:

**Omron**

<table>
<thead>
<tr>
<th>Word</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIO</td>
<td>00000 to 32767 (decimal)</td>
</tr>
<tr>
<td>DM</td>
<td>00000 to 32767 (decimal)</td>
</tr>
<tr>
<td>HR</td>
<td>00000 to 32767 (decimal)</td>
</tr>
<tr>
<td>AR</td>
<td>00000 to 32767 (decimal)</td>
</tr>
<tr>
<td>LR</td>
<td>00000 to 32767 (decimal)</td>
</tr>
<tr>
<td>EM</td>
<td>00000 to 32767 (decimal)</td>
</tr>
<tr>
<td>WR</td>
<td>00000 to 32767 (decimal)</td>
</tr>
<tr>
<td>E0 to EA</td>
<td>00000 to 32767 (decimal)</td>
</tr>
<tr>
<td>C</td>
<td>00000 to 32767 (decimal)</td>
</tr>
<tr>
<td>T</td>
<td>00000 to 32767 (decimal)</td>
</tr>
</tbody>
</table>

**Memory Link**

<table>
<thead>
<tr>
<th>Word</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIO</td>
<td>00000 to 32767 (decimal)</td>
</tr>
</tbody>
</table>

**Mitsubishi A**

<table>
<thead>
<tr>
<th>Word</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>0000 to 2700 (hexadecimal)</td>
</tr>
<tr>
<td>Y</td>
<td>0000 to 2700 (hexadecimal)</td>
</tr>
<tr>
<td>M</td>
<td>0000 to 9984 (decimal)</td>
</tr>
<tr>
<td>L</td>
<td>0000 to 9984 (decimal)</td>
</tr>
<tr>
<td>B</td>
<td>0000 to 2700 (hexadecimal)</td>
</tr>
<tr>
<td>D</td>
<td>0000 to 9999 (decimal)</td>
</tr>
<tr>
<td>R</td>
<td>0000 to 9999 (decimal)</td>
</tr>
<tr>
<td>W</td>
<td>0000 to 270F (hexadecimal)</td>
</tr>
<tr>
<td>C</td>
<td>0000 to 9999 (decimal)</td>
</tr>
<tr>
<td>T</td>
<td>0000 to 9999 (decimal)</td>
</tr>
</tbody>
</table>

**Mitsubishi Fx**

<table>
<thead>
<tr>
<th>Word</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>00000 to 23400 (octal)</td>
</tr>
<tr>
<td>Y</td>
<td>00000 to 23400 (octal)</td>
</tr>
<tr>
<td>M</td>
<td>00000 to 9984 (decimal)</td>
</tr>
<tr>
<td>S</td>
<td>00000 to 9984 (decimal)</td>
</tr>
<tr>
<td>D</td>
<td>00000 to 9999 (decimal)</td>
</tr>
<tr>
<td>C</td>
<td>00000 to 9999 (decimal)</td>
</tr>
<tr>
<td>T</td>
<td>00000 to 9999 (decimal)</td>
</tr>
</tbody>
</table>
7-9-4 Description of Mathematical Table Fields

Description

The mathematical function specified in each table entry will be displayed here in the form of a simple equation. Left-hand side of the equation will indicate the location where result calculated from the function will be stored. Right-hand side will display the actual function.

Set

Invokes ‘Set Mathematical Dialog Box’. Specify mathematical function using this dialog box.

Edit

Refer to 7-1 Common Operation.

Goto Entry

Refer to 7-1 Common Operation.

Move

Invokes 'Move To' dialog box. Move a table entry using this dialog box.

Close

Closes the dialog box.

Help

Shows help information related to mathematical table.
7-9-5 Description of Set Mathematical Formula Fields

This dialog box is to be used to define a new/edit an existing mathematical formula.

Formula
Shows the list of available formula that can either be arithmetic, boolean or bitwise operations. This will list out combinations of available operands and operators i.e., type of the function.

Selected Formula
Shows the selected mathematical formula for this entry. It is updated whenever there is any change in operands or operators.

Word Size
This is a common setting for Result and Operand. It is only valid for PLC Address and constant. For Numeral Table entry, the word size will follow the setting in the Numeral Table. This control will be enabled when the selected formula is not ‘None’.

Result
This button will be used to specify the result. This button will be enabled when the selected formula is not ‘None’. The following choices are available for result location.

- PLC word address
- Numeral table entry

Operand buttons
This buttons will be used to specify operands. Operand buttons will be enabled according selection of [Formula]. The following choices are available for operands.

- Constant value (integer only)
- Numeral table entry (Direct)
- PLC Address

Operators
These combo boxes will provide a list of available operators. Operator combo boxes will be enabled according selection of [Formula]. Following choices of types of operators will be available.
• Numerical Operator (Addition, Subtraction, Multiplication, Division (result will have the quotient only) and Modulo)
• Boolean Operator (AND, OR & XOR)
• Bitwise Operator (&: bitwise AND, |: bitwise OR and ^: bitwise XOR)
• Comparison Operator (<, > and =)

7-9-6 Description of Edit Operand Fields

This dialog box will be obtained by clicking ‘any of the enable Operand’ buttons. This will be used to specify the operand.

Operand Type

This combo box will specify the type of operand. Default is ‘None’ and OK button will remain disabled unless some other selection is made. The following choices are available for the combo box:

PLC Address

This is almost like the address dialog box. There is an extra field: Storage Type.

Storage Type

Specify the type of the storage type (BCD/BIN).

Numeral Table Entry

This edit box specifies numeral table entry number. Numeral table entry can be specified in this edit box using corresponding table button.
7-9-7 Description of Edit Result Fields

This dialog box will be obtained by clicking Result button. This will be used to specify the result.

Result Type

This is to specify type of the result. Choices for result types are:

- (1) Numeral Table Entry
- (2) PLC Address

Dialog boxes are same as that of corresponding 'Edit Operand' dialog boxes. Refer to 7-9-6 Description of Edit Operand Fields [Dialog Box] for UI and fields.

7-9-8 Description of Move To Fields

This dialog box will be used to move a mathematical table entry to any of the existing entry.

Entry

Specifies the table entry number of the table where current entry will be moved. The cursor moves to the specified table entry number. Entries following this will be moved downwards to adjust for the moved entry.

7-10 Recipe Table

Each application has one recipe table. A recipe table (see Section 7-10-2) consists of a number of entries. Each entry consists of a collection of records, and each record consists of a number of parameters or attributes. Parameters designate consecutive memory areas from a starting address defined for each recipe entry.

Each standard screen is limited to one recipe screen element. A recipe screen element (see Section 6-11-1) is a compound screen element, consisting of an alarm-like grid structure and some touch switches. It is like a collection of numerical inputs, featuring access and display of data from the recipe table.

Recipe Table is only available in the NT21 and NT31/631-V2 (System Ver. 3.1).

7-10-1 Operation Procedure

The recipe table can be activated by selecting [Tools] (menu bar) → [Recipe Table].
7-10-2 Description of Recipe Table Fields

Description of Recipe Table Dialog Controls

**No.**
Displays the entry number. By default, the 1st record is selected. Nothing happens when an entry is double-clicked. This number will not change when another entry is deleted.

**Name**
Displays the name for a recipe. Mark objects can be allowed.
A [Name] can comprise up to 12 characters.

**No. of Records**
Displays the number of records contained in the recipe.

**No. of Parameters**
Displays the number of parameters contained in the recipe.

**Bytes/Record**
Displays the size in bytes of all records in each entry. This size is 4 * no. of parameters in 1 record. The size of a parameter value is 4 bytes regardless of whether it is 1 or 2 words.

**Occupied Bytes**
Display the size in bytes of all records in each entry. This is the size of memory occupied by each recipe entry in the recipe memory. Equals [No. of Record] * [Bytes/Record].

**New**
Shows the recipe setting dialog to create a new recipe entry. The created entry becomes the last entry and gets selected.
Recipe Table

Delete
Delete the selected entry. Same as [Edit]–[Delete].

Set Recipe
Shows the setting of the selected entry in a recipe setting dialog.

Set Record
Show the records of the selected entry in a record setting table.

Edit
Permits delete, cut, copy and paste operations on a selected recipe. An edit pop-up menu with these 4 options will appear.

Delete, Cut, Copy, Paste is disabled when no entry exists. Paste is available when the clipboard contains recipe data.

Goto Entry
Selects an entry by specifying the entry number through a Go to dialog. The behavior is the same as numeral table Go to dialog.

Total
Displays the byte-size of all entries. Equals sum of all [Occupied Bytes].

Available
Displays the table's maximum byte-size less the used byte-size. This is the total recipe size minus total occupied size.

Recipe Setting Dialog

Recipe Setting

Number: [ ]
Name: [Pizza] [Input Meas.]
Comment: [Recipe for Pizza]
No of Records: [3] [ ]
No of Parameters: [3] [ ]
Storage Type: [System]

Address
PLC Address: [L00C20] [Set]
I/O Comments: [ ]
This Recipe Setting dialog allows you to specify the settings for an entry in the recipe table.

Description of Recipe Setting Dialog Controls

**Number**

Displays the recipe number in the recipe table. When creating a new entry, the lowest available number is suggested.

The maximum recipe number is 200.

**Name**

Specifies the name of the recipe entry. A character string of up to 12 characters can be accepted.

**Insert Mark**

Insert a mark object in recipe name.

**Comment**

Specifies a comment for recipe entry. A character string of up to 24 characters can be accepted.

**No. of Records**

Inputs the number of records required for this recipe entry. If this entry is being created, default value is 2.

Allocate up to a maximum of 200 digits.

**No. of Parameters**

Inputs the number of parameters required for this recipe entry. If this entry is being created, default value is 2.

Allocate up to a maximum of 200 digits.

**Storage Type**

Sets the numeral data type for parameter values in each record of this recipe entry.

**PLC Address**

Inputs the starting PLC address for this recipe entry. Bit addresses cannot be specified.

**Set**

Sets the starting PLC address via an address composition dialog.

**I/O Comments**

Inputs comments for the starting PLC address. By default, the current comment is shown.

A character string of up to 16 characters can accept.
This Record Setting Table dialog box permits you to specify the settings for all records of a recipe entry in the recipe table.

**Description of Record Setting Table Controls**

**Start Address**
Displays the starting PLC address.

**No.**
Displays the record number.

**Record**
Specifies the name for the record entry.
A string of up to 12 characters can be used and edited.

**Parameter Title**
Displays the parameter name, i.e., “Param1” and “Param2.” Default value is “ParamX,” where X is a number.
Up to 8 characters can be used and edited, with the column width depending on the parameter values.

**Parameter**
Displays the numerical data values for each record.
You can edit data values. The Initial value is 0.

**Lock**
Sets the Record as read only.

**Edit Param**
Displays the parameter setting table.
Edit
Permits clear, copy and paste operations on a selected range of record entries. An edit popup menu with these 4 options will appear, like the menu in the current numeral table entry.

Clear, Copy, Paste is only enabled when the clipboard contains record data.

Goto Entry
Allows the selection of an entry by specifying the entry number through a Go to dialog. The behavior is same as the numeral table Go to dialog.

Insert Mark
Inserts a mark object in a record or a parameter name.

Import
Import parameter data from a CSV formatted file. A file open dialog with a CSV Formatted Recipe Data (*.csv) filter will prompt for the source file.

Export
Export all data of this recipe entry. A file save dialog with a CSV Formatted Recipe Data (*.csv) filter will prompt for the target file name. Exporting a selection of parameter data is not supported.

Reset Width
Resets the width of each column to the default setting.

Note
The parameter data cell will always be displayed using the parameter’s number format. A decimal type parameter will display values in decimal, while a hexadecimal type parameter will display values in hexadecimal.

Parameter Setting Table

<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter</th>
<th>Dec/Hex</th>
<th>Sign</th>
<th>Integer</th>
<th>Decimal</th>
<th>Words</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Cheese</td>
<td>Dec</td>
<td>☐</td>
<td>5</td>
<td>0</td>
<td>1</td>
<td>L00020</td>
</tr>
<tr>
<td>2</td>
<td>Water</td>
<td>Dec</td>
<td>☐</td>
<td>5</td>
<td>0</td>
<td>1</td>
<td>L00021</td>
</tr>
<tr>
<td>3</td>
<td>Salt</td>
<td>Dec</td>
<td>☐</td>
<td>5</td>
<td>0</td>
<td>1</td>
<td>L00022</td>
</tr>
</tbody>
</table>

This dialog permits users to specify the setting for all parameters of a recipe table entry.

When the Words field is changed from 2 to 1, you will be prompted with a message that some data will be lost with this conversion. If the value is less than
-32,768 or greater than 32,767, the value will be set to 0. Otherwise, if the sum of Integer and Decimal digits exceed the maximum limit, the number of Decimal digits will be reduced. For example, given a parameter with settings “Dec,” “4 Integer” and “4 Decimal” and value 54.3675, when word size is reduced to 1, setting will become “4 Integer” and “1 Decimal” and value will be 54.3.

When entering values into the Integer and Decimal fields, the following validation will occur. When “Dec/Hex” is decimal and “Integer” or “Decimal” is set so that their sum is greater than the maximum digits allowed, once the cell loses the focus, the following occurs:

a) If the entered value is less than or equal to the maximum digits allowed, it is accepted. Any other value is reduced, so that their sum is not greater than the maximum digits allowed.
b) Otherwise, the entered value is set to the maximum digits allowed and the other value is set to 0.

The maximum digits allowed is 5 (1 word) or 10 (2 words).

Description of Parameter Setting Table Controls

**No.**
Displays the parameter entry number.

**Parameter**
Displays the parameter name.
A string of up to 8 characters can be used and edited.

**Dec/Hex**
Displays the numeral display format, either decimal or hexadecimal.
When this is changed Integer and Decimal will be reset to default.

**Sign**
Display sign option. Check if you want a sign to be displayed.

**Integer/Decimal**
Displays the precision of the integer/decimal digit of the numeral data. Limitation on the sum of integer and decimal digits will follow the numeral display restriction.

**Words**
Defines the memory size for the parameter. The address column will be reset when this size is changed.

**PLC Address**
Displays the starting PLC address used by the parameter.

**Goto Entry**
This will allow the selection of an entry by specifying the entry number through a Go to dialog.

**Insert Mark**
Inserts a mark object in a parameter name.

**Import**
The Parameter values in the records of a recipe can be edited through a CSV (Comma Separated Values) file. Each line consists of the fields of a record, with a comma separating two fields.
The first line of a CSV file is the header. The first field is the recipe name. If it contains ASCII characters from 0x00 to 0x1F will be converted to spaces after import. The second field is “Master Record Flag,” which is equivalent to the Lock check box in the Record Setting dialog. Subsequent fields are the names of all the parameters in the record.

The second line onwards contain the parameter value of the records in the recipe. The first field is the record name. The second field is a value indicating whether the Lock check box should be checked or unchecked. 0 means unchecked and 1 means checked. Any other values are considered invalid. Subsequent fields are the actual values of the parameters in that record.

During export of parameters in the Record Setting Table, the decimal points of the parameters will not be exported. **Example:** Parameter 1 is set to 3 integer digits and 2 decimal digits, and the parameter value is 123.45. After exporting to CSV format the value will become 12345. Hexadecimal values will be converted to the decimal equivalent after export.

If you try to import a CSV file that has a value with a decimal point, it is considered invalid and an improper line dialog is displayed. Likewise, hexadecimal values containing A-F are not allowed.

**Improper Line Dialog**

The import operation will overwrite all the current parameter values. However, if any line in the file is incorrect, an improper line dialog will prompt for instructions. An improper line is any line of text in the source import file whose data does not comply with the CSV format or whose data is not valid. Any incorrect value in a CSV line is shown in red in the Original row as shown in the diagram below. The Import row will display the adjusted values. You can change the values highlighted in red to the desired ones.

In the Name field, if the string consist of more than the allowed number of characters, the data will be truncated from the right.

In the Lock field, ‘0’ means unchecked and ‘1’ means checked. Anything other than that is considered invalid. This value will be reset to uncheck.

In the Parameter fields, any non-numeric data is considered invalid. The values will be reset to 0.
Example
For example, if the imported data is “this is only for testing” and only 11 characters are allowed, then the grid cell will show “this is only” in red. “for testing” will be truncated.

“**12**” is not valid for the Lock field and is thus highlighted in red.
So are “$%@” and “$62!78” for parameter values, which are both reset to 0.

Description of Improper Line Dialog Controls

Improper Line
You cannot edit this [Improper Line] edit box.
Displays the improper line in the CSV file.

Detail
Original – Shows the original CSV line. It cannot be edited and these invalid values will be displayed in red.
Import – Shows the default values and you can modify the default values.

Name
Shows the first value in the CSV file. This is the record name. If the value has more than 12 characters, only the first 12 characters from the left will be shown.
Accepts a character string of up to 8 characters.

Lock
Shows the second value in the CSV file. This is the master record flag. Only the first character from the right of the value is shown.
Can only accept 0 or 1 (0: unchecked, 1: checked).

Parameter data
Show the other values in the CSV file. These are the parameter data values. If the imported value has more than the number of characters allowed, the value will be set to 0.

Ignore
Ignore this improper line and proceed to import the rest of the lines in the file.

Ignore All
Ignore all improper lines and proceed to import the rest of the lines in the file.
The graphic data edit function creates images in the bit map data format, library data using fixed elements, and marks that display special characters and symbols.

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8-1</td>
<td>Image Editor</td>
<td>324</td>
</tr>
<tr>
<td>8-1-1</td>
<td>Operating the Image Table</td>
<td>324</td>
</tr>
<tr>
<td>8-1-2</td>
<td>Creating Image Data Using Image Editor</td>
<td>327</td>
</tr>
<tr>
<td>8-2</td>
<td>Library Editor</td>
<td>336</td>
</tr>
<tr>
<td>8-2-1</td>
<td>Operating the Library Table</td>
<td>336</td>
</tr>
<tr>
<td>8-2-2</td>
<td>Creating Library Data Using Library Editor</td>
<td>339</td>
</tr>
<tr>
<td>8-3</td>
<td>Mark Editor</td>
<td>344</td>
</tr>
<tr>
<td>8-3-1</td>
<td>Screen Configuration</td>
<td>344</td>
</tr>
<tr>
<td>8-3-2</td>
<td>Creating Marks Using the Mark Editor</td>
<td>344</td>
</tr>
</tbody>
</table>
8-1 Image Editor

The procedure for creating images of any required shape in the bit map (BMP) format is described below.

The bit map format graphic data that has been created using a Windows-based general purpose application software can be pasted onto the image creation screen by using the image editor via the clip board.

Created image data can be inserted into a character string in an image/library lamp display, alarm list display, alarm history display, or character string display. With the NT21 and NT31/631 without NT20/30/620-compatible mode, it is not possible to insert image data into a character string.

Reference: Image editor has the following features.

• You can draw any graphics in the bit map format freely.
• It is possible to import Image data from the different screen data file.
• Selected image data can be expanded or shrunk.
• The bit map file can be pasted onto the image editor.
• Copy, cut, paste operation of image data is possible.
• Preview display of selected image data is available on the image table.

8-1-1 Operating the Image Table

Image table dialog is configured as follows:

- [Edit] Deletes, cuts, copies or pastes the image data of the selected code (refer to pages 325 to 327). It is possible to select two or more codes and delete them collectively.
- [Goto Code] Code number can be specified and the cursor moves to the code. The operation method is same as the “Goto Entry” of a memory table (refer to 7-1-6 Table Display Operation by Specifying the Table Entry Number).
- [Preview] Switches the preview window ON and OFF (refer to page 325).
- [Open] Displays the editing screen (image editor) of the selected code (P331). When two or more codes are selected, edit screens of all the selected codes can be opened collectively.
- [New] Registers the new image code to the image table (refer to page 327). Only the registered image codes are listed on the image table. Press this button when you are going to create new image data.
[Delete] ....... Deletes the image data of the selected code. When two or more codes are selected, they can be deleted collectively.

[Close] ....... Closes the image table dialog.

[Help] ......... Displays Help about the image table dialog box.

• Specifying a code
To specify a code for operations, click on the objective line (image code). To specify the continuous codes collectively, click on the first code to be selected and then the last code to be selected while pressing the Shift key. If you click on a code while pressing the Ctrl key, the code will be selected or deselected alternately each time it is clicked.

• Preview Function
Support Tool provides a preview function that can display the contents of the selected code. When two or more codes are selected, the preview of the code selected last will be displayed in preview window. The preview window can be switched ON and OFF by clicking the button.

• Deleting the image data
To delete an image data, follow the procedure below. Deleted image data will not be stored to the clipboard and its code itself will be also deleted. When two or more codes are selected, they will be deleted collectively.

(1) Select [Image Editor] from the [Tools] menu. The image table is displayed.

(2) Select the code of the image data to be deleted. When two or more codes are selected, they can be deleted collectively.

(3) Perform one of the following operations.
  • Right-click the selected code → [Delete]
  • Selected code will be deleted after you click the [Yes] Button in the confirmation dialog box.

• Cutting/copying the image data
To cut or copy an image data, follow the procedure below. The cut/copied image data will be stored to the clipboard and can be pasted to the other codes.
In case of “cut,” cut code will be deleted from the image table. In case of “copy,” copied code remains in the image table.

**Reference:** When two Support Tools are started up by [Import Component] from the [File] menu, the data that is cut or copied on the image table of one Support Tool can be pasted onto the image table of another Support Tool (PT model setting of the two screen data files should be the same). For details, refer to 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool).

   The image table is displayed.
2. Select the code of the image data to be cut or copied.
   Select only one code. When two or more codes are selected, cut/copy operation can not be performed.
3. Click the **Edit** Button or right-click on the selected code.
4. Select [Cut] or [Copy].

Image data of the selected code will be stored to the clipboard. In case of [cut], confirmation dialog box will be displayed. After clicking the **Yes** Button, cut code will be deleted from the image table.

- Pasting the image data

To paste an image data that is stored in the clipboard by cut or copy operation, follow the procedure below.

**Reference:** When two Support Tools are started up by [Import Component] from the [File] menu, the data that is cut or copied on the image table of one Support Tool can be pasted onto the image table of another Support Tool (PT model setting of the two screen data files should be the same). For details, refer to 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool).

- If the paste operation is performed, the image data previously registered to the code is overwritten and lost. (Confirmation dialog box will be displayed.)
- When an image data is pasted, the property (size, colors, compression, comment) of the image code is changed to that of the new one.

   The image table is displayed.
2. Select the code of the image data to be pasted.
   Select only one code. When two or more codes are selected, paste operation can not be performed.
3. Click the **Edit** Button or right-click on the selected code.
(4) Select [Paste].

[Paste] can not be selected if the image data to be pasted is not stored in the clipboard. After clicking the [Yes] Button in confirmation dialog box, image data will be pasted to the selected code.

- Quitting the image table

You can quit the image table in any of the two ways described below.
- Clicking the [Close] Button of the image table dialog.
- Clicking the X Button at the upper right corner of the image table dialog.

8-1-2 Creating Image Data Using Image Editor

- Registering new image data

(1) Select [Image Editor] from the [Tools] menu.

The image table is displayed.

(2) Click the [Next] Button.

The New Image Entry dialog box is displayed.

(3) Set the code, size, colors, compression, comment of the image data to be newly created, then click the [OK] Button.

- Setting for New Image Entry dialog box

  Code: Specify the code to which the new image data is registered.
When the dialog box is opened, the smallest unused code is set.

Colors: Specify whether the image data is created in "2 Colors" (monochrome) or "8 Colors" (color).

Search Direction: Unregistered code can be searched using the Find Next button. In the Search Direction, specify Up (to the smaller code) or Down (to the larger code) to designate the direction to which search operation is executed.

Width: Specify the width of the image data as a number of dots.

Height: Specify the height of the image data as a number of dots. The image data size can be set in the range from 8 x 8 dots (minimum) to the screen size of the PT to be used (maximum). The image data width and height must be specified in units of 8 dots.

Compression: Specify the data format for storing the created image data. Check mark set: Image data is compressed for storage. Check mark not set: Image data is stored without being compressed.

Comments: Specify the comment for the image data to be created. Searches the unused code. Specify the search direction in the Search Direction.

Displaying image editor

(1) [Tools] (menu bar) → [Image Editor]

The image table is displayed.

(2) Select the code in the image table and click the Open button or double-click the mouse on the objective code line.

When two or more codes are selected, edit screens (editors) of all the selected codes can be opened collectively. Image table dialog automatically closes at the same time the editor is displayed.
• Changing the property

To change the property of the code that is already registered, open the editor and then display the property dialog of the image data as follows:

![Property dialog of Image Editor](image)

- **[Code]**: Displays the code of the selected image data.
- **[Size]**: Displays the size of the specified image data. To change the size, set the desired size.
- **[Mode]**: Displays the specified color mode. To change the color mode, set the desired color mode.
- **[Compression]**: Specify the data format for storing the created image data.
  - Check mark set: Image data is compressed for storage.
  - Check mark not set: Image data is stored without being compressed.

Although the data size of the created image data will be reduced if the data is compressed, the speed of display on the screen will be slowed a little.

- **[Comments]**: Specify the comment for the image data to be created.

**Screen Configuration of Image Editor**

The screen configuration of the image editor is described below.

![Screen configuration of Image Editor](image)

**Operating the image editor**

Using the image editor, you can create a graphic in the desired shape in the edit area as combinations of lines, points, rectangles, and circles after selecting the
tool and drawing conditions (color, tiling pattern, point type, line width, and font).

- Tool selection

- [Image Editor]

  Used to specify the range to copy, cut, move, shrink or expand the created graphic.

  The range is specified by dragging the mouse cursor.

  To cancel the range specifying frame, select the tools other than [Image Editor].

  ![Range specifying frame]

- [Image Editor]

  Used to move the graphic that is defined by the range specifying frame.

  The range specifying frame can be dragged, or a pop-up menu can be displayed by right clicking the mouse.

- [Image Editor]

  Used to draw a point.

  Click the mouse at the position where a point is to be drawn: a point is drawn in the size specified by point type selection and in the color specified as foreground color.

- [Image Editor]

  Used to draw a line.

  By dragging the mouse cursor from the start point to the end point of the line to be drawn, the desired line is drawn in the width specified by line width selection and in the specified foreground color.

- [Image Editor]

  Used to draw a rectangle.

  By dragging the mouse cursor, a rectangle is drawn having opposing corners at the start and the end point of dragging, having the line of the specified width (line width selection) and in the specified foreground color. The inside of the rectangle is tiled with the colors specified as foreground color and background color in the specified pattern.

- [Image Editor]

  Used to draw a circle or an oval.

  By dragging one corner or one side of a rectangle that circumscribes the circle or oval to be drawn, the desired circle or oval is drawn with a line of the specified width (line width selection) and in the specified foreground color. The inside of the circle or oval is tiled with the colors specified as foreground color and background color in the specified pattern.

- [Image Editor]

  Used to draw a character.

  Click the mouse at the position where a character is to be drawn and the character cursor is displayed. Input characters: the input characters are displayed in the color specified as foreground color with the background displayed in the specified background color.

- [Image Editor]

  Select this tool when tiling the inside of the closed area of a drawn graphic.

  The area is tiled according to the specified pattern and in the colors specified as foreground color and background color.
• Color selection

On the color selection palette, move the cursor to the desired color and click the mouse; a left click selects the foreground color and a right click selects the background color.

• Pattern selection

Move the cursor to the desired pattern and left click the mouse; the selection box moves to the pattern at the cursor location, indicating that the pattern is selected.

• Point type selection

Move the cursor to the desired point type and left click the mouse; the selection box moves to the point type at the cursor location, indicating that the point type is selected.

• Line width selection

Move the cursor to the desired line width type and left click the mouse; the line width type display at the cursor location will be highlighted, indicating that the line width type is selected.

• Font designation

Click the **Set Font...** Button and the font selection dialog box is displayed. After selecting the font, the style, and the size, click the **OK** Button.
• Modifying the size of an image data

Specify the range to be modified using the □ Button and drag one of green ■ marks (handles) that enclose the range specifying frame. Position the mouse cursor on a green handle, and the shape of mouse cursor changes as shown below. (The arrow indicates the same direction as the arrow mark in the handle.)

Drag the mouse cursor in the indicated direction to modify the size of an image data.

Reference: To shrink the size of an image data, shrink it by one dragging operation without releasing the button of the mouse. If you try to expand the image data that was shrunk once, the shape or the color may be modified.

Zooming the edit area

It is possible to display the edit area at an enlarged size to facilitate drawing fine areas and creating small images.

To change the display size of the edit area, select [View] in the menu bar then choose [Zoom]; specify the zoom percentage.

Modifying Graphics

Created graphics can be mirrored (flipped) up and down or right and left, or turned 90° left or right.

The mirroring and 90° turn operations are possible for the graphic in the range specifying frame.
To modify the graphic, select [Edit] (menu bar) → [Rotate or Flip], then specify the desired modification method.

Cutting/copying/deleting graphics

You can cut, copy, paste, and delete the created graphic.

Cut, copy and delete operations are valid for the graphic in the range specifying frame.

To call the desired operation, select [Edit] in the menu bar, then specify [Cut], [Copy], [Paste], or [Delete]. (or right click the mouse, then specify [Cut], [Copy], or [Paste])

Reference: Image data that is cut or copied on one image editor window can be pasted onto the other image editor window (The data can be pasted until another data is stored to the clipboard).
When more than one image editor window is displayed or when two Support Tools are opened by [Import Component] from the [File] menu (same PT model setting), cut, copy and paste operations between these image editor windows are possible. For details, refer to 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool).

Saving to the bit map file

You can save the created graphic to the file in bit map format. This operation is valid for the graphics in the range specifying frame.

To save the graphic to the bit map file, follow the procedure below.

1. Specify the area to be saved in a file with a range specifying frame.
2. Select [Copy To] from the [Edit] menu. The dialog box to specify the file name is displayed.
3. Set the folder and file name and click the Save Button. Graphics in the range specifying frame is saved in a file.

Pasting from the bit map file

You can read out the graphics saved in a bit map file and paste them onto the image editor. The graphics can be pasted onto the image editor that is currently activated.

To paste the graphic from the bit map file, follow the procedure below.

1. Select [Paste From] from the [Edit] menu. The dialog box to specify the file to be read is displayed.
2. Specify the folder and file name and click the Open Button. Read out graphic is pasted onto the image editor enclosed with a range specifying frame.
3. Select [Clip] from the [Edit] menu. Image data size is changed to the read out image size.

Instead of the procedure (3), it is also possible to drag the read out image to the required position.
Changing the image data size

The image data size can be changed in either of the following two ways.

- Changing the size by property setting
- Changing the size to the range specifying frame size

- Changing the size by property setting

Change the setting for [Size] in the image editor property settings to change the size of the image data.

The image data size is changed according to the new setting; the reference point of the size change is at the upper left corner of the present size.

If the size is reduced, part of the created graphic may be cut.

- Changing the size to the range specifying frame size

The size of the image data can be changed to fit the size of the specified range specifying frame.

Select [Edit] in the menu bar, then select [Clip].

Quit the image editor

You can quit the image editor in any of the three ways described below.

- Clicking the Button at the upper right corner of the image editor.
- Selecting [Close] from the control menu box of the image editor.
- Double clicking the control menu box of the image editor.
8-2 Library Editor

Graphics of any required shape can be created by combining fixed elements. The created graphic can be registered as one element (library data) and any number of elements can be displayed at any positions in any screen using the library display function.

Created library data can be used for image/library lamp display, alarm list display, alarm history display.

Reference: Library editor has the following features.
• You can draw any graphics by combining fixed elements.
• It is possible to import library data from the different screen data file.
• Fixed display elements can be copied, cut, pasted from the editing screen
• Copy, cut, paste operation of library data is possible.
• Preview display of selected library data is available on the library table.

8-2-1 Operating the Library Table

Library table dialog is configured as follows:

[Edit] ........ Deletes, cuts, copies or pastes the library data of the selected code (refer to pages 337 to 338). It is possible to select two or more codes and delete them collectively.

[Goto Code] ... Code number can be specified and the cursor moves to the code. The operation method is same as the “Goto Entry” of memory table (refer to 7-1-6 Table Display Operation by Specifying the Table Entry Number).

[Preview] ...... Switches the preview window ON and OFF (refer to page 337).

[Open] ......... Displays the editing screen (library editor) of the selected code (P343). When two or more codes are selected, edit screens of all the selected codes can be opened collectively.

[New] .......... Registers the new library code to the library table (refer to page 339).

Only the registered library codes are listed on the library table. Press this button when you are going to create new library data.

[Delete] ....... Deletes the library data of the selected code. When two or more codes are selected, they can be deleted collectively.

[Close] ....... Closes the library table dialog.
[Help] ........ Displays Help about the library table dialog box.

- Specifying a code

To specify a code for operations, click on the objective line (library code).
To specify the continuous codes collectively, click on the first code to be selected and then the last code to be selected while pressing the Shift key.
If you click on a code while pressing the Ctrl key, the code will be selected or deselected alternately each time it is clicked.

- Preview Function

Support Tool provides a preview function that can display the contents of the selected code.
When two or more codes are selected, the preview of the code selected last will be displayed in preview window.
The preview window can be switched ON and OFF using the Buttons.

- Deleting the library data

To delete a library data, follow the procedure below. Deleted library data will not be stored to the clipboard and its code itself will be also deleted. When two or more codes are selected, they will be deleted collectively.

The library table is displayed.

2. Select the code of the library data to be deleted.
When two or more codes are selected, they can be deleted collectively.

3. Perform one of the following operations.
   - Edit button → [Delete]
   - Right click on the selected code → [Delete]
   - Delete button
     Selected code will be deleted after you click the Button in the confirmation dialog box.

- Cutting/copying the library data

To cut or copy a library data, follow the procedure below. The cut/copied library data will be stored to the clipboard and can be pasted to the other codes.
In case of “cut,” cut code will be deleted from the library table. In case of “copy,” copied code remains in the library table.
Reference: When two Support Tools are started up by [Import Component] from the [File] menu, the data that is cut or copied on the library table of one Support Tool can be pasted onto the library table of another Support Tool (PT model setting of the two screen data files should be the same). For details, refer to 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool).

(1) Select [Library Editor] from the [Tools] menu. The library table is displayed.

(2) Select the code of the library data to be cut or copied. Select only one code. When two or more codes are selected, cut/copy operation can not be performed.

(3) Click the ![Edit](https://example.com/edit.png) Button or right-click on the selected code.

(4) Select [Cut] or [Copy].

Library data of the selected code will be stored to the clipboard. In case of [cut], confirmation dialog box will be displayed. After clicking on ![Yes](https://example.com/yes.png) button, cut code will be deleted from the library table.

**Pasting the library data**

To paste a library data that is stored in the clipboard by cut or copy operation, follow the procedure below.

Reference: When two Support Tools are started up by [Import Component] from the [File] menu, the data that is cut or copied on the library table of one Support Tool can be pasted onto the library table of another Support Tool (PT model setting of the two screen data files should be the same). For details, refer to 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool).

- If the paste operation is performed, the library data previously registered to the code is overwritten and lost. (Confirmation dialog box will be displayed.)
- When a library data is pasted, the property (size, colors, compression, comment) of the library code is changed to that of the new one.

(1) Select [Library Editor] from the [Tools] menu. The library table is displayed.

(2) Select the code of the library data to be pasted. Select only one code. When two or more codes are selected, paste operation can not be performed.

(3) Click the ![Edit](https://example.com/edit.png) Button or right-click on the selected code.

(4) Select [Paste].

[Paste] can not be selected if the library data to be pasted is not stored in the
clipboard. After clicking the Yes Button in confirmation dialog box, library data will be pasted to the selected code.

- Quitting the library table
You can quit the library table in any of the two ways described below.
  - Clicking the Close Button of the library table dialog.
  - Clicking the X Button at the upper right corner of the library table dialog.

### 8-2-2 Creating Library Data Using Library Editor

- Registering new library data
     The library table is displayed.
  2. Click the New Button.
     The New Library Entry dialog box is displayed.
  3. Set the code, size, colors, compression, comment of the library data to be newly created, then click the OK Button.

- Setting for New Library Entry dialog box
  Code: Specify the code to which the new library data is registered.
When the dialog box is opened, the smallest unused code is set.

**Search Direction:** Unregistered code can be searched using the [Find Next] button. In the Search Direction, specify Up (to the smaller code) or Down (to the larger code) to designate the direction to which search operation is executed.

**Comments:** Specify the comment for the library data to be created.

**Find Next:** Searches the unused code. Specify the search direction in the Search Direction.

### Displaying library editor

1. [Tools] (menu bar) → [Library Editor]
   The library table is displayed.

2. Select the code in the library table and click the [Open] button or double-click the mouse on the objective code line.
   When two or more codes are selected, edit screens (editors) of all the selected codes can be opened collectively. The library table dialog automatically closes at the same time the editor is displayed.

### Changing the property

To change the property of the code that is already registered, open the editor and then display the property dialog of the library data as follows:

- **[Code]:** Displays the code of the selected library data.
- **[Size]:** Displays the size of the specified library data. Size data is not displayed if there are no elements in the library data specifying frame.
- **[Comments]:** Specify the comment for the library data to be created.
Screen Configuration of Library Editor

The screen configuration of the library editor is described below.

Operating the library editor

Using the library editor, you can create a graphic using fixed elements in the same manner as creating graphics in a standard screen. The size of the library data specifying frame is taken as the size of the library data. The position and size of the library data specifying frame can be changed as needed. Only the graphic in the range of the library data specifying frame is registered as the library data.

For details on how to use fixed elements, refer to 6-2 Fixed Display.

Reference: Library data that is cut or copied on the library editor window can be pasted onto the other library editor window or standard editing screen (the data can be pasted until another data is stored to the clipboard). Also, fixed-display elements that were cut or copied from standard editing screens can be pasted onto the library editor window.

When more than one library editor window is displayed or when two Support Tools are opened by [Import Component] from the [File] menu (same PT model setting), cut, copy and paste operations between these library editor windows are possible. For details, refer to 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool).

Changing the size and display position of the library data specifying frame

To change the size of the library data specifying frame or move it, follow the steps described below.
(1) Click the mouse on the dotted lines of the library data specifying frame.

Green ■ (handles) are displayed enclosing the library data specifying frame.

(2) The size can be changed by dragging a handle.

Position the mouse cursor on a green handle: the shape of the mouse cursor changes as shown below. Drag the mouse cursor in the indicated direction to change the size of the library data specifying frame.

(3) The library data specifying frame can be moved by dragging the frame at positions other than handles.

When handles are displayed, position the mouse cursor on the dotted line at a position where there is no handle: the shape of mouse cursor changes as shown below. Drag the mouse. The frame moves as it is dragged.

(4) After changing the size and the position of the library data specifying frame, click on the screen at a position other than on the frame.

The size and the position of the library data specifying frame is determined and the handles are cleared.

To change the size and the position of the library data specifying frame, repeat the procedure above from step (1).

Setting grids

To set a grid on the library editor screen, select [Screen] (menu bar) and [Grid].

The necessary settings for displaying grids are same as those for a standard screen. For details, refer to 5-1-2 Grid Setting.

Quitting the library editor

You can quit the library editor in any of the three ways described below.

- Clicking the Button at the upper right area of the library editor.
- Selecting [Close] from the control menu box of the library editor.
• Double clicking the control menu box of the library editor.
8-3 Mark Editor

Special symbols and marks can be created by tiling selected dots in a $16 \times 16$ dot area. (For NT11S/NT11 it is $8 \times 16$ dot.)

The created mark data can be inserted into mark data displays and character string displays.

**Reference:** The NT-series Support Tool cannot handle marks of $32 \times 32$ dots and $64 \times 64$ dots. If marks created by the DOS version Support Tool are imported, $32 \times 32$ or $64 \times 64$ dot size marks must be represented by dividing and grouping them as $16 \times 16$ dot size mark data.

8-3-1 Screen Configuration

The screen configuration of the mark editor is shown below.

8-3-2 Creating Marks Using the Mark Editor

**Displaying the mark editor**

1. [Tools] (menu bar) → [Mark Editor]

   The mark data list dialog box is displayed.

   In the mark data list dialog box, the mark data registered for the codes are displayed.

2. Select the code in the mark data list dialog box and click on \(\text{OK}\), or double click the area corresponding to the code in the list.
A code can be selected either from the displayed list or by specification in the [Code] field. If a code is selected in the list, the specified part is displayed enlarged.

Operating the mark editor

Using the mark editor, you can create a mark by tiling dots arranged in a matrix. To tile a dot, position the cursor on it and left click the mouse. To cancel tiling, right click the mouse on a tiled dot.

Created graphics can be copied or pasted using the standard toolbar, and lines, rectangles, and circles can be easily created using the drawing toolbar.

Reference: When two Support Tools are started up by [Import Component] from the [File] menu, the data that is cut or copied on the mark editor of one Support Tool can be pasted onto the mark editor of another Support Tool (PT model setting of the two screen data files should be the same). For details, refer to 3-3-6 Importing Components from Different Screen Data File (Starting Up the Second Support Tool).

* Standard toolbar

Redo (operation canceled by undo is executed again)
Undo (previous operation is canceled)
Paste (data that has been copied or cut is pasted)
Copy (graphic in the specified range is copied)
Cut (graphic in the specified range is cut)
Register (mark data is registered)
Open (mark data list dialog box is opened)

* Drawing toolbar

- Toolbar

Used to move the graphic defined by the range specifying frame By positioning the cursor on graphic defined by the range specifying
frame after positioning the cursor on it and dragging, the graphic is moved.

Used to specify the range of a created graphic to copy, cut, or move. By dragging the cursor from one corner to the diagonally opposing corner, the range specifying rectangle frame is defined. To cancel the range specifying frame, select the tools other than

![Range specifying frame](image)

Used to tile dots. After placing the cursor on a dot to be tiled, left click the mouse. To cancel tiling, place the cursor on a tiled dot and right click the mouse.

Used to draw a line. By dragging the mouse cursor from the start point to the end point, dots arranged on a line are tiled.

Used to draw a rectangular frame. By dragging the mouse cursor, the dots on a rectangle that has its diagonally opposing corners at the start and the end point of the dragging route are tiled.

Used to draw a circular or oval frame. By dragging the mouse cursor between two diagonally opposing corners of a rectangle that circumscribes the desired circle or oval frame, the dots on the circle or oval are tiled.

Used to draw a tiled rectangle. By dragging the mouse cursor, the dots inside a rectangle that has its diagonally opposing corners at the start and end point of the dragging route are tiled.

Used to draw a tiled circle or oval. By dragging the mouse cursor between two diagonally opposing corners of a rectangle that circumscribes the desired circle or oval frame, the dots inside the circle or oval are tiled.

Used to move the entire drawn graphic. Drag the edit area and the graphic drawing position moves.
Referring to graphics

The mark editor allows you to refer to or reuse the existing graphics or sample characters to draw desired new marks.

Click on the Reference button and the reference graphic display area is displayed.

To close the reference graphic display area, click on the Reference button again.

- Referring to the existing mark data

To display the existing mark data as reference for creating a new mark, click on the Reference button above the reference graphic display area. The mark data list dialog box is displayed.
Select the data you want to use as the reference in the mark data list dialog box and click on **OK** , or double click the mouse on the desired reference data.

Referring to characters

The mark editor allows you to use the existing characters as the reference for creating characters. Click on **Ch** above the reference graphic display area, and the reference character setting dialog box is displayed.

Input the characters you want to use as the reference and click on **OK** .

For the reference characters, two characters (8 dot size) can be input.

To change the font and/or size of the characters used as the reference, click on **Font** . The character setting dialog box is displayed.

(Presently, the Color setting is not supported. It will be invalid even if it was specified.)
Copying the reference graphics

To reuse the existing graphic displayed in the reference graphic display area, specify the range to be copied and click on the Paste button above the reference graphic display area. After copying the graphic, click on the Copy button above the edit area.

 Quitting the mark editor

To quit the mark editor, click on the [OK] button of the mark editor.
If you click on [Cancel], the created mark data is discarded before you quit the mark editor.
Deleting mark data

To delete the mark data, specify the mark data to be deleted in the mark data list dialog box and click on **Reset**.
SECTION 9

Example Screens

This section is intended to familiarize you with the operation of the Support Tool through actual operation.

The operational procedures for creating example screens are explained step by step.

Please follow the steps shown in this section and create example screens in order to understand the functions and the features of the Support Tool.

Please do not forget to save the screen data frequently. (Refer to 3-3-3 Saving the Screen Data (Application) File.)

The sample screen data to be created in this section is supplied by the CD-ROM version Support Tool.

Use this data to check the setting status etc.

(This data is provided just as a sample screen data. It is not created for the purpose of actual operation on PT after downloading it to PT.)

9-1 Example Screen Configuration 352
   9-1-1 Screen Configuration 352
   9-1-2 Screen Transfer among Example Screens 353
9-2 Operation Flow 357
9-3 Creating the Sample Data 360
   9-3-1 Starting up the Support Tool 360
   9-3-2 File – New 360
   9-3-3 Setting the PT Configuration 360
   9-3-4 Setting Memory Tables 361
   9-3-5 Creating the Menu Screen 363
   9-3-6 Creating the Monitor Screen (Child Screen 1) 367
   9-3-7 Creating the Monitor Screen (Child Screen 2) 373
   9-3-8 Creating the Monitor Screen (Parent Screen) 382
   9-3-9 Creating the Set Screen 382
   9-3-10 Creating the Alarm Screen 394
   9-3-11 Creating the Alarm List Library Data 399
   9-3-12 Creating the Pop-up Display Numeric Keys 400
   9-3-13 Saving the Created Data 404
   9-3-14 Downloading to the PT 404
9-1 Example Screen Configuration

The configuration and screen transfer of the example screens you are going to create are described below.

9-1-1 Screen Configuration

Create the Monitor Screen as overlapping screens comprising screen No. 10 and screen No. 11.
9-1-2 Screen Transfer among Example Screens

How the displayed screen switches according to the button operation is shown below.

Menu Screen

- Monitor Screen button
  Switches the screen to the Monitor Screen (screen No. 2).
- Set Screen button
  Switches the screen to the Set Screen (screen No. 3).
- Alarm Screen button
  Switches the screen to the Alarm Screen (screen No. 4).

Monitor Screen

- Numeral Display 1
  Displays the value of DM0000 in the PC (PLC).
- Numeral Display 2
  Displays the value of 32-bit data, the sum of DM0001 and DM0002 in the PC (PLC).
- Trend graph
  Displays the value of DM0003 and DM0004 in the PC (PLC) in the form of a trend graph.
  Set the –100%, 0%, and 100% values as shown below.

<table>
<thead>
<tr>
<th></th>
<th>value for –100%</th>
<th>value for 0</th>
<th>value for 100%</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM0003</td>
<td>–800</td>
<td>0</td>
<td>800</td>
</tr>
<tr>
<td>DM0004</td>
<td>0</td>
<td>600</td>
<td>1200</td>
</tr>
</tbody>
</table>

- Lamp1 to Lamp 5
  Displays the ON/OFF state of L000000 to L000004 in the PC (PLC).
When L000000 is ON (OFF), Lamp 1 goes ON (OFF).
When L000001 is ON (OFF), Lamp 2 goes ON (OFF).
When L000002 is ON (OFF), Lamp 3 goes ON (OFF).
When L000003 is ON (OFF), Lamp 4 goes ON (OFF).
When L000004 is ON (OFF), Lamp 5 goes ON (OFF).

- **Image Lamp**
  Displays the ON/OFF state of L000005 in the PC (PLC).
  Display when L000005 is ON.

![Image Lamp]

Display when L000005 is OFF.

- **Bar Graph 1**
  Displays the value of DM0005 in the PC (PLC) in the form of a bar graph.
  Set the –100%, 0%, and 100% values as shown below.

<table>
<thead>
<tr>
<th></th>
<th>value for –100%</th>
<th>value for 0</th>
<th>value for 100%</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM0005</td>
<td>–500</td>
<td>0</td>
<td>500</td>
</tr>
</tbody>
</table>

- **Bar Graph 2**
  Displays the value of DM0006 in the PC (PLC) in the form of a bar graph.
  Set the –100%, 0%, and 100% values as shown below.

<table>
<thead>
<tr>
<th></th>
<th>value for –100%</th>
<th>value for 0</th>
<th>value for 100%</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM0006</td>
<td>–300</td>
<td>0</td>
<td>300</td>
</tr>
</tbody>
</table>

- **Menu**
  This is a screen switching button.
  When you touch this button, the screen switches to the Menu Screen (screen No. 1).

- **Set**
  This is a screen switching button.
  When you touch this button, the screen switches to the Set Screen (screen No. 3).

- **Alarm**
  This is a screen switching button.
  When you touch this button, the screen switches to the Alarm Screen (screen No. 4).
Set Screen

- **Numeral Input 1**
  Used to set the data at two words, DM0010 and DM0011, in the PC (PLC). When you touch the numeral display area, numeric keys are displayed (pop-up window), allowing you to input the data.

- **Numeral Input 2**
  Used to set the data at two words, DM0012 and DM0013, in the PC (PLC). When you touch the numeral display area, numeric keys are displayed (pop-up window), allowing you to input the data.

- **Thumbwheel**
  Used to set the data at DM0014 in the PC (PLC).

- **String Display, Auto./Man./Step/Reset**
  When you touch any of the [Auto.], [Man.], [Step], and [Reset] buttons, the following character string is displayed in the [String Display] filed.
  - [Auto.] button: Automatic
  - [Man.] button: Manual
  - [Step] button: Step
  - [Reset] button: Reset

- **Start**
  This is a momentary type button.
  When you touch this button, L000100 in the PC (PLC) goes ON.
  If L000200 in the PC (PLC) goes ON, the button lights.

- **Stop**
  This is a momentary type button.
  When you touch this button, L000101 in the PC (PLC) goes ON.
  If L000201 in the PC (PLC) goes ON, the button lights.

- **Menu**
  This is a screen switching button.
  When you touch this button, the screen switches to the Menu Screen (screen No. 1).

- **Monitor**
  This a screen switching button.
Example Screen Configuration

When you touch this button, the screen switches to the Monitor Screen (screen No. 2).

- Alarm

This is a screen switching button.

When you touch this button, the screen switches to the Alarm Screen (screen No. 4).

**Alarm Screen**

- Alarm list and contents

Allocate 0002000 to 0002007 in the PC (PLC) as alarm bits.

If any of the allocated bits goes ON, the corresponding alarm message is displayed.

When you touch the alarm message, the corrective action and details of the alarm are displayed in the alarm content display area.

<table>
<thead>
<tr>
<th>Bits</th>
<th>Alarm Message</th>
<th>Alarm Content Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>0002000</td>
<td>Line 1 Error</td>
<td>Set line 1.</td>
</tr>
<tr>
<td>0002001</td>
<td>Line 2 Error</td>
<td>Set line 2.</td>
</tr>
<tr>
<td>0002002</td>
<td>A-spot Screw Error</td>
<td>Check torque screw.</td>
</tr>
<tr>
<td>0002003</td>
<td>B-spot Screw Error</td>
<td>Check torque screw.</td>
</tr>
<tr>
<td>0002004</td>
<td>Low Pressure</td>
<td>Check pipe and valve.</td>
</tr>
<tr>
<td>0002005</td>
<td>Area 1 Alarm</td>
<td>Detection near entry. Confirm safety before restarting the line.</td>
</tr>
<tr>
<td>0002006</td>
<td>Area 2 Alarm</td>
<td>Detection near entry. Confirm safety before restarting the line.</td>
</tr>
<tr>
<td>0002007</td>
<td>PC (PLC) Network Error</td>
<td>Check the PC (PLC) and the network.</td>
</tr>
</tbody>
</table>

- Menu

This is a screen switching button.

When you touch this button, the screen switches to the Menu Screen (screen No. 1).

- Monitor

This is a screen switching button.

When you touch this button, the screen switches to the Monitor Screen (screen No. 2).
• Set

This is a screen switching button.

When you touch this button, the screen switches to the Set Screen (screen No. 3).

Required environment

The required hardware environment for the creation of the example screens is shown below.

• PT model: NT620C/625C
• Image memory: 512 Kbytes
• Memory table capacity:
  - Numerical memory table: 512 entries
  - Character string memory table (String table): 256 entries

9-2 Operation Flow

Create the example screens by following the steps shown below.

Start up the Support Tool
↓
[File] – [New]
↓
Set PT configuration
↓
Set memory tables
↓

Creating the Menu Screen

Create new screen (screen No. 1)
↓
Set properties for screen No. 1
↓
Create screen title
↓
Create [Monitor Screen] button
↓
Create [Set Screen] button
↓
Create [Alarm Screen] button
Creating Monitor Screen

- Create new screen (screen No. 10)
- Set properties for screen No. 10
- Create screen title
- Create numeral display field of [Numeral Display 1]
- Create numeral display field of [Numeral Display 2]
- Create [Trend graph]
- Create new screen (screen No. 11)
- Set properties for screen No. 11
- Create [Lamp 1] to [Lamp 5]
- Create image data for image lamp
- Create [Image Lamp]
- Create [Bar Graph 1]
- Create [Bar Graph 2]
- Create [Menu] button
- Create [Set] button
- Create [Alarm] button
- Create parent screen (screen No. 10, 11 as child screens)
Creating the Set Screen

1. Create new screen (screen No. 3)
2. Set properties for screen No. 3
3. Create screen title
4. Create numeral input field of [Numeral Input 1]
5. Create numeral input field of [Numeral Input 2]
6. Create [Thumbwheel]
7. Create [Start] and [Stop] buttons
8. Create [String Display] display field
9. Create [Auto] button
10. Create [Man.] button
11. Create [Step] button
12. Create [Reset] button
13. Create [Menu] button
14. Create [Monitor] button
15. Create [Alarm] button
9-3 Creating the Sample Data

This section describes the operational procedure and data creation procedure step by step according to the operation flow shown in 9-2 Operation Flow.

Reference: The explanation in this section assumes that the default value of each object’s property is not changed since installation.

9-3-1 Starting up the Support Tool

At the start-up screen of Windows, double click the Support Tool icon to start the Support Tool. (Refer to 3-1 Starting-up and Exiting the Support Tool.)

9-3-2 File – New

Select [File] in the main menu, then select [New] to create a new file. (Refer to 3-3-1 Creating New Screen Data (Application) File.)

9-3-3 Setting the PT Configuration

At the PT configuration setting dialog box, set the items as shown below. (Refer to 3-3-1 Creating New Screen Data (Application) File.)
Creating the Sample Data

### Section 9-3

<table>
<thead>
<tr>
<th>PT Type</th>
<th>PT Model</th>
<th>NT620C/625C</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC Vendor</td>
<td>OMRON</td>
<td></td>
</tr>
<tr>
<td>Font Type</td>
<td>CP437</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td>SAMPLE DATA</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>System</th>
<th>Initial Screen</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backlight OFF</td>
<td>Check mark set, 60 min</td>
<td></td>
</tr>
<tr>
<td>Resume function</td>
<td>Check mark not set</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Number of Table Entries</th>
<th>Numerical Table</th>
<th>512</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>String Table</td>
<td>256</td>
</tr>
<tr>
<td></td>
<td>Bit Memory Table</td>
<td>256</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Printer for PT</th>
<th>Printer</th>
<th>ESC/P</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mode</td>
<td>Color</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>History Setting</th>
<th>Alarm (Use Ring Buffer)</th>
<th>Check mark set</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Buzzer</th>
<th>Enable</th>
<th>Check mark set, On Error</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Key Input</td>
<td>Check mark not set</td>
</tr>
</tbody>
</table>

After setting the PT configuration items as indicated above, click on [OK].

### 9-3-4 Setting Memory Tables

Set the memory tables (numerical memory table, character string memory table (string table), and bit memory table). (Refer to Section 7 Memory Table Setting.)

#### Opening a table

(1) Select [Tools] (menu bar) → [Table].

#### Setting numerical memory table

(1) Make the numerical memory table settings as shown below.

<table>
<thead>
<tr>
<th>No.</th>
<th>Value</th>
<th>Initial</th>
<th>Words</th>
<th>PC (PLC) Address</th>
<th>I/O Comments</th>
<th>Ref</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>✔️</td>
<td>1</td>
<td>D00000</td>
<td>Mtr: Num.disp.1</td>
<td>—</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>✔️</td>
<td>2</td>
<td>D00001</td>
<td>Mtr: Num.disp.2</td>
<td>—</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>✔️</td>
<td>1</td>
<td>D00003</td>
<td>Mtr: Trd.graph 1</td>
<td>—</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>✔️</td>
<td>1</td>
<td>D00004</td>
<td>Mtr: Trd.graph 2</td>
<td>—</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>✔️</td>
<td>1</td>
<td>D00005</td>
<td>Mtr: Bar graph 1</td>
<td>—</td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>✔️</td>
<td>1</td>
<td>D00006</td>
<td>Mtr: Bar graph 2</td>
<td>—</td>
</tr>
<tr>
<td>10</td>
<td>0</td>
<td>✔️</td>
<td>2</td>
<td>D00010</td>
<td>Set: Num.input 1</td>
<td>—</td>
</tr>
<tr>
<td>11</td>
<td>0</td>
<td>✔️</td>
<td>2</td>
<td>D00012</td>
<td>Set: Num.input 2</td>
<td>—</td>
</tr>
<tr>
<td>12</td>
<td>0</td>
<td>✔️</td>
<td>1</td>
<td>D00014</td>
<td>Set: Thumbwheel</td>
<td>—</td>
</tr>
</tbody>
</table>

#### Setting character string memory table

(1) Click on [String].
(2) Make the character string memory table settings as shown below.

<table>
<thead>
<tr>
<th>No.</th>
<th>Value</th>
<th>Initial</th>
<th>Words</th>
<th>PC (PLC) Address</th>
<th>I/O Comments</th>
<th>Ref</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Automatic</td>
<td>✓</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Manual</td>
<td>✓</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Step</td>
<td>✓</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Reset</td>
<td>✓</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Line 1 Error</td>
<td>✓</td>
<td>20</td>
<td>D00150</td>
<td>Alarm data 1</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Line 2 Error</td>
<td>✓</td>
<td>20</td>
<td>D00170</td>
<td>Alarm data 2</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>A-spot Screw Error</td>
<td>✓</td>
<td>20</td>
<td>D00190</td>
<td>Alarm data 3</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>B-spot Screw Error</td>
<td>✓</td>
<td>20</td>
<td>D00210</td>
<td>Alarm data 4</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Low Pressure</td>
<td>✓</td>
<td>20</td>
<td>D00230</td>
<td>Alarm data 5</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Area 1 Alarm</td>
<td>✓</td>
<td>20</td>
<td>D00250</td>
<td>Alarm data 6</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Area 2 Alarm</td>
<td>✓</td>
<td>20</td>
<td>D00270</td>
<td>Alarm data 7</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>PC (PLC) Network Error</td>
<td>✓</td>
<td>20</td>
<td>D00290</td>
<td>Alarm data 8</td>
<td></td>
</tr>
</tbody>
</table>

Setting bit memory table

(1) Click on [Bit Memory].

(2) Make the bit memory table settings as shown below.

Click the Button to set the following items.

- Function
- History
- Switch Screen
- String Table Entry
- Image/Library Code
- Color

Click the Button to set the following items.

(Direct input on a bit memory table is also possible.)

- PLC Address
- I/O Comments
Creating the Sample Data

<table>
<thead>
<tr>
<th>No.</th>
<th>Function</th>
<th>Switch Screen</th>
<th>History</th>
<th>String Table Entry</th>
<th>Image/Library Code*1</th>
<th>Color</th>
<th>PC Address</th>
<th>I/O Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Alarm/Switch Screen</td>
<td></td>
<td>20</td>
<td>FA20</td>
<td>White</td>
<td></td>
<td>0002000</td>
<td>Alarm 1</td>
</tr>
<tr>
<td>1</td>
<td>Alarm/Switch Screen</td>
<td></td>
<td>21</td>
<td>FA21</td>
<td>White</td>
<td></td>
<td>0002001</td>
<td>Alarm 2</td>
</tr>
<tr>
<td>2</td>
<td>Alarm/Switch Screen</td>
<td></td>
<td>22</td>
<td>FA22</td>
<td>White</td>
<td></td>
<td>0002002</td>
<td>Alarm 3</td>
</tr>
<tr>
<td>3</td>
<td>Alarm/Switch Screen</td>
<td></td>
<td>23</td>
<td>FA22</td>
<td>White</td>
<td></td>
<td>0002003</td>
<td>Alarm 4</td>
</tr>
<tr>
<td>4</td>
<td>Alarm/Switch Screen</td>
<td></td>
<td>24</td>
<td>FA23</td>
<td>White</td>
<td></td>
<td>0002004</td>
<td>Alarm 5</td>
</tr>
<tr>
<td>5</td>
<td>Alarm/Switch Screen</td>
<td></td>
<td>25</td>
<td>FA24</td>
<td>White</td>
<td></td>
<td>0002005</td>
<td>Alarm 6</td>
</tr>
<tr>
<td>6</td>
<td>Alarm/Switch Screen</td>
<td></td>
<td>26</td>
<td>FA24</td>
<td>White</td>
<td></td>
<td>0002006</td>
<td>Alarm 7</td>
</tr>
<tr>
<td>7</td>
<td>Alarm/Switch Screen</td>
<td></td>
<td>27</td>
<td>FA25</td>
<td>White</td>
<td></td>
<td>0002007</td>
<td>Alarm 8</td>
</tr>
</tbody>
</table>

*1: With NT31, NT31C, NT631, NT631C, set the Alarm for function and unmark the check box for “Switch Screen.”

9-3-5 Creating the Menu Screen

Create the Menu Screen.

Display the data creation window for screen No. 1, which is displayed at the startup of the Support Tool, at the front.

Setting the screen properties

(1) Select [Screen] (menu bar) → [Properties].

(2) Set the screen properties as shown below for screen No. 1. (Refer to 5-1-1 Setting the Screen Attributes.)

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Screen No.</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>History</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Menu Screen</td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>Menu Screen</td>
<td></td>
</tr>
<tr>
<td>Buzzer</td>
<td>✔, Short</td>
<td></td>
</tr>
<tr>
<td>Load Local 1 (Keyboard)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Keypad</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>Background</td>
<td>Black</td>
</tr>
</tbody>
</table>
Creating the Sample Data

Creating the screen title (Menu Screen)

- Setting the characters
  1. Select [Objects] (menu bar) → [Fixed Display] → [Text] (Refer to 6-2-7 Text.)
  2. Click the mouse with the mouse cursor set at the position where the screen title is to be displayed (at the intended upper left corner of text).
  3. Set the properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Menu Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>$2 \times 2$</td>
</tr>
<tr>
<td>Smoothing</td>
<td>✓</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground</td>
</tr>
<tr>
<td></td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>Background</td>
</tr>
<tr>
<td></td>
<td>Transparent</td>
</tr>
</tbody>
</table>

4. Adjust the position of the “Menu Screen” on the data creation screen by dragging it.

- Surrounding the title with a frame
  5. Select [Objects] (menu bar) → [Fixed Display] → [Rectangle]. (Refer to 6-2-3 Rectangle.)
  6. On the data creation screen, drag the rectangle so that it encloses the “Menu Screen” character string.
  7. Use the properties as they are.
  8. Adjust the size and the position of the frame (rectangle).

Creating the [Monitor Screen] button

- Setting the characters
  1. Select [Objects] (menu bar) → [Fixed Display] → [Text] (Refer to 6-2-7 Text.)
  2. Click the mouse with the mouse cursor set at the position where the screen title is to be displayed (at the intended upper left corner of text).
  3. Set the properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Monitor Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>$2 \times 2$</td>
</tr>
<tr>
<td>Smoothing</td>
<td>✓</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground</td>
</tr>
<tr>
<td></td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>Background</td>
</tr>
<tr>
<td></td>
<td>Transparent</td>
</tr>
</tbody>
</table>

4. Adjust the position of the “Monitor Screen” on the data creation screen by dragging it.
• Setting the touch switch outline

(1) Select [Objects] (menu bar) → [Touch Switch]. (Refer to 6-8 Touch Switches.)

(2) Create the outline of the [Monitor Screen] button by dragging the mouse on the data creation screen.

(3) Set the properties as shown below.

<table>
<thead>
<tr>
<th>General</th>
<th>Position</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Size</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Frame</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Shape</td>
<td>3-Dimension</td>
</tr>
<tr>
<td></td>
<td>Show ON State</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Color</td>
<td>Frame: White; ON: White; OFF: Transparent</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Settings</th>
<th>Function</th>
<th>Switch Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen No.</td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

| Light Function | Address | PC (PLC) Address | — |
|                | I/O Comments | — |
| Lamp Attribute | Light |

<table>
<thead>
<tr>
<th>Label*1</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Monitor Screen (Refer to the following)*2</td>
</tr>
</tbody>
</table>

*1: For the NT21 and NT31, NT31C, NT631 and NT631C with “-V2” or later models, multiple lines of label, On Off static label, numeral/string display label can also be set.

*2: Click the Button to set the label. After completing the setting, go to the next step by clicking the Button.

*3: For the NT21 and NT31, NT31C, NT631 and NT631C with “-V2” or later models, it is possible to set an interlock bit that can enable/disable the operations.

• Setting the touch switch label

(4) Press in the general property of a touch switch and set the label properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Monitor Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>2 × 2</td>
</tr>
<tr>
<td>Smoothing</td>
<td>✓</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground: White; Background: Transparent</td>
</tr>
</tbody>
</table>
Click on \( \text{OK} \), (return to touch switch property) then click on \( \text{OK} \) again.

- Adjusting the size and position of the touch switch
  5. Adjust the size and position of the frame of [Monitor Screen] button.
     The label is centralized.

Creating the [Set Screen] button

![Set Screen]

- Copying and pasting the [Monitor Screen] button
  1. Specify the [Monitor Screen] button.
  2. Select [Edit] (menu bar) → [Copy]. (Refer to 6-1-5 Copying, Cutting, Pasting, and Deleting Elements.)
  3. Select [Edit] (menu bar) → [Paste]. (Refer to 6-1-5 Copying, Cutting, Pasting, and Deleting Elements.)
  4. Drag the [Monitor Screen] button, displayed at the upper left area in the data creation screen, to the position where you want to create the [Set Screen] button.

- Modifying to the [Set Screen] button
  5. Double click the moved button and modify the properties as shown below. Note that other properties must be left unchanged.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Label</th>
<th>( \times )</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Description</td>
<td>Set Screen*1</td>
</tr>
<tr>
<td>Settings</td>
<td>Screen No.</td>
<td>3</td>
</tr>
</tbody>
</table>

*1: Press \( \text{Edit} \) to set the label.

Creating the [Alarm Screen] button

![Alarm Screen]

- Copying and pasting the [Monitor Screen] button
  1. Specify the [Monitor Screen] button.
  2. Select [Edit] (menu bar) → [Copy].
  3. Select [Edit] (menu bar) → [Paste].
  4. Drag the [Monitor Screen] button, displayed at the upper left area in the data creation screen, to the position where you want to create the [Alarm Screen] button.

- Modifying to the [Alarm Screen] button
  5. Double click the moved button and modify the properties as shown below. Note that other properties must be left unchanged.
9-3-6 Creating the Monitor Screen (Child Screen 1)

The monitor screen consists of overlapping screens with screen Nos. 10 and 11 as its child screens. When creating overlapping screens, create the child screens first. Here, create screen No. 10 as child screen 1.

(1) Select [Screen] (menu bar) → [New]. (Refer to 4-2-3 Creating a New Screen.)

(2) At the screen selection dialog box, set “Standard Screen.”

(3) At the new standard screen dialog box, set 10 for the screen No.

Setting the screen properties

(1) Select [Screen] (menu bar) → [Properties].

(2) Set the screen properties as shown below for screen No. 10.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Screen No.</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>History</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Monitor Screen-1</td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>Monitor Screen-1</td>
<td></td>
</tr>
<tr>
<td>Buzzer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load Local 1 (Keyboard)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Keypad</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>Background</td>
<td>Black</td>
</tr>
<tr>
<td>Grid</td>
<td>Grid Size</td>
<td>Custom</td>
</tr>
<tr>
<td></td>
<td>Horizontal Spacing: 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vertical Spacing: 5</td>
<td></td>
</tr>
<tr>
<td>Display Grid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Snap to Grid</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating the screen title ([Monitor Screen])
Creating the Sample Data

Creating the Sample Data

- Copying the screen title from screen No. 1 (Menu Screen)
  1. Copy the "Menu Screen" character string and its frame (rectangle) on screen No. 1 and paste them to screen No. 10.
  2. Adjust the display position of the pasted character string and frame to the desired position.

- Modifying to [Monitor Screen]
  3. Double click the "Menu Screen" character string and modify the properties as shown below. Note that other properties must be left unchanged. If selection of the "Menu Screen" character string is not easy, select [Edit] (menu bar) → [Select Object], then click on the fixed display text.

<table>
<thead>
<tr>
<th>Description</th>
<th>Monitor Screen</th>
</tr>
</thead>
</table>

4. Adjust the size of the frame (rectangle).

Creating the data display field ([Numeral Display 1])

![Numeral Display 1]

- Setting the title
  1. Select [Objects] (menu bar) → [Fixed Display] → [Text].
  2. Click the mouse with the mouse cursor set at the position where the numeral display field title is to be displayed (at the intended upper left corner of text).
  3. Set the properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Numeral Display 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>$1 \times 2$ (High)</td>
</tr>
<tr>
<td>Smoothing</td>
<td>✓</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
</tbody>
</table>
| Color       | Foreground: White
               | Background: Transparent |

4. Adjust the position of “Numeral Display 1” on the data creation screen by dragging it.

![Numeral Display 1]

- Creating the numeral display field
  5. Select [Objects] (menu bar) → [Numeral Display]. (Refer to 6-6 Numeral Display.)
(6) Click the mouse with the mouse cursor set at the position where the numeral display field is to be displayed (at the intended upper left corner of numeral display).

(7) Set the properties as shown below.

<table>
<thead>
<tr>
<th>General</th>
<th>Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>$2 \times 2$</td>
</tr>
<tr>
<td>Smoothing</td>
<td>✓</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground White</td>
</tr>
<tr>
<td></td>
<td>Background Black</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Settings</th>
<th>Reference</th>
<th>Indirect Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Table Entry</td>
<td>0</td>
</tr>
<tr>
<td>Display Type</td>
<td>Decimal</td>
<td></td>
</tr>
<tr>
<td>Format</td>
<td>Integer</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Decimal</td>
<td>0</td>
</tr>
<tr>
<td>Zero Suppression</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Display Sign</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

(8) Adjust the position of the numeral display field by dragging it.

- Surrounding the numeral display field with a frame

(9) Select [Objects] (menu bar) → [Fixed Display] → [Rectangle].

(10) On the data creation screen, drag the rectangle so that it encloses the numeral display field.

(11) Use the properties as they are.

(12) Adjust the size and the position of the frame (rectangle).

**Creating the numeral display field ([Numeral Display 2])**

- Copying and pasting the numeral display field ([Numeral Display 1])

(1) Copy the “Numeral Display 1” character string, numeral display field, and its frame (rectangle).

(2) Paste the copied contents and move them to the desired position (for displaying [Numeral Display 2]).

- Modifying to [Numeral Display 2]

(3) Double click the “Numeral Display 1” character string and modify the properties as shown below. Note that other properties must be left unchanged.
Creating the Sample Data

<table>
<thead>
<tr>
<th>Description</th>
<th>Numeral Display 2</th>
</tr>
</thead>
</table>

• Modifying the numeral display field

(4) Double click the numeral display field ([0] displayed) and modify the properties as shown below. Note that other properties must be left unchanged.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Reference</th>
<th>Indirect Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Table Entry</td>
<td>1</td>
</tr>
<tr>
<td>Format</td>
<td>Integer</td>
<td>8</td>
</tr>
<tr>
<td>Decimal</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

(5) Drag the numeral display field ([0]) to the desired display position.

• Modifying the frame

(6) Specify the copied frame (rectangle) and adjust the size and the position.

Creating the trend graph

• Setting the graph

(1) Select [Objects] (menu bar) → [Graph] → [Trend Graph]. (Refer to 6-9-4 Trend Graph.)

(2) At the trend graph display position, drag the mouse to set the trend graph display area as desired.

(3) Set the general properties as shown below.
### General
- **Position:** __
- **Size:** __

<table>
<thead>
<tr>
<th>Display</th>
<th>Type</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing Width</td>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

| Frame |       |          |
| Display Sign |       |          |
| Direction | Right |          |

| Sampling Cycle | 1 *1 |
| Color | Frame | White |
| + Range | Black |          |
| − Range | Black |          |

*1: For NT31, NT31C, NT631, NT631C, sampling cycle of trend graph must be multiple of 5 (minimum 5).

- **Setting the graph line**

  4. Double click the [Settings] tab and click on [Line Property].

  Set the line 1 properties as shown below.

<table>
<thead>
<tr>
<th>Line</th>
<th>Value</th>
<th>Table Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display %</td>
<td></td>
<td>2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Line</th>
<th>Value</th>
<th>Table Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Cyan</td>
<td></td>
</tr>
<tr>
<td>Style</td>
<td>Solid (          )</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>100%</th>
<th>Value</th>
<th>Table Entry</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>0%</th>
<th>Value</th>
<th>Table Entry</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>−100%</th>
<th>Value</th>
<th>Table Entry</th>
</tr>
</thead>
</table>

  5. Click on [OK] to close the line 1 properties.

  6. Click on [Add Line] to add line 2.

  Set the line 2 properties as shown below.

<table>
<thead>
<tr>
<th>Line</th>
<th>Value</th>
<th>Table Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display %</td>
<td></td>
<td>3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Line</th>
<th>Value</th>
<th>Table Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>White</td>
<td></td>
</tr>
<tr>
<td>Style</td>
<td>Dot-dash (          )</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>100%</th>
<th>Value</th>
<th>Table Entry</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>0%</th>
<th>Value</th>
<th>Table Entry</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>−100%</th>
<th>Value</th>
<th>Table Entry</th>
</tr>
</thead>
</table>
Creating the Sample Data

Click on [OK], (returns to setting property) then click on [OK] again.

- Adjusting the size and position of the frame and % display

(7) Specify the trend graph and select [Edit] (menu bar) → [Select Object].

(8) In the list, specify [0%] (Line 1 display %) at the upper right of the trend graph and drag it to the % display position for Data 1.

Reference: Even if elements are overlapped, you can select the desired element easily using the [Select Object] function. For elements such as a trend graph that consist of several elements, use the [Edit Object] function to make element selection easier.

(9) Specify [–100%] (Line 2 display %) at the upper right of the trend graph and drag it to the % display position for Data 2.

(10) Specify the trend graph frame and adjust the size and the position.

- Displaying an example

Create the example of display using fixed display text and straight lines.

(11) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(12) Click the mouse with the mouse cursor positioned at the “Data 1” display position.

(13) Set “Data 1” in the character string setting (Fixed Display – Text) dialog box.

(14) Adjust the “Data 1” display position.

(15) Select [Objects] (menu bar) → [Fixed Display] → [Polyline]. (Refer to 6-2-1 Polyline.)

(16) Drag the mouse cursor in the range (from the start point to the end point) where a line is to be displayed to the left of [Data 1].

Set the line property as shown below.

<table>
<thead>
<tr>
<th>General</th>
<th>Line Style</th>
<th>Solid</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Line Color</td>
<td>Cyan</td>
</tr>
</tbody>
</table>

(17) Specify the drawn line and adjust the length and the position of the line.

(18) Create the example display of “Data 2” in the same manner.

Set the line property as shown below.

<table>
<thead>
<tr>
<th>General</th>
<th>Line Style</th>
<th>Dot-dash</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Line Color</td>
<td>White</td>
</tr>
</tbody>
</table>
9-3-7 Creating the Monitor Screen (Child Screen 2)

Here, create screen No. 11 as child screen 2.

(1) Select [Screen] (menu bar) → [New].
(2) At the screen selection dialog box, set “Standard Screen.”
(3) At the new standard screen dialog box, set 11 for the screen No.

Setting the screen properties

(1) Select [Screen] (menu bar) → [Properties].
(2) Set the screen properties as shown below for screen No. 11.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Screen No.</th>
<th>11</th>
</tr>
</thead>
<tbody>
<tr>
<td>History</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Title</td>
<td>Monitor Screen-2</td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>Monitor Screen-2</td>
<td></td>
</tr>
<tr>
<td>Buzzer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load Local 1 (Keyboard)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Keypad</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>Background</td>
<td>Black</td>
</tr>
<tr>
<td>Grid</td>
<td>Grid Size</td>
<td>Custom</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Horizontal Spacing: 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Vertical Spacing: 5</td>
</tr>
<tr>
<td>Display Grid</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Snap to Grid</td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating the lamps ([Lamp 1] to [Lamp 5])

- Creating the frame of lamp 1

  (1) Select [Objects] (menu bar) → [Lamp] → [Standard]. (Refer to 6-5 Lamps.)

  (2) At the [Lamp 1] display position in the data creation screen, drag the mouse to create the lamp frame.

  In this step, a rectangular frame is created.
(3) Set the properties as shown below.

<table>
<thead>
<tr>
<th>General</th>
<th>Position</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Size</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Frame</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Shape</td>
<td>Circle</td>
</tr>
<tr>
<td></td>
<td>Color</td>
<td>Frame</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ON</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF</td>
</tr>
<tr>
<td>Light</td>
<td>Address</td>
<td>PC (PLC) Bit Address</td>
</tr>
<tr>
<td>Functions</td>
<td></td>
<td>L00000000</td>
</tr>
<tr>
<td></td>
<td>I/O Comment</td>
<td>Lamp 1</td>
</tr>
<tr>
<td></td>
<td>Lamp Attribute</td>
<td>ON Type</td>
</tr>
<tr>
<td>Label*1</td>
<td>Label</td>
<td>✓ Lamp 1 (refer to the following)*2</td>
</tr>
</tbody>
</table>

*1: For the NT21 and NT31, NT31C, NT631 and NT631C with “-V2” or later models, multiple lines of label, On Off static label, numeral/ string display label can also be set.

*2: Click the Edit Button to set the label.
If the I/O comment is already set for the PLC address of light function, clicking the Copy I/O Comments Button copies the label.

After completing the setting, go to the next step with clicking the OK Button.

- Setting the label for lamp 1

(4) Press Edit in the general property of a lamp and set the label properties as shown below.

<table>
<thead>
<tr>
<th>Comment</th>
<th>Lamp 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>$1 \times 2$ (High)</td>
</tr>
<tr>
<td>Smoothing</td>
<td>✓</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground White</td>
</tr>
<tr>
<td></td>
<td>Background Transparent</td>
</tr>
</tbody>
</table>

Click on OK, (returns to lamp property) then click on OK again.

Reference: With the NT21, NT31, NT31C, NT631, and NT631C, “Color: ON” and “Color: OFF” can be set independently for a label so that the lamp can be displayed in different colors in the ON and OFF states.
Creating the Sample Data

Section 9-3

- Adjusting the size and position of the lamp

(5) Specify the “Lamp 1.”

   For methods of specifying an element consisting of multiple elements, refer to 6-1-3 Selecting an Element.

(7) Specify the “Lamp 1” and adjust the size and position of the lamp frame.

(8) Adjust the position of the “Lamp 1” character string by dragging it.

Creating lamp 2

(9) Copy [Lamp 1] and paste it onto the data creation screen.


(11) Double click the mouse on the pasted [Lamp 1] and modify the properties as shown below. Note that the properties not shown here must be left unchanged.

<table>
<thead>
<tr>
<th>Light Functions</th>
<th>Address</th>
<th>PC (PLC) Bit Address</th>
<th>L0000001</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Label</td>
<td>I/O Comment</td>
<td>Lamp 2</td>
</tr>
</tbody>
</table>

*1: Press to set the label.
   If the I/O comment is already set for the PLC address of light function, clicking on button copies the label.

(12) Create [Lamp 3], [Lamp 4], and [Lamp 5] in the same manner.

(13) Modify the properties as shown below meeting the individual lamps.

| Lamp 3 |  
|--------|--------|--------|
| Light Functions | Address | PC (PLC) Bit Address | L0000002 |
| Label | Label | I/O Comment          | Lamp 3 |

*1: Press to set the label.
   If the I/O comment is already set for the PLC address of light function, clicking on button copies the label.

Creating the image/library lamp image data

Create two kinds of image data for the image/library lamp.

Create the image data for codes FE20 and FE21.
(1) Select [Tools] (menu bar) → [Image Editor].
(2) Click on 

(3) Set the properties as shown below and click on 

<table>
<thead>
<tr>
<th>Code</th>
<th>FE20</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Width 64</td>
</tr>
<tr>
<td></td>
<td>Height 48</td>
</tr>
<tr>
<td>Mode</td>
<td>8 Colors</td>
</tr>
<tr>
<td>Compression</td>
<td></td>
</tr>
</tbody>
</table>

(4) Click on 

(5) Close the image editor.
(6) Call the image editor again and create the image data for code FE21.

Reference: It is possible to copy image data FE20 onto FE21 on the image table so that it can be reused. Follow the procedure below.

a. Click on and register the code FE21 (Properties other than code need not be changed).

b. Specify FE20 and select [Copy] by pressing button.

c. Specify FE21 and select [Paste] by pressing button.

Creating the [Image Lamp]

- Creating the title

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(2) Click the mouse with the mouse cursor set at the position where the label "Image Lamp" is to be displayed.

(3) Set the properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Image Lamp</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>2 × 2</td>
</tr>
<tr>
<td>Smoothing</td>
<td></td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground White</td>
</tr>
<tr>
<td></td>
<td>Background Transparent</td>
</tr>
</tbody>
</table>
Creating the Sample Data

(4) Adjust the position of "Image Lamp" character string on the data creation screen by dragging it.

- Setting the image/library lamp

(5) Select [Objects] (menu bar) → [Lamp] → [Image].

(6) Click the mouse with the mouse cursor set at the position where the image/library lamp is to be displayed (at the intended upper left corner).

(7) Set a check mark in the check box of the [Code] for OFF, in General, and click on [Change].

(8) In the image table, specify "FE20" and click on [OK].

(9) Set a check mark in the check box of the [Code] for ON, in General, and click on [Change].

(10) In the image table, specify "FE21" and click on [OK].

(11) Set the lamp function properties as shown below.

<table>
<thead>
<tr>
<th>Light Functions</th>
<th>Address</th>
<th>PC (PLC) Bit Address</th>
<th>L0000005</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Comment</td>
<td>Image Lamp</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(12) Adjust the display position of the image/library lamp.

Reference: With the NT21, NT31, NT31C, NT631, and NT631C, codes assigned to image data are from 0001 to 0FFF. However, if NT20/30/620-compatible mode is used with the NT21, NT31, NT31C, NT631, and NT631C, the image code will be the same as NT30, NT30C, NT620S, NT620C and NT625C.

Creating [Bar Graph 1] and [Bar Graph 2]

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(2) Click the mouse with the mouse cursor set at the position where the character string of [Bar Graph 1] is to be displayed (at the intended upper left corner of bar graph).

(3) Set the properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Bar Graph 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>1 × 2 (High)</td>
</tr>
<tr>
<td>Smoothing</td>
<td>✓</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground</td>
</tr>
<tr>
<td></td>
<td>Background</td>
</tr>
</tbody>
</table>
(4) Adjust the position of “Bar Graph 1” character string on the data creation screen by dragging it.

Creating the bar graph frame

(5) Select [Objects] (menu bar) → [Graph] → [Bar Graph]. (Refer to 6-9-1 Bar Graph.)

(6) Drag the mouse cursor at the position where bar graph 1 is to be displayed (drag between diagonally opposing corners) to create the frame of [Bar Graph 1].

(7) Set the properties as shown below.

<table>
<thead>
<tr>
<th>General</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Size</td>
<td>—</td>
</tr>
<tr>
<td>Frame</td>
<td>✓</td>
</tr>
<tr>
<td>Display Sign</td>
<td>✓</td>
</tr>
<tr>
<td>Direction</td>
<td>Right</td>
</tr>
<tr>
<td>Color</td>
<td>Frame: White, + Range: White, – Range: White</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Settings</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Table Entry: 4</td>
</tr>
<tr>
<td>Display %</td>
<td></td>
</tr>
<tr>
<td>100%</td>
<td>Table Entry</td>
</tr>
<tr>
<td>Display %</td>
<td></td>
</tr>
<tr>
<td>0%</td>
<td>Table Entry</td>
</tr>
<tr>
<td>Display %</td>
<td></td>
</tr>
<tr>
<td>–100%</td>
<td>Table Entry</td>
</tr>
<tr>
<td>Display %</td>
<td></td>
</tr>
</tbody>
</table>

Setting the % display

(8) After specifying the bar graph, select [Edit] (menu bar) → [Edit Object].

(9) Double click on [0%] and set the properties as shown below.

<table>
<thead>
<tr>
<th>Position</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>1 × 2 (High)</td>
</tr>
<tr>
<td>Smoothing</td>
<td></td>
</tr>
<tr>
<td>Attribute</td>
<td>—</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground: White, Background: Black</td>
</tr>
</tbody>
</table>

Adjusting the size and position of bar graph frame and % display
(10) Specify [0\%] at the upper left of the trend graph and drag it to the % display position.

(11) Specify the bar graph frame and adjust the size and position of bar graph frame.

![Bar Graph 2](image)

- Creating bar graph 2

(12) Specify all of label, bar graph frame, and % display of [Bar Graph 1] and copy and paste them onto the data creation screen.

(13) Move the pasted bar graph 1 element, which was pasted at the upper left area in the data creation screen, to the position of [Bar Graph 2].

(14) Double click the label “Bar Graph 1,” which has been moved to the bar graph 2 position, and modify the properties as shown below.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Value</th>
<th>Table Entry</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display %</td>
<td>100%</td>
<td>Table Entry</td>
<td>300</td>
</tr>
<tr>
<td>Display %</td>
<td>0%</td>
<td>Table Entry</td>
<td>0</td>
</tr>
<tr>
<td>Display %</td>
<td>–100%</td>
<td>Table Entry</td>
<td>–300</td>
</tr>
</tbody>
</table>

Creating the [Menu] button, [Set] button, and [Alarm] button

![Switch Screen](image)

- Creating the [Menu] button frame

(1) Select [Objects] (menu bar) → [Touch Switch]

(2) Create the [Menu] button frame by dragging the mouse at the button display position.

(3) Set the properties as shown below.
Creating the Sample Data

### Section 9-3

<table>
<thead>
<tr>
<th>General</th>
<th>Position</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Frame</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Shape</td>
<td>3-Dimension</td>
<td></td>
</tr>
<tr>
<td>Show ON State</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>Frame</td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>ON</td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>OFF</td>
<td>Transparent</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Settings</th>
<th>Function</th>
<th>Switch Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen No.</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Light Function</th>
<th>Address</th>
<th>PC (PLC) Address</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lamp Attribute</td>
<td>Attribute</td>
<td>Light</td>
<td>—</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Label</th>
<th>Label</th>
<th>✓, Menu (refer to the following)</th>
</tr>
</thead>
</table>

---

*1: Press to set the label.
After completing the setting, go to the next step without clicking on button.

- Setting the label of [Menu] button
  (4) Press in the general property of a touch switch and set the label properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>$1 \times 1$ (Equal)</td>
</tr>
<tr>
<td>Smoothing</td>
<td>—</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground</td>
</tr>
<tr>
<td></td>
<td>Background</td>
</tr>
</tbody>
</table>

**Reference:** With the NT21, NT31, NT31C, NT631 and NT631C, “Color: ON” and “Color: OFF” can be set independently for a label so that the lamp can be displayed in different colors in the ON and OFF states.

Click on , (returns to touch switch property) then click on again.

- Adjusting the size and position of the touch switch
  (5) Specify the [Menu] button and select [Edit] (menu bar) → [Edit Object].
  (6) Adjust the size and position of [Menu] button frame.
  (7) Adjust the position of label “Menu” by dragging it.

---

380
Creating the Sample Data

• Creating the [Set] button

(8) Copy the [Menu] button and paste it on the screen.

(9) Move the [Menu] button pasted at the upper left area of the screen to the [Set] button position.

(10) Double click the moved button and modify the properties as shown below. Note that other properties must be left unchanged.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Screen No.</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Label</td>
<td>✓, Set *1</td>
</tr>
</tbody>
</table>

*1: Press [Edit] to set the label.

(11) Create the [Alarm] button in the same manner. Modify [Alarm] button properties as shown below.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Screen No.</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Label</td>
<td>✓, Alarm *1</td>
</tr>
</tbody>
</table>

*1: Press [Edit] to set the label.

• Creating the frame

(12) Select [Objects] (main menu) → [Fixed Display] → [Rectangle].

(13) Drag the mouse so that the rectangular frame encloses the three buttons.

(14) Use the properties as they are.

(15) Adjust the size and the position of the frame (rectangle).

• Setting the [Switch Screen] character string

(16) Select [Objects] (main menu) → [Fixed Display] → [Text]

(17) Click the mouse with the mouse cursor set at the position where the [Switch Screen] character string is to be displayed (at the intended upper left corner).

(18) Set the properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Switch Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>1 × 1 (Equal)</td>
</tr>
<tr>
<td>Smoothing</td>
<td>✓</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color Foreground</td>
<td>White</td>
</tr>
<tr>
<td>Color Background</td>
<td>Black</td>
</tr>
</tbody>
</table>

(19) Adjust the position of the “Switch Screen” character string on the data creation screen by dragging it.
(20) Specify the “Switch Screen” character string, then select [Draw] (menu bar) → [Bring to Front]. (For details of Moving an overlapped element to the front or back, refer to 6-1-5 Copying, Cutting, Pasting, and Deleting Elements.) The “Switch Screen” character string is brought to the front of the frame.

**Reference:** The positional relationship in the display of the same kind of elements, such as among fixed display elements, can be controlled by selecting [Draw] → [Bring to Front] or [Send to Back].

### 9-3-8 Creating the Monitor Screen (Parent Screen)

Register screens No. 10 and No. 11 as child screens of screen No. 2. Screen No. 2 is regarded as a parent screen of overlapping screens. (Refer to 5-3-2 Overlapping Screens.)

![Monitor Screen Image](image)

(1) Select [Screen] (menu bar) → [New].

(2) In the screen type designation dialog box, select the Parent Screen and click on **OK**.

(3) In the setting dialog box of a parent screen, set the displayed items as shown below.

<table>
<thead>
<tr>
<th>Parent Screen</th>
<th>Screen No.</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Overlapping</td>
<td></td>
</tr>
</tbody>
</table>

(4) Specify 10 in the standard screen box and click on **Insert>>**.

(5) Specify 11 in the standard screen box and click on **Insert>>**.

(6) Click on **OK**.

### 9-3-9 Creating the Set Screen

Create screen No. 3 (new screen) as the Set Screen.

![Set Screen Image](image)
(1) Select [Screen] (menu bar) → [New].
(2) At the screen selection dialog box, set “Standard Screen.”
(3) At the new standard screen dialog box, set 3 for the screen No.

Setting the screen properties

(1) Select [Screen] (menu bar) → [Properties].
(2) Set the screen properties as shown below for screen No. 3.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Screen No.</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>History</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Title</td>
<td>Set Screen</td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>Set Screen</td>
<td></td>
</tr>
<tr>
<td>Buzzer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load Local 1 (Keyboard)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Keypad</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>Background</td>
<td>Black</td>
</tr>
<tr>
<td>Grid</td>
<td>Grid Size</td>
<td>Custom</td>
</tr>
<tr>
<td></td>
<td>Horizontal Spacing: 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vertical Spacing: 5</td>
<td></td>
</tr>
<tr>
<td>Display Grid</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Snap to Grid</td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>

Creating the screen title ([Set Screen])

- Copying the screen title from screen No. 1 (Menu Screen)
  (1) Copy the "Menu Screen" character string and its frame (rectangle) on screen No. 1 and paste them onto screen No. 3.
  (2) Adjust the display position of the pasted character string and frame to the desired position.
- Modifying to [Set Screen]
  (3) Double click the "Menu Screen" character string and modify the properties as shown below. Note that other properties must be left unchanged.

<table>
<thead>
<tr>
<th>Description</th>
<th>Set Screen</th>
</tr>
</thead>
</table>

(4) Adjust the size of the frame (rectangle).

Creating the data input field ([Numeral Input 1])
Creating the Sample Data

- Setting the title

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(2) Click the mouse with the mouse cursor set at the position where the data display field title is to be displayed (at the intended upper left corner).

(3) Set the properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Numeral Input 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>---</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>$1 \times 2$ (High)</td>
</tr>
<tr>
<td>Smoothing</td>
<td></td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground White</td>
</tr>
<tr>
<td></td>
<td>Background Transparent</td>
</tr>
</tbody>
</table>

(4) Adjust the position of “Numeral Input 1” on the data creation screen by dragging it.

- Creating the data input field

(5) Select [Objects] (menu bar) → [Data Input] → [Numeral]. (Refer to 6-4-1 Numerical Input.)

(6) Click the mouse with the mouse cursor set at the position where the data input field is to be displayed (at the intended upper left corner).

(7) At the cursor moving touch switch use selection dialog box, set the displayed items as shown below.

Create Cursor Move Touch Switch

- Setting the numeral input field

(8) Set the properties as shown below.

<table>
<thead>
<tr>
<th>General</th>
<th>Position</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font Type</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Scale</td>
<td>$2 \times 2$</td>
<td></td>
</tr>
<tr>
<td>Smoothing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>Foreground White</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Background Black</td>
<td></td>
</tr>
</tbody>
</table>
Settings | Table Entry | 10
--- | --- | ---
Display Type | | Decimal
Format | Integer | 8
 | Decimal | 0
Limit | Maximum | 99999999
 | Minimum | 0
Zero Suppression | | |
Display Sign | | |
Focus Frame | | |
Focus Attribute | | Standard

*1: For the NT21 and NT31, NT31C, NT631 and NT631C with “-V2” or later models, it is possible to set an interlock bit that can enable/disable the operations.

- Setting the cursor moving touch switch

(9) Double click on the touch switch area (dotted line frame) created at the numeral input field position and set the properties as shown below.
If selection of the touch switch is not easy, choose [Select Object] from the [Edit] menu and select the touch switch from the list.

| General | Position | — |
| Frame | — |
| Shape | Standard |
| Show ON State | |
| Color | Frame | White |
| | ON | White |
| | OFF | Transparent |

| Settings | Function | Cursor Move |
| Use Window/Keyboard Screen | |
| Screen No. | 1900 |
| Auto Arrange | |

| Light Function | Address | PC (PLC) Address | — |
| | I/O Comments | — |
| Lamp Attribute | Light |

Label | Label |

*1: Uncheck the check mark for “Auto Arrange.” Otherwise, it is not possible to change the position of each numeral input and touch switch.

*2: For the NT21 and NT31, NT31C, NT631 and NT631C with “-V2” or later models, it is possible to set an interlock bit that can enable/disable the operations.
Adjusting the size and position of numeral input 1 input field and the touch switch

(10) Specify only the touch switch area and adjust the size and the position.
(11) Specify only the numeral input field and adjust the size and the position.

Creating the numeral input field ([Numeral Input 2])

Copying and pasting the numeral input field ([Numeral Input 1])

(1) Copy “Numeral Input 1” character string, numeral display field, and touch switch and paste them to the data creation screen.
(2) Move the character string, numeral display field, and touch switch pasted at the upper left area of the screen to the desired position (for displaying [Numeral Input 2]).
(3) Double click the “Numeral Input 1” character string and modify the properties as shown below. Note that other properties must be left unchanged.

<table>
<thead>
<tr>
<th>Description</th>
<th>Numeral Input 2</th>
</tr>
</thead>
</table>

(4) Double click the data input field ([ 0 ] displayed) and modify the properties as shown below. Note that other properties must be left unchanged.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Table Entry</th>
<th>11</th>
</tr>
</thead>
</table>

Creating the thumbwheel switch

Creating the title

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text].
(2) Click the mouse with the mouse cursor set at the position where the title is to be displayed (at the intended upper left corner of text).
(3) Set the properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Thumbwheel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>1 × 2 (High)</td>
</tr>
<tr>
<td>Smoothing</td>
<td></td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground</td>
</tr>
<tr>
<td></td>
<td>Background</td>
</tr>
</tbody>
</table>
(4) Adjust the position of the Thumbwheel on the data creation screen by dragging it.

- Creating the thumbwheel switch

(5) Select [Objects] (menu bar) → [Data Input] → [Thumbwheel Switch]. (Refer to 6-4-3 Thumbwheel Switch.)

(6) Click the mouse with the mouse cursor set at the position where the thumbwheel switch is to be displayed (at the intended upper left corner of thumbwheel).

(7) Set the properties as shown below.

<table>
<thead>
<tr>
<th>General</th>
<th>Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Medium</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>End Plate</td>
<td>✔</td>
</tr>
<tr>
<td>Thumbwheel Color</td>
<td>Frame White</td>
</tr>
<tr>
<td></td>
<td>Foreground White</td>
</tr>
<tr>
<td></td>
<td>Background Black</td>
</tr>
<tr>
<td>Character Color</td>
<td>Foreground White</td>
</tr>
<tr>
<td></td>
<td>Background Black</td>
</tr>
<tr>
<td>Settings</td>
<td>Table Entry</td>
</tr>
<tr>
<td>Display Type</td>
<td>Decimal</td>
</tr>
<tr>
<td>Format</td>
<td>Integer 4</td>
</tr>
<tr>
<td></td>
<td>Decimal 0</td>
</tr>
<tr>
<td>Limit</td>
<td>Maximum 999</td>
</tr>
<tr>
<td></td>
<td>Minimum F0009999</td>
</tr>
<tr>
<td>Display sign</td>
<td>✔</td>
</tr>
</tbody>
</table>

*1: For the NT21 and NT31, NT31C, NT631 and NT631C with “-V2” or later models, it is possible to set an interlock bit that can enable/disable the operations.

(8) Adjust the position of the thumbwheel switch on the data creation screen by dragging it.

Creating the [Start] button and the [Stop] button
Creating the Sample Data

Creating the [Start] button frame

(1) Select [Objects] (menu bar) → [Touch Switch]

(2) Create the [Start] button frame by dragging the mouse at the button display position.

(3) Set the properties as shown below.

<table>
<thead>
<tr>
<th>General</th>
<th>Position</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Size</td>
<td>—</td>
</tr>
<tr>
<td>Label</td>
<td>Start (refer to the following) *1</td>
<td></td>
</tr>
<tr>
<td>Frame</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shape</td>
<td>Shadow</td>
<td></td>
</tr>
<tr>
<td>Show ON State</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>Frame White</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ON White</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OFF Transparent</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Settings</th>
<th>Function</th>
<th>Notify Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>PC (PLC) Address L0000100</td>
<td></td>
</tr>
<tr>
<td>I/O Comments</td>
<td>Start Switch</td>
<td></td>
</tr>
<tr>
<td>Action Type</td>
<td>Momentary</td>
<td></td>
</tr>
</tbody>
</table>

| Light Function | Address | PC (PLC) Address L0000200 |
| Lamp Attribute | General Light |

*1: Press to set the label.

After completing the setting, go to the next step without clicking on button.

(4) Press in the general property of a touch switch and set the label properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Start</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>1 × 2 (High)</td>
</tr>
<tr>
<td>Smoothing</td>
<td></td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground White</td>
</tr>
<tr>
<td></td>
<td>Background Black</td>
</tr>
</tbody>
</table>

Click on , (returns to touch switch property) then click on again.

• Adjusting the size and position of [Start] button

(5) Specify the [Start] button and select [Edit] (menu bar) → [Edit Object].

(6) Adjust the size and position of [Start] button frame.
Creating the Sample Data

(7) Adjust the position of the label "Start" by dragging it.

- Creating the [Stop] button

(8) Copy the [Start] button and paste it on the data creation screen.

(9) Move the [Start] button pasted at the upper left area of the screen to the [Stop] button position.

(10) Double click the moved button and modify the properties as shown below. Note that other properties must be left unchanged.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Address</th>
<th>PC (PLC) Address</th>
<th>L0000101</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Comments</td>
<td>Stop Switch</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Light Function</th>
<th>Address</th>
<th>PC (PLC) Address</th>
<th>L0000201</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Comments</td>
<td>Stop lamp</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Label</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(\therefore), Stop *1</td>
</tr>
</tbody>
</table>

*1: Press \(\therefore\) to set the label.

Creating the character string display field ([String Display])

- Setting the title

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(2) Click the mouse with the mouse cursor set at the position where the "String Display" character string is to be displayed (at the intended upper left corner of text).

(3) Set the properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>String Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>___</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>(1 \times 2) (High)</td>
</tr>
<tr>
<td>Smoothing</td>
<td>(\therefore)</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground (\therefore) White</td>
</tr>
<tr>
<td></td>
<td>Background (\therefore) Black</td>
</tr>
</tbody>
</table>

(4) Adjust the position of the “String Display” on the data creation screen by dragging it.
• Creating the character string display field

(5) Select [Objects] (menu bar) → [String Display].

(6) Click the mouse with the mouse cursor set at the position where the character string display field is to be displayed (at the intended upper left corner of string display field).

(7) Set the properties as shown below.

<table>
<thead>
<tr>
<th>General</th>
<th>Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>1 × 2 (High)</td>
</tr>
<tr>
<td>Smoothing</td>
<td>/</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground White</td>
</tr>
<tr>
<td></td>
<td>Background Black</td>
</tr>
<tr>
<td>Settings</td>
<td>Reference</td>
</tr>
<tr>
<td></td>
<td>Indirect</td>
</tr>
<tr>
<td></td>
<td>Reference</td>
</tr>
<tr>
<td></td>
<td>Table Entry 0</td>
</tr>
<tr>
<td>Length</td>
<td>20</td>
</tr>
</tbody>
</table>

(8) Adjust the position of the character string display field by dragging it.

• Creating the character string display field frame

(9) Select [Objects] (menu bar) → [Fixed Display] → [Rectangle].

(10) On the data creation screen, drag the rectangle so that it encloses the character string display field.

(11) Use the properties as they are.

(12) Adjust the size and the position of the frame (rectangle).

Creating the [Auto] button, [Man.] button, [Step] button, and [Reset] button

• Creating the [Auto] button frame

(1) Select [Objects] (menu bar) → [Touch Switch]

(2) Create the [Auto] button frame by dragging the mouse at the button display position.

(3) Set the properties as shown below.
Creating the Sample Data

### General

<table>
<thead>
<tr>
<th>Position</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>—</td>
</tr>
</tbody>
</table>

#### Frame

<table>
<thead>
<tr>
<th>Shape</th>
<th>Shadow</th>
</tr>
</thead>
</table>

#### Show ON State

<table>
<thead>
<tr>
<th>Color</th>
<th>ON Frame</th>
<th>ON White</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>OFF Translucent</td>
<td></td>
</tr>
</tbody>
</table>

### Settings

#### Function

<table>
<thead>
<tr>
<th>Copy From</th>
<th>Copy Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeral Table</td>
<td></td>
</tr>
<tr>
<td>String Table</td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td></td>
</tr>
<tr>
<td>Entry (Text Box)</td>
<td>10</td>
</tr>
</tbody>
</table>

#### Copy To

| Numeral Table | |
| String Table | |
| Cursor Position | |
| Entry (Text Box) | 0 |

#### Light Function

<table>
<thead>
<tr>
<th>Address</th>
<th>PC (PLC) Address</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Comments</td>
<td>—</td>
<td></td>
</tr>
</tbody>
</table>

#### Lamp Attribute

<table>
<thead>
<tr>
<th>On Type</th>
<th>Light</th>
</tr>
</thead>
</table>

#### Label

<table>
<thead>
<tr>
<th>Label</th>
<th>Label</th>
</tr>
</thead>
</table>

*1: Press \[ \text{Edit} \] to set the label.

After completing the setting, go to the next step without clicking on \[ \text{OK} \] button.

• Setting the label of [Auto] button

(4) Press \[ \text{Edit} \] in the general property of a touch switch and set the label properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Auto</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>[ 1 \times 2 ) (High)</td>
</tr>
<tr>
<td>Smoothing</td>
<td>—</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground White</td>
</tr>
<tr>
<td></td>
<td>Background Black</td>
</tr>
</tbody>
</table>

Click on \[ \text{OK} \], (returns to touch switch property) then click on \[ \text{OK} \] again.

• Adjusting the size and position of [Auto] button

(5) Specify the [Auto] button and select [Edit] (menu bar) → [Edit Object].

391
(6) Adjust the size and position of [Start] button frame.
(7) Adjust the position of the label “Auto” by dragging it.

- Creating the [Man.] button
  (8) Copy the [Auto] button and paste it onto the data creation screen.
  (9) Move the [Auto] button pasted at the upper left area of the screen to the [Man.] button position.
  (10) Double click the moved button and modify the properties as shown below. Note that other properties must be left unchanged.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Copy From</th>
<th>Numeral Table</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>String Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Code</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Entry (Text Box)</td>
</tr>
<tr>
<td>Label</td>
<td>Label</td>
<td>✓, Man. *1</td>
</tr>
</tbody>
</table>

*1: Press to set the label.

- Creating the [Step] button and the [Reset] button
  (11) Create the [Step] button and the [Reset] button in the same manner as the [Man.] button.
  For the [Step] button and the [Reset] button, change the properties as shown below.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Copy From</th>
<th>Numeral Table</th>
<th>[Step] button</th>
<th>[Reset] button</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>String Table</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Code</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Entry (Text Box)</td>
<td>12</td>
<td>13</td>
</tr>
<tr>
<td>General</td>
<td>Label</td>
<td>✓, Step</td>
<td>✓, Reset</td>
<td></td>
</tr>
</tbody>
</table>

- Creating the button group title bar
  (12) Select [Objects] (menu bar) → [Fixed Display] → [Polyline].
  (13) While pressing the shift key, drag the polyline from start point to the second vertex, and then from the second vertex to the third vertex. Repeat this procedure to create the desired form. Release the Shift key just before reaching at the last point.
**Reference:** To draw continuous polyline, press shift key when drag operation is finished. Dragging this end point creates continuous polyline.

(14) Use the properties as they are.

- Creating the “Select” character string

(15) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(16) Click the mouse with the mouse cursor set at the position where the “Select” character string is to be displayed (at the intended upper left corner of text).

In the character string setting (Fixed Display-text) dialog box, set “Select.”

(17) Set the properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>$1 \times 1$ (Equal)</td>
</tr>
<tr>
<td>Smoothing</td>
<td>$\checkmark$</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground: White, Background: Black</td>
</tr>
</tbody>
</table>

(18) Adjust the position of the “Select” character string on the data creation screen by dragging it.

(19) Specify the “Select” character string, then select [Draw] (menu bar) → [Bring to Front].

The “Select” character string is brought to the front of the title bar.

### Creating the [Menu] button, [Monitor] button, and [Alarm] button

- Copying and pasting the buttons from screen No. 11

(1) Copy the “Switch Screen” character string, frame (rectangle), [Menu] button, [Set] button, and [Alarm] button collectively and paste them to screen No. 3.

(2) Adjust the display position of the pasted character string, frame (rectangle), and buttons.

- Modifying to the [Monitor] button

(3) Double click the [Set] button and change the properties as shown below. Note that other properties must be left unchanged.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Screen No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Label</td>
</tr>
</tbody>
</table>
9-3-10 Creating the Alarm Screen

Create screen No. 4 (new screen) as the Alarm Screen.

(1) Select [Screen] (menu bar) → [New].
(2) At the screen selection dialog box, set “Standard Screen.”
(3) At the new standard screen dialog box, set 4 for the screen No.

Setting the screen properties

(1) Select [Screen] (menu bar) → [Properties].
(2) Set the screen properties as shown below for screen No. 4.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Screen No.</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>History</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Alarm Screen</td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>Alarm Screen</td>
<td></td>
</tr>
<tr>
<td>Buzzer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load Local 1 (Keyboard)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Keypad</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>Background</td>
<td>Black</td>
</tr>
<tr>
<td>Grid</td>
<td>Grid Size</td>
<td>Custom</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Horizontal Spacing: 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Vertical Spacing: 5</td>
</tr>
<tr>
<td>Display Grid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Snap to Grid</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating the screen title ([Alarm Screen])

* Copying the screen title from screen No. 1 (Menu Screen)

(1) Copy the “Menu Screen” character string and its frame (rectangle) on screen No. 1 and paste them onto screen No. 4.
Creating the Sample Data

(2) Adjust the display position of the pasted character string and frame to the desired position.

- Modifying to [Alarm Screen]

(3) Double click the “Menu Screen” character string and modify the properties as shown below. Note that other properties must be left unchanged.

<table>
<thead>
<tr>
<th>Description</th>
<th>Alarm Screen</th>
</tr>
</thead>
</table>

(4) Adjust the size of the frame (rectangle).

Creating the alarm list

![Alarm List]

- Setting the title

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(2) Click the mouse with the mouse cursor set at the position where the “Alarm List” character string is to be displayed (at the intended upper left corner of text).

(3) Set the properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Alarm List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>—</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>$1 \times 1$ (Equal)</td>
</tr>
<tr>
<td>Smoothing</td>
<td>✔</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground</td>
</tr>
<tr>
<td></td>
<td>Background</td>
</tr>
</tbody>
</table>

(4) Adjust the position of the “Alarm List” character string on the data creation screen by dragging it.
• Creating the alarm list

(5) Select [Objects] (menu bar) → [Alarm] → [List]. (Refer to 6-3-1 Alarm List.)

(6) Click the mouse with the mouse cursor set at the position where the alarm list is to be displayed (at the intended upper left corner).

(7) Make the following settings in the dialog box for selecting whether or not the line scroll touch switches and page scroll touch switches are used.

<table>
<thead>
<tr>
<th>Create Line Scroll Touch Switch</th>
<th>✔</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Page Scroll Touch Switch</td>
<td>✔</td>
</tr>
</tbody>
</table>

Reference: For NT21, NT31, NT31C, NT631, and NT631C, this dialog box is not displayed. For these models, create the alarm list and then set whether or not the line/page scroll touch switches are created in the property settings.

(8) Set the properties as shown below.

<table>
<thead>
<tr>
<th>General</th>
<th>Position</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Message</td>
<td>Length</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>Display Line Qty</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Scale</td>
<td>1 × 2 (High)</td>
</tr>
<tr>
<td></td>
<td>Smoothing</td>
<td>✔</td>
</tr>
<tr>
<td>Color</td>
<td>Frame</td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>Background</td>
<td>ON White</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF Black</td>
</tr>
<tr>
<td>Image &amp; Library</td>
<td>Display ImageLib</td>
<td>✔</td>
</tr>
<tr>
<td></td>
<td>Color</td>
<td>Foreground White</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Background Black</td>
</tr>
<tr>
<td>Settings</td>
<td>List Settings</td>
<td>Start Bit Table Entry 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No. of Bits Referenced 8</td>
</tr>
</tbody>
</table>

(9) Adjust the display position of the alarm list by dragging it.

After that, click on any position in the screen other than the alarm list to cancel the alarm list selected state (edit state).

• Changing the frame of the line scroll (down) touch switch

(10) Specify the switch at the bottom in the touch switches at the right side of the alarm list and adjust its size and position (move it to the lowest line in the alarm list).

(11) Double click the line scroll (down) touch switch and set the properties as shown below.
Creating the Sample Data

### 9-3 Section

#### General
- **Position**: __
- **Size**: __
- **Frame**: __
- **Shape**: Standard
- **Show ON State**: __
- **Color**
  - Frame: White
  - ON: White
  - OFF: Transparent

#### Settings
- **Function**: Input Key-Control
- **Control Key**: ▼
- **Light Function**
  - **Address**: __
  - **PC (PLC) Address**: __
  - **I/O Comments**: __
- **Lamp Attribute**
  - **General**: Light
- **Label**: __, <FFF9> *1

*1: Here, the label is not changed. (If you need to change it, press button.)

After completing the setting, go to the next step without clicking on button.

**Reference:** With the NT21, NT31, NT31C, NT631, and NT631C, the touch switches used to control the alarm list are a part of the list and their properties, such as the label and the size, cannot be changed. Only the position can be adjusted.

(12) Press in the general property of a touch switch and set the label properties as shown below.
Note that other properties must be left unchanged.
- **Foreground Color**: Cyan

(13) Adjust the position of the label graphic by dragging it.

- Setting the page down, page up, and line scroll (up) touch switches

(14) Modify the page down, page up, and line scroll (up) touch switches in the same manner as the line scroll (down) touch switch.
Refer to the screen in page 395 to check the position of each touch switch.
Modify the properties of the individual touch switches as shown below.

<table>
<thead>
<tr>
<th>General</th>
<th>Page down</th>
<th>Page up</th>
<th>Scroll up</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Position</strong></td>
<td>__</td>
<td>__</td>
<td>__</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>__</td>
<td>__</td>
<td>__</td>
</tr>
<tr>
<td><strong>Frame</strong></td>
<td>__</td>
<td>__</td>
<td>__</td>
</tr>
<tr>
<td><strong>Shape</strong></td>
<td>Standard</td>
<td>Standard</td>
<td>Standard</td>
</tr>
<tr>
<td><strong>Show ON State</strong></td>
<td>__</td>
<td>__</td>
<td>__</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>Frame: White</td>
<td>ON: White</td>
<td>OFF: Transparent</td>
</tr>
<tr>
<td></td>
<td>ON: White</td>
<td>White</td>
<td>Transparent</td>
</tr>
<tr>
<td></td>
<td>OFF: Transparent</td>
<td>White</td>
<td>Transparent</td>
</tr>
</tbody>
</table>
Creating the Sample Data

<table>
<thead>
<tr>
<th>Settings</th>
<th>Function</th>
<th>Input Key-Control</th>
<th>Input Key-Control</th>
<th>Input Key-Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Key</td>
<td>✂️</td>
<td>✂️</td>
<td>✂️</td>
<td></td>
</tr>
<tr>
<td>Light Function</td>
<td>Address</td>
<td>PC (PLC) Address</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>I/O Comments</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Lamp Attribute</td>
<td>General Light</td>
<td>Light</td>
<td>Light</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>Label</td>
<td>✅, &lt;FFF7&gt;</td>
<td>✅, &lt;FFF6&gt;</td>
<td>✅, &lt;FFF8&gt;</td>
</tr>
</tbody>
</table>

(15) Modify the foreground color of the label graphic to cyan as with the line scroll (down) touch switch.

**Reference:** With NT21, NT31, NT31C, NT631, and NT631C, the touch switches used to control the alarm list can be adjusted only in position. Size, color, label cannot be changed. If you want to move the position, select [Edit] (menu bar) → [Edit Object] (or right click → [Edit Object]) and specify the touch switch.

- Setting for the image/library data display field

(16) Specify the alarm list and select [Edit] (menu bar) → [Edit Object].

(17) Specify the image data display field, displayed at the central left part of the alarm list, and adjust the size and the position.

(Resize the size to 200 × 200 dots.)

**Creating the [Menu] button, [Monitor] button, and [Set] button**

- Copying and pasting the buttons from screen No. 3

(1) Copy the “Switch Screen” character string, frame (rectangle), [Menu] button, [Monitor] button, and [Alarm] button collectively and paste them onto screen No. 4.

(2) Adjust the display position of the pasted character string, frame (rectangle), and buttons.

- Modifying to the [Set] button

(3) Double click the [Alarm] button and change the properties as shown below.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Screen No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>3</td>
</tr>
</tbody>
</table>

*Press [Edit] to set the label.*
9-3-11 Creating the Alarm List Library Data

Create the library data that is displayed at the occurrence of an alarm.

Create the library data for FA20 to FA25. (For the library data creation procedure, refer to 8-2 Library Editor.)

FA20

Set line 1.

FA21

Set line 2.

FA22

Check torque screw.

FA23

Check pipe and valve.

FA24

Detection near entry. Confirm safety before restarting the line.

FA25

Check the PC (PLC) and the network.

Reference: With the NT21, NT31, NT31C, NT631, and NT631C, the library data codes are 1000 to 3FFF. However, if NT20/30/620-compatible mode is used with the NT21, NT31, NT31C, NT631, and NT631C, library code will be the same as NT30, NT30C, NT620S, NT620C and NT625C.

Creating the library data of code FA20

(1) Select [Tools] (menu bar) → [Library Editor].
(2) Specify FA20 in the library table and click on Edit.
(3) Click the library creation area frame (dotted lines) that is displayed at the upper left area in the library creation screen and drag the point at the lower right corner. The mouse cursor position is displayed under the screen; change the frame size to X=200, Y=200 (size: 200 × 200).
(4) Select [Objects] (menu bar) → [Fixed Display] → [Text].
(5) Click the mouse at the position where the character string is to be displayed (at the intended upper left corner of text).
(6) Set the properties as shown below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Set Line 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>–</td>
</tr>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>1 × 2 (High)</td>
</tr>
<tr>
<td>Smoothing</td>
<td>–</td>
</tr>
<tr>
<td>Attribute</td>
<td>Inverse Flash</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground White</td>
</tr>
<tr>
<td></td>
<td>Background Black</td>
</tr>
</tbody>
</table>
(7) Adjust the “Set Line 1” character string display position by dragging it.

(8) After creating the library data of code FA20, click at the upper right section in the FA20 library editor to close it.

- Creating the library data of code FA21 to FA25.

(9) Create the library data of code FA21 to code FA25 in the same manner. If character string occupies more than one line, create the character string line by line.

**Reference:** It is possible to copy library data FA20 to other code so that it can be reused. Follow the procedure below.

   a. Specify FA20 and select [Copy] by pressing button.
   b. Specify the code to be pasted and select [Paste] by pressing button.

### 9-3-12 Creating the Pop-up Display Numeric Keys

Create the numeric keys displayed in the pop-up window at screen No. 1900.

![Pop-up Display Numeric Keys](image)

**Reference:** With NT30, 30C, NT620S, NT620C, and NT625C, screen numbers of the screen where a window/keyboard screen can be created are restricted to 1900 to 1979. With the NT21, NT31, NT31C, NT631, and NT631C, however, a window/keyboard screen can be created for any screen number as with a standard screen (1 to 3999).

**Creating the window/keyboard screen**

For details of window/keyboard screen, refer to 5-4 Window/Keyboard Screens.

(1) Select [Screen] (menu bar) → [New].

(2) At the screen selection dialog box, set “Window/Keyboard Screen.”

(3) At the new standard screen dialog box, set 1900 for the screen No.

**Setting the screen properties**

(1) Select [Screen] (menu bar) → [Properties].

(2) Set the screen properties as shown below for screen No. 1900.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Screen No.</th>
<th>1900</th>
</tr>
</thead>
<tbody>
<tr>
<td>History</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td></td>
<td>Pop-up Numeric Keys</td>
</tr>
<tr>
<td>Buzzer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load Local 1 (Keyboard)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Keypad</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>Background</td>
<td>Black</td>
</tr>
</tbody>
</table>

400
Creating the Sample Data

<table>
<thead>
<tr>
<th>Grid</th>
<th>Grid Size</th>
<th>Custom</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Horizontal Spacing: 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Vertical Spacing: 5</td>
</tr>
<tr>
<td>Display Grid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Snap to Grid</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating the screen (numeric keys)

- Creating the [0] key frame
  1. Select [Objects] (menu bar) → [Touch Switch]
  2. Create the outline of the [0] key by dragging the mouse on the data creation screen.
  3. Set the properties as shown below.

<table>
<thead>
<tr>
<th>General</th>
<th>Position</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Size</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Frame</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Shape</td>
<td>Standard</td>
</tr>
<tr>
<td>Show ON State</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>Frame</td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>ON</td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>OFF</td>
<td>Transparent</td>
</tr>
<tr>
<td>Settings</td>
<td>Function</td>
<td>Input Key-Control</td>
</tr>
<tr>
<td>Control Key</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Light Function</td>
<td>Address</td>
<td>PC (PLC) Address —</td>
</tr>
<tr>
<td></td>
<td>I/O Comments</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Lamp Attribute</td>
<td>General</td>
</tr>
<tr>
<td>Label</td>
<td>Label</td>
<td>✓, 0 (refer to the following) *1</td>
</tr>
</tbody>
</table>

*1: Press button to set the label.
After completing the setting, go to the next step without clicking on button.
Creating the Sample Data

- Setting the label of the [0] key
  
  (4) Press \textit{Edit} button in the general property of a touch switch and set the label properties as shown below.
  
  Note that other properties must be left unchanged.

<table>
<thead>
<tr>
<th>Scale</th>
<th>2 x 2</th>
</tr>
</thead>
</table>

| Smoothing | ✔ |

Click on \textbf{OK}, (returns to touch switch property) then click on \textbf{OK} again.

- Adjusting the size and position of the [0] key
  
  (5) Specify the [0] key and select [Edit] (menu bar) \rightarrow [Edit Object].
  
  (6) Adjust the size and position of [0] key frame.
  
  (7) Drag [0] to adjust the display position.

Reference: The explanation above described the procedure for creating numeric keys using the touch switch control code input function. The Support Tool, however, provides numeric keys as symbol data and you do not have to create numeric keys by using the pre-registered numeric keys; in the menu bar, select [Window] \rightarrow [Symbol Manager] and drag the numeric keys appropriate for your PT model from the symbol file (Suppltmnt.sbl). The selected numeric keys can be registered on the screen. For details, refer to 6-10 Registering Created Elements (Symbol Manager Operation).

- Creating other keys
  
  (8) Copy the [0] key, paste it onto the screen and move the pasted [0] key to the position of the key to be created ([1] to [J]). Once the [0] is copied to the clipboard, it remains on the clipboard until the next cut or copy operation.

(9) Set the properties as shown below for the individual keys.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Control Key</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Label</td>
<td>✔, 1</td>
<td>✔, 2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Settings</th>
<th>Control Key</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>8</td>
<td>9</td>
</tr>
<tr>
<td>Label</td>
<td>✔, 8</td>
<td>✔, 9</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Settings</th>
<th>Control Key</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

*1: Press \textit{Edit} button to set the label.

*2: Press \textit{Edit} button to set the label. It is also possible to select a mark by pressing \textit{Insert Mark} button in the label property.

(10) For the [+/-] key and the [CLR] key, modify the label size to 1 x 2. For other keys, the label size should not be modified.
Creating the Sample Data

(11) Select all the touch switches above.

(12) Select [Centralize Label] from the [Draw] menu.
The position of all the labels for the selected touch switch is centralized both vertically and horizontally.

Creating a temporary input field

(1) Select [Objects] (menu bar) → [Data Input] → [Numeral].

(2) Click the mouse with the mouse cursor set at the position where the data input field is to be displayed (at the intended upper left corner of numeral input field).

(3) At the cursor moving touch switch use selection dialog box, set the displayed items as shown below.

| Create Cursor Move Touch Switch |

Reference: With the NT21, NT31, NT31C, NT631, and NT631C, this dialog box is not displayed and, accordingly, the cursor moving touch switch cannot be set at the temporary input field. For a temporary input field, the setting of “Create Cursor Move Touch Switch” is not so significant. Even with NT20, NT20S, NT30, NT30C, NT600S, NT620S, NT620C, and NT625C, it is not necessary to set this property.

(4) Set the properties as shown below.

<table>
<thead>
<tr>
<th>General</th>
<th>Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font Type</td>
<td>Standard</td>
</tr>
<tr>
<td>Scale</td>
<td>2 × 2</td>
</tr>
<tr>
<td>Smoothing</td>
<td>✔️</td>
</tr>
<tr>
<td>Attribute</td>
<td>Standard</td>
</tr>
<tr>
<td>Color</td>
<td>Foreground: Black; Background: White</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Settings</th>
<th>Table Entry: 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Type</td>
<td>Decimal</td>
</tr>
<tr>
<td>Format</td>
<td>Integer: 8; Decimal: 0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Settings</th>
<th>Limit *1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum</td>
<td>999999999</td>
</tr>
<tr>
<td>Minimum</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Settings</th>
<th>Zero Suppression: ✔️; Display Sign: ✔️</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td>Focus Frame: ✔️; Focus Attribute: Standard</td>
</tr>
</tbody>
</table>

*1: The setting is not needed for the NT21, NT31, NT31C, NT631 and NT631C.

(5) Specify the numeral input field and adjust the position.
Creating the Sample Data

Setting the pop-up display range frame

Set the range for pop-up display.

(1) Move the range specifying frame, displayed at the upper left section in the screen, to the numeric key area and adjust its size so that the keys and temporary input field are enclosed.

For details of changing the size and the position of pop-up display frame, refer to 5-4 Window/Keyboard Screens.

9-3-13 Saving the Created Data

(1) Select [File] (menu bar) → [Save As]. (Refer to 4-2-10 Saving the Screen Data (Application) to a File.)

(2) Specify the file name of the file where the created data is saved (example: SAMPLE.ONW) and click on OK.

9-3-14 Downloading to the PT

Setting the PT status control area and PT status notify area

(1) Select [Tools] (menu bar) → [PT Configuration].

(2) Click the [Control/Notify Area] tab and set the properties as shown below. (For details of Control/Notify area, refer to 3-3-1 Creating New Screen Data (Application) File.)

<table>
<thead>
<tr>
<th>PT Control Area</th>
<th>PC (PLC) Address</th>
<th>D00100</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Comments</td>
<td>Control Area</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PT Notify Area</th>
<th>PC (PLC) Address</th>
<th>D00110</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Comments</td>
<td>Notify Area</td>
</tr>
</tbody>
</table>

Downloading to the PT

(1) Place the PT in the [transfer mode] by the system menu operation.

(2) At the Support Tool, select [Connect] (menu bar) → [Download (NT-series Support Tool → PT)] → [Application].
Creating the Sample Data

Downloading of the screen data starts. During screen data download, the screen as shown below is displayed.

![Download Application](image)

For details of the screen data download, refer to 4-2-12 Sending (Downloading) the Data to a PT and 11-3 Sending (Downloading) the Data.
This section enables you to access the information you require easily using what you want to do as the key.
## 10-1 Quick Reference

<table>
<thead>
<tr>
<th>Item</th>
<th>Operation</th>
<th>Refer to</th>
</tr>
</thead>
</table>
| Displaying graphics | **To display a polyline or a broken line**  
[Objects] → [Fixed Display] → [Polyline] | 6-2-1 |
| | **To display a rectangle**  
[Objects] → [Fixed Display] → [Rectangle] | 6-2-3 |
| | **To display a triangle, polygon, trapezoid, or diamond**  
[Objects] → [Fixed Display] → [Polygon] | 6-2-5 |
| | **To display a circle**  
[Objects] → [Fixed Display] → [Circle] | 6-2-4 |
| | **To display an arc**  
[Objects] → [Fixed Display] → [Arc] | 6-2-2 |
| | **To display a sector**  
[Objects] → [Fixed Display] → [Sector] | 6-2-6 |
| | **To tile a graphic**  
[Objects] → [Fixed Display] → [Tiling] | 6-2-8 |
| | (1) [Window] → [Symbol Manager]  
Start the symbol manager, and register the created data from color palette symbol. | 6-10-5 |
| | **To display bit map data**  
(1) [Tools] → [Image Editor] Create the image data.  
(2) [Objects] → [Fixed Display] → [Image Display] Display the created data. | 8-1  
6-2-9 |
| | **To display a special symbol/character**  
(1) [Tools] → [Mark Editor] Create the mark data.  
(2) [Objects] → [Fixed Display] → [Mark] Display the created data. | 8-3  
6-2-10 |
| | **To display the same graphic in different positions and/or different screens**  
(1) [Tools] → [Library Editor] Create the library data.  
(2) [Objects] → [Fixed Display] → [Library Display] Display the created data. | 8-2  
6-2-11 |
| | **To switch the graphic display according to the PC (PLC) bit status**  
(1) [Tools] → [Library Editor] or [Tools] → [Image Editor] Create the graphic to be displayed.  
(2) [Objects] → [Lamp] → [Image] Display the created data. | 8-2  
8-1  
6-5-2 |
| | **To move a graphic according to shift of the PC (PLC) bit status.**  
(1) [Tools] → [Library Editor] or [Tools] → [Image Editor] Create the graphic to be displayed.  
(2) [Objects] → [Lamp] → [Image] Arrange the image on the locus of the graphic and display the same graphic according to bit shift of the PC (PLC) bits. | 8-1  
8-2  
6-5-2 |
| | **To switch the graphic display according to the status.**  
(1) [Tools] → [Library Editor] or [Tools] → [Image Editor] Create the graphic to be displayed.  
(2) [Objects] → [Fixed Display] → [Image Display] or [Library Display] Display the graphic using indirect reference.  
(3) Write the image/library code (1) in hexadecimal value to the numeral table entry (set the storage type to Binary) referenced at (2) according to the status. | 8-1  
8-2  
6-2-9  
6-2-11 |
<table>
<thead>
<tr>
<th>Item</th>
<th>Operation</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying graphics</td>
<td>To use the same graphic in multiple application data. (1) [Window] → [Symbol Manager] Start the symbol manager, and register the created data at the symbol manager. (2) Open other screen data. (3) [Window] → [Symbol Manager] Read the registered data.</td>
<td>6-10</td>
</tr>
<tr>
<td></td>
<td>[File] → [Import Component] Start up the second Support Tool. Perform copy &amp; paste operation of graphic between the screen data files. (Between the files of the same PT model setting only)</td>
<td>3-3-6</td>
</tr>
<tr>
<td>Item</td>
<td>Operation</td>
<td>Refer to</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td>Displaying character strings (texts)</td>
<td>To display text that will not change.</td>
<td>(1) [Objects] → [Fixed Display] → [Text] Create a text. 6-2-7</td>
</tr>
<tr>
<td></td>
<td>To switch the character string according to the status of a PC (PLC) bit.</td>
<td>(1) [Objects] → [Lamp] or [Touch Switch] Create a lamp or a touch switch for which On Off Static is set as the label type. (2) Turn the PC (PLC) bit to which the lamp is allocated ON/OFF. 8-2 6-5-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Only for the NT21, NT31/631-V2 and above)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(1) [Tools] → [Library Editor] Create the text to be displayed as the library data. (2) [Objects] → [Lamp] → [Image] Display the created data. (3) Turn the PC (PLC) bit to which the image/library lamp is allocated ON/OFF. 8-2 6-5-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Only for the NT21, NT31/631-V2 and above)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(1) [Objects] → [String display] Display the contents of a character string memory table entry (string table). (2) Change the contents of the word allocated to the character string memory table entry (string table) with the PC (PLC) ladder program. 6-7 7-3</td>
</tr>
<tr>
<td>Item</td>
<td>Operation</td>
<td>Refer to</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| Displaying character strings (texts)     | (1) [Objects] → [Touch Switch] → [Function: Copy Setting]  
Copy text to a character string memory table entry (string table) using a touch switch for which the copy function is set.  
(2) [Objects] → [String Display]  
Display the contents of the copy destination character string memory table entry (string table).                                                                                  | 6-8-6    |
|                                           | ![Diagram](image.png)                                                                                                                                                                                       |          |
| To display a character string in which a special symbol or character is inserted.                                                                                                                                   | [Objects] → [Fixed Display] → [Text]  
Specify the mark, or image/library code.  
Specification: ABC<!FE20>DE  
Display: ABC★DE                                                                                                                                     | 6-2-7    |
| To insert image data and library data into a string with NT21 and NT31/631-V2 and above                                                                                                                             | [Tool] → [PT Configuration]  
Set NT20/30/620 Compatible Mode on.  
(The range of image/library data is as the same as NT30/620 series in NT20/30/620 Compatible Mode.)                                               | 3-3      |
| Screen display                           | To display a blank screen  
Specify screen No. 0 at the first word in the PT status control area.  
Note With NT20, NT20S, NT30, NT30C, NT600S, NT620S, NT620C, and NT625S, if screen No. 0 is set for the touch switch assigned the screen switching function, the previous screen is displayed instead of a blank screen. | 1-3-4    |
|                                           | ![Diagram](image.png)                                                                                                                                                                                       |          |
| To switch the screen using a touch switch| [Objects] → [Touch Switch] → [Function: Switch Screen]  
Create a touch switch for which the screen switching function is set.                                                                                   | 6-8-2    |
|                                           | ![Diagram](image.png)                                                                                                                                                                                       |          |
| To switch the displayed screen according to a PC (PLC) bit status.                                                                                                                                            | [Tools] → [Table] → [Bit Memory]  
Set the bit memory table screen switching function.                                                                                                     | 7-4      |

![Diagram](image.png)
<table>
<thead>
<tr>
<th>Item</th>
<th>Operation</th>
<th>Refer to</th>
</tr>
</thead>
</table>
| Screen display | To switch the displayed screen using an arrow symbol key | (1) [Objects] → [Touch Switch] → [Function: Input Key – Control]  
Create the [↑] and [↓] touch switches, or [Screen] → [Properties] → [System Keypad: Tick]  
Display the [↑] and [↓] keys of the system keypad.  
(2) [Screen] → [New] → [Parent Screen: Continuous]  
Specify the screen to be switched to when the ↑ or ↓ key is pressed.  
Note With the NT21, NT31, NT31C, NT631 and NT631C, it is not possible to create continuous screens. Therefore, set the screen switching function for the touch switches created in step (1). | 6-8-5  5-1-1  5-3-1 |
| To switch the displayed screen using an external switch | [Tools] → [Table] → [Extended I/O input]  
Set the extended I/O input table screen switching function. | 7-5 |
| To display a pop-up screen (help, menu, etc.) using a touch switch | (1) [Objects] → [Touch Switch] → [Input Key-Window/Keyboard]  
Create a touch switch for which the window display function is set.  
(2) [Screen] → [New]  
Create the window/keyboard screen to be displayed.  
Note For a keyboard, the data registered to the symbol manager can be used. Creation is also possible using [Touch Switch] – [Function: Input Key – Control] | 6-8-4  1-3-4  6-10  6-8-5 |
<table>
<thead>
<tr>
<th>Item</th>
<th>Operation</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen display</td>
<td>To display multiple screens in one screen</td>
<td>5-3-2</td>
</tr>
<tr>
<td></td>
<td>[Screen] \rightarrow [New] \rightarrow [Parent]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set the child screens, then specify the parent screen on which to overlap them.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: With the NT21, NT31, NT31C, NT631, and NT631C, if a parent screen is created, it is automatically set for overlapping screens since continuous screens are not supported.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image.png" alt="Screen display diagram" /></td>
<td></td>
</tr>
<tr>
<td>To move a window using a touch switch. (Only for NT21 and for NT31, NT31C, NT631, NT631C with &quot;-V1&quot; and above.)</td>
<td>(1) [Screen] \rightarrow [New] Create a window/keyboard screen.</td>
<td>1-3-4</td>
</tr>
<tr>
<td></td>
<td>(2) [Objects] \rightarrow [Touch Switch] Register Window Move touch switch on a screen created in (1).</td>
<td>6-8-8</td>
</tr>
<tr>
<td></td>
<td><img src="image.png" alt="Window movement diagram" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Center point of the window/keyboard screen goes to the position touched next.</td>
<td></td>
</tr>
<tr>
<td>To open/close/control a window from the host. (Only for NT21 and for NT31, NT31C, NT631, NT631C with &quot;-V1&quot; and above.)</td>
<td>(1) [Tools] \rightarrow [PT Configuration] \rightarrow [Control/Notify Area] Allocate Window Control Area to a host.</td>
<td>3-3-1</td>
</tr>
<tr>
<td></td>
<td>(2) [Screen] \rightarrow [New] Create a window/keyboard screen.</td>
<td>1-3-4</td>
</tr>
<tr>
<td></td>
<td>(3) Write window screen No. to be displayed and X, Y coordinate in a word to which window control area is allocated.</td>
<td>3-3-1</td>
</tr>
<tr>
<td></td>
<td><img src="image.png" alt="Window control diagram" /></td>
<td></td>
</tr>
<tr>
<td>PC (PLC) Bit Status Display</td>
<td>To turn a lamp ON/OFF according to the ON/OFF status of a PC (PLC) bit</td>
<td>6-5-1</td>
</tr>
<tr>
<td></td>
<td>[Objects] \rightarrow [Lamp] \rightarrow [Standard] Set the PC (PLC) Bit address.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image.png" alt="Lamp status diagram" /></td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Operation</td>
<td>Refer to</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>PC (PLC) Bit Status Display</strong>&lt;br&gt;To turn a lamp ON/OFF according to the ON/OFF status of a PC (PLC) bit that is controlled by the operation of touch switches.</td>
<td>(1) [Objects] → [Touch Switch] → [Function: Notify Bit]&lt;br&gt;Reflect the touch switch status in the PC (PLC) bit status.&lt;br&gt;&lt;br&gt;(2) [Objects] → [Lamp] → [Standard]&lt;br&gt;Reflect the PC (PLC) bit status at the lamp.</td>
<td>6-8-1&lt;br&gt;6-5-1</td>
</tr>
<tr>
<td><strong>To switch the graphic to be displayed according to the PC (PLC) bit status</strong>&lt;br&gt;(1) [Tools] → [Image Editor]&lt;br&gt;[Tools] → [Library Editor]&lt;br&gt;Create the image data or the library data.&lt;br&gt;&lt;br&gt;(2) [Objects] → [Lamp] → [Image]&lt;br&gt;Create an image/library lamp.&lt;br&gt;Set the light function PC (PLC) address.</td>
<td>8-1&lt;br&gt;8-2&lt;br&gt;6-5-2</td>
<td></td>
</tr>
<tr>
<td><strong>To switch the text to be displayed according to the PC (PLC) bit status.</strong>&lt;br&gt;(1) [Objects] → [Lamp] or [Touch Switch]&lt;br&gt;Create a lamp or a touch switch for which On Off Static is set as the label type.&lt;br&gt;&lt;br&gt;(2) Turn the PC (PLC) bit to which the lamp is allocated ON/OFF&lt;br&gt;(Only for NT21, NT31/631-V2 and above)</td>
<td>8-2&lt;br&gt;6-5-2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(1) [Tools] – [Library Editor]&lt;br&gt;Register the text as the library data.&lt;br&gt;&lt;br&gt;(2) [Objects] → [Lamp] → [Image]&lt;br&gt;Create a lamp that displays the registered text.&lt;br&gt;&lt;br&gt;(3) Turn the PC (PLC) bit allocated to the lamp ON/OFF.</td>
<td>8-2&lt;br&gt;6-5-2</td>
</tr>
<tr>
<td>Item</td>
<td>Operation</td>
<td>Refer to</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td>PC (PLC) Bit Status Display</td>
<td>To display an alarm message according to the PC (PLC) bit status</td>
<td>7-4</td>
</tr>
</tbody>
</table>
| | (1) [Tools] → [Table] → [Bit Memory]  
Allocate the PC (PLC) bit and a character string memory table entry (string table) (storing an alarm message) to the bit memory table entry. | |
| | (2) [Tools] → [Table] → [String]  
Create the alarm message. | 7-3 |
| | (3) [Objects] → [Alarm] → [Alarm List]  
Create the alarm list and specify the bit memory table entry in the alarm area. | 6-3-1 |
| | To display alarm related information (details and corrective action) by touching an alarm message | |
| | (1) [Tools] → [Table] → [String]  
Create the alarm message. | 7-3 |
| | (2) [Tools] → [Image Editor] or [Library Editor]  
Register the alarm related information (details and corrective action). | 8-1 |
| | (3) [Tools] → [Table] → [Bit Memory]  
Allocate the PC (PLC) bit, a character string memory table entry (string table) (storing an alarm message), and image/library code to the bit memory table entry. | 7-4 |
| | (4) [Objects] → [Alarm] → [List]  
Create the alarm list and specify the bit memory table entry in the alarm area (set a check mark for image/library display in the alarm list properties.). | 6-3-1 |
| To store the ON/OFF status of a PC (PLC) bit as a history and check the history on the screen | (1) [Tools] → [Table] → [Bit Memory]  
Click the [function] button and choose alarm function. Allocate the PC (PLC) bit to the bit memory table entry.  
Then, set a check mark in the [History] check box in the function setting.  
After that, select the message and the image/library code to be displayed from the character string memory table (string table) and the image/library table. | 7-4 |
| | (2) [Objects] → [Alarm] → [History]  
Create the alarm history. | 6-3-2 |
<table>
<thead>
<tr>
<th>Item</th>
<th>Operation</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC (PLC) Word Status Display</td>
<td><strong>To display numeral data</strong>&lt;br&gt;[Objects] → [Numeral Display]&lt;br&gt;Create a numeral display element.</td>
<td>6-6</td>
</tr>
<tr>
<td></td>
<td>[Objects] → [Lamp] or [Touch Switch]&lt;br&gt;Create a lamp or a touch switch for which <em>Numeral Display</em> is set as the label type.&lt;br&gt;(Only for NT21, NT31/631-V2 and above)</td>
<td>6-5, 6-8</td>
</tr>
<tr>
<td></td>
<td><strong>To display a bar graph</strong>&lt;br&gt;[Objects] → [Graph] → [Bar Graph]&lt;br&gt;Create a bar graph.</td>
<td>6-9-1</td>
</tr>
<tr>
<td></td>
<td><strong>To display an analogue meter</strong>&lt;br&gt;[Objects] → [Graph] → [Analogue Meter]&lt;br&gt;Create an analogue meter.</td>
<td>6-9-2</td>
</tr>
<tr>
<td></td>
<td><strong>To display a trend graph</strong>&lt;br&gt;[Objects] → [Graph] → [Trend Graph]&lt;br&gt;Create a trend graph.</td>
<td>6-9-4</td>
</tr>
<tr>
<td></td>
<td><strong>To display a broken-line graph</strong>&lt;br&gt;[Objects] → [Graph] → [Broken-line Graph]&lt;br&gt;Create a broken-line graph.</td>
<td>6-9-3</td>
</tr>
<tr>
<td></td>
<td><strong>To display character string data</strong>&lt;br&gt;[Objects] → [String Display]&lt;br&gt;Create a character string display element.</td>
<td>6-7</td>
</tr>
<tr>
<td></td>
<td>[Objects] → [Lamp] or [Touch Switch]&lt;br&gt;Create a lamp or a touch switch for which <em>String Display</em> is set as the label type.&lt;br&gt;(Only for NT21, NT31/631-V2 and above)</td>
<td>6-5, 6-8</td>
</tr>
<tr>
<td>Item</td>
<td>Operation</td>
<td>Refer to</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td>Writing Data to the PC (PLC)</td>
<td>To turn PC (PLC) bits ON/OFF by operation at the PT</td>
<td>6-8-1</td>
</tr>
<tr>
<td>Writing Data to the PC (PLC)</td>
<td>[To write a numeric value] To input a numeric value using numeric keys or a system keyboard.</td>
<td>6-4-1</td>
</tr>
<tr>
<td></td>
<td>(1) [Objects] → [Data Input] → [Numeral] Create the numeral setting input field.</td>
<td>6-8-5</td>
</tr>
<tr>
<td></td>
<td>Note With the NT21, NT31, NT31C, NT631, and NT631C, register the system keypad from the symbol manager since the system keypad cannot be used for these models.</td>
<td></td>
</tr>
<tr>
<td>Writing Data to the PC (PLC)</td>
<td>[To write a numeric value] To write a constant using a touch switch</td>
<td>6-8-6</td>
</tr>
<tr>
<td></td>
<td>(1) [Objects] – [Touch Switch] – [Function: Copy Setting] Create a touch switch for which the copy function is set, and copy a constant to a numeral memory table entry using this touch switch.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(2) [Objects] – [Numeral Display] Display the contents in the copy destination numeral memory table entry.</td>
<td>6-6</td>
</tr>
</tbody>
</table>

![Diagram 1](image1.png)

![Diagram 2](image2.png)

![Diagram 3](image3.png)
<table>
<thead>
<tr>
<th>Item</th>
<th>Operation</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Writing Data to the PC (PLC)</td>
<td><strong>[To write a numeric value]</strong>&lt;br&gt; <strong>To write a constant to a numeral setting input field</strong>&lt;br&gt;(1) [Objects] – [Data Input] – [Numeral]&lt;br&gt;Create a numeral setting input field.&lt;br&gt;(2) [Objects] – [Touch Switch] – [Function: Copy Setting]&lt;br&gt;Create a touch switch for which the copy function is set, and copy a constant to a numeral memory table entry using this touch switch (Copy To = Cursor Position).</td>
<td>6-4-1</td>
</tr>
<tr>
<td></td>
<td><img src="image1.png" alt="Diagram" /></td>
<td>6-8-6</td>
</tr>
<tr>
<td>[To write a numeric value]</td>
<td><strong>To input a numeric value using thumbwheel switch</strong>&lt;br&gt;[Objects] – [Data Input] – [Thumbwheel Switch]&lt;br&gt;Create a thumbwheel switch.</td>
<td>6-4-3</td>
</tr>
<tr>
<td></td>
<td><img src="image2.png" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td>[To write a character string]</td>
<td><strong>To input a character string</strong>&lt;br&gt;(1) [Objects] – [Data Input] – [String]&lt;br&gt;Create a character string input field.&lt;br&gt;(2) [Objects] → [Touch Switch] → [Function: Input Key – Control] or [Objects] → [Touch Switch] → [Function: Input Key – String]&lt;br&gt;Create a touch switch for which the control code input function or the character string input function is set.</td>
<td>6-4-2</td>
</tr>
<tr>
<td></td>
<td><img src="image3.png" alt="Diagram" /></td>
<td>6-8-5, 6-8-3</td>
</tr>
<tr>
<td>Item</td>
<td>Operation</td>
<td>Refer to</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Writing Data to the PC (PLC)</strong></td>
<td><strong>[To write a character string]</strong> To copy between character string memory table entries (string table) with one touch switch</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(1) <strong>[Objects] – [Touch Switch] – [Function: Copy Setting]</strong></td>
<td>6-8-6</td>
</tr>
<tr>
<td></td>
<td>Create a touch switch for which the copy function is set, and copy the content of a character string memory table entry (string table) to another character string memory table entry (string table).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(2) <strong>[Objects] – [String Display]</strong></td>
<td>6-7</td>
</tr>
<tr>
<td></td>
<td>Display the content of the character string memory table entry (string table).</td>
<td></td>
</tr>
<tr>
<td><strong>Writing Data to the PC (PLC)</strong></td>
<td><strong>To disable the input according to the ON/OFF status of a PC(PLC) bit</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(1) <strong>[Objects] → [Data Input] → [Numeral], [String], [Recipe] or [Thumbwheel Switch]</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create a data input object and set Interlock on.</td>
<td>6-1-12</td>
</tr>
<tr>
<td></td>
<td>(2) Turn OFF the PC (PLC) bit to which the interlock is allocated to disable from inputting.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Only for NT21, NT31/631-V2 and above) It is possible to disable the input into a data input object by using Numeral/Character string input flag in PT status control bits.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Except NT20, NT20S and NT600S)</td>
<td></td>
</tr>
<tr>
<td><strong>To store calculated result in numeral table entry</strong></td>
<td>(1) <strong>[Tools] – [Mathematical Table]</strong> Click on Set button to specify the formula for calculation and set result to specific Numeral table entry.</td>
<td>7-9</td>
</tr>
<tr>
<td><strong>To store calculated result in a specified PLC address</strong></td>
<td>(1) <strong>[Tool] – [Mathematical Table]</strong> Click on Set button to specify the formula for calculation and set result to specific PLC address.</td>
<td>7-9</td>
</tr>
<tr>
<td><strong>To store more than one value in a specified PLC address</strong></td>
<td>(1) <strong>[Tools] – [Recipe Table]</strong> Create Recipe entry.</td>
<td>6-11-1</td>
</tr>
<tr>
<td></td>
<td>(2) <strong>[Objects] – [Data Input] – [Recipe]</strong></td>
<td>7-10</td>
</tr>
<tr>
<td></td>
<td>Create Recipe object referring to the Recipe entry. In Settings properties, check Show Window/Keyboard Screen and set screen number to display keypad. Create window screen containing keypad.</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Operation</td>
<td>Refer to</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Image</strong></td>
<td>To modify the size of an image data</td>
<td>8-1</td>
</tr>
<tr>
<td></td>
<td>(1) Specify the area of an image data to be shrunk or expanded on the image editor.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(2) Drag one of the green handles (●) displayed on the range specifying frame to modify the size of an image data.</td>
<td></td>
</tr>
<tr>
<td><strong>Label</strong></td>
<td>To display a label in multiple lines</td>
<td>6-5, 6-8</td>
</tr>
<tr>
<td></td>
<td>[Objects]→[Lamp] or [Touch switch] Create a lamp or a touch switch for which Static or On Off Static is set as the label type. (NT21, NT31/631-V2 and above)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>To change the contents and the position of a label according to the ON/OFF status of the lamp bit</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(1) [Objects]→[Lamp] or [Touch Switch] Create a lamp or a touch switch for which On Off Static is set as the label type</td>
<td>6-5, 6-8</td>
</tr>
<tr>
<td></td>
<td>(2) Turn the PC (PLC) bit to which the lamp is allocated ON/OFF.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image.png" alt="Diagram" /> Lamp or touch switch with On off static label (Only for NT21, NT31/631-V2 and above)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>To change the contents of a label according to the values in PLC memory</strong></td>
<td>6-5, 6-8</td>
</tr>
<tr>
<td></td>
<td>[Objects]→[Lamp] or [Touch switch] Create a lamp or a touch switch for which Numeral Display is set as the label type. (Only for NT21, NT31/631-V2 and above)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Objects]→[Lamp] or [Touch switch] Create a lamp or a touch switch for which String Display is set as the label type. (Only for NT21, NT31/631-V2 and above)</td>
<td>6-5, 6-8</td>
</tr>
<tr>
<td></td>
<td><strong>To insert image data and library data into a string with NT21, NT31/631-V2 and above</strong></td>
<td>3-3, APPENDIX A</td>
</tr>
<tr>
<td></td>
<td>[Tool]→[PT Configuration] Enable NT20/30/620 Compatible Mode. (The range of image/library data is as the same as NT30/620 series in NT20/30/620 Compatible Mode.)</td>
<td></td>
</tr>
<tr>
<td><strong>Lamp</strong></td>
<td>To centralize the lamp label Specify the lamp to be centralized and select [Draw]→[Centralize Label]</td>
<td>6-1-9</td>
</tr>
<tr>
<td>Item</td>
<td>Operation</td>
<td>Refer to</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Touch Switches</td>
<td>To create numeric keys</td>
<td>6-4-1</td>
</tr>
<tr>
<td></td>
<td>(1) [Objects] – [Data Input] – [Numeral]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create a numeral setting string input field.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(2) [Objects] → [Touch Switch] → [Function: Input Key – Control]</td>
<td>6-8-5</td>
</tr>
<tr>
<td></td>
<td>Create numeric keys using touch switches for which the control code input</td>
<td></td>
</tr>
<tr>
<td></td>
<td>function is set.</td>
<td></td>
</tr>
</tbody>
</table>

![Diagram of Touch Switches]

|                      | To display numeric keys as a pop-up window/keyboard by touching a numeric | 6-4-1    |
|                      | input field                                                              |          |
|                      | (1) [Objects] → [Data Input] → [Numeral]                                  |          |
|                      | Create a numeral input field, where a cursor moving touch switch is      |          |
|                      | automatically set.                                                       |          |
|                      | (2) Specify the automatically created touch switch and add the window/   | 6-8-4    |
|                      | keyboard screen display function by setting properties.                   |          |

![Diagram of Pop-up Window]

|                      | To switch the objective input field among multiple numeral setting input | 6-4-1    |
|                      | fields arranged in a screen in response to the touching of a numeric     |          |
|                      | setting input field.                                                     |          |
|                      | Create the cursor moving touch switches automatically.                    |          |

![Diagram of Screen Switches]
<table>
<thead>
<tr>
<th>Item</th>
<th>Operation</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch Switches</td>
<td>To switch the objective input field among multiple numeral setting input fields arranged in a screen using the arrow symbol [↑] and [↓] keys.</td>
<td>6-4-1</td>
</tr>
</tbody>
</table>
|                             | (1) [Objects] → [Data Input] → [Numeral]  
Create a numeral setting input field.                                                                 |          |
|                             | (2) [Objects] → [Touch Switch] → [Function: Input Key – Control]  
Create the [↑] and [↓] touch switches.                                                                 | 6-8-5    |
|                             | ![Touch Switches Diagram](image)                                                                                                           |          |
|                             | To copy between numeral memory table entries or character string memory table entries (string table) with one touch switch                  | 6-8-6    |
|                             | [Objects] → [Touch Switch] → [Function: Copy Setting]  
Create a touch switch for which the function to copy character strings or numeric values between character string memory table entries (string table) or numeral memory table entries. |          |
|                             | ![Character String Display Diagram](image)                                                                                              |          |
|                             | To set a constant (fixed numeral), including initialization and clear, using a touch switch                                                | 6-8-6    |
|                             | [Objects] → [Touch Switch] → [Function: Copy Setting]  
Set a constant for Code/No. of “Copy From” and a numeral memory table entry or a numeral setting input field for “Copy to.” |          |
|                             | ![Numeral Memory Table Diagram](image)                                                                                                    |          |
|                             | To set a constant or a content of a numeral memory table entry for a numeral setting input field                                         | 6-4-1    |
|                             | (1) [Objects] → [Data Input] → [Numeral]  
Create a numeral setting input field.                                                                 |          |
|                             | (2) [Objects] → [Touch Switch] → [Function: Copy Setting]  
Set a constant for Code/No. of “Copy From” and a numeral memory table entry or a constant for “Copy To.” | 6-8-6    |
<p>|                             | <img src="image" alt="Numeral Setting Input Field Diagram" />                                                                                             |          |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Operation</th>
<th>Refer to</th>
</tr>
</thead>
</table>
| Touch Switches              | **To print a hard copy of the screen**  
(1) [Tools] → [PT Configuration]  
Set the printer to be connected.  
(2) [Objects] → [Touch Switch] → [Function: Print Screen]  
Create a touch switch for which the print screen function is set. | 3-3-1    |
|                             | ![Diagram](touch_switch_print_screen.png)                                                                                                                                                                  | 6-8-9    |
|                             | **To stop the buzzer sound using a touch switch**  
[Objects] → [Touch Switch] → [Input Key – Control]  
Create a touch switch for which the “stop buzzer” code of the PT is set. | 6-8-5    |
|                             | ![Diagram](touch_switch_stop_buzzer.png)                                                                                                                                                                  |          |
|                             | **To display the PT’s system menu using a touch switch**  
[Objects] – [Touch Switch] – [Input Key – Control]  
Create a touch switch for which the menu display is set. | 6-8-5    |
<p>|                             | <img src="touch_switch_system_menu.png" alt="Diagram" />                                                                                                                                                                  |          |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Operation</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch Switches</td>
<td>To input a different string from the label</td>
<td>6-8-3</td>
</tr>
<tr>
<td></td>
<td>[Objects]→[Touch Switch]→[Input Key–String]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create a touch switch for which a different string from the label is set as the Input key string.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Only for NT21, NT31/631)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>To centralize the touch switch label</td>
<td>6-1-9</td>
</tr>
<tr>
<td></td>
<td>Specify the touch switch to be centralized and select [Draw] → [Centralize Label]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>To disable the touch switch input according to the ON/OFF status of a PC (PLC) bit</td>
<td>6-1-12</td>
</tr>
<tr>
<td></td>
<td>(1) [Objects]→[Touch Switch]Create a touch switch for which interlock is set.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(2) Turn OFF the PC (PLC) bit to which the interlock is allocated to disable the input.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Only for NT21, NT31/631-V2 and above)</td>
<td></td>
</tr>
<tr>
<td>Extended Input/Output (NT30/NT30C only)</td>
<td>To switch the displayed screen using an external switch</td>
<td>7-5</td>
</tr>
<tr>
<td></td>
<td>[Tools] → [Table] → [Extended I/O input]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set the screen switching function for an extended I/O input table entry.</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Operation</td>
<td>Refer to</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Extended Input/Output (NT30/NT30C only)</td>
<td><strong>To notify the PC (PLC) of the ON/OFF status of an external switch</strong></td>
<td>7-5</td>
</tr>
<tr>
<td></td>
<td>[Tools] → [Table] → [Extended I/O input]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set the Notify Bit Function for an extended I/O input table entry.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image1.png" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>To input a numeric value using an external switch (numeric keys, etc.)</strong></td>
<td>6-4-1</td>
</tr>
<tr>
<td></td>
<td>(1) [Objects] → [Data Input] → [Numeral]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create a numeral setting input field.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(2) [Tools] → [Table] → [Extended I/O input]</td>
<td>7-5</td>
</tr>
<tr>
<td></td>
<td>Set the control code input function for an extended I/O input table entry.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image2.png" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>To turn ON/OFF the lamp, connected to a PT, according to the status of a</strong></td>
<td>7-6</td>
</tr>
<tr>
<td></td>
<td><strong>PC (PLC) bit</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Tools] → [Table] → [Extended I/O Output]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set a PC (PLC) bit for an extended I/O output table entry.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image3.png" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>To output the status of a touch switch to an external device</strong></td>
<td>6-8-1</td>
</tr>
<tr>
<td></td>
<td>(1) [Objects] → [Touch Switch] → [Function: Notify Bit]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create a touch switch and notify the PC (PLC) of the status of the touch switch.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(2) [Tools] → [Table] → [Extended I/O Output]</td>
<td>7-6</td>
</tr>
<tr>
<td></td>
<td>Set the same PC (PLC) bit as the one set in (1) above for an extended I/O output table entry.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image4.png" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td>Operations</td>
<td><strong>To change grids</strong></td>
<td>5-1-2</td>
</tr>
<tr>
<td>To copy a created graphic</td>
<td>[Screen] → [Grid]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(1) Specify the graphic to be copied.</td>
<td>6-1-5</td>
</tr>
<tr>
<td></td>
<td>(2) [Edit] → [Copy]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(3) [Edit] → [Paste]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If screen data of the same PT model setting is opened by [Import Component] from the [File] menu, copy &amp; paste operation above is possible between the Support Tools.</td>
<td>3-3-6</td>
</tr>
<tr>
<td>Item</td>
<td>Operation</td>
<td>Refer to</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Operations</strong></td>
<td><strong>To copy the screen data</strong></td>
<td><strong>Refer to</strong></td>
</tr>
<tr>
<td></td>
<td>(1) Using the application manager, select the file of the screen to be copied.</td>
<td>4-2</td>
</tr>
<tr>
<td></td>
<td>(2) [Edit] → [Copy]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(3) [Edit] → [Paste]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(4) Specify the copy destination screen number.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(1) Display the copy source screen.</td>
<td>6-1-5</td>
</tr>
<tr>
<td></td>
<td>(2) [Edit] → [Select All]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(3) [Edit] → [Copy]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(4) Open the copy destination screen.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(5) [Edit] → [Paste]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If screen data of the same PT model setting is opened by [Import Component] from the [File] menu, copy &amp; paste operation above is possible between the Support Tools.</td>
<td>3-3-6</td>
</tr>
<tr>
<td><strong>To copy image/library data</strong></td>
<td>(1) Selected the code to be copied on the image/library table entry.</td>
<td>8-1</td>
</tr>
<tr>
<td></td>
<td>(2) [Edit] → [Copy]</td>
<td>8-2</td>
</tr>
<tr>
<td></td>
<td>(3) Select the code to be pasted.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(4) [Edit] → [Paste]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If screen data of the same PT model setting is opened by [Import Component] from the [File] menu, copy &amp; paste operation above is possible between the Support Tools.</td>
<td>3-3-6</td>
</tr>
<tr>
<td><strong>To group several graphics into one graphic</strong></td>
<td>(1) Select all graphics to be grouped.</td>
<td>6-1-7</td>
</tr>
<tr>
<td></td>
<td>(2) [Draw] → [Group]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: Use the following commands to ungroup the grouped graphics: [Draw] → [Ungroup]</td>
<td></td>
</tr>
<tr>
<td><strong>To specify the graphic that is behind another element/graphic</strong></td>
<td>Click the different position so that the graphic at the back side is selected.</td>
<td>6-1-3</td>
</tr>
<tr>
<td></td>
<td>Note: The element with the smallest area enclosing the point of selection will be selected.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(1) Select the graphic at the front side.</td>
<td>6-1-5</td>
</tr>
<tr>
<td></td>
<td>(2) [Draw] → [Send to Back]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(3) Specify the graphic brought to the front side.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(1) Select the graphic at the front side.</td>
<td>6-1-3</td>
</tr>
<tr>
<td></td>
<td>(2) [Edit] → [Select Object]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(3) Select the graphic to be specified in the list.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Keep pressing the Tab key (or Shift key + Tab key) until the objective graphic is selected.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Specify the objective type of element on a filter and select the graphic by the method above.</td>
<td>5-1-4</td>
</tr>
<tr>
<td><strong>To display only the selected type of element to facilitate the screen editing of complicated screen</strong></td>
<td>Specify the type of element to be displayed using a filter (on the utility bar). (During the filter function, only the displayed element can be edited.)</td>
<td>5-1-4</td>
</tr>
<tr>
<td><strong>To align the position of the graphics correctly</strong></td>
<td>(1) Select all the graphics to be aligned.</td>
<td>6-1-6</td>
</tr>
<tr>
<td></td>
<td>(2) [Edit] → [Align] and select the aligning method.</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Operation</td>
<td>Refer to</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| Operations | **To change the PC (PLC) words/bits in batch** | [Tools] → [Table] → [Change Address]  
Change the word (address) and bit numbers in a batch. | 7-1-3 |
| | **To use the created data in other applications** | (1) [Window] → [Symbol Manager]  
Start the symbol manager and register the created data.  
(2) Open other applications.  
(3) [Window] → [Symbol Manager]  
Start the symbol manager and read the registered data.  

[File] → [Import Component]  
Start up the second Support Tool.  
Perform copy & paste operation of graphic between the screen data files.  
(Between the files of the same PT model setting only) | 6-10 |
| | **To store large data in a FD** | [File] → [Save] or [Save As]  
Save data in Memory Map Image File (*.mmi) format. | 3-3-6 |
| | **To use I/O comments in ladder program** | [Tools] → [Import I/O comments]  
Import I/O comments file of ladder program. | 7-7-3 |
| | **To check the flash display on the screen** | [View] → [Simulate Flash]  
Elements with a flash attribute flashes. | 5-1-3 |
| | **To check the lamp ON status of lamps/touch switches on the screen** | [View] → [Simulate ON/OFF]  
Lamp ON status of lamps/touch switches is displayed.  
([Simulate Flash] mentioned above can be used at the same time.) | 5-1-3 |
| | **To specify whether or not to inverse the screen color or to print screen grid/dotted line for Screen Image printing (without changing the screen property).** | In Screen Image Attribute of Screen Image printing, set “Inverse Print,” “Hide Screen Grid” or “Show Dotted Line Frame” items as required. | 12-1-6 |
| | **To display time** | [Objects] → [Numeral Display]  
Specify numeral memory table entries No. 247 to No. 253 (time data) to display the time. | 6-6 |
| | **To set the time to be displayed** | (1) [Objects] → [Data Input] → [Numeral]  
Set the time to be written to a numeral memory table entry.  
(2) [Objects] → [Touch Switch] → [Function: Copy Setting]  
Copy the memory table contents where the time is set to numeral memory table entries No. 254 and No. 255 (time setting). | 6-4-1 |
| | **To display the display history of PT** | The display history is displayed by calling the following screen numbers.  
NT21, NT31, NT31C, NT631, and NT631C: No. 9001, No. 9002  
The history is displayed in either the order of occurrence or order of frequency. | 5-6 |
| | **To sound a buzzer at the occurrence of an error** | [Tools] → [PT Configuration]  
Set “On Error” for the buzzer setting. | 3-3-1 |
<table>
<thead>
<tr>
<th>Item</th>
<th>Operation</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>To upload/download the screen data without modifying the contents</td>
<td>Use the NT Transfer Utility supplied with the Support Tool on CD-ROM. (The screen data should be saved in mmi format.)</td>
<td>Appendix C</td>
</tr>
<tr>
<td>To display calculated numeric value</td>
<td>[Tool]–[Mathematical Table] Define formulas that are used for calculations on PT. (Only for NT21, NT31/631-V2 and above)</td>
<td>7-9</td>
</tr>
</tbody>
</table>
This section describes the procedure for sending the created and edited screen data to a PT to register them in the PT and also the procedure for reading the data registered in the PT.

<table>
<thead>
<tr>
<th>11-1</th>
<th>Preparation for Data Communications with a PT and Data Communication Procedure</th>
<th>430</th>
</tr>
</thead>
<tbody>
<tr>
<td>11-1-1</td>
<td>Connection to PT</td>
<td>430</td>
</tr>
<tr>
<td>11-1-2</td>
<td>Available Data Communication Methods by PT Models</td>
<td>430</td>
</tr>
<tr>
<td>11-1-3</td>
<td>Data Communication Procedure</td>
<td>432</td>
</tr>
<tr>
<td>11-2</td>
<td>Communication Setting at the Support Tool</td>
<td>432</td>
</tr>
<tr>
<td>11-3</td>
<td>Sending (Downloading) the Data</td>
<td>433</td>
</tr>
<tr>
<td>11-4</td>
<td>Receiving (Uploading) Data</td>
<td>436</td>
</tr>
<tr>
<td>11-5</td>
<td>Receiving (Uploading) the History Record</td>
<td>439</td>
</tr>
<tr>
<td>11-6</td>
<td>Setting and Reading the Date and Time</td>
<td>440</td>
</tr>
</tbody>
</table>
11-1 Preparation for Data Communications with a PT and Data Communication Procedure

11-1-1 Connection to PT

To send/receive data between a PT and the NT-series Support Tool (personal computer), connect them with a cable.

- **Cable**

  The recommended communication cable supplied by OMRON has a 25-pin RS-232C connector at the end for connection to a personal computer. To connect to a PC/AT compatible personal computer that has a 9-pin (female) connector, use a 25-pin to 9-pin conversion adapter available on the market.

  Recommended cable is in the Appendix J.

- **Connection**

  Connect the RS-232C connector at the personal computer to the Support Tool connection port at the PT.

  For the location of the connection port in the PT, refer to the Appendix of the User’s Manual of the PT. With some models of PT, it is necessary to disconnect from the host before connecting the Support Tool.

  An example of connection is shown below assuming NT31/NT31C.

![Connection Diagram](image)

11-1-2 Available Data Communication Methods by PT Models

Data communication is possible by the two methods indicated below.

- **Batch transmission of all screen data**

- **Data transmission in screen and data units (individual transmission)**

Whether or not individual data transmission is possible depends on the PT model as shown below.

<table>
<thead>
<tr>
<th>PT Model</th>
<th>Batch Transmission</th>
<th>Individual Transmission</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT11S/NT11</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>NT20, NT20S</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>NT21</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>NT600S</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>NT30</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>NT30C</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>NT620S</td>
<td>○</td>
<td>×</td>
</tr>
</tbody>
</table>
Preparation for Data Communications with a PT and Data Communication Procedure

<table>
<thead>
<tr>
<th>PT Model</th>
<th>Batch Transmission</th>
<th>Individual Transmission</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT620C, NT625C</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>NT31</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>NT31C</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>NT631</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>NT631C</td>
<td>○</td>
<td>○</td>
</tr>
</tbody>
</table>

○: Possible ×: Not possible

Reference: The type and content of individual transmission differs between the NT20/NT20S/NT600S and the NT21, NT31, NT31C, NT631, and NT631C. For details, refer to 11-3 Sending (Downloading) the Data and 11-4 Receiving (Uploading) Data.

In case of NT31, NT31C, NT631 and NT631C, screen data file that can be transmitted is as follows depending on the version of PT hardware and the system program version installed in a PT.

Use the method below to check the system program version of a PT (For details of the operation of a PT, refer to the manual of PT).

1) Display the system menu on a PT.
2) At the upper right position of the system menu screen, its version is displayed, like “Ver.2.10.” If you are using NT31, NT31C, NT631 or NT631C, it is also possible to check the PLC vendor by selecting [Expansion Mode] → [Version Display].

<table>
<thead>
<tr>
<th>PT model selected at Support Tool</th>
<th>NT31, NT31C, NT631, NT631C below “-V1”</th>
<th>NT31, NT31C, NT631, NT631C “-V1” and above</th>
</tr>
</thead>
<tbody>
<tr>
<td>System program Version 1.0</td>
<td>System program Version 2.0</td>
<td>System program Version 3.1</td>
</tr>
<tr>
<td>NT31, NT31C, NT631, NT631C without “-V1”</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>NT31, NT31C, NT631, NT631C “-V1”</td>
<td>×</td>
<td>Δ₂</td>
</tr>
<tr>
<td>NT31, NT31C, NT631, NT631C “-V1 (System Ver.2.1)”</td>
<td>×</td>
<td>Δ₂</td>
</tr>
<tr>
<td>NT31, NT31C, NT631, NT631C “-V2 (System Ver.3.1)”</td>
<td>×</td>
<td>Δ₂</td>
</tr>
</tbody>
</table>

○: Downloading/Uploading is possible (Both Batch Transmission and Individual Transmission are possible).

×: The message shown below is displayed on transmitting.

Application version mismatched; communication aborted.

Δ₁: Message warning you about 32 dot font and font type ISO-8859 is displayed on transmitting. If this combination is selected, 32 dot font and font type ISO-8859 are displayed on a PT but they are not available on the Support Tool.

Δ₂: Message warning you about 32 dot font and font type ISO-8859 is displayed on transmitting. If this combination is selected, 32 dot font and font type...
ISO-8859 are displayed on the Support Tool but they are not available on a PT (16x16 font and CP437 font type are used on the PT).

Note) If the vendor (manufacturer) of the PLC you are using and the PLC vendor setting of the created screen data is different, transmission is not possible. The following message is displayed. Memory access mismatched: communication aborted

11-1-3 Data Communication Procedure

The procedure for transmitting data between a PT and the Support Tool is indicated below.

Setting for communications at Support Tool

Set the RS-232C port and baud rate at the Support Tool (personal computer).

Set PC (PLC) to Transmit mode

Place the PT in the Transmit mode to allow communications of the data between the PT and the personal computer. For details of this procedure at PT, refer to the User’s Manual of your PT.

Selecting the data to be sent/received

From the menu at the Support Tool, select the direction of data transmission (download/upload) and the kind of data to be transmitted. Depending on the data, more detailed selection may be possible. After the data has been determined, data transmission will start.

11-2 Communication Setting at the Support Tool

Set the baud rate and communication port at the Support Tool (personal computer)

Operation procedure

(1) Select [Connect] (menu bar) → [Comms. Setting]. The communication dialog box is displayed.

(2) Set the data for the displayed items. The meanings of the items are described below.
Section 11-3

11-3 Sending (Downloading) the Data

To send (download) the data created or edited by the Support Tool to a PT, follow the steps shown below.

The type of data that can be sent is indicated in the table below.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application (in file units)</td>
<td>All data is sent in batch.</td>
</tr>
<tr>
<td>Screen</td>
<td>Data is sent in units of a screen. It is possible to send the data of several screens at a time. When sending the data of a parent screen, you can specify whether or not the data of the child screens should be sent with the parent screen data.</td>
</tr>
<tr>
<td>Direct Access Information</td>
<td>NT20, NT20S and NT600S: Information on the PC (PLC) addresses allocated to the PT status control area, PT status notify area, numeral/character string memory table (string table), etc. NT21: Information on the PC (PLC) addresses allocated to PT status control area, PT status notify area, and window control area. NT31, NT31C, NT631, and NT631C: Information of the PC (PLC) addresses allocated to PT status control area, PT status notify area and window control area (models with “-V1” and above).</td>
</tr>
</tbody>
</table>
### Sending (Downloading) the Data

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Memory*1</td>
<td>The setting contents of “System” of “PT Configuration” are sent and set at the PT.</td>
</tr>
<tr>
<td>Table*2</td>
<td>NT20, NT20S and NT600S: The following data is sent in a batch.</td>
</tr>
<tr>
<td></td>
<td>• Numeral memory table data</td>
</tr>
<tr>
<td></td>
<td>• Character string memory table (String table) data</td>
</tr>
<tr>
<td></td>
<td>• Mark data</td>
</tr>
<tr>
<td>NT21, NT31, NT31C, NT631, and NT631C: The following data can be sent individually.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Numeral memory table</td>
</tr>
<tr>
<td></td>
<td>• Character string memory table (String table)</td>
</tr>
<tr>
<td></td>
<td>• Bit memory table</td>
</tr>
<tr>
<td></td>
<td>• Mark data</td>
</tr>
<tr>
<td></td>
<td>• Image data</td>
</tr>
<tr>
<td></td>
<td>• Library data</td>
</tr>
<tr>
<td></td>
<td>• Recipe table</td>
</tr>
</tbody>
</table>

*1: With the NT21, NT31, NT31C, NT631 and NT631C, individual transmission of system memory is restricted as follows:

The following data stored in a PT cannot be overwritten.

• Number of numeral table entries
• Number of string table entries
• Number of bit memory table entries
• Screen history setting
• Alarm history setting
• Numeral storage type

The following data can be overwritten.

• Initial screen number
• Screen data comment

*2: You cannot transmit the mathematical table separately. The mathematical table will be transmitted only when application transmission is performed.

**Reference:**

- When data is sent from the Support Tool to a PT, the existing data in the PT is lost. Therefore, make sure that the existing data in the PT is backed up by the Support Tool before executing data transmission from the Support Tool to the PT.

- With the Support Tool on CD-ROM, NT Transfer Utility that is exclusively used for downloading/uploading the screen data is supplied (For details, refer to Appendix C).

**Operation procedure**

1. Select [Connect] (menu bar) → [Download (NT-series Support Tool → PT)].
The menu is displayed, allowing you to select the data to be sent.

The items that can be selected vary according to the PT model.

Selection of “Screen” is not possible if screen data is not selected.

(Pressing Ctrl key + Shift key + D executes Application downloading.)

(2) Select the data to be sent.

Data transmission timing is determined according to the type of data selected to be sent.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application (in file units)</td>
<td>Data transmission starts immediately.</td>
</tr>
<tr>
<td>Screen</td>
<td>If a parent screen is included in the screens selected to be sent, a dialog box is displayed requesting you to specify whether child screens are sent with the parent screen. Set a check mark for the “Include Child Screen” item if you want to send the child screens with the parent screen. Data transmission starts when is clicked.</td>
</tr>
<tr>
<td>Direct Access Information</td>
<td>Data transmission starts immediately.</td>
</tr>
<tr>
<td>System Memory</td>
<td>Data transmission starts immediately.</td>
</tr>
<tr>
<td>Table</td>
<td>NT20, NT20S and NT600S: Data transmission starts immediately. NT21, NT31, NT31C, NT631, and NT631C: The dialog box where the information to be sent is specified is displayed. Only the information for which a check mark is set is sent. Data transmission starts when is clicked.</td>
</tr>
</tbody>
</table>

(3) Place the PT in the Transmit mode so that the data sent from the Support Tool can be received.

If the PT is not in the Transmit mode, a timeout error occurs in about 10 seconds at the Support Tool. In this case, set the PT in the Transmit mode and click on in the error message dialog box.

(4) While the data is being sent to the PT, the progress of data transmission is indicated by a bar graph.

To abort the operation, click on .

Reference: If data transmission is aborted, it is necessary to initialize the image data memory in the Maintenance mode (System Menu). Execute the same processing if data transmission is interrupted due to trouble.

When sending all the screen data (Application), initialization is not necessary since initialization is automatically executed.
11-4 Receiving (Uploading) Data

To receive (upload) data stored in a PT at the Support Tool as the screen data being edited, follow the steps shown below.

The type of data that can be received is indicated in the table below.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application (in file units)</td>
<td>All data is sent in batch.</td>
</tr>
<tr>
<td>Screen</td>
<td>Data is received in units of a screen. It is possible to receive the data of several screens at a time. When receiving the data of a parent screen, you can specify whether or not the data of the child screens is to be received with the parent screen data.</td>
</tr>
<tr>
<td>Direct Access Information</td>
<td>NT20, NT20S and NT600S: Information on the PC (PLC) addresses allocated to the PT status control area, PT status notify area, numeral/character string memory table (string table), etc. NT21: Information on the PC (PLC) addresses allocated to the PT status control area, PT status notify area, and window control area. NT31, NT31C, NT631, and NT631C: Information on the PC (PLC) addresses allocated to the PT status control area, PT status notify area and window control area (models with “-V1” and above).</td>
</tr>
</tbody>
</table>
## Receiving (Uploading) Data

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Memory*1</td>
<td>The contents of “System” set at the PT are received and set for “System” of “PT Configuration.”</td>
</tr>
<tr>
<td>Table*2</td>
<td>NT20, NT20S and NT600S: The following data is received in a batch.</td>
</tr>
<tr>
<td></td>
<td>• Numerical memory table data</td>
</tr>
<tr>
<td></td>
<td>• Character string memory table (String table) data</td>
</tr>
<tr>
<td></td>
<td>• Mark data</td>
</tr>
<tr>
<td>NT21, NT31, NT31C, NT631, and NT631C:</td>
<td>The following data can be received individually.</td>
</tr>
<tr>
<td></td>
<td>• Numerical memory table data</td>
</tr>
<tr>
<td></td>
<td>• Character string memory table (String table) data</td>
</tr>
<tr>
<td></td>
<td>• Bit memory table data</td>
</tr>
<tr>
<td></td>
<td>• Mark data</td>
</tr>
<tr>
<td></td>
<td>• Image data</td>
</tr>
<tr>
<td></td>
<td>• Library data</td>
</tr>
<tr>
<td></td>
<td>• Recipe table</td>
</tr>
</tbody>
</table>

*1: With the NT21, NT31, NT31C, NT631 and NT631C, individual transmission of system memory is restricted as follows:

The following data stored in the Support Tool can not be overwritten.

- Number of numeral table entries
- Number of string table entries
- Number of bit memory table entries
- Screen history setting
- Alarm history setting
- Numerical storage type

The following data can be overwritten.

- Initial screen number
- Screen data comment

*2: It is not possible to perform individual transmission of the mathematical table. The mathematical table will be transmitted only when application transmission is performed.

**Reference:**

- When the Support Tool receives data from a PT, the data being edited at the Support Tool is lost. Therefore, make sure that the edit data is saved in a file before executing data receiving from the PT to the Support Tool.

- With the NT21, NT31, NT31C, NT631, and NT631C, individual uploading of tables is possible. However, it may take time to upload the bit memory table. In this case, perform batch transmission of the application (in file units).
• With the Support Tool on CD-ROM, NT Transfer Utility, which is exclusively used for downloading/uploading the screen data, is supplied (For details, refer to Appendix C).

**Operation procedure**

(1) Select [Connect] (menu bar) → [Upload (PT → NT-series Support Tool)].

The menu is displayed, allowing you to select the data to be received.

The items that can be selected vary according to the PT model.

(Pressing Ctrl key + Shift key + U executes Application uploading.)

(2) Select the data to be received.

The data receiving timing is determined according to the type of data selected to be received.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application (in file units)</td>
<td>Data receiving starts immediately.</td>
</tr>
<tr>
<td>Screen</td>
<td>If a parent screen is included in the screens selected to be received, a dialog box is displayed requesting you to specify whether child screens are to be received with the parent screen. To specify multiple screens in batch, specify the screen numbers in the manner “1, 3 - 5, 7,” delimiting them with commas “,” and hyphens “–.” Set a check mark for the “Include Child Screen” item if you want to receive the child screens with the parent screen. Data receiving starts when [OK] is clicked.</td>
</tr>
<tr>
<td>Direct Access Information</td>
<td>Data receiving starts immediately.</td>
</tr>
<tr>
<td>System Memory</td>
<td>Data receiving starts immediately.</td>
</tr>
<tr>
<td>Table</td>
<td>NT20, NT20S and NT600S: Data receiving starts immediately. NT21, NT31, NT31C, NT631, and NT631C: The dialog box is displayed where the information to be received is specified. Only the information for which a check mark is set is received. Data receiving starts when [OK] is clicked.</td>
</tr>
</tbody>
</table>

(3) Place the PT in the Transmit mode so that the data can be transmitted to the Support Tool.

If the PT is not in the Transmit mode, a timeout error occurs in about 10 seconds at the Support Tool. In this case, set the PT in the Transmit mode and click on [Yes] in the error message dialog box.

(4) While the data is sent from the PT, the progress of data transmission is indicated by a bar graph.

To abort the operation, click on [Cancel].
11-5 Receiving (Uploading) the History Record

It is possible to receive (upload) the display history record data and the alarm history record data, recorded in a PT, at the Support Tool to save them in a file.

The type of history record data that can be received is indicated in the table below.

<table>
<thead>
<tr>
<th>PT Model</th>
<th>Screen Display History Record Data</th>
<th>Alarm History Record Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT11S/NT11, NT20, NT20S</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>NT30, NT30C, NT600S, NT620S, NT620C, NT625C</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>NT21, NT31, NT31C, NT631, NT631C</td>
<td>○</td>
<td>○</td>
</tr>
</tbody>
</table>

The received history record data is saved in a desired folder by assigning a file name. The extension of the file name is fixed as .LOG.

Since the file is described in a special format, the contents cannot be read using Windows general application tools.

**Reference:** The history record data file (.LOG) can be output to a printer, saved in an RTF file, or output to the screen, using the [Print] function or the [Print Preview] function of the Support Tool.

To analyze the history record data using other software, convert the file into an RTF file so that it can be read by other software.

**Operation procedure**

1. Select [Connect] (menu bar) → [Get History Log].
   - The menu is displayed, allowing you to select the history record to be received.
   - The items that can be selected vary according to the PT model.
2. Select the history record to be received.
   - The dialog box for setting the file name for saving the history record is displayed.
3. Set the folder and file name where the history record is to be saved and click on [Save].
   - Receiving of the history record data starts.
4. Place the PT in the Transmit mode so that it can send the data to the Support Tool.
   - If the PT is not in the Transmit mode, a timeout error occurs in about 10 seconds at the Support Tool. In this case, set the PT in the Transmit mode and click on [Yes] in the error message dialog box.
5. While the data is sent from the PT, the progress of data transmission is indicated by a bar graph.
   - To abort the operation, click on [Cancel].
11-6 Setting and Reading the Date and Time

It is possible to set the date and time to PT from the Support Tool or to read the date and time from the PT to display them at the Support Tool.

The functions that can be used are indicated below.

<table>
<thead>
<tr>
<th>PT Model</th>
<th>Setting Date/Time</th>
<th>Reading Date/Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT11S/NT11, NT20, NT20S, NT600S</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>NT21</td>
<td>×*1</td>
<td>×*1</td>
</tr>
<tr>
<td>NT30, NT30C, NT620S, NT620C, NT625C</td>
<td>〇</td>
<td>〇</td>
</tr>
<tr>
<td>NT31, NT31C, NT631, NT631C</td>
<td>×*2</td>
<td>×*2</td>
</tr>
</tbody>
</table>

*1: The NT21 can read clock data from the PLC.

*2: PT has the clock function. For displaying and setting the date/time at a PT, use the System Menu.

Operation procedure

(1) Select [Connect] (menu bar) → [Date and Time].

The date and time dialog box is displayed.

![Date and Time Dialog Box]

**Current Date & Time**
Displays the date and time at the time the dialog box is displayed.

**Date**
This area is used for sending/receiving date data to/from a PT.

To set the date at a PT, set “Year, Month, Day, and Day of Week” here and execute sending (downloading).

Click the **Set** button to download it to the PT.

To read the date data of a PT, execute receiving (uploading) and the result is displayed here.

Click the **Set** button to upload it from the PT.

At first, the same contents as displayed at [Current Date & Time] are displayed.

**Time**
This area is used for sending/receiving the time to/from a PT.
To set the time at a PT, set “Hour, Minute, and Second” here and execute sending (downloading).

Click the button to download it to the PT.

To read the time data of a PT, execute receiving (uploading) and the result is displayed here.

Click the button to upload it from the PT.

At first, the same contents as displayed at [Current Date & Time] are displayed.

Used to download the date and time data, set at [Date] and [Time], to a PT to set them.

Used to upload the date and time data in a PT and display them at [Date] and [Time].

(2) To set the date and time at a PT, set the data at [Date] and [Time] and click on .

To read the date and time of a PT, click on .

Data transmission starts when or is clicked.

(3) Place the PT in the Transmit mode so that communications between the Support Tool and the PT are enabled.

If the PT is not in the Transmit mode, a timeout error occurs in about 10 seconds at the Support Tool. In this case, set the PT in the Transmit mode and click on in the error message dialog box.

(4) In the case of receiving (uploading), the date and time data that have been read from the PT are displayed at [Date] and [Time].
The Support Tool provides a function for displaying various kinds of data, such as screen data and memory table use status, in the form of a list, and printing them.
12-1 Report Types

The Support Tool outputs the following types of report.

- Cross-Reference
- Direct Connection Information
- History Report
- Image/Library Report
- Mark List
- Screen Image
- Screen list
- Table Report
- Validation Report

Output of these reports can be selected from the following three types (use [Print Preview] for outputting to the display).

Printer:
   Screen image, setting data, etc. are output to a printer.

Rich Text Format (file):
   Various setting data, etc. are output to a file in RTF.

Display (print preview):
   Screen image, setting data, etc. are displayed on the screen before output to a printer.

The screen image can be output to a file in bit map format using the [Screen] (menu bar) → [Copy to Image]. (Refer to 12-4 Outputting the Screen Image.)
12-1-1 Cross-References

The use statuses of memory tables such as the numeral memory table and character string memory table (string table) are printed or displayed.

The cross-reference allows you to find the screens where a specific memory table is used.
12-1-2 Direct Connection Information

Direct connection information is printed or displayed.

This report is available only when the direct connection setting data has been set.

<table>
<thead>
<tr>
<th>Direct Connection Information</th>
<th>Filename: SIMLE.E [SIMLE.DE]</th>
<th>9/12/25 8:53 P 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Control Area</td>
<td>IO Comments</td>
<td>Notify Area</td>
</tr>
<tr>
<td>0 D Yes - 1 D0000</td>
<td>Mbr. Numb Disp. 1</td>
<td></td>
</tr>
<tr>
<td>1 D Yes - 2 D0001</td>
<td>Mbr. Numb Disp. 2</td>
<td></td>
</tr>
<tr>
<td>2 D Yes - 1 D0003</td>
<td>Mbr. Tbl Disp. 1</td>
<td></td>
</tr>
<tr>
<td>3 D Yes - 1 D0004</td>
<td>Mbr. Tbl Disp. 2</td>
<td></td>
</tr>
<tr>
<td>4 D Yes - 1 D0005</td>
<td>Mbr. Bgr Disp. 1</td>
<td></td>
</tr>
<tr>
<td>5 D Yes - 1 D0006</td>
<td>Mbr. Bgr Disp. 2</td>
<td></td>
</tr>
<tr>
<td>10 D Yes - 2 D0010</td>
<td>Set. Nm. Input 1</td>
<td></td>
</tr>
<tr>
<td>11 D Yes - 2 D0012</td>
<td>Set. Nm. Input 2</td>
<td></td>
</tr>
<tr>
<td>12 D Yes - 1 D0014</td>
<td>Set. Thumbwheel</td>
<td></td>
</tr>
<tr>
<td>097 D No - 2 - -</td>
<td></td>
<td></td>
</tr>
<tr>
<td>098 D No - 2 - -</td>
<td></td>
<td></td>
</tr>
<tr>
<td>099 D No - 2 - -</td>
<td></td>
<td></td>
</tr>
<tr>
<td>251 D No - 2 - -</td>
<td></td>
<td></td>
</tr>
<tr>
<td>252 D No - 2 - -</td>
<td></td>
<td></td>
</tr>
<tr>
<td>253 D No - 2 - -</td>
<td></td>
<td></td>
</tr>
<tr>
<td>254 D No - 2 - -</td>
<td></td>
<td></td>
</tr>
<tr>
<td>255 D No - 2 - -</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[Numeric Memory Table]

<table>
<thead>
<tr>
<th>Nb</th>
<th>Init Value</th>
<th>Init Storage</th>
<th>Word</th>
<th>RO Address</th>
<th>IO Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Automatic</td>
<td>Yes 0 - - -</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Manual</td>
<td>Yes 0 - -</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
12-1-3 History Report

By specifying the display history record file or the alarm history record file, sent from a PT, the history record data can be printed or displayed.

The history record that can be read by the Support Tool depends on the PT model as shown below (refer to 11-5 Receiving (Uploading) the History Record).

NT30, NT30C, NT600S, NT620S, NT620C, NT625C

- Screen display history record

NT21, NT31, NT31C, NT631, NT631C

- Screen display history record

- Alarm history record

12-1-4 Image/Library Report

A list of the image data and the library data is printed or displayed.

12-1 Section
Report Types

12-1-5 Mark List

A list of mark data is printed or displayed.

Reference: In the case that the font size for Display Properties of Control Panel is set to large font, it may be printed while part of mark list is being chipped off. When it occurs, please select [Start] – [Settings] – [Control Panel], then open the Display Properties and set the font size in Setting to small font, and perform the mark list printing (displaying).

12-1-6 Screen Image

The screen image and the setting contents of a screen are printed or displayed (to print the screen image, add [Screen Image] to the simultaneously printed items. With the default status, check mark is set).

You can select whether or not to inverse screen image for printing. It is also possible to select whether or not to include screen grid or dotted line frame for string display etc. for printing (P461).
**Reference:** It is possible to save each screen image to a bit map file. In this case, open the screen to be saved and select [Screen] – [Copy to Image]. The saved screen image can be edited using the application software such as “Paint.”

### 12-1-7 Screen List

Screen numbers and comments are printed or displayed.

<table>
<thead>
<tr>
<th>Screen No.</th>
<th>Screen Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Menu Screen</td>
</tr>
<tr>
<td>2</td>
<td>Set Screen</td>
</tr>
<tr>
<td>3</td>
<td>Alarm Screen</td>
</tr>
<tr>
<td>4</td>
<td>Monitor Screen1</td>
</tr>
<tr>
<td>5</td>
<td>Monitor Screen2</td>
</tr>
<tr>
<td>6</td>
<td>Alarm Screen</td>
</tr>
</tbody>
</table>

*Screen Numbers and Comments are Printed or Displayed.*
12-1-8 Table Report

The setting contents of memory tables are printed or displayed.

12-1-9 Validation Report

The results of an error check on the setting contents are printed or displayed.

The contents to be printed or displayed are the same as in the error display dialog box.

12-1-10 Mathematical Report

The setting of mathematical table is printed or displayed.
12-1-11 Recipe Report

The setting of Recipe table is printed or displayed.

<table>
<thead>
<tr>
<th>Recipe Table Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Recipe Table]</td>
</tr>
<tr>
<td>No</td>
</tr>
<tr>
<td>----</td>
</tr>
<tr>
<td>0</td>
</tr>
<tr>
<td>1</td>
</tr>
</tbody>
</table>

[Recipe Table Entry] 1
[Record Table]
<table>
<thead>
<tr>
<th>No</th>
<th>Name</th>
<th>Lock</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hawaiian</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>Crispy</td>
<td>0</td>
</tr>
</tbody>
</table>

[Parameter Table]
<table>
<thead>
<tr>
<th>No</th>
<th>Name</th>
<th>Address</th>
<th>Words</th>
<th>Dec/Hex</th>
<th>Sign</th>
<th>No. of Int</th>
<th>No. of Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Salt</td>
<td>--</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>Cheese</td>
<td>--</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>Flour</td>
<td>--</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>0</td>
</tr>
</tbody>
</table>

12-2 Printing Reports

This section describes the procedure for printing reports (screen data, memory table use status, etc.) using a printer.

12-2-1 Printer Setting

To print a report using a printer, it is necessary to set the type of printer and print mode.

To set the printer information, display the Print Setup property by selecting [File] (menu bar) → [Print Setup].

**Printer:** Set the information of the printer you are going to use.

- **Name:** Specify the printer by selecting the printer name from the list of registered printer names.
- **Status:** Displays the status of the selected printer, and the number of files in the queue.
- **Type:** Displays the name of the driver that is set for the selected printer.
- **Where:** Displays the name of the port that is set for the selected printer.
- **Comment:** Displays the comment that is set for the selected printer.
- **Paper:** Set the paper size and the paper tray.
Size: Set the size of paper to be used.
Source: Set the paper tray to be used.
Orientation: Set the direction of printing paper.
  Portrait: Specify this item if the data is to be printed parallel to the shorter dimension of the paper.
  Landscape: Specify this item if the data is to be printed parallel to the longer dimension of the paper.
[Properties]: Used to set the printer properties.
Since the setting differs according to the printer, refer to the manual of the printer driver.

Reference: If the print setup, print, or print preview has been executed under condition that no printer driver has been installed, there may be times Support Tool does not move correctly.

12-2-2 Output to a Printer

To output the report to the printer, follow the procedure shown below.

1) Select [File] (menu bar) → [Print].
   The Reports dialog box is displayed. (page 453)

2) Set “Printer” for [Destination].

3) To specify the printing position of the paper, click on [Set Margins ..] button.
   The Set Margins dialog box is displayed.
   After setting the items in this dialog box, click on OK. The Reports dialog box is displayed again.

4) To set the header/footer, click on the [Header/Footer] button.
   The Header and Footer dialog box is displayed.
   After setting the items in this dialog box, click on OK. The Reports dialog box is displayed again.

5) After completing the setting, click on OK in the Reports dialog box.
   The Print dialog box is displayed. (page 457)
   Set the print range and the number of copies.
(6) After completing the setting, click on **OK** in the Print dialog box.

Printing starts.

Reports dialog box

In this dialog box, the contents of printing, and printing header/footer, are set.

- **Report Type:** Select the type of report to be printed.
- **Destination:** Specify the destination of report output.
  - **Printer:** The report is output to the printer.
  - **Rich Text Format:** The report is output to a file.
- **Header:** Specify this item to attach the header.
  - The contents of header can be specified by pressing **Header/Footer...**.
- **Footer:** Specify this item to attach the footer.
  - The contents of footer can be specified by pressing **Header/Footer...**.

- **Specification of “Screen Image”**

  If you specify “Screen Image” for [Report Type], a dialog for setting and selecting the range and print items is displayed.
Screen Image Attribute

Inverse Print: Specify this item when you want to inverse black and white for printing. When this item is selected, the screen image will be monochrome even when color-printer is used. With the color-type PT, the screen image will be turned to gray and the screen will be inverse for printing.

Hide Screen Grid: Specify this item when you do not want to include screen grid for printing. With the default status, check mark is set. If it is unchecked, the grid is printed according to the grid setting of each screen's property.

Show Dotted Line Frame: Specify this item when you want to include the dotted line frame for the following objects.
- Dotted line frame indicating the position of string input and string display
- Dotted line frame indicating the touch sensing area of touch switch
- Dotted line frame indicating the display position of image/library data of an image lamp
  (The status of an image lamp to be printed depends on the [Simulate ON/OFF] setting of the [View] menu. With lamp ON status, display position of image/library data for OFF state is shown with the dotted line frame and with lamp OFF status, display position of image/library data for ON state is shown with the dotted line frame.)

Screen: Specify the screen to be printed.
- All: Select this item to print all screens.
- Range: Select this item if you want to print only specified screens. Specify the screen numbers using a comma (,) as a delimiter. By joining two page number with a hyphen (–), you can specify the range. (“5 - 12,” for example, indicates the range from screen No. 5 to screen No. 12.)

Include: Specify the items to be printed.
- Screen Image: Specify this to print the screen image.
- Screen Information: Specify this to print the detailed screen setting information.
- Lamp/Touch Switch Number: Specify this when there is a lamp and/or touch switch on the screen and you want to print the allocated bit number of a lamp and/or touch switch. Usually in the case of a touch switch, the allocated bit number specified when setting a lamp is
printed. If the notify bit function is set, however, the notify bit number is printed.

Memory Table Entry Number:
Specify this when there is a character string display, numeral display, bar graph, and/or input setting element on the screen and if you want to print the element with the set memory table entry number.

Image/Library Number:
Specify this when there is image data display and/or library data display on the screen and you want to print the displayed data with the image/library code number.

- Specification of “History Report”
If you specify “History Report” for [Report Type], you are requested to specify the file name where the display history record data sent from the PT is stored.

- Specification of “Validation Report”
If you specify “Validation Report” for [Report Type], you are requested to specify whether an error check is to be executed and then the result of the check is to be printed or the present error log information is to be printed.

If an error check is executed, the existing error log is lost. To keep the record on the error for which the message is displayed like after the conversion, select “Print Current Error Log Window.”

To print the result of error check, click on [OK] after selecting “Print After Validation.” A message asking if you want to execute an error check is displayed. The time necessary for error check execution varies depending on the registered screen data.

Reference: Printing information on errors occurring during data conversion
The procedure for printing information on errors occurring during data conversion is shown below.

(1) Data of NT-series Support Tool
- Open the source file.
• Select [Tools] → [PT Configuration] and specify the PT model (conversion destination).
• Execute data conversion.

Data of DOS version
• Specify the file using [File] → [Import].
• Execute data conversion.

(2) If an error occurs, the message “Application conversion has resulted some messages in Error Log.” is displayed.
Click on  

(3) Select [View] → [Error Log] to display the error log.
(4) Select [File] → [Print] and set the properties as shown below.
• Report Type: Validation Report
• Destination: Printer, or Rich Text Format
• Screen: Print Current Error Log Window

For details of data conversion, refer to Appendix A Data Conversion.

Setting margins

Specify the margins to define the print area.

The units for dimensions can be selected between cm and inch.

Setting footer and header

Specify contents of header and footer to be printed.
The header/footer print position can be set as Left, Center, or Right.

Page numbers, date, time, and file name can be printed automatically.
To select the item to be printed as a header or a footer, move the cursor to the
Print location and click on the corresponding button (Page No., Date).

Print dialog box

Printer: Set the printer to be used.
Range: Specify the pages to be printed.
   All: All pages are printed.
   Pages: Only the specified pages are printed.
   The pages to be printed are specified as a range.

![Print dialog box]

The pages to be specified here are actual print pages and it must be taken into consideration that one screen data does not always correspond to one print page. If you want to print the screens partially, use the “Print Preview” function to check the correspondence between pages and screens to specify pages.

Print to File: Specify this item to output the contents to be printed to a file. The file format differs depending on the printer used. After setting a check mark in the check box, click on: the file name setting dialog box is displayed.

Copies: Specify the number of copies to be printed.
Number of copies: Set the number of copies.
Collate: Specify if the same page is printed in a group when printing multiple copies. (The same page is printed in a group if a check mark is set in the check box.)

12-2-3 Output to a File (RTF)

Reports can be output to a file in the rich text format.

The operation for outputting the reports to a file is basically the same as that for printing them.

Reference: The rich text format is a file format used for document data; in this file format, information such as characters and indents is retained. The data saved in this format is highly interchangeable among Windows 95/98 applications.

Operation procedure to output to a file is shown below:

(1) Select [File] (menu bar) → [Print].
   The Report dialog box is displayed. (page 453)
(2) Set “Rich Text Format” for [Destination].
(3) To specify the print position of the paper, click on [Set Margins ..].
   The Set Margins dialog box is displayed.
   After setting the items in this dialog box, click on [OK]. The Reports dialog box is displayed again.
(4) To set the header/footer, click on the [Header/Footer].
   The Header and Footer dialog box is displayed.
   After setting the items in this dialog box, click on [OK]. The Reports dialog box is displayed again.
(5) After completing the setting, click on **OK** in the Reports dialog box.

If you click on **OK** in the Reports dialog box, the dialog box used to specify the report output file is displayed. Specify the file name and click on **Save**, then the report is output to a file.

For details on operations at the Reports dialog box, the Set Margins dialog box, and the Header and Footer dialog box, refer to 12-2-2 Output to a Printer.

### 12-3 Displaying the Print Image (Preview)

Before printing a report, it is possible to visually check the print image on the screen.

The procedure for displaying the print image is basically the same as that for outputting the report to a printer.

Operation procedure to display the print preview is shown below:

1. Select [File] (menu bar) → [Print Preview]. The Reports dialog box is displayed.

2. To specify the print position of the paper, click on [Set Margins ..]. The Set Margins dialog box is displayed. After setting the items in this dialog box, click on **OK**. The Reports dialog box is displayed again.

3. To set the header/footer, click on the [Header/Footer]. The Header and Footer dialog box is displayed. After setting the items in this dialog box, click on **OK**. The Reports dialog box is displayed again.
(4) After completing the setting, click on [OK] in the Reports dialog box.

For details, Reports dialog box, the Set Margins dialog box, and the Header and Footer dialog box, refer to 12-2-2 Output to a Printer.

The operation procedure at the preview screen is shown below.

Print: Specify this item to output the data to the printer.
Next Page: Specify this item to display the next page.
Prev Page: Specify this item to display the previous page.
Two Page: Specify this item to display two pages on the screen.
Zoom In: Specify this item to enlarge the displayed image.
   After moving the cursor to the desired position, click the mouse and the specified area is enlarged.
Zoom Out: Cancels the enlarged display mode.
Close: Closes the print preview screen.

12-4 Outputting the Screen Image

It is possible to output only the data creation screen in the bit map format. The output data can be used in other applications to be displayed or printed.

The operation procedure for outputting the screen image is shown below.

(1) Display the screen to be output at the front.
(2) Select [Screen] (menu bar) → [Copy to Image].
   The file name setting dialog box is displayed.
(3) Specify the folder and file name and click on [Save].
Reference: The screen image of the editing screen is saved in the bit map file without change. If you want to save an inverted image to a file, select [File] - [Print] and set “Screen Image” for “Report Type” and “Rich Text Format” for “Destination,” set a check mark for “Inverse Print” and output it. (Refer to 12-2-3 Output to a File (RTF).) If you use this method, the screen image will be monochrome even when the color-printer is used.
APPENDICES

This section provides reference information on using the Support Tool, information on the operational procedure for the system installer which is supplied with the Support Tool. Please refer to the information that you need.

A  Data Conversion ................................................................. 463
B  System Installer Operation .................................................. 487
C  NT Transfer Utility ............................................................... 493
D  Translation Support Utility .................................................... 451
E  Tables of Functions of PT Models .......................................... 517
F  Limits on Numbers of Elements ............................................ 537
G  New Functions of Support Tool Ver.4.1 ................................. 541
H  New Functions of Support Tool Ver.4.6 ................................. 543
I  New Functions of Support Tool Ver.4.7 ................................. 545
J  New Functions of Support Tool Ver.4.8 ................................. 547
K  Error Messages ..................................................................... 549
L  Shortcut Keys ...................................................................... 555
M  Connecting Cable Specifications .......................................... 557
N  Keycode Tables and Conversion Rule ..................................... 559
Appendix A
Data Conversion

This section describes the data conversion method between different direct access types and different PT models.

In the following explanation, the NT20, NT20S, NT30, NT30C, NT600S, NT620S, NT620C, and NT625C are referred to as "conventional models" and the NT21, NT31, NT31C, NT631, and NT631C (including models with "-V1," "-V2 (System Ver. 2.1)" and "-V2 (System Ver.3.1)") are referred to as "new models."

Direct Access Types

Direct access type can be set at “PLC Vendor” of “PT Type (PT Configuration).” Changing PLC vendor of existing screen data changes direct access type. The direct access types that can be handled by the Support Tool (Ver. 4.) are as follows;

OMRON: This is a direct access for OMRON PLCs

Memory Link: This is a simulative direct access with which host and PT execute sending or receiving of command via RS-232C/422A communication.

Mitsubishi A: This is a direct access for Mitsubishi A series PLC.

Mitsubishi FX: This is a direct access for Mitsubishi FX series PLC.

Memory Link, Mitsubishi A and Mitsubishi FX can be set only with NT31, NT31C, NT631 and NT631C with “-V1” and above.

Reference: The direct access version that can be handled by the Support Tool is:

NT20S, NT600S:  Ver. 5

Conventional models other than NT20, NT20S, NT600S:

Ver. 4

New models: No direct access versions

• Depending on the direct access types, exclusive system program may be needed for the PT hardware.

For details of the system programs and system installer, refer to Appendix B System Installer Operation.

• Direct access version 4 screen data for the NT20S or NT600S, or direct access version 3 or lower screen data from previous PT models can be used on Windows by using version 4 or 5 of the Support Tool for Windows.

• NT20M/NT600M screen data can be reused by converting it to NT20S/NT600S screen data using the Support Tool for Windows. Refer to the Support Tool for Windows Operation Manual (Cat. No. V028-E1-□).

• To create screen data to be used for direct access (PLC vendor) other than OMRON, Memory Link, Mitsubishi A and Mitsubishi FX, use system installer of DOS version.

Conversion between different direct accesses (PLC vendor)

With the Support Tool (Ver. 4.□), data conversion between different direct accesses such as OMRON→Mitsubishi A or Mitsubishi FX→OMRON is possible.
However, data conversion between different direct accesses is limited to data of the same PT model. (e.g., Between NT31-V1 data for OMRON and Mitsubishi A).

When both direct accesses and PT model are different, convert data to that of the same PT model first (see figures in next page) and then convert the direct access type.

Conversion between conventional PT models (Between same direct access)

Conversion from conventional PT model to new PT model (Between same direct access)

Conversion between new PT models (Between same direct access)

It is possible to convert the screen data for the lower system program version to that for the higher system program version freely regardless of the PT models. (e.g., from "-V1" to "-V2" or from "-V2" to "-V2 (System Ver3.1)). However, conversion towards the opposite direction is not possible (ex. PT models with V1 → PT models without -V1 or higher system program version → lower).
system program version).
When the PT models with the large screen size are converted to those with the
smaller screen size (ex. NT631 → NT31), the elements exceeding the screen
size after conversion are deleted.
Note that when the screen data is converted, user group and grid information will
be lost.

Reference:
• The data conversions shown above indicate the conversion of entire screen
data files.

If an element registered to the symbol manager is registered for a screen of
another PT model, the data is converted. In this case, conversion is performed in
element units. For data conversion in element units, the restrictions shown
above are not applicable and element data can be converted between any com-
bination of PT models.

• You cannot convert both the PT Model and PLC Vendor at the same time (an
error message will be displayed). First, change either of them and then perform
conversion a second time.

Data Conversion Procedure

The data conversion procedure is shown below.

(1) Open the existing screen data file.

Open the existing screen data file that is the source for data conversion.

If the data has been created using the DOS version Support Tool, select
[File] (menu bar) → [Import] in the Support Tool screen to open the file.

For details of the operation, refer to 3-3-2 Reading the Existing Screen Data
(Application) File or 3-3-5 Importing (Reading) the DOS Version Screen
Data (Application) File.

(2) Convert the data.

At the Support Tool, select [Tools] (menu bar) → [PT Configuration], then se-
lect the [PT Type] tab. Select the conversion destination PT model or PLC
Vendor (refer to Dialog Box Settings in the PT configuration on page 46).

Click on [OK], and the data conversion confirmation message is dis-
played. Click on [OK] again to execute data conversion.

• NT11S/NT11 cannot convert to other model from [PT Configuration]. If you
want, please use symbol manager to convert to other model.

Reference:
• After converting the screen data, there might be some messages in the error
log. This error messages will disappear when the screen data has been edited.
Especially for the converting errors, it is not possible to reproduce these errors
even if the error check (Validation) has been performed. So soon after the con-
verting error occurs, it is recommended to perform “Print Current Error Log
Window.” The operation for this, refer to 12-2 Printing Reports.

• When converting the screen data to the NT21 or the NT31, NT31C, NT631 or
NT631C using “-V2,” the specification of NT20/30/620 Compatible Mode is
possible. (For details of NT20/30/620 compatible mode, refer to Appendix A
NT20/30/620 Compatible Mode). For details of the modification of screen data
and program at the host, refer to Correcting the NT21, NT31, NT31C, NT631,
and NT631C screen data after conversion on page 467).
(3) Change the allocated bits and words

If necessary, change the allocated bits and words.

Usually, it is not necessary to change the allocated bits and words since their settings in the conversion source data are reflected in the converted data. However, if the data is converted from the NT21, NT31, NT31C, NT631, or NT631C to a conventional model in element units, or if the data is converted between different direct access types, modification of the allocated bits and words may become necessary since the range of usable word addresses differ. For details, refer to Correcting the PC (PLC) addresses on page 468.

(4) Correct the screen data

If the data is converted from a PT model to another PT model that has smaller screen than the source PT model, it is necessary to modify the screen data in accordance with the screen size.

If data is converted between a conventional model and a new model, the data must be corrected in accordance with the conversion destination because there are many differences between a conventional model and a new model.

Refer to page 466.

(5) Modify the program.

If the screen data is corrected, the program at the host may have to be modified. Modify the program by referring to “Correcting the Screen Data Conversion” (page 466).

Correcting the Screen Data Conversion

This section describes how the screen data should be corrected after it has been converted.

If the screen data cannot be converted correctly, an error message is displayed on conversion of the data (when changing a PT model or PLC Vendor, or registering a symbol from the symbol manager). If an error message is displayed, it will be necessary to correct the screen data or the program.
### Correcting the NT11, NT21, NT31, NT31C, NT631, NT631C screen data after conversion

If the screen data is converted to the NT21, NT31, NT31C, NT631 or NT631C, the following modification of the screen data and program is needed according to the source/destination PT model.

<table>
<thead>
<tr>
<th>Convert From</th>
<th>Convert To</th>
<th>Modification needed</th>
</tr>
</thead>
</table>
| NT30, NT30C, NT620S, NT620C, NT625C | NT31, NT31C, NT631, NT631C with `~V1~` *1 | • If image/library is inserted into a lamp/touch switch label or a character string, modification of screen data is needed. For how to perform the correction, refer to [Correction of image codes](#) or [Correction of library codes](#).  
• Word configuration of PT control/notify area differs between the source and destination PT model. Check the program at the host and make corrections. For details, refer to [Appendix A NT20/30/620 compatible mode](#).  
• If a keyboard screen is used, the size of the keyboard screen frame needs to be checked/adjusted. For how to perform the correction, refer to [Correction related to keyboard screens](#). |
| NT20S | NT21 | • Word configuration of PT control/notify area differs between the source and destination PT model. Check the program at the host and make corrections. For details, refer to [Appendix A NT20/30/620 Compatible Mode](#).  
• Some changes will occur on the screens, such as in the sizes of touch switches and the positions of objects, check all converted screens and correct them as necessary. |
| NT30, NT30C, NT620S, NT620C, NT625C | NT31, NT31C, NT631, NT631C with `~V2~` or `~V3~` *2 | If a keyboard screen is used, the size of the keyboard screen frame needs to be checked/adjusted. For how to perform the correction, refer to [Correction related to keyboard screens](#). |
| NT31, NT31C, NT631, NT631C with `~V1~` | NT31, NT31C, NT631, NT631C with `~V2~` or `~V3~` | Not needed. |
| NT31, NT31C, NT631, NT631C with `~V2~` | NT31, NT31C, NT631, NT631C with `~V2~` or `~V3~` | Not needed. |
| NT21 | NT31 with `V2` | Not needed. |
| NT11S | NT11 | Not needed. |

*1: When converting the screen data from NT30/620 series to NT31/631 series, we recommend converting to NT31, NT31C, NT631, NT631C with “~V2~” using NT30/620 compatible mode. This requires less modification of screen data and is easy to perform. In this case, check if the system program installed in the PT is Ver3.□ or Ver 4.□. For details of how to install the system program, refer to [Appendix B System Installer Operation](#).

*2: On conversion, check if “NT20/30/620 Compatible Mode” ([PT Configuration] – [PT Type] is selected). (In the default status, the check mark will be ON when trying to convert screen data from the NT20S, NT30, NT30C, NT620S, NT620C, and NT625C to the NT21, NT31, NT31C, NT631, and NT631C with “~V2~” or “~V3~”).

#### Correcting colors

- Conversion from monochrome display models to color display models  
  Colors (black and white) remain as they are after the conversion.

  If you want to color the converted data, change or color the data as needed.
• Conversion from color display models to monochrome display models

Colors are converted into black or white as shown below.

Colors for objects other than Image

- Black, blue, red, magenta: Black
- Green, cyan, yellow, white: White

Colors for Image

- Black: Black
- Blue, red, magenta, green, cyan, yellow, white: White

Change the colors as needed.

Correcting the PLC addresses (On data conversion between direct accesses)

When converting the data between different direct accesses, it may be necessary to change PLC addresses since corresponding PLC is changed. In this manual, conversion between OMRON and MEMLINK is described.

• Difference

OMRON: Various words are available such as CIO area and data memory area.
Available word addresses differ depending on the PLC that is used.

MEMLINK: Only memory link area (PT memory) can be used.
Available word addresses: 0000-9999

• Conversion result, error message and corrective action.

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With OMRON data, an area other than the CIO area is set.</td>
<td>The PLC address is reset.</td>
<td>PLC address (XXX) of YYY is invalid. It is reset to default.</td>
<td>Reset the area to memory link area (PT memory). If this PC (PLC) address is referred to from the program, it is necessary to correct the program accordingly. (Refer to 6-1-10 Setting Properties.)</td>
</tr>
</tbody>
</table>

Correcting the PC (PLC) addresses (On data conversion between PT models)

When converting the data of the entire screen data file, screen data for use with new models cannot be converted to screen data for use with conventional models. However, if the data of a new model is registered for the screen of a conventional model using the symbol manager, the following points must be taken into consideration due to differences in the usable PC (PLC) address range between a conventional and a new model.

• Difference

New models: Word addresses can be handled up to five digits.
Conventional models: Word addresses can be handled up to four digits.

• Conversion result, error message and corrective action
**Correction related to continuous screens**

When the data of a conventional model is converted into data for a new model, an error may occur due to differences in the handling of continuous screens between conventional models and new models.

- **Difference**
  - New models: Continuous screens cannot be used.
  - Conventional models: Continuous screens can be used.

- **Conversion result, error message and corrective action**

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With conventional models, continuous screens are used.</td>
<td>The parent screen of the continuous screens is deleted.</td>
<td>The screen no. XXXX was a Continuous Parent Screen that is not supported in this model. It is discarded.</td>
<td>Use a touch switch to switch screens. If the program is created to display the parent screen of continuous screens, correct the program so that the first child screen is displayed. (Refer to 6-8-2 Switch Screen Touch Switch.)</td>
</tr>
</tbody>
</table>

**Correction related to overlapping screens**

When overlapping screens are converted, an error may occur due to differences in the handling of overlapping screens between conventional models and new models.

- **Difference**
  - New models: A window/keyboard screen cannot be specified as a child screen.
  - Conventional models: A window/keyboard screen can be specified as a child screen.

- **Conversion result, error message and corrective action**
Appendix A

Data Conversion

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a conventional model, a window/keyboard screen is specified as a child screen.</td>
<td>With a new model, a window/keyboard screen is removed from child screens.</td>
<td>The screen no. XXX of type YYY is not supported as a child, so the parent-child association is discarded.</td>
<td>Copy the contents of the window/keyboard screen to a standard screen and specify that standard screen as a child screen. (Refer to 5-3-2 Overlapping Screens)</td>
</tr>
</tbody>
</table>

Correction related to number of window/keyboard screens to be opened

When a window/keyboard screen is converted, conversion is executed as shown below due to differences in number of window/keyboard screens that can be displayed at the same time.

- Difference

New models (NT21, NT31/631-V1 and above):

- Up to three window/keyboard screens can be opened at the same time. (1 Global Window and 2 Local Windows)
- With a screen attribute, up to two local windows can be specified as pop-up windows to be displayed when the screen is opened.
- With a touch switch (cursor move and input key-window/keyboard function), specification of local window 1 or 2 is possible.

Conventional models, New models (NT31/631):

- Only one window/keyboard screen can be opened. (Local window 1 (keyboard) only)
- With a screen attribute, only one window can be specified as a pop-up window to be displayed when the screen is opened.
- With a touch switch (cursor move and input key-window/keyboard function), specification of only local window 1 (keyboard) is possible.

- Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a new model with &quot;-V1&quot; and above, local window 2 is specified for the attribute of touch switch. And the touch switch is registered to the symbol manager.</td>
<td>Minimum value is restored for window/keyboard screen number.</td>
<td>Input Key-Window/Keyboard screen number is not within the valid range. Minimum value restored.</td>
<td>Correct the screen data so that the local window 1 includes all the required elements.</td>
</tr>
</tbody>
</table>

Correction related to display range of window/keyboard screens

When a window/keyboard screen is converted, conversion is executed as shown below due to differences in the window/keyboard screen display range between a conventional and a new model.

- Difference:

New models: A window/keyboard screen can be specified only in the range that fits the touch switch grids.
Conventional models: A window/keyboard screen can be specified at any desired position.

- Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a conventional model, a range that does not fit the touch switch size is specified as the display range.</td>
<td>With a new model, the range is corrected so that it agrees with the touch switch positions.</td>
<td>Some screen elements exceed frame size. The elements will not be downloaded to PT Hardware.</td>
<td>If the position and the range of the window to be displayed is inconvenient for operation, correct the position and the range. (Refer to 5-4 Window/Keyboard Screens.)</td>
</tr>
</tbody>
</table>

Correction related to the system initializing screen (Host Connect screen)

When the system initializing screen is converted, conversion is executed as shown below due to differences in screen numbers and elements that can be registered between conventional and new models.

- Difference

New models: Screen No. 9000
- Only fixed display elements (excluding image data and library data) can be registered.

Conventional models: Screen No. 1999
- All kinds of element can be registered.
- Some elements that need communications with a host may not be displayed correctly.

- Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a conventional model, elements that cannot be registered on a new model are registered.</td>
<td>With a new model, the screen No. is modified to 9000. Elements that cannot be registered for a new model are removed.</td>
<td>This screen does not support XXX. It is discarded.</td>
<td>Correct the screen so that the same screen as before the conversion is created using fixed display elements excluding image/library data. (Refer to 5-8 Host Connect Screen (System Initializing Screen))</td>
</tr>
</tbody>
</table>

Correction related to extended screens

When an extended screen is converted, an error message may be displayed due to differences in the handling of an extended screen between conventional and new models.

- Difference

New models: Extended screens are not supported.

Conventional models: Extended screens can be used as standard screens.

- Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a conventional model, the screen number of an extended screen is used for a standard screen.</td>
<td>With a new model, the screen is treated as a standard screen.</td>
<td>The screen no. XXX was an Extended Screen that is not supported by this model, so it is converted to a standard screen.</td>
<td>—</td>
</tr>
</tbody>
</table>
Data Conversion

Appendix A

Correction related to history screens

When a history screen is converted, an error message may be displayed due to differences in the handling of the screen numbers of the frequency history screen and the occurrence history screen between conventional and new models.

- **Difference:**
  
  **New models:** Screen No. 9001 and No. 9002
  History screens (occurrence order, frequency order) cannot be edited.

  **Conventional models:** Screen No. 1997 and No. 1998
  History screens (occurrence order, frequency order) can be edited.

- **Conversion result, error message and corrective action**

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a conventional model, a history screen (occurrence order, frequency order) is edited.</td>
<td>With a new model, the history screen is deleted (displaying the edited history screen is possible by specifying it from a PT).</td>
<td>The screen no. xxx was a history occurrence (frequency) screen that is not supported in this model. It is discarded.</td>
<td>—</td>
</tr>
</tbody>
</table>

Correction related to the number of memory tables

Since the number of entries that can be used in the memory tables depend on the PT model, conversion is executed in the manner shown below.

- **Difference**

<table>
<thead>
<tr>
<th>NT11S/NT11</th>
<th>NT20/NT20S</th>
<th>NT600S</th>
<th>NT30/NT30C</th>
<th>NT620S/NT620C/NT625C</th>
<th>NT21/NT31/NT31C/NT631/NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeral memory table</td>
<td>128</td>
<td>128</td>
<td>512</td>
<td>512, or 1000</td>
<td>512, 1000, or 2000</td>
</tr>
<tr>
<td>Character string memory table (String table)</td>
<td>128</td>
<td>128</td>
<td>256</td>
<td>256, or 1000</td>
<td>256, 1000, or 2000</td>
</tr>
<tr>
<td>Bit memory table</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>256</td>
<td>256, or 1000</td>
</tr>
<tr>
<td>Extended I/O input table</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>64</td>
<td>—</td>
</tr>
<tr>
<td>Extended I/O output table</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>64</td>
<td>—</td>
</tr>
<tr>
<td>F-key input notify table</td>
<td>4</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

- **Conversion result, error message and corrective action**

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A memory table number that is outside the allowable range for the memory table is used for display or input.</td>
<td>The memory table number is reset to 0.</td>
<td>[Object Name] refers to invalid numeral table entry. The referenced table entry is reset to entry 0.</td>
<td>Correct the memory table number to the one that is in the valid range. If the memory table number is specified in a program, correct it also. (Refer to Dialog Box Settings in the PT Configuration on page 46.)</td>
</tr>
</tbody>
</table>
Correction related to contents of numeral memory table

When the data of a conventional model is converted to the data for a new model, the converted data requires your attention to the fact that the processing that occurs if incorrect data (existence of A to F other than F at the most significant bit position) is written to an allocated word in the host differs between a conventional and a new model.

- Difference

New models: The written data is invalid and the existing content is retained.

Conventional models: The incorrect data is stored.

- Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note that the display differs between a conventional and a new model if incorrect data is written. (Refer to 7-2 Numerical Memory Table.)</td>
</tr>
</tbody>
</table>

Correction related to bit memory table

If a bit memory table is converted from the conventional model to the new model, conversion will be executed in the manner shown below due to the difference of the bit memory table function.

- Difference

New models: Alarm function and switch screen function cannot be set simultaneously.

Conventional models: Alarm function and switch screen function can be set simultaneously.

- Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Switch screen]: OFF</td>
<td>Function: None</td>
<td></td>
<td>Change function to [Alarm], if you want to display the alarm. (Refer to 7-4 Bit Memory Table.)</td>
</tr>
<tr>
<td>[Screen No]: 0</td>
<td>[Switch screen]: OFF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Screen No]: 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Function: Alarm</td>
<td></td>
<td>Correction is not necessary.</td>
</tr>
<tr>
<td>[Switch screen]: OFF</td>
<td>[Switch screen]: ON</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[Screen No]: As desired</td>
<td>[Screen No]: As desired</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[Switch screen]: OFF</td>
<td>Function: Alarm</td>
<td></td>
<td>Correction is not necessary.</td>
</tr>
<tr>
<td>[Screen No]: 0</td>
<td>[Switch screen]: ON</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Screen No]: 9999</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[Switch screen]: ON</td>
<td>Function: Alarm</td>
<td></td>
<td>Change the function to [Switch screen]. (Refer to 7-4 Bit Memory Table.)</td>
</tr>
<tr>
<td>[Screen No]: As desired</td>
<td>[Switch screen]: ON</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Screen No]: As desired</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Correction related to extended I/O input/output table

When an extended I/O input/output table is converted, the data is converted in the manner shown below due to differences in the handling of an extended I/O input/output table between NT30/NT30C and other models.

- Difference

NT30/NT30C: Extended I/O input/output table can be used.

Other models: Extended I/O input/output table cannot be used.
Data Conversion

Appendix A

Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With an NT30/NT30C, an extended I/O input/output table is set.</td>
<td>With a PT model other than NT30/NT30C, the setting of an extended I/O input/output table is discarded.</td>
<td>—</td>
<td>Correct the screen data and a host program so that unusable table entries can be replaced with inputs/outputs of a host, etc. (Refer to 7-5 Extended I/O Input Table and 7-6 Extended I/O Output Table.)</td>
</tr>
</tbody>
</table>

Correction of image codes

When an image code is converted between a conventional and a new model, conversion is executed in the manner shown below due to differences in the image codes between them.

- **Difference**
  - New models: 0001 to 0FFF (hexadecimal)
  - Conventional models: FE20 to FEFF (hexadecimal)

- **Conversion result, error message and corrective action**

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conventional model Assume the code is X.</td>
<td>New model The code is X – FE1F.</td>
<td>[E] Image Table entry has been converted. [W] The code for screen element [Object Name] has been converted from XXXX to YYY.</td>
<td>If the code after conversion differs from the image code to be used, change the code to the correct one. (Refer to 8-1 Image Editor.)</td>
</tr>
<tr>
<td>New model Assume the code is Y.</td>
<td>Conventional model The code is Y + FE1F (if the converted code is outside the usable range, the code is fixed as FE20.)</td>
<td>[W] The code for screen element [Object Name] has been converted from XXXX to YYY.</td>
<td></td>
</tr>
</tbody>
</table>

Correction of library codes

When a library code is converted between a conventional and a new model, conversion is executed in the manner shown below due to differences in the library codes between them.

- **Difference**
  - New models: 1000 to 3FFF (hexadecimal)
  - Conventional models: FA20 to FAFF, FB20 to FBFF, FC20 to FCFF, FD20 to FDFF (hexadecimal)

- **Conversion result, error message and corrective action**
Correction related to image/library in character strings

When an image/library in a character string is converted between a conventional and a new model, conversion is executed in the manner shown below due to differences in handling of the image/library between them.

- Difference

  New models: Insertion of an image/library into a character string is impossible except for NT21, NT31/631-V2 and later models in NT20/30/620-compatible mode.

  Conventional models: Insertion of an image/library into a character string is possible.

- Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a conventional model, the image/library is used in a character string.</td>
<td>With a new model, the code is displayed like this: <code>&lt;!xxxx&gt;</code> ''. (The code after conversion conforms to the image/library code conversion method.)</td>
<td>[E] Image Table entry has been converted. [E] String Table: Table Entry XXXX has invalid component code. It has been converted from XXXX to YYYY.</td>
<td>Delete a code in the character string and make corrections so that the character string and image/library (fixed display or image lamp) are overlapped for display or grouped, allowing the image/library to be displayed in the same way as a character string. (Refer to 6-1-7 Grouping Elements.) (In case of lamp/touch switch label, a fixed display-image goes behind the label and the display will not be as desired. In this case, use an image lamp instead.)</td>
</tr>
</tbody>
</table>

Correction of graphic display attributes

When a graphic is converted between a conventional and a new model, conversion is executed as shown below due to differences in the display attributes.

- Difference

  New models: The inverse attribute is not supported for some kinds of graphic.

  Conventional models: All graphics have inverse attributes.
Appendix A

Data Conversion

- Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a conventional model, the inverse attribute is specified for a graphic for which the inverse attribute is not supported by a new model.</td>
<td>With a new model, the foreground color and background color are automatically interchanged.</td>
<td>[Object Name] – inverse attribute not supported. Foreground and background colors interchanged.</td>
<td>Since the foreground color and background color are automatically interchanged, no special correction is required (display attribute is set to default (standard)).</td>
</tr>
</tbody>
</table>

**Correction of smoothing processing for marks**

If a mark is converted between a conventional and a new model, conversion is executed in the manner shown below due to differences in the handling of mark smoothing processing between them.

- Difference

  New models: Smoothing processing is not possible for marks.
  Conventional models: Smoothing processing is possible for marks.

- Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a conventional model, smoothing processing is specified for a mark.</td>
<td>With a new model, smoothing processing is invalid for a mark.</td>
<td>[Fixed Display Mark] – smoothing not supported. It is ignored.</td>
<td>Correction not necessary.</td>
</tr>
</tbody>
</table>

**Correction related to the system keypad**

If a system keypad is converted between a conventional and a new model, conversion is executed in the manner shown below due to differences in the handling of the system keypad between them.

- Difference

  New models: The system keypad cannot be set.
  Conventional models: Numeric keys can be created automatically by setting a system keypad.

- Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a conventional model, a system keypad is automatically created with a numeral setting input screen.</td>
<td>With a new model, the system keypad is invalid and thus not displayed.</td>
<td>—</td>
<td>Either copy the registered keyboard from the symbol manager (refer to 6-10 Registering Created Elements (Symbol Manager Operation)), or create numeric keys that are equivalent to a system keypad using the touch switch control code input function (refer to 6-8-5 Control Code Input Touch Switches).</td>
</tr>
</tbody>
</table>

**Correction of alarm list/history touch switches**

If a touch switch for alarm list/history is converted between a conventional and a new model, conversion is executed in the manner shown below due to differences in the handling of this kind of touch switch between them.
Appendix A

Data Conversion

• Difference

New models: Control touch switches are annexed to alarm lists/histories; correction is possible only with regard to the position of the touch switches. When converted to the NT21, NT31/631-V2 or later models (NT20/30/620-compatible mode ON) associated touch switches will keep other properties, as it is, only thing is that it cannot be edited separately.

Conventional models: Control touch switches can be handled as independent touch switches (to be associated with alarm lists/histories). Their position, size, label, etc. can be edited as desired.

Switches: When converted to the NT21, NT31/631-V2 models (20/30/620 mode on) associated touch switches will keep other properties, as it is, only thing is that it cannot be edited separately.

• Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a conventional model, an alarm list/history is registered for a screen and touch switches are associated with it.</td>
<td>With a new model, the associated touch switches are deleted and the control touch switches (in the initial state) are automatically created. When converted to the NT21, NT31/631-V2 or later models (NT20/30/620-compatible mode on) associated touch switches will be converted to control touch switches, other properties remaining the same.</td>
<td>[E] Touch Switch function type is not supported. It is discarded. [W] The associated touch switches of the alarm has been discarded and component touch switches have been created. No error message will be generated.</td>
<td>Adjust the position of control touch switches if necessary. (Refer to 6-3 Alarm.)</td>
</tr>
<tr>
<td>With a conventional model, an alarm list/history is registered for a screen (without control touch switches).</td>
<td>With a new model, control touch switches (in the initial state) are automatically created.</td>
<td>[W] The associated touch switches of the alarm have been discarded and component touch switches have been created.</td>
<td>If control touch switches are not necessary, delete them by setting in the alarm list/history properties. (Refer to 6-3 Alarm.)</td>
</tr>
<tr>
<td>With a new model, touch switches are automatically created by registering alarm list/history to the symbol manager.</td>
<td>With a conventional model, all control touch switches are deleted.</td>
<td>[W] The component Touch Switches of the Alarm List will be discarded.</td>
<td>Create the control touch switches using the touch switch control code input function and associate them with the alarm list/history. (Refer to 6-8-5 Control Code Input Touch Switches.)</td>
</tr>
</tbody>
</table>

Correction of touch switch position and size

Touch switch size differs between NT20, NT20S, NT600S, NT620S and other PT models. Therefore, when the data of NT20, NT20S, NT600S, NT620S is converted to the data for other PT models, touch switch position and size may change.
### Appendix A

#### Data Conversion

**Conversion result, error message and corrective action**

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>—</td>
<td>Touch switch position and size may change.</td>
<td>—</td>
<td>Correct the touch switch position and size as needed. (Refer to 6-8 Touch Switches)</td>
</tr>
</tbody>
</table>

**Correction related to a touch switch for which a pop-up window/keyboard function is set**

If a touch switch assigned the pop-up window/keyboard function is converted between a conventional and a new model, conversion is executed in the manner shown below due to differences in the range of screen numbers of the touch switch window/keyboard screen.

**Difference**

- **New models:** Screen numbers of window/keyboard screen: 1 to 3999
- **Conventional models:** Screen numbers of window/keyboard screen: 1900 to 1979

**Conversion result, error message and corrective action**

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a new model, the touch switch for which a pop-up window/keyboard function is set is registered to the symbol manager.</td>
<td>With a conventional model, the window/keyboard screen number is corrected to 1900.</td>
<td>Input Key-Window/Keyboard screen number is not within the valid range. Minimum value restored.</td>
<td>Create the window/keyboard screen for a screen number in the range 1900 to 1979 and correct the window/keyboard screen number set for the touch switch accordingly. (Refer to 5-4 Window/Keyboard Screens and 6-8-4 Pop-up Window/Keyboard Function Touch Switch.)</td>
</tr>
</tbody>
</table>

**Correction related to the touch switch for which the copy function is set**

If a touch switch assigned the copy function is converted between a conventional and a new model, conversion is executed in the manner shown below due to differences in the range of numeric values that can be input.

**Difference**

- **New models:** As a constant for the copy setting function, a numeric value of up to 10 digits can be input.
- **Conventional models:** As a constant for the copy setting function, a numeric value of up to 8 digits can be input.

**Conversion result, error message and corrective action**

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a new model, a touch switch for which the copy setting function is set with a numeric value greater than 100000000 or smaller than −10000000 specified is registered to the symbol manager.</td>
<td>With a conventional model, a value greater than 100000000 is corrected to 99999999 or a value smaller than −10000000 is corrected to F0000000.</td>
<td>[W] Constant Value is out of limit. Maximum value restored.</td>
<td>Correct the screen data or the program in the host so that a constant of up to 8 digits suffices. (Refer to 6-8-6 Copy Setting Touch Switch.)</td>
</tr>
</tbody>
</table>
Corrections related to lamp/touch switch label

In the conversion of data between a V2 model and a non-V2 model/conventional model, conversion is executed in the manner shown below due to differences in the new functions of the lamp/touch switch label added to V2 models.

- **Difference**
  - V2/V3 models: Multiple lines of label, On Off Static label, Numeral/String Display label can be set.
  - Conventional models, non-V2/V3 models: Only fixed display label (one line) can be set.

Conversion from conventional models to V2/V3 models

- **Conversion result, error message and corrective action**

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a conventional model, a fixed display object is used with a label to display multiple label lines.</td>
<td>With a V2/V3 model, multiple label lines can be set (no need to add a fixed display object.)</td>
<td>*1</td>
<td>Create multiple label lines using Label property (6-5-1 Standard Lamps or 6-8 Touch Switches) and delete fixed display objects.</td>
</tr>
<tr>
<td>With a conventional model. A numeral/string display object is created on a lamp/touch switch.</td>
<td>With V2/V3 models. numeral/string display labels can be set.</td>
<td>*1</td>
<td>Select “Numeral Display” or “String Display” as the Label Type in Label Property for the lamp/touch switch. Make the setting as required. Delete the numeral/string display objects created on the lamp/touch switch.</td>
</tr>
</tbody>
</table>

*1: It is also possible to use the screen data after conversion without performing the above modification.

Conversion from V2/V3 models to conventional models

- **Conversion result, error message and corrective action**

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a V2/V3 model, a lamp/touch switch allocated a newly added function is registered in the symbol manager.</td>
<td>According to the status before conversion, the label will be converted to a default status (Label) or OFF label (see below).</td>
<td>See below</td>
<td>Create a fixed display object or a numeral/string display object on a lamp/touch switch (use Group function if needed) so that it matches the status before conversion.</td>
</tr>
</tbody>
</table>

- **Label error messages following conversion from V2 models to conventional model.**

<table>
<thead>
<tr>
<th>Status of label before conversion</th>
<th>Error Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static</td>
<td>Label Type – Static not supported. Label will be set to Off Description.</td>
</tr>
<tr>
<td>Two or more lines</td>
<td>Label Type – Static not supported. Label will be set to default.</td>
</tr>
<tr>
<td>On Off Static</td>
<td>Label Type – On Off Static not supported. Label will be set to Off Description.</td>
</tr>
<tr>
<td>Off label – one line</td>
<td>Label Type – On Off Static not supported. Label will be set to Default.</td>
</tr>
<tr>
<td>Off label – two or more lines</td>
<td>Label Type – On Off Static not supported. Label will be set to Default.</td>
</tr>
<tr>
<td>Numeral Display</td>
<td>Label Type – Numeral Display not supported. Label will be set to Default.</td>
</tr>
<tr>
<td>String Display</td>
<td>Label Type – String Display not supported. Label will be set to Default.</td>
</tr>
</tbody>
</table>
Correction related to the lamp label (ON state)

If a lamp’s label is converted between a conventional and a new model, conversion is executed in the manner shown below due to difference of label color setting.

- **Difference**
  
  **New models:** ON state and OFF state can be set independently. Background color is transparent only.
  
  **Conventional models:** Only foreground color can be set. (OFF, ON/Flash has same color). Background color can be set as desired.

- **Conversion result, error message and corrective action**

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a conventional model; Background: Any Foreground: Any</td>
<td>With a new model; Background: Transparent OFF State: Same as Foreground ON State: Black</td>
<td>—</td>
<td>This will lead to an invisible label when the lamp is ON. Select the lamp and choose [Edit] – [Edit Object] and double click at the label. Then change the label ON state color to different color.</td>
</tr>
</tbody>
</table>

Correction related to the maximum and minimum limit check function for numeral input

In the conversion of the data between a conventional and a new model, conversion is executed in the manner shown below due to differences in the range of numeral that can be input.

- **Difference**
  
  **New models:** A numeric value of up to 10 digits can be input for the maximum/minimum limit.
  
  **Conventional models:** A numeric value of up to 8 digits can be input for the maximum/minimum limit.

- **Conversion result, error message and corrective action**

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a new model, a numeral setting input field for which a numeric value greater than 100000000 or smaller than –10000000 is specified as a maximum or minimum limit is registered to the symbol manager.</td>
<td>With a conventional model, maximum and minimum value greater than 8 digits will be reset.</td>
<td>[W] Numeral Input Maximum value is out of limit. Default values restored for maximum and minimum.</td>
<td>Create a new numeral setting input field. Correct the screen data or the program in the host so that a constant of up to 8 digits suffices. (Refer to 6-4-1 Numeral Input, 6-4-3 Thumbwheel Switch.)</td>
</tr>
</tbody>
</table>

Correction related the number of digits for numeral input

In the conversion of the data between a conventional and a new model, conversion is executed in the manner shown below due to differences in the range of numeric values that can be input.

- **Difference**
  
  **New models:** A numeric value of up to 10 digits can be input.
  
  **Conventional models:** A numeric value of up to 8 digits can be input.
• Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a new model, a numeral setting input field (or a thumbwheel switch) for which a numeric value exceeding 8 digits is input is registered to the symbol manager.</td>
<td>With a conventional model, a numeral setting input field (or a thumbwheel switch) of greater than 8 digits is discarded.</td>
<td>[E] Numeral Input – Total number of integer and decimal exceeds limit. It is discarded.</td>
<td>Create a new numeral setting input field (thumbwheel switch). Correct the screen data or the program in the host so that a constant of up to 8 digits suffices. (Refer to 6-4-1 Numeral Input, 6-4-3 Thumbwheel Switch.)</td>
</tr>
</tbody>
</table>

**Correction related to the reference memory table entries for numeral input**

In the conversion of the data between a conventional and a new model, conversion is executed in the manner shown below due to differences in the numeral memory table entries that can be referred to.

• Difference

  New models: For numeral memory table entries No. 247 to No. 253, reference is not possible for numeral input/thumbwheel switch.

  Conventional models: For numeral memory table entries No. 247 to No. 253, reference is possible for numeral input/thumbwheel switch. (Display only)

• Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a conventional model, a numeral setting input field (or a thumbwheel switch) for which a numeral memory table in the range No. 247 to No. 253 is referred to is registered to the symbol manager.</td>
<td>With a new model, the reference numeral memory table No. is corrected to 0.</td>
<td>Thumbwheel switch refers to reserved numeral table entry. The referenced table entry is reset to 0.</td>
<td>Make corrections so that the contents of a numeral memory table in the range No. 247 to No. 253 are displayed in a numeral display. (Refer to 6-6 Numeral Display.)</td>
</tr>
</tbody>
</table>

**Correction related to an interlock function of a touch switch, numeral/string input, or thumbwheel**

In the conversion of the data between a V2/V3 model and a non-V2/V3 model/conventional model, conversion is executed in the manner shown below due to an interlock function, that has been added to V2/V3 models.

• Difference

  V2/V3 models: Operations/Inputs can be enabled/disabled according to the status of the host bit (interlock bit).

  Conventional models, non-V2/V3 models: Interlock bit can not be set.

• Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With V2/V3 models, an object allocated an interlock function is registered in the symbol manager.</td>
<td>With non-V2/V3 models/conventional models, an interlock bit setting will be discarded.</td>
<td>Interlock not supported. Interlock setting will be discarded.</td>
<td>Screen switching, numeral/string input at PT side can be enabled/disabled using the PT control bit in PT control area also. Modify the program according to the setting.</td>
</tr>
</tbody>
</table>
Correction related the number of digits for numeral display

In the conversion of the data between a conventional and a new model, conversion is executed in the manner shown below due to differences in the range of numeric values that can be displayed.

- **Difference**

  New models: A numeric value of up to 10 digits can be displayed.

  Conventional models: A numeric value of up to 8 digits can be displayed.

- **Conversion result, error message and corrective action**

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a new model, a numeral display element for which a numeric value exceeding 8 digits is displayed is registered to the symbol manager.</td>
<td>With a conventional model, a numeral display element of greater than 8 digits is discarded.</td>
<td>Numeral Display: Total number of integer and decimal exceeds limit. It is discarded.</td>
<td>Create a new numeral display element. Correct the screen data or the program at the host so that a constant of up to 8 digits suffices. (Refer to 6-6 Numeral Display.)</td>
</tr>
</tbody>
</table>

Correction related to analogue meter

In the conversion of the data between new models (with “-V1” and above) and other PT models, conversion is executed in the manner shown below due to presence/absence of analogue meter.

- **Difference**

  New models (with “-V1” and above): Analogue meter can be used.

  Conventional models, new models (below “-V1”): Analogue meter cannot be used.

- **Conversion result, error message and corrective action**

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a new model (“-V1” and above), an analogue meter is registered to the symbol manager.</td>
<td>With a conventional model and a new model (below “-V1”), an analogue meter is not displayed.</td>
<td>Cannot paste analogue meter. It is discarded.</td>
<td>Create a bar graph or other display element instead of an analogue meter to display contents that was displayed by an analogue meter.</td>
</tr>
</tbody>
</table>

Correction related to control touch switch of trend graph

In the conversion of the data between a conventional and a new model, conversion is executed in the manner shown below due to differences in the trend graph control touch switches.

- **Difference**

  New models: Marks with codes FFEF to FFF5 (hexadecimal) are used as trend graph control touch switches.

  Conventional models: No trend graph control touch switches (codes FFEF to FFF5 may be used as desired).
• Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
</table>
| With a conventional model, the marks with codes FFEF to FFF5 are used as desired. | With a new model, marks registered with a conventional model are used as trend graph control touch switches. | — | (1) Copy marks registered under codes FFEF to FFF5 to other codes with the mark editor.  
(2) Reset the marks with codes FFEF to FFF5 with the mark editor. (By resetting, the marks are returned to the trend graph control marks.)  
(3) For the elements that use the conventional marks of codes FFEF to FFF5, correct the codes to those assigned after copying the marks. (Refer to 8-3 Mark Editor.) |
| With a conventional model, the marks with codes FFEF to FFF5 are not used. | With a new model, nothing is registered for codes FFEF to FFF5 and trend graph control touch switches are not displayed. | — | Reset the marks with codes FFEF to FFF5 with the mark editor. The marks of these codes are recognized as the trend graph control marks. (Refer to 8-3 Mark Editor.) |

Correction related to sampling cycles of trend graphs

In the conversion of the data between a conventional and a new model, conversion is executed in the manner shown below due to differences of trend graph sampling cycles.

• Difference

New models: The sampling cycle can be set in the range from 0.5 to 6553.5 s in units of 0.5 s.

Conventional models: The sampling cycle can be set in the range from 0.1 to 6553.5 s in units of 0.1 s.

• Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a conventional model, the sampling cycle is set in units other than 0.5 s.</td>
<td>With a new model, the sampling cycle is corrected to 0.5 s unit cycle (corrected to the nearest value).</td>
<td>[W] Sampling cycle less than minimum value. Minimum value restored. [W] Sampling cycle not multiple of 5. Value rounded off to nearest multiple of 5.</td>
<td>Since there are no problems in actual operation, correction is not necessary.</td>
</tr>
</tbody>
</table>

Correction related to the 100% value, 0% value and –100% value of a graph

In the conversion of the data between a conventional and a new model, conversion is executed in the manner shown below due to differences in the range of numeral that can be input.
• Difference

New models: A numeric value of up to 10 digits can be input for a % value.

Conventional models: A numeric value of up to 8 digits can be input for a % value.

• Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a new model, a graph for which a value greater than 100000000 or smaller than −10000000 is set for a % value is registered.</td>
<td>With a conventional model, if a % value is outside the allowable range, it is replaced as shown below: for a 100% value, the existing value is corrected to 100, for a 0% value, it is corrected to 0, and for a −100% value, it is corrected to −100.</td>
<td>[W] [Object Name] – % value is out of limit. Default values restored for 100%, 0% and −100%.</td>
<td>Correct the screen data or the program at the host so that a constant of up to 8 digits suffices. (Refer to 6-9 Graph.)</td>
</tr>
</tbody>
</table>

Correction related to the label component of standard lamp and touch switch

In the conversion of the data between a NT31/631-V2 or later model and a NT31/631-V1 or earlier model, conversion is executed in the manner shown below due to differences in the label data of standard lamp and touch switch.

• Difference

V2 or later models: On label and Off label can be different.

Other models: On label and Off label should be same.

• Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a V2 or later model, a standard lamp/touch switch label type is set to Static’ and On/Off label descriptions are different.</td>
<td>With a V2 or earlier model, standard lamp/touch switch label type is set to Static’ and On label description will be set to that of Off label.</td>
<td>[W] Label Type-On Off Static is not supported. Label will set to Off description.</td>
<td>None</td>
</tr>
</tbody>
</table>
| With a V2 or later model, set Standard Lamp/Touch Switch label to “Label
in <n> multiple <n> lines”. | With a V2 or earlier model, standard lamp/touch switch label set to “Label” (Default). | [W] Label Type-Static not supported. Label will set to default. | None |
| From a 31/631-V2 model application copy Touch Switch/ Standard Lamp with Label Type set to Numerical Display or String Display and paste in an application for a model earlier than V2. | Label properties are set to default. | [W] Label Type-Numerical Display not supported. Label will set to default. (Or) [W] Label Type-String Display not supported. Label will set to default. | None |

Correction related to ‘switch screen’ screen numbers

In the conversion of the data between a V2 or later model and a V1 or earlier model, conversion is executed in the manner shown below due to differences in the new device monitor screens available in V2 or later models.
• Difference

V2 or later models: New device monitor screens available.
Other models: Device monitor screens are not supported.

• Conversion result, error message and corrective action

<table>
<thead>
<tr>
<th>Status before Conversion</th>
<th>Status after Conversion</th>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a V2 or later model, a touch switch of switch screen type is created with switch screen number being 9023 (device monitor screen)</td>
<td>With a model earlier than V2, touch switch will be discarded, because switch screen number 9023 is not supported</td>
<td>[E] Invalid screen number in Touch Switch (Switch Screen).</td>
<td>None</td>
</tr>
</tbody>
</table>

In the case of Bit Memory Table, it will be reset based on the following table.

<table>
<thead>
<tr>
<th>Default Screen Number</th>
<th>PT-Models</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>NT30, NT30C, NT620C/625C, NT620S</td>
</tr>
<tr>
<td>1</td>
<td>NT20S, NT21, NT31, NT31C, NT31C-V1, NT31C-V1 (System Ver 2.1), NT31-V1 NT31-V1 (System Ver 2.1), NT600S, NT631, NT631C, NT631C-V1, NT631C-V1 (System Ver 2.1) NT631-V1, NT631-V1 (System Ver 2.1)</td>
</tr>
</tbody>
</table>

NT20/30/620-compatible Mode

For the NT21 and the NT31, NT31C, NT631 and NT631C with “-V2” or “-V3” NT20/30/620-compatible Mode can be set. Using this mode requires less modification of screen data and programs, and is easier following conversion of screen data between the NT21 and NT20S, and between V2 models and NT30, NT30C, NT620S, NT620C, and NT625C.

If NT20/30/620-compatible mode is used, the functions of the NT21, NT31, NT31C, NT631 and NT631C with “-V2” or “-V3” will differ as described below. For details of the each function, refer to the NT21/31/631 Series Reference Manual (V069-E1-□).

Reference: • Except for the following points, the NT21, NT31, NT31C, NT631, and NT631C-V2/V3 functions can be used as they are in NT20/30/620-compatible mode.

• When trying to convert the screen data from NT30, NT30C, NT620S, NT620C or NT625C to NT31, NT31C, NT631 or NT631C with “-V2” or “-V3” or from the NT20S to the NT21, NT20/30/620-compatible mode will be automatically ON in the default status. If you do not want to use NT20/30/620-compatible mode, disable the NT20/30/620-compatible mode ([PT Configuration] – [PT Type]).

• NT20/30/620-compatible mode can be set only when NT21, NT31, NT31C, NT631 or NT631C-V2/V3 is selected as a PT Model. In NT20/30/620-compatible mode, the following points will be the same as for the NT30/620 series.

  • Image/library can be inserted into a lamp/touch switch label or a character string.
  • Image/library code
  • Word configuration of PT control/notify area
Appendix B
System Installer Operation

The Support Tool is provided with a system installer, which installs the system program at a PT.

Version up of the PT system program or installation of new communication programs in a PT are possible by installing the system program.

Reference: Version up of NT31, NT31C, NT631, NT631C with “-V1” (system program Ver. 2.1)” or below is possible by installing the system program that is supplied with the Support Tool (Ver. 4.□).
For details of the conversion method, refer to Appendix A Data Conversion.
In this case, however, the following function can not be used.

• 32-dot high-definition font (Refer to Settings for text display in 6-1-10 Setting Properties.)
• Font type ISO8859-1 (Refer to Font Type in 3-3 and Appendix K.)
• Memory unit system transmission (Refer to operation manual of NT31, NT31C, NT631, NT631C with “-V2”.)

To reuse the existing NT31, NT31C, NT631, NT631C screen data, the screen data should be converted to the data for system program Ver.3.1 beforehand.

Applicable PT Models

The system installer is used to install the system program in the following PT models.

NT11S/NT11, NT21, NT30, NT30C, NT31, NT31C, NT620S, NT620C/NT625C, NT631, NT631C

Note For the individual PC (PLC) models, always install the system program of the specific PT model. It is not permissible to install the system program of another PT model.

Reference: The Support Tool is provided with the system programs of the following PT models.

NT31, NT31C, NT631, NT631C with “-V2” (system program Ver.3.1), NT11S/NT11, NT21, NT30, NT30C, NT620S, NT620C/NT625C

The system program must be installed with the system installer when installing the Support Tool at your personal computer. For details of installation at the personal computer, refer to Section 2 Setting Up the Support Tool.

These system programs can be transmitted to a PT using the system installer supplied with the Support Tool (Ver.4.1).

Starting and Exiting the System Installer

The system installer is started by pressing the Windows start button, then selecting [Programs] → [Omron] → [Ntst4.8] → [NT-series System Installer] as shown below.
On Windows 2000, XP, Vista, or 7, run the Support Tool as a user with administrator rights.

Example: Windows XP

When the system installer starts, the main window, shown below, is displayed.

Existing the system installer

You can exit the system installer by using any of the following operations:

- Select [Download System] → [Exit].
- Click on the button in the upper right section of the main window.
- Double click on the system installer icon in the upper left section of the main window.
- Click on the system installer icon in the upper left section of the main window, then select [Close] in the control menu box.
- Press the [F4] key while holding down the [Alt] key.

When you exit the system installer, the Windows screen is displayed.
Functions of the Main Window

The functions provided by the main window of the system installer are described below.

Drive:

Specify the drive where the system program is stored. Click on \(\downarrow\) and select the drive name from the displayed items.

The drive in the network can be selected only when it is allocated to “My Computer.” (When installing on a personal computer, the system installer will be installed but the system program will not be installed.)

PT Model:

Specify the PT model for which the system program is installed. Click on \(\downarrow\) and select the drive name from the displayed items.

Select NT31, NT31C, NT631 or NT631C to use NT31, NT631C, NT631 or NT631C.

Com Port:

Specify the port used for communications with the PT. Click on \(\downarrow\) and select the drive name from the displayed items. Selection is possible from [COM1] and [COM2].

Look in:

Specify the folder where the system program is stored. The folder can be opened or closed by double clicking on the folder line.

Among the folders that are open, the folder at the bottom line is selected.

System File(s):

The system programs in the specified folder and those for the specified PT model are displayed. Specify the system program that is to be installed at the PT from among the displayed programs. The extension of a system program file name represents the PT model.
System Installer Operation

Appendix B

<table>
<thead>
<tr>
<th>Extension</th>
<th>PT Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>.20</td>
<td>NT20 (System)</td>
</tr>
<tr>
<td>.20M</td>
<td>NT20 (Extended)</td>
</tr>
<tr>
<td>.21</td>
<td>NT21</td>
</tr>
<tr>
<td>.31</td>
<td>NT31</td>
</tr>
<tr>
<td>.31C</td>
<td>NT31C</td>
</tr>
<tr>
<td>.31G</td>
<td>NT31-V3</td>
</tr>
<tr>
<td>.31D</td>
<td>NT31C-V3</td>
</tr>
<tr>
<td>.631</td>
<td>NT631</td>
</tr>
<tr>
<td>.63C</td>
<td>NT631C</td>
</tr>
<tr>
<td>.63D</td>
<td>NT631C-V3</td>
</tr>
<tr>
<td>.11S</td>
<td>NT11S</td>
</tr>
<tr>
<td>.11</td>
<td>NT11</td>
</tr>
<tr>
<td>30</td>
<td>NT30</td>
</tr>
<tr>
<td>30C</td>
<td>NT30C</td>
</tr>
<tr>
<td>62S</td>
<td>NT620S</td>
</tr>
<tr>
<td>62C</td>
<td>NT620C/NT625C</td>
</tr>
</tbody>
</table>

- Specifying the System and Extension

These selection items will be displayed if the NT20 is selected for the PT model.

For the NT20, the system program will be divided into the following two items:

System: Program itself
Extension: Resource data for each display language

Select which of the two will be transferred.

The system program is installed when this button is clicked.

Installing the System Program

The procedure for installing the system program is shown below.

1. Specify the PT model for which the system program is installed for [PT Model] in the main window.

2. Specify the system program to be installed by setting the information at [Drive], [Look in], and [System File(s)] in the main window.

3. Specify the RS-232C port used for the communications with the PT for [Com Port].

4. Make the PT ready for installation of the system program.

   The operation required at the PT varies depending on the PT model. Basically, execute the processing for deleting the system program, then that for setting the PT in the state in which it waits for the reception of the system program. For details, refer to the manual for your PT.

5. Click on [Go] in the main window.
The system program is installed.

While the system program is being installed, the progress of the operation is displayed in graph form.

(6) At the completion of system program installation, the corresponding message is displayed.

Read the message and click on OK.

(7) At the PT, press the touch switch that acknowledges the end of system program installation.

The PT re-starts by the installed system program.
Appendix C
NT Transfer Utility

With the Support Tool on CD-ROM, the NT Transfer Utility, which can transmit screen data to a PT easily on site, is supplied. It can download the screen data file in mmi format to a PT and can save the screen data uploaded from a PT to a file in mmi format. Screen data file in mmi format is less than 1.44 Mbytes. So it is useful when you save the file in a floppy disk to transfer the data to and from a PT on site.

Reference:
- NT Transfer Utility is a software that is exclusively used for downloading/uploading the screen data without modifying the contents.
- NT Transfer Utility can handle only the file in mmi format. It is not possible to read or write the file in onw format, which is a standard format of the Support Tool. Therefore, please be sure to save the screen data in mmi format when you use the NT Transfer Utility. For details of the restriction of the file types and mmi format, refer to 3-3-3 Saving the Screen Data (Application) File.
- NT Transfer utility downloads/uploads the screen data in the application unit. It is not possible to perform individual transmission such as the transmission in the screen unit.

Equipment necessary for using the NT Transfer Utility

The following indicates the equipment necessary for using the Support Tool.

Hardware

- Recommended CPU
  Pentium 100 MHz or faster CPU
- Personal Computer
  Use an IBM personal computer or 100% compatible.
- Recommended Memory
  32 Mbytes minimum
- Free Area in Hard Disk
  At least 3.5 Mbytes

Operating System

The NT Transfer Utility runs on Microsoft Windows 95, Microsoft Windows 98, and Microsoft Windows NT 4.0. Version 4.05 or higher of the NT Transfer Utility also runs on Microsoft Windows 2000 and Microsoft Windows XP.

Version 4.80 or higher of the NT Transfer Utility also runs on Microsoft Windows Vista and Microsoft Windows 7.

The NT Transfer Utility will not run on Windows 3.1.

Operation on a 64-bit OS or server OS is also not supported.
Device necessary for transmitting screen data

- RS-232C cable

The cable used for the Support Tool can be used.
For cable specifications, refer to Appendix J Connecting Cable Specifications.

Installing the NT Transfer Utility

Install the NT Transfer Utility in the personal computer that is to be connected to a PT on site. NT Transfer utility operates alone. You do not need to pre-install the Support Tool in the personal computer.

Installation

To install the NT Transfer Utility, execute the install program that is in your software package.

Reference: The basic operation of the install program is same as the install program of the Support Tool. Refer to 2-2-1 Basic Installation Operation.

Procedure

1. Start up Windows.
   When using Windows 2000, Windows XP, Windows Vista, or Windows 7, log in with a user ID in the administrators group.

2. If you are using CD-ROM, set the Support Tool CD-ROM in the CD-ROM drive while holding down the Shift key to prevent the Support Tool setup program from starting up. (Release the Shift key after CD-ROM is recognized and the access to the CD-ROM is stopped.) If the Support Tool setup program is automatically started, click on Cancel to abort it.

Reference: You can execute the setup program by double clicking Setup.exe for NT Transfer Utility in the Support Tool system disk by displaying the Windows Explorer. In this case, steps 3, 4 and 5 below can be skipped.

3. Click on the Start button of Windows and select “Run...”
(4) Input "a:\setup" in the input field in the specified window. For the drive, specify the drive containing the CD-ROM. For example, if the CD-ROM is in drive E, enter "e:\setup". To use a floppy disk, click the Browse button and specify the SETUP.EXE file that was copied from the NT Transfer Utility folder to the floppy disk.

(5) Click on OK. The installation started.

(6) When the setup screen of the NT Transfer Utility is displayed, click on Next. The screen for specifying the destination of program installation is displayed.

(7) Specify the directory for installation. In the initial state, the directory shown below is set as the destination directory.
C: \Program Files\Omron\Ntst4.8\Transfer Utility
If you want to change the directory, click on Browse and input the drive and directory. (If a directory that does not exist in the hard disk is specified, the directory is automatically made.)

After specifying the destination, click on Next. The screen for specifying the destination for registering the start menu is displayed.
(8) In the start menu of Windows, specify the folder where the short-cut to the Support Tool is created.
In the initial state, the following folder is selected.
Start\Program\Omron\Ntst4.8E
If you want to change the folder, select the desired folder from the Existing Folders or directly input the folder name. (If a folder that does not exist in the hard disk is specified, the specified folder is automatically made.)

![NT Transfer Utility Setup](image)

After specifying the folder, click on [Next].
Installation of the specified programs is implemented; files are copied.
During program installation, the progress of the processing is indicated as a percentage.

(9) After the completion of installation, the folder specified in step (8) is displayed along with the installation completion message.
Click on [OK], then click on [Finish] in the setup completion screen.
Installation operation is completed.

**Uninstall**

An uninstaller (uninstall software) is supplied with the NT Transfer Utility.
If you want to remove the NT Transfer Utility from your personal computer, run the uninstaller to delete the NT Transfer Utility program files and installation information. (Note that the data saved by the NT Transfer Utility is not deleted.)

- Starting the uninstaller from the Windows start menu
  Select "Uninstall Transfer Utility" in the same folder where the short-cut to the Support Tool is stored.

Example: Assuming the short-cut to the Support Tool exists in the Start\Program\Omron\NTST4.8E\Uninstall Transfer Utility folder
Select the uninstaller by the following operation.
  [Start] → [Program] → [Omron] → [NTST4.8E] → [Uninstall Transfer Utility]

After the start up of the uninstaller, follow the instructions displayed on the screen.
How to use the NT Transfer Utility

Reference: For connection method of the NT Transfer Utility and PT, refer to 11-1-1 Connecting to PT.

Start up and exiting the NT Transfer Utility

- Starting up the NT Transfer Utility
  When using Windows 2000, Windows XP, Windows Vista, or Windows 7, log in with a user ID in the administrators group.


  The NT Transfer Utility starts up and displays the main window shown below.

- Exiting the NT Transfer Utility
  When using Windows 2000, Windows XP, Windows Vista, or Windows 7, log in with a user ID in the administrators group.

  You can exit the NT Transfer Utility in any of the methods below.
  - Select [File] – [Exit].
  - Click on [ ] at the upper right area of the main window.
  - Double click on the NT Transfer Utility icon at the upper left area of the main window.
  - Click on the NT Transfer Utility icon at the upper left area of the main window and select [Close] from the displayed control menu box.
  - Press F4 key while holding down the Alt key.

  The screen returns to the Windows screen after the NT Transfer Utility is closed.

Communication Setting at the NT Transfer Utility

Set the baud rate and communication port at the NT Transfer Utility (personal computer).

1. Select [Configure] (menu bar) → [Comms. Setting].
   The communication setting dialog box is displayed.
(2) Set the data for the displayed item
The meanings of the items are described below.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COM Port</td>
<td>Specify the RS-232C port to be used. Specify either COM1 or COM2.</td>
</tr>
</tbody>
</table>
| Baud Rate  | Set the data communication rate. If “High” is set, high-speed data communi-
|            | cation is possible. (Not available for NT11S/NT11.) It is recommended to
|            | specify “Standard” to ensure error-free communication if a communication er-
|            | rors due to an inadequate communication environment. Data communication at
|            | the Standard setting will take about twice the time required in the High set-
|            | ting.                                                                        |

(3) After completing the setting for all items, click on [OK].

Sending (Downloading) the Data

The screen data file saved in mmi format is sent (downloaded) to a PT.

Reference:
- When data is sent from the NT Transfer Utility to a PT, the existing data in
  the PT is lost. Therefore, make sure that the existing data in the PT is backed
  up by the Support Tool or by the NT Transfer Utility before executing data trans-
  mission from the NT Transfer Utility to the PT.
- NT Transfer Utility can send only the file in mmi format.
- Operation Procedure

(1) Select [Download] from the [File] menu.
   The dialog box to specify the screen data file (mmi format) to be sent is dis-
   played (see below). This dialog box can be called also by pressing the Ctrl
   key + Shift key + D key.

   ![Open dialog box](image)

   Click on [Open] and the dialog to confirm the screen data to be trans-
   mitted is displayed.

(2) Place the PT in the Transmit mode so that the data sent from the NT Transfer
    Utility can be received.

(3) Click on [OK] after confirming the screen data to be transmitted in the
dialog shown below. Downloading of data is started.
If you want to change the screen data to be transmitted, click on [ ] at the right side of the file name and select the file you want to download.

If the PT is not in the Transmit mode, a timeout error occurs in about 10 seconds at the NT Transfer Utility. In this case, set the PT in the Transmit mode and click on [ ] in the error message dialog box.

(4) While the data is being sent to the PT, the progress of data transmission is indicated by a bar graph.
To abort the operation, click on [ ].

(5) After data transmission is completed, click on [OK ] in the message box.

Receiving (Uploading) the Data

The NT Transfer Utility receives (uploads) the data stored in a PT and saves it in mmi file format.

• Operation Procedure

(1) Select [Upload] from the [File] menu.
The dialog box to specify the PT model is displayed (see below). This dialog box can be called also by pressing the Ctrl key + Shift key + U key.

(2) Place the PT in the Transmit mode so that the data can be transmitted to the NT Transfer Utility.

(3) Click on [OK ] after selecting the PT model. Uploading of data is started.
If the PT is not in the Transmit mode, a timeout error occurs in about 10 seconds at the NT Transfer Utility. In this case, set the PT in the Transmit mode and click on [ ] in the error message dialog box.

If the type of PT connected and the PT model setting at the NT Transfer Utility is different, error message is displayed.

(4) While the data is sent from the PT, the progress of data transmission is indicated by a bar graph.
To abort the operation, click on [ ].
(5) After data transmission is completed, click on **OK** in the message box.

(6) The dialog to confirm the screen data is displayed (see below).

![Upload File Information](image)

Specify the folder and file name where data is to be stored and click on **Save**. The warning message about the mmi format is displayed. Click on **OK** and the screen data is saved to the specified file in mmi format. If you specify the existing file, the overwrite confirmation message is displayed.

For details of the file name setting dialog, refer to 3-3-3 Saving the Screen Data (Application) File.

**Reference:** The screen data file received from a PT can be edited using the Support Tool.
Appendix D
Translation Support Utility

The Translation Support Utility is utility software that runs on Windows 95/98/Me/2000/Xp and Windows NT Ver.4. The Translation Support Utility was developed to help in translating a language to another supported language.

Currently, translation for label contents in NTST can only be performed manually by opening and editing individual visible string contents in NTST, before downloading applications to a different language PT.

Therefore, the purpose of this utility is to provide a translation support utility that enables you to load the memory map image file (.MMI) for the source language and be able to translate the new string contents of the application and generate independent memory map files (.MMI) for the specified target language. The string data can be exported to Microsoft Excel files and from there you can edit/change the string data outside the Translation Support Utility. You can also import the string data in Microsoft Excel format to Translation Support Utility.

Installing the NT Translation Support Utility

The basic installation method is the same as that for the NT Transfer Utility. Refer to Installing the NT Transfer Utility in Appendix C.

Setup.exe for NT Translation Support Utility is in the \Translation Support Utility\disk1 folder in the Support Tool CD-ROM. By double-clicking the Setup.exe icon, you can start the installation program. Follow the instructions on the setup screen to install the NT Translation Support Utility.

Flow of Operations

An NTST application needs to be saved in MMI format before it can be used in Translation Support Utility.

2. Use [Translation] – [New] to create a new language column. More than one target languages may be created.
3. Strings in target language text are translated using the translation editor window.

Select the cell in the target language in which the source text is to be translated. The source text is displayed in the upper pane of the editor translation window. You can input the translated text in the lower pane and confirm by clicking the OK button.

4. Repeat the steps for each of the strings to be translated.
5. Select [Translation] – [Delete] operation if you wish to remove any of the target languages.
6. Use [File] – [Generate MMI] to save all the languages to their respective MMI files.
7. If you wish to perform the translation using an Excel sheet rather than in the utility itself, use the Export function in [Translation] – [Export] to export the strings to .XLS format.
To read back the translated text in Excel format to the utility, use the Import function in [Translation] – [Import].

Application Window

The name of each part and the available functions are described below.

Main Translation Table

The Main Translation Table displays the ID, Source Text and Language in columns for the particular MMI file.

Sorting preference for display of extracted string contents are as follows: Screen number, and then the object type sorted alphabetically for that particular screen when there are no header rows identifying the object type.

Select the cell in the target language, into which the source text is to be translated. You can move around the cells in the translation columns using the arrow keys or the tab key.

Short Form in the ID Column

The ID of screen objects are displayed in short form.

Below are the short forms with their meanings:

Scr  Screen
Txt  Fixed Display Text
TSW  Touch Switch
Appendix D

Translation Support Utility

Lmp Lamp
Rec Record in Recipe Entry
Param Parameter in Recipe Entry

Translation Editor Window

You can view the Translation Editor Window in the lower part of the Application Window. This is where the translated text can be input.

When the source text in the source language column in the translation table is selected, both panes will be disabled.

Source text of the selected label or string.

Input translated label or string.

Counter
Displays remaining number of characters that can be entered for the selected cell from the selection table. It will display 0 if the current selected cell is on the Source Language column. In addition, if the length exceeds the limit, the counter will display a negative value in the red color.

OK
Copy
Prev
Next
Copy source text into the editor
Accept changes. Enabled only when contents are changed.

Status Bar

The status bar, which you can find at the bottom of the translation window, is divided into four panes.

Menu Bar

The menu bar shows the names of each function. The pull-down menu commands provided by the Translation Support Utility and the functions of each menu item are shown below.
Translation Support Utility

Appendix D

File or ALT+F

- **Open** or Ctrl+O – Opens the source MMI file.
- **Close** – Close current Application.
- **Generate MMI** or Ctrl+S – Save current Application in MMI format.
- **Exit** – Exit Utility.
- **Recent File List** – Displays recently opened file list.

File or ALT+T

- **New** or Ctrl+N – Creates a new target translation column.
- **Import** – Import from Excel.
- **Export** – Export to Excel.
- **Settings** or Ctrl+T – Opens the translation setting dialog.
- **Delete** – Deletes the selected translation column. This option will only be enabled if there is at least one target language.
- **Update Database** or Ctrl+U – Refresh database if timestamp of the source MMI file is different from the source application, thereby indicating that the source application has changed.

Edit or ALT+E

- **Find/Replace** or Ctrl+F – Search for and/or replace specified text.
- **Edit Translation Item** or Ins – Move focus to the lower pane of Translation Window for user input.
- **Next Item** – Navigate to previous item under selected column. It will wrap around when it reaches the last row.
- **Previous Item** – Navigate to previous item above selected column. It will wrap around when it reaches the top row.

View or ALT+V

- **Toolbar** – Displays or hides toolbar.
- **Status Bar** – Displays or hides status bar.

Help or ALT+H

- **Contents** – Opens the Online Help.
- **About** – Displays the version number.

Standard Toolbar

The Standard Tool Bar displays the functions that are used most frequently. In the Translation Support Utility, the standard toolbar options are Open and Save.
These functions can be called easily without selecting the function item from the menu bar.

File Open

A File Open dialog box is a window that is displayed in a fixed size.


The File Open Dialog box will be displayed so that the user can select the .MMI file that will be opened.

Click the OK button after selecting the MMI file. A Translation Dialog Box will be displayed for the user to enter the language and character set of the file being opened. However, this translation dialog will not be shown when .MMI files are opened subsequently as the languages information will be stored in the database the first time it is opened.

Source Project Language

Displays all the available Languages. You may input a language that is not in the list.

Source Project Character Set

This will be disabled if the specified Source Project Language type is the same as the pre-defined Source Project language type. However, if you have input your own language, the Source Project Character Set combo box will be enabled and the default language will be Latin.

New Translation

Creates a new target language column for translation.

The New Translation Dialog box will appear and the user can edit the Language, Character Set and Output File Name.

Language
Displays all the available Languages. You may input a language that is not in the list.

Character Set
The Code Page will be disabled if the specified language type is the same as the pre-defined language type. However, if you have input your own language in the edit box, the character set combo box will be enabled and the default will be Latin.

Output File Name
Modify the path or name of the output file of the translated language.

Translation Setting
This option is used to display translation settings such as language, character set, database file, source file, output file name of the source file, and the target file. You can also use this setting to change the output file name of the target language.


The Source Translation Setting Dialog box will be displayed.
If you change the source language to the target language, the source translation dialog box will become the target translation dialog. The path and name of the Output File Name may be modified.

![Translation Settings dialog box]

Delete Translation

Deletes the selected Language column.


This option will only be enabled if there is at least one target language translation data present.

The Delete Translation Dialog box will be displayed.

You can delete any language except the source language.

![Delete Translation dialog box]

Export

Use Export to export string data to an MS Excel worksheet (*.xls). You can then translate the strings on MS Excel and subsequently import the data to the Translation Support Utility to save it to the MMI files of the translated language.

The Export Translation Dialog box will be displayed.

Click the **OK** Button after selecting the language to be exported. A file save dialog box similar to the file open dialog box will prompt you to enter a filename. Once a valid filename is specified, the export operation begins. The cursor will change to a wait cursor for the duration of this operation. When the operation is finished, an export completion message box will be displayed.

**Import**

Use Import to import string data from an MS Excel worksheet (*.xls).


The Open File dialog box will be displayed. Enter the name of the file to be imported.

The Import Translation Dialog box will be displayed.

**Language**

Displays all the available target languages present in the Translation Table and that have corresponding valid target language data in Excel. All items are selected as the default, but are disabled once the import operation starts.
Status
Displays the status of each target language that is being imported.

Current Text – Source
Displays the source text present in the Translation Table.

Current Text – Translation
Displays the translated text for the target language existing in the Translation Table.

Excel Text
Displays the translated text for the target language that can be imported from Microsoft Excel format.

Import Text
Shows the converted text, i.e., with correct converted key code (if necessary), length limit, etc. However, if you modify the text and then press Import or Import All, validation is performed.

Start
Use the Start button to activate the import operation for a language.

Stop
Use the Stop Button to terminate the import operation for that language.

Next
Use the Next Button to move down by one item.

Previous
Use the Previous Button to move up by one item.

Import All
Use the Import All Button to import all items for the selected column.

Import
Use the Import Button to import the selected item.

The sequence of events for the import operation is given below (The term Translation Data Item may be used interchangeably with a 'Record' in the notes below and both mean the same thing):

First of all, the Language Selection list box is enabled so the user can choose from the list of languages available for Import. By default, all items are selected.

Press the Start button to initiate the whole import operation. Once Start is clicked, the Language list box is disabled and the Import operation starts. The multi-line edit boxes are populated with relevant data. The status box displays the start of the import operation by displaying "Importing <Language>..."

At this stage, you have the following options:

Import translation data for all the languages in the Language list box (i.e., accept all translation data as it exists in Excel format) by clicking the Import All button. By doing this, translation data for all languages is processed and imported. During this process, when all translation data for a particular language is processed/imported, that language is removed from the Language list box and the status box displays “Done,” for that language. This process is repeated for all languages in the Language list box.
Import translation data one by one by viewing the data (in the Excel Text edit box in the Import dialog above) to be imported and, if necessary, edit the data (in the Import Text edit box in the Import Dialog above), and then click the 'Import' button. This way, you can inspect and also edit the translation data that is being imported for that language. During this process of importing translation data items one by one, you can skip any of the translation data items by clicking the 'Next' button the item will be ignored for import and processing will proceed to the next record. Conversely, you can navigate back to any of the previous records that you may have missed inadvertently by clicking the 'Previous' Button, so that you can inspect and import that particular record.

When the last record of a language is processed, the language will be removed from the Language list box and the next language will become ready for import. In addition, the status box displays “Done” for the completed language, and the Start button (which had until now displayed ‘Stop’) caption changes back to ‘Start’. You may start importing the next language by clicking the ‘Start’ Button again.

Find/Replace

You can search for specific text and replace it, or you can search for and replace all forms of a word (for example, replace “lamp” with “standard lamp.”


A Find/Replace Dialog box will appear on the screen.

Error/Warning Messages

Situations where error/warnings may be displayed are given below. The list is by no means exhaustive as more may be added. Also, there may be differences with the exact messages that are shown.

(1) Fonts with the following character sets are not available on your local machine. Not all languages can be shown with the required character set.

(2) Only with the NT30/620 series, when saving, once the translation is completed a warning message will be displayed to prompt you to open the translated MMI file in NTST and validate the application to ensure proper behavior. This is due to the paging memory constraints for those PT Models.

(3) Database file cannot be found/No access rights for database file/Database file cannot be opened.

(4) Export/Import successful/unsuccessful (as appropriate).
(5) When closing the source MMI file or exiting the Translation Support Utility, if you have made some translation changes that have not been committed to MMI files corresponding to target languages, the Translation Support Utility will prompt you to generate the corresponding MMI for the target languages (if any). Refer to the message below.

![Translation Support Utility](image1)

(6) If the current source MMI file is newer than the one registered in the MDB database or it has contents that are different from the MDB database file, then it prompts you whether to update the database with the information of the current file or not. Refer to the message below.

![Translation Support Utility](image2)

(7) File save error when saving translated target MMI files. Refer to the following image for a sample.

![Translation Support Utility](image3)

**System Function**

**Translation Scope and Policy**

(1) Only the following kinds of label translation are supported, subject to availability in the target PT model of the source application:
• Static label of Touch Switch and Standard Lamp (where Touch Switch is a standalone screen object and not any component such as touch switch in Alarm/Trend Graph in NT21, NT31/631 models).

• On/Off static label of Touch Switch and Standard Lamp (where Touch Switch is a standalone screen object and not any component such as touch switch in Alarm/Trend Graph in NT21, NT31/631 models).

• Fixed Display Text

• Input Key String label

• String Table Initial value

• Screen History Title

• Names of Recipe Table Entries, their records (name only) and parameters (name only)

• Static label of Touch Switches internal to Recipe Screen Element

(2) Multiple language translation is supported by Translation Support Utility.

(3) Automatic generation of translated MMI file. Default target filename with country/language name as qualifier is used to store the translated MMI file.

(4) Contents not translated are displayed as blank and changes will not be tracked.

(5) The length limit of label is constrained by the target PT Model.

(6) Code that corresponds to an image/mark/library entry will be displayed in its original form (ASCII representation), i.e., it will not be tagged by the NTST opening token !< and closing token >.

(7) Touch Switch and Standard Lamp with dynamic labels only, or those with no label at all will not be extracted for translation.

(8) The validations performed are the number of row/column and the length limit of the label according to PT Model. Additionally, with the NT30/620 series, during saving, once the translation is completed a warning message will be displayed to open the translated MMI file in NTST and validate the application to ensure proper behavior.

(9) Translation Support Utility will also take care of key code conversion (ISO8859-1 → CP437) results wherever necessary and also restricted Chinese Input for NT20S.

Translation Management

• Languages

The following is a list of commonly used languages available for selection. You can also specify a language not in the list.

(1) English

(2) Japanese

(3) Simplified Chinese

(4) Traditional Chinese

(5) German

(6) French
(7) Italian
(8) Spanish

- Character set
A character set is an ordered set of characters in which a numeric index (code-point value) is associated with each character.

Different languages and locales may be used in different character sets.
Character sets to choose from are provided based on the language selected. However, for the Translation Support Utility, the following are the character set shown.

(1) Japanese (Shift JIS)
(2) Simplified Chinese (GB 2312)
(3) Traditional Chinese (BIG 5)
(4) Latin (ISO 8859-1/CP437)

- Filename
An output filename is provided as a default. The filename can be edited.

Database Management
All translation data for each of the source applications with their respective translation will be stored in a Microsoft Access relational database, which has to be retained for later retrieval of translated data for modification etc.

You can update the database with the latest application information.

When updating the database, Translation Support Utility checks for changes made at the source file. Items will be added, removed, or updated depending on the current file. As a result, there may be new text requiring translation or already translated text that is obsolete in the database.

File Management
Upon opening a source application MMI file for translation, the user will be prompted to inform the utility about the language character set pertaining to the application that is going to be opened for translation.

At any given time, only one application can be opened.

Standard file operations are available for the user to close files, save files, and exit the utility (which will prompt you to save if any changes have been made).

The following are the file types involved in translation management for this utility:

- .MMI files (Memory Map Image file corresponding to NTST data)
- .mdb files (Microsoft Access database storing translation data for source and target)
- .xls files (for Export/Import functionality)

Export/Import Management

Export:

(1) All language column headers (excluding the source) will be displayed for selection of export and the user will be able to select one or more languages for export from among them.
(2) The ID for screen objects containing the label and the source text will be mandatory export fields and therefore will be exported automatically.

(3) For multi-line text, new lines will remain unchanged and also image, library and mark codes will remain in binary when exported.

(4) Non-translated text will be exported as blank.

(5) Column widths will take the default for Microsoft Excel after export. The exported format in Excel will resemble that of the Translation Table.

**Import:**

(1) You are allowed to export translated string data for one or more languages of your selection and also will be able to view and change each data item under a language before it is imported.

(2) The following will be displayed for selection and navigation by the user:
- Listing and selection of source column headers in Excel to be imported.
- Display of corresponding target column headers into which the column data from Excel will be imported.
- Read-only Listing of source text for selected items in selected language and corresponding translation text existing in Translation Support Utility tables read from the database.
- Display of text that is being exported corresponding to selection made above with facility for editing.
- Navigational buttons for moving up and down each data item for the selected language.

(3) Import All facility will also be provided.

(4) Import of Excel data into Translation Support Utility will be a controlled check-in with key code conversion being performed if necessary.

(5) If you attempt to change the item data during import, validation is performed for length limit, limit for number of rows and columns for multi-line data etc. before the changed text can be accepted for import.

**Launching and Closing**

**Launching the Translation Support Utility**


This option is not available when no application is loaded in NTST.

When launching the translation Support Utility, the current application in NTST will close. The user can easily reopen the file by selecting it from recent file list.

**Closing the Translation Support Utility**

To close the Translation Support Utility, use any of the operations shown below.

- In the menu, select [File] → [Exit].
- Click the **Button at the upper right corner in the main window.
- Double click the Translation Support Utility icon displayed in the upper left section in the main window [Control Menu].
• Click the Support Tool icon displayed in the upper left section in the main window, then select Close Alt+F4 in the control menu box.

• Press the F4 key while holding down the Alt key.

If you are going to exit the Translation Support Utility, a confirmation message will be displayed for you to generate .MMI files for the particular languages.

After you exit the Translation Support Utility, the screen will return to the Windows screen.
Appendix E
Tables of Functions of PT Models

The functions that can be set by the Support Tool are summarized below for each PT model. Some functions can be set at the PT side even if they cannot be set by the Support Tool.

### PLC Vendor (PT Configuration-PT Type)

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S Ver. 5/NT20</th>
<th>NT30 Ver. 4</th>
<th>NT30C Ver. 4</th>
<th>NT600S Ver. 5</th>
<th>NT620S Ver. 4</th>
<th>NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>OMRON</td>
<td>● ● ● ● ●</td>
<td>x x x x x x</td>
<td>x x x x x</td>
<td>x x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x x x</td>
<td>△*1</td>
<td>△*1</td>
<td>△*1</td>
<td>△*1</td>
<td></td>
</tr>
<tr>
<td>Mitsubishi_A</td>
<td>x x x x</td>
<td>x x x x x x</td>
<td>x x x x</td>
<td>x x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x x x</td>
<td>△*1</td>
<td>△*1</td>
<td>△*1</td>
<td>△*1</td>
<td></td>
</tr>
<tr>
<td>Mitsubishi_Fx</td>
<td>x x x x</td>
<td>x x x x x x</td>
<td>x x x x</td>
<td>x x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x x x</td>
<td>△*1</td>
<td>△*1</td>
<td>△*1</td>
<td>△*1</td>
<td></td>
</tr>
<tr>
<td>Memory Link</td>
<td>x x x</td>
<td>x x x x x x</td>
<td>x x x x</td>
<td>x x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x x x</td>
<td>△*1</td>
<td>△*1</td>
<td>△*1</td>
<td>△*1</td>
<td></td>
</tr>
<tr>
<td>AB</td>
<td>x x x</td>
<td>x x x x x x</td>
<td>x x x x</td>
<td>x x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x x x</td>
<td>△*2</td>
<td>△*2</td>
<td>△*2</td>
<td>△*2</td>
<td></td>
</tr>
<tr>
<td>GE</td>
<td>x x x</td>
<td>x x x x x x</td>
<td>x x x x</td>
<td>x x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x x x</td>
<td>△*2</td>
<td>△*2</td>
<td>△*2</td>
<td>△*2</td>
<td></td>
</tr>
<tr>
<td>Siemens</td>
<td>x x x</td>
<td>x x x x x x</td>
<td>x x x x</td>
<td>x x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x x x</td>
<td>△*3</td>
<td>△*3</td>
<td>△*3</td>
<td>△*3</td>
<td></td>
</tr>
<tr>
<td>Modicon</td>
<td>x x x</td>
<td>x x x x x x</td>
<td>x x x x</td>
<td>x x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x x x</td>
<td>△*4</td>
<td>△*4</td>
<td>△*4</td>
<td>△*4</td>
<td>x</td>
</tr>
</tbody>
</table>

*1: Can be set only with the NT31, NT31C, NT631 and NT631C with “-V1” and above.
*2: Can be set only with the NT31, NT31C, NT631 and NT631C with “-V2.”
*3: Can be set only with the NT31, NT31C, NT631 and NT631C with “-V1.”
*4: Can be set only with the NT31, NT31C, NT631 and NT631C with “-V1” and “-V2.”

### System Setting (PT Configuration)

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S Ver. 5/NT20</th>
<th>NT30 Ver. 4</th>
<th>NT30C Ver. 4</th>
<th>NT600S Ver. 5</th>
<th>NT620S Ver. 4</th>
<th>NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buzzer</td>
<td>x x</td>
<td>● ● ● ● ●</td>
<td>x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x x x</td>
<td>x x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td>x x</td>
<td>● ● ● ● ●</td>
<td>x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x x x</td>
<td>x x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Key Input</td>
<td>x x</td>
<td>● ● ● ● ●</td>
<td>x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x x x</td>
<td>x x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resume Function</td>
<td>x x</td>
<td>● ● ● ● ●</td>
<td>x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x x x</td>
<td>x x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Backlight OFF</td>
<td>x x</td>
<td>● ● ● ● ●</td>
<td>x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x</td>
<td>x x x x x x x</td>
<td>x x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Number of Table Entries – Numerical Table | 128 | ● ● ● ● ● | x x x x x x | x x x x x x | x x x x x x | x x x x x x | x x x x x x x | x x x x x x x |}

517
### Printer for PT

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S Ver. 5/NT20</th>
<th>NT30 Ver. 4</th>
<th>NT30C Ver. 4</th>
<th>NT600S Ver. 5</th>
<th>NT620S Ver. 4</th>
<th>NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Mode</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>History Setting</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Alarm</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen</td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

*1: Setting is not possible from the Support Tool. Set these items at the PT.

*2: For the NT21, NT31, NT31C, NT631, and NT631C, set the screen saver function at the PT. The Backlight OFF function is only for turning off the screen or the backlight. If the screen saver function is used, it is possible to display a string at a desired position in predetermined intervals in addition to turning off the screen/backlight.

### Report

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S Ver. 5/NT20</th>
<th>NT30 Ver. 4</th>
<th>NT30C Ver. 4</th>
<th>NT600S Ver. 5</th>
<th>NT620S Ver. 4</th>
<th>NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross-Reference</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Direct Connection Information</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>History Report</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Image/Library Report</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Mark List</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Screen Image</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Screen List</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Table Report</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Validation Report</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Mathematical Report</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Recipe Table</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

*1 This option is available only for V2 models and above

*2 This option is available only for V2 (System Ver.3.1) models and above

### Data Transmission (Download/Upload)

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S Ver. 5/NT20</th>
<th>NT30 Ver. 4</th>
<th>NT30C Ver. 4</th>
<th>NT600S Ver. 5</th>
<th>NT620S Ver. 4</th>
<th>NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download/Upload</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Screen</td>
<td>X</td>
<td>●</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Direct Access Information</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>System Memory</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Table</td>
<td>X</td>
<td>●</td>
<td>X</td>
<td>X</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Get History Log</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen History</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Alarm History</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Date and Time</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

518
# Appendix E

## Tables of Functions of PT Models

### Image Data, Library Data, and Marks

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S Ver. 5/NT20</th>
<th>NT30 Ver. 4</th>
<th>NT30C Ver. 4</th>
<th>NT600S Ver. 5</th>
<th>NT620S Ver. 4</th>
<th>NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Image</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total No.</td>
<td>×</td>
<td>×</td>
<td>224</td>
<td>×</td>
<td>224</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>×</td>
<td>×</td>
<td>FE20 to FEFF</td>
<td>×</td>
<td>FE20 to FEFF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comp.</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mode – 8 Colors</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>×</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Library</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total No.</td>
<td>×</td>
<td>×</td>
<td>896</td>
<td>×</td>
<td>896</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>×</td>
<td>×</td>
<td>FA20 to FAFF</td>
<td>FB20 to FBFF</td>
<td>FC20 to FCFF</td>
<td>FD20 to FDF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mark</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total No.</td>
<td>64</td>
<td>64</td>
<td>224</td>
<td>64</td>
<td>64</td>
<td>224</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>FF20 to FF5F</td>
<td>FF20 to FF5F</td>
<td>FF20 to FFFF</td>
<td>FF20 to FFFF</td>
<td>FF20 to FFFF</td>
<td>FF20 to FFFF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Memory Tables

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S Ver. 5/NT20</th>
<th>NT30 Ver. 4</th>
<th>NT30C Ver. 4</th>
<th>NT600S Ver. 5</th>
<th>NT620S Ver. 4</th>
<th>NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table – Numeral</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No.</td>
<td>128</td>
<td>128</td>
<td>512/1000</td>
<td>512</td>
<td>512/1000</td>
<td>512/1000/2000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initial</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Words</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PC (PLC) Address</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I/O Comment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Table – String</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No.</td>
<td>128</td>
<td>128</td>
<td>256/1000</td>
<td>256</td>
<td>256/1000</td>
<td>256/1000/2000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Value*3</td>
<td>(20)</td>
<td>(32)</td>
<td>(40)</td>
<td>(40)</td>
<td>(40)</td>
<td>(40)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initial</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Words</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PC (PLC) Address</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I/O Comment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1: String Table entry no. from 256 to 999 are the entries that only the initial value can be stored and can not be changed.

*2: String Table entry no. from 500 to 1999 are the entries that only the initial value can be stored and can not be changed.

*3: Image/library data can be inserted in the following models, NT30/C, NT620/C, NT625C, NT21 (NT20S-compatible mode) NT31/C-V2 or later models (NT30/620-compatible mode) and NT631/C-V2 or later models (NT30/620-compatible mode).
## Tables of Functions of PT Models

### Appendix E

#### Table – Bit Memory

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20 Ver. 5/NT20 Ver. 4</th>
<th>NT30C/NT30 Ver. 5</th>
<th>NT600S/NT600 Ver. 4</th>
<th>NT620C/NT625S/NT620C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
<td>x</td>
<td>x</td>
<td>256</td>
<td>256</td>
<td>256/1000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>History</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>String Table Entry</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image/Library Code</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Switch Screen</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen No.</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PC (PLC) Address</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I/O Comment</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Table – Extended I/O Input

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20 Ver. 5/NT20 Ver. 4</th>
<th>NT30C/NT30 Ver. 5</th>
<th>NT600S/NT600 Ver. 4</th>
<th>NT620C/NT625S/NT620C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
<td>x</td>
<td>x</td>
<td>64</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancel Backlight Off</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function</td>
<td></td>
<td>x</td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Table – Extended I/O Output

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20 Ver. 5/NT20 Ver. 4</th>
<th>NT30C/NT30 Ver. 5</th>
<th>NT600S/NT600 Ver. 4</th>
<th>NT620C/NT625S/NT620C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
<td>x</td>
<td>x</td>
<td>64</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PC (PLC) Address</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I/O Comment</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Table – I/O Comments

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20 Ver. 5/NT20 Ver. 4</th>
<th>NT30C/NT30 Ver. 5</th>
<th>NT600S/NT600 Ver. 4</th>
<th>NT620C/NT625S/NT620C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total No.</td>
<td>3000</td>
<td>3000</td>
<td>3000</td>
<td>3000</td>
<td>3000</td>
<td>3000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td></td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I/O Comments</td>
<td></td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### F-key Input Notify Table

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20 Ver. 5/NT20 Ver. 4</th>
<th>NT30C/NT30 Ver. 5</th>
<th>NT600S/NT600 Ver. 4</th>
<th>NT620C/NT625S/NT620C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total No.</td>
<td>4</td>
<td>x</td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PC (PLC) Address</td>
<td></td>
<td>x</td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I/O Comments</td>
<td></td>
<td>x</td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Mathematical Table

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20 Ver. 5/NT20 Ver. 4</th>
<th>NT30C/NT30 Ver. 5</th>
<th>NT600S/NT600 Ver. 4</th>
<th>NT620C/NT625S/NT620C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total No.</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No.</td>
<td>x</td>
<td>x</td>
<td></td>
<td>256</td>
<td>256*4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Recipe Table

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20 Ver. 5/NT20 Ver. 4</th>
<th>NT30C/NT30 Ver. 5</th>
<th>NT600S/NT600 Ver. 4</th>
<th>NT620C/NT625S/NT620C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No.</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*4: This option is available only for V2 or later models.

*5: This option is available only for V2 (System Ver. 3.1) or later models.
## Screens

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S Ver. 5/NT20</th>
<th>NT30 Ver. 4</th>
<th>NT30C Ver. 4</th>
<th>NT600S Ver. 5</th>
<th>NT620S Ver. 4</th>
<th>NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen Size (Dots)</td>
<td>160</td>
<td>×</td>
<td>256</td>
<td>×</td>
<td>320</td>
<td>×</td>
<td>640</td>
<td>×</td>
<td>640</td>
<td>×</td>
<td>640</td>
<td>×</td>
</tr>
<tr>
<td>Max. No. of Screen</td>
<td>250</td>
<td>500</td>
<td>2000</td>
<td>1000</td>
<td>2000</td>
<td>3999</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard Screen</td>
<td>1 to 250</td>
<td>1 to 250</td>
<td>1 to 2000</td>
<td>1 to 1000</td>
<td>1 to 1000</td>
<td>1 to 3999</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parent Screen</td>
<td>×</td>
<td>1 to 250</td>
<td>1 to 2000</td>
<td>1 to 1000</td>
<td>1 to 1000</td>
<td>1 to 3999</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Window/Keyboard Screen</td>
<td>×</td>
<td>×</td>
<td>1900 to 1979</td>
<td>×</td>
<td>1900 to 1979</td>
<td>×</td>
<td>1 to 3999</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extended Screen</td>
<td>×</td>
<td>×</td>
<td>1980 to 1996</td>
<td>×</td>
<td>1980 to 1996</td>
<td>×</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Occurrence History Screen</td>
<td>×</td>
<td>×</td>
<td>1997</td>
<td>×</td>
<td>1997</td>
<td>9001 (Not editable)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frequency History Screen</td>
<td>×</td>
<td>×</td>
<td>1998</td>
<td>×</td>
<td>1998</td>
<td>9002 (Not editable)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Host Connect Screen</td>
<td>×</td>
<td>×</td>
<td>1999</td>
<td>×</td>
<td>1999</td>
<td>9000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Password Screen</td>
<td>●</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Menu Screen</td>
<td>●</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Format Screen</td>
<td>●</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device Monitor Screen</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>9021-9023*1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Brightness and Contrast Adjustment Screen</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>9030*2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1: Available only for V2 models.
*2: Available only for V2 (System Ver. 3.1) or later models.

## Screen Properties

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S Ver. 5/NT20</th>
<th>NT30 Ver. 4</th>
<th>NT30C Ver. 4</th>
<th>NT600S Ver. 5</th>
<th>NT620S Ver. 4</th>
<th>NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buzzer</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Continous</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Beep</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Long</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>History</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Keypad</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Back-light</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color – Background</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Tables of Functions of PT Models

#### Elements

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20 Ver. 5/NT20</th>
<th>NT30C/NT30 Ver. 4</th>
<th>NT600S/NT600 Ver. 4</th>
<th>NT620S/NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Start Bit Table Entry</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm List No. of Bits Referenced</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm History order of frequency/order of occurrence</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm History History Info</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm History Info Type</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message – Display Line Qty</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message – Length</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message – Smoothing</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message – Scale</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display ImageLib</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color – Frame</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color – Background – ON</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color – Background – OFF</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image &amp; Library – Color – Foreground</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Tables of Functions of PT Models

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20</th>
<th>NT30/NT30C</th>
<th>NT600S/NT620S/NT620C/NT625C</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alarm</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image &amp; Library –</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color – Background</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line Scroll Touch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Switch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Scroll Touch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Touch Switch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frame</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard Lamp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shape – Rectangle</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shape – Circle</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shape – Polygon</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shape – Sector</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frame</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color – Frame</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lamp Attribute</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color – ON</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color – OFF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label – Max No. of</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>characters</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label – Font Type</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label – Scale</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label – Smoothing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label – Attribute</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label – Color – ON</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label – Color – OFF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label – Color – Background</td>
<td>Δ^2</td>
<td>Δ^2</td>
<td>Δ^2</td>
<td>Δ^1</td>
<td>Δ^1</td>
<td>Δ^1</td>
<td>Δ^1</td>
<td>Δ^1</td>
<td>Δ^1</td>
</tr>
<tr>
<td>Label-Off-Description</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Δ^2* indicates features that are available in NT30/NT30C and NT600S/NT620S/NT620C/NT625C models.

*Δ^1* indicates features that are available in NT21 and NT31 models.

---

Annotation for Table: This table outlines the functions available for different models of PT (Programmable Text) devices, including alarm functions, standard lamp features, and label attributes. The table uses symbols to indicate the availability of each feature across various model numbers and versions.
### Tables of Functions of PT Models

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20</th>
<th>NT30 Ver. 5/NT20</th>
<th>NT30C Ver. 4</th>
<th>NT600S Ver. 5</th>
<th>NT620S Ver. 4</th>
<th>NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Lamp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label-On-Description</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>●</td>
<td>●</td>
<td>●*3</td>
<td>●*3</td>
<td>●*3</td>
</tr>
<tr>
<td>Multiline Label</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>●</td>
<td>●</td>
<td>●*3</td>
<td>●*3</td>
<td>●*3</td>
</tr>
<tr>
<td>Static Label Type</td>
<td>x</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Numeral/String Display Label Type</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>●</td>
<td>●</td>
<td>●*3</td>
<td>●*3</td>
<td>●*3</td>
</tr>
</tbody>
</table>

*1: Fix to transparent  *2: Fix to black  *3: Available only in V2 and later models

With the NT21 and with the NT31, NT31C, NT631 and NT631C with "-V1" and above, smoothing is not performed since 32 dot font is used.
<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S Ver. 5/NT20</th>
<th>NT30C Ver. 4</th>
<th>NT600S Ver. 5</th>
<th>NT620S Ver. 4</th>
<th>NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard Lamp</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insert Mark</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Insert Image</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>Image Lamp</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ON State – Code</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>OFF State – Code</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>Numerical Display</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indirect Reference</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Table Entry</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Display Type – Decimal/Hexadecimal</td>
<td>● Decimal only</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Format – Integer/Decimal</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Zero Suppression</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Display Sign</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Font Type</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Standard only</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale</td>
<td>●</td>
<td>2×1, 1×1</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Smoothing</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Attribute</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – Foreground</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Color – Background</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>String Display</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indirect Reference</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Table Entry</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Length</td>
<td>● (20)</td>
<td>● (32)</td>
<td>● (40)</td>
<td>● (40)</td>
<td>● (40)</td>
<td>● (40)</td>
<td>● (32)</td>
<td>● (40)</td>
<td>● (40)</td>
<td>● (40)</td>
<td>● (40)</td>
</tr>
<tr>
<td>Font Type</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Standard only</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale</td>
<td>●</td>
<td>1×1, 2×1</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

**Appendix E**

*Tables of Functions of PT Models*
### Tables of Functions of PT Models

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20 Ver. 5/NT20 Ver. 4</th>
<th>NT30C/NT30 Ver. 4</th>
<th>NT600S/NT600C Ver. 4</th>
<th>NT620C/NT620C Ver. 4</th>
<th>NT620C/NT620C Ver. 4</th>
<th>NT620C/NT620C Ver. 4</th>
<th>NT620C/NT620C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>String Display</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smoothing</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Attribute</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – Foreground</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – Background</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td><strong>Data Input – Numerical</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table Entry</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Display Type – Decimal/Hexadecimal</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Limit – Maximum</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Limit – Minimum</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Format – Integer/Decimal</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Zero Suppression</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Display Sign</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Font Type</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Scale</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Smoothing</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Attribute</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – Foreground</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – Background</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Focus Frame</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Focus Attribute</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Interlock</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td><strong>Data Input – String</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table Entry</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Length</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Font Type</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Scale</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Smoothing</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

*3: Available only in V2 and later models.
### Tables of Functions of PT Models

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20 Ver. 5/NT20 Ver. 4</th>
<th>NT30/NT30C Ver. 4</th>
<th>NT600S/NT600C Ver. 5</th>
<th>NT620S/NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Input – String</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attribute</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – Foreground</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – Background</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Focus Frame</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Focus Attribute</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Interlock</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>●^3</td>
<td>●^3</td>
<td>●^3</td>
<td>●^3</td>
</tr>
<tr>
<td><strong>Data Input – Thumbwheel Switch</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table Entry</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Display Type – Decimal/Hexadecimal</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Format – Integer/Decimal</td>
<td></td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Limit – Maximum</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Limit – Minimum</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Display Sign</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Attribute</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Size</td>
<td>X</td>
<td>●^1</td>
<td>●</td>
<td>●^2</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>End Plate</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Character Color – Foreground</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Character Color – Background</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Thumbwheel Color – Frame</td>
<td>X</td>
<td>X</td>
<td>●</td>
<td>X</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

*1: Small & Medium only
*2: Medium only
*3: Available only in V2 and later models.
## Tables of Functions of PT Models

### Appendix E

<table>
<thead>
<tr>
<th>Items</th>
<th>Data Input – Thumbwheel Switch</th>
<th>Graphic (Fixed Display)</th>
<th>Text (Fixed Display)</th>
<th>Tiling (Fixed Display)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Thumbwheel Color – Foreground</td>
<td>Polyline</td>
<td>Maximum Character</td>
<td>Pattern</td>
</tr>
<tr>
<td></td>
<td>*1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Thumbwheel Color – Background</td>
<td>Rectangle</td>
<td>Font Type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>*2</td>
<td>Polyline</td>
<td>Scale</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Interlock</td>
<td>Circle</td>
<td>Smoothing</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Arc</td>
<td>Attribute</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sector</td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Mark</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Background</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Color – Foreground</td>
<td></td>
</tr>
</tbody>
</table>

*1: Foreground color for switch
*2: Background color for switch
*3: This option will be available for corresponding V2 and later models in NT30/620-compatible mode.
*4: Available only in V2 and later models.
*5: This option is available in NT20S-compatible mode.
<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20 Ver. 5/NT20 Ver. 4</th>
<th>NT30C Ver. 4</th>
<th>NT600S Ver. 5</th>
<th>NT620S Ver. 4</th>
<th>NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark (Fixed Display)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Scale</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Attribute</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Smoothing</td>
<td>×</td>
<td>× *1</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – Foreground</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – Background</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Image Display (Fixed Display)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indirect Reference</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>Δ²</td>
<td>Δ²</td>
<td>Δ²</td>
<td>Δ²</td>
</tr>
<tr>
<td>Color – Foreground</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – Background</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Library Display (Fixed Display)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indirect Reference</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>Δ²</td>
<td>Δ²</td>
<td>Δ²</td>
<td>Δ²</td>
</tr>
<tr>
<td>Touch Switch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function – Notify Bit</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Function – Switch Screen</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function – Input Key – Control</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function – Input Key – Window/Keyboard</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function – Input Key – String</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function – Copy Setting</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

*1: For NT20, NT20S, NT600S, smoothing is always ON.
*2: Can be used only NT31, NT31C, NT631, NT631C with system Ver. 2.1 and above or with “-V2” or “-V3”.
*3: Input character strings different from the label characters can be specified.
### Tables of Functions of PT Models

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S /NT11</th>
<th>NT20S Ver. 5/NT20</th>
<th>NT30 Ver. 4</th>
<th>NT30C Ver. 4</th>
<th>NT600S Ver. 5</th>
<th>NT620S Ver. 4</th>
<th>NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch Switch Function – Cursor Move</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Function – Screen Print</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Function – Window Move</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>Δ(^1)</td>
<td>Δ(^1)</td>
<td>Δ(^1)</td>
<td>Δ(^1)</td>
<td>Δ(^1)</td>
</tr>
<tr>
<td>PC (PLC) Bit Address</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Shape – Standard</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Shape – Shadow</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Shape – 3-Dimension</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Shape – Rectangle</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Shape – Circle</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Shape – Polygon</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Shape – Sector</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Frame</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – Frame</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Show ON State</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Lamp Attribute</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – ON</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – OFF</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Max No. of Characters</td>
<td>×</td>
<td>32</td>
<td>40</td>
<td>40</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>32</td>
<td>40</td>
<td>40</td>
<td>80</td>
<td>80</td>
</tr>
<tr>
<td>Label – Font Type</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Label – Scale</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Label – Smoothing</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

*1: Can be used only for NT31, NT31C, NT631 and NT631C with "-V\□" and above.
## Tables of Functions of PT Models

### Appendix E

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20 Ver. 5/4</th>
<th>NT30/NT30C Ver. 4</th>
<th>NT600S/NT600C Ver. 5/4</th>
<th>NT620S/NT620C Ver. 4/5/4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch Switch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label – Attribute</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label – Color – ON</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label – Color – OFF</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label – Color – Background</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label – Insert Mark</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label – Insert Image</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interlock</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multiline Label</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Static Label Type</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Numeral/ String Display Label Type</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Trend Graph

| Standard/ Pen Reco | X |                     |                   |                        |                          |      |      |      |       |       |
| Sampling Cycle     | X |                     |                   |                        |                          |      |      |      |       |       |
| Table Entry        | X |                     |                   |                        |                          |      |      |      |       |       |
| 100% Table Entry   | X |                     |                   |                        |                          |      |      |      |       |       |
| 100% – Value       | X |                     |                   |                        |                          |      |      |      |       |       |
| 0% – Table Entry   | X |                     |                   |                        |                          |      |      |      |       |       |
| 0% – Value         | X |                     |                   |                        |                          |      |      |      |       |       |
| –100% – Table Entry| X |                     |                   |                        |                          |      |      |      |       |       |
| –100% – Value      | X |                     |                   |                        |                          |      |      |      |       |       |

*3: Available only in V2 and later models.
<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20 Ver. 5</th>
<th>NT30/NT20 Ver. 4</th>
<th>NT30C/NT20 Ver. 5</th>
<th>NT600S/NT20 Ver. 4</th>
<th>NT620S/NT20 Ver. 4</th>
<th>NT620C/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend Graph</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line – Style</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Line – Color</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Direction</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Display Sign</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Frame</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Color – Frame</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Color – + Range</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Color – – Range</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Display %</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Display % – Font Type</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Display % – Scale</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Display % – Smoothe ing</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Display % – Color – Foreground</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Display % – Color – Background</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Items</td>
<td>NT11S /NT11</td>
<td>NT20S Ver. 5/NT20</td>
<td>NT30 Ver. 4</td>
<td>NT30C Ver. 4</td>
<td>NT600S Ver. 5</td>
<td>NT620S Ver. 4</td>
<td>NT620C/NT625C Ver. 4</td>
<td>NT21</td>
<td>NT31</td>
<td>NT31C</td>
<td>NT631</td>
<td>NT631C</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------</td>
<td>---------------</td>
<td>---------------</td>
<td>---------------------</td>
<td>------</td>
<td>------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>Broken-line Graph</td>
<td>Start Table Entry</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>No. of Points</td>
<td>×</td>
<td>×</td>
<td>2-320</td>
<td>2-320</td>
<td>×</td>
<td>2-512</td>
<td>2-512</td>
<td>2-260</td>
<td>2-320</td>
<td>2-512</td>
<td>2-512</td>
</tr>
<tr>
<td></td>
<td>100% – Table Entry</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>100% – Value</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>0% – Table Entry</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>0% – Value</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>–100% – Table Entry</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>–100% – Value</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>Line – Style</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>Line – Color</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>Direction</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>Display Sign</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>Frame</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>Color – Frame</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>Color – + Range</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>Color – – Range</td>
<td>×</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>×</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>
### Tables of Functions of PT Models

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S Ver. 5/NT20</th>
<th>NT30 Ver. 4</th>
<th>NT30C Ver. 4</th>
<th>NT600S Ver. 5</th>
<th>NT620S Ver. 4</th>
<th>NT620G/NT625C Ver. 4</th>
<th>NT21</th>
<th>NT31</th>
<th>NT31C</th>
<th>NT631</th>
<th>NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar Graph</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table Entry</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>100% – Table Entry</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>100% – Value</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>0% – Table Entry</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>0% – Value</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>–100% – Table Entry</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>–100% – Value</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Direction</td>
<td>●</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Right only</td>
<td></td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Display Sign</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Frame</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – Frame</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – + Range</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Color – – Range</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Display %</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Display % – Font Type</td>
<td>●</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Standard only</td>
<td></td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Display % – Scale</td>
<td>●</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>1 × 1, 2 × 1</td>
<td></td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Display % – Smoothing</td>
<td>●</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Display % – Color – Foreground</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Display % – Color – Background</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Display % – Color – Background</td>
<td>×</td>
<td>×</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

**Appendix E**
### Appendix E

#### Tables of Functions of PT Models

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20</th>
<th>NT30/NT30C</th>
<th>NT600S/NT600C</th>
<th>NT620S/NT620C</th>
<th>NT620G/NT620G</th>
<th>NT21/NT21C</th>
<th>NT31/NT31C</th>
<th>NT631/NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analogue Meter</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Frame</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Color – Frame</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Display Sign</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Direction</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Meter – Shape</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Meter – Direction</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Meter – Type</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Meter – Width Rate</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Scale</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Distance</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Scale Length</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>No. of Division</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Scale Color</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Color – Foreground</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Color – Background</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Color – +Range</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Color – –Range</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Value – Table Entry</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

*1: Can be used only with NT31, NT31C, NT631 and NT631C with “-V1” and above.
### Tables of Functions of PT Models

**Appendix E**

<table>
<thead>
<tr>
<th>Items</th>
<th>NT11S/NT11</th>
<th>NT20S/NT20</th>
<th>NT30/NT30C</th>
<th>NT600S/NT620S/NT620C/NT625C</th>
<th>NT21/NT21C</th>
<th>NT31/NT31C</th>
<th>NT631/NT631C</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Analog Meter</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display Label</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Δ⁺¹</td>
<td>Δ⁺¹</td>
</tr>
<tr>
<td>100% – Table Entry</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Δ⁺¹</td>
<td>Δ⁺¹</td>
</tr>
<tr>
<td>100% – Value</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Δ⁺¹</td>
<td>Δ⁺¹</td>
</tr>
<tr>
<td>0% – Table Entry</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Δ⁺¹</td>
<td>Δ⁺¹</td>
</tr>
<tr>
<td>0% – Value</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Δ⁺¹</td>
<td>Δ⁺¹</td>
</tr>
<tr>
<td>–100% – Table Entry</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Δ⁺¹</td>
<td>Δ⁺¹</td>
</tr>
<tr>
<td>–100% – Value</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Δ⁺¹</td>
<td>Δ⁺¹</td>
</tr>
<tr>
<td>Display % – Font Type</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Δ⁺¹</td>
<td>Δ⁺¹</td>
</tr>
<tr>
<td>Display % – Scale</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Δ⁺¹</td>
<td>Δ⁺¹</td>
</tr>
<tr>
<td>Display % – Smoothing</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Δ⁺¹</td>
<td>Δ⁺¹</td>
</tr>
<tr>
<td>Display % – Foreground</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Δ⁺¹</td>
<td>Δ⁺¹</td>
</tr>
<tr>
<td>Display % – Background</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Δ⁺¹</td>
<td>Δ⁺¹</td>
</tr>
<tr>
<td>Recipe</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Δ⁺²</td>
<td>Δ⁺²</td>
</tr>
</tbody>
</table>

*¹: Can be used only with NT31, NT31C, NT631 and NT631C with “-V1” and above.

*²: Can be used only with NT31/631C(System Ver.3.1) and above.
Appendix F
Limits on Numbers of Elements

Limits with Conventional Models

For NT20, NT20S, NT30, NT30C, NT600S, NT620S, NT620C, and NT625C, the limits on the use of elements are indicated below for each PT model.

<table>
<thead>
<tr>
<th>Item</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeral Display</td>
<td>50 entries/screen</td>
</tr>
<tr>
<td>String Display</td>
<td>NT20, NT20S: 32 entries/screen</td>
</tr>
<tr>
<td></td>
<td>Other models: 50 entries/screen</td>
</tr>
<tr>
<td>Bar Graph</td>
<td>50 entries/screen</td>
</tr>
<tr>
<td>Broken-line graph</td>
<td>NT20, NT20S, NT600S: Not supported</td>
</tr>
<tr>
<td></td>
<td>Other models: 1 frame/screen, 256 lines/frame</td>
</tr>
<tr>
<td>Trend Graph</td>
<td>NT20, NT20S, NT600S: Not supported</td>
</tr>
<tr>
<td></td>
<td>Other models: 1 frame/screen, 50 lines/screen data file</td>
</tr>
<tr>
<td>Lamp</td>
<td>NT20, NT20S: 128 entries/screen</td>
</tr>
<tr>
<td></td>
<td>NT600S: 255 entries/screen</td>
</tr>
<tr>
<td></td>
<td>Other models: 256 entries/screen</td>
</tr>
<tr>
<td>Touch Switch</td>
<td>NT20, NT20S: 72 entries/screen</td>
</tr>
<tr>
<td></td>
<td>NT600S: 128 entries/screen</td>
</tr>
<tr>
<td></td>
<td>Other models: 256 entries/screen</td>
</tr>
<tr>
<td>Data Input – Numeral</td>
<td>50 entries/screen (overlapping screens: Registration is possible only on one child screen.)</td>
</tr>
<tr>
<td>Data Input – String</td>
<td>50 entries/screen (overlapping screens: Registration is possible only on one child screen.)</td>
</tr>
<tr>
<td>Alarm List</td>
<td>NT20, NT20S, NT600S: Not supported</td>
</tr>
<tr>
<td></td>
<td>Other models: 4 groups/screen (max: 32 groups in overlapping screens)</td>
</tr>
</tbody>
</table>
# Limits on Numbers of Elements

## New Models

<table>
<thead>
<tr>
<th>Item</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fixed Display</strong></td>
<td>65,535 entries/screen (overlapping screens(^1): max. 524,280 entries)</td>
</tr>
<tr>
<td><strong>Numeral Display</strong></td>
<td>256 entries/screen (overlapping screens(^1): max. 1,024 entries)</td>
</tr>
<tr>
<td><strong>String Display</strong></td>
<td>256 entries/screen (overlapping screens(^1): max. 1,024 entries)</td>
</tr>
<tr>
<td><strong>Image Data</strong></td>
<td>256 entries/screen, including library data (overlapping screens(^1): max. 1,024 entries)</td>
</tr>
<tr>
<td><strong>Library Data</strong></td>
<td>256 entries/screen, including image data (overlapping screens(^1): max. 1,024 entries)</td>
</tr>
<tr>
<td><strong>Mark Display (fixed display)</strong></td>
<td>65,535 entries/screen (overlapping screens(^1): max. 52,480 entries)</td>
</tr>
<tr>
<td><strong>Bar Graph</strong></td>
<td>50 entries/screen (overlapping screens(^1): max. 400 entries)</td>
</tr>
<tr>
<td><strong>Analogue Meter(^2)</strong></td>
<td>50 entries/screen (overlapping screens(^1): max. 400 entries)</td>
</tr>
<tr>
<td><strong>Broken-line Graph</strong></td>
<td>1 frame/screen (overlapping screens(^1): max. 8 frames) 256 lines/frame</td>
</tr>
<tr>
<td><strong>Trend Graph</strong></td>
<td>1 frame/screen (overlapping screens(^1): max. 8 frames)</td>
</tr>
<tr>
<td>Data logging function not used: 50 lines/screen data</td>
<td></td>
</tr>
<tr>
<td>Data logging function used: 8 lines/screen data</td>
<td></td>
</tr>
<tr>
<td><strong>Lamp</strong></td>
<td>256 entries/screen (overlapping screens(^1): max. 1,024 entries)</td>
</tr>
<tr>
<td><strong>Touch Switch</strong></td>
<td>256 entries/screen (overlapping screens(^1): max. 1,024 entries)</td>
</tr>
<tr>
<td><strong>Numerical Input</strong></td>
<td><strong>Numeric Key Type</strong></td>
</tr>
<tr>
<td><strong>Thumbwheel SW Type</strong></td>
<td>256 entries/screen (overlapping screens(^3): Registration is possible only on one child screen)</td>
</tr>
<tr>
<td>NT21: 26 entries/screen (overlapping screens(^4): Registration is possible only on one child screen.)</td>
<td></td>
</tr>
<tr>
<td>NT31/NT31C: 64 entries/screen (overlapping screens(^4): Registration is possible only on one child screen.)</td>
<td></td>
</tr>
<tr>
<td>NT31/NT31C: 256 entries/screen (overlapping screens(^4): Registration is possible only on one child screen.)</td>
<td></td>
</tr>
<tr>
<td><strong>Data Input – String</strong></td>
<td>256 entries/screen (overlapping screens(^3): Registration is possible only on one child screen.)</td>
</tr>
<tr>
<td><strong>Alarm List</strong></td>
<td>4 groups/screen (max. 32 groups in overlapping screens(^1))</td>
</tr>
<tr>
<td><strong>Alarm History</strong></td>
<td>(Alarm history: One group each for occurrence order and frequency order in standard/child screen)</td>
</tr>
<tr>
<td><strong>Recipe</strong></td>
<td>1 frame/screen (overlapping screens(^1): max. 8 frames)</td>
</tr>
</tbody>
</table>

\(^1\): Limits on numbers of elements on a window/keyboard screen is same as on a standard screen. Limit check is not performed for overlapping screens at the Support Tool.

\(^2\): Analogue meter can be used only with the NT21 and with the NT31, NT31C, NT631 and NT631C with “-V1” and above.

\(^3\): Either of numeral input (numeric key type) or string input can be registered on a window/keyboard screen.

\(^4\): Thumbwheel type numeral input can not be registered on a window/keyboard screen.
Limits on display

For elements, limits are also applied to display in addition to the limits on the numbers shown above.

- Limits on reading the data

  For the NT21, NT31, NT31C, NT631, and NT631C, the allowable number of data entries that can be read at the same time is set and read elements exceeding this limit are not displayed. If the same data is read from different elements, reading of the data is counted separately.

  Refer to the appendix in the NT21/31/631 Reference Manual for the allowable maximum number of data entries that can be read.
Appendix G
New Functions of Support Tool Ver.4.1

Here, differences between the Support Tool Ver.3.3 and Ver.4.1 and the new functions added to Ver.4.1 are shown in the table. Various functions are added to Ver.4.1 to improve operational efficiency.

<table>
<thead>
<tr>
<th>Items</th>
<th>Ver.3.3</th>
<th>Ver.4.1</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT31/631 V2 Models support</td>
<td>Not supported</td>
<td>The following PT Models are supported: NT31-V2 NT31C-V2 NT631-V2 NT631C-V2</td>
<td>3-3</td>
</tr>
<tr>
<td>Different On/off description for standard lamp/touch switch.</td>
<td>Not supported</td>
<td>The following functions are supported.</td>
<td>6-5-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• On description and Off description of standard lamp/touch switch can be different in V2 models.</td>
<td>6-8</td>
</tr>
<tr>
<td>Insertion of image/library in character string</td>
<td>Not available in new models</td>
<td>This option will be available for NT31/C-V2 and NT631/C-V2 models in NT30/620 compatible mode.</td>
<td>6-2-7</td>
</tr>
<tr>
<td>Retaining of alarm history/list associated touch switch attributes, when converted from NT30/620 model to new V2 models.</td>
<td>Not supported</td>
<td>Alarm history/list associated touch switches will keep its attributes unchanged when converted from NT30/620 to V2 models in NT30/620-compatible mode.</td>
<td>Appendix-A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Correc- tion of alarm list/his- to- ry touch switches</td>
<td>7-3-5</td>
</tr>
<tr>
<td>Centralizing the Label of Lamp and Touch switch in both horizontal and vertical direction.</td>
<td>Label is centralized only in horizontal direction</td>
<td>Label is centralized both horizontal and vertical direction.</td>
<td>6-1-9</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>9-3-12</td>
</tr>
<tr>
<td>Mathematical Table</td>
<td>Not supported</td>
<td>A different memory table is supplied to input mathematical functions.</td>
<td>7-9</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>9-3</td>
</tr>
<tr>
<td>Interlock</td>
<td>Not supported</td>
<td>This facility is provided to activate or deactivate the associated object. Only when interlock is ON the object will response to the user touches, deactivated otherwise.</td>
<td>6-1-12</td>
</tr>
<tr>
<td>New Words Added to OMRON</td>
<td>Not supported</td>
<td>Words for EM Bank 0..F, Time Up Flag, Counter Up Flag, Task Flag and Work Area are added.</td>
<td>6-1-10</td>
</tr>
<tr>
<td>Device monitor screen</td>
<td>Not supported</td>
<td>New Device monitor screens (9021-23) are available switch screen functionality of touch switch/bit memory table.</td>
<td>5-12</td>
</tr>
<tr>
<td>Items</td>
<td>Ver.3.3</td>
<td>Ver.4.1</td>
<td>Section</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>I/O Comments Import</td>
<td>Not supported</td>
<td>I/O Comments in TAB delimited text file can be imported to NTST.</td>
<td>7-7-4</td>
</tr>
<tr>
<td>Multiline Label</td>
<td>Not supported</td>
<td>Labels (ON/OFF Descriptions) can be entered in multiple lines.</td>
<td>6-5-1</td>
</tr>
<tr>
<td>Multiline Label</td>
<td>Not supported</td>
<td>Labels (ON/OFF Descriptions) can be entered in multiple lines.</td>
<td>6-5-1</td>
</tr>
<tr>
<td>NT30/620 Compatible Mode</td>
<td>Not supported</td>
<td>With this option it can be chosen between the existing 31/631 model's 5-2 control/Notify structure or the 30/620 model's 4-3 control/notify structure.</td>
<td>3-3-1</td>
</tr>
<tr>
<td>Numeral/String Display Label Type</td>
<td>Not supported</td>
<td>Enables dynamic labeling as Label can be taken from Numeral or String table.</td>
<td>6-5-1</td>
</tr>
<tr>
<td>Input Key – String function Touch Switch of NT31, NT31C, NT631, NT631C</td>
<td>Description of label is always used as a character string to be input. (When a touch switch is pressed, a label will be input.)</td>
<td>Character strings can be specified individually. Addition of Copy From Label button. When a touch switch is pressed, set character string will be input regardless of the label.</td>
<td>6-8-3</td>
</tr>
<tr>
<td>Start-up of system installer from the Support Tool</td>
<td>Not supported</td>
<td>System installer can be started directly by selecting [Connect] – [Launch System Installer]. (It can also be started up from Windows.)</td>
<td>1-1</td>
</tr>
<tr>
<td>System programs to be attached</td>
<td>NT31/631 series system programs</td>
<td>System programs of conventional models such as NT30/620 series are also included in a CD-ROM.</td>
<td>1-1</td>
</tr>
<tr>
<td>Recipe</td>
<td>Not supported</td>
<td>This is available only for NT31/631-V2 (System Ver.3.1).</td>
<td>6-11-1</td>
</tr>
<tr>
<td>Brightness and Contrast Adjustment Screen</td>
<td>Not supported</td>
<td>This is available only for NT31/631-V2 (System Ver.3.1).</td>
<td>5-14</td>
</tr>
<tr>
<td>Multi-Edit Mode</td>
<td>Not supported</td>
<td>Available only for recipe object.</td>
<td>6-1</td>
</tr>
</tbody>
</table>
Appendix H
New Functions of Support Tool Ver.4.6

Some User Interface functionality was added to Ver.4.6 to improve operation efficiency.

<table>
<thead>
<tr>
<th>Item</th>
<th>Ver. 4.1</th>
<th>Ver. 4.6</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT21 Model support</td>
<td>Not supported.</td>
<td>NT21 is supported.</td>
</tr>
<tr>
<td>Pick I/O comment from CX-Server database</td>
<td>Only CSV file import is available.</td>
<td>When defining PLC address for each object, the I/O name in CX-Server point data is picked up as the PT I/O comment. When editing the I/O comment table multiple I/O names in CX-Server point data are imported as PT I/O comments.</td>
</tr>
<tr>
<td>Property Dialog for Grouped Object</td>
<td>Grouped object attributes cannot be edited unless ungrouped.</td>
<td>Grouped object attributes can be edited to select each property for grouped object.</td>
</tr>
<tr>
<td>Preview in Symbol manager</td>
<td>Each symbol cannot be previewed on the Symbol Manager.</td>
<td>Symbol Manager shows preview and object tree view. Symbols created before V4.6 can be read on V4.6 screen edit to add preview data, then can be previewed after copying then back to the Symbol Manager.</td>
</tr>
<tr>
<td>Copying Image/Library/Mark with contents</td>
<td>Only code of image/Library/Mark in the object is copied when the object is copied from other application with Import Components Command. Contents must be copied separately.</td>
<td>Contents of Image/Library/Mark in the object is copied when the object is copied form other application with Import Components command. Separate copying of contents is also available.</td>
</tr>
</tbody>
</table>
Appendix I
New Functions of Support Tool Ver.4.7

Some User Interface functionality was added to Ver.4.7 to improve operation efficiency.

<table>
<thead>
<tr>
<th>Item</th>
<th>Ver. 4.1</th>
<th>Ver. 4.7</th>
</tr>
</thead>
<tbody>
<tr>
<td>NT11-V1 Model support</td>
<td>Not supported.</td>
<td>NT11-V1 is supported.</td>
</tr>
<tr>
<td>Supported OS</td>
<td>Windows 95/98 and NT</td>
<td>Windows 95/98, Me, NT, 2000, and Xp</td>
</tr>
<tr>
<td>Screen size at start of</td>
<td>100% (fixed)</td>
<td>For NT11S, NT11, NT20S, and NT21, magnification of 100%, 200%, or 400% is automatically selected to match the resolution of the personal computer being used.</td>
</tr>
<tr>
<td>screen editing</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix J
New Functions of Support Tool Ver.4.8

Version 4.8 supports NT20.
- Support for NT20
A system program for the NT20 has been added.
Functionality for transferring the system program to the NT20 has been added to the system installer.
Appendix K
Error Messages

The error message that may be displayed while using the Support Tool, and the action to take in response to them, are shown below.

The indications [W] and [E], given at the beginning of an error message, classify the level of errors as indicated below.

[W]: Minor error (permits transmission and execution of screen data)
[E]: Major error (disables transmission of screen data)

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sign % display or other element(s) cannot overlap with the Trend Graph.</td>
<td>A “% display” or other element is overlapping the trend graph. Move the element outside the trend graph frame.</td>
</tr>
<tr>
<td>A Application version mismatched; Communication aborted.</td>
<td>System program version installed in a PT maybe a lower one. For details of the combination of system program version that can be transmitted and the PT model setting at the Support Tool, refer to 11-1-2 Available Data Communication Methods by PT Models. For details of updating the system program, refer to Appendix B.</td>
</tr>
<tr>
<td>C Cannot have more than XXX child screens.</td>
<td>When creating a new screen, insert a number of child screens that does not exceed the maximum limit.</td>
</tr>
<tr>
<td>Clock Monitoring Address has not been set.</td>
<td>With an NT21 PT, set the Clock Address to define a clock Data Area so the clock data can be read from the PLC.</td>
</tr>
<tr>
<td>Constant Value is out of limit. Maximum value restored.</td>
<td>Correct the screen data or the program in the host so that a constant of up to 8 digits set for the copy setting touch switch will suffice.</td>
</tr>
<tr>
<td>Continuous screen does not allow child screen to have Thumbwheel/Numeral/String Input elements.</td>
<td>Delete thumbwheel switches, numeral input elements, and/or character string input elements.</td>
</tr>
<tr>
<td>Control/Notify/Window Control area cannot overlap each other.</td>
<td>Make sure that the PT status control area, the PT status notify area and the window control area are not overlapping each other.</td>
</tr>
<tr>
<td>Cursor Move Touch Switch does not have any association link.</td>
<td>Select the cursor moving touch switch on the screen, choose [Draw] – [Associate], then specify the element with which the selected touch switch is to be associated.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>D Due to length limitation, Input Key – String Touch Switch is only displaying part of the label message.</td>
<td>With NT620S, NT620C and NT625C, if a character string input is selected as the touch switch function, up to 80 characters can be set for an input character string. With NT21, NT31, NT31C, NT631 and NT631C, however, although up to 80 characters can be set for a label, the limit is 40 characters for an input character string (a character string that is input using a touch switch).</td>
</tr>
<tr>
<td>F [Fixed Display Mark] – smoothing not supported. It is ignored.</td>
<td>The mark is automatically displayed without smoothing processing.</td>
</tr>
<tr>
<td>I Image Table entry has been converted.</td>
<td>If the converted image code differs from the code of the image data that is to be displayed, correct the code.</td>
</tr>
<tr>
<td>Incompatible PT hardware connected; communication aborted.</td>
<td>The PT model between the screen data and the target PT is mismatching on downloading/uploading. Check the contents of PT Configuration.</td>
</tr>
<tr>
<td>Input key-window/keyboard screen number is not within the valid range. Minimum value restored.</td>
<td>Create the window/keyboard screen for a screen number in the range 1900 to 1979 and convert the window/keyboard screen number set for the touch switch accordingly.</td>
</tr>
<tr>
<td>L Library Table Entry has been converted.</td>
<td>If the converted library code differs from the code of the library data that is to be displayed, correct the code.</td>
</tr>
<tr>
<td>M Memory access mismatched; communication aborted.</td>
<td>Target PLC vendor type or PT type is mismatching between the Support Tool and PT hardware. Confirm the Support Tool and PT side PLC vendor and PT type is mismatching.</td>
</tr>
<tr>
<td>Memory utilization has exceeded the XXX bytes limit by YYY bytes.</td>
<td>Delete several elements.</td>
</tr>
<tr>
<td>Memory utilization has exceeded the XXX bytes limit by YYY bytes.</td>
<td>Delete several elements and screens.</td>
</tr>
<tr>
<td>More than one Numeral Input/Thumbwheel are referring to Numeral Table entry 0.</td>
<td>Set different numeral memory table entry numbers at the numeral input and thumbwheel switch properties.</td>
</tr>
<tr>
<td>N Notify Area not specified. Control Area not specified.</td>
<td>Set the PC (PLC) address for the PT status control area/PT status notify area after selecting [Tools] – [PT Configuration].</td>
</tr>
<tr>
<td>Number of [Object name] has exceeded the XXX limit by YYY.</td>
<td>Delete several elements.</td>
</tr>
<tr>
<td>[Numeral Input] – Total number of integer and decimal exceeds limit. It is discarded.</td>
<td>Create the numeral input field again. Correct the screen data and the program in the host so that numeric values such as maximum/minimum check values and an input value of up to 8 digits will suffice.</td>
</tr>
<tr>
<td></td>
<td>Error Message</td>
</tr>
<tr>
<td>----</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>O</td>
<td>[Object Name] – % value is out of limit. Default values restored for 100%, 0%, and –100%.</td>
</tr>
<tr>
<td></td>
<td>[Object Name] has exceeded the maximum number of characters.</td>
</tr>
<tr>
<td></td>
<td>[Object name] refers to invalid numeral table entry. The referenced table entry is reset to entry 0.</td>
</tr>
<tr>
<td></td>
<td>[Object Name] – Invalid PLC address. It is reset to default.</td>
</tr>
<tr>
<td></td>
<td>[Object Name] – inverse attribute not supported. Foreground and Background colors interchanged.</td>
</tr>
<tr>
<td></td>
<td>Overlapping screen has more than 1 child screen containing Thumbwheel/Numeric/String Input elements.</td>
</tr>
<tr>
<td>P</td>
<td>Please make sure this parent screen have at least 2 children.</td>
</tr>
<tr>
<td>S</td>
<td>Sampling cycle less than the minimum value. Minimum value is restored.</td>
</tr>
<tr>
<td></td>
<td>Sampling cycle not multiple of 5. Value rounded off to nearest multiple of 5.</td>
</tr>
<tr>
<td></td>
<td>Screen is empty, downloading may not be possible.</td>
</tr>
<tr>
<td></td>
<td>Some objects exceed library size in code FA20. The objects will not be downloaded to PT hardware.</td>
</tr>
<tr>
<td></td>
<td>String Table: Table Entry XXX has invalid component code. It has been converted from XXXX to YYYY.</td>
</tr>
<tr>
<td>T</td>
<td>The associated touch switches of the alarm has been discarded and component touch switches have been created.</td>
</tr>
<tr>
<td></td>
<td>The child screen XXX containing Numerical/String Input element(s) does not have the same key attribute as the overlapping screen.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The code for screen element [ObjectName] has been converted from XXXX to YYYY.</td>
<td>If the converted code differs from the code of the image element that is to be displayed, correct the code.</td>
</tr>
<tr>
<td>The code for screen element [ObjectName] has been converted from XXXX to YYYY.</td>
<td>If the converted code differs from the code of the library data that is to be displayed, correct the code.</td>
</tr>
<tr>
<td>The component Touch Switches of the Alarm List will be discarded.</td>
<td>Create the control touch switches using the control code input function as required, and associate them with the alarm list/history.</td>
</tr>
<tr>
<td>The screen no. XXX of type YYY is not supported as a child, so the parent-child association is discarded.</td>
<td>With a new model, it is not permissible to specify a window/keyboard screen as a child screen of overlapping screens. Copy the contents of the window/keyboard screen to a standard screen and specify this screen as the child screen of the overlapping screens.</td>
</tr>
<tr>
<td>The screen no. XXX was a Continuous Parent Screen which is not supported in this model. It is discarded.</td>
<td>Use a touch switch to switch screens. If the program is created to display the parent screen of the continuous screens, correct the program so that the first child screen is displayed.</td>
</tr>
<tr>
<td>The screen no. XXX was an Extended Screen which is not supported in this model, so it is converted to standard screen.</td>
<td>Correction not necessary.</td>
</tr>
<tr>
<td>The screen number referenced in Touch Switch, is not a Window/Keyboard screen.</td>
<td>Create the window/keyboard screen after selecting [New], then use it as the reference screen.</td>
</tr>
<tr>
<td>The total number of Alarm List and History exceeds the overlapping screen’s limit of XXX by YYY.</td>
<td>Create the alarm list/history within the limit.</td>
</tr>
<tr>
<td>The total number of Bar Graph exceeds the overlapping screen’s limit of 400 by YYY.</td>
<td>Create the bar graphs within the limit.</td>
</tr>
<tr>
<td>The total number of Broken Line Graphs exceeds the overlapping screen’s limit of XXX by YYY.</td>
<td>Create the broken line graphs within the limit.</td>
</tr>
<tr>
<td>The total number of lines in Broken Line Graphs exceeds the overlapping screen’s limit of XXX by YYY.</td>
<td>Create the broken line graphs within the limit.</td>
</tr>
<tr>
<td>The total number of XXX exceeds the overlapping screen’s limit of 256 by ZZZ.</td>
<td>Create the elements within the limit.</td>
</tr>
<tr>
<td>The total number of Image Display and Library Display exceeds the overlapping screen’s limit of 256 by XXX.</td>
<td>Create the image/library data within the limit.</td>
</tr>
<tr>
<td>The total number of Numeral Display exceeds the overlapping screen’s limit of 1024 by XXX.</td>
<td>Create the numeral display fields within the limit.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>T</td>
<td>Reduce the number of reference elements.</td>
</tr>
<tr>
<td>The total number of Numeral Table references exceeds the overlapping screen’s limit of XXX by YYY.</td>
<td></td>
</tr>
<tr>
<td>The total number of String Table references exceeds the overlapping screen’s limit of XXX by YYY.</td>
<td>Create the elements within the maximum limit.</td>
</tr>
<tr>
<td>The total number of touch switches exceeds the overlapping screen’s limit of XXX by YYY.</td>
<td>Create the touch switches within the limit.</td>
</tr>
<tr>
<td>The total number of Trend graph frame exceeds the overlapping screen’s limit of 8 by XXX.</td>
<td>Create the trend graphs within the limit.</td>
</tr>
<tr>
<td>The total number of Trend Graph line with Data Logging is ON exceeds the application limit of 8 by YYY.</td>
<td>Create the trend graphs within the limit.</td>
</tr>
<tr>
<td>The total number of vertices in Broken Line Graphs exceeds the overlapping screen’s limit of XXX by YYY.</td>
<td>Create the broken line graphs within the limit.</td>
</tr>
<tr>
<td>This screen does not support XXX. It is discarded.</td>
<td>Correct the system initialization screen so that the same screen as before the conversion is created using fixed display elements excluding image/library data.</td>
</tr>
<tr>
<td>Touch Switch function type is not supported. It is discarded.</td>
<td>Correct the position of the control touch switch as needed.</td>
</tr>
<tr>
<td>Touch switch does not have associated alarm object.</td>
<td>Select the alarm touch switch on the screen, choose [Draw] – [Associate], then specify the element with which the selected touch switch is to be associated.</td>
</tr>
<tr>
<td>Y</td>
<td>To import screen data by starting up two Support Tools, select [Import Component] from the [File] menu.</td>
</tr>
<tr>
<td>You have already started NT-series Support Tool.</td>
<td></td>
</tr>
</tbody>
</table>
# Appendix L
## Shortcut Keys

The following shortcut keys can be used with the Support Tool. Pressing these shortcut keys can perform the functions easily without selecting the items from the menu.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td><strong>New</strong></td>
<td>Ctrl + N</td>
</tr>
<tr>
<td></td>
<td><strong>Open</strong></td>
<td>Ctrl + O</td>
</tr>
<tr>
<td></td>
<td><strong>Save</strong></td>
<td>Ctrl + S</td>
</tr>
<tr>
<td></td>
<td><strong>Print</strong></td>
<td>Ctrl + P</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td><strong>Undo</strong></td>
<td>Ctrl + Z</td>
</tr>
<tr>
<td></td>
<td><strong>Redo</strong></td>
<td>Ctrl + Y</td>
</tr>
<tr>
<td></td>
<td><strong>Cut</strong></td>
<td>Ctrl + X</td>
</tr>
<tr>
<td></td>
<td><strong>Copy</strong></td>
<td>Ctrl + C</td>
</tr>
<tr>
<td></td>
<td><strong>Paste</strong></td>
<td>Ctrl + V</td>
</tr>
<tr>
<td></td>
<td><strong>Align Top</strong></td>
<td>Ctrl + Up Arrow</td>
</tr>
<tr>
<td></td>
<td><strong>Align Bottom</strong></td>
<td>Ctrl + Down Arrow</td>
</tr>
<tr>
<td></td>
<td><strong>Align Left</strong></td>
<td>Ctrl + Left Arrow</td>
</tr>
<tr>
<td></td>
<td><strong>Align Right</strong></td>
<td>Ctrl + Right Arrow</td>
</tr>
<tr>
<td></td>
<td><strong>Center in a Column</strong></td>
<td>Ctrl + F9</td>
</tr>
<tr>
<td></td>
<td><strong>Center in a Row</strong></td>
<td>Ctrl + Shift + F9</td>
</tr>
<tr>
<td></td>
<td><strong>Delete</strong></td>
<td>Del</td>
</tr>
<tr>
<td></td>
<td><strong>Select All</strong></td>
<td>Ctrl + A</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td><strong>Refresh</strong></td>
<td>F9</td>
</tr>
<tr>
<td><strong>Draw</strong></td>
<td><strong>Group</strong></td>
<td>Ctrl + G</td>
</tr>
<tr>
<td></td>
<td><strong>Ungroup</strong></td>
<td>Ctrl + U</td>
</tr>
<tr>
<td></td>
<td><strong>Bring to Front</strong></td>
<td>Ctrl + F</td>
</tr>
<tr>
<td></td>
<td><strong>Send to Back</strong></td>
<td>Ctrl + B</td>
</tr>
<tr>
<td></td>
<td><strong>Centralize Label</strong></td>
<td>Ctrl + L</td>
</tr>
<tr>
<td><strong>Screen</strong></td>
<td><strong>New</strong></td>
<td>Ctrl + W</td>
</tr>
<tr>
<td></td>
<td><strong>Delete</strong></td>
<td>Ctrl + E</td>
</tr>
<tr>
<td><strong>Tools</strong></td>
<td><strong>Table</strong></td>
<td>Ctrl + T</td>
</tr>
<tr>
<td></td>
<td><strong>Validate</strong></td>
<td>F12</td>
</tr>
<tr>
<td><strong>Connect</strong></td>
<td><strong>Download (Application)</strong></td>
<td>Ctrl + Shift + D</td>
</tr>
<tr>
<td></td>
<td><strong>Upload (Application)</strong></td>
<td>Ctrl + Shift + U</td>
</tr>
<tr>
<td><strong>Others</strong></td>
<td><strong>Properties</strong></td>
<td>Alt + Enter</td>
</tr>
<tr>
<td></td>
<td><strong>Objects Selection</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Higher Display Order</strong></td>
<td>Tab</td>
</tr>
<tr>
<td></td>
<td><strong>Lower Display Order</strong></td>
<td>Shift + Tab</td>
</tr>
<tr>
<td></td>
<td><strong>Edit Object Mode ON/OFF</strong></td>
<td>Insert</td>
</tr>
<tr>
<td></td>
<td><strong>Edit Object Mode ON + Object Selection</strong></td>
<td>Ctrl + Shift + Click</td>
</tr>
</tbody>
</table>

The “+” mark in the list indicates that you should press the key after the “+” mark while you press the Ctrl key etc.
Appendix M
Connecting Cable Specifications

Tool Interface Connector Specifications

The following specifications apply to the connection between the PT and the support tool (personal computer).

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal Name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FG</td>
<td>Frame ground</td>
</tr>
<tr>
<td>2</td>
<td>SD</td>
<td>Send data</td>
</tr>
<tr>
<td>3</td>
<td>RD</td>
<td>Receive data</td>
</tr>
<tr>
<td>4</td>
<td>RS</td>
<td>Request to send</td>
</tr>
<tr>
<td>5</td>
<td>CS</td>
<td>Clear to send</td>
</tr>
<tr>
<td>9</td>
<td>SG</td>
<td>Signal ground</td>
</tr>
</tbody>
</table>

Assembly of Connecting Cables

Wiring should be carried out in one of the following ways, depending on the type of RS-232C connector.

25-pin Connector

![Diagram of 25-pin Connector Wiring]

**Note** Connect the shield wire to the connector hood at both the personal computer and at the PT.

Use the following recommended products when making the connecting cable.

<table>
<thead>
<tr>
<th>Name</th>
<th>Model</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
<td>XM2D-2501</td>
<td>25-pin Made by OMRON</td>
</tr>
<tr>
<td></td>
<td>XM2A-0901</td>
<td>9-pin Made by OMRON</td>
</tr>
<tr>
<td>Connector hood</td>
<td>XM2S-2511</td>
<td>25-pin Made by OMRON</td>
</tr>
<tr>
<td></td>
<td>XM2S-0911</td>
<td>9-pin Made by OMRON</td>
</tr>
<tr>
<td>Cable</td>
<td>AWG28 × 5P IFVV-SB</td>
<td>Multi-core shielded cable Made by Fujikura, Ltd.</td>
</tr>
<tr>
<td></td>
<td>CO-MA-VV-SB 5P × 28AWG</td>
<td>Multi-core shielded cable Made by Hitachi, Ltd.</td>
</tr>
</tbody>
</table>
9-pin Connector

![Diagram of 9-pin connector](image)

**Note**  Connect the shield wire to the connector hood at both the personal computer and at the PT.

Use the following recommended products when making the connecting cable.

<table>
<thead>
<tr>
<th>Name</th>
<th>Model</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
<td>XM2D-0901</td>
<td>9-pin Made by OMRON</td>
</tr>
<tr>
<td></td>
<td>XM2A-0901</td>
<td>9-pin Made by OMRON</td>
</tr>
<tr>
<td>Connector hood*</td>
<td>XM2S-0911</td>
<td>9-pin, mm-pitch screw Made by OMRON</td>
</tr>
<tr>
<td></td>
<td>XM2S-0913</td>
<td>9-pin, inch-pitch screw Made by OMRON</td>
</tr>
<tr>
<td>Cable</td>
<td>AWG28 × 5P IFVV-SB</td>
<td>Multi-core shielded cable Made by Fujikura, Ltd.</td>
</tr>
<tr>
<td></td>
<td>CO-MA-VV-SB 5P × 28AWG</td>
<td>Multi-core shielded cable Made by Hitachi, Ltd.</td>
</tr>
</tbody>
</table>

*: At personal computer, use the connector hood which conforms to the standard of the screw at connector part.
## Appendix N
### Keycode Tables and Conversion Rule

**ISO 8859/1**

Example: Hex code is represented by 30, decimal code by 48, and character by 0.

<table>
<thead>
<tr>
<th>30</th>
<th>0</th>
<th>48</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>30</td>
<td>40</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>!</td>
</tr>
<tr>
<td>1</td>
<td>49</td>
<td>65</td>
</tr>
<tr>
<td>2</td>
<td>34</td>
<td>50</td>
</tr>
<tr>
<td>3</td>
<td>35</td>
<td>51</td>
</tr>
<tr>
<td>4</td>
<td>52</td>
<td>68</td>
</tr>
<tr>
<td>5</td>
<td>37</td>
<td>53</td>
</tr>
<tr>
<td>6</td>
<td>38</td>
<td>54</td>
</tr>
<tr>
<td>7</td>
<td>39</td>
<td>55</td>
</tr>
<tr>
<td>8</td>
<td>40</td>
<td>56</td>
</tr>
<tr>
<td>9</td>
<td>41</td>
<td>57</td>
</tr>
<tr>
<td>A</td>
<td>42</td>
<td>58</td>
</tr>
<tr>
<td>B</td>
<td>43</td>
<td>59</td>
</tr>
<tr>
<td>C</td>
<td>44</td>
<td>60</td>
</tr>
<tr>
<td>D</td>
<td>45</td>
<td>61</td>
</tr>
<tr>
<td>E</td>
<td>46</td>
<td>62</td>
</tr>
<tr>
<td>F</td>
<td>47</td>
<td>63</td>
</tr>
</tbody>
</table>
Keycode Tables and Conversion Rule

Appendix N

MS-DOS CP437

<table>
<thead>
<tr>
<th>20</th>
<th>30</th>
<th>40</th>
<th>50</th>
<th>60</th>
<th>70</th>
<th>80</th>
<th>90</th>
<th>A0</th>
<th>B0</th>
<th>C0</th>
<th>D0</th>
<th>E0</th>
<th>F0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>@</td>
<td>P</td>
<td>’</td>
<td>p</td>
<td>Ç</td>
<td>É</td>
<td>á</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>!</td>
<td>A</td>
<td>Q</td>
<td>a</td>
<td>q</td>
<td>ü</td>
<td>æ</td>
<td>Í</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>”</td>
<td>B</td>
<td>R</td>
<td>b</td>
<td>r</td>
<td>Æ</td>
<td>Ó</td>
<td>Ð</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>#</td>
<td>C</td>
<td>S</td>
<td>c</td>
<td>s</td>
<td>â</td>
<td>ô</td>
<td>ú</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>$</td>
<td>D</td>
<td>T</td>
<td>d</td>
<td>t</td>
<td>ã</td>
<td>Õ</td>
<td>Ñ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>%</td>
<td>E</td>
<td>U</td>
<td>e</td>
<td>u</td>
<td>à</td>
<td>ã</td>
<td>Ó</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>&amp;</td>
<td>F</td>
<td>V</td>
<td>f</td>
<td>v</td>
<td>â</td>
<td>õ</td>
<td>Θ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>’</td>
<td>G</td>
<td>W</td>
<td>g</td>
<td>w</td>
<td>ç</td>
<td>ù</td>
<td>ø</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>(</td>
<td>H</td>
<td>X</td>
<td>h</td>
<td>x</td>
<td>ê</td>
<td>ŋ</td>
<td>Θ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>)</td>
<td>I</td>
<td>Y</td>
<td>i</td>
<td>y</td>
<td>è</td>
<td>Ō</td>
<td>Θ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>*</td>
<td>J</td>
<td>Z</td>
<td>j</td>
<td>z</td>
<td>è</td>
<td>Ü</td>
<td>Ï</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>+</td>
<td>K</td>
<td>[</td>
<td>k</td>
<td>{</td>
<td>į</td>
<td>é</td>
<td>½</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>,</td>
<td>L</td>
<td>\</td>
<td>l</td>
<td>]</td>
<td>i</td>
<td>¥</td>
<td>¼</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>-</td>
<td>M</td>
<td>]</td>
<td>m</td>
<td>}</td>
<td>i</td>
<td>¥</td>
<td>Φ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>&gt;</td>
<td>N</td>
<td>^</td>
<td>n</td>
<td>~</td>
<td>À</td>
<td>Pts</td>
<td>«</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>/</td>
<td>O</td>
<td>-</td>
<td>o</td>
<td>△</td>
<td>À</td>
<td>f</td>
<td>»</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Keycode Tables and Conversion Rule

Appendix N

MS-DOS CP437

<table>
<thead>
<tr>
<th>20</th>
<th>30</th>
<th>40</th>
<th>50</th>
<th>60</th>
<th>70</th>
<th>80</th>
<th>90</th>
<th>A0</th>
<th>B0</th>
<th>C0</th>
<th>D0</th>
<th>E0</th>
<th>F0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>@</td>
<td>P</td>
<td>’</td>
<td>p</td>
<td>Ç</td>
<td>É</td>
<td>á</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>!</td>
<td>A</td>
<td>Q</td>
<td>a</td>
<td>q</td>
<td>ü</td>
<td>æ</td>
<td>Í</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>”</td>
<td>B</td>
<td>R</td>
<td>b</td>
<td>r</td>
<td>Æ</td>
<td>Ó</td>
<td>Ð</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>#</td>
<td>C</td>
<td>S</td>
<td>c</td>
<td>s</td>
<td>â</td>
<td>ô</td>
<td>ú</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>$</td>
<td>D</td>
<td>T</td>
<td>d</td>
<td>t</td>
<td>ã</td>
<td>Õ</td>
<td>Ñ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>%</td>
<td>E</td>
<td>U</td>
<td>e</td>
<td>u</td>
<td>à</td>
<td>ã</td>
<td>Ó</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>&amp;</td>
<td>F</td>
<td>V</td>
<td>f</td>
<td>v</td>
<td>â</td>
<td>õ</td>
<td>Θ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>’</td>
<td>G</td>
<td>W</td>
<td>g</td>
<td>w</td>
<td>ç</td>
<td>ù</td>
<td>ø</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>(</td>
<td>H</td>
<td>X</td>
<td>h</td>
<td>x</td>
<td>ê</td>
<td>ŋ</td>
<td>Θ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>)</td>
<td>I</td>
<td>Y</td>
<td>i</td>
<td>y</td>
<td>è</td>
<td>Ō</td>
<td>Θ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>*</td>
<td>J</td>
<td>Z</td>
<td>j</td>
<td>z</td>
<td>è</td>
<td>Ü</td>
<td>Ï</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>+</td>
<td>K</td>
<td>[</td>
<td>k</td>
<td>{</td>
<td>į</td>
<td>é</td>
<td>½</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>,</td>
<td>L</td>
<td>\</td>
<td>l</td>
<td>]</td>
<td>i</td>
<td>¥</td>
<td>¼</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>-</td>
<td>M</td>
<td>]</td>
<td>m</td>
<td>}</td>
<td>i</td>
<td>¥</td>
<td>Φ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>&gt;</td>
<td>N</td>
<td>^</td>
<td>n</td>
<td>~</td>
<td>À</td>
<td>Pts</td>
<td>«</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>/</td>
<td>O</td>
<td>-</td>
<td>o</td>
<td>△</td>
<td>À</td>
<td>f</td>
<td>»</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Keycode Conversion Rules

When you are using the European keyboard, please read the following keycode conversion rules.

Also, PT Hardware NT21 and NT31-V1/NT31C-V1/NT631-V1/NT631C-V1 and above are supporting both Keycodes ISO8859/1 and CP437. This section will describe the rule for Keycode conversion between ISO8859-1 & Latin-US (CP437) and vice versa.

Above mentioned will be explained in following order.

1. When the conversion will be performed.
2. Basic Policy of the Conversion.
3. How to Convert.
4. Conversion Rule from ISO8859/1 to CP437.
5. Conversion Rule from CP437 to ISO8859/1.

(1) When the conversion will be performed.

The conversion will take place during the following cases.

1. By changing to a different keycode from an existing application.
   (From <Tools> – <PT Configuration>)
   This is only for the NT21 and the NT31-V1/31C-V1/631-V1/631C-V1 and above.

2. Drag/Drop of Symbols with different keycode.

3. Key input (Old & new models from ISO8859/1-CP437).

(2) Basic Policy

Basic Policy: If the Character is not found in the Target keycode, “?” (063) is chosen.

(3) How to convert. (Only for the NT21 and the NT31/631 series with “-V1” and above.)

The way to convert the Keycode will be as follows.

2. Change the “Font Type.”

(4) Conversion Rule from ISO8859/1 to CP437.

Mapping tables for the conversion.

This conversion will be performed when you try to make the former model screen data such as,

NT11S/NT11, NT20S, N30/30C, NT600S, NT620S/620C, NT31/NT631 series (System program ver.1.0) by using European Keyboard.
Also this conversion will take place if you are selecting “CP437” in NT31/631 series with “-V1” and above.

**Note** If you have Hardware NT31/631(below V1) and version up the system program of NT31/631 series to “-V2” system program which is version 3, treat it as NT31/631 series hardware with “-V2.”

<table>
<thead>
<tr>
<th>No.</th>
<th>Source</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows ISO8859/1</td>
<td>MS-DOS CP437</td>
</tr>
<tr>
<td>01</td>
<td>“Space” 0128</td>
<td>[?] 063</td>
</tr>
<tr>
<td>02</td>
<td>“Space” 0129</td>
<td>[?] 063</td>
</tr>
<tr>
<td>03</td>
<td>“Space” 0130</td>
<td>[.] 044</td>
</tr>
<tr>
<td>04</td>
<td>“Space” 0131</td>
<td>[f] 159</td>
</tr>
<tr>
<td>05</td>
<td>“Space” 0132</td>
<td>[?] 034</td>
</tr>
<tr>
<td>06</td>
<td>“Space” 0133</td>
<td>[?] 063</td>
</tr>
<tr>
<td>07</td>
<td>“Space” 0134</td>
<td>[?] 063</td>
</tr>
<tr>
<td>08</td>
<td>“Space” 0135</td>
<td>[?] 063</td>
</tr>
<tr>
<td>09</td>
<td>“Space” 0136</td>
<td>[‘] 094</td>
</tr>
<tr>
<td>10</td>
<td>“Space” 0137</td>
<td>[?] 063</td>
</tr>
<tr>
<td>11</td>
<td>“Space” 0138</td>
<td>[S] 083</td>
</tr>
<tr>
<td>12</td>
<td>“Space” 0139</td>
<td>[&lt;] 060</td>
</tr>
<tr>
<td>13</td>
<td>“Space” 0140</td>
<td>[?] 063</td>
</tr>
<tr>
<td>14</td>
<td>“Space” 0141</td>
<td>[?] 063</td>
</tr>
<tr>
<td>15</td>
<td>“Space” 0142</td>
<td>[?] 063</td>
</tr>
<tr>
<td>16</td>
<td>“Space” 0143</td>
<td>[?] 063</td>
</tr>
<tr>
<td>17</td>
<td>“Space” 0144</td>
<td>[?] 063</td>
</tr>
<tr>
<td>18</td>
<td>“Space” 0145</td>
<td>[?] 039</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Source</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows ISO8859/1</td>
<td>MS-DOS CP437</td>
</tr>
<tr>
<td>19</td>
<td>“Space” 0146</td>
<td>['] 146</td>
</tr>
<tr>
<td>20</td>
<td>“Space” 0147</td>
<td>['] 147</td>
</tr>
<tr>
<td>21</td>
<td>“Space” 0148</td>
<td>['] 148</td>
</tr>
<tr>
<td>22</td>
<td>“Space” 0149</td>
<td>[’] 149</td>
</tr>
<tr>
<td>23</td>
<td>“Space” 0150</td>
<td>[’] 150</td>
</tr>
<tr>
<td>24</td>
<td>“Space” 0151</td>
<td>[’] 151</td>
</tr>
<tr>
<td>25</td>
<td>“Space” 0152</td>
<td>[’] 152</td>
</tr>
<tr>
<td>26</td>
<td>“Space” 0153</td>
<td>[’] 153</td>
</tr>
<tr>
<td>27</td>
<td>“Space” 0154</td>
<td>[’] 154</td>
</tr>
<tr>
<td>28</td>
<td>“Space” 0155</td>
<td>[’] 155</td>
</tr>
<tr>
<td>29</td>
<td>“Space” 0156</td>
<td>[’] 156</td>
</tr>
<tr>
<td>30</td>
<td>“Space” 0157</td>
<td>[’] 157</td>
</tr>
<tr>
<td>31</td>
<td>“Space” 0158</td>
<td>[’] 158</td>
</tr>
<tr>
<td>32</td>
<td>“Space” 0159</td>
<td>[’] 159</td>
</tr>
<tr>
<td>33</td>
<td>“Space” 0160</td>
<td>[’] 160</td>
</tr>
<tr>
<td>34</td>
<td>[!] 161</td>
<td>[!] 161</td>
</tr>
<tr>
<td>35</td>
<td>[c] 162</td>
<td>[c] 162</td>
</tr>
<tr>
<td>36</td>
<td>[€] 163</td>
<td>[€] 163</td>
</tr>
<tr>
<td>No.</td>
<td>Source</td>
<td>Destination</td>
</tr>
<tr>
<td>-----</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Windows ISO8859/1</td>
<td>MS-DOS CP437</td>
</tr>
<tr>
<td>37</td>
<td>[ :] 164</td>
<td>[?] 063</td>
</tr>
<tr>
<td>38</td>
<td>[¥] 165</td>
<td>[¥] 157</td>
</tr>
<tr>
<td>39</td>
<td>[!] 166</td>
<td>[?] 063</td>
</tr>
<tr>
<td>40</td>
<td>[$] 167</td>
<td>[?] 063</td>
</tr>
<tr>
<td>41</td>
<td>[?] 168</td>
<td>[?] 063</td>
</tr>
<tr>
<td>42</td>
<td>[0] 169</td>
<td>[?] 063</td>
</tr>
<tr>
<td>43</td>
<td>[?] 170</td>
<td>[?] 166</td>
</tr>
<tr>
<td>44</td>
<td>[-] 171</td>
<td>[-] 174</td>
</tr>
<tr>
<td>45</td>
<td>[~] 172</td>
<td>[~] 170</td>
</tr>
<tr>
<td>46</td>
<td>[~] 173</td>
<td>[?] 063</td>
</tr>
<tr>
<td>47</td>
<td>[?] 174</td>
<td>[?] 063</td>
</tr>
<tr>
<td>48</td>
<td>[?] 175</td>
<td>[?] 063</td>
</tr>
<tr>
<td>49</td>
<td>[?] 176</td>
<td>[?] 248</td>
</tr>
<tr>
<td>50</td>
<td>[?] 177</td>
<td>[?] 241</td>
</tr>
<tr>
<td>51</td>
<td>[?] 178</td>
<td>[?] 253</td>
</tr>
<tr>
<td>52</td>
<td>[?] 179</td>
<td>[?] 063</td>
</tr>
<tr>
<td>53</td>
<td>[?] 180</td>
<td>[?] 034</td>
</tr>
<tr>
<td>54</td>
<td>[!] 181</td>
<td>[!] 230</td>
</tr>
<tr>
<td>55</td>
<td>[?] 182</td>
<td>[?] 063</td>
</tr>
<tr>
<td>56</td>
<td>[!] 183</td>
<td>[!] 250</td>
</tr>
<tr>
<td>57</td>
<td>[!] 184</td>
<td>[!] 044</td>
</tr>
<tr>
<td>58</td>
<td>[?] 185</td>
<td>[?] 063</td>
</tr>
<tr>
<td>59</td>
<td>[?] 186</td>
<td>[?] 167</td>
</tr>
<tr>
<td>60</td>
<td>[-] 187</td>
<td>[-] 175</td>
</tr>
<tr>
<td>61</td>
<td>[¼] 188</td>
<td>[¼] 172</td>
</tr>
<tr>
<td></td>
<td>Windows ISO8859/1</td>
<td>MS-DOS CP437</td>
</tr>
<tr>
<td>62</td>
<td>[¼] 189</td>
<td>[¼] 171</td>
</tr>
<tr>
<td>63</td>
<td>[¼] 190</td>
<td>[?] 065</td>
</tr>
<tr>
<td>64</td>
<td>[¿] 191</td>
<td>[¿] 168</td>
</tr>
<tr>
<td>65</td>
<td>[Á] 192</td>
<td>[Á] 065</td>
</tr>
<tr>
<td>66</td>
<td>[Á] 193</td>
<td>[Á] 065</td>
</tr>
<tr>
<td>67</td>
<td>[Á] 194</td>
<td>[Á] 065</td>
</tr>
<tr>
<td>68</td>
<td>[Á] 195</td>
<td>[Á] 065</td>
</tr>
<tr>
<td>69</td>
<td>[Á] 196</td>
<td>[Á] 142</td>
</tr>
<tr>
<td>70</td>
<td>[Á] 197</td>
<td>[Á] 143</td>
</tr>
<tr>
<td>71</td>
<td>[É] 198</td>
<td>[É] 146</td>
</tr>
<tr>
<td>72</td>
<td>[Ç] 199</td>
<td>[Ç] 128</td>
</tr>
<tr>
<td>73</td>
<td>[È] 200</td>
<td>[È] 069</td>
</tr>
<tr>
<td>74</td>
<td>[È] 201</td>
<td>[È] 144</td>
</tr>
<tr>
<td>75</td>
<td>[È] 202</td>
<td>[È] 069</td>
</tr>
<tr>
<td>76</td>
<td>[È] 203</td>
<td>[È] 069</td>
</tr>
<tr>
<td>77</td>
<td>[Í] 204</td>
<td>[Í] 073</td>
</tr>
<tr>
<td>78</td>
<td>[Í] 205</td>
<td>[Í] 073</td>
</tr>
<tr>
<td>79</td>
<td>[Í] 206</td>
<td>[Í] 073</td>
</tr>
<tr>
<td>80</td>
<td>[Í] 207</td>
<td>[Í] 073</td>
</tr>
<tr>
<td>81</td>
<td>[D] 208</td>
<td>[D] 068</td>
</tr>
<tr>
<td>82</td>
<td>[N] 209</td>
<td>[N] 165</td>
</tr>
<tr>
<td>84</td>
<td>[O] 211</td>
<td>[O] 079</td>
</tr>
</tbody>
</table>
### Appendix N

#### Keycode Tables and Conversion Rule

<table>
<thead>
<tr>
<th>No.</th>
<th>Source</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>87</td>
<td>[Ö] 214</td>
<td>[Ö] 103</td>
</tr>
<tr>
<td>88</td>
<td>[×] 215</td>
<td>[×] 120</td>
</tr>
<tr>
<td>89</td>
<td>[Ø] 216</td>
<td>[Ø] 079</td>
</tr>
<tr>
<td>90</td>
<td>[Ü] 217</td>
<td>[S] 083</td>
</tr>
<tr>
<td>91</td>
<td>[Ü] 218</td>
<td>[S] 083</td>
</tr>
<tr>
<td>92</td>
<td>[Ü] 219</td>
<td>[S] 083</td>
</tr>
<tr>
<td>93</td>
<td>[Û] 220</td>
<td>[Û] 154</td>
</tr>
<tr>
<td>94</td>
<td>[¥] 221</td>
<td>[¥] 089</td>
</tr>
<tr>
<td>95</td>
<td>[ø] 222</td>
<td>[ø] 084</td>
</tr>
<tr>
<td>96</td>
<td>[ø] 223</td>
<td>[ø] 225</td>
</tr>
<tr>
<td>97</td>
<td>[ä] 224</td>
<td>[ä] 133</td>
</tr>
<tr>
<td>98</td>
<td>[ä] 225</td>
<td>[ä] 160</td>
</tr>
<tr>
<td>99</td>
<td>[ä] 226</td>
<td>[ä] 131</td>
</tr>
<tr>
<td>100</td>
<td>[ä] 227</td>
<td>[a] 097</td>
</tr>
<tr>
<td>101</td>
<td>[ä] 228</td>
<td>[ä] 132</td>
</tr>
<tr>
<td>102</td>
<td>[ä] 229</td>
<td>[ä] 134</td>
</tr>
<tr>
<td>103</td>
<td>[æ] 230</td>
<td>[æ] 145</td>
</tr>
<tr>
<td>104</td>
<td>[ç] 231</td>
<td>[ç] 135</td>
</tr>
<tr>
<td>105</td>
<td>[ê] 232</td>
<td>[ê] 138</td>
</tr>
<tr>
<td>106</td>
<td>[ë] 233</td>
<td>[ë] 130</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Source</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>108</td>
<td>[ä] 235</td>
<td>[ä] 137</td>
</tr>
<tr>
<td>109</td>
<td>[i] 236</td>
<td>[i] 141</td>
</tr>
<tr>
<td>110</td>
<td>[i] 237</td>
<td>[i] 161</td>
</tr>
<tr>
<td>111</td>
<td>[i] 238</td>
<td>[i] 140</td>
</tr>
<tr>
<td>112</td>
<td>[i] 239</td>
<td>[i] 139</td>
</tr>
<tr>
<td>113</td>
<td>[ø] 240</td>
<td>[ø] 100</td>
</tr>
<tr>
<td>114</td>
<td>[œ] 241</td>
<td>[œ] 164</td>
</tr>
<tr>
<td>115</td>
<td>[ç] 242</td>
<td>[ç] 149</td>
</tr>
<tr>
<td>117</td>
<td>[œ] 244</td>
<td>[œ] 147</td>
</tr>
<tr>
<td>118</td>
<td>[œ] 245</td>
<td>[œ] 111</td>
</tr>
<tr>
<td>119</td>
<td>[ö] 246</td>
<td>[ö] 148</td>
</tr>
<tr>
<td>120</td>
<td>[–] 247</td>
<td>[–] 246</td>
</tr>
<tr>
<td>121</td>
<td>[œ] 248</td>
<td>[œ] 237</td>
</tr>
<tr>
<td>122</td>
<td>[ö] 249</td>
<td>[ö] 151</td>
</tr>
<tr>
<td>123</td>
<td>[ö] 250</td>
<td>[ö] 163</td>
</tr>
<tr>
<td>124</td>
<td>[ü] 251</td>
<td>[ü] 150</td>
</tr>
<tr>
<td>125</td>
<td>[ü] 252</td>
<td>[ü] 129</td>
</tr>
<tr>
<td>126</td>
<td>[ë] 253</td>
<td>[ë] 121</td>
</tr>
<tr>
<td>128</td>
<td>Not Used</td>
<td>Not Used</td>
</tr>
</tbody>
</table>
(5) Conversion Rule from CP437 to ISO8859/1
This conversion will be performed at the time when you try to change the PT Type to the NT21 and NT31-V1/31C-V1/631-V1/631C-V1 and above with Font Type ISO8859/1.

<table>
<thead>
<tr>
<th>No.</th>
<th>Source</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MS-DOS CP437</td>
<td>Windows ISO8859/1</td>
</tr>
<tr>
<td>01</td>
<td>[Ç] 128</td>
<td>[Ç] 199</td>
</tr>
<tr>
<td>02</td>
<td>[ü] 129</td>
<td>[ü] 252</td>
</tr>
<tr>
<td>03</td>
<td>[ê] 130</td>
<td>[ê] 233</td>
</tr>
<tr>
<td>04</td>
<td>[ä] 131</td>
<td>[ä] 226</td>
</tr>
<tr>
<td>05</td>
<td>[ä] 132</td>
<td>[ä] 228</td>
</tr>
<tr>
<td>06</td>
<td>[à] 133</td>
<td>[à] 224</td>
</tr>
<tr>
<td>07</td>
<td>[à] 134</td>
<td>[à] 229</td>
</tr>
<tr>
<td>08</td>
<td>[ç] 135</td>
<td>[ç] 231</td>
</tr>
<tr>
<td>09</td>
<td>[ê] 136</td>
<td>[ê] 234</td>
</tr>
<tr>
<td>10</td>
<td>[ä] 137</td>
<td>[ä] 235</td>
</tr>
<tr>
<td>12</td>
<td>[û] 139</td>
<td>[û] 239</td>
</tr>
<tr>
<td>13</td>
<td>[û] 140</td>
<td>[û] 238</td>
</tr>
<tr>
<td>14</td>
<td>[û] 141</td>
<td>[û] 236</td>
</tr>
<tr>
<td>15</td>
<td>[À] 142</td>
<td>[À] 196</td>
</tr>
<tr>
<td>16</td>
<td>[À] 143</td>
<td>[À] 197</td>
</tr>
<tr>
<td>17</td>
<td>[È] 144</td>
<td>[È] 201</td>
</tr>
<tr>
<td>18</td>
<td>[æ] 145</td>
<td>[æ] 230</td>
</tr>
<tr>
<td>19</td>
<td>[Æ] 146</td>
<td>[Æ] 198</td>
</tr>
<tr>
<td>20</td>
<td>[ô] 147</td>
<td>[ô] 244</td>
</tr>
<tr>
<td>21</td>
<td>[ô] 148</td>
<td>[ô] 246</td>
</tr>
<tr>
<td>22</td>
<td>[ô] 149</td>
<td>[ô] 242</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Source</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MS-DOS CP437</td>
<td>Windows ISO8859/1</td>
</tr>
<tr>
<td>26</td>
<td>[Ö] 153</td>
<td>[Ö] 214</td>
</tr>
<tr>
<td>28</td>
<td>[ë] 155</td>
<td>[ë] 162</td>
</tr>
<tr>
<td>29</td>
<td>[Ä] 156</td>
<td>[Ä] 163</td>
</tr>
<tr>
<td>30</td>
<td>[¥] 157</td>
<td>[¥] 165</td>
</tr>
<tr>
<td>31</td>
<td>[Pts] 158</td>
<td>[?] 063</td>
</tr>
<tr>
<td>32</td>
<td>[f] 159</td>
<td>[?] 063</td>
</tr>
<tr>
<td>33</td>
<td>[á] 160</td>
<td>[á] 225</td>
</tr>
<tr>
<td>34</td>
<td>[î] 161</td>
<td>[î] 237</td>
</tr>
<tr>
<td>35</td>
<td>[ô] 162</td>
<td>[ô] 243</td>
</tr>
<tr>
<td>36</td>
<td>[û] 163</td>
<td>[û] 250</td>
</tr>
<tr>
<td>37</td>
<td>[î] 164</td>
<td>[î] 241</td>
</tr>
<tr>
<td>38</td>
<td>[N] 165</td>
<td>[N] 209</td>
</tr>
<tr>
<td>39</td>
<td>[?] 166</td>
<td>[?] 170</td>
</tr>
<tr>
<td>40</td>
<td>[?] 167</td>
<td>[?] 186</td>
</tr>
<tr>
<td>41</td>
<td>[ê] 168</td>
<td>[ê] 191</td>
</tr>
<tr>
<td>42</td>
<td>[?] 169</td>
<td>[?] 063</td>
</tr>
<tr>
<td>43</td>
<td>[¬] 170</td>
<td>[¬] 172</td>
</tr>
<tr>
<td>44</td>
<td>[½] 171</td>
<td>[½] 189</td>
</tr>
<tr>
<td>45</td>
<td>[¾] 172</td>
<td>[¾] 188</td>
</tr>
<tr>
<td>46</td>
<td>[¡] 173</td>
<td>[¡] 161</td>
</tr>
<tr>
<td>47</td>
<td>[¬] 174</td>
<td>[¬] 171</td>
</tr>
<tr>
<td>No.</td>
<td>Source</td>
<td>Destination</td>
</tr>
<tr>
<td>-----</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>48</td>
<td>[+] 175</td>
<td>[+] 167</td>
</tr>
<tr>
<td>49</td>
<td>[ ] 176</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>50</td>
<td>[ ] 177</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>51</td>
<td>[ ] 178</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>52</td>
<td>[ ] 179</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>53</td>
<td>[ ] 180</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>54</td>
<td>[ ] 181</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>55</td>
<td>[ ] 182</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>56</td>
<td>[ ] 183</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>57</td>
<td>[ ] 184</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>58</td>
<td>[ ] 185</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>59</td>
<td>[ ] 186</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>60</td>
<td>[ ] 187</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>61</td>
<td>[ ] 188</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>62</td>
<td>[ ] 189</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>63</td>
<td>[ ] 190</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>64</td>
<td>[ ] 191</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>65</td>
<td>[ ] 192</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>66</td>
<td>[ ] 193</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>67</td>
<td>[ ] 194</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>68</td>
<td>[ ] 195</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>69</td>
<td>[ ] 196</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>70</td>
<td>[ ] 197</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>71</td>
<td>[ ] 198</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>72</td>
<td>[ ] 199</td>
<td>[ ] 063</td>
</tr>
<tr>
<td>73</td>
<td>200</td>
<td>[?] 063</td>
</tr>
<tr>
<td>74</td>
<td>201</td>
<td>[?] 063</td>
</tr>
<tr>
<td>75</td>
<td>202</td>
<td>[?] 063</td>
</tr>
<tr>
<td>76</td>
<td>203</td>
<td>[?] 063</td>
</tr>
<tr>
<td>77</td>
<td>204</td>
<td>[?] 063</td>
</tr>
<tr>
<td>78</td>
<td>205</td>
<td>[?] 063</td>
</tr>
<tr>
<td>79</td>
<td>206</td>
<td>[?] 063</td>
</tr>
<tr>
<td>80</td>
<td>207</td>
<td>[?] 063</td>
</tr>
<tr>
<td>81</td>
<td>208</td>
<td>[?] 063</td>
</tr>
<tr>
<td>82</td>
<td>209</td>
<td>[?] 063</td>
</tr>
<tr>
<td>83</td>
<td>210</td>
<td>[?] 063</td>
</tr>
<tr>
<td>84</td>
<td>211</td>
<td>[?] 063</td>
</tr>
<tr>
<td>85</td>
<td>212</td>
<td>[?] 063</td>
</tr>
<tr>
<td>86</td>
<td>213</td>
<td>[?] 063</td>
</tr>
<tr>
<td>87</td>
<td>214</td>
<td>[?] 063</td>
</tr>
<tr>
<td>88</td>
<td>215</td>
<td>[?] 063</td>
</tr>
<tr>
<td>89</td>
<td>216</td>
<td>[?] 063</td>
</tr>
<tr>
<td>90</td>
<td>217</td>
<td>[?] 063</td>
</tr>
<tr>
<td>91</td>
<td>218</td>
<td>[?] 063</td>
</tr>
<tr>
<td>92</td>
<td>219</td>
<td>[?] 063</td>
</tr>
<tr>
<td>93</td>
<td>220</td>
<td>[?] 063</td>
</tr>
<tr>
<td>94</td>
<td>221</td>
<td>[?] 063</td>
</tr>
<tr>
<td>95</td>
<td>222</td>
<td>[?] 063</td>
</tr>
<tr>
<td>96</td>
<td>223</td>
<td>[?] 063</td>
</tr>
<tr>
<td>97</td>
<td>[α] 224</td>
<td>[?] 063</td>
</tr>
</tbody>
</table>
### Keycode Tables and Conversion Rule

#### Appendix N

<table>
<thead>
<tr>
<th>No.</th>
<th>Source</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MS-DOS CP437</td>
<td>Windows ISO8859/1</td>
</tr>
<tr>
<td>98</td>
<td>[β] 225</td>
<td>[β] 223</td>
</tr>
<tr>
<td>99</td>
<td>[Γ] 226</td>
<td>[?] 063</td>
</tr>
<tr>
<td>100</td>
<td>[?] 227</td>
<td>[?] 063</td>
</tr>
<tr>
<td>101</td>
<td>[Σ] 228</td>
<td>[?] 063</td>
</tr>
<tr>
<td>102</td>
<td>[σ] 229</td>
<td>[?] 063</td>
</tr>
<tr>
<td>103</td>
<td>[μ] 230</td>
<td>[μ] 181</td>
</tr>
<tr>
<td>104</td>
<td>[τ] 231</td>
<td>[?] 063</td>
</tr>
<tr>
<td>105</td>
<td>[Φ] 232</td>
<td>[?] 063</td>
</tr>
<tr>
<td>106</td>
<td>[Θ] 233</td>
<td>[?] 063</td>
</tr>
<tr>
<td>107</td>
<td>[Ω] 234</td>
<td>[?] 063</td>
</tr>
<tr>
<td>108</td>
<td>[?] 235</td>
<td>[?] 063</td>
</tr>
<tr>
<td>109</td>
<td>[≡] 236</td>
<td>[?] 063</td>
</tr>
<tr>
<td>110</td>
<td>[ε] 237</td>
<td>[ε] 248</td>
</tr>
<tr>
<td>111</td>
<td>[ε] 238</td>
<td>[?] 063</td>
</tr>
<tr>
<td>112</td>
<td>[∫] 239</td>
<td>[?] 063</td>
</tr>
<tr>
<td>113</td>
<td>[∫] 240</td>
<td>[?] 063</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Source</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MS-DOS CP437</td>
<td>Windows ISO8859/1</td>
</tr>
<tr>
<td>114</td>
<td>[±] 241</td>
<td>[±] 177</td>
</tr>
<tr>
<td>115</td>
<td>[±] 242</td>
<td>[?] 063</td>
</tr>
<tr>
<td>116</td>
<td>[≥] 243</td>
<td>[?] 063</td>
</tr>
<tr>
<td>117</td>
<td>[≤] 244</td>
<td>[?] 063</td>
</tr>
<tr>
<td>118</td>
<td>[∫] 245</td>
<td>[?] 063</td>
</tr>
<tr>
<td>119</td>
<td>[∫] 246</td>
<td>[∫] 247</td>
</tr>
<tr>
<td>120</td>
<td>[∫] 247</td>
<td>[?] 063</td>
</tr>
<tr>
<td>121</td>
<td>[∫] 248</td>
<td>[∫] 176</td>
</tr>
<tr>
<td>122</td>
<td>[±] 249</td>
<td>[Space] 149</td>
</tr>
<tr>
<td>123</td>
<td>[∫] 250</td>
<td>[∫] 183</td>
</tr>
<tr>
<td>124</td>
<td>[∫] 251</td>
<td>[?] 063</td>
</tr>
<tr>
<td>125</td>
<td>[∫] 252</td>
<td>[?] 063</td>
</tr>
<tr>
<td>126</td>
<td>[∫] 253</td>
<td>[∫] 178</td>
</tr>
<tr>
<td>127</td>
<td>[±] 254</td>
<td>[?] 063</td>
</tr>
<tr>
<td>128</td>
<td>Not Used 255</td>
<td>“Space” 160</td>
</tr>
</tbody>
</table>
Index

Symbols

[Help] Menu, 76
[Show Window/Keyboard], 87

Numbers

32 dot font, 125

A

[About NT–series Support Tool], 77
[Add Node], 139
Alarm History, 167
alarm history, 439
Alarm list, 161
Applicable PT, 26
Application (in file units), 435, 438
Application Manager, 66
[Arc], 140
Arrange Icons, 76
[Associate With...], 119
[Attribute], 125
Available Data Communication Methods, 430

B

[Background function], 249
[Backlight], 81
[Bar Graph], 226
base screen, 94
Batch selection of multiple elements, 109
[Bring to Front], 116
[Broken–line Graph], 230, 237
Buzzer, 81

C

Cable, 430
Cascade, 76
Channel setting, 129
(Character) String Input, 181
(Character) String Input Touch Switch, 217
child screen, 92, 93
[Circle], 142
[Clip], 335
Closing a Creation Screen, 67
Color Palette Symbol, 260
Colour, 82
Comment, 81
[Comms. Setting], 73
Comms. Setting, 432
communication method, 27
Communication method for each PT type, 27
Connection to PT, 430
[Contents], 76
Continuous Screen, 91
Control Code Input Touch Switches, 219
[Copy], 114
Copy Setting Touch Switch, 222
[Copy to Image], 90
Copying a Screen, 68
Copying and pasting elements, 113
Creating a New Screen, 67
Creating an Element, 107
Cross–Reference, 445
Cursor Moving Touch Switch, 223
Cutting and pasting elements, 114

D

Data Communication Procedure, 432
Data logging function, 249
[Date and Time], 440
Decimal, 128
[Delete], 115
Delete, 69
Deleting a Screen, 69
Deleting an element, 115
Direct Access Information, 435
Direct Connection Information, 446
[Disassociate], 119
display history, 439
display history (Screen History) function, 100
[Display Sign], 128
Display Type, 128
Displaying and Setting Screen Properties, 69
Displaying and Setting the PT configuration, 69
Displaying the Print Image (Preview), 458
Distance, 232
Download (NT–Series Support Tool " PT), 434
Download (NT–series Support Tool " PT), 74

E
[Edit Object], 110
Editing a Table, 69
Error Log, 73
Extended I/O Input table, 15
Extended I/O Input table, 17
Extended I/O Output table, 15, 17
Extended Screen, 99

F
[Fixed Display], 138
[Format], 128
Full Screen, 87
Full Tiling, 83

G
Get History Log, 439
Global window, 97
[Graph], 226
[Group], 118
Grouping Elements, 118

H
Hardware, 6
Hexadecimal, 128
History, 81
History Report, 447
Host Connect Screen (System Initializing Screen), 101

I
[Image], 199
Image data, 8
[Image Display], 152
Image/Library Report, 447

K
Input Notify Touch Switch, 216

L
Keyboard Screens, 94

M
[Mark Editor], 344
Mark List, 448
Marks, 8
MEMLINK, 131
Menu Chart, 22
Meter Shape, 231
Mitsubishi_A, 131
Mitsubishi_Fx, 132
[Modify Parent], 94
Modifying an Element, 112
[More windows...], 76
Moving an overlapped element to the front or back, 115

N
[New], 67
[New Window], 75
No. of Division, 232
[Numeral Display], 202
Numeral Input, 173

O
Objects which can be used, 9
Occurrence History Screen, 100
OMRON, 130
Opening a Data Creation Screen, 67
Opening/Closing and moving a window, 98
Output to a File (RTF), 457
Output to a Printer, 452
Outputting the Screen Image, 459
Overlapping Screens, 93

P
parent screen, 92, 93
[Paste], 114
PC (PLC) address, 129
[Polygon], 144
[Polyline], 138
pop–up window function, 94
Pop–up Window/Keyboard Touch Switch, 218
[Print], 452
[Print Preview], 458
Print Screen Touch Switch, 225
[Print Setup], 451
Printing information on errors occurring during data conversion, 455
[Properties], 69, 80, 121
[PT Configuration], 69

R
Receiving (Uploading) Data, 436
Receiving (Uploading) the History Record, 439
[Rectangle], 141
Refresh, 86
Relationships between Elements and Memory Tables, 136
[Remove Node], 140
rich text format, 457
Right click the mouse, 108
Rotate or Flip, 333

S
Save, 71
Save As, 71
Saving the Screen Image, 90
[Scale], 125, 126
Scale, 232
Scale Length, 232
Screen, 435, 438
Screen Image, 448
Screen List, 449
Screen No., 81
Search for Help on, 77
[Sector], 146
[Select Object], 109
Selecting an Element, 108
[Selector], 107
Sending (Downloading) the Data, 73, 433
Setting footer and header, 456
setting for screen switching, 89
Setting margins, 456
Setting the color for graphics, 122
Setting the color for lamps and touch switches, 123
Setting the color for text and numerals, 122
Setting the display color, 121
Setting the line type, 121
Setting the Screen Attributes, 80
Setting the tiling color, 122
Settings for numeral display, 126
Settings for text display, 124
setup, 31
[Show Tag], 85
Size and display position of window, 99
[Smoothing], 148
Smoothing, 125
Specifying an element consisting of multiple elements, 110
Standard Lamps, 194
Standard Screen, 90
[String Display], 206
String table, 16
Style Fun, Style Name, Page# Sep
[Window Control Area], 53
Alarm list/history function, 289
Application manager screen, 40
[Backlight OFF], 49
Bit Memory Tables, 288
[Buzzer], 50
Canceling backlight OFF, 294
character string memory table (string table), 283
Check box, 44
[Close], 57
Code setting in the image/library code field, 292
Combo box, 45
[Comment], 48
Connecting Cable Specifications, 557, 558
Control code input, 294
Control Menu Box, 40
[Control/Notify Area], 51
Copy Increment, 276
Copy Increment Setting Operation, 276
Correcting colors, 467
Correcting the PC (PLC) addresses (On data conversion between PT models), 468
Correction of alarm list/history touch switches, 476
Correction of graphic display attributes, 475
Correction of image codes, 474
Correction of library codes, 474
Correction of smoothing processing for marks, 476
Correction of touch switch position and size, 477
Correction related the number of digits for numeral display, 482
Correction related the number of digits for numeral input, 480
Correction related the reference memory tables for numeral input, 481
Correction related to a touch switch for which a pop–up keyboard function is set, 478
Correction related to analogue meter, 482
Correction related to bit memory table, 473
Correction related to contents of numeral memory table, 473
Correction related to continuous screens, 469
Correction related to control touch switch of trend graph, 482
Correction related to display range of window/keyboard screens, 470
Correction related to extended I/O input/output table, 473
Correction related to extended screens, 471
Correction related to history screens, 472
Correction related to image/library codes in (character) strings, 475
Correction related to keyboard screens, 470
Correction related to number of window/keyboard screens to be opened, 470
Correction related to overlapping screens, 469
Correction related to sampling cycles of trend graphs, 483
Correction related to the 100% value, 0% value and –100% value of a graph, 483
Correction related to the lamp label (ON state), 480
Correction related to the maximum and minimum limit check function for numeral input, 480
Correction related to the number of memory tables, 472
Correction related to the system initial screen (Host Connect screen), 471
Correction related to the system keypad, 476
Correction related to the touch switch for which the copy function is set, 478
Cursor Position, 41
cursor position, 41
data conversion, 465
Data creation screen, 40
device monitor, 485
dialog box, 44
Dialog Box Settings in the PT Configuration, 46
Direct access (PLC vendor, 463
direct connection type, 48
Edit Operation, 274
[Enable], 50
Error Messages, 549, 550, 551
[Exit], 40
Extended I/O Input Tables, 293
File types, 56
floating palette, 43
[History Setting], 49
I/O Comment Tables, 298
[I/O Comments], 54
[Import], 465
Import I/O Comments, 303
Importing I/O Comment from Ladder Program, 301
[Initial], 280
[Initial Screen], 49
Inserting Image Data, 287
Inserting Library Data, 288
Inserting Mark Data, 286
Installing the System Program, 490
interlock function, 481
[Key Input], 50
Limits on display, 539
Limits on Numbers of Elements, 537, 538, 539
Limits on reading the data, 539
limits on the use of elements, 537
List box, 45
Main Window, 40
Mathematical table, 308
MEMLINK, 48
Menu bar, 41
message box, 45
Mitsubishi–A, 48
Mitsubishi–FX, 48
mmi format, 56
[New], 46
New Models, 538
Notify bit, 293
[NT–series Support Tool], 38
[Number of Table Entries], 50
Numeral Memory Tables, 277
[Numeral Storage Type], 51
object position, 41
OMRON, 48
onw format, 56
[Open], 54
Option button, 44
PC (PLC) Address dialog box, 53
PLC Vender, 41
[Printer for PT], 50
[PT Control Area], 52
[PT Notify Area], 52
PT Type page, 47
Reference Operation, 268
Remaning memory, 41
replacement, 269
[Resume Function], 49
[Save], 55
[Save As], 55
Screen switching, 293
Screen switching function, 289
Search Operation, 269
Selected PT model, 41
Siemens, 48
Start–up Procedure, 38
Status bar, 41
[Storage Type], 280
System Installer Operation, 487, 488, 489
System page, 49
system program, 487
Table Display Operation by Specifying the Table Number, 277
Table of Functions, 4, 493, 494, 495, 517, 518, 519
Text box, 45
the import method of I/O comment, 301
Title bar, 41
[Tools], 465
Total memory, 41
[Value], 279
[Vendor], 48
[Words], 281
Switch Screen Touch Switch, 217
Index

Switching Screen by Extended I/O Input, 89
Switching Screens by Extended I/O Input at Each Screen, 89
[Symbol Manager], 254
System installer, 30
System Keypad, 82
System Memory, 435, 438

T
Table, 15, 70, 89, 435
Table Report, 450
[Text], 147
The relationships between elements and memory tables, 136
[Thumbwheel Switch], 190
Thumbwheel switch, 173
Tile, 76
[Tiling], 149
Title, 81
[Touch Switch], 211
[Trend Graph], 242
Type, 231
Types of Screens, 18
Types of windows, 97

U
[Uninstall], 36
[unInstallShield], 36
Upload (PT " NT-series Support Tool), 438

V
Validate, 72
Validation Report, 450

W
[What’s This?], 77
Width Rate, 231

Z
[Zero Suppression], 128
[Zoom], 87
# Revision History

A manual revision code appears as a suffix to the catalog number on the front cover of the manual.

Cat. No. V061-E1-06

The following table outlines the changes made to the manual during each revision. Page numbers refer to the previous version.

<table>
<thead>
<tr>
<th>Revision code</th>
<th>Date</th>
<th>Revised content</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>July 2000</td>
<td>Original production</td>
</tr>
<tr>
<td>02</td>
<td>October 2001</td>
<td>Revisions to add information on the NT21 and clarify terminology.</td>
</tr>
<tr>
<td>03</td>
<td>January 2004</td>
<td>Revisions to add information on the upgraded version (Ver. 4.7) of the NT Support Tool for the NT11.</td>
</tr>
</tbody>
</table>
| 04            | June 2004   | **Page 4:** "CS1" changed to CS-series PLC.  
**Page 25, 47, and 57:** Reference information added.  
**Page 27:** Model numbers added.  
**Page 174:** Information on inputting decimal fractions added toward bottom of page.  
**Page 219:** Note added.  
**Page 302:** Information added just before 7-7-4.  
**Page 461:** Information added on direct access versions.  
**Page 475:** Left cell in bottom table changed.  
**Page 487:** Sentence added at end of Drive information.  
**Page 551 and 552:** Text added to graphic and note added. |
| 05            | May 2007    | Revisions to add information on the NT20, NT31/31C-V3, and NT631C-V3 (new models).                                                             |
| 06            | July 2010   | Revisions to add information and correct mistakes.                                                                                           |